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1.1 GENERAL 

TERMS 

Work plane 

The work plane is the current plane in the room on which you are processing your 

design model. The position of the work plane can be controlled via the functions in the 

menu DRAW > WORK PLANE. 

Object 

The term "object" encompasses architectural or mechanical construction parts as well 

as 3D objects such as boxes, free forms, etc. 

Model 

The term model has been used in earlier versions of ELITECAD. A model represents 

a manually defined component and is therefore an object too. Apart from some special 

functions, the term model has been replaced by object or component. 

It is a free combination of 2D and 3D geometry, like lines, circles, arcs, as well as help 

lines, hatches, dimensions, texts to a component. Models receive a name and attributes 

for evaluations programs (e.g. bill of material). 

Drawing elements include 

Line, polygon, circle, ellipse and spline 

 

Delimited by start and end point 

Help elements are 

Help lines and help circle 

 

Delimited by edge of monitor (no start and end point)  

Residual elements include 

Dimensioning, Tip arrow, Hatch, Text 
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Handles 

Handles are the small square or triangular symbols that appear when clicking on the 

edges or surfaces of a part. Various manipulation options are available to you by 

clicking on a handle for a second time. The manipulation functions can be selected 

with the cursor from a toolbar or [TAB]. 

The size and colour of these handles can be set in the OPTIONS. 
 

Handles for dimensioning and for an arc 

        

Gripper 

Grippers are the symbols that appear with a dotted line on the elements when clicking 

on a part. Various manipulation options are available to you by clicking on a gripper 

for a second time. The manipulation functions can be selected with the cursor from a 

toolbar or [TAB]. 
 

Gripper on a polygon and on a wall in ELITECAD Architecture. 
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1.2 USER INTERFACE 

 

The appearance of the interface may differ, depending on the installation 

(Architecture, Mechanics, Viewer) and screen resolution. 

Title line 

 

The title line of the program shows, which file is opened. In ELITECAD Architecture 

it show additionally, which project is loaded, in which structure and storey you are 

currently located. 

ELITECAD – Menu bar 

 

The menu bar with opened and extended MODIFY menu. 

Toolbars 

 

Toolbars offer rapid access to the most important commands. Many of the symbols or 

icons can also be found with the same meaning in the relevant menu entries. 

Properties bar 

Storeys 
manager 

Layer 

CAD Input window 

Menu bar 

Dimension 
values 

Status bar

 

Title line 

Info window 

Views 

Library 

Materials 

Graphics 
window 

Tools 
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Toolbars 

Properties 

References 
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Welcome screen 

Classification 
Drawing 
structure 

Status 

Image properties

 



Chapter 1 – Managing and organising  

www.elitecad.eu  5 

Tools manager 

Multiple toolbars are combined in the tools manager. These can be opened and closed 

as required, enabling you to fit many functions into a small space. The order in which 

the bars appear can be adapted and you may add your own new bars. 

Properties bar 

 

The properties bar always displays the properties of the active part or properties for a 

manipulation to be performed. There are properties bars for manipulations, elements, 

hatches, dimensioning, text, 3D objects and construction parts. The example shows the 

properties bar of the window. 

Input Assistant 

The Input Assistant consists of additional functions that vary according to the function 

selected. The functions of the Input Assistant can be displayed on the cursor using the 

[Tab] key. 

Not every function has these extended functions. In principle, these are the create 

functions and the manipulations on the handle. 
 

Example of the polygon drawing function with the additional functions for arches: 

 

Example of manipulation on the handle of a polygon: 

 

CAD input window 
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The input window contains the image properties, the information line, the entry line 

and the status. 

Image properties 

 

These commands are fixed. They control how the data is displayed on the monitor. 

Zoom factor, cutout, imaging, etc. 

Information line 

This line contains commands regarding what you must enter or specify within a 

function. 

Entry line 

Use the entry line to forward information to the program. This information can be 

texts, coordinates or, in the event of queries, confirmations. 

Status for ELITECAD Architecture 

 

You can select representation level, filter for renovation planning states, scale, units 

and the page format here. 

Status for ELITECAD Mechanics 

 

You can select the view, scale, units and the page format here. 

Status – scale 

A free scale can be specified in addition to the predefined scales. 

            

The new scale is defined in the entry line for the user-defined scale. 

Status – format 

 

A user-defined format can be created by selecting "User". The special formats can be 

saved under a parameter name and used again at any time. 
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Status bar 

                

The left-hand area shows confirmations, e.g. that the data was saved successfully. The 

active work plane is positioned to the far right. "Z" stands for axis; "-10" indicates the 

height on this axis.  

In ELITECAD Architecture, for example, these coordinates would be in the upper 

storey, "Z270", and in the basement "Z-260". 

If working with classification is active, then the classification (model, group, class, 

level) from the active object is displayed in the status bar. 

Status – filter for renovation planning state (only ELITECAD Architecture) 

 

Several reasonable combinations of renovation planning states are predefined in this 

menu. By selecting one item all object are assembled which belong to this state. 

Measurement 

The dialog window also displays the measurement functions for lines, arcs, areas, 

angles and points. Simple calculation operations can be performed using the 

measurement results. 

 

Views management 

The management stores the different plans for the design models by type. 
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Layer management 

The management shows the defined layers and their statuses (used/unused, active/not 

active, visible/invisible, locked/not locked). 

 

Library management 

The standard library parts and users' own parts as well as external 3D formats (i.e. 

SketchUp, 3DS) can also be organised in the management. The parts most recently 

loaded are listed in a selection and can be selected again directly. 

 

Materials management 

Materials management is used for the simple organisation and selection of your 

materials. The materials can be set or modified in terms of the properties, such as 

texture image, transparency, mirroring, shine, etc. 
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Reference management 

Reference management organises the internal and external references. 

  

Storeys manager 

The storey management is only available in ELITECAD Architecture. 

The defined structures and storeys are defined in the storeys manager. The 

management controls the correct allocation of the construction parts and the visibility 

of the individual storeys. 

 

Drawing structure 

The drawing structure is displayed in ELITECAD Mechanics in a separate window. In 

ELITECAD Architecture, the drawing structure is part of the management window for 

references. In this window, the assembly groups and components are depicted 

hierarchically. 
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Properties 

An object type and descriptions can be allocated in ELITECAD Architecture to free 

forms such as boxes, rotation solids and free forms to ensure that these parts are 

evaluated correctly. 

Info window 

Special information is displayed in the Info window. This information includes lists of 

element values, dimensions, structures and information for importing data. 

Clicking on the Info window moves it into the foreground or "refilled" with 

information. 

Info balloon 

The Info window messages can also be displayed in the Info area (task bar) of the 

operating system. 

Requirement: 
 

Activated option DISPLAY NOTIFICATIONS AS INFO BALLOON under 

SETTINGS > OPTIONS > SYSTEM > USER INTERFACE 
 

Activated notification in the Windows system  

Windows system > Notifications and actions 

Info window-Delete content 

 

Window toolbar 

 

The info window may soon be overloaded with data. In order to have a better overview 

the may be deleted. 

Report management 

The management is not visible on the monitor in the default settings. 

The management controls the relation of the design model to the numerical evaluation 

data and contains operating instructions for quantity surveying.  
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Time lapse 

The time lapse is not visible on the monitor in the default settings. 

This tool can be used to check the lighting contrast of a project in time lapse mode and 

present this on the monitor. 

 

Start dialog window 

A welcome dialog is displayed when launching ELITECAD. This dialog window 

assists when staring a new project or it is used to continue the work in the previously 

edited project. 

New project 

Clicking the button CREATE NEW PROJECT leads directly to the definition dialog 

window for new projects. 

Alternatively, a project can be created from a project template. The templates are not 

modified during this process. The path for project templates is defined in the 

ELITECAD configuration. 

Existing project 

An existing project can be selected in the menu. The recently edited drawings are 

available in the according tab. 
 

Additionally, the course units, the manual, hotline numbers and available updates can 

be accessed directly. 

The dialog can be opened at any time under menu HELP > WELCOME TO 

ELITECAD. The automatic appearance of the dialog can be suppressed by setting the 

OPTIONS. 
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Docking windows 

If a management window is placed in the title line, assistance with positioning appears 

in a graphic preview in order to dock the window in the user interface. 

 

 

If a management window is moved to the centre of another management window, 

assistance with positioning also appears. 
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View layout 

Three possible layouts can be selected: 

 Single view 

 Multiple views 

 Views in tabbed format 

Layout settings are made in the menu SETTINGS > OPTIONS > SYSTEM > USER 

INTERFACE. 

Multiple views 

Multiple views can be opened. The maximum number of opened views can be 

specified. 

 

Excerpt from the OPTIONS 

Additionally, there is the option to open selected plan views VIEWS > SECTIONS > 

DETAILS > PLOTS directly always in a new window.  

In order to display multiple views on the monitor, either the function described above 

must be active or the views are opened from the context menu of the views 

management with the function SHOW VIEW IN A NEW WINDOW. As the first view 

has been maximised, the views below are not visible. The windows below appear only 

when the view window is minimised. Automatic arrangement can be selected in the 

window menu. 
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Views management context menu 

  

Display view in a new window 

 

Opens the view in a new window. 

Detach view window 

 

 

Opens the view in a separate window. This can be moved to a second monitor, for 

example. 

Dock view window 

 

A detached view can be reintegrated into the user interface via the context menu. 
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Menu window 

 

Functions are available for the automatic arrangement of multiple windows. 

All opened views are listed in the menu. 
 

All of the open views are listed in the management and the status of each window can 

be set. 

 

Views in tabbed format 

Multiple views can be opened that appear as a tab on the monitor. The maximum 

number of opened views can be specified. 

 
Excerpt from the OPTIONS 

Additionally, there is the option to always open selected plan views VIEWS > 

SECTIONS > DETAILS > PLOTS directly in a new tab, as well as colour coding of 

the tab headers by view type. 

 

In order to display multiple views on the monitor, either the function described above 

must be active or the views are opened from the context menu of the views 

management with the function SHOW VIEW IN A NEW WINDOW. The tabs are 

lined up at the bottom left of the screen. 

 

An additional tab group can be generated in the context menu of the tab. 

The order can be changed and you can switch to a new tab group by pulling on the tab. 

The open views are listed in the window menu. 
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View management context menu 

Tabs context menu 

 

New vertical/horizontal tab group 

The monitor can be divided into horizontal or vertical tab groups. The group disappears 

automatically when the last view of the group is deleted or moved. 

Move to next tab group 

Moves the view to the next tab group. The tab can also be moved by mouse to the 

desired group. 

Unpin views 

User interface design 

Various user interface designs are available. The design can be selected under 

OPTIONS. 

Menu SETTINGS > OPTIONS > SYSTEM > USER INTERFACE 

silver blue 

  

black granite 
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etc….. 
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FUNCTIONS IN THE GRAPHICS WINDOWS 

Left mouse button  

The left mouse button can be used to draw, select and modify. If you move the mouse 

in the graphics window, crosshairs appear on the cursor. The position of the point most 

recently clicked on in the graphics window is displayed with the marker in the shape 

of a crossed square " ".  
 

Depending on which function is currently active, the cursor offers additional support 

by displaying information and help functions. These functions are described below 

using general examples. You will find further descriptions for the respective functions.  

Temporary reference points and help lines 

If the system recognises a capturable point when drawing close to an element, it 

displays this with the capture symbol that is displayed beneath the cursor. The symbols 

are described in the "Right mouse button" chapter. 

Example:  

  

Values field  

A distance from the most recently selected point can be entered in the value field. For 

example, a line is to be copied 50 cm from the other line, parallel and offset. After 

calling up the copy function and stating the direction, the alignment can be stated 

directly in the distance field. 

  

  

Symbol: 

perpendicular 

to base line 

Temporary 

helpline and 

point of 

reference 

result 

Which point 

to move: 

intersection 

Point direction: 

onto element 

Enter 

distance 

result 
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Input Assistant 

The Input Assistant appears above the value field when the [TAB] key is pressed. The 

Input Assistant provides additional options for inputs or processing depending on the 

function that is currently selected. 

A selected line is to be connected to another in the example. The STRETCH function 

is called up in addition via the Input Assistant.  

 

Right mouse button 

The context menu may contain various functions. 

   
Standard   for a selection   in a text field 

Capture functions 

The capture functions are described in chapter 4.1 "Cursor, capture functions". 

Divide 

A division by number or fixed distance can be displayed on a line or polygon using 

this function. Temporary capture points are generated that are only deleted when the 

freehand capture mode is called up. 

Number on line 

Two points and the number of distances are queried. 

Input Assistant 

appears on 

pressing Tab-Key 
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Distance on line 

Two points and the distance are queried. Division begins at the first point. 

Number on polygon 

The polygon must first be selected and then the position of the start and end points and 

the number of distances is queried. 

Distance on polygon 

The polygon must first be selected and then the position of the start and end points and 

the distance queried. Division begins at the first point. The side to be divided must also 

be stated for a closed polygon. 

Measure… 

This function moves the dimension values window into the foreground. 

Move selection 

You can use this function to move previously selected parts. 

Copy selection 

You can use this function to copy previously selected parts. 

Delete 

You can use this function to delete previously selected parts. 

Group selection 

An arbitrary selection can be combined into a group using this function. 

Ungroup 

A previously selected group can be ungrouped using this function. 

Selection to foreground 

The visibility of a specific selection can be modified and placed in the foreground 

using this function. 

Selection to background 

The visibility of a specific selection can be modified and placed in the background 

using this function. 

Selection in front of model 

The visibility of a specific selection can be modified and placed in front of a specific 

model using this function. 

Selection behind model 

The visibility of a specific selection can be modified and placed behind a specific 

model using this function. 

Middle mouse button 

Rotate image 

Hold down the middle mouse button (scroll wheel) and move the mouse. 

Zoom 

Scroll with the middle mouse button (scroll wheel) or hold down the middle mouse 

button and the [Shift] key together and move the mouse up and down. 

The current position of the cursor is the zoom centre when zooming with the scroll 

wheel. 

Move 

Hold down the middle mouse button and the [Ctrl] button and move the mouse.  

The image section can also be moved using the arrow keys. 
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The key combination of the functions ROTATE IMAGE and MOVE IMAGE can be 

switched in the OPTIONS. 

Touch Input 

Several gestures with the fingers are supported for tablets with touch sensitive displays 

in the graphics window. 

Move 

Put one finger on the graphics window and move the finger. 

Rotate 2D 

Put two fingers on the graphics window and rest one finger. This defines the rotation 

point. Rotate the second finger around the first. The z-axis remains unchanged. 

Zoom 

Put two fingers on the graphics window and move them closer or farther away. 

Rotate 3D 

Put two fingers on the graphics window and move them up and down. The z-axis is 

tilted. 

Reset view 

Put one finger on the graphics window and tap with the second finger. 

Functions in the entry line 

The crosshairs can be positioned using coordinate entries. 

The Cartesian and polar coordinates system are available options. 
 

Cartesian coordinate system: Lines x (X), y (Y) and z (Z) 

Polar coordinates system: Polar angle a (A) and radius vector d (D) 

Positive direction (direction of rotating) anticlockwise. 

        

(x,y) and (a,d) written in lower case mean relative entry from the perspective of the 

current location. (X,Y) and (A,D) written in upper case mean absolute entry from the 

perspective of the absolute reference point (e.g. centre of page). It is also possible to 

combine relative and absolute coordinates. The system recognises the difference 

between x and y values by setting a separator sign. 

The separator signs for list values and decimal numbers are defined in the OPTIONS. 

The default sign for lists of values is the comma, for decimal number the point. 
 

The system is set to relative coordinates by default. 
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Entering special characters 

 

If the right mouse button is pressed above the 

entry line on "??", a selection of special characters 

appears. 

The character can be copied into a different dialog 

window using the clipboard. 

Copy: [Ctrl]+[C] 

Insert: [Ctrl]+[V] 

Not all character sets have all special characters. 

 

Individual special characters can also be entered by holding down the [Alt] key and 

entering the corresponding ASCII number. The number must be entered using the 

numeric keypad (usually on the right of the keyboard). 
 

Examples: 

[Alt]+155 produces "ø" (small diameter character) after releasing the [Alt] key. 

[Alt]+241 produces "±" (plus-minus sign) after releasing the [Alt] key. 

Calculating expressions  

There is an option for calculating mathematical expressions in the entry line. 

This type of calculation is made by pressing [F9]. 

Example: 

50*50 [F9] >> 2500 

sin(45) [F9] >> 0.707106781186547 

Keyboard commands (short cuts)  

Users can create their own keyboard shortcuts or modify existing ones. The keyboard 

commands can be set in the menu SETTINGS > KEYBOARD COMMANDS. 
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NOTE 
Keep in mind that the following keys on international keyboards may 

have different inscriptions. 

[Ctrl] 

[Shift] 

[Delete] 

[Home]  

Categories 

All menus and submenus are listed here.  
 

TIP 
The commands are organised by toolbars under "All commands". 

  

Command 

Individual commands are listed by selecting a category.  

If a command is selected, the "Current key commands" field will show whether a 

keyboard combination has already been assigned to this command. 
 

TIP 
Users can choose between the OPTIONS "Current category" and 

"Display all". All commands are displayed by selecting "Display all". 
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New keyboard commands 

 

If a command is selected, the key combination can be entered in the "New key 

command" field. This is done by pressing the required keys together. If the selected 

combination is already in use for a different command, the command is displayed in 

the field "Currently used for".  

The new combination is saved by selecting "Apply". If the combination has already 

been assigned, a warning message appears.  

 

NOTE 
Possible keyboard commands: 

A modifier key must be used: 

[Ctrl], [Alt] or [Shift]  

Letters on their own do not work.  

The only single key combinations are the function keys [F1]–[F12]. 

  

Current keyboard commands 

The current allocation of the command is displayed here. A marked command can also 

be deleted here. 

Reset all 

Commands can be reset if you wish to return to the default settings. A warning message 

appears. 

 

Management functions 
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The key combinations can be saved or transferred to other computers with the LOAD 

COMMANDS and SAVE COMMANDS management functions.  

List commands 

 

This function provides a complete list of all keyboard commands and provides a 

function for printing the list or searching for specific commands.  

 

NOTE 
The list can be reduced to keyboard commands already in use. 

  

Search 

 

Enter a word or part of a word into the search field. The current list is filtered based 

on the text you enter. 
 

TIP 
Double-clicking on an entry takes you back to the main dialog window 

and displays the corresponding command directly.   
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1.3 TOOLBARS 

Functions can be accessed directly using icons (buttons). The functions are grouped 

together in toolbars or in the large tools manager. There is an icon for almost every 

function. While the most important functions are displayed on the user interface after 

installation, various prepared toolbars are available. Alternatively, users can create 

their own toolbars and populate them with frequently used functions. The most 

recently used toolbars and their position are loaded automatically when starting 

ELITECAD. 

Modify 

In order to create your own toolbars or display existing bars, the function MODIFY or 

the menu SETTINGS > TOOLBARS/KEYBOARD COMMANDS must be selected.  

 

The dialog window is divided into two sections. The left-hand column lists all of the 

toolbars, beginning with custom-made toolbars, then the bars of the system and finally 

the bars that are integrated into the tools. The right-hand column lists the commands 

of the marked toolbar. 

Search command 

Users can search for a command in the search field. In addition, the toolbar in which 

the command is stored is marked in the left-hand column. 

Load toolbar 

If a toolbar is selected, a query appears asking the user whether the toolbar is to be 

integrated into the Tools window or whether it should be displayed as a separate 

toolbar on the monitor. The toolbar has three statuses: not loaded, loaded and visible, 

and loaded and invisible. The active option states that the toolbar is loaded. 
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Toolbar visible/invisible 

All loaded toolbars are listed in the toolbar context menu. If a toolbar is closed with 

"x", it is still loaded but invisible. 

 

Add or delete buttons 

This function is always hidden at the end of a toolbar. The visible toolbars are listed 

with their functions. Buttons can be switched to invisible or back to visible. 

 

New 

 

Users can open their own toolbar by clicking on "New". 
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Name the bar and store it in the file structure. 

An empty toolbar is displayed at the top left of the screen. 

 

Copy command 

Drag the command into the new toolbar with the drag and drop function while holding 

down the [Ctrl] key. 

 

Move command 

Drag the command into the new toolbar with the drag and drop function. 

 

Delete command 

Drag the command into the graphics window with the mouse to delete it. 

 

Integrate toolbar into graphics window (docking) 

Drag the toolbar into the desired location by clicking and holding its title line. 

 

Change position between integrated and loose 

Double-clicking on the "Gripper" or on the title bar toggles between integrated and 

loose positions. 

  

Import toolbar 

 
Custom-made toolbars from previous versions or from other stations can be loaded. 

The toolbar can be loaded as a separate bar or loaded into the Tools window. 

Export toolbar 
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Toolbars assembled by the user can be exported in order to import them to other 

stations or back them up. 

Manage user interface 

 

The button opens functions for managing the user interface. 

 

Reload personal user interface settings 

All toolbars and management windows are reset to the status from the last time 

ELITECAD was launched. 

All modifications to the toolbars (functions added, deleted, position of the bar changed, 

etc.) that were made since the last time ELITECAD was launched are lost. 

Restore installation situation of user interface 

All toolbars and management windows are reset to the installation status. The 

modifications made to the toolbars and management windows are lost. The function 

requires the CAD to be rebooted. 

Export user interface and parameter settings 

All user interface and parameter settings (elitecfg) are exported to a directory. This 

function enables the user interface to be copied to another computer. Users should note 

that the result might deviate from the original if the monitor resolution is different.  

A blank directory is required for exporting the settings and ELITECAD must be closed 

afterwards. 

Import settings 

Exported user interfaces and parameter settings can be imported. In a second query, 

users can decide whether only the parameters, only the user interface or both should 

be imported. 
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The current settings are deleted when importing the parameters. 

ELITECAD must be closed and restarted. 

Tools manager 

 

Predefined toolbars are managed in the tools manager. The individual lists can be 

opened and closed. The internal order of the bars can be controlled or an individual 

bar unloaded in the context menu of the individual titles. 

When loading a toolbar users can choose to integrate the bar into the management. 

Only predefined and complete bars can be integrated. In order to add individual 

commands, the corresponding bar must be unloaded, the new function added, saved, 

unloaded and then reloaded afterwards. 



Chapter 1 – Managing and organising  

www.elitecad.eu  31 

1.4 COLOURS 

The pen colours, hatch colours, 3D colours and light colours all use the same 1024 

pens and colours. This means that hatch no. 433 has the same colour as pen no. 433 or 

3D colour no. 433. 
 

TIP 
Do not use colours 1–15 for hatches as colours 1–10 are used by the 

pens by default and the greyscales 11–15 by the architectural 

construction parts walls, slab, ceiling, etc.  

Entry 

   

The colour number can be directly entered into the entry fields or selected via the 

colour table. 
 

Please note that you can switch between the respective colour and material mode. If a 

material has been defined, it has priority. The entire material name must be deleted in 

order to display the colour again. 
 

Material mode     Colour mode 

   

Concept 

1024 pens are available, each of which can be defined in terms of their stroke strength, 

monitor colour and print colour. The settings are made in the menu SETTINGS > 

COLOUR PROPERTIES. 

The pen numbers 0–10 are fixed monitor colours that cannot be changed. 

The numbers 11–15 are additional greyscales. 

Pen numbers 16–127 are general hues that can be brightened or greyed in the various 

rows. 

M-RAL colours are available to be selected from numbers 128–303. The quick info 

function displays the respective colour name and the M-RAL number. 

 

Numbers 303–348 are greyscales. 
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The other colours are assembled based on the M-NCS system. M-NCS (colour 

triangle) and pen view (table) are available colour display options. 

  

Example colour 699 (S 6733-G) 

  

S 67 stands for 67 % black 

F 33 stands for 33 % colour 

G stands for colour area 
 

All information and designations for the colours described are subject to the 

printing quality and are therefore considered as benchmarks. 
 

TIP 
Colour fields and colour circles are stored as an ELITECAD file on the 

system.<ELITECAD installation path>u\<version>\cad\glob\d 

Print or plot these files. The colours are best chosen by using the 

printouts.  
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1.5 LINE TYPES 

Nine different standard line types and freely definable line types are available. 

 

The freely definable line types are not available everywhere. 

USER-DEFINED LINE TYPES 

 

Properties bar of 2D drawing elements 

Settings menu > User-defined line types 

Management window for the user-defined line types 

 

Import 

 

Allows line types that were exported on a different workstation from ELITECAD to 

be imported. 

Export 

 

The selected line type can be exported as a file. The line type can be reimported on a 

different workstation or in a remote office. 

Save 

 

If a drawing is loaded that contains line types that are not available to you, these are 

labelled in the list in addition (drawing). This is also the case if you have edited a line 

type. 

Line types must be saved in order for them to be permanently available. 
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If the name of a temporary or editable line type already exists, (.1) is added to the end 

of the name. If the line type is saved now, a message appears to inform the user that 

the line type name is not unique. Enter a new name, which may not start with a number. 

 

Rename 

 

The line type can be given a new name.  

Edit 

   

Allows new line types to be edited and created. 

After calling up the function, the line type that is selected in the list is displayed on the 

monitor. 

 

The circles with the larger diameter specify the start and end of the line model. 

The small dotted circles are only relevant if the option DRAW START AND END 

LINE is active. In this case, a line is automatically drawn between the large and small 

circle. 

The white cross in the centre is the actual line model in this example. 
 

If the editing process is complete, a query appears on the monitor. 
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Overwrite original 

The editable line type is overwritten. The line type must be saved in order for it to be 

permanently available. 

Append to list end 

The modified line type is added at the end of the list. The line type must be renamed 

and saved in order for it to be permanently available. 

 

Reject modifications 

The modifications made are not saved. 

Delete 

 

The marked line type is deleted. This is only possible in an empty drawing, however. 

Cancel 

 

Cancels editing or closes the dialog window. 

Draw start and end line 

 

If the option is set, an automatic line is drawn to connect the large and small circle of 

the line model. 
 

Original example 

 

Without start and end line  with start and end line 
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Line model contiguous 

 

If this option is not active, a direct connecting line is always drawn in the corners if 

there is no more space in the line model. If this option is selected, the line model is 

always completely visible even if the corners overlap. 
 

Line model not contiguous Line model contiguous 

  

Scale line model as geometry 

 

If this option is not active, the size of the line model always stays the same in the 

printout, regardless of the scale set. If this option is selected, the line model is scaled 

using the scale of the drawing. 

 WORKSHOP  

Create new line type 

Select the function DRAW LINE and then the line parameters in the properties bar. 

  

Select the line type (e.g. border 2) and click Edit. 

 

The line model is displayed on the monitor. Add to the drawing using the drawing 

functions. 
 

Template    new line model 

  

Click "Complete edit" and then on "Append to list end". 
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The new line type is displayed in the list. Click on Save. 

 

Enter a new name and confirm it with OK. 

 

The new line type is available for use. 

 

  WORKSHOP END 
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1.6 LAYER / CLASSIFICATION 

Layers are the preferred method to structure plans in ELITECAD Architecture. 

ELITECAD Mechanics offers multiple tools to structure objects in a drawing. The 

classification structure (with model/group/class/level), the layer structure and the 

hierarchical assembly groups. 

LAYER 

The Layer management is described with examples from ELITECAD 

Architecture. 

 

Active layer 

 

The current layer is displayed in this field. The program recognises the current layer 

for the 2D elements (elements, text, hatch) for dimensioning and for each construction 

part. 
 

If you have made a selection on the screen, you can modify the structure by selecting 

a different layer. 

The layers switched off in layer management are not displayed in the selection. 

State layer for objects  

The architecture objects (walls, ceilings, windows, etc.) are automatically assigned a 

layer as this can be entered directly in the parameter dialog window. 

The layer can be selected or saved with the correct layer in the parameter record in the 

"Layer" field.  
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If a parameter record is selected in the wall properties bar, the layer converts 

automatically to the layer saved in the parameter. 

Layer management 

 

Layer management opens with a single click on the layer function. 

 

Header functions 

The top row populated with functions in the 

management window. 

Structure 

The layers are structured into main layer groups and 

layer groups.  

In this example: 

Main layer group > "Architecture" 

Layer group > "Drainage group" 

DXF layer 

Layers made up of data imported via the DXF/DWG 

interface are stored in this group. 

Further CAD layers 

If data is inserted from other ELITECAD design 

models with layers that are not defined in this 

project, these layers are stored in the main group 

"Further CAD layers". 

If a layer is deleted from the default structure that 

still contains data, the layer is also added for the 

additional CAD layers. 

These layers are only listed as long they contain 

data. 

 

 

Filter 

A filter is an instrument used for switching a certain 

subset of layers to visible, invisible or visible alone. 
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Meaning of the symbols in layer management 

 

 Layer main group/layer group  

 Layer without content (as long no objects assigned to this layer) 

 Layer with content (objects have already been assigned to this layer) 

 Layer is active 

 Layer is visible 

 Layer is invisible 

 

 Layer is locked 

 Layer is not locked 

 

 Filter 

 Layer in filter 

Visibility 

The "eye" indicates whether a layer is visible or invisible. The active layer is always 

switched on. 

Lock layer 

Locked layers may NOT be edited. The capture points can still be selected, however. 

The active layer may never be locked. 

The pen colour with which the locked layers are displayed is specified under 

SETTINGS > OPTIONS > REFERENCE PLAN. 

Select multiple layers 

Multiple individual layers can be selected with the [Ctrl] key. A specific area can be 

selected with the [Shift] key or an area opened up with the cursor. 

Layer management header functions 

 

New group 

 

Layers can be combined into a group for the sake of clarity. The function creates a 

layer group at the end of the list. The name can be edited straight away. 

New layer 

  

Creates a new layer. The name can be edited straight away. The insert location depends 

on the sorting. The layer is created at the end of the list for "user-defined" sorting. 
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Expand all layer groups 

 

Close all layer groups 

 

Manage/save record 

 

This function shows a second row with record management functions in the header 

functions. 

Manage records in the parameters. 

 

Records with layer structures can be stored, loaded or deleted in the parameters. These 

records are written to the local parameters. 

Import/export records 

 

A layer structure can be exported and imported in order to make it available to other 

employees. 

Sort 

User-defined sorting 

 

The order of the layers can be freely defined by moving the layers. If new layers are 

created in the alphabetical sorting, these are listed in the "user-defined" sorting at the 

end of the list. 

Ascending/descending sorting 

    

The layers are listed alphabetically. 

Layer management context menus 

There are two context menus in the layer management (right-click). One opens when 

clicking on a layer name or its symbols; the other opens when clicking on the 

background. 
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Background context menu 

 

View all 

Switches all layers to visible . 

All invisible 

Switches all layers to invisible . 

Invert visibility 

Switches all visible layers to invisible and all invisible layers to visible. The active 

layer is always visible. 

New main layer group 

Creates a main layer group at the end of the layer list. 

Settings > Display used layers only 

Layer management is reduced to the layers used. 

Settings > Further CAD layers from all views 

This option is only required in views of the category view, section and detail. You 

have defined further layers under the heading "Further CAD layers" in a calculated 

view. You have switched to a different view and require the same layers in this view. 

The layers are currently not displayed, however, as they do not contain any data. This 

function searches for defined layers in all created views. 

Settings > Modify display with "Assemble all" 

If this function is active, the visible layers are shown for the ASSEMBLE function. 

Settings > Include sub objects (such as windows) in modify 

The sub objects are included when this function is active. If a layer is modified for a 

wall, the sub objects windows, doors and wall openings are also modified. 

Settings > Change current layer when editing 

When editing objects (e.g. by clicking) the corresponding layer is displayed in the layer 

management- If this setting is enabled the layer of the selected object remains as active 

layer. Otherwise, the previous layer is restored after editing of the object is completed. 



Chapter 1 – Managing and organising  

www.elitecad.eu  43 

Layer name context menu 

 

Hide/assemble 

The HIDE or ASSEMBLE function appears depending on whether the layer is visible 

or invisible. 

Assemble alone 

Activates the layer and hides all other layers. 

Lock 

Locks the layer. 

Select 

All elements/construction parts that belong to the marked layer are marked in CAD. 

This selection can be used for a manipulation. 

Rename 

Modify a layer name. 

Delete 

Deletes the layer. If data has been allocated to the layer, the layer is stored under the 

heading "Further CAD layers". A layer under the heading "Further CAD layers" may 

not be deleted if data is still allocated to the layer. 

New layer 

Creates a new layer. The name can be edited straight away. The insert location depends 

on the sorting. The layer is created directly beneath the selected layer for "user-

defined" sorting. 

New layer group 

Creates a new layer group (such as Architecture), which can contain a number of 

layers. 

Filter 

A filter is an instrument used for switching a certain subset of layers to visible, 

invisible or visible alone. 

Filter management header functions 

 

New filter 

 

A query appears if an empty filter or a filter with all visible or invisible layers should 

be created. 
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Additional layers can be dragged into the filter using drag and drop. 

Delete filter 

 

The selected filter is deleted. 

Filter management context functions 

 

Hide 

Hides all layers of the filter. If the active layer is included, it stays switched on. 

Assemble 

Displays all layers of the filter. 

Assemble alone 

Only the layers of the filter are displayed. If the active layer is not contained in the 

filter, the first layer of the filter is activated. 

Select 

All elements/construction parts that belong to the layers in the filter are marked. This 

selection can be used for a manipulation. 

Rename 

Modify the filter name. 

Delete 

Deletes the filter. If the context menu is called up for an inserted layer, the entire filter 

is not deleted but only the individual layer from the filter. 

New filter 

Creates a new filter. 

CLASSIFICATION 

Classification management is described with examples from ELITECAD Mechanics. 

Classification management 

The classification manager supports working with classifications and models. 

The classification management opens with a single click on the CLASSIFICATION 

function. 
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Classification management header functions 

 

List view / hierarchical view 

 

This function switches between the list view and the hierarchical view. 

Selection mode 

 

This function activates and deactivates the selection mode 
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Sorting 

 

 

Using the sort function, the lists can be displayed in ascending or descending order. In 

the list view, the categories model, group, class, and level have a fixed position and 

will not be resorted. 

   

List view – visibility 

Meaning of the symbols 

 

 The adjacent name has been chosen in the manager 

 All models with this name are completely visible 

 All models with this name are completely invisible 

 Some models with this name are visible 

 One of 58 models with this name is visible 
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  The symbol at the category indicates the overall state 
 

By clicking on the eye icon, the models associated with the adjacent classification 

name are set to visible and simultaneously displayed in the manager as active (filter 

symbol). 
 

The visibility of models in other categories results from logical relationships, 

indicating how many models are visible with the given name. If all models with the 

given name are visible, an open eye is displayed, if not all models are visible, the entry 

gets a greyed-out eye and if no models are visible, a closed eye is displayed. The two 

numbers at the end of each entry also indicate how many models are visible with the 

given name and how many exist in total. 
 

It should also be noted that at least one name of a classification must be active, which 

manifests itself in the fact that the last active name of the current classification cannot 

be switched invisible. 

List view with selection mode 

By clicking on the symbol shown, the selection view can be switched on or off. 

 

Meaning of the symbols 

 

 The adjacent name has been chosen in the manager 

 No model with this name is selected 

 All models with this name are selected 

 Some models with this name are selected 

 51 out of 58 models with this name are selected and 58 are 

visible 

   The symbol at the category indicates the overall state 
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Similar to the visibility view, individual names can also be selected in selection mode 

by clicking on the checkboxes. The rest of the control is analogous to the visibility 

mode. 

List view – multi selection 

A selection is unique within a category. If, in addition, a selection is made in a further 

category, those objects that fulfil one of the selected criteria are set to visible or active 

(not all). 

Tree view - visibility 

By clicking on the symbol shown, you can switch to the tree view. 

 

By clicking on the symbol shown, you can switch to the list view. 

 

Meaning of the symbols 

 

The icons in the tree view are the same as in the list view. 
 

A "check mark" for an entry means that this entry has been activated by the user and 

that the selected hierarchy is visible. All states of the subordinate models result from 

logical contexts. If, for example, the class in-house is active, all the entries below will 

be displayed as visible. Conversely, all entries would be invisible if an entry above 

them has been deactivated. 

The further down in the hierarchy levels, the more special is the selection for the 

visibility, whereby it is possible to specialize down to the model name. 
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The hierarchical arrangement of the classifications in the manager enables a multitude 

of logical operations and makes working with the models easier. 

Tree view with selection mode 

By clicking on the symbol shown, the selection view can be switched on or off. 

 

Meaning of the symbols 

 

Similar to the visibility mode, individual names can also be selected in selection mode 

by clicking on the checkboxes. The selection of the hierarchically subordinate 

classifications or models results from logical relationships. If a hierarchically higher 

entry is activated (marked with a check mark), all subordinate entries are also selected. 

The further down in the hierarchy levels, the more special is the selection for the 

selection, whereby it is possible to specialize down to the model name. 
 

TIP 
If a model is not highlighted in the graphics window after being selected 

in the manager, it may be due to the fact, that this model was previously 

hidden in the visibility mode.  

Tree view - behaviour 

For the operation of the classification manager, there are certain restrictions, which are 

due to logical relationships and which must be taken into account. 

E.g., at least one entry must be active per branch. 
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In the example above, the class in-house (and thus all models with this class name) 

could not be deactivated by clicking, since the level bearing is already active and 

therefore all subordinate entries have also been automatically selected. The tick at the 

class in-house represents only a specialization of the selection. If you clicked on the 

level bearing in this case, the specialization would be omitted and all subordinate 

entries from the level bearing would be selected - both in-house and DUMMY-POS. 
 

The same behaviour applies to the visibility mode, whereby an exception applies to 

the selection mode, that at the hierarchy level of the levels, the last active entry can 

also be deactivated (with a simple click), whereby nothing would be selected. 
 

The following example shows the specialization when setting the visibility in the 

classification manager. 

    

In the first graphic the classes DUMMY-POS and in-house are activated. 

If the user specializes in the selection of the visibility (as shown in the second graphic) 

by the group turned parts (by clicking on the eye symbol), the class DUMMY-POS 

automatically falls out of the selection of visibility, because it was further specialized 

by clicking on the desired entries. Thus, all models with the classifications bearing/in-

house/turned parts are now visible, which is represented by an open eye in the 

manager. If now another specialization would take place at the level of the model 

names, only these selected models would be visible. 
 

The same behaviour of the automatic activation or deactivation of neighbouring and 

subentries also largely applies to the selection mode. 
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TIP 
If you only want to switch already in advance e.g. special models names 

to visible or to select, you can start directly with the specialization at the 

desired classification level. Hierarchically higher classifications are 

automatically activated by the manager.  

Classification manager context menu 

Depending on the position of the mouse pointer (over a classification name or group), 

different functions may be active or permitted. 

 

Show / Hide 

Depending on whether all models with the selected classification are visible or 

invisible, the function HIDE or SHOW appears. All models with the selected 

classification are set to visible or invisible. 

Invert visibility 

The visibility of all models with the selected classification is inverted. 

Select / Deselect 

Depending on whether all models with the selected classification are selected or not 

selected, the function SELECT or DESELECT appears. All models with the selected 

classification are added to or removed from a selection. This selection can be used for 

further manipulations. 

Invert selection 

The current selection is cancelled. All models that do not belong to the current 

selection are defined as a new selection. The new selection can be used for further 

manipulations. 

Rename 

This can be used to change the name of the classification of the model. 

 

This affects all models with the same classification name. 
 

TIP 
If the desired entry is already selected in the manager, just click on the 

entry again to automatically start the renaming.  

Modify classification 

Opens a dialog to change the classification of a selection. If no models have been 

selected when calling the function, a query appears to indicate a selection. 
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Assigning classifications by drag and drop 

Drag and Drop provides the ability to change classifications quickly and intuitively 

without using the CHANGE CLASSIFICATION dialog. In this case, the 

classifications are changed by simply dragging classification names from the manager 

to the desired models in the graphics window. Two variants are available. On the one 

hand, the possibility of pre-selection of the models to be changed and on the other hand 

the dynamic selection during the drag and drop process. 

Drag and Drop with pre-selection 

First, select the model to be changed (via manager or by selecting in the graphics 

window via mouse) 

  

Select the new classification in the manager and drag the entry into the graphics 

window with the left mouse button pressed. 

  

Release left mouse button on selection. 
 

The group name in-house will be replaced with the group name purchase for all models 

of the selection. 
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During the process, current information is displayed in the status bar, e.g. Copy all 

selected classifications. After the button has been released: All selected classifications 

were copied. 

If the drag and drop is started from the tree view, all hierarchically superior 

classification names (beginning with the entry from where the drag-and-drop was 

started) are also automatically transferred. If only the current classification name 

(selected in the manager) is to be transferred, the <Ctrl> key must also be held down 

during the drag and drop process. 

If the drag and drop is started from the list view, then only the name of the 

classification selected in the manager is transferred. 

Drag and Drop without pre-selection 

In this case, no preselection of the models to be changed is required, since this is done 

automatically during the drag and drop process and displayed to the user. 
 

Select new classification in the manager and drag the entry into the graphics window 

with the left mouse button pressed. 

  

During drag and drop, the model is highlighted at the current mouse position. 
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Releasing the left mouse button changes the classifications. 

Modify creation filter of a view 

 

With the filter symbol,  the creation filter of a view can be changed quickly and 

easily afterwards. To do this, switch to the desired, already created view with the filter 

icon displayed in the toolbar of the manager. After pressing the button, the view's 

filters can be adjusted by setting the individual classifications in the manager visible 

or invisible. The process is completed by pressing the confirmation button (green 

flashing) in the manager toolbar, which updates and displays the view. 

 

New classification 

 

Structure toolbar 

 

This function is used to set the model, group, class, and layer name, provided, that the 

"group / class / level selection" check box is set in the OPTIONS. 

After activating the function, the names for model, group, class and level can be 

entered in the dialog window displayed. All already defined values can be selected via 

the combo box. 
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New group 

 

Structure toolbar 

 

This function sets a new group and starts a new model. New group means that, 

although the group name remains the same, an intrinsic coupling is set for the 

following new models. This means that this group can be manipulated independently 

of other groups with the same name. 
 

REMARK 
If a group is copied, the copy is automatically a new group and can be 

manipulated later, regardless of the original group.  

Select classification 

 

Structure toolbar 

 

This function is used to set the model, group, class, and layer name, provided, that the 

"group / class / level selection" check box is set in the OPTIONS. 
 

After activating the function, the names for model, group, class and level can be 

entered. The values must be entered in the correct order and separated by "," in the 

input line. Thereafter, a new model is automatically started. 
 

TIP 
If some values are equal to the current classification, only the changed 

names are to be specified. The current classification is displayed at the 

bottom of the screen. To delete an existing classification name, a blank 

must be entered. 

To preserve an existing classification name, place a comma. (For 

example, if the group should be preserved, the input looks like this: 

model,,class,level.  

Modify classification 

 

Structure toolbar 

Modify menu > classification 

This function is used to set the model, group, class, and layer name subsequently, 

provided, that the "group / class / level selection" check box is set in the OPTIONS. 
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After activating the function, the names for model, group, class and level can be 

entered in the dialog window displayed. All already defined values can be selected via 

the combo box. 

 

TIP 
To delete an existing classification name, a blank must be entered. 

If no selection is made, this function refers to the current model. 

This function can also be called by double-clicking on the classification 

in the status bar. 

If a model is selected, this function is also available in the context menu.
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1.7 MATERIALS 

A material consists of surface properties and it can be allocated to an object or a 

surface. Surface properties include texture image, transparency and mirroring. The 

materials make it possible for 3D CAD data to be displayed in visualised quality. The 

materials can be defined in the parameter dialog window when creating the 

construction parts or allocated afterwards via drag and drop from materials 

management. 

Predefined materials for objects 

A function for materials allocation is offered in the respective parameter dialog 

window. 

ELITECAD Architecture 

 

ELITECAD Mechanics 

 

Users can toggle between material mode and colour mode. 
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Material mode     Colour mode 

ELITECAD Architecture 

   

ELITECAD Mechanics 

   

If a material has been defined, it has priority. The entire material name must be deleted 

in order to display the colour again. 
 

If you are currently in material mode, left-click the selection button to access the 

material database. 

     

ELITECAD Architecture   ELITECAD Mechanics 
 

In this selection dialog window, you can click on a material of your choice that is then 

transferred to the entry field. 

Up 

 

Click on the "Up" symbol to access the higher-level folder. 

Continue/back 

 

If a folder contains a large number of materials, these two buttons are used for scrolling 

through pages in the graphics preview. 
 

TIP 
You can display the full material name by right-clicking on the "Material 

selection" button.  
 

A material can be entered into the entry field via drag and drop directly from materials 

management. To do this, the parameter dialog window and Materials management 

must be open. 

To delete a material from the dialog window, simply delete the name from the field. 

Switching to the colour mode is not sufficient. 
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TIP 
The material can be saved along with all of the other properties from the 

parameter dialog window under menu item RECORD > SAVE.  

MATERIALS MANAGEMENT 

 

View toolbar 

View menu > Window > Material 

Materials management is used for organising and selecting materials. Each material 

has properties such as texture image, transparency, mirroring, shine, etc. that can be 

set in the Materials editor. 

Materials management can be opened via the menu VIEW > WINDOW > 

MATERIAL. 

 

Header functions 

The top row populated with functions in the 

management window. 

Left mouse button 

The subfolders are displayed by double clicking on 

a folder icon. If there are no subfolders, the 

materials are visible. These can be allocated via drag 

and drop. 

Right mouse button 

Various options that are described in detail below 

can be called up by clicking once on a folder, 

material or background. 
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Header functions 

 

Folder 

 

If this button is pressed, the materials management window is divided and the folders 

displayed in an Explorer view in the bottom half. 

 

Further structures are displayed or hidden by clicking once on the plus or minus sign 

preceding the main titles. If you click on the folder itself, either the subfolders or the 

materials it contains are displayed at the top. 

Up 

 

Click this button to return to the higher-level folder. 

Hierarchical/flat display 

  

The respective materials are initially displayed in the bottommost folder in the 

"Hierarchical view" (default setting). In "Flat display", however, all materials are 

visible in the same window regardless of the folder they belong to. 

This button is only available in the drawing, image and temporary materials "filter". 

Filter 

The materials are always saved in a database. It may be the case that materials that 

have not yet been stored are present in a drawing. This may be a result of an external 

drawing or new materials that you have not yet saved to the database. 
 

The display of the folders and materials in the management window can be controlled 

in different ways using this toggle key. 
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All materials 

 

This switch setting always displays all of the materials, regardless of whether they are 

present in the database or not. 

Materials database 

 

Only displays the materials that are not yet saved in the database. 

Drawing 

 

Only displays the materials that are used in the drawing. 

Image 

 

Only displays the materials that are assembled in the drawing. 

Temporary materials 

 

Only displays the materials that are not yet saved in the database. 

Sort ascending/descending 

  

Change the sorting to alphabetical order. 
 

TIP 
The management window can be refreshed by pressing [F5] 

  

Assignment mode 

There are various allocation options for allocating the construction parts with 

materials. The surfaces are allocated differently depending on the switch setting. The 

same options can be used for material to be deleted, which deletes the materials again. 
 

EXPLANATION 
Materials are allocated via drag and drop. Left-click a material from the 

management, hold down the mouse button and drag the material to the 

object or surface that is to receive the material. Depending on the current 

allocation mode, the material is then additionally allocated to multiple 

surfaces, e.g. all surfaces in an object.  

On object 

 

If the allocation mode is set to object, the entire object is allocated with the material 

unless it is an "intelligent" construction part such as a window or a door, etc. 
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Although these are objects, a distinction is made depending on whether the material is 

allocated to a frame, window sill or glass, etc. 

For partial object 

 

The material always only occupies parts of an object. 

On surface 

 

Only occupies individual surfaces. Users should note that the allocation disappears if 

the object is edited and modified. 

Replace 

 

If this switch is active, the material that you drag to a surface with drag and drop is 

allocated to all surfaces that have the same material or colour as this surface. 

On selection 

If you want to allocate a material on a specific selection, you can make a prior selection 

on the screen and drag the material into the selection. It does not matter which switch 

setting is currently active. 
 

TIP 
If you want to allocate the same material to multiple surfaces or objects 

etc., there is a multiple allocation function. Drag the material onto a 

surface as normal. However, instead of releasing it, press the [Shift] key 

on the keyboard or the "+" sign. Click and hold down the mouse and 

move it to a different surface before pressing one of the two buttons. 

This can be repeated any number of times.  

Right-click functions 

Different submenus are displayed by right-clicking a folder, material or background. 

Right-clicking a folder 

The following submenu opens. 

 

EXPLANATION 
The materials are saved in ELITECAD either as "user" or "global". This 

depends on the active storage type of the parameters under SETTINGS 

> OPTIONS > SYSTEM > CONFIGURATION. 
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This switch setting is also used for deleting. If a material has been saved 

as "global", it cannot be deleted as "user" or vice versa. A copy is created 

when renaming a "global" material as "user".  

The occurrence of a material can be read in quick info. 

  

Rename 

Folder names can be changed. 

Delete 

Folder can be deleted together with their entire contents. 

Create copy of folder 

Creates a copy of the folder including the entire content. 

Save folder content in DB 

Saves the entire contents of the folder, depending on the "Storage type", in the 

database. 

Export folder content 

The folder content can be exported as a file. This line type can be reimported on a 

different workstation or in a remote office. 

Select material over surface 

See "Right-clicking on the background". 

Edit material over surface 

See "Right-clicking on the background". 

Properties 

Displays the properties of the folder. 

Right-clicking a material 

The following submenu opens: 
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Edit 

The Materials editor opens. 

Rename 

Materials can be renamed. 

Delete 

Materials can be deleted. 

Texture preview 

The original image is displayed. 

  

Create copy of material 

Creates a copy of the material. 
 

TIP 
If you want to select multiple folders or materials simultaneously, you 

can do this either by holding down [Shift], [Ctrl] or by dragging a 

rectangle over the folders and materials. The context menu is shortened.

  

Export material 

Materials can be exported as a file. These files can be reimported on a different 

workstation or in a remote office. 

Select material over surface 

See "Right-clicking on the background" 

Edit material over surface 

See "Right-clicking on the background" 
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Show material assignments 

All objects, sub objects or surfaces, where this material is assigned, are selected. 

Properties 

Displays the properties of the material. 

Right-clicking on the background 

The following submenu opens: 

 

View 

A menu appears beneath "View" in which the appearance of materials management 

can be modified. 

 

Large symbols  Small symbols  List 

   

Create folder 

Creates a new folder in the folder in which the menu item is called up. 

Import material 

Imports material data that was either exported from materials management (*.mydmp) 

or saved as parameters (*.par) in Messerli VIS (up to Release 12). 
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Select material over surface 

If this point is selected, a material in the drawing can then be clicked on that is 

displayed directly in the management window. (Blue frame) 

If a surface is selected, that does not have any material but rather a 3D colour, a 

message is displayed. 

 

Selecting "Yes" automatically generates a new material that can then be processed. 

The function is cancelled by selecting "No". 

Edit material over surface 

This option functions in exactly the same way as "Select material over surface", with 

the difference that the Materials editor opens straight away for making changes to the 

settings. 
 

TIP 
These two options are very useful for finding the material that has 

already been used and for editing it straight away if required.  

  

Align texture 

This function is used for orientating a texture on an edge that can be selected. The 

exact description of this function can be found in the chapter Layout > Material > 

Align text. 

Align text globally 

This function is used for orientating multiple textures on an edge that can be selected. 

The exact description of this function can be found in the chapter LAYOUT > 

MATERIAL > ALIGN TEXTURE GLOBALLY. 

MATERIALS EDITOR 

All properties that a material displays such as image texture image, transparency, 

mirroring, shine, etc. can be set or modified in the Materials editor. 
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If a material that is saved in a database is modified in any way and you are currently 

in the "All materials" or "Material database" filter, a query appears asking whether a 

modification should be saved. 

The new settings are saved by clicking "Yes". If this is done under the storage type 

"user", the "global" material is retained. If the material is deleted as "user", the "global" 

material appears. If this is done under the storage type "global", an additional message 

appears informing the user that a global material is being modified.  

If "No" is selected, a copy of the material is created and allocated automatically in the 

drawing. This material is a temporary material for now and can be saved in the 

database. 

 

However, if you are in the "Drawing" or "Image" filter and modify a material that is 

located in the database, the material is replaced automatically and assigned to the 

drawing. The material name is modified. 
 

TIP 
Please note the quick info for each material. 

  

Please also note that all parameter modifications affect the material itself and have an 

impact on all surfaces that are covered with this material. 
 

The dialog window is always divided into three parts.  
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Left area 

In the left area, you can see which effects have been allocated to a 

material. If one of these effects is selected, its properties are 

displayed in the middle area. If no effect but rather the name of the 

material is selected, all effects that are available to be selected 

become visible in the middle area. 

 

 

 

 

 

 

Middle area 

Properties     Effects selection 

    

Right area 

There is a small preview window in the right-hand area where any 

changes to the material are visible. 

The following selection options are available for the preview via the 

selection list beneath the preview window. 
 

Surface:      Cube:  Torus:   Sphere:       Cylinder: 

     
 

 This button defines if shaders are used for the preview. 
 

If the option REFRESH AUTOMATICALLY is active, a change to 

a material is directly visible on the design model. If it is inactive, it 

is only refreshed after confirming with "Apply". 
 

If the option ANIMATED PREVIEW is active, a preview window is opened, where 

the material is displayed on a rotating object. The rotation stops by clicking the little 

square in the right bottom corner or if the mouse cursor is placed over the preview 

window. The slider position defines the number of images per second. The window is 

resizable in order to achieve a bigger preview. 
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Base colour 

 

Base colour 

There are multiple selection options for the base colour. The colour selected is always 

displayed with the RGB values. 

RGB 

 

The values can be entered directly into the entry fields or set with the slider. 

 

The standard Windows colour dialog box appears when clicking on the colour button. 
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Colour from screen 

 

The cursor switches to a pipette symbol by clicking on this button. You can now click 

on any surface in the graphics window or in the preview window. This colour value is 

then set. 

M-NCS 

 

Switch to the M-NCS view by clicking the right-hand selection button. 

 

M-RAL 

 

You can select an M-RAL colour by clicking the right-hand selection button. 

Pen 

 

The pen number can be entered directly into the entry field and you can proceed to the 

Pen selection menu by clicking the selection button. 
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Intensity 

 

You can change the brightness of the base colour with this slider. 

Across objects 

 

This option is only used in ELITECAD Architecture. If the option is selected, materials 

that are the same are rendered to overlap for surfaces that meet. For performance 

reasons, this option may only be selected for materials that have a continuous pattern 

(exposed masonry, timber formwork). 

This button only works if "Textures across construction parts" is active in the 

OPTIONS (menu SETTINGS > OPTIONS > WORK PARAMETERS > 

ARCHITECTURE). 

Texture 

The texture effect offers you extensive options for modifying the characteristics of 

image files or for making modifications yourself. 

 

Image 

 

Select image 

 

Opens the standard Windows dialog using which you can select an image file as a 

texture image. 
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The following file types can be selected: *.tif, *.jpg, *.bmp, *.gif, *.png 
 

EXPLANATION 
Each texture that is loaded by the program when rendering uses internal 

memory. Users should note that the textures should not be overly large 

in terms of their data volume depending on whether they want to view 

the design model from a distance or close up.   

Delete image 

 

Deletes a previously selected image. A confirmation prompt appears to ask you 

whether you really want to delete the image. 

Edit image 

 

Opens the textures manager. 

 

There are different options for changing the texture image in terms of its size or colour. 
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Trim texture 

You can reposition the texture on the margins of the preview image or on the trim lines 

themselves. If you then perform the function TRIM, the image is reduced in size and 

the image cutout enlarged. You can repeat this until the procedure is confirmed with 

OK or cancelled with CANCEL. 

 

The new dimensions (pixels) are revised on a continuous basis and can be entered into 

the entry field manually. 

 

If the option MAINTAIN XY is activated, the trim lines are fixed in their positions 

and can be moved all together. 

 

Gamma correction 

A gamma correction is a change to the colour balance between the separate base 

colours red, green and blue. 
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The values can be entered directly into the entry fields or set with the slider. If the 

option CONNECT is activated, the three sliders are connected. 

You can zoom either with the mouse wheel in the preview image or with the slide on 

the right-hand side. The image section can also be moved by left-clicking it. 

Brightness/contrast 

Modifying the brightness and contrast of an image has an impact on highlighting, 

shadows and mid-range colours. This function is normally used to correct images that 

are too bright or too dark. 

 

The values can be entered directly into the entry fields or set with the slider. 

You can zoom either with the mouse wheel in the preview image or with the slide on 

the right-hand side. The image section can also be moved by left-clicking it. 

Texture filter 
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Textures that display brightness fluctuations close to each other and are very small can 

appear with the so-called moiré effect from a certain distance. This is often the case 

for exposed masonry or flagging. 

If, for example, the joints are smaller than a pixel on the monitor, the graphic/video 

card and the monitor decide randomly whether a bright or dark pixel is used. To avoid 

this effect, the texture filter can be set to "Simple", which performs a special kind of 

smoothing on the texture and corrects the moiré effect. If this effect is still visible 

despite the simple filter, it can be set to "Tri-linear". 

Note that these options increase the memory requirements and the rendering time. 

Therefore, only use it when necessary. 
 

Without texture filter   with texture filter 

   

TIP 
Texture filters are only applied for image rendering if the option 

TEXTURE FILTER IS SELECTED in the render parameters.  

Division 

There are various settings options for displaying materials realistically in the geometry 

in terms of size and scaling. 

Tiled 

 

The real size of the texture image can be entered here. The entry always refers to the 

entire texture image. If you no longer know what the original image looks like, you 

can display it as a Texture preview here. 

If the option MAINTAIN XY is set, the fields for width and height are linked. 

If the box "Repeat" is activated, the texture image is laid over the surface multiple 

times. 

Users can specify under "Mirroring" whether a material mirrors or not when covering 

a surface. 
 

EXPLANATION 
Unlike the process for rendering a solid image, which uses the graphic 

card, the rendering is performed via the ELITECAD software. As the 

hardware does not feature all functions for rendering the texture image 
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in all variations, there may be optical differences between the two 

rendering types. 

To ensure that the material appears in its final version, the image should 

be rendered from time to time. Alternatively, area rendering can be used 

to avoid having to render the entire image.   

Number 

 

The number of repeats can be entered here. The material is displayed on the surfaces 

using these inputs. 

If the option MAINTAIN XY is set, the fields for the number X+Y are connected. 

Under "Mirroring", users can specify whether a material is alternately mirrored when 

allocating. 

Stretched 

 

The material is always projected onto the entire surface with this option, regardless of 

how large the surface is. 

Position 

Settings can be made here to specify the position of the texture on the geometry.  

 

If the option MIRROR HORIZONTAL is selected, the original image is folded on the 

horizontal axis. 

   

The texture image can be rotated between 0° and 360° using the function ROTATE 

ANGLE.  

For example, a formwork with a horizontal orientation can be displayed diagonally. 
 

Rotation angle 0°   Rotation angle 45° 
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The texture can be moved to a surface using the "Move" entry fields. 
 

Without shift    with shift 

  

Blue screen 

It is possible to switch a specific colour or a texture to transparent via the blue screen 

procedure. This function is especially suitable for displaying people, animals, plants 

and objects, etc. without displaying their background. This material must have a 

single-colour background or an alpha channel that is then transparently rendered to 

make a person or background visible, for example. 

This effect is only available if a texture is available. 

 

Colour 

   

The type of transparency can be set if the option BLUESCREEN ACTIVE is selected.  
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The transparency values are applied directly from the texture bitmap for the setting 

"Alpha channel".  

A colour can be selected for the COLOUR setting that is to be rendered transparently.  

The standard Windows colour dialog opens via "Colour selection button". In this case, 

it makes more sense to use the pipette. 

You can click on any surface in the work area or in the preview window and this colour 

value is then set. 

Use the "Tolerance" slider to control the accepted difference of a colour to the 

transparency colour. 

Example: 

Tolerance 0 %   Tolerance 30 %  Tolerance 80 % 

     

The material can then be allocated to a surface. It is best to use a freestanding surface 

that corresponds with the surfaces of the texture in its dimensions.  

You can set the texture to cover an entire surface automatically by selecting the 

division "stretched" in the texture settings. 
 

TIP 
If your texture is not already displayed in front of a neutral background, 

you can use various image-processing programs for changing the colour.

  
 

TIP 
Ensure that the background colour is not used in your actual image, as 

there may be holes at these locations otherwise.   

Bump map 

As textures are based on two-dimensional images, they always appear "flat" when 

being rendered, i.e. with no illusion of depth. This kind of effect can be achieved with 

the bump map effect. 

The depth structure is generated from bright and dark areas of the texture image. 
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Image 

 

You will find the description for loading, deleting, editing and filtering under Texture. 
 

Link with texture 

   

You can use this option to define whether the image that you have selected under 

Texture is also to be used as a template for the bump map.  

This means that if the little padlock is locked (red), the image and the settings are the 

same for the texture and the bump map.  
 

TIP 
This option can be accessed if a texture image is already present. If the 

settings such as size and moving are modified for the texture, this also 

occurs automatically for the bump map.   
 

If the little padlock is unlocked (green), the image file that was loaded for this is used 

for the bump map.  
 

TIP 
This can also be used to create an illusion of depth for a material that 

does not have its own texture image.  

Depth 

 

The bright and dark areas are displayed with different depths depending on whether a 

negative or positive value is entered. For example, bright areas face outwards and dark 

areas inwards. 
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Example with texture image and bump map 

Without depth     with positive depth 

  

Example without texture image and bump map 

Without depth     with negative depth 

  

The other settings such as segmentation and position are described under Texture. 
 

TIP 
The darker the texture image, the less visible the illusion of depth. This 

can be compensated with an additional shine effect.  
 

TIP 
The bump map is only applied for image rendering if the option BUMP 

MAPPING is selected in the render parameters.   

Transparency 

The transparent properties for a material can be specified here. 
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Intensity 

 

Use this slider to define the intensity of the transparency. 

Colour 

 

A special "transparency colour" can be selected that can be different from the base 

colour. The standard Windows colour dialog opens. 

The function BASE COLOUR PART controls the share of the base colour part for the 

transparency. If the slide is set to 0, the "transparency colour" is applied. If the slider 

is set to 100, only the base colour is used. 
 

TIP 
The option COLOUR is only visible if the "Extended" check box is 

activated. 

  

Refraction 

If a light beam hits a boundary surface of two materials with a different refraction 

index, e.g. air and water, it is "bent", which means it changes its direction. The light is 

"refracted" at the border surface of the two materials. 
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The refraction index can be changed from 0.5 to 1.5 with the slider. The value 1 is 

neutral. 
 

Example with value 1    Example with value 1.33 for water 

  

TIP 
The refraction is only applied for image rendering if the option 

MIRRORING, REFRACTION is selected in the render parameters.  

Absorption 

No light is absorbed behind the transparent surface for the value 0. It is dark behind 

the surface for the value 100.  
 

TIP 
The option ABSORPTION is only visible if the "Extended" check box 

is activated. Does not apply for windows and glass elements. 

  

Mirroring 

The mirroring properties for a material can be specified here. 
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Intensity 

 

Use this slider to define the intensity of the mirroring. 

Colour 

 

A special "mirroring colour" can be selected that can be different from the base colour. 

The standard Windows colour dialog opens. 

The function BASE COLOUR PART controls the share of the base colour part for the 

mirroring. If the slider is set to 0, only the "mirroring colour" is applied. If the slider 

is set to 100, only the base colour is used. 
 

TIP 
The option COLOUR is only visible if the "Extended" check box is 

activated. 

  
 

TIP 
The mirroring is only applied for image rendering if the option 

MIRRORING, REFRACTION is selected in the render parameters.  

  

Shine 

The shine properties for a material can be specified here. 
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Surface presets 

 

Predefined shine settings for various material types simplify the configuration of shine. 

Intensity 

 

Use this slider to define the intensity of the shine. 
 

TIP 
The intensity can be overridden by up to a value of 600. Enter the 

corresponding value into the entry field.  

Brightness extent 

 

You can specify the width of the shine points with this slider. 

Colour 

 

A special "brightness colour" can be selected that can be different from the base colour. 

The standard Windows colour dialog opens. 

The function BASE COLOUR PART controls the share of the base colour part for the 

shine. If the slider is set to 0, only the "brightness colour" is applied. If the slider is set 

to 100, only the base colour is used. 
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TIP 
The option COLOUR is only visible if the "Extended" check box is 

activated. 

  

Shader values 

 

Visualisation of shine is also possible in real-time visualisation mode. It is necessary 

to activate shader technology first (see chapter SETTINGS > IMAGE PROPERTIES). 

Select individual values and modify the values using the slider. Modifications are 

displayed immediately if the preview is enabled. 

Reflection 

The reflection properties for a material can be specified here.  

This effect is only available if a shine is available. The appearance of the reflection 

points depends on the shine and light settings. 

 

Extent 

 

The higher the value you specify, the more likely it is that shine points will be 

generated. 
 

Extent 0 %     Extent increased 
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Intensity and size 

 

The higher the value you specify, the more intense the shine points generated. 
 

Low intensity     intensity increased 

  

Rays 

 

The rays are arranged in random order if this option is selected. 

Illumination 

You can specify the illumination of a specific material here. 
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Intensity 

 

Use this slider to define the intensity of the illumination. 

Colour 

 

A special "light colour" can be selected that can be different from the base colour. The 

standard Windows colour dialog opens. 
 

TIP 
The option COLOUR is only visible if the "Extended" check box is 

activated. 

  

Shadow 

You can set the shadow parameters of a material here. 
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Cast shadows 

 

A material casts shadows if this option is selected. 

Receive shadows 

 

Shadows are cast on the material if this option is selected. 

Shadowing only 

 

If this option is selected, the material is switched to transparent but still receives 

shadows if the option RECEIVE SHADOWS is selected. 
 

TIP 
This option is especially suitable for displaying a shadow cast by 3D 

objects on a background. Draw a surface under the objects and allocate 

a material for which "Shadowing only" and "Receive shadows" is 

activated. The colour of the material should preferably be white. 

  
 

"Shadowing only" inactive   "Shadowing only" active 

  

Shader 

Here you can set the shader parameters of a material. 
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Shaders generate material visualisation on 3D surfaces in real-time. Surfaces with 

complex structures and depth effects are depicted on flat surfaces, which only need 

little memory. This process takes place on the graphics card and therefore enables huge 

performance gains. 

Name 

 

Here you can select the shader type. There is a predefined number of shaders for 

several material types available. 

Settings 

In this section, the parameters of the respective shaders are configured. The parameters 

displayed depend on the type of the shader. 

Changes of parameters are immediately displayed in the preview window or in the 

model if the option is set. 

Filter for parameters 

 

By entering a text, only the values, which fulfil the search criteria, are shown. 

Values 
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In this area, a description of possible values of the selected parameter is displayed. 

Skybox 

 

A skybox, also called skymap, is a background image, which automatically adjusts 

according to the viewing direction. In contrast to the static background images, which 

only work for one camera position, a skymap can be used for 360° views. Landscape 

images and views of the sky work particularly well. One can even take their own 360° 

picture via app or 360° camera of the future building site and load it into ELITECAD. 

 

Configure skybox / skymap 

 

Depending on the type of the image, multiple options can be selected. The button opens 

a dialog window where the image can be configured. 

Skybox 

Skyboxes usually consist of the six sides of a cube. ELITECAD tries to identify the 

six sides automatically. The markers indicate where the sides are connected. 
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This button starts an automatic identification of the sides. 

If the automatic identification does not deliver the correct positions, the six squares 

can be arranged manually in the graphics window. 

Skymap 

A skymap is a panorama image either on a cylindrical or on a spherical surface, which 

encloses the model. 

  

The panorama can be positioned horizontally in order to align the orientation of the 

model with the panorama image. 
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1.8 LIBRARY 

Library management 

 

View toolbar 

View menu > Window > Library... 

Library management allows you to search for a library part via the file structure and 

offers you a graphic preview for selection (similar to the explorer). A library part can 

be selected by selecting the preview graphic. Not only the parts saved as a library part 

but also ELITECAD drawings and external 3D formats (i.e. SketchUp, 3DS) are 

displayed in management. 

 

The option SCALING enlarges or reduces the 

library part to the corresponding scale of the 

drawing (only valid for ELITECAD drawings). No 

scaling is required in most cases for plan elements 

graphics (header, north arrow). 

If the option RECENTLY LOADED is selected, 

the most recently loaded library parts are loaded in 

the preview area and the background of the folder 

structure is set to grey. 

 

The management window is divided into two areas. 

The preview of the library parts is displayed in the 

upper field. The folder structure is shown at the 

bottom. The folder structure is displayed from a 

root directory. 

Root directories can be added, for example for the 

parts used in the office or for own parts. 

  

 

The drawing can be manipulated accordingly using the functions from the 

Load/position properties bar before being placed. 
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Properties bar for loading/positioning 

 

The properties bar becomes visible as soon as you insert a file, library part, graphic or 

data from the clipboard into the drawing. Data can be mirrored, rotated or scaled before 

they are placed in the drawing. 
 

 
Align to area/terrain 

 
Align on a line 

 
Align automatically to element 

 
Next point of reference 

 Current library part name 

 
Rotate 

 
Mirroring 

 
Scale 

 
Free selection of reference point 

  
Rotate on X/Y axis 

Align to area/terrain 

 

The library parts are automatically aligned by on a surface with this option. If this is a 

terrain surface, the library part retains its reference to this surface after modifications. 

If the library part is located within a room and has the option ADJUST TO 

(FINISHED) FLOOR HEIGHT IN ADDITION, these parts are also adjusted to the 

new height of the room. 

Align on a line 

 

A start direction and then the end direction are defined after placing the library part 

with the function ALIGN ON A LINE. The library part is rotated on the positioning 

point from the start direction to the end direction. 

Align automatically to element 

 

The selected library part is rotated to the element and a preview is displayed. The 

library part may be displayed on the other side depending on which side of the line the 

cursor is located. The position is confirmed with the left-hand mouse button. 



Chapter 1 – Managing and organising  

www.elitecad.eu  94 

Next point of placement 

 

If a library part has been defined with various points of placement, users can switch to 

the next point of placement by pressing this function. 

Current library part name 

The file name of the library part to be set appears in this field. 

Rotate 

 

Having selected the angle via the "Combobox" or inputting a random angle, the loaded 

part can be rotated clockwise or anticlockwise with the corresponding function. 

Mirroring 

  

The loaded part can be mirrored accordingly by selecting the function MIRROR 

HORIZONTAL or MIRROR VERTICAL or by entering an arbitrary angle in the entry 

line. 

Scale 

 

Having selected the function, you will be prompted to enter the required scale factor. 

Following entry of the scale factor, the part is enlarged or reduced around the point of 

placement and can be placed with the usual crosshairs positioning procedure. 

Modify reference point 

 

This function can be used to specify the reference point when positioning, moving or 

copying. 
 

Activating this function opens a separate window "Modify reference point" with the 

current selection. The selection can be moved to the required location in this window 

(by zooming, rotating, etc.). The new reference point (reference point for the 

manipulation) is set by tapping on it. The window is closed automatically and the 

selection can be placed via the new point of reference. 

Rotate on X/Y axis 

 

This function can be used to rotate objects on the X- or Y-axis before they are placed. 
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Properties bar for library part 

 

The properties bar becomes visible as soon as you select a library part, 

 Current library part name 

 
Renovation planning state (only ELITECAD 

Architecture, see chapter 8.5) 

Exchange library part 

The library part is replaced as soon as a different file name is selected. The reference 

point remains the same during this process. The reference point of the new part is 

located on the reference point of the existing part. 

Exchange of library parts in renovation planning (only ELITECAD 

Architecture) 

If renovation planning is active and the library part is assigned to the state existing 

construction, then the part is maintained and set to the state demolition. The new part 

receives the state new construction. 

Insert library 

 

Insert toolbar 

Insert menu > Library.... 

Instead of using library management, a library part can be called up and set directly 

via the Windows file selection. The parts adjust to the scale. 

The library part can be manipulated accordingly using the functions from the 

Load/position properties bar before being placed. 

Insert symbol 

 

Insert toolbar 

Menu Insert > Symbol ...  

This function is used for absolute loading and placing of symbols such as title blocks, 

location symbols, keys, etc. This means that symbols are always read in the same size 

regardless of the scale and format of the current drawing. 

The symbol can be manipulated accordingly using the functions from the 

Load/position properties bar before being placed. 

Define Library part 

 

Extras toolbar 

Extras menu > Define library part 

This function is only available in ELITECAD Architecture. Multiple models with 2D 

and 3D information can be combined with this function and they can be defined as a 

furnishing object. All assembled parts are summarised into an object. This object can 

be manipulated and deleted in its entirety as an object, or part objects can be 

manipulated and deleted separately.  
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If a set library part is selected in the drawing, it displays an enclosing rectangle with 

handles in the corners and placement points. The part can be moved using the handles. 

If there is a part that is defined as an object among the assembled parts, it becomes 

active. The associated information is displayed in the dialog window. If no object is 

yet defined, an object can be created with "Define object". 

  

Name 

The name of the library part becomes the file name. 

Description 

The description turns into quick info. Dimensions and article numbers can be entered 

here, for example. 

Layer 

The structure into which the library part is allocated when being applied can be entered.  

Adjust to (finished) floor height 

If this option is selected, the Library part is adjusted to the height of the floor if it is 

standing on a floor. The 3D information is adjusted to the height. The 2D floor plan 

remains "lying" on the work plane applied. 

Point of reference 

The point of reference is important for the height adjustments for the base. The 3D of 

the library part adjusts to the height if the reference point is within the room. 

Pt. of placement 

You can apply multiple placement points for each part. 

You can move the Library part precisely to the correct location in the drawing using 

placement points. If the Library part is selected in the drawing, additional handles 

appear on the placement points to move the part. 
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In the case of a table, it would be a good idea to set a point in each corner and in the 

middle of the table. 

When inserting the Library part, the function NEXT PLACEMENT POINT appears 

in the properties bar. 

 

You can use this function to jump from one point to the next. 

Define object 

If only a pure 2D graphic is present, you must specify one of the contours as a main 

model. In the case of 3D data, three options are available to be selected for the 2D 

display. 

Automatic contour 

The current detail parameters of the 3D objects are used for the views here. However, 

they are only displayed in plan views if the option AUTOMATIC HIDDEN LINE is 

selected in the plan parameters. The detail parameters are always applied in views and 

sections. 

Generate contour 

The 2D display is generated using the visible parts and projected onto the floor plan. 

The 3D object detail parameters are no longer used. 

Select contour 

A separate contour can be selected for 2D display. The 3D object detail parameters are 

no longer used. 

Dissolve Library part 

 
 

Context menu in the graphics window 

If a library part is selected in the graphics window, then the function DISSOLVE 

LIBRARY PART is available in the context menu. The object thereby loses the 

properties of the library part and is available again as a normal object. 
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1.9 REFERENCES 

The principle behind references is that a construction subset or design model part is 

defined in order then to use it multiple times in different places, or so that an area that 

is linked to the drawing as a reference can be worked on externally. 

A distinction is made between internal and external reference. The internal reference 

is managed in the design model file; the external reference is outside the design model 

file and can be edited independently by other users. 

In ELITECAD Architecture, the internal reference is limited to a single storey, the 

external reference has no limitations for the number of storeys. 

REFERENCE MANAGEMENT 

 

 

View menu > Window > References... 

Reference management manages the internal and external references and displays the 

references that are currently being used. 
 

 

Header functions 

The top row populated with functions in the 

management window. 

Internal references 
List of internal references. 

External references 
List of external references. 

Drawing structure 
This overview is only available in ELITECAD 

Architecture and contains a list of all references in 

the current view (design model view, section view, 

etc.). 

In ELITECAD Mechanics, this overview is shown 

in the assembly management. 
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Header functions 

New reference (internal reference) 

 

A name must be assigned to the reference. 

 

An empty worksheet is opened on which the reference can be drawn. 

Define reference (internal reference) 

 

The function defines a reference from a selection. The selection must be limited to a 

storey. The reference point must be specified if the selection is correct. 

  

The reference is opened with the selection. 

The selection is also the first instance of the reference. 

Instead of selecting the function in the header bar, it is integrated into the default 

context menu (only appears if something is selected). 

Load external reference 

 

Any ELITECAD file can be loaded as an external reference. The reference is limited 

to 2D elements if the target location is a view. The reference should ideally be located 

in the project directory as this ensures that the reference can also be found at other 

stations. A warning message appears if the drawing is not contained in the project. 
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A range of commands is provided for positioning the reference in the properties bar 

for loading/positioning. 

If the reference consists of a storey, the file is positioned in the current storey. If the 

file consists of multiple storeys, it is loaded and the corresponding structures 

generated. The structure height is aligned to the design model if the structure is not yet 

present. 

Manage external references 

 

The external references have an additional management window, which displays the 

status of the reference. 

 

State – not found 

The file was renamed or moved > Change path 

If the file cannot be found, it is advisable to integrate the file so that it can be edited > 

Integrate 
 

Status – is outdated   

The file has now been saved again in a different state. The reference must be refreshed 

> Reload 
 

Status – active 

The file was not modified, which means that the reference is up to date > no action 

Change path 

 

A new path can be entered if the file is not found. 

Reload 

 

The reference is updated. 
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Integrate 

 

The reference is separated in the drawing. While it can no longer be selected as a 

reference, all parts can be edited. 

Internal reference 

The internal reference is managed in the design model file. A new blank reference can 

be generated (New reference) or a reference created from a selection (Define 

reference). 

The internal reference is used in the same way as a view. The references are listed in 

reference management. The reference is displayed on the monitor by double-clicking 

a name. The name is highlighted in management and the title "Reference" is active in 

views management. 

  

The storeys manager is inactive in ELITECAD Architecture in this status as the 

internal reference is limited to one storey. The storey that was active when defining 

the new reference is used. 

To leave a reference, users must click on another view in views management or double-

click on the name in reference management to switch back to the design model. 

The reference can be inserted into the drawing using drag and drop. The reference can 

be rotated or mirrored in the properties bar before being placed. 

When setting a reference, a check is performed for 3D objects to ensure that no 

construction parts are set in a section or a view but only references with 2D elements. 

The instances of a reference are always kept up to date with the original in reference 

management. If architectural construction parts are present in the reference, it may be 

the case that the design model must be refreshed after a modification to ensure that all 

sections of wall, slab, ceiling, base and roof are correct. 

References can be exported and imported in order to use them in other design models. 

The internal references cannot be copied via the clipboard or read into other design 

models via positioning and loading. The references are inserted separately. 

 

Design model editing in team (chapter 8.4) is not yet possible in ELITECAD 

Architecture with internal references. 
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Reference point 

The reference point is the anchor point of the reference in the plan. The reference is 

always removed from this point when modifying the size.  

The centre of the page is automatically the reference point in the case of a new empty 

reference. In the case of a reference from a selection, the reference point for the 

selection must be selected directly. 

The reference point can be modified via the context menu on the reference name. The 

reference point is displayed with a blue cross. 

Context menu for non-active reference 

 

Insert 

 or drag and drop 

Adds the reference to the drawing. The reference is attached to the cursor and can be 

dropped on the reference point. Furthermore, the properties bar for loading/positioning 

opens to rotate, mirror, etc. the reference. 

Open reference editor 

 or double-click reference name 

The reference must be open in the reference editor to perform modifications to a 

reference. Modifications are forwarded directly to the instances after closing the 

reference editor. 

Export reference 

 

The internal reference is only saved in the respective design model file. References 

must be saved externally and reimported in the respective model or station in order to 

be used in other design models or stations. 

Context menu for active reference 

 

Close reference editor 

Double-click reference name 

Switches from editing the reference back to the design model. Completed 

modifications are forwarded directly to the instances. 
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Modify reference point 

Export reference 

"Internal references" context menu 

 

New reference 

 

Import reference 

 

Exported references can be imported from other design models.  

External reference 

An external file can be loaded into the design model or into a view as a reference. 

Entire partial design models can be loaded into the design model as a reference. The 

program checks the structure settings and integrates the design model correctly. If the 

references are only 2D, they can be set in the views/section. 

The external reference is inserted using the function LOAD EXTERNAL 

REFERENCE. The program checks whether its external references are up to date when 

opening the drawing. If this is not the case, the management window of the external 

references opens. This can be opened via the function MANAGE EXTERNAL 

REFERENCES. The external references and their status are saved in this management 

window. 

References that have since been changed externally can be refreshed. 

External reference context menu 

 

Integrate reference 

Replace reference 

An internal/external reference can be substituted by another random internal/external 

reference. All instances are switched for the internal references. 
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If the reference is substituted by an external reference, a new ELITECAD file can be 

selected in the file selection. If the reference is substituted by an internal reference, a 

new dialog window opens for the selection of the reference. 

 

All available internal references are listed in the left-hand column. The properties of 

the marked reference are visible in the right-hand area. 

"External references" context menu 

 

Load external reference 
 

Manage external reference 

Drawing structure 

This overview is only available in ELITECAD Architecture. In ELITECAD 

Mechanics, this overview is shown in the assembly management. References for the 

current view (design model view, section view, etc.) are listed in the drawing 

structure. The references can be selected, hidden or structured. The storey and layer 

filter are deleted in the design model. 

External reference context menu 

  

Unload/load 

The reference is not loaded together with the design model file; the program recognises 

the position of the reference, however. The reference can be loaded if required again. 

Display position 

The frame of an unloaded external reference can be switched to visible. 
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Integrate reference 

Replace reference 

Display/hide 

Controls the visibility of the reference. Other assembly filters are lost. 

Assemble 

Displays the reference separately on the monitor. 

Internal reference context menu 

 

Replace reference 

Display/hide 

Controls the visibility of the reference. Other assembly filters are lost. 

Assemble 

Displays the reference separately on the monitor. 

Dissolve reference 

The selected instance is dissolved in the plan. While the parts lose their reference to 

the reference, they can be edited again "normally". 
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1.10 OPEN AND SAVE 

File selection for opening and saving 

Opening and saving functions call up the Windows file selection. The dialog window 

appears differently depending on the operating system.  

All files listed under "File type" can be read in. 

 

 

When selecting a project, the directory path for opening and saving it is set 

automatically to the project path. The most recently used path is opened for libraries, 

symbols and graphics. 

 ELITECAD symbol 

The display can be switched to "large symbols" to find out more about the contents of 

the ELITECAD file. A preview image of the file appears. 
 

Via file type, users can filter whether only ELITECAD files or all files (necessary for 

reading CAD400 files) are displayed. If "ELITECAD files" is set for the file type, the 

file extension ".d" is automatically added to the file name when saving. If the file type 

is set to "All files", then you need to add this file extension to the file name. Files with 

the extension ".d" are displayed together with the ELITECAD symbol in Explorer. 
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TIP 
All other common file formats can be selected directly under the file 

type. You therefore do not have to open all user interface dialog 

windows in order to open certain formats. 

  

New 

 

Toolbar *main functions 

File menu > New              [Ctrl] + [N] 

This function starts a new drawing with the title "unnamed.d". 

A number of pre-settings can be made in the OPTIONS. 

Menu SETTINGS > OPTIONS > SAVE/OPEN > GENERAL 

The name for "New file" can be specified in this directory and the user can decide at 

the same time whether a master drawing should be loaded. 

OPTIONS > WORK PARAMETERS > NEW DRAWING 

Various basic parameters can be set for the new drawing here. 

Scale, unit, page format, angle unit, etc. 

Having selected the function, if a drawing was loaded and modified, a query appears 

asking whether this drawing should be saved. A new drawing is then started.  

Open 

 

Toolbar *main functions 

File menu > Open....         [Ctrl] + [O] 

If a file has already been loaded and modified, a query appears asking the user if it 

should be saved. If the work area is empty, the dialog field "Open drawing" appears. 

The drawing required can now be selected and loaded. 

Recently opened files 

 
 

File menu > Recently opened files 

The eight most recently opened files can be displayed with a corresponding path and 

opened directly. 

Load work copy  

 

Toolbar *main functions 

File menu > Load work copy 

This function opens the most recent work copy. 
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If the function is called up via the menu FILE > LOAD WORK COPY, a dialog field 

"Open file" appears and old work copies can be loaded. 

Show 

 
 

File menu > Show 

This can be helpful for copying data from existing plans into the current project via 

the clipboard. 
 

In ELITECAD Architecture, the program is started for a second time. 

In ELITECAD Mechanics the ELITECAD Viewer is started. 

Insert graphic 

 

Pixel toolbar 

Menu Insert > Image 

 

This function is used to read in pixel graphics in TIFF, JPEG, BMP, PNG and GIF 

format. 

The graphic can be manipulated accordingly using the functions from the 

Load/position properties bar before being placed. 

The reference point can also be modified using the function MODIFY REFERENCE 

POINT. 

Position 

 

Insert toolbar 

Insert menu > Position ...  

This function reads an existing drawing into the current drawing. In ELITECAD 

Architecture, the drawing is assigned to the current structure and storey if it does not 

contain data from multiple storeys. The drawing is loaded in if this is the case.  

The drawing is adjusted to the respective scale when being positioned. 

The drawing can be manipulated accordingly using the functions from the 

Load/position properties bar before being placed. 

The reference point can also be modified using the function MODIFY REFERENCE 

POINT. 

Load into  

 

Insert toolbar 

Insert menu > Load into.... 

This function reads an existing drawing in ELITECAD Architecture into the current 

drawing with its specific storey and structure settings. The drawing is adjusted to the 

respective scale when being loaded. 
 

The following query window for the position appears after activating this function. 
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To start point 

The drawing is applied absolutely (as saved). 

New position 

The drawing can be placed in any given position. 

Insert OLE object 

 

Insert toolbar 

Menu Insert > OLE object 

OLE stands for Object Linking and Embedding. This function allows users to add 

multiple data to an ELITECAD drawing from multiple other applications. For 

example, an image that was created in a graphics program can be integrated into 

ELITECAD. The special feature to note here is that this embedded image can be edited 

with the original graphics program directly in ELITECAD by double-clicking on it. 
 

The OLE objects are either embedded in ELITECAD or linked with the original file. 

The OLE functionality is provided by the operating system (Microsoft Windows). 

OLE does not support all functions and features of third-party programs. For example, 

only the first page is imported from a text document. 
 

The dialog field "Insert object" appears after activating this function. 

  

Create new 

The corresponding application for generating a file can be selected under "Create 

new". Confirming with OK always starts the program before the document, worksheet, 

etc. is positioned in the ELITECAD drawing. 
 

The data has to be saved in the external programs menu for refreshing it in 

ELITECAD. 
 

Files created in this way are always embedded in ELITECAD. 
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Create from file 

  

An existing document can be selected and inserted into ELITECAD using this option. 

If the button "Link" is not active, the document is embedded in ELITECAD. Otherwise 

it is connected. 

If the button "As Symbol" is activated, the file itself is not displayed but only a symbol. 
 

EXPLANATION 
OLE objects can either be linked or embedded. Users can find out 

whether an object is linked with ELITECAD or not via the menu item 

EDIT > LINKS or in the menu of the open application (refreshing not 

saving).  

Link 

A linked object is a reference to data in another document. You can use the same data 

in multiple drawings. If the original document is modified on this basis, the links in 

ELITECAD are, depending on their properties, refreshed automatically as soon as the 

corresponding drawing is loaded. All links can be refreshed via the menu item EDIT 

> REFRESH LINKS for open drawings. The properties of the links can be modified 

via the menu item EDIT > LINKS. 

Please note that the object can also be edited in ELITECAD by double-clicking on it 

and that the original document can therefore be modified. 

Embed 

If an object is embedded, the data from this document is integrated into ELITECAD 

as a copy and no longer connected to the original document. 
 

TIP 
Parts of documents can be inserted into an ELITECAD drawing with the 

Windows clipboard. Select the parts to be copied in the corresponding 

application and move them to the clipboard. These parts can be 

incorporated into the ELITECAD drawing. These objects are embedded 

in ELITECAD and can be opened with their original application and 

edited by double-clicking on them.  

Edit links 

 

Edit toolbar 

Edit menu > Links... 

The properties of linked OLE objects can be modified via this menu item. 
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All links that are contained in the drawing are always displayed. 

Update now 

The selected link is refreshed. 

Open source 

The selected link is opened with the corresponding application. 

Change source 

A different document can be added to the background of the selected link. 

Remove 

The selected link is deleted. While the graphic remains in ELITECAD, it can no longer 

be edited. 

Refresh:  

If a link is set to "automatic" (default), it will always be refreshed when loaded. 

If a link is set to "manual", however, it must be refreshed either via the function 

UPDATE NOW or via the menu item EDIT > REFRESH LINKS. 

Refresh links 

 

Edit toolbar 

Edit menu > Refresh links 

All links in the loaded drawing are refreshed. 

Save  

 

File toolbar 

File menu > Save          [Ctrl] + [S] 

The drawing is saved under its current name and file type, which can be seen in the 

title line. 
 

TIP 
The complete drawing is always saved, regardless of whether 

"elements", "geometry", "text", "arrows", "dimension" and "hatch" are 

visible.   

Save as  

 

File toolbar 

File menu > Save as …      [F12] 
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This function saves the current screen contents of the existing drawing in a new file. 

A new file path and file name can be selected in the Windows file selection. If a pre-

existing name is selected, a confirmation prompt appears. 
 

EXPLANATION 
If not all of the data of the design model is assembled, a query appears 

asking the user whether the complete drawing or only the visible part of 

the drawing is to be saved. Parts from the design model can be saved 

individually as a template in this way.  

  

The following file formats can be written instead of an ELITECAD file: 

 DXF/DWG 2D files (*.dxf,*.dwg) 

 DXF/DWG 3D files (*.dxf,*.dwg) 

 IGES 2D files (*.igs) 

 TIFF files (*.tif) 

 JPEG files (*.jpg) 

 BMP files (*.bmp) 

 VDAFS files (*.vda) 

 SAT files (*.sat) 

 3DS files (*.3ds) 

 MI files (*.mi) 

 IFC files (*.ifc) (only in ELITECAD Architecture) 

 TGF files (*.tgf) 

 VIS files (*.ray) 

 VRML files (*.wrl) 

Data loss occurs if an entire design model is saved in one of these formats as only 

corresponding areas are saved depending on the format. 

Option for Save as 

Additional queries can be activated in the OPTIONS. (Standard is switched off) 

Attention: These queries must then be confirmed otherwise the drawing will not be 

saved. 

 

Either the reference point for a saved drawing can be assigned with one of the common 

capture modes or the current origin (centre of page) is used as a reference point by 

pressing the [Enter] key. This will be the current reference point later on when the 

drawing is read in with the functions POSITION, LIBRARY and SYMBOL. 
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The query Enter description appears. If the "Graphics preview" is called up for one of 

the loading functions, this entry is displayed as a tip (quick info) when you hold the 

mouse over the preview image. 
 

The keyword is an additional piece of information for the drawing. 

Save work copy  

 

File toolbar 

File menu > Save work copy        [Ctrl] + [W] 

The work copy is a temporary backup of the drawing. A distinction is made between 

an automatic and a manual work copy. 
 

The function saves a manual work copy. The file is saved in the directory of work 

copies (ELITECAD configuration). A certain number of work copies can be accessed 

(SETTINGS > OPTIONS > SAVE/OPEN > DRAWING). A suffix (".0", ".1", ".2", 

…) is appended to the work copies. The work copy with the suffix ".0" is the most 

recent. 
 

Work copies can also be saved as project-specific in ELITECAD Architecture 

(SETTINGS > OPTIONS > SAVE/OPEN > DRAWING). The name is composed as 

follows: <Project name>_WOCO<Suffix> 

Tip: 

This function ignores all assembly filters and saves the entire drawing in the backup 

file.  

Automatic work copy 

An automatic work copy can be activated in the OPTIONS (SETTINGS > OPTIONS 

> SAVE/OPEN > DRAWING). The work copy is given the extension "_auto" in its 

name. In the OPTIONS, you can set the number of work steps to be carried out before 

a work copy is saved. The manual work copies are not affected. 

 

Export 

 

File toolbar 

File menu > Export 
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In order to load all building views, sections, details and plot views generated in 

ELITECAD individually or to decouple them from the design model, they must be 

saved as separate drawings with the function EXPORT. When doing this, they lose all 

object intelligence of the construction parts. 

  

Save for transfer 

 
 

File menu > Save for transfer 

This function can be used for forwarding files, e.g. to a third-party office, without 

having to worry about any references. 

All relevant data is saved into a single file independently of the current settings. (e.g. 

OLE objects, background images, visualisation materials, views, references) 

Create archive 

 
 

File menu > Create archive 

This function can be used for forwarding files, e.g. to a third-party office, without 

having to worry about any references. 

All relevant references such as OLE objects, background images, visualisation 

materials, etc. are exported into a blank directory to be stated. 

Read archive 

 
 

File menu > Read archive 

A previously generated archive is loaded with all references, such as OLE objects, 

background images, visualisation materials, etc. 

Insert reference drawing 

 

Reference drawing toolbar 

Insert menu > Reference drawing > Load into 

This function inserts an ELITECAD drawing as a reference plan. The reference point 

of the drawing is transferred. The reference drawing is assigned to the original storey. 

The reference plan is displayed in a pen colour and can neither be edited nor activated. 
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The capture points can be selected, however. The settings in SETTINGS > OPTIONS 

> REFERENCE PLAN apply for the display (pen type) and the procedure for saving 

and printing. 

Position reference drawing 

 

Reference drawing toolbar 

Insert menu > Reference drawing > Position 

This function inserts an ELITECAD drawing as a reference plan. The position of the 

reference plan can be redefined. The reference drawing is assigned to the active storey. 

The reference plan is displayed in a pen colour and can neither be edited nor activated. 

The capture points can be selected, however. The settings in SETTINGS > OPTIONS 

> REFERENCE PLAN apply for the display (pen type) and the procedure for saving 

and printing. 

Delete reference drawing 

 

Reference drawing toolbar 

Insert menu > Reference drawing > Delete 

This function deletes a reference plan. If multiple reference plans are loaded, all are 

deleted. If reference plans have been hidden, however, a query appears asking you 

whether you want to delete only the visible reference plans or all reference plans. 

 

Hide reference drawing 

The reference drawings can be hidden in the monitor settings [Ctrl]+[Q]. 
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1.11 OTHER FUNCTIONS 

Cancel 

  

Create new toolbar 

[Esc] 

The current function or action is cancelled. 

End 

 

File toolbar 

File menu > End    [Alt]+[F4] 

This function is used to end ELITECAD. CAD is closed after the confirmation prompt. 

When being closed, the current setting of the user interface is saved in the parameters. 

Undo  

 

Edit toolbar 

Edit menu > Undo    [Ctrl]+[Z]       

This function is used to remove the most recent program step. 

An additional program function is cancelled by activating the function again. 

UNDO is reset for the following functions 

New file; load work copy; load drawing; save drawing; clean data; modify the number 

of "undo steps" 
 

TIP 
The number of maximum "undo operations" can be set in the OPTIONS 

under SETTINGS > OPTIONS > WORK PARAMETERS > EDIT. 

  

Restore  

 

Edit toolbar 

Edit menu > Restore    [Ctrl]+[Y]       

This function is used for removing "undo operations" carried out. 

Purge data  

 

Special functions toolbar 

Extras menu > Special functions > Purge data    

This function cleans the data structure. 

Macro call 

 

File toolbar 

Extras menu > Execute macro … 

This function loads a macro (predefined working procedures) into the working storage 

of the computer and starts it. After activating the function, you can select the macro 

file. 

You can interrupt the currently executed macro via [Esc] or CANCEL. 
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Performance 

 

Special functions toolbar 

Extras menu > Special functions > Performance …. 

This function is used to test the graphical performance of the system or for animation. 

After activating the function, the number of desired rotations of the current design 

model is queried in the input line. The design model is rotated in steps of 5 degrees. 

(72 steps produce a full rotation of the design model) A click in the graphics window 

interrupts the function. Determined characteristic values are the “frames per minute” 

and timed periods. 
 

TIP 
Measured values are only significant if the same design model in the 

same orientation with the same graphical settings (light, edges, surfaces 

etc.) is used.  

Reconstruct copies 

 

Special functions toolbar 

Extras menu > Special functions > Reconstruct copies 

This function discovers copied elements, regenerates copies and hence reduces 

memory usage. 

The function can be applied especially for files that were created in versions older than 

version 11 or after data import via DXF/DWG or other interfaces. 

The colour mode ”copies” shows copies of objects graphically. 

Memory usage 

 

Special functions toolbar 

Extras menu > Special functions > Memory usage 

This function delivers statistical values of the loaded design model. The function 

counts the number of polygons, points and 3D object definitions as well as measured 

valued for the graphical output. 

Polygons 

These are the polygons used for the graphical output which were created when faceting 

3D objects. 

Points 

Number of corners of the polygons. 

Definitions 

Real 3D definitions without copies. 
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2.1 SETTINGS 

INPUT DEVICES 

Configuration input devices 

 

Camera toolbar 

Menu View > Camera > Configuration walk mode / input devices / shader 

General 

This dialog window is used to configure input devices in the walking mode. 

Depending on installed devices, some sub items may not be visible. 

 

 
 

 Walking Mode 

 

 

 Rotate / Move 

 
 

 Shader quality 

 

 

 Shader effects 

 

 

 Context menu 

 

 

 Keyboard and mouse 

 

 

 Gamepad 

 

 
 

 SpaceMouse 

 

 

 Axes 

 

 
 

 Virtual Reality 

 

 

 Leap Motion 
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Reset 

 

This button opens a dialog window where either the setting of the current page or all 

settings are set to the previous state. 

Walking Mode 

 

 

Start settings 

The start settings define which settings are automatically enabled upon activating the 

walking mode.  

Solid design model 

 

Sets the desired depiction mode. If the mode is set to ‘off’, the current mode will be 

retained. 

Edges 

 

Edges can be blended in and out optionally. 

Fullscreen mode 

 

Switches the graphics window to fullscreen mode. 

Shader 
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Activates the shader technology. 

Skybox 

 

Displays the skybox, in case it is defined. 

 

Virtual Reality 

 

Activates the Virtual Reality mode and configures the graphics output for VR glasses.  

Movement 

Status display 

 

When the walking-mode is enabled, there is an optional transparent status bar at the 

lower part of the display. It features various indicators about which state you are 

currently in. 

Collision control 

 

Virtual objects represent obstacles just like in the real world. They cannot be 

penetrated in the walking-mode. This is intentional as otherwise one would fall 

through the floor or would not be able to walk up a flight of stairs. Collision control 

can be deactivated in order to be able to walk through walls. 

Go through openings 

 

This switch is an additional option for the collision control (only in ELITECAD 

Architecture). If the option is enabled, it is possible to move through closed doors and 

windows.  

Go through bluescreen objects 

 

This switch is another additional option for the collision control. If it is enabled, it is 

possible to move through bluescreen objects like trees and people.  

Gravity 

 

Gravity ensures that during navigation the observer is always dragged to the ground. 

When gravity is active the free fall stops upon the nearest surface. In case there is no 

surface underneath the current position, free fall ends at the current floor level. 

Align viewing direction horizontally 
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This option ensures that whenever the user moves up or down, the viewing direction 

will be aligned automatically with the moving direction. Some users might react 

sensitive to those automatic movements; therefore, the option is usually disabled. 

Roll 

 

This option locks or activates the rolling of the camera. This kind of movement is 

rather unnatural and therefore it is usually disabled.  

Speed and dimensions 

Speed 

 

Definition of speed during walking mode in m/s.  

Eye level 

 

Definition of eye level in cm.  

The level that can be exceeded 

 

Definition of the level that can be exceeded in cm. If it is set too small, curbs or stairs 

might impose obstacles. On the other hand, if it is set too high, fences and walls could 

be passed too. 

Angular velocity 

 

Definition of the speed for changing the direction of view in degrees/second.  

Aperture angle of the camera 

 

This setting has to be set specifically to override the aperture of the current camera. It 

defines the aperture angle in the walking mode. 

Rotate/Move 
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The settings in this mode are valid for the input devices gamepad and 3D mouse.  

Move object / camera 

  

Movements are interpreted relative to the object or relative to the camera. There can 

only be one of these two options active at any given time.  

Rotate relative to object / viewing direction 

  

Rotations are interpreted relative to the object or relative to the camera. There can be 

only be one of the two options active at any given time.  

Move relative to the selection 

 

Activating this option means that, in case a selection is active, the centre point of the 

selection will be used as fixed point for rotations. Default rotation point is the centre 

of the screen.  

Move relative to the origin of the work plane 

 

Activating this option means that the centre point of the work plane will be used as 

fixed point for rotations. Default rotation point is the centre of the screen. 

Automatically raise 
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Usually the z-Axis is aligned vertically to the screen. In case this alignment does not 

match up anymore, the z-axis will be raised automatically again upon a rotation.  

Shader quality 

 

 

Depiction 

Despite their high performance on the graphics card, shaders can take up some time 

during image rendering. Depending on the ability of your hardware, you can influence 

the graphics output by reducing the level of detail for instance. An example for this 

technique is the distance of the camera up until which the grass shader will generate 

grass stems. 

 

There are four predefined quality settings to facilitate easy configuration. 
 

TIP 
When producing photos and videos, LOD can be disabled. 

  
 

Each setting on this page can be adjusted individually in order to deactivate or 

emphasize single effects. 

Object-reflections 

 

Object-reflections are pre-calculated once, when the shader technology is enabled. 

This calculation takes some processing power once, and if new objects are added to 

the model, only the changes have to be calculated. Optionally it is possible to calculate 
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reflections in reflections. This increases the quality but also requires more processing 

power.  

Resolution 

 

Shininess and reflections are pre-calculated and saved as bitmaps. The larger the 

resolution, the better the quality. The size however is limited by the available memory 

on the graphics card. On low-budget graphics cards, this value should be reduced.  

Lights and shadows 

 

Also soft shadows are pre-calculated and could be deactivated in order to improve 

performance. 

Level of Detail 

  

The main switch activates the possibility to use the level of detail technology. Every 

single option can be set individually and adapted in quality.  

Shader effects 

 

 

Independent of shader material properties, various effects can be applied to the whole 

image. Some of those effects, you might already know from image processing 
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software. In ELITECAD, they are calculated in real time, while you walk through your 

model. 

Some effects have a common technical term, but in the user interface, comprehensible 

terms were preferred. The technical names are sometimes given in brackets. 

There is no special knowledge required. Just select the effect and use the sliders to 

modify the values. The image is updated in real-time and the effect is visible 

immediately.  

Graphics performance 

 

Depending on the power of your graphics card, more or less spheres are displayed.  

Automatic refresh 

 

If this option is enabled, every change in the options will be displayed immediately in 

the graphics window.  

Image rendering with shaders 

 

This switch enables the shader technology.  

The menu allows you to set different styles of image generation. The standard setting 

is Phong-Shading. Alternatively, you can generate output as greyscale, or dotted 

images. Some options have additional parameters, which will be visible on demand. 
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Skybox 

 

This switch enables the depiction of a skybox.  

In the menu, you can select if the skybox gets darker during night scenes. In the state 

ambient, die darkening of the skybox is enabled.  

  

Filter 

 

This switch activates image filters like for instance depth of field.  

The menu allows you to choose the type of filter. Some filters feature special 

parameters that are made visible if required.  

Extended Bump Mapping (Steep Parallax) 
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Bump maps create depth effects on surfaces. Using additional shadows for bump maps 

the naturalness of the surface can be enhanced even further. 

Extended light model (Micro facets) 

 

Over exposure (Emission) 

 

This over exposure emphasizes very luminous 

objects. 

Rim lighting 

 

Rim light is usually used in movie productions. A light source is placed behind a 

person, which creates discreet lighting along the silhouette, therefore creating a good 

contrast with the background.  

Surface appearance without visualisation material 

 

For all objects that have not been assigned a visualisation material, a default 

appearance can be assigned here. 

Maximum Filter quality 

 

If this setting is active, then it is attempted to achieve the maximum image quality 

depending on capabilities of the graphics card but independent of the material settings. 

Hence, the material may define simple texture filter but the trilinear texture filter is 

used instead. 

Extended transparency calculation 
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Bump-Map Shadows 

 

Antialiasing 

  

Renovation planning Shader 

 

This special ELITECAD shader is only available in ELITECAD Architecture and 

takes care of the colouring of renovation planning projects. 

Ambient shadows (SSAO) 

 

 

Ambient shadows enhance the shadows of corners and edges inside the building. This 

leads to a more contrasting depth perception for example of joining walls having the 

same colour. 

Soft shadows (Shadow Occlusion) 

 

 

While the sun in nature generates a precise shadow, soft shadows can often be observed 

with extended light sources. 

Light aura (Halo) 
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This effect creates a halo effect around light emitting objects. 

Gamma correction 

 

Dynamic range effects (HDR) 

 

Context menu 

 

 

The walking mode features its own context menu, which can be operated by various 

input devices. Using this dialog window it is possible to add entries to the context 

menu, remove them or change their order.  

Insert 

 

The selected menu entry from the list will be inserted into the context menu. 

Alternatively, it is possible to move a menu entry from the list to the menu via drag 

and drop. 

Remove 
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The selected entry will be deleted from the context menu. Alternatively, it is possible 

to remove an entry from the list via drag and drop.  

Move counter clockwise 

 

The selected menu entry in the context menu will be moved counter-clockwise by one 

entry. Alternatively, the entry can also be moved in the context menu using drag and 

drop.  

Move clockwise 

 

The selected entry in the context menu will be moved clockwise by one entry. 

Alternatively, the entry can also be moved in the context menu using drag and drop.  

Menu style 

 

Depending on the selection, the menu will be depicted in a different way. For the 

depiction in a virtual reality environment, a transparent style can be selected as well.  

Number of entries 

 

The number of entries in the menu can be increased up to 12 entries.  

Keyboard and mouse 

 

 

Controlling with mouse and keyboard is the standard way of input in the walking 

mode.  
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Mouse 

The green cross in the circle visualizes the mouse movement.  

Sensitivity 

 

The sensitivity of the mouse movement can be set between 0 and 100%.  

Vertical / Horizontal 

  

The horizontal and vertical movements can be deactivated independently. 

Invert 

 

The direction of movement, horizontal or vertical, can be inverted if necessary.  

Keyboard 

The red cross in the circle shows the keyboard input.  

Movement 

 

Movement control with the keyboard can be done using the arrow keys or using the 

keys W-A-S-D. 

Acceleration 

 

The key that is set here allows increasing the speed of movement. This corresponds to 

the running mode. 

Gamepad 
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PS4® is a registered trademark of Sony Computer Entertainment. 

XBOX® is a registered trademark of Microsoft.   

These components are only configurable if they are installed. Depending on the type, 

there are more or fewer options available for configuration. 

Configuration 

Device selection 

 

Selection of the gamepad to configure. There can be multiple gamepads active at the 

same time. The checkbox shows if the gamepad is active. 

Pre-settings 

 

These switches can be used to load presets for the selected controllers.  

Restricted input device 

 

A gamepad can also be configured as a restricted input device. This setting is especially 

useful if multiple gamepads are active. Restricted input devices can be paused with a 

button, which can be configured in the button assignments. 

Invert axis 

 

This switch inverts the axis.  
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Control 

Movement 

The control of the gamepads is done with two joysticks. The movement can be checked 

by looking at the two circles with the red and the green cross.  

 

In general, the movement and rotation axis are controlled with the two joysticks. Each 

direction can be inverted optionally.  

Buttons 

  

The buttons on the gamepad can be assigned individually.  

Depending on the type of device, there is a variable number of buttons on the device. 

Pressing a button will be displayed in the dialog window. These buttons can be 

assigned to functions.  

SpaceMouse 

 

 

SpaceMouse®, SpaceNavigator® und SpacePilot® are registered trademarks of 

3Dconnexion GmbH. 
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These components can only be configured if they are installed. Depending on the type, 

more or fewer options are shown.  

The settings in ELITECAD correspond to the settings in the options dialog of the 

manufacturer.  

Configuration 

Settings 

 

Opens the settings dialog of the manufacturer.  

Axes 

Main scale-factor 

 

There is one global factor as well as several different factors for the 6 degrees of 

freedom.  

Axis on / off 

 

Every axis can be activated independently.  

Invert 

 

Every axis can be inverted independently.  

Buttons 

Depending on the device type, it is possible to assign certain functions to certain 

buttons of the device.  

Axes 
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In this dialog window, the sensitivity of the input device can be configured. The 

movement of the joysticks is shown in the corresponding bars. The diagram visualizes 

the current setting of the sensitivity.  

Movement / Rotation 

Dead zone 

 

In order not to react to unintended inputs, it is possible to configure a dead zone at the 

beginning of an input.   

Maximum 

 

After a certain maximum is reached, the reaction to the input joystick is no longer 

active.   

Exponent 

 

The sensitivity between the dead zone at the beginning and the maximum at the end 

can be configured here. The higher the exponent, the later but also the more intense 

the system will receive the input.  

Leap Motion 
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LeapMotion® is a registered trademark of Leap Motion Inc. 

The LeapMotion is an input device, which allows for the interaction using gestures. 

The device can be used to manipulate camera positions or as input device for the 

walking mode.  

Requirements 

In order to be able to use the LeapMotion, first the according drivers have to be 

installed. These can be found on the manufacturer website: 

https://www.leapmotion.com/setup/desktop/windows 

Connection 

As soon as the drivers are installed and the device is connected via USB, they 

LeapMotion will be shown as connected.  

  Device not connected or drivers not installed 

  Device connected 

Activate gesture control 

If the device is connected correctly, the interaction can start. By pushing the Stop 

button, the interaction can be cancelled at any moment.  

Configuration: Camera mode 

The camera mode is activated automatically when a common design model view is 

open. In this mode, the camera can be moved to observe the model from all angles. To 

start the interaction the user has to perform a grab movement, to gain control over the 

model. The following interactions are possible: 

 Translation: moving the model along x,y,z axis 

 Rotation: tilting and rotating the model around x,y axis 

 

https://www.leapmotion.com/setup/desktop/windows
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To achieve a more dynamic behaviour it is possible to enable an inertia. This option 

allows the model to keep moving the direction it was being moved, even after the 

interaction stops. If for instance, a model is rotated and the user lets go of the model, 

it will keep rotating for a few moments before it stops completely. 

 

If inertia and endless rotation are enabled, and the model is rotated with a certain speed, 

an endless rotation can be achieved. This means that the rotation is performed even 

after the model is let go. The endless rotation can be stopped by grabbing the model 

again with the hand.  

 

This setting allows dynamically moving the clipping plane with the hand. To achieve 

this, first select the model with your hand, and then in case the clipping is active, you 

can move the clipping plane by extending your thumb from the hand. 

Configuration: walking mode.  

As soon as the walking mode is activated, the LeapMotion starts behaving like a 

controller. The user has the possibility to move and rotate in all directions. To move 

in a certain direction it is only necessary to move the hand in the according direction.   

Hands 

 

  

This setting enables you to actually see your hands in ELITECAD and get a visual 

representation of the movements. To enable the hands, the walking mode has to be 

enabled first. Furthermore, using the material editor, you can set a custom material or 

colour to your hand. 

Sensibility 

Using the 6 sliders for the corresponding axis it is possible to set the sensibility of the 

interaction. There are 3 sliders for the rotation and 3 for the translation. Using the 

toggle buttons it is also possible to lock each axis individually.  

Tips 

The area of interaction of the LeapMotion is a cone, spreading out over the sensor. If 

the hands are not located inside this cone, there might be issues with detecting the 

interaction.  

Virtual Reality 
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Runtime 

This option allows switching between different runtime libraries of VR headsets. The 

SteamVR is independent of a manufacturer therefore VR devices like Oculus Rift, 

HTC Vive, Windows Mixed Reality, etc. can be used. The usage of touch controllers 

becomes possible as well. 

 SteamVR runtime 

 Oculus Rift runtime 

SteamVR has to be installed independently and a SteamVR account has to be created. 

Steam VR should run in parallel to ELITECAD. 

Movement 

Fix body vertically 

 

This option can be used to fix the observer to an upright position.  

Depiction 

Brightness head up display 
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A status bar is displayed inside the VR glasses. In dark environments, the brightness 

can be reduced at any time.  

Autofocus 

 
In a stereoscopic image, the focus is always set to a certain distance. Either this is done 

automatically, or the distance has to be provided.  

Context menu 

 

This option configures the style of the graphical menu.  

Aspect ratio 

 

The image the observer sees in Virtual Reality can also be displayed in the graphics 

window. Various options are available for this setting. 

Sensors 

 

If this option is activated the sensors are displayed in the VR-glasses. 

Cross hair / interaction rays 

 

This option switches between the cross hair and the interaction rays of the VR 

controllers. 

Position of the graphical menu 

 

If this option is activated the graphical menu is displayed relative to the VR controllers. 

LIGHT SOURCE 

 

*Modify toolbar 

Settings > Light source... 

This function is used to configure the light sources in the 4-view window. 

The light sources are always saved along with the drawing. 

When you open a new file, the most recently used light sources are selected. 

The light sources can be switched on or off separately in design model views, views 

and sections. The intensity of the ambient light can also be adjusted on its own. 

4-view window 

The light sources are configured in the 4-view window. If the light dialog window is 

open, only the light symbol can be clicked on in CAD. CAD objects cannot be selected 

or manipulated. 
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The depiction of the design model view can be controlled separately. If you right-click 

in this area, a menu opens where you can select how the design model view should be 

represented. This is also true for the other views, as they are interconnected. 

 

TIP 
The depiction of the standard view should be in the wire model, if 

possible, as this speeds up image assembly.  

  

 WORKSHOP  

Front view Side view left 

Floor plan Design model view 
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Create new light source 

                     

Under "New light source", choose the "Spotlight" type and tick it in the light source 

list. Now the light source is highlighted in red in the 4-view window and can be 

aligned. 

Using light sources in the 4-view window 

Depending on the light type, there are various handles available, which you can use to 

manipulate the light type interactively while holding down the left mouse button. 
 

Here is a spotlight, for example: 
 

Modify position of light source  Move light source 

   

Modify direction of light source  Modify opening angle of light source  

   

  WORKSHOP END 

Light mask 

The light dialog window is divided into 5 main groups. 
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Light source list 

 

This lists all of the light sources present in the drawing.  

Symbol and heading columns 

 

By clicking one of the symbols in the columns, the list can be sorted in different ways. 

Light status 

 

You can use this column to switch the light sources on or off. If a light source is active 

and you right-click on the on/off symbol, an extended selection is displayed. 

 

 Visible in the solid and in the render 

 Visible only in the render 

 Is not visible 
 

EXPLANATION 
OpenGL image rendering (solid depiction) only permits a limited 

number of light sources. Depending on the graphic/video card, that 

could be 8 or 16. The number of light sources selected for the solid 

depiction can be specified in this sub-menu.  

Light name 

 

This column lists the names of the light sources. If you select a light source and right-

click on its name, you can modify it. 

Light type 

 

This column displays the different light types. If you left-click on a specific light 

symbol, you can toggle through the different available types. If you right-click on the 

symbol, a sub-menu appears where you can choose the type directly. 
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Ambient light: 

 

The ambient light is a diffuse background light that comes from all directions. It helps 

brighten surfaces that are not lit up by a light source. 
 

Parallel light: 

 

The parallel light matches the sunlight (parallel beams of light from one defined 

direction). The light source is defined by its position and direction. There is also an 

option to set the light "absolutely" or "camera relative". 
 

All around light: 

 

All around light is a light source at a specific position that shines in all directions 

equally. This type of light source can be affected by intensity and range. 
 

Spotlight: 

 

A spotlight is a light that spreads out like a cone. The light source's impact can be 

modified by adjusting the intensity, range, opening angle and sharpness of this cone of 

light. 
 

Sun: 

 

Sunlight is a form of parallel light that comes from the distance and shines in from a 

defined direction. The light source is defined by its position and direction. There is 

also an option to perform a sun position rendering. 

Select colour 

 

Select the light colour in this column. The standard Windows colour dialog opens. If 

you click the "Define colour" button, the entire menu opens. 
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Light mask 

 

This column displays the different light masks. If you left-click on the respective 

symbol, the light mask can be switched on. If you right-click on the symbol, a sub-

menu appears where you can choose the light mask directly. 

 

Camera-relative: (only available with parallel light) 

 

The light source is tied to the camera position. The light always comes from ahead and 

its position cannot be changed. 
 

Not camera-relative: (only available with parallel light) 

 

The light source always retains its predefined position. The light's location can be 

freely modified. 
 

Associative light source: 

 

If this symbol is selected and you close the light dialog window by clicking OK, you 

can select an associative polygon or object. This associates the light source with that 

object. If the object is later moved, copied or deleted, the light source follows it. If you 

want to configure multiple lights that way after closing the light dialog window, assign 

them in sequence. 

Shadow type 

 

This column displays the different shadow types. If you left-click on a shadow symbol, 

its type can be switched on. If you right-click on the "soft shadow" symbol, an 

extended selection set appears. 
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Soft shadow: 

 

This rendering produces a soft shadow that fades outwards. You can also adjust the 

shadow resolution. This rendering option does not take as much time as a hard shadow 

does but it does require more memory. 
 

Hard shadow:  

 

This rendering option creates a hard, precise shadow on the edge. The transparencies 

are also taken into account (slide effect). This rendering option takes more time than a 

soft shadow, but requires less memory. 

Administer light sources 

 

Create new light source 

 

If you select a light type from the DROP-DOWN menu, a new light source is created 

automatically. 

 Ambient light 

 Parallel light 

 All around light 

 Spotlight 

 Sun 

Delete light source 

 

The selected light source is deleted. This procedure cannot be undone. 

Load light sources from file 

 

This is where you can load a previously saved light source list (*.ld). 

Save light sources in file 

 

This is where you can save a light source list (*.ld). 

Global light source properties 
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Shine parameters 

 

Using these settings, you can define a shine level for the light that looks good 

especially for curved surfaces. However, this setting applies only to the solid depiction 

and not to the rendering. The shine applies to all objects and cannot be limited to 

individual ones. 

   

The effect can be adjusted via the "shine weight" (shiny or matte) or the "shine 

strength" (size of shiny area). 

Shadow parameter(s) 

There are 3 entry fields here for the shadow rendering settings. 
 

Shadow distance: 

The shadow does not take effect until the distance entered here. This is always entered 

in metre units. 
 

Distance for self-shadowing: 

Occasionally, surfaces positioned close to each other may have dark spots, making the 

shadow seem incorrect. If so, you can raise the value to disable self-shadowing. 
 

Scope radius soft shadow: 

This value determines the width of the fading gradient at the edge of the shadow. 

Lower values generate harder shadows; higher values create softer shadows. 
 

The "Standard values" button resets the values back to their origin. 
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Position of light sources 

 

This is where you can enter the coordinates for the "Position" and the directional 

vectors for the "Direction". Either the values are defined using interactive 

configuration, or you can enter them in the entry fields manually. 

Intensity of light and shadow 

 

You can use the "Intensity" slider to adjust the strength of the light source. The 

"Shadow resolution" slider is only available for soft shadows and controls the precision 

of a shadow's edge.  
 

TIP 
The larger the design model, the finer you should set the shadow 

resolution. As a fine resolution uses more internal RAM, you should 

always start with a low resolution. Gradually raise the slider until you 

are happy with the result.  

Properties of light sources 

 

The "Range" slider can be used to reduce the light's intensity starting at a specific 

distance. If you set the "Range" to 100 %, the intensity will hold constant throughout 

all distances (extent of the model). Depending on that distance, the slider can be 

adjusted from 0–100 %. Up to the specified distance, the intensity holds constant, then 

decreases beyond it accordingly. 

This setting is only available for the all around light and spotlight light types. 
 

Range 100 %     Range reduced 
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The "Widen" slider can be used to modify the opening angle of a light source. 

This setting is only available for the spotlight light type. 
 

The "Sharpness" slider can be used to reduce the intensity of the cone of light 

outwards. If you set the slider to 0 %, a sharply demarcated cone of light will be 

represented. The higher the value you specify, the more rapidly the intensity decreases 

outwards. 

This setting is only available for the spotlight light type. 
 

Sharpness 0 %     Sharpness increased 

  

Light intervals 
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Activate 

 

This switch can be used to activate light intervals for this light source.  

Night-active 

A night active light source automatically is switched on during the nights with the sun 

position animation. This option has the advantage that the beginning of the activity is 

independent of the calendar day and the geographical location. Examples of night-

active light sources are for instance streetlights.  

Intervals 

 

The intervals are listed in columns and the bar on top indicates the brightness. By 

clicking on them, the name can be changed.  

Adding/ deleting intervals 

 

The selected interval is deleted and a new interval can be added.  

Interval properties 

 

Every interval has a start and ending point, as well as a start and an ending brightness.  
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Visible light 

 

Activate 

 

This check box activates the visible light. 

Brightness 

 

Use this slide to define the intensity of the shine.  
 

TIP 
The brightness can be overridden by up to a value of 600. Enter the 

corresponding value into the entry field.  

Decrease 

 

The "Decrease" slider can be used to reduce the intensity of visible light outwards. If 

you set the slider to 0 %, a sharply demarcated cone of light will be represented. The 

higher the value you specify, the more rapidly the intensity decreases outwards.  
 

TIP 
The decrease can be overridden by up to a value of 600. Enter the 

corresponding value into the entry field.  
 

Decrease: 0 %     Decrease higher 



Chapter 2 – Settings  

www.elitecad.eu  152 

  

Diameter 

 

This value defines the diameter of the visible light for the sun, parallel light and all 

around light types. For the spotlight light type, this defines the diameter of the initial 

opening in the light source. 
 

Example of all around light: 

Diameter 1 m     Diameter increased 

  

Example of spotlight: 

Diameter 0 m     Diameter increased 

    

Start at, end at: 

 

These two values can be used to restrict the cone of light to a specific area. 
 

Start at 0.01 m, end at 5.00 m  Start at 0.5 m, end at 2.00 m 
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Smooth light 

 

If this option is switched on, the visible light is rendered more precisely and 

represented more softly. It should also be taken into account that these options increase 

the rendering time.  

Shadow 

 

If this option is switched off, the light beam infuses all objects in the path of the cone 

of light. However, if the option is switched on, a spatial shadow is rendered that is 

visible within the cone of light. 

The "Quality" slider can be used to specify the precision of shadow rendering. Keep 

in mind, though, that the rendering time is greater the higher the precision. 
 

Without shadow    with shadow 

    

Render sun position 

If you set the light type to sun, you can also switch to sun position rendering. The 

dialog window is divided into 4 main groups. 
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Location 

 

The locations are selected from a list. You can enter the longitude and latitude 

manually or using the sliders. 

You cannot save your own locations. 

Hour/time 

 

You can either enter the time of day manually or adjust it using the slider.  

You can modify the date manually or click on the selection box to open a small 

calendar. Click the appropriate date to add it into the list. 

 

The time offset is always listed as compared to Coordinated Universal Time (UTC), 

based in Greenwich, England (at 0 degrees of longitude). The time offset for Central 

Europe (CET) is +1 hours. Central European Summer Time (CEST) has an offset of 

+2 hours. 

Alignment of floor plan 

 

The sun's compass alignment in relation to the floor plan can be modified here. 
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Results 

 

The calculated values can be read under results. 
 

Clicking "Apply" refreshes the light symbol on the plan. If the "Set automatically" 

button is active, this is done automatically after every modification. 

 

SUN POSITION ANIMATION 

The sun position animation tool can be used to check the lighting contrast of a project 

in time lapse mode and display it on the screen. 

 

The following simulations are available: 

 Whole days 

 Sun position 

The intervals for time steps and updating the depiction are configurable. During a time-

lapse animation, the design model can be rotated and moved. Fullscreen mode is 

available for a presentation. 

Time lapse 

 
 

View menu > Window > Time lapse; 

In the time lapse, you can specify the simulation's properties, start or stop the animation 

and track the animation in the time toolbar. 
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Header functions 

 

Start/stop/pause 

 

The animation can be started, interrupted or stopped. 

Whole days simulation type 

 

An image is calculated at the same time for each day, configurable for any duration 

(several months to a year). 

Example: 

Sun position at 12:00 pm over the course of a year 

Sun position simulation 

 

The path of the sun is simulated on one day from morning to evening. The start and 

end time can be specified. If the animation extends across multiple days, night-time is 

simulated as well. 

Example: 

Path of the sun from 21 June at 4:00 am to 11:00 pm 

Light source 

 

Opens the light dialog window to configure the sun for the animation. The animation 

requires a light source of the type "Sun". The sun's location and floor plan direction 

are to be configured and confirmed using APPLY. The date is not adopted. Ambient 

light should also be switched on. The lights are automatically dimmed at twilight. 

Fullscreen mode 

 

The animation can be viewed in fullscreen mode. 

Display time lapse values 

 

If the check box is active, various details regarding the solar calculations are displayed 

in the info window/balloon during playback of the animation. 

Value settings 

Depending on the active simulation type, other value settings are to be configured.  

 Whole days 



Chapter 2 – Settings  

www.elitecad.eu  157 

 

 Sun position simulation 

 

To implement a date or time, the number must be highlighted. Then a number can be 

entered manually or adjusted using the switch. 

 

To change the date, a calendar can be opened. 

 

Time bar 

Depending on active simulation type, the time bar may be structured in one of several 

ways. 

 Whole days 

 

The days are shown in the first row. The animation (red marker) runs from day 1 to 

day x. The second row displays the time of day for the sun's position. This position 

remains the same for the duration of the animation. 

 Sun position simulation 
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The hours are shown in the first row. The animation (red marker) runs from the start 

time up to the end time. The yellow diamonds represent sun up in relation to sun down. 

In the grey area of the beam, the light source is dark (night-time). 

COLOUR PROPERTIES... 

 

Settings toolbar 

Settings menu > Colour properties... 

The line thicknesses and colours for output on the printer and on the screen are 

managed here. These settings take effect when printing, plotting or in Colour mode > 

Printer.  

Colour properties – Main dialog window 

 

Colour scheme functions 

Colour scheme 

In this dialog window, you can define all print-specific parameters and save them as a 

custom parameter record (colour scheme). You can do so by clicking New to create a 

new colour scheme. Next, save the new colour scheme by clicking Save. Click Delete 

to remove an existing colour scheme. 
 

When saving a drawing all existing colour schemes are stored in the drawing file. This 

concerns all colour schemes of the own ELITECAD – configuration, the current colour 

scheme (if it differs from colour schemes of the configuration), as well as all temporary 

colour schemes of a previously opened drawing (if they differ from colour schemes of 

the configuration). 
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If a drawing is opened, imported colour schemes will be temporarily displayed in the 

selection list of colour schemes (only if they differ in name or content from the own 

colour scheme). Temporary displayed colour schemes are shown in a specific manner. 

 

Here the last two colour schemes originate from a recently opened drawing. They can 

be selected as usual like other colour schemes. But they won’t be transferred to the 

ELITECAD configuration unless they are explicitly saved using the SAVE button. 

Lines / areas colour 

If you tick a check box, you can configure the line and plane colours separately. 

Print line width 

If this check box is ticked, drawing elements that were created using this pen are 

displayed with the specified width. If the check box is not ticked, the output is a thin 

line (1 pixel in the printer). 

Line gauge scaling 

This value defines an additional scale value, used to additionally scale all defined line 

width settings uniformly, before creating an output on a printer. If the toggle print line 

width is disabled, the scale factor has no effect. 

Import 

Using this function, you can import a colour scheme. This way a colour scheme that 

you have created yourself can be read on different workstations. 

Export 

Using this function, a colour scheme can be saved as a text file and read on other 

workstations. 

 WORKSHOP  

Create and save new colour scheme 

Start new colour scheme. 
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Required line and area colours depending on the printer. 

 

Specify a freely chosen parameter name. 

 

Assign the print colour and line width of the respective pen if necessary. The standard 

Windows colour dialog box appears when clicking on the standard Windows colour 

mixing dialog. 

 

Saving colour scheme 

  

Depiction of a saved colour scheme 

 

Switch the screen background colour several times with [Ctrl]+[B] until the drawing's 

print preview can be viewed clearly. 

You can also change quickly between the printer and pen colour modes via the image 

properties on the bottom left. 

 

  WORKSHOP END 

 

COLOUR MODE 

The colour depiction of the data on the screen can be configured according to various 

criteria. This is known as the colour mode. ELITECAD has 9 colour modes. Pen mode 
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is the default mode to use when working; you can switch to other modes temporarily 

to see how they look. Under OPTIONS, you can specify the default mode. 

You can also change quickly between the printer and pen colour modes via the image 

properties on the bottom left. 

 

Pen 

 

Colour mode toolbar 

Settings menu > Colour mode > Pen 

Elements are represented in accordance with the pen colours. 

Printer 

 

Colour mode toolbar 

Settings menu > Colour mode > Printer 

Depiction in accordance with the configured print parameters. (See the function under 

SETTINGS menu > COLOUR PROPERTIES...) 

The pens are represented in their "actual width" and/or "actual colour". 
 

TIP 
The "Print preview" can be activated in the context menu. This depiction 

matches the printer output. To switch to the previous depiction, the 

"Print preview" must be called up again. 

  

Mono 

 

Colour mode toolbar 

Settings menu > Colour mode > Mono 

Monochrome depiction of entire drawing. 

Model 

 

Colour mode toolbar 

Settings menu > Colour mode > Model 

Different colour for each model. 

 

 

Group 

 

Colour mode toolbar 

Settings menu > Colour mode > Group 

Different colour for each group. 

Class 

 

Colour mode toolbar 

Settings menu > Colour mode > Class 

Different colour for each class. 

Level 

 

Colour mode toolbar 

Settings menu > Colour mode > Level 

Different colour for each level. 

Copy 

 

Colour mode toolbar 

Settings menu > Colour mode > Copy 

Black and white depiction signifies the original of a 2D model or 3D part. 
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Red depiction signifies a copy of an original model. 

Blue depiction signifies copies with original 3D parts. 

 

Layer 

 
Colour mode toolbar 

Settings menu > Colour mode > Layer 

Different colour for each layer. 

REST SCALING 

 

Settings toolbar 

Settings menu > Rest scaling 

Rest scaling on 

Elements and all other features of the design model (the "rest": text, hatches, 

dimensions, arrows) are scaled to size when calling functions. 

Rest scaling off 

Only elements are scaled to size for functions. 

When you restart the program, the current setting under OPTIONS is taken into 

account. 

REFERENCE POINT... 

 

Settings toolbar 

Settings menu > Reference point 

Move the standard zero point (centre of screen) 

X-, Y-coordinates of the new reference point 

Rotation of coordinate system 

Drawing moving as well 

From now on, the X- and Y-coordinates of all other points you define will be based on 

the new reference point. 

Query function 

Reference point (RETURN for centre of page) 

Specifying point by clicking on screen  

X-,Y-coordinates for this point 

By default, the reference point has the coordinates of (X = 0, Y = 0). You may also 

assign specific coordinates to it, e.g. (X = 10000, Y = 15000). 

By default, the rotation is 0 degrees (or radian). However, you may also enter another 

angle in order to take into account the difference between north and the verticals for 

surveying. 

Move active drawing as well? 

By default, the drawing is not moved as well. In other words, existing objects remain 

at the same position on the screen. However, the INFO > COORDINATES OF POINT 

function will display other coordinates after you change the reference point. 
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If you respond to this query with "Y", the contents of the screen will be moved to a 

new screen position so that the INFO > COORDINATES OF POINT feature will still 

display the same coordinates as before after the change in reference point. This option 

is especially significant for surveying. 
 

TIP 
3D Axes on/off 

The system normally uses the centre point of the screen as the reference 

point. The 3D AXES ON/OFF function displays the original axes 

through the centre of the screen.  
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2.2 OPTIONS 

 

Settings toolbar 

Settings menu > Options 

The options window includes the following settings, which are described below in 

more detail. 

 

 

 

System 

Configuration 

General 

User interface 

Region 

Save /Open 

General 

Drawing 

File exchange 

Work parameter(s) 

General 

Drawing 

Drawing (CAD-Start) 

Edit 

Geodesy 

Reference plan/Layer 

Architecture 

Reporting... 

Plane(s) verification 

Mechanical 

Mechanic lines 

Depiction 

2D/3D 

Image assembly 

Architecture 

Renovation planning 

Tools 

Views 

General 

Vector shadow 

New vector shadow 
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SYSTEM 

Configuration 

 

Extended settings 

 

Only visible if active: 

 

Parameter – Storage directory for user settings 

All parameters that you set yourself are saved in the user settings. You can save your 

own parameter records in almost every dialog window of ELITECAD. All personal 

parameter records are stored in the "elitecfg" subfolder of this storage directory. You 

can define the directory under ELITECAD configuration (WINDOWS START menu). 

You can find extended details in manual of the ELITECAD configuration. 

In ELITECAD, the value settings are saved in country-specific subfolder. The 

subfolder name in ELITECAD Architecture is <language>_<region>. In ELITECAD 

Mechanics only <language> is used for the name. 

Examples for ELITECAD Architecture: 

German-Austria: de_at 

German-Germany: de_de 

German-Switzerland: de_ch 

English-UK:  en_uk 

French-Switzerland: fr_ch 

Examples for ELITECAD Mechanics: 

German:  de 

English:  en 
 

TIP 
Periodically include your user parameters in a data backup. 
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Parameter – Storage type 

This is where you specify whether parameters should be saved by user or globally. 

The User and Global storage modes apply to architectural, mechanical and basic 

parameters. The default user can only save User parameters. In order to save Global 

parameters, parameter management must be set up.  

You can find extended details in manual of the ELITECAD configuration. 

Parameter – Interpretation 

The reader type specifies which parameters should be displayed and which ones take 

priority in the event of redundant designations. With the only global or only user reader 

type, you can check which option has been assigned to which parameters. 

Parameter – Show parameter read mode 

(Extended setting) 

In Read mode, a "U" (for User) or a "G" (for Global) is prefixed before the parameter 

names in type selection menus. 

This option should only be used temporarily, as it slows down parameter access. 

 

Print – Memory limit for graphic output 

The memory limit can be set from 128 MB up to 1 GB. This is the maximum size of 

the file that is generated and sent to the printer when printing a plan. How high this 

value can be set depends on the hardware. 

Larger files are produced when high-resolution bitmap images are integrated into the 

plans.  

If the output file is larger than the memory limit, ELITECAD will halve the plan's 

resolution. This is listed in the info window. 

Print – Print help lines 

Define here whether help lines will appear when printing.  

Print – Print in highest quality (slow print) 

The printer is not sent the individual objects (lines, hatches, text), but rather a 

completely rendered image. This is necessary if the output device cannot handle 

transparency or colour gradients. You must also activate the option for a plan with 

bitmap images if an image fails to appear. 



Chapter 2 – Settings  

www.elitecad.eu  167 

General 

 

Extended settings 

 

Only visible if active: 

 

Hardware – Use a touch pad or another 2-button mouse  

Bypassing mouse drivers on laptops. Can be used if a three-button mouse is not 

correctly recognised by a laptop. 

Hardware – Invert mouse wheel-zoom  

This option reverses the scroll wheel's zoom function.  

Standard: Scroll wheel backwards, image is reduced 

Hardware – Move using middle mouse button (scroll wheel) 

This option changes the function of the middle mouse button (scroll wheel) from the 

ROTATE CAMERA function to MOVE IMAGE. If the option is set and you move 

the mouse while holding down the middle mouse button (scroll wheel), this moves the 

image.  

If you press the [Ctrl] key at the same time, the design model will rotate. 

Hardware – Use horizontal mouse wheel for rotations 

Using the scroll wheel, you can move the camera in the design model. This is only 

possible with mice with scroll wheels that can be tilted left/right. 

Codeword check 

Displays whether the codeword check works using a dongle or a network card. You 

can define this setting under ELITECAD configuration (WINDOWS START menu). 

General – Language  

Display of language settings. 

You can define this setting under ELITECAD configuration (WINDOWS START 

menu). 
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General – Path for temporary files 

Display of path of temporary files. 

You can define this setting under ELITECAD configuration (WINDOWS START 

menu). 

General – Internet update 

After a configurable length of time, the program searches for new online updates to 

the CAD. The online update can be switched off by setting the interval to ~ months. 

User interface 

 

User interface general – View layout 

 

Single view 

The active view is shown. 

Multiple views 

Multiple views can be opened. The maximum number of opened views can be 

specified. 

Views in the tab format 

Multiple views can be opened. The views you open are presented in tab format. The 

maximum number of opened views can be specified. The tabs can be colour-coded by 

view type. 

 

If a new view is selected in views management, it is opened in a new window or new 

tab. 

User interface general – Colour by view type 

Tabs can be colourised. E.g., all section in the same colour. 

User interface general – Colour scheme 

Various user interface designs are available for selection. 
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User interface general – Scrollbar 

To facilitate navigating around the user interface, horizontal and vertical scrollbars can 

be added. 

User interface general – Notifications 

In addition to showing notifications in the info window, the messages can also be 

displayed as info balloons in the Windows taskbar. 

User interface general – Welcome screen at start-up 

The welcome screen shows notifications about updates during the start of ELITECAD 

and offers quick access to recently loaded drawing. Showing the welcome screen 

during the start-up can be disabled.  

Tooltips (quick info) 

If you hover your cursor over a function, a description of it appears. If you continue 

hovering, the extended description is shown. 

 

You can configure the number of seconds of hovering before the extended description 

appears. 

You can specify the display size in pixels in the minimum width field. If you set the 

minimum width to "0", the width is determined automatically. 

Region 

 

Language and region 
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Display of the language for the user interface and the ELITECAD region for parameter 

management. You can define these settings under ELITECAD configuration 

(WINDOWS START menu). 

The System Region is defined in the Windows settings. 

Decimal symbol and symbol for separating values 

  

The ELITECAD standard setting for the decimal symbol is the point, or separating 

values the comma. Optionally the Windows regions settings could be applied. These 

settings are valid for all entries of coordinate values. 

TIP 
Macros always use ELITECAD standard settings. 

  

SAVE/OPEN 

General 

 

Extended settings 

 

Only visible if active: 

 

 

General – Name for "New file" 

Name recommended for an unsaved ELITECAD file right after clicking the NEW 

FILE function or starting ELITECAD. This name is displayed on the title bar of 

ELITECAD. Using the SAVE AS function, you can change this name. 
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General – Master drawing 

File that is automatically loaded after every NEW FILE command. All file extensions 

permitted in ELITECAD are also allowed here. 

General – Query for reference point, description and catchwords 

If this option is set, the system also prompts the user for a reference point, a description 

and catchwords when using "Save as". Each of these must be confirmed by pressing 

[Enter]. 

General – Drawing with .d file extension 

If this check box is not ticked, the file extension is switched off in the Save dialog. The 

file extension .d is no longer recommended for ELITECAD drawings. Doing so also 

switches off all other possible file saving types. 

General – Query in case of different structure settings 

This option is only available in ELITECAD Architecture. If a drawing is opened with 

different structure settings, a query appears how to deal with the differences. 

Project  

The project options are only available in ELITECAD Architecture. 

 Project – Project group  

To make projects more comprehensible, you can introduce project groups. These 

project groups can be organised by client, department or year. This can be activated in 

Setup under Settings or via this check box. 

When this is enabled, the system creates an additional subdirectory under the drawing 

directory with the name of the group, and then creates a folder with the project name 

under that subdirectory. When using multiple workstations, they should all be 

configured with the same option for this setting. 

Project – Add drawing comment to project selection  

The standard setting is switched on. 

In this state, when you read an architecture ELITECAD file that was saved with 

Release 12 or above, the project data is generated in the project directory. The save 

path is also set to the project directory. 

Project – Catchwords  

Adopt project name as a suggestion for entering catchwords when saving a drawing. 

Project – Storeys in files 

If this option is selected, when someone tries to load/activate a storey, the system 

prompts whether it should be loaded "for editing" or only as "reference". 

For more detail, see chapter 8.3 "Working with storeys". 
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Drawing 

 

Drawing – Path for projects  

You can define this setting under ELITECAD configuration (WINDOWS START 

menu). The active state is displayed here. 

Drawing – Include views in save 

This parameter is only active for the SAVE AS function and makes it possible to save 

parts of drawings (e.g. Lib parts) without also saving all views. This reduces file size 

for individual parts. For the SAVE function, all views are always saved as well. 

If this parameter is selected, the SAVE AS function must be confirmed with a 

confirmation prompt. 

Drawing – Include radiosity in save 

This option controls whether or not the radiosity results are saved along with the 

drawing. The data is not part of the drawing itself, but is stored as external references 

and loaded as needed. 

Drawing – Save background image as external reference 

This setting controls whether or not the rendered background images are saved in the 

views as external references. These images are then loaded as needed. 

Drawing – Save textures as well 

The textures are stored in a database and must not necessarily be saved along with the 

drawing. Then the drawing only contains the settings for the texture images, but not 

the data itself.  

If a plan is forwarded to someone without access to the same database, such as a 

partner's office, it is recommended to save the textures along with the drawing. 

Work copies – Path for WOCOs 

You can define this setting under ELITECAD configuration (WINDOWS START 

menu). The active state is displayed here. 

Work copies – No. of work copies (WOCOs) 

Lists how many manual and automatic work copies have been created. These are 

numbered sequentially with numbers starting with 0 up to the specified value. The 

lower the number, the earlier the work copy. If the number of work copies exceeds the 
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specified value when clicking "Save work copy", the oldest one is removed. If the 

number is too large (above 10), this slows down the saving process. 

With project name 

This option is only available in ELITECAD Architecture. The work copies are stored 

for each project when this function is selected. The name of the work copy is prefixed 

with the project name. 
 

EXPLANATION 
This option can lead to too many work copies amassing and taking up a 

large amount of memory. Periodically, work copies that are no longer 

needed should be deleted manually.  

Work copies – Selection 

 

The automatic work copies are saved in the same directory as the manual work copies 

but have names with "woco.auto..." 

Work copies – No. of functions used 

When setting SAVE AFTER X ACTIONS or REMIND AFTER X ACTIONS, you 

can specify the number for "x". 
 

EXPLANATION 
If you set "No. of functions used" to 50 that means that an auto-save or 

reminder will occur after 50 main functions.  

File exchange 
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DXF parameters 

 

This field takes you to the DXF import and DXF export parameters. 

WORK PARAMETERS 

General 

 

General – Work in parallel work planes 

When this option is selected, it not only takes into account elements on the current 

work plane (as would be the case when the option is switched off), but also elements 

located on work planes that are on a different height parallel to the active work plane. 

In the default state, capture points are found on all storeys in ELITECAD Architecture. 

General – Confirm delete 

 

When this option is selected, after you attempt to delete, a dialog window opens asking 

you to confirm the deletion. 

General – Hatch in contour model 

This setting is only meaningful if you are working in the "V11 user interface". 
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The hatch is assigned to the model of the hatched contour. If the contour consists of 

multiple patterns, the hatch is assigned to the one pattern that shares the largest part. 

General – Text into new model 

This setting is only meaningful if you are working in the "V11 user interface". 

The text is assigned to a new model.  

General – Automatic text enlargement 

Small texts are displayed enlarged during entry or when editing. 

General – Contour search 

 

Here you can specify branching mode for contour search (Measure area, Hatch). 

You can use this function to specify the automatic process for a drawn contour. 

Branching at point 

The crosshairs move onto where the start/end points of two lines meet. 

Branching at T-junction 

If the start/end point of line is on another line, the crosshairs continue at this branching 

point. 

Branching at section 

If two lines cross, the crosshairs continue onto the other line. 
 

TIP 
Contour search is used for the following functions: HATCH, AUTO-

HATCH, PLANES, EXTENT, PLANE FOCAL POINT AND 

PARALLEL CONTOUR.  

General – Corner with parallel contour 

The option specifies how corners are treated when generating a parallel contour. 

 No other elements are added. 

 Corners are added matching the existing contour. 

 The corners are treated as curves whose radius corresponds to the distance of 

the parallel contour. 

Delay with properties bar 

If an entry is changed in the properties bar, the length of time specified here is how 

long it takes until the value is adopted.  

If the "tilde character " is selected, the change must be confirmed by pressing [Enter]. 

Entry of text direction 

Determines how the angle is measured for the text slant. This entry is only available 

for CAD character sets, not for TTF fonts. 

Measure – Decimal places when measuring 

The output of decimal places is rounded to the specified value. Applies only to outputs. 

Internally, renderings use all available decimal places. 

Measure – Preview area 

If the MEASURE AREA function is selected, the contour in focus is highlighted. 
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Drawing 

 

Extended settings 

 

Only visible if selected. 

 

Drawing parameter(s) of active drawing 

This tab displays the parameters of the active loaded drawing. If no drawing is loaded 

or the drawing has no saved parameters, the parameters saved in NEW DRAWING 

are displayed. 

Drawing – Unit 

 

Drawing – Angle unit 
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Drawing – Format 

 

Drawing – Dimension 

 

Drawing – Reference point 

The X and Y values list how far the reference point is in centimetres from the start or, 

after NEW FILE, from the centre of the screen. This is also the absolute zero point 

(X=0, Y=0). 

Drawing – Draw mode 

(Extended setting) 

 

The default setting is RELATIVE. With this setting, enter all figures for a point request 

in the entry line relative to the current CAD cursor position. 

With the ABSOLUTE setting, the figures you enter are always calculated based on the 

CAD reference point. This is normally in the centre of the screen in CAD. 
 

TIP 
You can click on the symbol adjacent to the value in the value field to 

switch between "relative" and "absolute". 

 

Characters for absolute 

 Characters for relative  
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Drawing (CAD start) 

 

This tab displays the pre-settings. These settings take effect after NEW FILE or right 

after ELITECAD is launched. 

The parameters are the same as those described under DRAWING. 

Edit 

 

Extended settings 

 

Only visible if selected. 
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Copy/move – Correct dimension angle  

If this parameter is set, dimension texts are adjusted with the rotation so they are not 

upside-down. 

Copy/move – Correct dimension value 

If this parameter is set, dimension texts (single dimensions) are automatically adjusted 

after manipulations (move, copy, rotate, scale, etc.). The architecture dimension (chain 

dimension) is always adjusted automatically. 
 

TIP 
Be careful with modified dimension texts: 

If dimension texts were modified, they are corrected back to the true 

value after manipulations.  

Copy/move – Correct hatches 

If this parameter is set, hatches are rotated during manipulations. 

Copy/move – Rest scaling 

With functions that use scaling, when REST SCALING is selected, the "rest" items 

are scaled (text, dimensions, arrows and hatches). 

Copy/move – Correct texts (Rotation/mirroring) 

If this parameter is set, texts are adjusted with the rotation so they are not upside-down. 

In keeping with the standard, the check box must be selected so that texts are always 

represented visibly. 

Undo – No. of steps 

Can be configured between 0 and 100 %. As increasing the number of steps also 

increases the number of saved operations; this number also has an effect on 

performance depending on the hardware. 

Selection – Selection using Group/Class/Level 

If this check box is ticked, you can work with the full organisational scheme. If the 

drawing is structured using layers, the option should not be selected. 
 

TIPP 
We recommend no changing of the presets in ELITECAD Architecture. 

  
 

When this is selected, the organisational structure of the active model is displayed in 

the status bar on the bottom right. (M:    G:     C:     L:) 

 
The "Selection" toolbar displays the ACTIVATE MODEL and NEW MODEL 

functions and the selection mode for model, group, class and layer. 

 

Selection – Synchronise class with layer(s) 

This function is important for carrying over plans from version 9.2 or earlier. 

When this option is selected, the classes are linked with the layer. The layers have the 

same names as the classes. The option should be selected if you are working with plans 

from version 9 and have used the plan filter. 
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Selection – Pre-setting for part selection mode 

When it is selected, the "Selection mode for part" is selected, if the "V11 user 

interface" is activated. 

Selection – V11 user interface 

If this option has been selected, you can use the same user interface as in version 11. 

Selection – De-activate object lock 

The option is only available if the "V11 user interface" check box is ticked. 
 

If the object lock is deactivated, the architectural or mechanical objects are no longer 

protected from manipulations that destroy the objects, such as the DELETE SECTION 

function. 

Geodesy 

 

Geodesy – Reference point alignment  right 

The value you enter here is taken into account in the COORDINATES OF POINT 

function and all specified coordinates. 

Geodesy – Reference point alignment  upwards 

The value you enter here is taken into account in the COORDINATES OF POINT 

function and all specified coordinates. 

Geodesy – Rotate ref. system 

The value you enter here in degrees is taken into account in the COORDINATES OF 

POINT function and all specified coordinates. 

Geodesy – Dimensioning coordinates 

 

Y: upwards, X: rightwards 
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The first coordinate for entry and output is the X-value, and then comes the Y-value. 

Positive X upwards, Y rightwards 

The first coordinate for entry and output is the Y-value, and then comes the X-value. 

X: downwards, Y: rightwards 

The first coordinate for entry and output is the X-value, and then comes the X-value. 

Here, the positive x-axis points downward. 

Reference plan / layer 

 

Storage mode 

 

Behaviour of reference plan when saving. With "selection for inclusion in save", a 

query appears. 

Print in single colour 

Behaviour of reference plan when printing. 

Colour of reference plan 

 

Specifying pen colour for reference plan. 

Colour of blocked layer/storey 

 

Specifies the pen colour of the locked layer and locked storeys (only in ELITECAD 

Architecture). 
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Architecture 

This option is only available in ELITECAD Architecture. 

 

Extended settings 

 

Only visible if selected. 

 

Architecture work parameters – Use renovation planning  

This setting is the main switch to activate renovation planning. Only if the option is 

active, the objects may be assigned to a renovation planning state and the assembly 

filter for the states can be used. 

Architecture work parameters – renovation planning objects according material 

Some renovation planning objects are created automatically (e.g. filling walls for 

demolished windows). You can select the depiction mode for these new objects, which 

is done either coloured using the defined depiction parameters of the states or 

according to the material settings of the representation levels. 

Architecture work parameters – Generate roof sections at once  

Deselecting this reduces the processing needed and increases performance. The update 

can be made later using the REFRESH AR-OBJECTS function. 

Architecture work parameters – Create 3D intersection with layers immediately 

Deselecting this reduces the processing needed and increases performance. You can 

refresh this later via the menu item REFRESH AR-OBJECTS. 

Architecture work parameters – Refresh after move/copy 

Deselecting this reduces the processing needed and increases performance. You can 

refresh this later via the menu item REFRESH AR-OBJECTS. 
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Architecture work parameters – Refresh rooms now 

If this option is deactivated, the rooms are not automatically adjusted if the walls 

around the rooms change. You can refresh this later via the menu item LAY-OUT > 

REFRESH ROOMS. 

Architecture work parameters – Textures across construction parts 

If this option is selected, all construction parts are given the same texture so that no 

textural transition is visible between storeys or at the meeting points of walls. 
 

TIP 
This option should be deselected for larger projects for the sake of 

quicker processing. This is not necessary for an EFH or for smaller 

objects.  

Architecture work parameters – Show duplicated room descriptions while 

drawing 

This option helps the person drawing avoid creating room contours that are no longer 

closed when performing manipulations in the floor plan. 

Quantities 

This option is only available in ELITECAD Architecture. 

 

Quantities – Display docu-text 

When this is selected, an additional text is written into the plan for all architecture 

objects following the SUMMARY TO PROJECT BOOK function. The name consists 

of an architecture object abbreviation and a serial number. 

For example, WA1, etc. Wall Number 1, RM1, etc. Room Number 1, etc. 
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General – By storey 

The assignment of docu-texts can be defined for each storey. 

General – Parameters 

Text parameters for the docu-text. 

General – AR-object | Text 

This table can be used to define the assignment of abbreviations to architecture objects. 

You can enter the abbreviations in the text fields. 

Area verification 

This option is only available in ELITECAD Architecture. 

 

Plane(s) verification 

Settings parameter for the area verification that is generated using the AREA 

VERIFICATION function in the EXTRAS menu > QUANTITIES. 

Living space verification 

Settings parameter for the living space verification that is generated using the LIVING 

SPACE VERIFICATION function in the EXTRAS menu > QUANTITIES. 
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Mechanical 

These options are only available in ELITECAD Mechanics. 

 

Mechanical – General – Bill of material 

 

With ELITECAD, you currently have four possibilities to generate a bill of material. 
 

 Info window 

Bills of material in the info window are used for a quick check of the entries 

and assigned attributes. Information printed in the info window are replaced by 

the subsequent output into the info window like object information. 
 

 Graphic 
A bill of material can be positioned into your ELITECAD drawing using the 

snap functions. A subdivision point is queried which is used to split long lists 

and the second part could be positioned on a different position. Use the [Esc] 

key in order to undo a split or positioning operation. The positioning operation 

of the bill of material is completed with the [Enter] key. 
 

Calling the bill of material function once again allows modifying later. The complete 

bill of material can be selected with the mouse and repositioned with the manipulation 

function or it can be deleted with by selecting and pressing the [Del] key. 
 

Bill of material drawings (<ELITECAD installation path>\u\<version>\me 

\glob\l\table\bom_def_standard.d and bom_tail_standard.d) can be adjusted to your 

needs. These ELITECAD files define the layout of the bill of material by the drawn 

geometry, the elements (pen/line type) and texts (size, colour, reference point, etc.). 
 

 Text file 

After having defined the file name for the bill of material, it is opened with an 

editor (Notepad) for checking. 
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The bill of material definition file (<ELITECAD installation 

path>\u\<version>\me\glob\dflt\mecha.bom) can be adjusted with a text editor. 
 

 Excel 
See chapter 12.3: Creation of bill of materials, section Excel. 

Mechanical – General – Table output 

 

With ELITECAD, you currently have three possibilities to display calculation results 

and other data. 
 

 Info window 

Data is displayed in the info window for quick checks.  

 Graphic 

Data is positioned as a table into the drawing. 

 Text file 

Data is written into a specified ASCII-file 
 

This setting is valid for the output of following tables: 

- Tolerance table 

- Fittings table 

- Result of the calculation of the moments if inertia 

- Result of the calculation of the area 

These options have no influence to the results of the measure functions. 

The results are always displayed in the CAD info window. 

Mechanical – General – Reference point selection during placement 

 

 

Mechanical – General – Helper objects as independent objects 

 

Mechanical – Standard parts 

 

In diesem Teil der Maske können Einstellungen über das Verhalten von 

Normteilschraffuren bei Manipulationsfunktionen sowie Stiftfarbe und Linientyp 

getätigt werden. 
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Mechanic lines 

These options are only available in ELITECAD Mechanics. 

 

Mechanic lines – break lines 

 

This is the setting for the line parameters pen and line types for the depiction of break 

lines of partial sections and detail cut-outs. 

Mechanic lines – hidden lines 

 

This is the setting for the line parameters pen and line types for the depiction of hidden 

lines of invisible component contours. 

Mechanic lines – thread lines 

 

This is the setting for the line parameters pen and line types for the depiction of thread 

lines of standard parts. 

Mechanic lines – centre lines 

 

This is the setting for the line parameters pen and line types for the depiction and the 

extent over the component boundaries for centre lines of rotational objects and circle 

centre lines. 
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DEPICTION 

2D/3D 

 

Extended settings 

 

Only visible if selected. 

 

2D – Rubberbanding  

This is where you specify the pen and line type for rubberbanding (an elastic band 

attached to the cursor). 

2D – Polylines 

This is where you specify pen and line types for representing the lines (e.g. for 

selection with block/section functions). 

2D – Show line gauge 

On screen, the line gauge is represented according to the width for each pen in the 

colour settings. 

2D – Dimension and text checks 

 

In order to determine whether linear dimensions no longer possess any association, 

this can be displayed optically. The depiction uses red arrows and highlights the 

dimension text in red. A red arrow means that the point at which the dimension was 

set has lost its association and no longer matches the represented size. 
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2D – Windows True-Type-Fonts 

(Extended setting) 

TTF ELITECAD texts are selected and depicted with real Windows True Type Fonts. 

Otherwise, there is an approximate depiction. 

2D – Elements always in foreground 

(Extended setting) 

If the option is inactive (default setting), the individual object's visibility is controlled 

by the sort order. 

If this option is selected, elements, texts, line hatches, dimensions and arrows are 

always represented before the infill hatch no matter the sequence of the objects.  
 

EXPLANATION 
As the control of foreground/background was not available in versions 

before V11, this option is set automatically if you load plans from 

versions before V11 in order to prevent the plan image from changing. 

If a new drawing is open, the check box is automatically reset again. 

  

2D – Image resolution 

 

This function is used to convert monochrome bitmaps into greyscale. 

Once you switch to high quality, all monochrome bitmaps are represented in greyscale. 

Likewise, upon switching to normal quality, they are represented in monochrome. 
 

TIP 
For colour images, the IMAGE RESOLUTION function does NOT 

have an effect, as colour images are always represented in high quality. 

If there are both monochrome and colour images on the screen, the 

monochrome images are NOT converted either.  

3D – Box mode 

Using the "3D – Box mode" check box, you can depict a box outlining a part instead 

of its exact 3D depiction. This drastically accelerates image assembly. 

The only objects represented as a 3D-encasing box are those that are predefined by 

selecting them and pressing [Ctrl]+[Num]. You can remove this depiction type from 

the current selection by pressing [Ctrl]+[Num]. 

3D – object reflections automatically 

When the shader technology is switched on and the option is active, the object 

reflections are automatically calculated or updated. 
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3D – Activate edges with solid mode 

If you switch to solid mode, the edges are automatically activated. 

3D – Activate shader with solid mode 

If you switch to solid mode, the shader technology is automatically activated. 

Image display 

 

Extended settings 

 

Only visible if selected. 

 

General – Animate camera 

If you move the rotated design model back to its starting position using the IMAGE 

START POINT function, the camera is shifted gradually, not jerkily. 

General – Interrupt assembly 

The "Interrupt assembly" parameter cancels the image assembly as soon as a new 

image assembly becomes necessary due to a modification (zoom, move, change 

window size, etc.). This speeds up the system, as that way an individual image 

assembly is not carried out completely before being overwritten anyway. 

General – Double buffer 

The "Double buffer" check box only takes effect in combination with OpenGL. This 

is normally always switched on and enables smooth, dynamic rotation in 3D without 

jerky movements. 

General – Pen filter for elements only 

When this check box is selected, the pen filter (View > Pens...) only applies to 

elements, but NOT to dimensions, hatches or arrows. 

The selected pen filter is only used for the image view but not for manipulation 

functions. 

Colour mode – Type 

Default colour mode setting for ELITECAD start or in New file. 
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For an explanation, see Colour mode. 

For "Printer" colour mode, the option ALLOW BLACK BACKGROUND also 

appears. For the "Model, Group, Class, Layer" colour modes, the colours can be 

specified. 

Colour mode – Highlight active object by  

The active (current) object/model can be highlighted in two different ways in order to 

make it better distinguishable from others. 

 

It is displayed brighter (greater line width) than all others. 

 

It is depicted with the pen colour in the colour mode "Mono". In other colour modes, 

this option is not recognizable very well. 

Colour mode – Allow black background 

When switching the background colour, switching to black is prevented, in case also 

lines are displayed in black. If this option is active, then this combination is 

permissible. 

OpenGL – Use OpenGL  

On by default. If this check box is deselected, the GDI graphic display is always used 

except in solid mode. 

OpenGL – Two sided lighting 

Off by default. In this state, ELITECAD takes over rendering of lighting. 

OpenGL – Use OpenGL 

(Extended setting) 

In rare cases, if there is an error when rendering with the graphic/video card, it may be 

necessary to select this check box. Then ELITECAD takes over rendering images. 

However, this leads to worse performance. 

OpenGL – Reduced textures 

Texture images with large amounts of data can be represented in OpenGL with reduced 

quality in order to save memory and rendering time. 

This option controls whether or not high-resolution textures are to be used. 

OpenGL – Texture compression 

Texture compression is a procedure for reducing the storage need of textures. This also 

carries a benefit in terms of speed. 

Render – Update render mode in case of camera change 

If this option is selected, rendering is automatically restarted after each change to the 

camera (zoom, rotate). When it is deselected, the design model is restored to the solid 

depiction and rendering must be re-triggered manually. 
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Architecture 

This option is only available in ELITECAD Architecture. 

 

General – Outer contour 

Show or hide outer contours. 

General – Room contour 

Show or hide room contours. 

General – Opening contour 

When the opening contour is selected, the floor plans of window openings, doors and 

wall openings are displayed as graphical aids. 

General – Wall axis 

Show or hide wall axis. Switching on wall axes helps connect two walls. The axis is 

represented in blue pen. 

Time states (renovation planning) – Visibility filters 

Three time states are configurable: Before or after the renovation, as well as a working 

state. Switching is possible via functions in the RENOVATION PLANNING toolbar. 

Time states (renovation planning) – Animation 

The change between two time states can be animated with simple and good 

transparency quality. The duration of the animation is set in seconds. 

Renovation Planning 

This option is only available in ELITECAD Architecture. 
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Object colouring 

 

The depiction of objects is done either coloured with the defined depiction parameters 

of the states or according to the material settings of the representation levels. 

For each of the states demolition, existing and new construction the same colours, line 

type settings and text options available. 

Colour settings 

 

You can select the colour for lines, 3D surfaces, texts, line hatches and filling hatches. 

The line type remains or is overwritten. 

Text settings 

 

Texts may remain unchanged or are underlined, crossed out or over lined. 

 

The background of texts may remain unchanged or is depicted with a fill colour or 

inverted. It may also be depicted with a borderline or inverted with borderline. 
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Tools 

 

Grid – Type 

 

This function specifies the grid type. 

Grid – Pen 

Pen colour of grid. 

Grid – Distance 

The first value matches the point distance of the grid in the X-direction. 

The second value matches the point distance of the grid in the Y-direction in terms of 

the configured units. 

Grid – Angle 

The value specifies the desired angle of the grid. 

Handles – Standard  

 

Pen colour of handles. 

Handles – Size 

The size of the handles can be configured from 3x3 pixels up to 10x10. 

Handles – Selection 

 

Pen colour of a selected handle. 

Handles – Text: 
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Specify the position of text handles here. If the option is set to "on frame", the handles 

have a specific distance from the text. For the ON TEXT option, the handles are 

directly on the text. 

AUTOcapture mode – Point colour 

Specify the pen colour of temporary capture points here. 

AUTOcapture mode – Size 

The size of the temporary capture points can be configured to be from 10x10 up to 

20x20 pixels. 

AUTOcapture mode – Line colour 

Pen colour of temporary help lines. 

AUTOcapture mode – Snap time 

If you hover over a point with the cursor, it take the length of time specified here until 

the temporary capture point is shown. 

VIEWS 

General 

 

Extended settings 

 

Only visible if selected. 

 

General – Prompt when refreshing 

If this is selected, the user will be prompted upon changing into a view whether it 

should be refreshed. 

General – Automatic hiddenline printing 

Automatically renders a hidden line depiction when calling up the printer. Otherwise, 

the printout will match the representation on the screen. 

General – Calculation with hardware support 

(Extended setting) 
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When this is selected (default setting), the graphics hardware is used for various 

renderings. This raises performance when using hidden lines, views where shadows 

are cast or views with intersection lines. 

In rare cases, if there is an error when rendering with the graphic/video card, it may be 

necessary to deselect this check box. Then ELITECAD takes over rendering. However, 

this leads to losses in performance. 

General – Save display list in view 

When this is selected (default setting), information from individual views is kept in the 

RAM and facilitates switching more rapidly between the different views. If there is 

not enough memory for specific drawings, this option can be deselected. 

General – Use external rendering process 

If there is a large number of render graphics in high resolution, it may be the case that 

the RAM becomes fragmented and is no longer fully available after a period. As such, 

the render graphics can no longer be rendered. To circumvent this, the external render 

process may be used. However, only activate this option if necessary. 

Pre-setting – Display new views as 2D-Views 

When this option is selected, (unchanged views) are inserted as the VIEW type into 

the plots. 

When this option is deselected, (unchanged views) are inserted as the DESIGN 

MODEL type into the plots. 

This way you can define the basic way that views that have not been changed are 

inserted into the plots. 

Pre-setting – Generate 4 views with title 

If 4-views are inserted into a plot, a title is displayed above each view. 

The following views are inserted when inserting "4-views": 

Top view 

Isometric view 

Side view left 

Front view 

CAD-start – 3D axes 

If this option is selected, the 3D axes are selected after NEW FILE or after 

ELITECAD is launched. 

CAD-start – Shadow 

If this option is selected, the drop shadow in solid mode is selected after NEW FILE 

or after ELITECAD is launched. 

Pre-setting - 4 views according to ISO/ANSI 

This setting is only available in ELITECAD Mechanics and defines according to which 

standard the four views are inserted into a plot view. 
 

ISO      ANSI 

  

Front view 

Top view 

Top view 
Side view 

Side view 

Isometric view 

Isometric view 

Front view 
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Vector shadow 

This option is only available in ELITECAD Architecture. 

 

Vector shadow parameters for the active drawing 

This tab displays the parameters of the active loaded drawing. If no drawing is loaded 

or the drawing has no saved parameters, the parameters saved in NEW VECTOR 

SHADOW are displayed. 

To modify the settings, you must save them by clicking OK. 

Hatch – Parameter  

Selection of a hatch parameter with which the shadow will be filled. 

Hatch – Pen 

Pen colour in which the shadow contours will be drawn if the "Draw contours" check 

box is selected. 

Hatch – Draw contours 

Select or deselect drawing the shadow contours. 

Shadow – Resolution 

 

Resolution Details Calculation time 

minimal few small 

normal   

good 

Very good 

maximal all large 
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Shadow – Do not renew shadows 

Off by default. When off, the shadow is always re-rendered, which may require more 

or less time depending on the drawing's size. By selecting this, you can suppress 

shadow rendering. An existing shadow is retained. 

Selection – Objects that cast no shadow 

 

The window displays a selection of available layers. 

When a layer is selected, a shadow is not rendered from any objects assigned to that 

layer. 
 

TIP 
When rendering the vector shadow in the presence of terrain, the 

OBJECTS THAT CAST NO SHADOW check box should be selected 

for the terrain. This saves rendering time.  

Selection – Object that receive no shadow 

The window displays a selection of available layers. 

When a layer is selected, a shadow is not rendered onto any objects assigned to that 

layer. 

New vector shadow 

This option is only available in ELITECAD Architecture. 



Chapter 2 – Settings  

www.elitecad.eu  199 

 

This setting displays the pre-settings. These settings take effect after NEW FILE or 

right after ELITECAD is launched. To modify the settings, you must save them by 

clicking OK. 

The parameters are the same as those described under VECTOR SHADOW. 
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2.3 CAMERA 

 

*Modify toolbar 

View menu > Camera 

The dialog window is used to set the current camera. 

4-VIEW WINDOW 

The camera is set up in the 4-view window. If the camera dialog window is open, only 

the camera symbol can be clicked in CAD. CAD objects cannot be selected or 

manipulated. 

The depiction of the design model view can be controlled separately. If you right-click 

in this area, a menu opens where you can select how the design model view should be 

represented. This is also true for the other views, as they are interconnected. 

 

TIP 
The depiction of the standard view should be in the wire model, if 

possible, as this speeds up image assembly.  

 

 

 

Using camera in the 4-view window 

There are various handles available, which you can use to manipulate the camera 

interactively while holding down the left mouse button. 
 

Modify position of camera   Move camera 

Front view Side view left 

Floor plan Design model view 
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Modify direction of camera   Modify opening angle of camera  

   

MAIN CAMERA WINDOW 

 

 

The camera dialog window manages a list of named camera positions. The active 

camera is always visible. By selecting one entry in the list, a previously saved camera 

is activated again. 
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Save camera 

 

The save function stores the active camera as a new entry in the list of cameras. By 

clicking on the name, the camera can be renamed. 
 

TIP 
Camera positions can also be created with the SNAPSHOT function. 

This is very practical in the walking mode. 

  

Delete camera 

  

The camera selected in the list is deleted. 

Camera export and import 

  

All camera positions are saved into a file or read back from a file. 

Camera status 

 

If you left-click on this symbol, you can switch between perspective and parallel 

projection. If you right-click on the symbol, a sub-menu appears where you can choose 

the projection directly. 

Camera position 

 

Here, enter the coordinates for the "View position" and "Focal point". The values are 

either defined using interactive configuration, or by entering them in the entry fields 

manually. 

Opening angle 

The opening angle can be modified using this slider. The value is defined using 

interactive configuration, or by entering it in the entry field manually. 
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SAVE CAMERA 

 

Camera toolbar 

Menu View > Camera > Save camera 

With showing the camera save dialog, a snapshot is saved with preconfigured quality 

settings and is added to the list of cameras. That allows returning to interesting 

positions later. 

LOAD NEXT CAMERA 

 

Camera toolbar 

Menu View > Camera > Load next camera 

This function switches to the next camera in the camera list. 

LOAD PREVIOUS CAMERA 

 

Camera toolbar 

Menu View > Camera > Load previous camera 

This function switches to the previous camera in the camera list. 

CAMERA MODE ROTATE/MOVE 

 

Camera toolbar 

Menu View > Camera > Camera mode Rotate/Move 

This function activates the camera mode Rotate / Move. 
 

Fundamentally, the viewing point of the observer is defined as a camera position. In 

the Rotate/Move the model is rotated and moved in space in front of the observer. 

Zooming merely changes the angle of aperture, but does not change the distance from 

the observer to the model 

CAMERA MODE WALK 

 

Camera toolbar 

Menu View > Camera > Camera mode walk 

This function turns on the camera mode walk. 
 

The walking-mode on the other hand changes the position of the camera, and allows 

navigating through a model. 

Changing the position is implemented in various ways through supporting multiple 

input devices. The simplest way to do this is with a gamepad, but also mouse and 

keyboard can be used. The Behaviour in the walking mode and the usage of input 

devices is described in the chapter Settings > input devices. 

TIP 
It is recommended to activate real-time visualisation for presentations 

in the walking mode. 
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FUNCTIONS IN THE CAMERA MODE WALK 

Some functions only make sense in the camera mode walk and are not available in the 

traditional menu. Nevertheless, it is possible to assign functions to buttons on input 

devices or put them into the graphical menu (see Settings > Input devices). The 

graphical menu is displayed via the right mouse button in the walking mode. 

Alternatively, the menu display can be assigned to a button on the gamepad. This 

section only contains a description of functions that are exclusively available in the 

walking mode. 

Interaction 

Interaction in direction of view 

 

 

Graphical menu in the walking mode 

During walking-mode or in 

a virtual reality 

environment it is possible 

to interact with the model 

without switching to the 

traditional ELITECAD 

interface. A small cross hair 

indicates the focal point. 

Depending on, which 

object is in focus, the 

interaction button shows 

available actions. 

Fast interaction 

 

 

Graphical menu in the walking mode 

When quick interaction is used, the selection with the highest priority will be chosen 

(e.g. library part before material). 

Exchange of skymaps 

 

 

Graphical menu in the walking mode 

The new graphical menu offers all skymaps, which are located in the same folder as 

the selected skymap and displays preview images. 

Exchange of material 

 

 

Graphical menu in the walking mode 

The new graphical menu also shows all materials, which are located in the same folder 

and displays preview images. The rendered effects, like reflections, are preserved upon 

a change of material or are recalculated again. 

Exchange of library parts 

 

 

Graphical menu in the walking mode 

The graphical menu shows all library parts, which are located in the same folder and 

displays preview images. 
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Selection 

 

 

Graphical menu in the walking mode 

This function is used to select an object. If the property bar is visible, the object 

properties will also be displayed in the full screen mode. 

Object Information 

 

 

Graphical menu in the walking mode 

This function is used to display the properties of the selected object. 

Teleport 

 

 

Graphical menu in the walking mode 

With this function, the position is changed to the focused point (hair cross). If camera 

animation is active, the movement is displayed animated. 

Increase the aperture angle 

 

 

Graphical menu in the walking mode 

The camera aperture angle is defined in the configuration of the walking mode. With 

this function, the angle can be increased dynamically. 

Decrease the aperture angle 

 

 

Graphical menu in the walking mode 

The camera aperture angle is defined in the configuration of the walking mode. With 

this function, the angle can be decreased dynamically. 

Show context menu 

 
 

Graphical menu in the walking mode 

The context menu of the traditional user interface can be displayed over the graphical 

context menu. 

Show graphical menu 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device and allows the display of 

the graphical menu. 

Jump 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device and allows jumping in the 

walking mode. 
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Run 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device. Walking speed is 

increased by pushing and holding the button. 

Crawl 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device. Crawling is enabled by 

pushing and holding the button. 

Walk slowly 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device. Walking speed is slowed 

down by pushing and holding the button. 

Rotate slowly 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device. Rotation speed is slowed 

down by pushing and holding the button. 

Fly up 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device and allows moving up in 

the walking mode. If gravity is turned on, the observer position is automatically going 

down after releasing the button. 

Fly down 

 

 

Button configuration of input devices 

This function can be assigned to a button of an input device and allows moving down 

in the walking mode. If gravity is turned on, the observer position is automatically 

going further down after releasing the button. 

Suspend restricted input devices 

 

 

Graphical menu in the walking mode 

Multiple gamepads can be used simultaneously in the walking mode. The presenter 

usually uses the main gamepad. All other gamepads are defined as restricted gamepads 

in the configuration of input devices. 
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With this switch, all restricted gamepads are deactivated and the presenter takes 

control alone. Now the presenter can walk to new positions. 

 

Reactivation of the functions resumes the suspended gamepads. 

Suspend audio output 

 

 

Graphical menu in the walking mode 

This function is used to turn the audio output for effects on and off. 

Flashlight on/off 

 

 

Graphical menu in the walking mode 

This function is used to turn the flashlight on and off. 

CAMERA PATH 

The camera path is represented as a 3D line, is an individual object and can also be 

saved separately. Multiple camera paths are supported for every model. 

Automatic recording in camera mode Walk 

 
Whenever the user navigates through the model in walking-mode, ELITECAD is 

recording all movements as intelligent camera path 

Create camera path 

 

Camera toolbar 

Menu View > Camera > Create camera path 

As an alternative to the automatic recording in the camera mode walk the camera path 

can be defined manually. For that purpose, multiple camera positions are necessary. 

The movement is interpolated between the positions. Each section is individually 

configurable. 
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View parameters 

For the generation of preview images either the current settings or the settings from 

the camera mode walk are used. 

Cameras 

The list shows all previously saved camera positions. The last selected entry is 

displayed in the camera preview. 

  Adds the selected entry to the camera path 

Camera path sections 

The list shows all selected camera positions. The camera path is a result of the current 

order. The last selected entry is displayed in the camera preview. 

  Changes the sequence 

  Removes the current entry 

TIPP 
A camera position can be used multiple times. If the same position is 

used twice in a row, a break with configurable length can be inserted.  

Total time 

The total time of the camera animation is indicated here. Either the total time or the 

time for the sections can be defined. 

Constant pace 

This setting is only available if the total time is defined. Either each section has the 

same duration or the movement has a constant pace. If the speed remains constant, 

then sections will have different times depending on their length. 
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Interpolation type 

 

This setting applies to movement towards the selected entry in the camera path 

sections. 

The line of sight of the camera is interpolated during the transition between two 

positions. The rotation of the line of sight is performed either smoothly over the whole 

distance or behaves like a flight. The flight mode aligns the line of sight in the 

beginning to the direction of movement. Then the camera moves towards the target. 

Finally, the line of sight rotates to the end position. 

Section time 

This setting applies to movement towards the selected entry in the camera path 

sections. 

The time for a single section is indicated here. Either the total time or the time for the 

sections could be defined. 

TIPP 
A duration of 0 seconds creates an immediate move from one position 

to the next.  

Start time-camera path-End time 

The camera path is animated in this area. 

Create 

A click on the create button creates the camera path. 

No LOD 

This switch deactivates the level of detail options for the calculation of preview 

images. 

Create a video 

If this check box is ticked, then a click on the create button opens the dialog window 

for creating a video and the defined camera path will be loaded. 

Play current recording 

 

Camera toolbar 

Menu View > Camera > Play current recording 

The current camera path or a saved camera path can be played automatically. The 

experience resembles driving a car along the saved path. 

Load and play camera path 

 

Camera toolbar 

Menu View > Camera > Load and play camera path 

A saved camera path has to be selected first and is then automatically played. The 

experience resembles driving a car along the saved path. 

Restart recording 

 

Camera toolbar 

Menu View > Camera > Restart recording 

This function is used to define a specific starting point for saving a camera path 

manually. 
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If the function is not executed via the gamepad, the user is asked whether the current 

camera path should be saved first. 

Save recording as camera path 

 

Camera toolbar 

Menu View > Camera > Save recording as camera path 

This function is used to manually define a specific end point for saving a camera path. 

If the function is not executed via the gamepad, the user is asked at the end of the 

function, whether the recording of the current camera path should be continued saved 

first or if a new camera path should be started. 

Create a video 

 

Camera toolbar 

Menu View > Camera > Create a video 
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The camera path can be exported as video with numerous graphical effects. If multiple 

camera paths exist, the desired path can be selected after starting the function.  

The preview window in the middle shows the selected path- The left window shows 

the starting frame and the right window displays the last frame.  

Pre-sets 

 Free configuration of the presets 

 Presets for a YouTube 360° video 

 Presets for a Facebook 360° video 

 Presets for a Oculus Rift 360° video 

Video mode 

 2D video 

 Panorama video 

 360° video 
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View parameter 

For the image generations you can use either the current settings or the settings from 

the walking mode. 

Format 

Here you can set the image resolution in pixels. The available options depend on the 

type of the video. If you choose custom type, you can choose the resolution freely.  

Samples per second 

The bitrate defines he frames per second. Entering a value here also sets the period 

value (period = 1000 / frame rate).  

Time period [ms] 

Here you can choose the period [ms] that every frame is displayed. Entering a value 

here also sets the bitrate (Bitrate = 1000 / period). 

Viewing direction 

You can choose between three viewing directions:  

 Current direction 

 Up 

 North 

Kinematics 

In ELITECAD Mechanics, kinematics and video export can be combined. 

 

This option is only visible if a kinematics system is defined and can be activated 

optionally. Depending on the type of simulation, the increment distance or the angle is 

synchronized with the time control of the video. 

Start time 

The start time is a value in seconds, and can be entered manually or with the help of a 

slider. The position in the camera path is displayed in the preview window. 

End time 

The end time is a value in seconds, and can be entered manually or with the help of a 

slider. The position in the camera path is displayed in the preview window. 

Camera path 

The window in the middle shows the preview between start and stop frame.  

Select camera path 

 

If multiple camera paths exist, these buttons can be used to switch between the paths.  

Animate preview 

If this option is set, the window in the middle will show an animated preview of the 

video.  

File 

This text field can be used to enter a target file. This selection can also be made by 

using the button next to it.  
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No LOD 

The settings for Level of Detail are described in Settings > Input Devices, and reduce 

the graphical effects. For image generation the Level of Detail can be deactivated. This 

leads to a better image quality, but also takes more time.  

Follow recording 

The rendering of images can be observed in the window.  

Play video 

At the end of the video generation, the video can be played optionally.  

CREATE A SNAPSHOT 

 

Camera toolbar 

Menu View > Camera > Create a snapshot 

Using the SNAPSHOT function, you can create high-resolution images of the current 

camera position. 

 

 

Type of image 

 2D image 
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 Cubemap 

 Panorama 

 360° image 

Camera 

Using this menu, you can choose the desired camera position from the list of saved 

camera points.  

View parameter 

For image generation use either the current settings, or the settings of the walking 

mode. 

File format 

Here you can choose the file format. 

Format 

Here the resolution can be set in pixels. If you choose user defined, the resolution can 

be entered freely.  

Viewing direction 

Three different viewing directions are available:  

 Current viewing direction 

 Up 

 North 

View picture 

At the end of the image generation, the image can be displayed optionally.  

No LOD 

The settings for Level of Detail are described in Settings > Input Devices, and reduce 

the graphical effects. For image generation the Level of Detail can be deactivated. This 

leads to a better image quality, but also takes more time.  

Auto-create when saving snapshot camera 

If this setting is active, every time a snapshot is saved, an image will be save das well.  

VIRTUAL REALITY 

VR on/off 

 

 

Image properties 

After activating the function, the output of the current camera image is enabled in the 

VR glasses. To be able to use the VR glasses the drivers have to be installed 

appropriately. At the same time the image is displayed in the graphics window 

according to the setting in the dialog CONFIGURATION INPUT DEVICES > VR. 



Chapter 2 – Settings  

www.elitecad.eu  215 

VR quickstart 

 

Camera toolbar 

 

This function executes multiple functions at the same time. 

 Image display in the Oculus Rift is activated. 

 The fullscreen mode is activated 

 If a camera path is present, it is replayed. 

Control 

Moving the head changes the viewing direction, exactly as it would be in the real 

world. The recognition of the movement is done by sensors, in a similar way as 

smartphones detect movements. The control of the body (walking direction) is done 

by a controller or other input devices like mouse and keyboard. All interactions that 

are possible in the walking-mode are also possible in Virtual Reality. 

Stereoscopic autofocus hair cross 

In the centre of the image (which corresponds to the viewing direction) a small hair 

cross is displayed. This point is used to set the depth for the autofocus of the 

stereoscopic image.  

Centre VR headset 

 
 

Graphical menu in the walking mode 

This function is used to reconnect the VR headset with the sensor and to adjust the VR 

glasses. 
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2.4 IMAGE PROPERTIES 

The image properties are docked in the CAD input window above the entry line. 

 

 Parameter view 

 Zoom by 2 points 

 Last zoom 

 Fit to screen 

 Fullscreen mode 

 VR on/off 

 Zoom on format 

 Image start point 

 Colour mode of printer/pen 

 Area renderer 

 Render design model 

 Solid design model 

 Pixel hidden line 

 Wire frame model 

 Shader on/off 

 Edges on/off 

 3D Axes on/off 

 Reset work plane 

 Work plane on surface 

 Work plane through 3 points 

 Select work plane origin 

 Create work plane using normal 

 Change work plane 

 Clipping on/off 

 Camera pivot point 

 Define coordinate system 

 View position 

 Grid on/off 

 Texts on/off 

 Arrows on/off 

 Dimensions on/off 

 Hatches on/off 
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IMAGE PROPERTIES 

 

View toolbar 

View menu > Screen parameters [Ctrl] + [Q] 

All image properties for the depiction of wire models, pixel hidden lines, solid design 

models (with or without shader technology) and rendering can be selected or 

deselected. 

A preset record can be selected for the render settings. The render parameters for a 

custom setting can be called up via the Parameters button. 

For real-time visualization, the shader technology has to be activated first. The Shader 

Effects and Level of Detail for a custom setting can be called up via the Parameters 

button. 

 

TIP 
The settings can be controlled separately for each view. 

  

REAL-TIME VISUALISATION 

The term real-time visualisation means display of a 3D model close to reality while 

changing the camera. As opposed to this, the rendering generates a static image or 

video. 

Because the camera remains changeable, a fast screen refresh is required. This is 

accomplished using the shader technology. 

Shaders generate material visualisation on 3D surfaces in real-time. Surfaces with 

complex structures and depth effects are depicted on flat surfaces, which only need 
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little memory. This process takes place on the graphics card and therefore enables huge 

performance gains. 

 WORKSHOP  

For the efficient usage of real-time visualisation, a few steps are 

necessary. 

Activate the Shader-Technology in the solid mode. 

Use visualisation materials with shader material properties (e.g. grass, 

water, bump maps). 

Activate the shader effects under Settings > Input devices. 

Define a 360° background image for the current view in the view 

parameters. 360° background images can be stored in the material 

management.  

Switch to the walking mode. 

Use a gamepad for navigation through the model. 

An optimal experience of a virtual 3D model is achieved in a Virtual 

Reality environment. If available, activate VR glasses. 

 

 

  WORKSHOPENDE 
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Shader on/off 

 
 

Image properties 

This check box controls the use of shader technology in the solid model. 

Depending on whether the check box is selected, the shaders are activated or 

deactivated. 

Object reflections for mirroring surfaces are pre-calculated only once. Depending on 

the model size, this process can take several minutes. According to the configuration, 

reflections are automatically calculated when activating the shader technology 

(SETTINGS > OPTIONS > DEPICTION > 2D/3D), the walking mode (VIEW > 

CAMERA > CONFIGURE INPUT DEVICES > WALKING MODE) or the 

calculation is manually launched. 

Re-create object reflections 

 

Camera toolbar 

Menu view > Camera > Re-create object reflections 

This function is used to re-create the object reflections for the shader mode. An 

automatic calculation can be activated in the OPTIONS under DEPICTION > 2D/3D. 

Delete object reflections 

 

Camera toolbar 

Menu view > Camera > Delete object reflections 

This function is used to delete the object reflections for the shader mode. An automatic 

calculation can be activated in the OPTIONS under DEPICTION > 2D/3D. 

Update object reflections 

 

Camera toolbar 

Menu view > Camera > Update object reflections 

This function is used to update the object reflections for the shader mode. An automatic 

calculation can be activated in the OPTIONS under DEPICTION > 2D/3D. 
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RENDER PARAMETERS 

  

Parameter 

 

Here you can call up, save or delete settings. 

Settings 
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Mirroring, Refraction 

This setting determines whether mirroring and refraction are rendered as configured 

in each material during the render model's render process. 

Bump mapping 

This setting determines whether bump mapping is rendered as configured in each 

material during the render model's render process. 

Use high resolution textures 

Texture images with large amounts of data can be represented in the render with 

reduced quality in order to save memory and rendering time. 

This option controls whether or not high-resolution textures are to be used. 

Texture filter 

This setting determines whether texture filters are rendered as configured in each 

material during the render model's render process. 

Edge smoothing 

As the image is rendered pixel by pixel and is independent of the resolution, it is often 

possible for slanted edges to appear staircase-like. If you select edge smoothing, each 

pixel is virtually subdivided into smaller points, improving image quality. 

Note that these options increase the memory requirements and the rendering time. 

Therefore, only use it when necessary. 
 

 

Without edge smoothing   with edge smoothing 

   

Image section 

The IMAGE SECTION option has differing availability in the various views. 
 

Active image: 

With this setting, only the active image section is ever rendered. 
 

Format: 

With this setting, the configured format is rendered. 
 

Total scene: 

When doing so, the total scene is always calculated. 

Refresh automatically 

This check box is only available in the design model views. 

If the option is not set, the rendered build is "frozen" and must be manually refreshed 

in case of any changes. If it is set, the design model view is re-rendered when you 

switch to it. 
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TIP 
If you add design model views to the plot, they should not be 

automatically refreshed any more, if possible. Instead, the image should 

be re-rendered every time you switch to the plot view.  

Lighting 

 

This setting determines whether shadows are represented during the render model's 

render process. Using the LIGHT INTENSITY option, you can change the brightness 

of all light sources globally. 

Radiosity 

 

Daylight rendering is a process for rendering the energy distribution of atmospheric 

light in the scene. If the light strikes planes, they reflect it and diffuse it back into the 

room. In this process, the light energy is progressively reduced with distance. 

This energy diffusion enables a basic illumination level as would be found on a cloudy 

day, which you can combine with other light sources. 

Intensity 

If the slider is set to "0", the other options are blocked and the rendering is not run. If 

a value is entered, the radiosity rendering is started the next time rendering is started. 

After rendering has been completed, the intensity of the result can be adjusted 

retroactively without the need to run the rendering again. If you reset the slider to "0", 

the radiosity result is deleted. 

Quality 

You can distinguish between "preview", "simple", "good" and "optimal", each 

requiring progressively more rendering time. While working, it is recommended to 

only use the "preview" depiction and only use the optimal rendering for the final 

image. 
 

Preview:   Simple:   Good/optimal: 
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Daylight 

You can choose between OUTSIDE and INSIDE. The OUTSIDE option simulates 

light from the entire sky, while the INSIDE option simulates the light entering through 

the window. 

Accordingly, only use INSIDE daylight for interior perspectives. 

Use all windows 

This check box is only available if daylight is set to INSIDE.  

If the option is not selected, the radiosity lighting only uses the windows that are visible 

from the position of the camera. If the option is selected, all included windows are 

used for rendering, which may potentially lead to prolonged rendering time. 

Radiosity Update 

Once the radiosity has been rendered, it is not automatically refreshed when the 

geometry is modified. The daylight rendering process must be manually restarted. In 

the Render depiction (design model view only), right-click in the graphic window and 

then on "Radiosity Update". 

 

Quality 

 

You can control the quality of the rendered image in this area. 

Resolution 

There are three options available for selection. 
 

Display quality: 

ELITE's current work area is used no matter which format is selected. The screen's 

resolution also has an effect. That is why the quality is expressed as a percentage and 

not in DPI. 
 

Print quality: 

The quality is dependent upon the format and the selected image section. Based on the 

calculated pixels, the quality in DPI (dots per inch) can be specified. 
 

Free: 

You can enter the pixel values manually. 
 

TIP 
Do not set the quality unnecessarily high while working. Only do so 

before rendering the final image.  

ZOOM BY 2 POINTS 

  

View toolbar 

Image properties 
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This function is used to enlarge details of the drawing to fill the screen. 

After you activate the function, enter the lower left and upper right corner of a "range" 

that contains the detail to be enlarged. You can also highlight the upper right corner 

before the lower left corner. 

LAST ZOOM 

 

View toolbar 

Image properties 

When this function is selected, the previous zoom area of the active window is 

represented. 

If you are already working in an image section and require a greater enlargement, 

simply select a new zoom level to continue working at that level. 

To return to your original zoom cutout, use the LAST ZOOM function. 

FIT TO SCREEN 

 

View toolbar 

Image properties 

Selecting this function sets a zoom for all visible elements. 

You can run this function periodically to check whether data exists outside of the 

format (e.g. after importing DXF data). 

ZOOM WITH FACTOR 

 

Options toolbar 

Image properties 

This function enables the enlargement of an existing depiction around a point to be 

specified. 

After you activate the function, specify the zoom factor (enlargement factor) and the 

position of the reference point. The position of the reference point corresponds to 

individual keys on the numeric keypad. That means that you should enter the number 

7 to set the reference point to "upper left". The number 1 stands for "lower left", and 

so forth. 

Finally, you must specify the reference point for zoom area. This can be performed by 

clicking the position or entering the coordinates using your keyboard. Pressing 

[Return] without coordinates corresponds with the centre of the page. 

ZOOM ON FORMAT 

 

View toolbar 

Image properties; View menu  

This function returns the drawing in the current window to the state without zoom. 

FULLSCREEN MODE 

 
Fullscreen mode toolbar 

Image properties; View menu > Fullscreen mode 

The working area is scaled to the size of the screen and all controls except for the 

fullscreen mode toolbar are hidden. 
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Fullscreen mode toolbar 

 

Fullscreen mode off 

Switches back to the standard user interface. 

Show properties bar in fullscreen mode 

 

Shows the properties bar in order to modify construction parts. 

Render 

 

Renders the active image with the selected render parameters. 

VR ON/OFF 

 

 

Image properties 

After activating the function, the output of the current camera image is enabled in the 

VR glasses. At the same time the image is displayed in the graphics window according 

to the setting in the dialog Input devices > VR. 

To be able to use the VR glasses the drivers have to be installed appropriately. 

IMAGE START POINT 

 

View toolbar 

Image properties 

Key combination [Ctrl]+[Home]  

After you activate the function, the image is represented in its original position. 

That means that the 3D axes of the active design model are aligned parallel to the 

screen's axes. 

COLOUR MODE PRINTER/PEN 

 

 

Image properties 

This function leads you through switching from the pen to the print view and vice 

versa. 
 

TIP 
If you right-click inside a view, the context menu appears with the item 

"Print preview". If you select this option, the screen output will match 



Chapter 2 – Settings  

www.elitecad.eu  226 

the printout. If you leave the view or call up the menu item again, the 

previous depiction is restored. 

  

AREA RENDER 

 

 

Image properties 

For larger design models, the complete rendering process may require a long time. 

That is why there is an option to use range rendering to represent a specific range of 

the drawing as a rendering design model. The active render parameters are taken into 

account. The rest of the image is preserved in the previous depiction. 
 

TIP 
The function is a constraint. (Also in the context of materials 

management)  

RENDER MODEL 

 

 

Image properties 

This function is used to create a photo-realistic depiction that accounts for light, the 

casting of shadows, the colour scheme, etc. The quality is dependent on the render 

parameters. 

SOLID DESIGN MODEL 

 

Switches toolbar 

Image properties … [Ctrl] + [D] 

This function is used to represent the 3D image in colour. 

After you activate the function, the edges and 3D elements are hidden. The planes are 

represented in colour with the defined 3D colours. 

PIXEL HIDDEN LINE 

 

 

Image properties … [Ctrl] + [H] 

  

Enables a hidden line depiction that is rendered and displayed during dynamic 

rotation/movement. 

Switch on/off with [Ctrl]+[H]. 
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WIRE FRAME MODEL 

 

Switches toolbar 

Image properties 

This function is used to represent the image as a wire model. 

After you activate the function, the surfaces are hidden. The edges and 2D elements 

are shown. 

EDGES ON/OFF 

 

Switches toolbar 

Image properties... [Ctrl] + [C] 

This check box controls the depiction of edges on the screen. 

Depending on whether the check box is selected, the 3D edges are either displayed or 

hidden. 

3D AXES ON/OFF 

 

Switches toolbar 

Image properties 

This check box is used to display or hide the axes on the work plane. 

Depending on whether the check box is selected, the axes are either displayed or 

hidden. 
 

 

Meaning of lines 

Red contiguous line Positive X-axis 

Red dashed line Negative X-axis 

Green contiguous line Positive Y-axis 

Dotted lines Negative axes 
 

 

In addition, the original axes are shown in the 

lower left corner of the CAD window. 

RESET WORK PLANE 

 

Create New toolbar 

Draw menu > Work plane > Reset work plane, Image properties 

This function is used to place the edit plane back into the original floor plan plane of 

the current storey. 

WORK PLANE ON SURFACE 

 

Create New toolbar 

Draw menu > Work plane > Work plane on surface, Image properties 

Use this function if you want to place a new edit plane precisely on top of an existing 

surface. 
 

After you activate the function, you must click the desired plane in 3D. 
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TIP 
Curved surfaces can also be selected. The Edit plane is then placed 

tangential to the plan.  

WORK PLANE OVER 3 POINTS 

 

Create New toolbar 

Draw menu > Work plane > Work plane on surface, Image properties 

Use this function if you want to place a new edit plane to pass precisely through 3 

specific points in the room. 

You need to enter 3 points for which the entry row or 3D capture function can be used. 

The first point defines the origin, the second point the direction of the X-axis and the 

third point determines the XY-level. 

Examples of point entries: 

With an entry line: 

 X50, Y-100, Z50 

 X50, Y100 

 ,,50 

 a45, d100, Z50, etc. 
 

With 3D point capture mode: 

 Any points of a box, etc.  

SELECT WORK PLANE ORIGIN 

 

Create New toolbar 

Draw menu > Work plane > Select work plane origin, Image properties 

This function is used to place the origin of the coordinate system on the desired point. 
 

Given a point entry, the work plane undergoes a geometrical translation that places the 

origin of the coordinate system at the specified point. 

CREATE WORK PLANE USING NORMAL 

 

Create New toolbar 

Draw menu > Work plane > Create work plane using perpendicular, Image properties 

Use this function if you want to place a new edit plane to connect two points normally.  
 

The first point defines the position of the origin of the axes of coordinates of the new 

edit plane. The second point defines the direction of the Z-axis by taking the 

connection between the first and second points as a normal vector for the edit plane. 
 

TIP 
In this process, the direction of the X-axis is set to be horizontal. 
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CHANGE WORK PLANE 

 

Create New toolbar 

Draw menu > Work plane > Change work plane, Image properties 

In a separate window, the work plane can be rotated around one of the axes or moved.  

 

CLIPPING ON/OFF 

 

View toolbar 

Above the entry line... [Ctrl] + [I], Image properties 

This function is used to trim the 3D image area temporarily. This gives you a better 

overview during 3D editing. 

Once clipping has been selected, the clipping property bar is displayed. The active 

work plane is used as clipping plane. 

 

Clipping on/off 

 

This switch turns Clipping on and off. 

Section surface 

 Section surface uni coloured 

 Section surface on 

 Section surface off 

 

This setting defines if the section surface should be displayed or not. Either the 

depiction is done with the colour of the object or mono coloured. The section surface 

is only displayed if just the upper clipping plane is active. 

Upper and lower clipping plane 
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Upper and lower clipping plane can be switched on and off independently. The value 

fields define the distance to the current working plane. 

Clipping parameter 

 

The parameter button opens the clipping dialog window. 

 

For "z", you can enter the distance from the work plane in a positive or negative Z-

direction. If you do not enter a value for the Z-distance, the default value is 0. When 

you click APPLY, the specified Z-values are applied and the image is refreshed. 
 

If only the positive range is clipped, there are three different options for representing 

the section plane. 

 

Change clipping 

Changing the values in the property bar or in the parameter dialog window moves the 

clipping plane. Alternatively, the clipping plane is moved in parallel direction using 

the handles. 

The orientation of the clipping plane is modified by changing the work plane. 

 WORKSHOP  

Clipping applies to the current image and work plane. 

Set the following switches in the property bar. 

 

Now you can move the clipping plane through the model using the 

handles. 
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  WORKSHOP END 

CAMERA PIVOT POINT 

 

View toolbar 

Image properties 

This function is used to realign the camera pivot point. 

Normally, the camera pivot point is the centre of the screen. If you want to rotate 

objects that are far from the zero point, it is better to reset the centre point for the 

rotation to enable precise navigation. You can do this by clicking the object in question 

(which selects the centre point of the surrounding rectangle) or via point entry. 
 

TIP 
The pivot centre point is reset every time the image section is modified. 

  

DEFINE COORDINATE SYSTEM 

 

Settings toolbar 

Image properties 

The coordinate system can be rotated via an angle or point entry. All inputs and 

manipulations (e.g. vertical or horizontal) will then refer to the new coordinate system.  

The new entry generates a symbol on the screen. Double-clicking a coordinate symbol 

switches to that coordinate system. Double-clicking the main coordinate symbol in the 

lower left corner switches back to the original work plane. 

If custom coordinate systems have been saved with the drawing, they are automatically 

displayed when it is loaded. 
 

Origin      Coordinate system rotated 
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TIP 
A coordinate symbol can be selected and deleted. 

  

VIEW POSITION 

 

View toolbar 

Image properties 

This function is used to view the 3D object from any point in any direction. You can 

finely tune the direction of view via the subsequent Camera dialog window. The design 

model depiction is automatically set to be in perspective. 

After you activate the function, you will be prompted for: 

The digitisation of the view position by entering a value or capture mode. 

The height of the view position (Z-value compared to the active work plane) 

The digitisation of the focal point by entering a value or capture mode. 

The height of view point (Z-value compared to the active work plane) 

Now the 3D image is rendered according to the configured parameters and represented 

in the 4-view window. 

GRID ON/OFF 

 

Switches toolbar 

Image properties 

This check box controls the depiction of a grid on the screen. 

Depending on whether the check box is selected, the grid is either displayed or hidden. 

You can define the grid settings under the SETTINGS menu > OPTIONS > 

DEPICTION > TOOLS. 

TEXTS ON/OFF 

 

Switches toolbar 

Image properties 

This check box controls the depiction of texts on the screen. 

Depending on whether the check box is selected, the texts are either displayed or 

hidden. 

ARROWS ON/OFF 

 

Switches toolbar 

Image properties 
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This check box controls the depiction of arrows on the screen. 

Depending on whether the check box is selected, the arrows are either displayed or 

hidden. 

DIMENSIONS ON/OFF 

 

Switches toolbar 

Image properties 

This check box controls the depiction of dimensions on the screen. 

Depending on whether the check box is selected, the dimensions are either displayed 

or hidden. 

HATCHES ON/OFF 

 

Switches toolbar 

Image properties 

This check box controls the depiction of hatches on the screen. 

Depending on whether the check box is selected, the hatches are either displayed or 

hidden. 

PERSPECTIVE ON/OFF 

 

Switches toolbar 

View menu > Switches > .... [Ctrl] + [Shift] + [P] 

This check box controls the depiction of perspective. When you switch on perspective, 

differences in rendered size aim to create an illusion of depth. 

LINE TYPES (SINGLE) ON/OFF 

 

Switches toolbar 

View menu > Line types... 

Your entry defines whether specific line types are taken into account for the output 

(screen, printer) or for manipulation operations (such as "Delete block/section"). 

If the check box is selected, specific line types can be selected by entering their line 

type numbers. All other line types are hidden but are not lost. By entering "-1" as the 

line type number, you can reactivate all line types. 

If you prefix the line type number with a "^", it excludes the designated line type, e.g. 

"^2" means all line types should be displayed except for line type 2. 

PENS (SINGLE) ON/OFF 

 

Switches toolbar 

View menu > Pens... 

Your entry defines whether specific pens are taken into account for the output (screen, 

printer) or for manipulation operations (such as "Delete block/section"). 

If the check box is selected, specific pens can be selected by entering their pen 

numbers. All other pens are hidden but are not lost. By entering "-1" as the pen number, 

you can reactivate all pens. 

If you prefix the pen number with a "^", it excludes the designated pen, e.g. "^2" means 

all pens should be displayed except for pen 2. 
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See also Pen filter for elements only. 

LIGHT ON/OFF 

 

Switches toolbar 

View menu > Switches > Light... [Ctrl] + [L] 

This check box controls how light sources are taken into account for the colour 

depiction in the solid model. Key combination [Ctrl] +[L] 
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3.1 DXF/DWG 

 

File exchange toolbar 

File menu > File exchange > DXF/DWG 

GENERAL 

The DXF file exchange in ELITECAD offers the user a clear configuration of the data 

transfer. The program processes drawings in DXF and DWG formats up to AutoCAD 

2019 2D or 3D. 
 

FILE menu > FILE EXCHANGE > DXF/DWG calls up the DXF file exchange. 

 

Load/save configuration 

 

These functions serve to read and save a configuration including all settings in the 

tables. 
 

The dialog fields Load Dxf table and Save Dxf table appear after activating this 

function. The desired configuration can then be selected and loaded, or the active 

configuration can be saved as a new file. 

DXF/DWG - IMPORT 

Main settings 

 

This function is used to read a DXF/DWG file. 
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ON: When selecting a file, only DWG files (*.dwg) can be selected. The selected file 

is automatically converted into a DXF file (*.dxf). 

OFF: When selecting a file, DXF files (*.dxf) appear. 

 

ON: The maximal values saved in the DXF file are applied to the drawing dimensions. 

These drawing boundaries determine the scale, which is set, in case the active scale is 

too small. 

OFF: The drawing boundaries are automatically calculated. 

 

ON: The drawing's origin saved in the DXF file is used. 

OFF: The drawing is centred. 

 

ON: Layers that are marked and saved in DXF as frozen (meaning: hidden) are read. 

OFF: Only "visible" layers are read. 

 

Associative - M,Cm/mm. The dimensioning including exponents is associatively 

applied in full. 

associative: The dimensioning is associatively applied in full. Dimensions, which are 

not available in ELITECAD, can be incorrectly converted. 

free: Non-associative dimensioning is generated. This is fully handled as dimensioning 

but not corrected after block stretch. 

Line + Text: Dimensions are converted to lines and text. 

 

ON: A contour of the infill hatch is displayed. 

OFF: No contour of the infill hatch is displayed. 

 

ON: A view window is generated when reading the paper space. 

OFF: No view window is generated. 
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ON: A drawing is started before an import. 

OFF: The import of data occurs in the active drawing. 

 

User-defined coordinate system (German BKS, English UCS) 

ON: A coordinate system defined by a user becomes the standard coordinate system. 

OFF: The standard coordinate system is applied. 

 

2D: Only 2D data can be read. 

3D: Both 2D and 3D data can be read. 

3D with lines: 3D information, which does not create 3D-objects (for example, height 

markers), is taken into account.  

Design model range: If this check box is ticked, the design model range can be read. 

Paper space: If this check box is ticked, the paper spaces can be read. 

Model + paper spaces: If this check box is ticked, the design model range and all 

present paper spaces can be read. Paper spaces are automatically converted to plots 

and listed in views management. 

 

automatic: after every ACAD setting 

ON: Infill hatch is automatically generated. 

OFF: No infill hatch is created. 

 

Because no units have been saved in the DXF file, the correct unit can be selected here. 

active: The units set in CAD are used. 

mm: Data is read in millimetres. 

m: Data is read in metres. 

 

A separate unit can be chosen for the paper space (plot view). 

active: The units set in CAD are used. 

mm: Data is read in millimetres. 

m: Data is read in metres. 

 

in model name: The block names are used as model names. 

In attr. block: The block names are saved in the "block" attribute. 

Do not adopt: The blocks are not adopted. 
 

NOTE 
If the IN ATTR. BLOCK option is selected, an attribute file needs to 

have been loaded beforehand. 

Start the ATTRIBUTE-PARAMETER function from the 

ATTRIBUTES toolbar, enter the following path into the entry row  

<ELITECAD installation path>\u\<version> 
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\int\dxf\dflt\de\dxf.attr and confirm with [Enter].  

 

in group: The layer name is attributed to the classification GROUP. 

in class: The layer name is attributed to the classification CLASS. 

in level: The layer name is attributed to the classification LEVEL. 

in layer: The layer name is saved in the layer attribute and the layer manager is 

automatically made available. 

Show protocol  

 

This function is used to display the protocol file dxf.proto from the home directory. 
 

After activation of the function, a window is opened that displays all previous working 

steps. 

Default settings for the import 

 

Pens 

This function is used to allocate the DXF colours to the ELITECAD pens. 
 

An ELITECAD pen is allocated to a DXF pen in the set-up dialog window. All of the 

non-listed "DEF" pens are allocated in this case to Pen 10 in ELITECAD. The table 

can be extended in any way and saved as a new configuration. 
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The following must be noted when entering the desired allocation (this applies to all 

following tables): 

 At least one blank space must be present between two values. 

 The table is completed by an empty row. 

 All entries after the empty row will be ignored. 

Line types 

The line types defined in DXF are allocated a line type number. The table can be 

extended in any way and saved as a new configuration. 

 

Undefined line types are automatically assigned as line type 1. 

Characters 

This function is used for the allocation of DXF text sequences (%%..) and special 

characters to the ELITECAD ASCII code. The table can be extended in any way and 

saved as a new configuration. 
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Tip: 

The ELITECAD character "-1" (minus 1) means that the relevant DXF character is 

deleted. 

Fonts 

This function is used to allocate DXF fonts to ELITECAD fonts with optional 

character width (space) separated from the font number by a comma. The table can be 

extended in any way and saved as a new configuration. 

 

Layer 

This function is used to allocate the layers. The table can be extended in any way and 

saved as a new configuration. 
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Attributes 

This function is used to allocate the DXF attributes to ELITECAD attributes. The table 

can be extended in any way and saved as a new configuration. 

 

Filling colours 

This function is used to allocate the filling colours. 

(According to the allocation in the pen colour table) 

DXF/DWG – EXPORT 

Main settings 

 

This function is used to write the active drawings as DXF/DWG files. 
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The desired AutoCAD/DXF-Version needs to be entered here. The generated data can 

be adjusted to the specified DXF-Version. 

 

ON: When saved, a DXF file is generated which is automatically converted into a 

DWG file (*.dwg). 

OFF: A DXF file is generated. 

 

Model > Block: Every model becomes a block; the model name becomes a block name. 

Level > Block: Every level becomes a block; the level name is applied. 

Class > Block: Every class becomes a block; the class name is applied. 

none: No blocks are generated. (Exception: dimension blocks) 

 

ON: The dimensioning (dimension blocks) is entered into the model blocks. (Rather 

uncommon in DXF) 

OFF: The dimensioning blocks are generated as separate blocks. 

 

ON: DXF dimensions (DIMENSION) are generated. 

OFF: Blocks with geometry and text are generated. 

Special case: If the target system is set to easy geometry and the check box NO for 

generate blocks is selected, then no blocks will be generated for the dimensions. This 

setting is especially for data transfer to CAD systems having problems with blocks. 

 

do not write: Line hatches will not be written. 

write: Line hatches will be written for up to AutoCAD13. (Attention: Files can become 

very large.) From AutoCAD14, hatches will be written as associative hatches. 

as block: The line hatches are written as blocks. 

 

adopt: The ELITECAD reference points (1-9) are adopted in DXF. 

adjusted: The text is adjusted between two points. In other words, the overall text 

spacing always stays the same. For this reason, changes made to the text length always 

affects the text parameters. 

aligned: The text parameters always remain the same independent of the text length. 

In other words, if text becomes longer due to changes made, it will also need more 

space. 

 

The scaling factor of the line types can be defined here.  
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LAYER NAME for ELEMENTS: 

from Group:  The layer name is read from the classification GROUP. 

from Class:  The layer name is read from the classification CLASS. 

from Level:  The layer name is read from the classification LEVEL. 

from Layer:  The layer name is read from the layer attribute. 
 

LAYER NAME for TEXTS / HATCHES / DIMENSIONS 

fix OFF: Layer names for texts such as elements from the layer or attribute are read. 

fix ON: The content of the text fields is used for the layer names. 

 

The USE LAYER FROM DXF FILE TEMPLATE option can be used in order to add 

an additional layer from the template to the DWG file. 
 

If the USE LAYER FROM DXF FILE TEMPLATE option is activated, the properties 

"Colour from layer", "Line type from layer" and "Line thickness from layer" are 

additionally added to a DWG file. 
 

ON: A selected DXF file is used as a template for the conversion. 

OFF: The properties of the individual object are transferred. 
 

An example of a DXF layer template: 
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EXPLANATION 
In AutoCAD, colours, line types and line thickness are often governed 

by the layer properties manager and not by the object itself. If these layer 

properties are desired by the recipient, this option can be used here.  

The same layers must be defined as such in ELITECAD or be assigned 

in the conversion table. If the template does not contain a layer from 

ELITECAD, a notification will appear in the info window. This layer is 

then treated as a normal layer and is not assigned the FROM LAYER 

option  

 

With the help of this option and an appropriate Excel file, the layers from the 

construction parts can be divided even further apart, either in another layer or with a 

layer name extension. 
 

ON: A selected Excel file is used as a template for the conversion. 

OFF: No additional layer conversion is made. 
 

An example file (layerconv.xls) can be found under  

<ELITECAD-installation path>\u\<version>\int\dxf\dflt\. 

 

 

2D: Only 2D data can be written. 
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3D: All data (2D + 3D) can be written. 

 

Specifying the precision of the numbers (decimal places) for the DXF file. 

 

active: The units set in CAD are used. 

mm: The data is exported in millimetres. 

m: The data is exported in metres. 

 

ON: The ELITECAD attributes and layers are written as DXF attributes. The 

ELITECAD attributes are written as being converted 1:1 where the conversion file is 

not otherwise stated; in other words, the attribute id becomes the DXF attribute id. 

The ELITECAD model, group, class, level classifications are converted to the DXF 

attributes HD_PATTERN, HD_GROUP, HD_CLASS and HD_LAYER. 

If the ELITECAD classifications or attributes are visible and the ELITECAD text only 

contains the classification or attribute names, these are written as visible DXF 

attributes, or as DXF text and invisible DXF attributes. The invisible attributes are 

arranged one below the other in order to ensure an overview when changing visibility 

e.g. in AutoCAD. 

OFF: No ELITECAD attributes or layers are written as DXF attributes. 

 

ON: Infill hatches are written as associative hatches (HATCH).  

OFF: No infill hatches are written. 

 

After activating the switch, the following set-up dialog window appears. 

 

 

As personal text: The two-line tolerance text is generated separately from the 

dimensioning block as independent text with the same layer. 

As personal dimension style: For every different tolerance text, a separate DIMSTYLE 

(dimension parameter) is generated. 

In dimension block: The two-line tolerance text is also stored in the dimension block. 

Tolerance text is lost in AutoCAD if stretched. 

 



Chapter 3 – File exchange  

www.elitecad.eu  247 

constant: The specified distance between the dimensions and the start of the dimension 

help line is used. 

calculate: The distance is calculated from the dimension geometry and saved in the 

DXF dimension parameter. For architectural dimensions (constant length of help lines) 

the settings are useless because another distance is given for every dimension. 

 

Value for the constant setting. 

 

Lines + arcs: ELITECAD elements are written as individual lines and arcs, e.g. 1 

rectangle > 4 lines 

Polylines: successive ELITECAD elements are written as polylines, e.g. 1 rectangle > 

1 polyline 

 

(Up to ACAD Release 12) 

Circular resolution: Number of segments or curve lengths. 

Fixed number: Number of segments for every full circle. 

Curve length: Segment lengths in the active unit. To avoid unwanted results, the 

number of segments per curve in the program is limited to a minimum of three and a 

maximum of 100. 

Default settings for the export 

 

Pens 

This function is used to allocate the ELITECAD pens to the DXF colours. 
 

Because Version 8 and higher of ELITECAD have over 1024 pens to choose from, 

whereas the DXF file format (and also AutoCAD) only has 256 pens, several 

ELITECAD pens must be assigned to a DXF colour. For this to work, ELITECAD has 

predefined conversion tables for IMPORT and EXPORT. 

Consequently, and from the fact that the conversion tables were created based on the 

most similar colour, the pen numbers can be changed after EXPORT and subsequent 

IMPORT, e.g. ELITECAD pen no. 94 becomes ELITECAD pen no. 78 after DXF-

EXPORT and subsequent DXF-IMPORT. 

If this is not required, separate entries for the desired pens must be created in the 

conversion tables, e.g. 

 EXPORT 94 > 55 and IMPORT 55 > 94 
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Tip: 

The DXF pen "-1" (minus 1) means that the respective ELITECAD pen is not written 

into the DXF file.  
 

The following must be noted when entering the desired allocation (this applies to all 

following tables): 

 At least one blank space must be present between two values. 

 The table is completed by an empty row. 

 All entries after the empty row will be ignored. 

Line types 

This function is used to allocate the ELITECAD line types to the DXF line types. 

 

Characters 

This function is used for the allocation of ELITECAD special characters to DXF text 

sequences (%%...) and other special characters. 
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Tip: 

"^5" stands for exponent 5 in the M,cm/mm dimensioning. Numbers 1 - 9 can be used 

here.  

Fonts 

This function is used for the allocation of ELITECAD fonts to DXF fonts. 

 

Layer 

This function is used for the allocation of ELITECAD layers to DXF layers. 

After activating the function, the following set-up dialog window opens. 

 

Filling colours 

This function is used to allocate the filling colours. 
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READING THE INFORMATION 

In order to increase the quality of the imports, previous information can be read from 

the DXF file. The basic criteria of a DXF file are displayed on dialog windows and 

can be applied to the import tables. Both "CAD-Layer names" and "CAD-Block 

names" functions list the values from the active drawings on the screen. To read the 

information in a DWG file, the file must first be converted into a DXF file in 

Converter. 

 

DXF-Version 

This function is used to show the DXF-Version that is being used. 

 

Layer 

This function is used to show the layers that have been defined, are used or are frozen 

in DXF. 
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Colours 

This function is used to show the colours used in DXF. 

 

Line types 

This function is used to show the line types that have been defined or are used in DXF. 

 

Texts 

This function is used to show texts used in DXF. For special characters, the ASCII 

code is subsequently written in parentheses. If the characters are incorrectly imported, 

the character has to be amended in the import tables. 
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TIP 
Converting special characters: 

 

When reading a file, the text reads as follows, for example: "10.95 m»" 

This text should be changed to "10.95 m²". 
 

All text in the DXF file can be listed with the SHOW INFO > TEXT 

function. Special characters' ASCII codes are marked with parentheses. 
 

Result: "10.95 m» (253)" or "10.95 m (253)" 
 

The character code for the special character in ELITECAD can be 

identified with the function HELP > CHARACTER SET. In this case, it 

is 178. Now all you need to do is insert 178 for the value 253, and on 

rereading the file, "10.95 m²" appears instead of "10.95 m»". 

  

Fonts 

Shows the used DXF font definitions. 

Fonts and texts 

Shows the used DXF font definitions including the texts used. 

Attributes 

Shows the used DXF attributes and their content. 

CAD-Layer names 

Layers used in the active images are displayed in the info window. 

CAD-Block names 

Blocks used in the active images are displayed in the info window. 
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UTILITIES 

DXF > DWG/DWG > DXF 

 

Converts a DXF file into a DWG file or a DWG file into a DXF file. 

HELP 

Character set 

 

This function is used to show the important ELITECAD special characters and their 

internal ASCII code. 
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3.2 IFC 

The IFC-interface is only available in ELITECAD Architecture. 
 

In the frame of IFCs (Industry Foundation Classes), all construction parts existing 

within the construction are defined as objects and are identified as such in programs, 

which support this standard. Compared to the conventional exchange of simple 2D and 

3D line drawings, the IFCs make "intelligent" data models for general programs 

available to the user.  

Version  

The version IFC2x3 2nd level supports the most important architectural construction 

parts. A detailed list is outlined in the IFC user handbook: 

http://www.buildingsmart.co.uk 
 

The IFC-interface is continuously being further developed by the relevant associations. 

READ IFC2X3 

 

File exchange toolbar 

File menu > File exchange > Read IFC2x3 

General 

 

Open IFC-file as new drawing 

The current drawing will be deleted and the IFC file will be loaded. 

Append IFC-file to the active drawing 

The current drawing remains unchains and the IFC file will be loaded into the current 

drawing. 

Generate architectural objects 

The IFC data is generated as architectural objects if this information is present. 

Generate geometry only 

The IFC data is only generated as 3D geometry and cannot be edited as architectural 

objects. 

Create properties for free objects 

A set of free properties is assigned to nonparametric objects. 

http://www.buildingsmart.de/
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Renovation planning – fill openings automatically 

Opening objects belonging to demolition state automatically receive the ELITECAD 

property that the opening is automatically filled. 

Column 

 

Import columns simplified without opening elements 

OFF: Columns are imported with openings. Can take longer. (Standard) 

ON: Columns are read simplified (without openings). 

Girder 

 

Import girders simplified without opening elements 

OFF: Girders are imported with openings. Can take longer. (Standard) 

ON: Girders are read simplified (without openings). 
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Wall 

 

Connect wall parts 

Wall parts are connected together if this information is present. 

Do not connect wall parts 

Every wall section forms an individual object. 

Doors 

 

Import doors preferably parametric 

Doors are read as parametric objects if this information is present. 

Import doors as geometry 

Doors are generated as 3D geometry. 
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Windows 

 

Import windows preferably parametric 

Windows are read as parametric objects if this information is present. 

Import windows as geometry 

Windows are only generated as 3D geometry. 

WRITE IFC2X3 

 

File exchange toolbar 

File menu > File exchange > Write IFC2x3 

General 

 

Generate geometry only 

ON: The IFC data is only generated as 3D geometry and cannot be edited as 

architectural objects. 

OFF: The IFC data is generated as architectural objects. 

Quantities export 

Quantities are written into the IFC file if desired. 
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Room 

 

Represent as 2D contour 

Room volume is not exported as 3D. 

Represent as volume 

Room volume is also exported as 3D. This begins from TS Floor and goes up to the 

lower edge of the ceiling. 

Represent with levels of room boundaries 

With this option, boundaries of the room are determined and saved according to the 

surrounding building elements such as the walls, windows, doors, floors, ceilings or 

other room separators.  

This is important for energy calculation programs that need to know which 

construction elements surround the rooms and in which manner. 

The following rules are in force 

Exterior space: 

The room kind for the room label must be set to "Exterior space". 
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Free construction element 

 

Do not generate copies 

Identical library parts are never generated as copies. 

Maintain existing copies 

Identical library parts are generated as copies. 

Search for equal objects and reconstruct as copies 

Identical library parts are checked and generated as copies. 

Doors 

 

Export doors geometrically 

ON: Doors are generated as 3D geometry. 

OFF: Doors are exported as parametric objects. 
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Windows 

 

Export windows geometrically 

ON: Windows are generated as 3D geometry. 

OFF: Windows are exported as parametric objects. 
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3.3 BCF 

 

File exchange toolbar 

File menu > File exchange > BCF 

The BCF-interface is only available in ELITECAD Architecture. 
 

For collaborating with your partners, the support of BCF (BIM 

collaboration format) ensures for a smooth exchange of information, and 

is another milestone in the BIM process. The BCF format is developed 

by the BuildingSmart organisation and provides a data interface to easily 

exchange information during collaboration of different project partners 

in addition to an IFC model. It enables a model-based communication between various 

users and contains information about state, location, viewing direction, component, 

comments, users and time stamps in the IFC data model. 

In case all people involved in a project are working with ELITECAD, the possibility 

to exchange information using BCF is also provided using ELITECAD models instead 

of IFC models. 

BASICS 

A BFC file contains different topics. Each topic is intended to describe one 

independent issue. For each topic, there is some detail information available: 

 general data for the topic 

 image 

 camera 

 involved objects 

 comments 

In order to identify objects in an IFC file or in the ELITECAD design model, the 

objects need a unique id, the so-called Globally Unique ID, short GUID. GUIDs are 

saved in the ELITECAD drawing as well as in an IFC file. 

BCF DIALOG WINDOW 

After calling the function, the BCF dialog window is opened. 
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BCF file new, load, save 

 

Via these functions, BCF files are created, selected for editing or saved. 

Update GUIDs 

 

GUIDs are created when the BCF function is called in ELITECAD. If the design model 

changes or a new file is opened while the BFC dialog is on the screen, the GUIDs can 

be updated with this function. 

Link BCF-file with drawing 

 

The name of the corresponding drawing is saved in the BCF file. 

Topic 
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In the left top area of the dialog window, all existing topics are listed. There is always 

one topic active. In the large BCF dialog window, all information of the currently 

selected topic is displayed. 

 

These buttons are intended to create, delete and rename a topic. All fields of the topic 

properties can be filled as needed. 

 

Information 

 

The information area displays general data of the current topic. Examples are the 

author, description, date of creation or the state of a topic. 

 

The information button displays the link from the BCF file to the ELITECAD drawing. 
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View point 

 

Viewpoints and involved objects can be retrieved from the design model currently 

loaded in ELITECAD. Viewpoints can be reactivated afterwards. Objects are 

visualised if needed and added or removed afterwards as well. 

Show viewpoint 

 

This function activates the saved viewpoint in ELITECAD. 

Create, edit, delete viewpoint 

 

These buttons are used to create, edit and delete viewpoints. For creation and editing 

a dialog window with a preview image opens. 

 

Save camera viewpoint 

 

The camera viewpoint is required in order to return to the position where the image 

was saved. 

Save selection 
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In addition to the image, involved objects can be saved as well. The objects have to be 

selected before saving. 

Edit image 

 

With this function, the snapshot is opened in Microsoft Paint® and can be edited or 

supplemented with graphical notes (arrows, circles). After saving and closing Paint, 

the modified image is substituted. 

Create snapshot from CAD 

 

By activating this function, the image of the current view is saved with the 

SNAPSHOT function and displayed in the preview area. 

Select saved image 

 

A saved image file can be used instead of creating a snapshot. 

Object list 

 

This function becomes active after the first viewpoint was saved. 
 

Involved objects are saved optionally when creating a snapshot. The function opens a 

dialog window where the saved objects are listed. This function is used to add further 

objects to the list or to remove objects. 

 

Add / delete objects 

 

With the + sign all selected objects in ELITECAD are added to the list. With the – sign 

the selected entries are removed from the list. Adding new objects is only available 

after the creation of GUIDs. 

Show / hide objects 

 

These two functions either set the objects visible exclusively or set the whole design 

model visible in the graphics window. 
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Preview 

 

Optionally an image for a better explanation of a topic can be saved. This image is 

created via the VIEWPOINT function and displayed in the preview area. 

Comment 

 

Comments are sequential documentations of a topic, which are added by different 

project partners. 

 

These buttons are intended to create, edit and delete comments. Comments are used 

for communication or remembering detail information, as well as documenting 

completed tasks. 
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3.4 IMAGE 

 
 

File menu > File exchange > Write pixel format 

WRITE PIXEL FORMAT 

This function is used to save the image in pixel format. 

 

The following formats are possible: 

 TIFF 

 JPEG 

 Windows BMP 

 PNG 
 

If the active view is rendered, the dialog window directly appears. Otherwise, the 

corresponding dialog window with the resolution details is shown first. 

 

Under ACTIVE IMAGE, the desired pixel size from the active screen settings can be 

applied. 
 

Under WIDTH and HEIGHT, the desired pixel size can be set. The relationship 

between width and height should be retained. 

CREATE SNAPSHOT 

 

Camera toolbar 

Menu View > Camera > Create a snapshot 

Description see chapter SETTINGS > CAMERA > CREATE A SNAPSHOT. 

CREATE VIDEO 

 

Camera toolbar 

Menu View > Camera > Create a video 

Description see chapter SETTINGS > CAMERA > CAMERA PATH > CREATE A 

VIDEO. 
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3.5 POINT CLOUDS 

Point clouds are usually generated using laser scanners and are provided as text files. 

In general, each line represents the XYZ coordinates of a single 3D point. A line may 

eventually also contain the colour of a point defined as RGB value or an intensity 

value. Depending on the scanner software, a line may additionally contain data like 

point number or other values. 

Read point cloud 

 
 

File menu > File exchange > Read point cloud 

The point cloud file has to be selected. A dialog window showing a preview of the first 

lines opens. 

 

Following settings can be made: 

 The separator for the values in between a row 

 Columns for the X-, Y-, and Z-value 

 Columns for the R-, G-, and B-value (if colour import is active) 

 The number of rows for the header or from which row the point import should begin 

 The mode of colour import (no colour, RGB, intensity) 
 

In practice, there are often enormous amounts of data with millions of points that are 

at the expense of performance during the processing and frequently not even necessary 

in this level of detail. For this reason, ELITECAD offers the possibility to reduce the 

number of acquired points via a controllable filter. 
 

After the selection has been made, you can start the import with OK. 
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Each import process generates a new point cloud object. When combining multiple 

files it is necessary to assure that all files refer to the same origin. 
 

Imported points can be selected using all snap functions and can be used for measuring. 
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3.6 VRML 

  

File exchange toolbar 

File menu > File exchange > Write VRML 

The Virtual Reality Modelling Language (VRML) generates 3D models including 

illumination and surface colours. The files are saved in VRML 2.0 format with file 

name extension ".wrl". 

Use: 

The models can be presented within a web browser with an additional plugin. 

Various render programs can read VRML files.  

  

Internet Explorer 10.0 with the Cortona3D Viewer plugin is one such example. 
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3.7 MESSERLI VIS 

 

File exchange toolbar 

File menu > File exchange > Write Messerli VIS 

From Release 12 (*.ray) 

The RAY format is the native format from Messerli VIS 12.14 and Gamma-Ray 15.16. 

All textures that were assigned in ELITECAD are applied here. This file can be read 

and edited in Messerli VIS Releases 12 and 14. 

Up to version 11 (*.tgf) 

The TGF format is a file exchange format, which can be read in Messerli VIS. Only 

geometry without textures can be applied. This file can be read and edited in Messerli 

VIS up to version 11. 
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3.8 SAT 

The file exchange supplies a volume model according to the ACIS standard. 

Used typically as 3D file exchange for other mechanical CADs. 

Read SAT 

 

File exchange toolbar 

File menu > File exchange > Read SAT 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The SAT design model is ideally read in an empty drawing so that the 

quality and orientation can be checked to make sure they are correct before the model 

is placed into the correct drawing. 

Write SAT 

 

File exchange toolbar 

File menu > File exchange > Write SAT 

Currently visible 3D data is saved in SAT format. The written SAT file should always 

be checked by reading it back. Several construction parts / free forms are not exported. 

(e.g. roof) 

TIP 
It is also possible to save 3D data in an older SAT version. The version 

is defined in the file type menu.  
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3.9 3DS 

3DS is an Autodesk 3D Studio max file. This format saves 3D models including 

textures. The format provides better quality than a 3D-DXF.  

Use: 

 There are thousands of library parts on the internet in this format such as 

furniture, amenities, vehicles, plants. 

 Manufacturers (for example Villeroy & Boch) deliver their parts in this format. 

 Data exchange for render programs 

Read 3DS 

 

File exchange toolbar 

File menu > File exchange > Read 3DS 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The 3DS model is ideally read in an empty drawing so that the quality and 

orientation can be checked to make sure they are correct before the model is placed 

into the correct drawing. 

Write 3DS 

 

File exchange toolbar 

File menu > File exchange > Write 3DS 

Currently visible 3D data is saved in 3DS format. The written 3DS file should always 

be checked by reading it back. 
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3.10 U3D 

Write U3D 

 

File exchange toolbar 

File menu > File exchange > Write U3D 

The Universal 3D (U3D) is a format for 3D models and was standardised as ECMA-

363. 
 

If not the entire design model is assembled, on saving the U3D it can be determined 

whether only the assembled objects or the entire design model could be converted. 

This allows partial areas of the design model to be exported. 

 

Additionally in the hierarchical structure can be written in the U3D file as well. 

Optionally the building and storeys are exported in ELITECAD Architecture in 

addition to the layers. In ELITECAD Mechanics either layer, classification or asseblies 

are exported. 

Renovation planning information is optionally also exorted in ELITECAD 

Architecture as a separate hierarchical structure. If neccessary the renovation clour 

settings are used for the export. 
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3.11 PDF 

Write PDF3D 

 

File exchange toolbar 

File menu > File exchange > Write PDF3D 

The file exchange generates a 3D model in PDF format which can be opened in Adobe 

Reader ®. The viewer can freely rotate the design model in a PDF. This allows for a 

smooth exchange of data in a very popular program. The file exchange is very 

extensive and in addition to geometry includes light sources, textures and camera 

angles, as well as the layer and model structure. 
 

If not the entire design model is assembled, on saving the PDF3D it can be determined 

whether only the assembled objects or the entire design model could be converted. 

This allows partial areas of the design model to be exported. 

 

Additionally in the hierarchical structure can be written in the PDF3D file as well. 

Optionally the building and storeys are exported in ELITECAD Architecture in 

addition to the layers. In ELITECAD Mechanics either layer, classification or asseblies 

are exported. 

Renovation planning information is optionally also exorted in ELITECAD 

Architecture as a separate hierarchical structure. If neccessary the renovation clour 

settings are used for the export. 

 

Result in ELITECAD Architecture: 

 "Only layer"   "Building, storey, then layer" 
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Adobe Reader ® 

A range of possibilities is available in Adobe Reader as to how the design model can 

be viewed. 

 

Model hierarchy 

 on/off 

 

Control visibility of the structure, storeys, layer and objects. 

Camera angles 

The design model views are added to the PDF and can be selected in Reader. 

 

Rotate (horizontal) 

 

"Rotate horizontally" allows the design model to be rotated in fashion similar to 

ELITECAD. 
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Display 

 

The design model can be rendered in different display modes. 

Read PDF 

 

File exchange toolbar 

File menu > File exchange > Read PDF 

PDF documents can be read in vector format. This allows changes to be made to this 

data later on. It is necessary for the PDF to be generated with vectors and not as an 

image. 

Settings can be changed in the import dialog window for optimal import. The imported 

PDF page is always grouped. The grouping can be cancelled (context menu) so that 

the individual parts can be manipulated. 

The imported PDF is not 100 % true to scale to the original because inaccuracies 

already arise already when generating the PDF file (rounding to a multiple of 1/72 

inch). 

PDF import dialog window 
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Path for PDF file 

 

Select PDF file. 

Information 

 

Opens a window with the information from the PDF file (author, creator, subject ...). 

Font-assignment 

 

Fonts from the PDF can be assigned new fonts in ELITECAD. For example, the font 

in the PDF is Helvetica; in ELITECAD, the font should be Arial. 

 

The ONLY SHOW FONTS OF THE ACTIVE PAGE option must be active so then 

only these fonts will be listed in the first row. 

The selected font (for instance "Helvetica") can be assigned a new font (for instance 

"Arial"). The "Bold" and "Italic" formatting can also be selected. 

The text size can be uniformly changed by scaling. 

Depiction parameters 

 

The different PDF elements (text, hatch, bitmap and geometry) can be deselected for 

the import. 
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Lines can be created as polylines or replaced by a hatch. 

So that the lines have the desired pen on import, either select "Use pen with fitting line 

width" or "Use pen with fitting colour". 

Select page/Select object 

  

A toggle switch between the import of an entire page and the import of individual 

objects from the page. If "Select object" is active, a selection list of objects from the 

PDF page also opens. The page must have individual objects. 

Page navigation 

 

In PDF files that have several pages, the desired pages can be selected. For every 

import, only one page is imported. 

Fix reference point 

 

Choice of reference points to apply the PDF file to the drawing. 

Scale 

 

For a correct scaling of the PDF file, a scale can be set. 

Insert / OK 

INSERT reopens the import dialog window after the PDF page has been applied in 

order to import the next page or another PDF file. OK cancels the function after the 

PDF page has been placed. 
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3.12 SKETCHUP 

SketchUp (.skp) is a widely used format for 3D models. The area of use contains 

illustrating, product design, design models for architectural visualization, building 

models for Google Earth, numerous library parts and so forth. 
 

SketchUp is a trademark of Trimble Navigation Limited. 

 

Read SketchUp 

 

File exchange toolbar 

File menu > File exchange > Read SketchUp 

The imported model has to be checked if its dimensions are correct and scaled if 

necessary. Ideally, the SketchUp model is imported into a new drawing, in order to be 

checked if its quality and orientation are correct before it is positioned in the final 

drawing. 
 

Textures belonging to the imported model are automatically read and grouped in the 

material management. 

Write SketchUp 

 

File exchange toolbar 

File menu > File exchange > Write SketchUp... 

Currently visible 3D data is saved in SketchUp format. The written SketchUp file 

should always be checked by reading it back. 

TIP 
It is also possible to save 3D data in an older SketchUp version. The 

version is defined in the file type menu.  

https://www.google.com/earth/
http://www.trimble.com/


Chapter 3 – File exchange  

www.elitecad.eu  281 

3.13 IGES 

The IGES 3D import/export interface is an add-on and requires a separate 
codeword. 

READ IGES 

 

File exchange toolbar 

File menu > File exchange > Read IGES 

The dimensions of the IGES drawing need to be checked and scaled where necessary. 

The IGES drawing is ideally read in an empty drawing so that the quality and 

orientation can be checked to make sure they are correct before the IGES drawing is 

placed into the correct drawing. 

WRITE IGES 

 

File exchange toolbar 

File menu > File exchange > Write IGES 

Currently visible 2D data is saved in IGES format. The written IGES file should 

always be checked by reading it back. 

READ IGES 3D 

 

File exchange toolbar (optional) 

File menu > File exchange > Read IGES 3D 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The IGES 3D design model is ideally read in an empty drawing so that the 

quality and orientation can be checked to make sure they are correct before the model 

is placed into the correct drawing. 

WRITE IGES 3D 

 

File exchange toolbar (optional) 

File menu > File exchange > Write IGES 3D 

Currently visible 3D data is saved in IGES 3D format. The written IGES 3D file should 

always be checked by reading it back. 
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3.14 STEP 

The STEP import/export interface is an add-on and requires a separate 
codeword. 

READ STEP 

 

File exchange toolbar (optional) 

File menu > File exchange > Read STEP 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The STEP design model is ideally read in an empty drawing so that the 

quality and orientation can be checked to make sure they are correct before the model 

is placed into the correct drawing. 

WRITE STEP 

 

File exchange toolbar (optional) 

File menu > File exchange > Write STEP 

Currently visible 3D data is saved in STEP format. The written STEP file should 

always be checked by reading it back. 
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3.15 VDAFS 

The VDAFS import/export interface is an add-on and requires a separate 
codeword. 

Read VDAFS 

 

File exchange toolbar (optional) 

File menu > File exchange > Read VDAFS 

This function is used to import data in the VDAFS format. 

After activation of the function the dialog window Read VDAFS opens. Having 

selected the desired file, the following query appears: 

"2D depiction projected [0], rectangle [1] or without elements [2]" 

 Projected: the wire frame is projected in the current workspace 

 Rectangle: the bounding box is created as a rectangle in current workspace 

 No elements: an empty object is created 

NOTE 
The protocol contains the header of the VDA file and a statistic, which 

is written after completion of the import process. Additionally, the 

dimensions of the bounding box are noted. Hints for the scaling may be 

contained as well.  

Write VDAFS 

 

File exchange toolbar (optional) 

File menu > File exchange > Write VDAFS 

Currently visible 3D data is saved in VDAFS format. The written VDAFS file should 

always be checked by reading it back. 
 

After activation of the function the dialog window Write VDAFS opens. 
 

NOTE 
A statistic is displayed in the info window.  

VDAFS Parameter 

 
 

Menu Settings > Options > Save/Open > File exchange > VDA-FS-Parameters 

This function is used to set the parameters for the VDAFS import and export. After 

activation of the function the VDAFS parameter window appears. 
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Parameters for the import 

Some element types can be switched on or off. 

 points 

 point sequence (polylines) 

 point-vector sequence (polylines with normal vectors) 

 circles 

 curves 

 surfaces 

 trimmed surfaces 

 ATTENTION: trimmed surfaces consist of curves and surfaces 

The switched SET and GROUP define, if the VDAFS types SET and GROUP are 

considered for the import. 
 

TLIST 

In the field Scale the desired factor can be specified (default = 1) 
 

Parameters for the export 

In the field Version the desired VDAFS version is specified (default = 2.0) 
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Some element types can be switched on or off. 

 curves 

 surfaces 

The switch special parts defines, if special parts are written into a separate group or 

not. 

The field company needs always an entry. Otherwise, the ELITECAD file cannot be 

converted into a VDAFS file. The other fields are optionally filled. 
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3.16 CATIA 

The CATIA import/export interface is an add-on and requires a separate 
codeword. 

CATIA is a trademark of Dassault Systemes. 

READ CATIA V4 

 

File exchange toolbar (optional) 

File menu > File exchange > Read CATIA V4 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The CATIA V4 design model is ideally read in an empty drawing so that 

the quality and orientation can be checked to make sure they are correct before the 

model is placed into the correct drawing. 

WRITE CATIA V4 

 

File exchange toolbar (optional) 

File menu > File exchange > Write CATIA V4 

Currently visible 3D data is saved in CATIA V4 format. The written CATIA V4 file 

should always be checked by reading it back. 

READ CATIA V5 

 

File exchange toolbar (optional) 

File menu > File exchange > Read CATIA V5 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The CATIA V5 design model is ideally read in an empty drawing so that 

the quality and orientation can be checked to make sure they are correct before the 

model is placed into the correct drawing. 

WRITE CATIA V5 

 

File exchange toolbar (optional) 

File menu > File exchange > Write CATIA V5 

Currently visible 3D data is saved in CATIA V5 format. The written CATIA V5 file 

should always be checked by reading it back. 
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3.17 PTC CREO – PRO/ENGINEER 

The PTC Creo – Pro/Engineer import interface is an add-on and requires a 
separate codeword. 

Creo und PTC are trademarks of PTC. 

READ CREO – PRO/ENGINEER 

 

File exchange toolbar (optional) 

File menu > File exchange > Read Pro/E 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The Creo or Pro/Engineer design model is ideally read in an empty drawing 

so that the quality and orientation can be checked to make sure they are correct before 

the model is placed into the correct drawing. 
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3.18 AUTODESK INVENTOR 

The AUTODESK INVENTOR import interface is an add-on and requires a 
separate codeword. 

Inventor is a trademark of Autodesk. 

READ INVENTOR 

 

File exchange toolbar (optional) 

File menu > File exchange > Read Inventor 

The dimensions of the entry design model need to be checked and scaled where 

necessary. The Inventor design model is ideally read in an empty drawing so that the 

quality and orientation can be checked to make sure they are correct before the model 

is placed into the correct drawing. 
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3.19 MI 

MI is the file format of ME10, today OneSpace Designer Drafting. 

ME10 and OneSpace Designer Drafting are trademarks of CoCreate. 

READ MI 

 

File exchange toolbar 

File menu > File exchange > Read MI 

The dimensions of the drawing need to be checked and scaled where necessary. The 

MI drawing is ideally read in an empty drawing so that the quality and orientation can 

be checked to make sure they are correct before the drawing is placed into the correct 

drawing. 

WRITE MI 

 

File exchange toolbar 

File menu > File exchange > Write MI 

Currently visible 2D data is saved in MI format. The written MI file should always be 

checked by reading it back. 
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4.1 CURSOR, CAPTURE FUNCTIONS 

CURSOR 

The cursor displays the marker, the cross hair, the arrow and, if a point is entered, the 

values field as well. The marker always specifies the last position. As soon as the 

cursor is at right angles to the last position, temporary reference lines appear with 

display of the angle. This means you can check whether you are drawing at right 

angles. 

 

Values field 

The values field is shown as soon as a point input is required.  

You can switch to the values field with the [Tab] key. The values shown are relative 

to the marker or to a temporary reference point. To enter absolute values (from the 

zero point), you must click on the symbol at the start of the line. A value can be 

fixed. The values field can be exited with the [Enter/Return] key or by clicking on 

the tick. 

Relative  Absolute  Fixed value  Confirm 

    

The direct input of coordinates is still implemented in the same way as in release 11. 

Without switching to the values field with the [Tab] key, you can make entries such 

as "30,60" or ",100". The values are correctly entered into the values field.  
 

SPECIAL FEATURE 
Entering "value" for a movement along the z-axis changes the values 

field to an x,y,z input. 

  

temporary helpline 

angle 

snap mode 
crosshair 

cursor 

marker 
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Temporary reference points and help lines 

When you are drawing, references often need to be made to the geometry that has 

already been created. 

You create a reference point by hovering the cursor briefly over the desired point; the 

program displays the reference point as an orange cross. 

Instead of hovering over the point, you can press the [Shift] key. 

The temporary reference points are deleted again after every click. The points can be 

deleted manually the same way they were created. 
 

Drag the line perpendicularly beneath a wall corner 

 

Drag the line into the extension of an existing line 

 

A new line/help line should lie parallel to an existing line/help line. 

 

Draw a line in the middle of two points. 

temporary 

reference point 

as soon as the cursor is perpendicular 

to the reference point, the temporary 

help line and the symbol 

‘perpendicular’ appears 

remain briefly until temporary 

reference point appears 

temporary 

reference point 

temporary 

reference point 
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Draw a line perpendicular to a line. 

 

The snap time until the reference point appears can be set in the options. 

 

Input assistant 

The input assistant consists of additional functions that appear either at the cursor or 

in the INPUT ASSISTANT toolbar. The input assistant at the cursor can be 

displayed using the [Tab] key. The toolbar always shows the available functions. 

    

Which functions have an input assistant? 

When you draw a polygon, the curve functions are also available. 

 

When you draw a contour for an object (3D, architectural, mechanical) the drawing 

functions are available. 

 

When you click on a handle or gripper (element, text, hatch, 3D, object), 

manipulation options appear. The functions change depending on the type. 
 

1. reference point 

2. reference point 

temporary 

reference point 
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Handle      Gripper 

  

 

CAPTURE FUNCTIONS 

AUTOcapture mode 

The cursor responds as soon as it is positioned near a capture point and indicates the 

type of capture point by means of a symbol.  

    

In the AUTOcapture mode configuration, the individual capture options are enabled 

or disabled in the context menu. 

        

Cross hair 

Display 

The most frequently used capture functions can be distinguished by the different 

cross hairs. 
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Free 

 

 
Point 

 

 
Section point 

 

 
Help section point 

 

 
To element 

 

 
Centre circle 

 

 
Normal on circle/line 

 

 
Middle of element 

 

 
Middle of 2 points 

 

Orthogonal with arrow key 

When the arrow key is pressed on the keyboard, the cross hair only moves 

orthogonally on the screen. The [] [] arrow keys lock the cross hair vertically and 

the [] [] arrow keys lock the cross hair horizontally. 
 

TIP 
As soon as you lock the cross hair horizontally or vertically with the 

arrow keys, you can also specify a reference point with any capture 

mode using the  cursor. 

 

For the end point of the line, first select point capture, then press and 

hold the left or right arrow key and move the  cursor to the corner of 

the rectangle. You will notice that the cross hair snaps to the corner as 

you approach it.   

Alternative capture modes 

AUTOcapture and free capture mode are usually sufficient. The capture modes that 

appear on the first page of the context menu can be set in the Further Capture modes 

menu item. 
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AUTOcapture 

  

Capture mode toolbar 

Context menu (right mouse button) 

This capture mode is a convenient capture function that searches hierarchically for 

various capture criteria. 
 

When this function is activated, the subsequently digitised position is evaluated 

according to the criteria listed below and the cross hair is positioned accordingly.  
 

Search sequence: 

No point found, then section point 

No point found, then help section point 

No point found, then element 

No element found, then freehand 
 

TIP 
You can recognise which capture function is being used currently to 

focus on a position by the display of the cross hair. 

This capture function always finds a position on the screen. 

  

Orthogonal locking 

When the cursor is at a right angle to the reference point, a temporary help line is 

displayed and the cursor easily snaps to this position. 

To AUTOcapture 

  

Capture mode toolbar 

Context menu (right mouse button) 

Using the TO option, it is possible to select any reference point regardless of the 

current location (small white rectangle) and to effect a movement from here (e.g. by 

entering values). 



Chapter 4 – Basic function  

www.elitecad.eu  297 

When this function is activated, the subsequently digitised position (reference point) 

is evaluated according to the criteria listed below. 
 

Search sequence: 

No point found, then section point 

No point found, then help section point 

No point found, then element 

No element found, then freehand 
 

Now the final position of the cross hair must be determined (e.g. by entering values). 
 

TIP 
The MOVE AUTOMATICALLY TO capture mode can also be 

supplemented with an additional capture mode: 

If the destination point is a certain distance from the centre of a circle, 

it can be reached with the following input: Select the MOVE 

AUTOMATICALLY TO capture mode and select CENTRE CIRCLE 

capture. Place the reference point into the centre of the circle and now 

enter the desired distance from this point.  

Freehand  

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to position the cross hair at any freely selectable location 

(by freehand). 

Point capture 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to position the cross hair at the start or end of an existing 

drawing element. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a point, the cross hair becomes orthogonal and you can confirm the point 

by clicking with the left mouse button. Then the cross hair jumps to this point. 

 

Section point 

  

Capture mode toolbar 

Context menu (right mouse button) 

This capture mode allows you to position the cross hair at the intersection of two 

drawing elements, of one drawing element and a help element, or of two help 

elements. 
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When this function is activated, the cross hair is tilted through 45°. When you 

approach a section point, the cross hair becomes orthogonal and you can confirm by 

clicking with the left mouse button. Then the cross hair jumps to this section point. 

 

Geometry section point  

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to position the cross hair at the intersection of two help 

elements. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a help element section point, the cross hair becomes orthogonal and you 

can confirm by clicking with the left mouse button. Then the cross hair jumps to this 

help element section point. 

 

Centre circle 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to go to the centre of a circle or arc. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a circle or arc (drawing or help element), the cross hair becomes orthogonal 

and jumps to the centre. Confirm with the left mouse button. 

 

TIP 
The centre of the circle may also lie outside the drawing format. 
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Middle of element  

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to go to the centre of a drawing element. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a drawing element, the cross hair becomes orthogonal and jumps to its 

centre. Confirm with the left mouse button. 

 

TIP 
This function can only be used for drawing elements. 

  

Middle of 2 points 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to go to the middle of 2 points. 
 

When this function is activated, the two points must be clicked. Then the cross hair 

jumps to the middle of the imaginary line connecting the specified points. 

 

Normal to element 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to automatically calculate and display the normals to a 

drawing or help element (straight and circle/arc) from the current position. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a drawing or help element, the cross hair becomes orthogonal and jumps to 

the section point that is normal to the current position. Confirm with the left mouse 

button. 
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TIP 
The section point of the normals from the current position to the 

selected element need not necessarily be on this selected element, but 

may lie outside it. 

  

Distance to element from point 

  

Capture mode toolbar 

Context menu (right mouse button) 

This capture mode allows you to position the cross hair on an element and to specify 

a distance to the nearest point. 
 

When this function is activated, the element in question must be clicked. Then the 

cross hair jumps to the point nearest to the element. Now the desired distance from 

this point can be specified. Then the cross hair is set to the calculated position. 

 WORKSHOP  

Distance to element from point 

Place a window in ELITECAD Architecture in a wall at one metre from the wall 

corner. 

Pick a window 

Image 1: Activate the Distance to element from point capture mode and click on the 

wall in which the window is to be placed, near to the corner from which you wish to 

specify the distance. Do not click in the corner. Otherwise, you will not know 

whether the window will be placed in the horizontal wall or the vertical one. 

Image 2: When you click on the wall, the  marker jumps to the corner. Check 

whether it is the correct corner. If you have clicked on the inside of the wall, it must 

not switch to the outside. If the marker is in the wrong location, select capture mode 

again and click the wall nearer to the corner. 

Image 3: In the input line, enter and confirm the distance. The marker jumps to the 

specified position and the window can be placed. Because you click on the element 

to which the distance is to be applied, there is no need to enter a direction using x and 

y values or +/-. 
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     1  

  WORKSHOP END 

Tangent  

  

Capture mode toolbar 

 

This function allows you to calculate automatically the tangents from an initial 

location (defined location outside the circle) to a clicked circle or arc. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a circle or arc (drawing or help element), the cross hair becomes orthogonal 

and jumps to the tangent point. Confirm with the left mouse button. 
 

TIP 
This process can also be used for measuring.  

To element  

  

Capture mode toolbar 

Context menu (right mouse button) 

This capture mode allows you to specify an existing drawing or help element (line or 

arc) as a guide for the cross hair. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a drawing or help element, the cross hair becomes orthogonal and you are 

guided along the element as if on "tracks". Confirm with the left mouse button when 

you have reached the required position. 
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Grid  

  

Capture mode toolbar 

 

This function allows you to position the cross hair in a defined grid. This is 

particularly useful for electrical and hydraulic plans, and for the exact positioning of 

the scale and text. 
 

When this function is activated, the cross hair jumps to the nearest grid point. 

Keep orthogonal 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to move the cross hair freehand while keeping it horizontal 

or vertical. It is particularly suitable for underlining, information arrows, centre lines, 

etc. and also for positioning objects. 
 

When this function is activated, the cross hair is restricted to horizontal and vertical 

movements when it is moved freehand. Whether it moves horizontally or vertically 

depends on what is nearest to the current cross hair position. 
 

TIP 
The arrow keys [] [] [] [] on the keyboard have the same effect 

as this capture mode.  

Keep horizontal  

  

Capture mode toolbar 

Context menu (right mouse button) 

This function forces the cross hair to be guided in a horizontal direction. This 

function can be combined with the other capture functions. Missing parameters can 

thus be constructively determined directly from the drawing without the 

corresponding measurements having to be taken. 
 

When the function is activated, the cross hair is guided horizontally on the screen. A 

second capture function can now be selected and used in combination. 
 

TIP 
The arrow keys [] [] on the keyboard have the same effect as this 

capture mode.  

Keep vertical 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function forces the cross hair to be guided in a vertical direction. This function 

can be combined with the other capture functions. Missing parameters can thus be 

constructively determined directly from the drawing without the corresponding 

measurements having to be taken. 
 

When the function is activated, the cross hair is guided vertically on the screen. A 

second capture function can now be selected and used in combination.  
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TIP 
The arrow keys [] [] on the keyboard have the same effect as this 

capture mode.  

Element 

  

Capture mode toolbar 

Context menu (right mouse button) 

This capture mode allows you to position the cross hair on an imaginary beam in the 

direction of a definable drawing element. 
 

When this function is activated, you click on the element that determines the 

direction. The cross hair is now locked on this beam. 

Centre edge 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to go to the middle of an edge in 3D. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a 3D edge, the cross hair becomes orthogonal and jumps to the centre of 

the edge. Confirm with the left mouse button. 

Centre surface 

  

Capture mode toolbar 

Context menu (right mouse button) 

This function allows you to go to the middle of a surface in 3D. 
 

When this function is activated, the cross hair is tilted through 45°. When you 

approach a 3D surface, the cross hair becomes orthogonal and jumps to the centre of 

the surface. Confirm with the left mouse button. 
 

TIP 
The centre of a surface is calculated as the centre of gravity. 

This capture mode cannot be used for the lateral surfaces of boxes and 

extrudes or for trimmed surfaces.  

Section of work plane with surface 

  

Capture mode toolbar 

 

This function allows you to capture a section point between a surface edge and the 

current work plane. 
 

When this function is activated, the cross hair jumps, but a surface edge must be 

sighted with the cursor. When you approach an edge, the cross hair jumps to the 

section with the current work plane. 
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Straight/surface section  

  

Capture mode toolbar 

 

This function allows you to capture a section point between a straight and a surface. 
 

When you select this function, you are prompted for a point on the straight (start 

point) and its direction (end point). Then the surface that it will intersect must be 

entered. The marker is set to the section point as a result. 

 WORKSHOP  

Straight/surface section capture mode  

The straight is specified by two points. Points that do not lie on the current work 

plane can also be selected with the POINT capture mode. 

  

When the two points of the straights have been entered, the surface must be defined. 

Point on line? Direction of line? 
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A virtual straight is generated along the two specified points. The marker is set at the 

point where the straight intersects the surface of the extrude. 

  WORKSHOP END 

Quadrants 

  

Snap mode toolbar 

 

The snap mode "quadrants" is only available in ELITECAD Mechanics. It snaps four 

special points on a circle or arc – especially intended as an assistance for diameter 

measurements. 
 

Set the workspace in the plane of the circle before applying this snap function. The 

points represent the quadrant boundaries on the arc or circle relative to the X-Y plane 

of the current workspace. It is not mandatory to set the workspace in the circle plane. 
 

In detail, the snap mode snaps the intersection points of the arc or circle with a plane 

that is normal to the X- or Y-direction of the current workspace and goes through the 

centre of the circle. If the Z-direction of the current workspace is orthogonal to the 

normal direction of the circle, the Z normal plane is used for snapping instead of the 

X normal plane, so to say the Y-Z plane. 
 

The procedure of the snap function is as follows: 
 

Determination of the closest edge near the selected point. 

If the edge is circular, the four quadrant boundaries are determined. 

Finally, the closest of these four points is selected.  
 

TIP 
In order to facilitate correct snapping the mouse cursor should be 

positioned on the surface where the edge belongs to, as close as 

possible to the edge. The snap mode may eventually not work properly 

for surfaces generated in old ELITECAD versions or surfaces imported 

by interfaces.  

Move cross hair  

  

Snap mode toolbar 

 

Which plane should 

be intersected? 
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The function performs a SINGLE movement step, independent of the current 

position of the cross hair. 
 

After activating the function, the cross hair can be moved additionally. The point 

input can be done by value input. The procedure can be repeated for multiple 

consecutive relative movements. 

To point 

  

Snap mode toolbar 

 

This function allows selecting a point as a new reference point for point inputs, 

independently of the current position (indicated by the marker – a small white 

rectangle). The new reference point is then used to enter a movement relative to it 

(e.g. by entering a value). The result is the distance between the current position 

(start position) and the end position of the cross hair. 
 

After activating the function and when moving the cross hair near a point, it jumps to 

it. From here, the new position of the cross hair is defined relatively (e.g. by value 

input). 
 

TIP 
The current position is not modified by the snap mode TO POINT. 

Only by further inputs (e.g. by entering a value), the position is 

changed.  

To section 

 

Snap mode toolbar 

 

This function allows selecting an intersection point as a new reference point for point 

inputs, independently of the current position (indicated by the marker – a small white 

rectangle). The new reference point is then used to enter a movement relative to it 

(e.g. by entering a value). The result is the distance between the current position 

(start position) and the end position of the cross hair. 
 

After activating the function and when moving the cross hair near an intersection 

point, it jumps to it. From here, the new position of the cross hair is defined relatively 

(e.g. by value input). 
 

TIP 
The current position is not modified by the snap mode TO SECTION. 

Only by further inputs (e.g. by entering a value), the position is 

changed.  

To centre circle 

  

Snap mode toolbar 

 

This function allows selecting the centre of a circle as a new reference point for point 

inputs, independently of the current position (indicated by the marker – a small white 

rectangle). The new reference point is then used to enter a movement relative to it 
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(e.g. by entering a value). The result is the distance between the current position 

(start position) and the end position of the cross hair. 
 

After activating the function and when moving the cross hair near a circle, it jumps 

to its centre. From here, the new position of the cross hair is defined relatively (e.g. 

by value input). 
 

TIP 
The current position is not modified by the snap mode TO CENTRE 

CIRCLE. Only by further inputs (e.g. by entering a value), the position 

is changed.  

To middle of element 

  

Snap mode toolbar 

 

This function allows selecting the middle point of an element as a new reference 

point for point inputs, independently of the current position (indicated by the marker 

– a small white rectangle). The new reference point is then used to enter a movement 

relative to it (e.g. by entering a value). The result is the distance between the current 

position (start position) and the end position of the cross hair. 
 

After activating the function and when moving the cross hair near an element, it 

jumps to its middle point. From here, the new position of the cross hair is defined 

relatively (e.g. by value input). 
 

TIP 
The current position is not modified by the snap mode TO MIDDLE 

OF ELEMENT. Only by further inputs (e.g. by entering a value), the 

position is changed.  
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4.2 POLYGONAL CHAIN  

The polygonal chain is often used when a selection is manipulated (e.g. block, 

section, stretch, etc.), a parallel contour is created, a hatch contour is defined, or 

during contour specification when an area is measured. 

Direct polygon input 

For the stretch functions and the block and section manipulation functions, you are 

directly prompted for a polygon. A rectangle can be defined via the diagonal points 

of a polygon via individual points.  

Example of a polygon via diagonal points: 

   

    

Image1: Select elements and call up the STRETCH POINT OR LINE function. 

Image2: Enter the existing point and its new position. 

Image3: Set the start point of the polygon on the outer left and double-click the 

second point on the outer right.  

Double-click = close polygon 

Image4: Result 

Example of a polygon via individual points: 

   

    

Image1: Select elements and call up the STRETCH POINT OR LINE function. 

Image2: Enter the existing point and its new position. 

Image3: Draw a polygon that includes the two ends of the outer lines. The lines in 

the centre must not be stretched at the same time. 

The polygon is closed automatically when you select the start point again. 

Image4: Result 

Polygon functions in properties bar 

The polygon functions appear directly in the properties bar for the HATCH and 

MEASURE AREA functions. 

Example of hatch properties bar: 
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Polygon 

 

This function allows you to specify the unclosed contour of recesses or surfaces. 

If the contour search comes to a halt at an open position, the polygon is automatically 

started and further points can be entered. 

         

Image1: Select the MEASURE AREA/START HATCH function. Click on the 

contour. 

Image2: The contour is tracked up to the opening. 

Image3: Set the first point 

Image4: Set the second polygon point 

Image5: Click on the end point. The polygon is automatically closed. The values can 

be read off from the info window for the MEASURE AREA function. When START 

HATCH is selected, the polygon is filled with the required hatch. 
 

TIP 
When the POLYGON function is selected, additional functions are 

made available in the input assistant. 

  

TIP 
An open polygon can also be closed by double-clicking or pressing 

[Enter].  

Next contour 

 

The NEXT CONTOUR function allows you to jump to the next contour so that the 

contour search automatically tracks along it.  

Contour end 

 

This function is used to close an open polygon chain. This function comes into effect 

for a parallel contour and for measuring a line. 
 

Example: Measure the length of a certain line, e.g. Pitch line on a stair 

Start the MEASURE AREA function 

Click on the contour 

CONTOUR END function 
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The length (circumference) can be read off from the info window. 

                      

        

TIP 
If an open profile is automatically tracked by the cross hair, it begins at 

the marked point and runs anticlockwise. If only one element of the 

contour is followed by the automatic tracking, you have positioned the 

cross hair at the wrong end. You should therefore try moving the cross 

hair to the other end of the contour.  
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4.3 MEASURE 

Show dimension values 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Show dimension values 

This function opens the dimension values dialog window. 

DIMENSION VALUES 

The measurement functions can be called up at any time via the MEASURE context 

menu (right mouse button). 

 

In addition to the measurement functions, there is a list, a calculation line and 

calculation operations. 

This window is a docking menu and behaves in the same way as the layer, storey and 

views windows. 

List 

The 20 most recently measured values appear in this list; it does not matter whether 

the dialog window is open or closed. The most recently measured value is always at 

the bottom and highlighted in blue. The unit of the values is the unit set in the status 

window. When you double-click a value, the number is copied to the calculation line. 

The rounding of the figures in the list can be set in the SETTINGS menu > 

OPTIONS > WORK PARAMETERS > GENERAL. 
 

TIP 
To copy a value from the list to the input line or a field in a dialog 

window, the value must first be copied to the calculation line. 

          

Delete list 

 

This function deletes all values from the list. 
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Copy selected value from list 

 

This function transfers the active value (highlighted blue) from the list and copies it 

to the calculation line. 

Calculation line 

 

The values from the list can be transferred to the calculation line by double-clicking 

them, or you can enter new values here using the keyboard. The calculation 

operations can be entered with the relevant button or via the keyboard. Clicking the 

buttons always enters the operations at the end of the line. In order to enter an 

operation subsequently, the input cursor must be in the correct position and the 

operation entered via the keyboard. 

Rounding to a number of decimal places can be set in the OPTIONS. 

Equals 

 

The equals button shows the result of a calculation. 

Clear 

 

The clear button deletes all values in the calculation line. 

Add, subtract, multiply, divide, bracket open, bracket close 

           

The main operations are available as buttons so that you can enter a calculation 

operation in the calculation line. The operations can also be entered via the keyboard, 

but you must make sure that you put the input cursor in the correct place first. 

Clicking the buttons always enters the operations at the end of the line. 

Behaviour of measurement functions 

> only applies if the measurement function is called up via the dimension values 

dialog window. 

The behaviour of the measurement functions differs depending on a function was 

active when a measurement function was selected or whether the measurement 

function was started within another function. 
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No function active: 

The measured value is shown in the status bar for information and written to the list 

in the measurement dialog window for further processing. It makes no difference 

whether the measurement window is open or not. 

This measurement function remains active. 

Within a function: 

The measured value is written to the status bar for information and directly to the 

input line in the measurement window. The value can therefore be used immediately. 

This measurement function does not remain active. 

MEASUREMENT FUNCTIONS 

Measure horizontal 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Horizontal 

This function measures the horizontal distance between two points in the drawing. 
 

After the function is activated, the two points in the drawing can be specified. 

See the Behaviour of measurement functions chapter for information about where the 

dimension values appear and how they can be further processed. 
 

TIP 
The two points you enter do not need to be at the same horizontal 

height.  

Measure vertical 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Vertical 

This function measures the vertical distance between two points in the drawing. 
 

After the function is activated, the two points in the drawing can be specified. 

See the Behaviour of measurement functions chapter for information about where the 

dimension values appear and how they can be further processed. 
 

TIP 
The two points you enter do not need to be at the same vertical height. 

  

Measure now 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Measure now 

This function measures the direct distance between two points in the drawing. 
 

After the function is activated, the two points in the drawing can be specified. 

See the Behaviour of measurement functions chapter for information about where the 

dimension values appear and how they can be further processed. 
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Measure arc length 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Arc dimension 

This function measures an arc length, either the length of the entire arc or part of the 

arc. The arc must be a drawing element. 
 

Once the function is activated, the arc to be measured must be selected. The element 

capture function is activated for selecting the arc. 

If you confirm with [Return], the entire arc length is measured. Instead of 

confirming, you can also set a start and end point on the arc to allow partial 

measurements of an arc. 

Measure area 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Measure area 

This function measures the specified area, calculates the circumference and positions 

the cross hair in the centre of gravity of the area. 

Properties bar 

 

The toggle button "hatches" defines if hatches or 2D contours may be selected for 

area measurement. The polygon functions allow you, to draw a contour manually. 

The graphic preview of the area can be deactivated with the "Preview area" switch. If 

cut-outs are to be extracted within the area, the "Include cut-outs" switch must be 

activated. The unit for the measurement results can be defined separately. 

Closed contour 

When this function is activated, you are prompted to position the cross hair on the 

required contour. The circumference of the contour, the area and the centre of the 

area are calculated. The reference point is set at the centre of the area. The calculated 

values are shown in the info window. The centre point coordinates relate to the 

current reference point on the drawing. 

 

TIP 
This function takes account of the branching parameters of the contour 

search under SETTINGS > OPTIONS > WORK PARAMETERS > 

GENERAL.  

Open contour/polygon functions 

Additional polygon functions are available in this properties bar. These polygon 

functions allow you to track along even imaginary surfaces that do not have a 

contour, to follow contours that have open points, or to determine a profile length. 

See the Polygon chain chapter for information about what the polygon functions can 

do. 
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Measure angle between 2 surfaces 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Angle between 2 surfaces 

You can use this function to determine the angle between two surfaces. 
 

After you activate the function, you are prompted to specify the surfaces between 

which the angle is to be determined. The value appears in the info window. 

If a surface is curved, the tangent plane is used in the specified point. 

Measure angle between 2 lines 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Angle between 2 lines 

You can use this function to determine the angle between two straights (element or 

help line). 
 

After you activate the function, you are prompted to specify the lines between which 

the angle is to be determined. 
 

TIP 
The relevant angle is calculated when you click the inside or outside of 

the elements with the cross hair.  

Measure angle of a line 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Angle of a line 

You can use this function to determine the angle of a straight (drawing or help 

element) that it forms with the horizontal. 
 

After you activate the function, you are prompted to specify the straight for which 

you wish to determine the angle. 
 

The angle units DEGREE, GRADIAN or RADIANT can be set in the OPTIONS. 

Coordinates of point 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Coordinates of point 

This function allows you to display the absolute and relative x,y,z coordinates of any 

point on the drawing. The coordinates are displayed in the info window. 
 

After the function is activated, the point in question is marked. The coordinates are 

displayed as follows: 

REL/ABS: X value, Y value, Z value 
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TIP 
The relative Z value is always measured from the current work plane 

and the absolute Z value is measured from project null.  

Element information 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Element information 

This function allows you to list the geometry information for an element shown on 

the screen. 
 

When you select the command, the required element is marked with the cross hair.  

The following information is shown in the info window: 
 

Line 

 

Circle 

 

TIP 
If an element attribute is available, this is shown in the info window. 

  

Model information 

  

Measure toolbar 

Context menu (right mouse button) > Measure; Info menu > Measure > Model information 

This function lists the details of a selected model. This information includes model 

name, all attributes, number of points, groups, classes, levels, and so on. 
 

When you activate this function, the information is listed in the info window. 

Example of a wall: 
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Volume calculation 

  

Measure toolbar 

Info menu > Measure > Volumes... 

This function allows you to calculate the volume that is enclosed by the currently 

constructed surfaces. 

When the function is activated, the settings dialog window on the left appears. 

 

  

Tolerance [%]: 

The value entered here corresponds to the specified 

precision of the volume in per cent. 
 

Volume: 

The calculated volume is displayed here. 
 

Surface: 

The calculated surface is displayed here. 
 

Calculate: 

This button starts the calculation. The calculated volume 

is also shown in the info window in the current cubic 

user unit, litres, and millilitres. 
 

Cancel: 

This button allows you to cancel the calculation process 

at any point. 
 

The progress bar in the status line shows the progress of the volume calculation. The 

indicator starts every calculation at 0%. 
 

TIP 
The volume is precisely calculated for boxes with any contour. All 

other objects are calculated approximately. The calculation is repeated 

with increasing precision until the desired tolerance is achieved. 

If the tolerance is zero, the calculation is repeated with increasing 

precision until the CANCEL button end the process.  
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The new approximation is shown in the dialog window and in the info 

window after each run. Only closed objects without protrusions can be 

calculated. Cavities are possible.  

Height in point 

 

Measure toolbar / Roof / Extended roof functions 

Info menu > Measure > Height in point 

This function is only available in ELITECAD Architecture and is used to measure 

the height inside the roof. Click any point in the roof area and upper and lower edge 

of the roof point is shown in the info window in reference to the top floor level. 
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4.4 HELP GEOMETRY 

GENERAL 

The help geometry elements (or help lines for short) are intended for the design. 

They are not for permanent auxiliary designs. The help lines are always deleted 

again so that the plan is clearly presented. The help lines are not printed by default. If 

the help lines are to be printed out, the PRINT HELP LINES option can be activated 

in SETTINGS > OPTIONS > SYSTEM > CONFIGURATION. 
 

 

TIP 
For permanent help lines, a line with pen colour "0" (blue) can be used. 

These lines are not printed. 

The help lines can be hidden in the screen settings.  

FUNCTIONS 

Straight line through points/to circles  

  

Help lines toolbar 

Draw menu > Help geometry > Straight line by two points 

This function allows you to create a help line through two points. If a circle is 

selected, this allows you to use an automatically calculated tangent point. 

Options 

2 points   point + circle   2 circles 

               

After this function is activated, the two points must be defined. You see a preview of 

the help line. If you want to run a line tangent to a circle, click on the arc near to the 

final tangent point. 
 

TIP 
The function remains active. 

You can see which capture mode is active by the appearance of the 

cross hair. This means you can see whether a tangent will be created or 

a straight through a point. While element capture is active, a tangent 

will be generated.  
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Straight with angle through a point/on a circle 

  

Help lines toolbar 

Draw menu > Help geometry > Straight line by angle and point 

This function allows you to create a help line with a given angle through a point or 

tangent to a circle. 

If several angles are entered, several help lines can be created at once. 

 

Options 

through point   tangent to circle   through point with 2 angles 

               

 

After this function is activated, the properties bar appears. Enter the appropriate 

angle in the field of the properties bar or select a previously entered value from the 

list. Now the cross hair can be set at the point through which the help line should run 

at the specified angle. 

 This option offers the possibility to apply the angle relative to a selected line 

TIP 
Up to 10 values can be entered for the value in the properties bar field 

separated by commas. 

The value entered is always measured from the x-axis. Once the angles 

are defined, any number of points can be selected.  

 

Tangent/straight through point normal to line  

  

Help lines toolbar 

Draw menu > Help geometry > Straight line by point - normal on line 

This function allows you to create a help line through a point normal to a line or a 

tangent normal to a line. 
 

After the function is activated, a point or a circle must be defined. Then the line can 

be selected to which the help line should be normal. 
 

TIP 
The function remains active. 

You can see which capture mode is active by the appearance of the 

cross hair. This means you can see whether a tangent will be created or 

a straight through a point. While element capture is active, a tangent 

will be generated.  
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Parallel lines 

  

Help lines toolbar 

Draw menu > Help geometry > Parallel lines 

This function allows you to draw parallel help lines with a certain distance between 

them and to copy them multiple times. Relative or absolute distances can be entered. 

 

Entry mode 

This function determines whether the distances are measured absolutely or relatively. 
 

Relative means that the distances are measured sequentially. 

 

Absolute means that the distances are always measured from the start point. 

 

Number of repeats 

 

The number of repeats is only active if the input mode is set to "relative". A 

maximum of 100 repeats can be entered. 

Geometry at single point  

  

Help lines toolbar 

Draw menu > Help geometry > Geometry at single point 

This function allows you to create the help geometry at a point of an element. If 

several elements border this point, one help line is created for each element. 
 

When the function is activated, the cross hair is placed next to the required points. 

Then the geometry elements are drawn as explained above. 

      

Circle with given centre and radius 

  

Help lines toolbar 

Draw menu > Help geometry > Circle with given centre and radius 

This function allows you to create one or more circles by entering the radii. 
 

When the function is activated, the properties bar opens and you can specify the radii 

and the circle's reference point. 
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Radius 

Up to 10 radii can be entered, separated by a comma. 

Reference point 

 

The reference point determines the point at which the circle is attached to the cross 

hair. 

 >         >  

Circle by centre 

  

Help lines toolbar 

Draw menu > Help geometry > Circle by centre 

This function allows you to create a help circle by stating its centre point and a point 

on the circle's circumference. The circle can also be added as a tangent to an element 

(drawing, help line, line or curve). 
 

Once the function is activated, the centre point is determined. Then the extent of the 

circle is determined with a point on the circumference or an element to which the 

circle should be tangentially arranged. 
 

by point Tangent to element 

   

TIP 
The function remains active. 

You can see which capture mode is active by the appearance of the 

cross hair. This means you can see whether the help circle will be 

created tangentially to an element or using a point. If you move over 

an element with the element capture mode, the help circle will be 

generated tangentially to the element.  
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Circle by 3 points or tangents 

  

Help lines toolbar 

Draw menu > Help geometry > Circle by 3 points or tangents 

This function allows you to create a help circle, which is defined by the input of 3 

"locations". These "locations" can be either free points or tangential points. 

Options 

by 3 points   mixed    by tangents 

     

Cursor position 

The direction changes depending on the position of the cursor in relation to the cross 

hair. 
 

Cursor above cross hair  Cursor below cross hair 

    

TIP 
The solution for a circle touching 3 tangents is very complicated and is 

based on an interactive process. If no solution is found, you are 

prompted to try again by entering more precise boundary points, i.e. 

the boundary points should be marked so that they correspond as 

closely as possible to their actual position on the circumference of the 

help circle you are attempting to create. 

You can see which capture mode is active by the appearance of the 

cross hair. This means you can see whether the help circle will be 

created tangentially to an element or using a point. If you move over 

an element with the element capture mode, the help circle will be 

generated tangentially to the element.  

Circle by radius 

  

Help lines toolbar 

Draw menu > Help geometry > Circle by radius 

This function allows you to create a help circle with a certain radius by specifying 

two "locations". These two "locations" can be either free points or tangential points. 
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Options 

by 2 points   mixed    by tangents 

     

When the function is activated, the properties bar opens and you can specify the 

radii. The points or elements, which must form tangents to the help circle, must be 

selected one by one. 

Cursor position 

The direction changes depending on the position of the cursor in relation to the cross 

hair. 
 

Cursor above cross hair  Cursor below cross hair 

    

TIP 
The function remains active. 

You can see which capture mode is active by the appearance of the 

cross hair. This means you can see whether the help circle will be 

created tangentially to an element or using a point. If you move over 

an element with the element capture mode, the help circle will be 

generated tangential to the element.  

DELETING HELP GEOMETRY 

Deleting a single geometry element 

 

Toolbar. Help geometry 

 

This function deletes single help lines. Instead of using this function, you can 

highlight the help lines and delete them with the [Delete] key. If you hold down the 

[Shift] key, you can highlight several help lines. 

Deleting all help geometry 

 

Toolbar. Help geometry 

 

This function deletes all help lines from the plan, including hidden lines. 
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4.5 MANIPULATE 

Assemble selection 

 

*Manipulate toolbar 

View menu > Assemble selection 

This function is used to assemble a certain selection.  

If there is no current selection, everything is assembled. 

Hide selection 

 

*Manipulate toolbar 

View menu > Hide selection 

This function is used to hide a certain selection.  

Everything is re-assembled with the ASSEMBLE SELECTION function. 
 

TIP 
If you use the [F5] key (Assemble storey filter), you only assemble 

objects from the previous storey filter.   

Move selection 

 

*Manipulate toolbar 

Edit menu > Selection > Move selection 

This function is used to move a certain selection. 
 

When the function has been selected, you can select the point to move and the new 

position. 

Once the selection has been placed at the new point, the function remains active, so 

that the end point can be placed elsewhere until the selection is in the required 

location. The function is exited with [Esc]. 

Additional functions 

When the selection being moved is "attached" to the cursor (after the points of the 

selection to be moved have been determined), a properties bar appears with 

additional manipulation functions. 

 

Rotate 

 

Rotates the selection clockwise or anticlockwise by the value entered in the "rotation 

angle" field. 

3D rotate 

 

This function can be used to rotate objects about an axis in the space. 

Once the function is activated, the second point of the rotation axis must be digitised. 

This point must not be identical to the first point. The two points describe the 

rotation axis. The value for the desired angle must then be entered in the input line. 
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Rotate on x-axis 

 

This function rotates the selection by 90° about the x-axis. 
 

TIP 
This option is useful if you have drawn a cross-section on the floor 

plan and wish to convert it to 3D.  

Rotate on y-axis 

 

This function rotates the selection by 90° about the y-axis. 
 

TIP 
This option is useful if you have drawn a cross-section on the floor 

plan and wish to convert it to 3D.  

Mirror vertical 

 

This additional function mirrors the selection vertically. No additional input is 

required. The axis of symmetry is placed through the current reference point. 

Mirror horizontal 

 

This additional function mirrors the selection horizontally. No additional input is 

required. The axis of symmetry is placed through the current reference point. 

Mirror over arbitrary axis 

 

This additional function mirrors the selection along an axis of your choosing. Once 

the function is activated, the angle of the symmetry axis must be entered in the input 

line. The axis of symmetry is placed through the current reference point. 

Mirroring 3D 

 

This additional function mirrors the selection along the current work plane. The work 

plane corresponds to the axis (plane) of symmetry. 
 

When the function is activated, the selection made is mirrored along the current work 

plane. No additional input is required.  

Scale 

 

This additional function allows you to also make the selection larger (>1) or smaller 

(>0 and <1). 
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Once the function is activated, the scaling factor must be entered in the input line. 

The factor is greater than 1 to increase the size or less than 1 to make it smaller. 

Move on circle 

 

This additional function allows you to rotate a selection about a certain point without 

it being rotated in itself. After the function is activated, you are prompted to enter the 

rotation point. The selection is then moved through the previously entered rotation 

angle. This may be positive or negative. 

Free selection of reference point 

 

The reference point is the point to which the selection is "attached". If you notice that 

you have selected an incorrect point as you make your entry, you can redefine the 

reference point using this additional function. 
 

When this function is activated, a new window opens containing the selection. A new 

reference point can now be defined by clicking with the mouse. Once you click, the 

window disappears and the selection is "attached" to the new reference point. 

Copy selection 

 

*Manipulate toolbar 

Edit menu > Selection > Copy selection 

This function is used to copy a certain selection. 
 

When the function has been selected, you can select the point to copy and the new 

position for this point. 

Once the selection has been placed at the new point, the function remains active, so 

that the selection can immediately be copied multiple times. The function is exited 

with [Esc]. 

Additional functions 

When the selection being copied is "attached" to the cursor (after the points of the 

selection to be copied have been determined), a properties bar appears with 

additional manipulation functions. 

 

Rotate 

 

Rotates the selection clockwise or anticlockwise by the value entered in the "rotation 

angle" field. 

3D rotate 

 

This function can be used to rotate objects about an axis in the space. 

Once the function is activated, the second point of the rotation axis must be digitised. 

This point must not be identical to the first point. The two points describe the 
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rotation axis. The set angle is adopted. Then the desired placement point must be 

entered. 

Rotate on x-axis 

 

This function rotates the selection by the set angle about the x-axis. 
 

TIP 
This option is useful if you have drawn a cross-section on the floor 

plan and wish to convert it to 3D.  

Rotate on y-axis 

 

This function rotates the selection by the set angle about the y-axis. 
 

TIP 
This option is useful if you have drawn a cross-section on the floor 

plan and wish to convert it to 3D.  

Mirror vertical 

 

This additional function mirrors the selection vertically. No additional input is 

required. The axis of symmetry is placed through the current reference point. 

Mirror horizontal 

 

This additional function mirrors the selection horizontally. No additional input is 

required. The axis of symmetry is placed through the current reference point. 

Mirror over arbitrary axis 

 

This additional function mirrors the selection along an axis of your choosing... Once 

the function is activated, the angle of the symmetry axis must be entered in the input 

line. The axis of symmetry is placed through the current reference point. 

Mirroring 3D 

 

This additional function mirrors the selection along the current work plane. The work 

plane corresponds to the axis (plane) of symmetry. 
 

When the function is activated, the selection made is mirrored along the current work 

plane. No additional input is required.  

Scale 

 

This additional function allows you to make the selection larger or smaller. 
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Once the function is activated, the scaling factor must be entered in the input line. 

The factor is greater than 1 to increase the size or less than 1 to make it smaller. 

Move on circle 

 

This additional function allows you to rotate a selection about a certain point without 

it being rotated in itself. After the function is activated, you are prompted to enter the 

rotation point. The selection is then copied through the previously entered rotation 

angle. This may be positive or negative. 

Free selection of reference point 

 

The reference point is the point to which the selection is "attached". If you notice that 

you have selected an incorrect point as you make your entry, you can redefine the 

reference point using this additional function. 
 

When this function is activated, a new window opens containing the selection. A new 

reference point can now be defined by clicking with the mouse. Once you click, the 

window disappears and the selection is "attached" to the new reference point. 

Multiple copy 

 

This function is used to repeat a manipulation. 
 

After you activate the function, you are prompted to specify the number of repeats 

required in the input line. 
 

TIP 
"Multiple copy" can be combined with any number of additional 

functions. For example, a selection can be rotated and copied multiple 

times.  

Rotate Selection 

 

*Manipulate toolbar 

Edit menu > Selection > Rotate selection 

This function is used to rotate a certain selection. 
 

When this function is selected, you define the point about which the selection will be 

rotated. 

You can then enter a rotation angle in the input line or enter "0" to define two points, 

the output direction and the end direction. 

Additional functions 

When the selection being rotated is "attached" to the cursor (after the points of the 

selection to be rotated have been determined), a properties bar appears with 

additional manipulation functions. 
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Rotate 

 

Rotates the selection clockwise or anticlockwise by the value entered in the "rotation 

angle" field. 

Rotate around X-axis or Y-axis 

  

Rotates the selection by the value entered in the "rotation angle" field around the X- 

or Y-axis. 

Rotate around a free 3D-axis 

  

Rotates the selection by the value entered in the "rotation angle" field around a free 

3D-axis. The second point of the axis has to be entered. 

Rotate by point entry 

 

This additional function allows you to determine the angle of rotation through an 

output and end direction. 

Copy 

 

Activating the COPY additional function rotates a copy and leaves the original as it 

is. You can also rotate and copy a selection multiple times simultaneously by 

entering a number. 

Mirror selection 

 

*Manipulate toolbar 

Edit menu > Selection > Mirror selection 

This function is used to mirror a certain selection. 
 

When this function is selected, you define the point along which the selection will be 

mirrored. 

The angle of the symmetry axis can now be entered in the input line. 

Additional functions 

When the selection being mirrored is "attached" to the cursor (after the point of the 

axis of symmetry has been determined), a properties bar appears with additional 

manipulation functions. 

 

Mirror over arbitrary axis 

 

Mirrors the selection by the value entered in the "Angle of the symmetry axis" field. 
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Mirror vertical 

 

This additional function mirrors the selection vertically. No additional input is 

required. The axis of symmetry is placed through the specified point. 

Mirror horizontal 

 

This additional function mirrors the selection horizontally. No additional input is 

required. The axis of symmetry is placed through the specified point. 

Symmetry axis by 2nd point 

 

This additional function allows you to define the axis of symmetry through a second 

point. 

Copy 

 

Activating the COPY additional function mirrors a copy and leaves the original as it 

is.  

Scale selection 

 

*Manipulate toolbar 

Edit menu > Selection > Scale selection 

This function is used to make a certain selection larger or smaller. 
 

When this function is selected, you define the point from which the selection will be 

scaled up or down. 

A scaling factor can now be entered in the input line. The factor is greater than 1 to 

increase the size or less than 1 to make it smaller. 

Additional functions 

When the selection being scaled is "attached" to the cursor (after the point from 

which it will be scaled has been determined), a properties bar appears with additional 

manipulation functions. 

 

Scale 

 

Scales the selection by the value entered in the "Factor" field. 

Scale by point entry 

 

This additional function allows you to determine the scaling through a start and an 

end point. 
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Copy 

 

Activating the COPY additional function scales a copy up or down and leaves the 

original as it is. You can also scale and copy a selection multiple times 

simultaneously by entering a number. 

Join selection 

 

*Manipulate toolbar 

Edit menu > Selection > Join selection 

You can use this function to join individual lines or polygons to a polygon. The lines 

must result in a logical sequence. If the lines do not touch or are on a different work 

plane, they will not be taken into account. 

 

Grouping 

 

Grouping toolbar 

Edit menu > Grouping 

A selection of individually drawn parts can be grouped. This allows elements, text, 

hatches, etc. that belong together to be combined and manipulated as a group. The 

parts to be grouped must be in the same storey. Groupings can be nested. 

The preset keyboard command for "Group selection" is [Ctrl]+[G] and for 

"Ungroup" it is [Ctrl]+[Shift]+[G]. Alternatively, the options are included in the 

context menu. 

 

A selected group is highlighted in colour and given a frame with handles. The group 

can be moved or copied using the handles. 

 

A group can either be edited using the properties bar or by double-clicking. When a 

group is in editing mode, the individual objects can be changed or new parts added. 

 

Grouping selected    Edit group 
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In the group editing mode, a selection of parts can be removed from the group using 

the REMOVE SELECTION FROM GOUP function in the context menu. 

To incorporate a selection of parts into the group, the EXPAND GROUP function 

must be activated in the context menu. The selection can be made and then ended 

again via the context menu function CLOSE EXPANSION OF GROUP, or cancelled 

via the CANCEL EXPANSION OF GROUP function. 

Remove selection from group 

To remove elements from the group, a selection can be made in the group editing 

mode and confirmed in the context menu with REMOVE SELECTION FROM 

GROUP. 

Expand group 

If new parts are drawn in group editing mode, these automatically belong to the 

group. To incorporate a selection of elements that are already drawn into the group, 

the EXPAND GROUP function must be activated in the context menu and the 

required elements then selected. To exit, select the CLOSE EXPANSION OF 

GROUP function from the context menu. The function can be cancelled in the 

context menu. 

Stretch at point or line 

 

*Manipulate toolbar 

Edit menu > Selection > Stretch selection 

This function applies to the current selection and stretches or compresses the 

elements enclosed in a polygon. 
 

The stretch can be defined via a line or two points. 

Via points 

After activating the function, you are prompted to first specify a point in the current 

image and then a new position for this point. Then you are prompted to enclose the 

section of the current image that is to be moved in a polygon. The polygon chain is 

closed by clicking again on the last position. The polygon chain not only relates to 

the current work plane, but is actually a cuboid, which extends infinitely at right 

angles to the work plane. All the elements included in the cuboid are moved towards 

the new point by the distance between the two points – the connecting lines are 

"stretched" or "compressed" accordingly. 
 

Stretching is according to the following criteria: 

If possible, the 2D objects are stretched in their work plane. 

If boxes, extrudes or surface definitions are stretched along the z-axis, their 3D 

definition parameters change. 

If the stretch vector is along the z-axis and the entire object is in the cuboid, the 

entire object will be moved. 

If only part of a 3D object is in the cuboid, the surfaces are stretched.  



Chapter 4 – Basic function  

www.elitecad.eu  334 

Via a line 

When the function has been activated, you indicate the line that specifies the 

direction for the stretch. When you click on the line, the current length of the line 

appears in the input line. Entering the new line length determines the length of the 

stretch. Then you are prompted to enclose the section of the current image that is to 

be moved in a polygon. The polygon chain is closed by clicking again on the last 

position. All the elements included in the cuboid are moved along the line by the 

distance – the connecting lines are "stretched" or "compressed" accordingly. 

Lengthen/Shorten at corner 

 

*Manipulate toolbar 

 

The function connects either 2 elements or 2 walls to a corner. 

Lengthen/shorten single element 

 

*Manipulate toolbar and Lengthen/Shorten 

 

The function lengthens or shortens either elements or walls to each other. When the 

function is called up, the delimiting object is clicked first and then the one to be 

lengthened. If elements or walls are crossed, the side that is clicked with the mouse 

remains in place. 

For delimiting of elements also help lines and circles can be selected. 

Lengthen/shorten multiple elements 

 

*Manipulate toolbar and Lengthen/Shorten 

 

The function lengthens or shortens either multiple elements or walls to each other. 

When the function is called up, the delimiting object is clicked first and then the 

objects to be lengthened one after another. The function is retained until it is 

cancelled with [Esc]. If elements or walls are crossed, the side that is clicked with the 

mouse remains in place. 

For delimiting of elements also help lines and circles can be selected. 

Delete selection 

 

*Manipulate toolbar and Lengthen/Shorten 

Edit menu > Selection > Delete selection 

This function is used to delete a selection. 
 

The deletion must be confirmed. 

 

TIP 
Confirmation of the deletion process can be switched off under 

SETTINGS > OPTIONS > WORK PARAMETERS > GENERAL. 
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Copy into active storey 

 

*Modify toolbar 

Modify menu > Copy into active storey 

This function is only available in ELITECAD Architecture and is used to copy 

individual objects or a selection of objects on a storey to a different storey. 

The target storey must be active.  

If the object in question has sub objects (such as walls with windows and doors), the 

associated sub objects are also copied. The heights of walls are adapted to the storey 

concerned. In the same way, copied slabs adapt the thickness set in the storey list. A 

wall must be present for windows, doors and wall openings to be copied to a storey. 

If you wish to copy a selection, the selection must first be made and then the function 

started. 

 

The selection can be copied to further storeys. 

 

You are asked about each storey and can answer Yes or No. 

 

TIP 
This function only works within the same structure. 
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CLIPBOARD 

Cut 

  

*Main functions/Edit toolbar 

Edit menu > Cut    [Ctrl] + [X] 

This function is used to move a certain selection between drawings or views. 
 

When the function is called up, the reference point for the move can be selected. The 

selection is deleted from the current drawing and placed on the ELITECAD 

clipboard for further use. 

Copy 

  

*Main functions/Edit toolbar 

Edit menu > Copy    [Ctrl] + [C] 

This function is used to copy a certain selection between drawings or views. 
 

When the function is called up, the reference point for the copy can be selected. The 

selection is placed on the ELITECAD clipboard for further use. 

Paste 

 

*Main functions/Edit toolbar 

Edit menu > Paste    [Ctrl] + [V] 

Pastes the content of the ELITECAD clipboard into the current drawing. The pasted 

content is automatically adjusted to the scale and, in the architecture version, 

assigned to the current floor. This function is also used to paste the ELITECAD 

clipboard between ELITECAD sessions that are open at the same time. 

Absolute paste 

 

Edit toolbar 

Edit menu > Absolute paste 

Pastes the content of the ELITECAD clipboard into the current drawing. The content 

is imported regardless of the current scale. 

Image to clipboard 

 

Edit toolbar 

Edit menu > Image to clipboard [Ctrl] + [Shift] + [C] 

This function is used to copy the screen content to the Windows clipboard. The 

content of the clipboard can be transferred to other applications using Edit > Paste or 

[Ctrl] + [V]. 
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A settings dialog window appears for the IMAGE TO CLIPBOARD function. This 

allows you to control the quality. For a transfer to MS Word, the scaling can be 

increased to 300 % or even 600 % if high quality is required. Depending on the 

scaling, however, this may take up 100 MB or more of memory. 

Compatibility mode is required to generate the clipboard for programs that have 

restrictions. If this mode is switched off, the entire image section is saved to the 

clipboard. If the mode is switched on, Windows only calculates the used part. 

Whether the line gauge should be used is defined in the colour properties dialog 

window (SETTINGS menu > COLOUR PROPERTIES). 
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4.6 SELECTING 

GENERAL 

For each selection, the following principles are true: 

 A selection is highlighted in magenta. 

 If possible, the corresponding property bar and handles of the selection are 

displayed. 

 A selection can be further manipulated with the manipulation functions. 

SELECTION BY MOUSE CLICK 

A click with the left mouse button in the graphics window means SELECTING and 

EDITING. If there is nothing selected and no special selection function is active, the 

selection by rectangle starts. 
 

With a single click, the property bar of the selected object is displayed. A double 

click opens, if available, the big parameter dialog window. The text has different 

behavior – a double click on texts starts the editing function of the text. 
 

The [Shift] key enables adding or removing something to the selection. Selected 

objects are displayed in magenta and their corresponding handles are shown, 

provided there is no mixture of incompatible objects. 

SELECTION BY RECTANGLE 

The selection rectangle is used to make a selection. If the selection is made from left 

to right, a blue rectangle appears, which selects only those parts that are fully 

included in it. If the selection is made from right to left, a green rectangle appears, 

which selects all parts that it covers. You can use [Shift] + [click] to select additional 

parts or to deselect parts. 
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SELECTION BY PARAMETER 

 

Select toolbar 

Edit menu > Select > Parameter 

With this selection function, a selection is made via object parameters. Therefore, an 

object has to be selected in the graphics window. If an object is already selected 

when the function is launched, the query is obsolete and the selected object is used 

immediately. 

All parameters of the selected object are displayed in a dialog window in a list. These 

parameters are available as search criteria. 

Example for hatching parameters: 

 

Selection 

 

In this column, you can select, which parameters should be used for the search and 

which should not. If the box is ticked, the parameter will be used. 

All / None 

 

These options allow you to select or deselect all parameters. 

Open / close all groups 

 

With these functions, all parameter groups can be opened and closed all together. 

Select 

 

With a click on this button, the selection will be made. 
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SELECTION SETTINGS 

Selection with group/class/level 

Working with the classification structure model/group/class/level is possible, if the 

switch "Selection with group/class/level" is enabled under SETTINGS > OPTIONS 

> WORKING PARAMETERS > EDIT. 

The default setting for ELITECAD Mechanics is working with the classification 

structure and in ELITECAD Architecture without classification structure. 

TIP 
It is recommended not to change the presets.  

Selection element/part 

 

Selecting toolbar 

 

The part selection mode allows access to: 

 Single lines of a polygon 

 Single dimension of a chain dimension 

 3D-Object without 2D 

 The last 3D operation (e.g. Boolean operation) 
 

The selection mode is permanently changed in selection toolbar. 

For a single application of a part selection, a selection per [Alt] + click is available. 

There is no access in part selection mode for objects generated by the program. 

SELECTING TOOLBAR 

The preset in ELITECAD is a selection per mouse click or per selection rectangle. 

Special functions for selecting are launched directly via the menu EDIT > SELECT. 

Functions related to selecting which are used very often are combined into the 

SELECTING toolbar. 

The available functions in the toolbar depend on the setting SELECTION WITH 

GROUP/CLASS/LEVEL. This is the reason why the presets differ between 

ELITECAD Architecture and Mechanics. The functions ABORT and SELECTION 

ELEMENT/PART are always visible. 

Selecting in ELITECAD Architecture 

Selection mode mouse click/rectangle and layer 

 

One can switch between the two selection modes mouse click/rectangle and layer. 

Selection in layer mode selects parts based on the layer they belong to. 
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Selection image 

 

Selection of all assembled parts. 

Selecting in ELITECAD Mechanics 

Selection mode mouse click/rectangle and object 

 

One can switch between the two modes mouse click/rectangle and object. In the 

object mode objects are always selected completely. 

New object 

 

This function starts a new component (analogously to NEW CLASSIFICATION, see 

chapter 1.6 layer / classification). 

TIP 
An existing component is ACTIVATED by [Ctrl] + click. Activating 

an object also activates the workspace of the selected object. The 

classification of the selected object becomes the active classification. 

  

Select 

 

Offers quick access to the select functions. 

SELECTING 

All 

 

Select toolbar 

Edit menu > Select > All 

This function selects everything, including quantities not shown on the screen. 

Image 

 

Select toolbar 

Edit menu > Select > Image 

With this function, the current image is selected, i.e. just what is shown on the screen 

currently, but regardless of the zoom. 
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Layer 

 

Select toolbar 

Edit menu > Select > Layer 

This function includes objects depending on their layers in the selection. 
 

When you activate the function, the layer is selected. There are several options for 

this: 

 If the selection is made by clicking, several layers can be marked with the cross 

hair. To remove a layer from the selection again, simply click it again. Once you 

have specified all the layers, complete the function with [Return]. 

 The selection can be made by entering the layer name in the input line. When you 

confirm the name with [Return], more layers can be clicked or the selection ended 

with [Return]. Several layer names can be entered together in the input line. Each 

layer name must be separated with a comma. 

 If you only press [Return], the current layer is selected. 

Block 

 

Select toolbar 

Edit menu > Select > Block 

With this function, the lines contained by a polygon are selected if the elements are 

fully contained within the polygon. 
 

TIP 
ATTENTION 

Architectural objects such as walls, ceilings, windows, etc., or 

mechanical objects such as screws, profiles, etc. cannot be selected 

with this function. The objects are protected.  
 

After the function is activated, the elements in question are enclosed within a 

polygon. The polygon chain is closed by clicking again on the last position. 

Section 

 

Select toolbar 

Edit menu > Select > Section 

Lines contained by a polygon are selected and the lines are severed at the point 

where they intersect the polygon. 
 

TIP 
ATTENTION 

Architectural objects such as walls, ceilings, windows, etc., or 

mechanical objects such as screws, profiles, etc. cannot be selected 

with this function. The objects are protected.  
 

After the function is activated, the elements in question are enclosed within a 

polygon. The polygon chain is closed by clicking again on the last position. 

Exterior block 

 

Select toolbar 

Edit menu > Select > Exterior block 
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With this function, the lines excluded by a polygon are selected if the elements are 

fully outside the polygon. 
 

TIP 
ATTENTION 

Architectural objects such as walls, ceilings, windows, etc., or 

mechanical objects such as screws, profiles, etc. cannot be selected 

with this function. The objects are protected.  
 

After the function is activated, the elements in question are excluded outside a 

polygon. The polygon chain is closed by clicking again on the last position. 

Exterior section 

 

Select toolbar 

Edit menu > Select > Exterior section 

Lines excluded by a polygon are selected and the lines are severed at the point where 

they intersect the polygon. 
 

TIP 
ATTENTION 

Architectural objects such as walls, ceilings, windows, etc., or 

mechanical objects such as screws, profiles, etc. cannot be selected 

with this function. The objects are protected.  
 

After the function is activated, the elements in question are excluded outside a 

polygon. The polygon chain is closed by clicking again on the last position. 

Object 

 

Select toolbar 

Edit menu > Select > Object 

The object mode is only available in ELITECAD Mechanics and adds objects to the 

selection. It is intended primarily for self-defined components, because the objects 

generated by the program are always chosen as a whole anyway. With the 

corresponding shortcut key [F4] (default), the object mode can be activated and 

deactivated. 
 

In object mode, no rectangle selection is possible. Instead, the function EDIT > 

SELECT > BLOCK MODEL can be used. 
 

After activating the function, the objects are selected. There are several possibilities: 

 If the selection is made by clicking, several objects can be marked with the 

crosshairs. To remove an object from the selection, it has to be clicked again. If 

you have specified all objects, the function must be terminated with [Return]. 

 If you only press [Return], the current object will be selected. 

Model 

 

Select toolbar 

Edit menu > Select > Model 

This function includes objects into the selection based on their model name. 
 

After activating the function, the models are selected. There are several possibilities: 
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 If the selection is made by clicking, several models can be marked with the 

crosshairs. To remove a model from the selection, it has to be clicked again. If 

you have specified all models, the function must be terminated with [Return]. 

 If the selection is made by specifying the model name, all models with this name 

are selected. After confirming [Return] of the name, further models can be clicked 

or the selection can be ended with [Return]. It is also possible to enter several 

model names in the input line. The respective model names must be separated by 

a comma. 

 If you only press [Return], the current model will be selected. 

Block model 

 

Select toolbar 

Edit menu > Select > Block model 

This function selects the models touched by a polygon, with only one element of the 

model partially contained in the polygon. The models defined by the polygon are 

selected entirely. 
 

After activating the function, the patterns affected by the polygon are marked. The 

polygonal chain is completed by a second click on the last position. Subsequently, 

the selection made can be manipulated. 
 

TIP 
In contrast to the selection functions CUT and BLOCK, the BLOCK 

MODEL selection function also includes all 3D and object 

information. An architectural or mechanical object can therefore be 

processed further.  

Group 

 

Select toolbar 

Edit menu > Select > Group 

This function includes objects into the selection based on their group name. 
 

TIP 
The selection GROUP only appears in the selection options of the 

manipulations if the option SELECTION WITH GROUP / CLASS / 

LEVEL is activated in the working parameters.  
 

After activating the function, the groups are selected. There are several possibilities: 

 If the selection is made by clicking, several groups can be marked with the 

crosshairs. To remove a group from the selection, it has to be clicked again. If you 

have specified all groups, the function must be terminated with [Return]. 

 If the selection is made by specifying the group name, all groups with this name 

are selected. After confirming [Return] of the name, further groups can be clicked 

or the selection can be ended with [Return]. It is also possible to enter several 

group names in the input line. The respective group names must be separated by a 

comma. 

 If you only press [Return], the current group will be selected. 
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Class 

 

Select toolbar 

Edit menu > Select > Class 

This function includes objects into the selection based on their class name. 
 

TIP 
The selection CLASS only appears in the selection options of the 

manipulations if the option SELECTION WITH GROUP / CLASS / 

LEVEL is activated in the working parameters.  
 

After activating the function, the classes are selected. There are several possibilities: 

 If the selection is made by clicking, several classes can be marked with the 

crosshairs. To remove a class from the selection, it has to be clicked again. If you 

have specified all classes, the function must be terminated with [Return]. 

 If the selection is made by specifying the class name, all classes with this name 

are selected. After confirming [Return] of the name, further classes can be clicked 

or the selection can be ended with [Return]. It is also possible to enter several 

class names in the input line. The respective class names must be separated by a 

comma. 

 If you only press [Return], the current class will be selected. 

Level 

 

Select toolbar 

Edit menu > Select > Level 

This function includes objects into the selection based on their level name. 
 

TIP 
The selection LEVEL only appears in the selection options of the 

manipulations if the option SELECTION WITH GROUP / CLASS / 

LEVEL is activated in the working parameters.  
 

After activating the function, the levels are selected. There are several possibilities: 

 If the selection is made by clicking, several levels can be marked with the 

crosshairs. To remove a level from the selection, it has to be clicked again. If you 

have specified all levels, the function must be terminated with [Return]. 

 If the selection is made by specifying the level name, all levels with this name are 

selected. After confirming [Return] of the name, further levels can be clicked or 

the selection can be ended with [Return]. It is also possible to enter several level 

names in the input line. The respective level names must be separated by a 

comma. 

 If you only press [Return], the current level will be selected. 

Attribute 

 

Select toolbar 

Edit menu > Select > Attribute 

This function includes objects into the selection based on their attributes. 
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TIP 
With the help of the INFO> MODEL INFORMATION function, the 

various attributes and their values can be viewed.  
 

After activating the function, the desired attribute name is entered in the input line. 

Thereafter, the value of the attribute, which is to be selected, is entered. This process 

is carried out as often as required until the appropriate selection has been made and 

finally ended with [Return]. 
 

TIP 
The prerequisite is that a corresponding attribute file is loaded with the 

function ATTRIBUTE PARAMETERS.  

BUFFER 

The buffer provides a special selection function. The buffer can temporarily store a 

mixed selection. 

The buffer will remain until the drawing is deleted. 
 

TIP 
A buffer is not stored in a work copy. 

  

Select buffer 

 

Buffer toolbar 

Menu Edit > Select > Buffer 

This function is used to select a defined buffer for subsequent manipulation. 
 

After activating the function, the desired buffer name is entered in the input line. The 

buffer content is marked and can then be further processed with the manipulation 

functions. 

In Buffer 

 

Buffer toolbar 

Menu Edit > Select > In Buffer 

This function causes an assignment of the defined selection to the specified buffer, 

whereby it adds to an already existing content additively. 
 

Before activating the function, the selection is defined. Then the function is called 

and the name of the desired buffer is entered. The selection made is added to the 

buffer contents. 

From Buffer 

 

Buffer toolbar 

Menu Edit > Select > From Buffer 

This function removes the selection made from the specified buffer. 
 

Before activating the function, the selection is defined. Then the function is called 

and the name of the desired buffer is entered. The selection made is removed from 

the buffer. 

Block copy in buffer 

 

Buffer toolbar 
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This function copies the lines delimited by a polygon to the specified buffer. Only 

lines that are completely contained in the polygon are affected by this operation. 

This function creates copies, the original objects remain unchanged. 
 

After activating the function, the polygonal chain limits the affected elements. The 

polygon is completed by a second click on the last position. After closing the 

polygon, the name of the buffer must be entered in the input line. Now the elements 

are copied and can be called up and manipulated by means of the function SELECT 

BUFFER. 

Section copy in buffer 

 

Buffer toolbar 

 

This function copies the lines delimited by a polygon to the specified buffer, dividing 

the lines at the intersection with the polygon. This function creates copies, the 

original objects remain unchanged. 
 

After activating the function, the polygon chain limits the affected elements. The 

polygon is completed by a second click on the last position. After closing the 

polygon, the name of the buffer must be entered in the input line. Now the elements 

are copied and can be called up and manipulated by means of the function SELECT 

BUFFER. 

Clear buffer 

 

Buffer toolbar 

Menu Edit > Select > Clear Buffer 

This function clears the specified buffer. That means, after calling the function and 

specifying the buffer name, the affected buffer is empty. 
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4.7 GENERAL PARAMETERS 

EDITING PARAMETERS 

When you click on an element, a rest (text, hatch, scale) or an architectural or 

mechanical object, the properties bar opens and the properties can be changed.  

ADOPT PARAMETERS 

 

*Modify toolbar 

Edit menu > Adopt parameters 

This function adopts a current parameter and opens the relevant creation function so 

that this parameter can be used to create other elements, rests (text, hatch, 

dimensions) or architectural or mechanical objects.  
 

The function can be called up in two different ways. First, select the function and 

then click on the relevant object or, if you are already in editing mode, select the 

function afterwards. In both cases, the associated creation function is opened. 

 WORKSHOP  

Adopting parameters for a hatch 

When you select the AUTOMATIC HATCH function to create a hatch, the 

properties bar always opens with the parameter settings of the hatch you created most 

recently. 

 

 

In this case, a "brick" hatch was created. 

Now you already have a hatch on your plan and you want to generate an identical 

one. 
 

Select the ADOPT PARAMETERS function. 

 

Click on the hatch from which you want to adopt the parameters. 

 

The properties bar opens with the correctly set values and you can create the hatch. 

 

  WORKSHOP END 
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COPY PARAMETERS 

 

*Modify toolbar 

Modify menu > Copy parameter(s) 

This function transfers the parameters from an existing element, rest (text, hatch, 

dimensions) or architectural or mechanical object to another of the same type. 
 

The function can be called up in two different ways. First select the function and then 

click on the relevant object or, if you are already in editing mode (double-click), 

select the function afterwards. In both cases, the associated dialog window is opened. 

Parameter 

 

Selection 

 

In this column, you can select which parameters should be copied and which not. If 

the box is ticked, the parameter will be copied. 

If all parameters are selected, the parameter record name will also be copied for the 

following objects: dimension, hatch, text, column, door, girder, floor, wall, window. 

Parameter 

 

The parameters that can be copied are listed here. 
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Modify value locked 

   

In this column you can see, which of the values can be modified and which cannot. If 

the padlock is open (green), the value to the right can be changed. If the padlock is 

closed (red), the parameter can be copied but not changed. 

If several objects are selected for copying parameters, the parameters of the first 

object selected are used and a ≠ indicates parameters that are not the same for all 

selected objects. 

Value 

 

The various values for the individual parameters are listed here. These values can be 

changed, depending on the status of the padlock symbol. 

If the padlock is open (green) and you click in the field, a selection list appears. 

 

Selection and copying options 

 

All / None 

 

These options allow you to select or deselect all parameters. 

Open / close all groups 

 

With these functions, all parameter groups can be opened and closed all together. 

Copy to single/on image/on all 

 

The parameters can either be inherited by individual parts, by visible parts or by all.  

If you select the SINGLE option, you can then click on the relevant objects in the 

plan. 

If you select the ON IMAGE option, the parameters are applied to the appropriate 

objects that are visible on the screen. 

If you select the ON ALL option, the parameters are applied to the appropriate 

objects, even if they are not visible on the screen. 

Selection 
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For the ON IMAGE and ON ALL copying options, there is an additional option in 

addition to the selection regarding visibility. 

 

If you make only the selection "Text height" (5) in the window, for instance, and 

close with "Select" and "on image", only the text that is visible on the screen and has 

text height 5 will be changed. With the copying option ON ALL, all text with text 

height 5 will be changed. 

If you close the selection dialog window and then click on "Copy to single", the 

selection will be ignored. 

 WORKSHOP  

Copying parameters for lines 

You have a thin, dotted line and thick, solid lines. You now want to change the solid 

lines to thin, dotted lines. 

 

Select the COPY PARAMETER(S) function and click on the dotted line. 

 

 

Select the SINGLE option and click on the elements one by one that you want to 

change. If you want to change all the elements visible on the screen, select the ON 

IMAGE option. 
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CANCEL function 

 

  WORKSHOP END 
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5.1 ELEMENTS 

Drawing lines 

  

Draw toolbar 

Draw menu > Draw line 

Draw single lines from a start point to an end point. 

Line properties bar 

 

The line type and line colour can be selected from the line properties bar. In 

ELITECAD Architecture the renovation planning state can be selected. 

Line length and line angle also appear when editing. Changes of the length are 

applied relative to the start point. 

Draw polygon 

  

Draw toolbar 

Draw menu > Draw 

This is used to draw a continuous line. In order to complete the line, the last point 

can be selected again. The function remains active and more lines can be drawn. If a 

line has been completed, a new line can be started by selecting another start point. 

Press the [Esc] key or click the CANCEL function in order to end this function. 

A polygon can be selected with a single click. If the Selection mode element part is 

active, single elements can be accessed. 

Polygon properties bar 

 

The line type and line colour can be selected from the line properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 
 

TIP 
The program shows the additional functions, which are useful when 

drawing in the input assistant. The functions can be displayed either in 

a separate input assistant toolbar or on the cursor by pressing the [Tab] 

key. 

  

Polygon via entry of coordinates 

Very often it is not possible to capture a point, a certain line length is predefined. 

These lines can of course be constructed with help lines. It is much easier and more 

efficient to enter a polygon using coordinates. 

Values field 

Lengths can be entered directly in the values field. To move to the values field, press 

the [Tab] key. In the values field the x value (horizontal), the y value (vertical), the 

direct value or the angle can be entered. 
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Value on element or help line 

If, when a value is entered, the cursor is on an element or a help line that passes 

through the marker or a temporary reference point, the entry switches to the direct 

value and you need only enter the distance, without worrying about the angle or the 

minus range. 

    

x, y distance from a given point (capture mode to AUTOcapture) 
 

The capture mode to AUTOcapture is directly integrated into the AUTOcapture 

mode. If, when a value is entered, the cursor is on a point, the values of this point are 

removed. The sign for the direction must be taken into consideration. 

  

Manipulate Polygon 

A created polygon can be modified. The 1st click on the polygon selects it and the 

handles appear at the corners. 

 1st click 2nd click 

 

marker 

temporary help line 

capture-symbol 

temporary  

reference point 

capture-symbol 

control symbol to which reference 
point the distance is measured 

minus x value 

angle 

direct value 

y value 

minus 
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The second click decides which corner or which edge to modify. So that you can tell 

that the cursor is over a changeable element, it changes its appearance to a quadruple 

arrow. 

Other manipulation functions appear depending on whether a line, a curve, a corner 

or an end point was clicked. The function last selected is immediately active. 
 

The available manipulation options can be displayed in a separate input assistant 

toolbar either by pressing the [Tab] key or on the cursor.  

 

Manipulation options on a corner 

Stretch point   Delete point 

     

  

Chamfer   Fillet 

      

  

Manipulation options on an edge 

Insert point   Round edge   Stretch element 

         

   

Manipulation options for a corner or edge 

Move selection    Scale element 
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By pressing the [Ctrl] key at the same time, the selection can be copied when moved.  

When scaling, a reference point must be set as the starting point for scaling. 
 

Move elements parallel  Move all edges parallel 

      

   

Selection element part 

For certain manipulations such as move selection or extend elements/move in 

parallel, it makes sense to perform the manipulation not on the entire polygon but 

only on certain elements. 

To enable individual elements to be selected, the selection mode must be switched to 

Selection element part. Alternatively, press the [Alt] key. Multiple selection is 

possible with [Shift].  

 

Change polygon 

A distinction is made between whether a closed or an open polygon is to be 

modified. 

After selecting the CHANGE function, the drawing functions with which the change 

can be drawn appear in the input assistant. 
 

Expand/reduce closed polygon by one circle: 

First, select the EXPAND OR REDUCE POLYGON function followed by the 

drawing function CIRCLE. 

Drawing function   Polygon   Reduce polygon 

Extend circle 
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Open polygon: 

 

For the open polygon, the extension polygon must be started on the geometry and 

ended by double-clicking on the geometry. An exception is when you start on an end 

point. If the polygon cannot be closed properly, the change is not carried out. 

  

 

Rectangle by diagonal 

  

Draw toolbar 

Draw menu > Rectangle by diagonal 

Creating a rectangle by entering two points over a diagonal. 

While drawing a rectangle the entry mode can be changed in the input assistant. 

Three options are available. 

 Rectangle by diagonal 

 Rectangle by dimensions and reference point 

 Rectangle by edge and height 

Rectangle properties bar 

 

The line type and line colour can be selected from the properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 

Rectangle by dimensions and reference point 

  

Draw toolbar 

Draw menu > Rectangle by dimension and reference point 

This function enables the drawing of a rectangle by entering its width and height as 

well as the optional reference point and a display angle. 

While drawing a rectangle the entry mode can be changed in the input assistant. 

Three options are available. 

 Rectangle by diagonal 

 Rectangle by dimensions and reference point 
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 Rectangle by edge and height 

Rectangle properties bar 

 

The line type, line colour, width, height, angle and reference point can be selected 

from the properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 

Parallel contour 

  

Draw toolbar 

Draw menu > Parallel contour 

This function creates a new contour on one side of the original contour (open or 

closed) which is displaced so that all points are parallel to the desired distance. 
 

After activating the function, enter the contour distance into the properties bar. After 

selecting the contour, the direction of the parallel contour can be selected by flipping. 

The selected contour is automatically scanned or the points can be marked over a 

polygonal chain. Closed profiles are automatically recognised, open profiles must be 

completed by specifying the end point (close polygon). 

 

In ELITECAD Architecture the renovation planning state can be selected. 

Breadth line 

  

Geometry toolbar 

Draw menu > Geometry > Breadth line 

This function enables you to create a breadth line (e.g. pipe, wall) easily. Only either 

one side or the breadth line's centre line must be drawn. 

After activating the function, the gauge, breadth line type and line reference are 

given and separated by a comma. 

Breadth line type 

 

Line reference 

breadth line type 
0   . .  not open 

breadth line type 
1   . .  start open 

thickness 

breadth line type 

2   . .  start&end open 

breadth line type 

3   . .  end open 

breadth line start 
reference – 1 for centred 



Chapter 5 – 2D Objects  

www.elitecad.eu  360 

 

After setting the starting point, the direction for the breadth line thickness needs to be 

indicated by clicking it in case the line preference is not centred. The line is then 

specified by the input of further points. The input is completed when the last point is 

entered twice. The system automatically draws the second line and finalises the 

breadth line corresponding to the breadth line type. 
 

TIP 
If a breadth line joins an already existing one that requires a breadth 

line type, the connection point is assumed. 

  

Halving of an angle 

 

Geometry toolbar 

Draw menu > Geometry > Halving of an angle 

This function enables elements or help lines with half angles to be generated.  
 

After activating the function, a first and a second element are requested. If two help 

lines are clicked, a help line is generated.  

If at least one element is selected, a line with an active pen/line type is drawn and an 

additional query for the position of the start and end points appears. The suggested 

position can be confirmed by hitting [Enter] each time or by clicking the specific 

points with the mouse.  

breadth line start 
reference – 1 for centred 

breadth line start 
reference – 0 for not-centred 

direction point 

connection  
points 

1. breadth line 

2. breadth line 
breadth line type 2 
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5.2 CIRCLE FUNCTIONS 

Circle with given centre and radius 

  

Draw toolbar 

Draw menu > Circle with given centre and radius 

This function enables the construction of one or more circles by entering the radii. 

Circle properties bar 

 

The line type, line colour, radii and the circle's reference point can be specified in the 

properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 

Radius 

Up to 10 radii can be entered separated by commas. 

Reference point 

 

The reference point determines which point the circle is attached to the crosshair. 

 >         >  

Circle by centre 

  

Draw toolbar 

Draw menu > Circle by centre 

This function creates a circle by specifying the centre point as well as a point on the 

circle's circumference. The circle can also be established tangentially to an element 

(drawing line, help line or line, curve). 

Circles properties bar 

 

The line type and line colour can be selected from the properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 
 

Through point Tangent to element 
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TIP 
You can see which capture mode is active by the appearance of the 

crosshair. This means you can see whether a circle will be created 

tangential to an element or straight through a point. As long as you 

position the element with the element mode, the circle will be 

generated tangential to the element.  

Circle by 3 points or tangents 

  

Draw toolbar 

Draw menu > Circle by 3 points or tangents 

This function enables the construction of a circle, which is specified by three 

"locations". These "locations" can be either free points or tangential points. 

Options 

By 3 Points   Mixed    By tangents 

     

After activating the function, the points or elements to which the circle needs to be 

tangential must be selected one by one. 

Cursor position 

The direction changes depending on the cursor's position over the crosshair. 
 

Cursor above crosshair  Cursor below crosshair 

    

Circle by radius 

  

Draw toolbar 

Draw menu > Circle by radius 
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This function creates a circle with the radius value specified in the properties bar and 

then prompts for two more points or tangential elements. 
 

TIP 

 

The radii of circles can be retrospectively modified by selecting the 

circle.  

Options 

By 2 points   mixed    by tangents 

     

When the function is activated, the properties bar opens and you can specify the 

radii. The points or elements to which the circle needs to be tangential must then be 

selected one by one. 

Cursor position 

The direction changes depending on the cursor's position over the crosshair. 
 

Cursor above crosshair  Cursor below crosshair 

    

Curve by 3 points 

  

Draw toolbar 

Draw menu > Curve by 3 points 

This function creates a curve through a given start point, point on the circumference 

and end point. 

While drawing a curve the entry mode can be changed in the input assistant. Three 

options are available. 

 Curve by 3 points 

 Curve by centre point 

 Curve by tangent  Curve by centre point 
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Curve properties bar 

 

The line type and line colour can be selected from the properties bar. The curve 

radius and angle are displayed when editing. 

In ELITECAD Architecture the renovation planning state can be selected. 

Curve over angle, direction and centre point 

  

Draw toolbar 

Draw menu > Curve over angle 

This function enables a curve through a given start point, angle and the curve's centre 

point. 

Curve properties bar 

 

The line type and line colour can be selected from the properties bar. The curve 

radius and angle are displayed when editing. 

In ELITECAD Architecture the renovation planning state can be selected. 

Ellipse 

  

Geometry toolbar 

Draw menu > Geometry > Ellipse 

This function is used to create an ellipse.  

Create an ellipse by inputting two vertices on an axis and clicking on a third. 

Ellipse properties bar 

 

The line type and line colour can be selected from the properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 

Spline 

  

Geometry toolbar 

Draw menu > Geometry > Spline 

This function enables the creation of a smooth interpolation curve with a random 

number of points (cubic splines). 
 

After activating the function, you can specify the points of the polygon and once 

again tap the end of the last point. In this case, the curve is incomplete and you will 

be prompted to enter an inclination angle in the start and end points. 

Spline properties bar 

 

The line type and line colour can be selected from the properties bar. 

In ELITECAD Architecture the renovation planning state can be selected. 
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5.3 EDIT 

Fillet 

  

*Modify toolbar 

Modify menu > Elements > Fillet 

This function rounds line or wall corners (in ELITECAD Architecture). Joints, which 

have already been rounded, can be modified or restored to a corner. After entering 

the desired radius, you must click INSIDE the filleted corner. 

Fillet property bar 

 

Fillet 

 

The symbol indicates that the FILLET function is active. You can switch to 

CHAMFER or NOTCH here. 

Radius 

 

Enter the radius, which is used for the fillet operation. 

Modify 

 

This function modifies or deletes previously defined fillets. Enter a "0" in order to 

delete a fillet. 
 

TIP 
 More corners with the same radius are filleted when you indicate 

more points. 

 T-joints with these functions are also editable. The function affects 

the entire picture and not just the active object.  

Notch 

  

*Modify toolbar > Fillet > property bar 

Modify menu > Elements > Fillet 

This function generates a notch in the corner of two lines or it is used to modify 

existing notches. After entering the desired radius, you must click INSIDE the 

corner. The notch is generated automatically. 

Notch property bar 

 

The functions on the property bar are identically to the FILLET function. 
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Chamfer 

  

*Modify toolbar > Fillet > property bar 

Modify menu > Elements > Chamfer 

This function generates a chamfer in the corner of two lines or walls (in ELITECAD 

Architecture) by specifying the chamfer distance and chamfer angle or the function is 

used to modify existing fillets. The chamfer distance and angle ("0" if the fillets are 

symmetrical) can be specified. The point of both lines will subsequently be marked 

by the crosshair, which will need to be moved closer to the line, and which is then 

used as a reference for the angle and parallel distance. 

Chamfer property bar 

 

Chamfer 

 

The symbol indicates that the CHAMFER function is active. You can switch to 

FILLET or NOTCH here. 

Chamfer type 

There are three options to define a chamfer. 

 

Chamfer by two distances 

 

This option defines a chamfer by two distances measured from the corner. 

Chamfer by distance and angle 

 

This option defines a chamfer by a distance and an angle. 

Chamfer symmetrically by distance 

 

This option uses two symmetrical distances from the corner point to define the 

chamfer. 

Modify 

 

This function modifies or deletes a previously defined chamfer. In order to delete a 

fillet, switch to "symmetrically by distance" and enter a "0". 
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TIP 
The function is only applicable to straight lines (not curves). Both lines 

can represent different models. More identical fillets are created by 

specifying more points. Should the fillets need modifying, this can be 

done by entering "0". The active values of displayed fillets are taken 

into account when the entry for the angle or distance (value 

maintained) is changed to "-1". It is then possible that, for example, 

multiple fillets with different angles the same fillet distances apart and 

vice versa can be modified. A change in angle and distance for existing 

fillets is also possible.  

Divide element 

  

*Modify toolbar 

Modify menu > Elements > Divide element 

Divide an element to a particular location. This can be applied to lines, polygons or 

rectangles. 

Join element 

  

*Modify toolbar 

Modify menu > Elements > Join element 

Connect adjacent elements lying on a straight line. Only one line needs to be 

selected. The system combines all possible lines to one line.  

Name element 

  

Elements toolbar 

Modify menu > Elements > Name element 

This function allows assigning names to elements. 

An element has to be selected. 
 

Element names a assigned by functions or by external programs. Used element are 

described in the corresponding documentation. 

Pen/line type of element 

  

Elements toolbar 

Modify menu > Elements > Modify pen/line type of element 

This applies to an element's pen and line type settings. These settings become active 

when a drawing function is called up (line, rectangle, circle ...).  

Modify pen/line type of segment 

  

Elements toolbar 

Modify menu > Elements > Pen/line type of segments 

This enables changes to a segment's pen and line type settings (segment = part of an 

element). Multiple segments can be selected until the function is exited. The chosen 

segment is separated from the line and remains as a separate line. 
 

TIP 
Intersection points with geometric lines are not taken into account. 
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Modify pen/line type of element 

  

Elements toolbar 

Modify menu > Elements > Modify pen/line type of element 

This enables changes to an element's pen and line type settings. Multiple segments 

can be selected until the function is exited. 

Globally modify pen/line type of elements 

 

Elements toolbar 

Modify menu > Elements > Globally modify pen/line type of elements 

This functions allows you to globally modify elements of a desired pen/line type by 

choosing the pen and line type in the active image. 

After activating the function, a query dialog appears with a selection of elements for 

pen and line type where the single values are entered and separated by commas. The 

pen/line type is consequently entered, which should modify the elements. 

To change elements with pen 1 and line type 1 to pen 3 and line type 4, enter "1.1" to 

select them and "3.4" for the new pen and line type. 

Modify pen/line type of elements from a 

selection 

 

Elements toolbar 

Modify menu > Elements > Modify pen/line of selection  

This function allows you to modify the pen number and line type of an already drawn 

element from a selection. 
 

After activating the function, both the pen number and line type, which are to be 

changed, are entered. The new pen number and new line type are subsequently 

entered. 

Delete element 

 

Elements toolbar 

 

This function deletes an element. 
 

TIP 
You can also delete an element by directly clicking on it or by 

selecting it from the selection mode "element/part", and then pressing 

the [Delete] key. Depending on the settings under OPTIONS, a 

confirmation prompt appears.  

Delete segment 

 

*Manipulate toolbar; Elements 

 

This function deletes part of an element. The part needs to be marked off with 

another element (line or circle). 
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Delete polygon 

 

*Manipulate toolbar 

 

This function deletes an entire sequence of lines. 

Delete last drawn element 

 

*Manipulate toolbar 

 

This function deletes the last drawn line. When drawing a line, it is preferable to use 

this function if a point is incorrectly set and you wish to go back without ending the 

drawing. 
 

TIP 
Alternatively, the UNDO function [Ctrl]+[Z] can be used. 

  

Delete block 

 

*Manipulate toolbar 

 

This function deletes all parts, which fully lie within a determinable polygon. 
 

TIP 
If 3D objects can only be partly found in a polygon, a message appears 

saying that parameterised objects can be found in the block. In this 

case, the polygon must be drawn differently or you can remove the 

object lock under SETTINGS > OPTIONS > WORK PARAMETERS 

> EDIT (a conversion from the V11 user interface).  

Delete section 

 

*Manipulate toolbar 

 

This function deletes all parts, which lie within a determinable polygon. Elements or 

hatches are cut. 
 

TIP 
If 3D objects can only be partly found in a polygon, a message appears 

saying that parameterised objects can be found in the block. In this 

case, the polygon must be drawn differently or you can remove the 

object lock under SETTINGS > OPTIONS > WORK PARAMETERS 

> EDIT (a conversion from the V11 user interface).  

Delete double line 

 

Special functions toolbar 

Extras menu > View tools/deletion lines 

The function DELETE DOUBLE LINES can be found under View tools. This 

function eliminates superimposed lines with the same stroke thickness. 
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Verify 2D model 

  

Info toolbar 

Info menu > Verify 2D model 

It only makes sense to use this function when you are working with the classification 

structure (model). This function checks whether the model is a closed contour. A 

query dialog appears in an open model asking whether it should visualise where the 

contour is open. The crosshair is set at the open location. 

 

Secondly, the model is checked to see if the model's lines cross each other. These 

locations can also be visualised. 

 

 

Stretch single point 

 

Elements toolbar 

Modify menu > Elements > Stretch single point  

This function enables you to stretch or compress an element by moving a boundary 

point. 
 

After activating the function, you are prompted to specify the point to be moved. 

You are then prompted to publish the new position. The element concerned is 

intersecting itself 

open contour 
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subsequently moved towards the new point by the distance between the two points 

and is "stretched" or "compressed" accordingly. 
 

TIP 
The same can be achieved by clicking on element and manipulation via 

the handle.  

Stretch selected points 

 

Elements toolbar 

Modify menu > Elements > Stretch selected points  

This function enables you to stretch or compress one or all combined elements in a 

point by moving a boundary point. 
 

After activating the function, you are prompted to specify the point to be moved. 

You are then prompted to indicate the new position. The elements, which should be 

stretched / compressed, can now be accessed. These are moved towards the new 

point by the distance between the two points and are "stretched" or "compressed" 

accordingly. 
 

TIP 
The same can be achieved by clicking on element and manipulation via 

the handle. You can select multiple elements by holding down the 

[Shift] key.  

Stretch all points 

 

Elements toolbar 

Modify menu > Elements > Stretch all points  

This function enables you to stretch or compress all combined elements in a point by 

moving a boundary point. 
 

After activating the function, you are prompted to specify the point to be moved. 

You are then prompted to publish the new position. All elements concerned are 

subsequently moved towards the new point by the distance between the two points 

and is "stretched" or "compressed" accordingly. 
 

TIP 
The same can be achieved by clicking on element and manipulation via 

the handle. You can select multiple elements by holding down the 

[Shift] key.  
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5.4 IMAGE 

Load bitmap file 

  

Bitmap toolbar 

Menu Insert > Image 

This function is used to read an image in bitmap format. 

The dialog field Load bitmap appears after activating this function. The desired 

bitmap image can now be selected and positioned. Whilst positioning it, other 

possibilities such as stretching, mirroring, etc. are available in the manipulation bar. 

 

The manipulation of bitmap images such as stretch, mirror etc. can also be 

performed retrospectively with the normal edit function. 

In ELITECAD Architecture the renovation planning state can be selected. 
 

TIP 
Available bitmap formats for import are TIFF, JPEG, BMP and PNG. 

  

Delete bitmap image 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > delete 

This function is used to delete one or multiple bitmap images. 

When the function is activated, the existing bitmap image is deleted. 
 

Deleting bitmap images is also possible by selection. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to delete.  

Crop bitmap image 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > Crop 

This function is used to crop an image section. The rest of the bitmap image is 

automatically deleted. After activating the function, the desired cut-out is defined by 

the entry of two points (defining rectangle) or a free polygon. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  

Invert monochrome bitmap 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > Invert colour 

You can use this function to swap the monochrome (B/W) bitmaps in the background 

with those in the foreground. The white pixels will turn black and vice versa. 
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TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  

Delete bitmap range 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > Delete range 

This function is used to cut a defined range of bitmap images. The ranges of the 

bitmap images, which are not needed, can be deleted with this function. 

After activating the function, the cutout to be deleted is defined by the entry of two 

points (defining rectangle) or a free polygon. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  

Copy range 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > Copy range 

You can use this function to copy ranges from bitmap images. 

After activating the function, the range to be copied over is defined by the diagonal 

of a rectangle. 
 

TIP 
The background of the set copy is no longer visible after it has been 

placed. If multiple bitmap images can be found on the plan, you will be 

asked which bitmap image you wish to edit. 

The copy can only be pasted into the bitmap image out of which the 

copied range was selected.  

Copy range transparent 

  

Bitmap toolbar 

Menu > Modify > Edit bitmap > Copy range transparent 

You can use this function to copy transparent ranges from monochrome (B/W) 

bitmap images whose background is inverted to black where necessary by means of 

the pixels. After activating the function, the range to be copied over is defined by the 

diagonal of a rectangle. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit. 

The copy can only be pasted into the bitmap image out of which the 

copied range was selected.  

High quality on/off 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > High quality on/off 
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This function is used to convert monochrome bitmap images into greyscale. 

After activating the function, all monochrome bitmap images are depicted in either 

greyscale or back to monochrome. 
 

TIP 
For colour images, this function does not have an effect, as colour 

images are always depicted in high quality. If there are both 

monochrome and colour images on the screen, the monochrome 

images are not converted either.  

Assign transparent colours 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > Assign transparent colours 

You can use this function to switch on the transparency of a particular colour of a 

bitmap image. After activating the function, the cursor becomes a pipette icon and 

the appropriate colour can be selected.  

The tolerance value can subsequently be entered into the input line. You can then 

control the intensity of the transparency colour. The higher the value, the more 

transparent is the colour. 

Example: 

Tolerance 0%  Tolerance 30% Tolerance 80% 

     

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit. The transparency can be deleted 

with the DELETE TRANSPARENCY function.  

Transparency gradient 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > Transparency gradient 

A bitmap image is allocated a transparency gradient with this function. After 

activating this function, you will be asked for the start and end transparency as well 

as the start distance (gradient starts at 0-50%). The values are each separated by a 

comma. The angle of the gradient is subsequently requested. 
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Example: 

Transparency: 0-100  Transparency: 80-80  Transparency: 0-100 

Start distance 0  Start distance 0  Start distance 0 

Angle 0   Angle 0   Angle 90 

   

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit. The transparency can be deleted 

with the DELETE TRANSPARENCY function.  

Delete transparency 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > Delete transparency 

This function deletes transparent colours or gradients from bitmap images.  
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  

Bitmap image: export to file 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > Bitmap image: export to file 

This function is used to export a bitmap image from an ELITECAD drawing into a 

file. The dialog field "Bitmap image: export to file" appears after activating this 

function. A new file name can be entered here or an existing one chosen and 

confirmed with "Save". If a pre-existing name is selected, a confirmation prompt 

then appears which needs to be confirmed with either OK or CANCEL. 
 

The following data formats can be written: TIFF, JPEG, BMP and PNG. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  
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Bitmap image: delete from file 

  

Bitmap toolbar 

Menu > Modify > Edit pixel > Bitmap image: delete from file 

This function is used to replace an already existing bitmap image with another 

whereby the dimensions of the existing image are applied. 
 

TIP 
If multiple bitmap images can be found on the plan, you will be asked 

which bitmap image you wish to edit.  
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6.1 DIMENSIONING 

GENERAL 

The dimensioning is part of the rest. 

Visible/invisible 

 

Dimensions can be switched off temporarily using the image control functions. 

Switch on/off 

VIEW menu > SWITCHES 

If you switch off the dimensions using this check box, the dimensions are not saved 

during "Save as" unless the subsequent dialog window is confirmed with "visible 

selection". 

Rest scaling 

SETTINGS menu > REST SCALING on/off 

If rest scaling is switched off, the dimensions are not enlarged or reduced when 

scaling or modifying the scale. 

Behaviour when positioning dimensions 

When you position a dimension line, the system always prompts for two points to be 

dimensioned. It does not matter whether this is a chain dimension or a single 

dimension.  

If the points lie horizontally on a line, this results in a horizontal dimension: 

 

If the points lie vertically on a line, this automatically results in a vertical dimension 

line: 

 

If the points lie neither horizontally nor vertically on a line, you can specify the 

desired direction when defining the dimension line. 
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As you position the dimension lines, you are aided by "dimension tracking", which 

gives a preview of where the dimension will lie.  

Handle behaviour 

If you click on a dimension, the handles appear on screen. 

Handles: 

 

Handle 1: Used for lengthening or shortening the help line 

Handle 2: Used for positioning/moving text 

Handle 3: Used for lengthening or shortening the help line 

Handle 4: Used for lengthening or shortening the help line 

Handle 5: Used for lengthening or shortening the help line 

Gripper 6: Used for moving the dimension chain 

Refresh dimension associations 

 
 

Extras menu > Special functions > Refresh dimension associations 

This function is only available in ELITECAD Architecture and checks all 

dimensions, cleans up existing dimension associations and adds missing dimension 

associations to architectural objects. 

You should run this function if you modify architectural objects and their dimensions 

do not adapt accordingly. 
 

TIP 
In the SETTINGS > OPTIONS > DEPICTION > 2D/3D menu, under 

the DIMENSION AND TEXT CHECKS function, you can view the 

non-associative dimensions.   
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SINGLE DIMENSION  

 

Toolbar * Create new 

Lay-out menu > Dimensions > Single dimension 

This function is only available in ELITECAD Mechanics and is analogue to the first 

dimension of a chain dimension. 

CHAIN DIMENSION  

 

Toolbar * Create new 

Lay-out menu > Dimensions > Chain dimension 

This function is used to enter a sequential dimension. 

Chain dimension properties bar  

You can select the dimension's main values in the properties bar. In the rear area, you 

can select options for defining dimension points. However, the dimensions are fine-

tuned under the dimension parameters. The property bar in ELITECAD Architecture 

and Mechanics is different. 
 

Properties bar in ELITECAD Architecture 

 

Properties bar in ELITECAD Mechanics 

 

 
Dimension parameters 

 
Dimension position 

 
Dimension parameters group (only Architecture) 

 Parameter name 

 

Renovation planning state (only in ELITECAD 

Architecture, see chapter 8.5) 

 
Font size 

 Dimension help line length (only Architecture) 

 
Dimension limitation (only Mechanics) 

 
Dimension help line colour (only Mechanics) 

 
Diameter character, square, arc, M or R 

 
M,cm/mm dimensioning (only Architecture) 

 
Tolerance (only Mechanics) 
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Dimension on arc 

 
Regenerate chain dimension 

 
Define dimension point 

 
Delete dimension point 

 Section line/opening dimension (only Architecture) 

 
Section line/delete definition line (only Architecture) 

 
Parameter for opening dimension (only Architecture) 

 

Parameter for multi-layer dimension (only 

Architecture) 

Dimension parameters 

 

Opens the Dimension parameters dialog window. 

Dimension positioning 

 

Automatic 

Horizontal 

Vertical 

Direct 

The dimension direction can be fixed: horizontal, vertical, automatic (horizontal and 

vertical) or direct. 

After generating dimensions, you can change the direction via the context menu. 

   

Dimension parameters group 

This field is only available in ELITECAD Architecture and only visible if a 

representation level has been activated. 

 

Without parameter group 

Parameter group 1 

Parameter group 2 

Parameter group 3 

The parameter group is a quick selection of preset types. If you select a parameter 

group, the associated parameter type is displayed. If you select "Without parameter 

group", the current settings are adopted. 
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Parameter groups are assigned to individual parameter types for each representation 

level in the representation level parameters. 

 

Parameter name 

The "Parameter name" field displays all records. You can save additional records 

from the dimension parameter dialog window. 

Font size 

Use this field to change the font size of the dimension text. The superscript is 

enlarged proportionally to the main text. 

Dimension help line length 

This setting is only available in ELITECAD Architecture.  

 

Fixed length of dimension help line 

Fixed distance to dim. point 

You can determine the length of dimension help lines in one of two ways.  

Fixed length of dimension help line 

 

Fixed distance to dim. point 

 

 

The distance is specified in paper millimetres. 

Dimension limitation 

You can select from various dimension limitations. 

 

without 

Arrow 
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Circle 

Backslash, pen like dimension line 

Backslash, pen configurable 

The dimensions are configured using the DIMENSION ARROW PARAMETERS 

detail parameter. 

Dimension help line colour 

    Adjust the colour of dimension help lines in this field. 

Diameter character 

 

If the DIAMETER CHARACTER option is activated, a diameter character is added 

before the dimension figure. For a chain dimension, this option always applies to the 

entire chain. For the dimension parameters, you can specify under the DETAIL 

PARAMETERS menu > TEXT PARAMETERS whether to display a small or large 

character. 

 

When dimensioning thread diameters in ELITECAD Mechanics these dimensions 

are recognised and the letters M and R will be added automatically, provided, that 

the thread has been created with the drill/sink functions of ELITECAD. 
 

TIP 
If you only want to add a diameter character to one dimension figure, 

you can do this by editing the dimension figure after it has been added: 

Right-click dimension figure > Modify dimension text  

M,cm/mm dimensioning 

The m,cm/mm dimensioning is a special depiction of the tolerance text for 

architectural dimension figures. 

This rounds the millimetres to the nearest half centimetre and adds them in 

superscript. Metres are separated with a decimal point. 

 

If a tolerance is switched on with the TOLERANCE function, m,cm/mm 

dimensioning is deactivated. 

Tolerance (not available for chain dimension) 

Here, enter how the tolerance text should be displayed. If the tolerance text is 

switched on, m,cm/mm dimensioning is automatically switched off. 

 The tolerance text is not displayed. 
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 Having set the dimension line, the tolerance text is queried. 

 Having set the dimension line, the lower and upper tolerance text is queried. 

 Having set the dimension line, the lower and upper tolerance text is queried and 

integrated into the dimension text. 

Dimension on arc 

 

The DIMENSION ON CURVE function places the dimension point tangential to a 

circle or curve of your choosing. The function is only active once. You must select it 

another time to use it again. 

Regenerate chain dimension 

 

This function resets all dimension texts in a dimension chain that were moved by 

hand to their original positions. 

Define dimension point 

 

This function enables you to specify additional dimension points during editing. You 

may also add individual dimension points to a dimension chain that was created with 

a section line or opening dimension. 

Delete dimension point 

 

The function enables you, during creation or editing, to delete dimension points that 

have been placed. You can also delete individual dimension points that were created 

with a section line or an opening dimension. 

Dimensioning options 

The dimensioning options are only valid for ELITECAD Architecture. 

 

Define section line for walls 

Define section line for walls contours 

Section line 

Define section line for axis grid 

Opening dimension/set definition line (size) 

Opening dimension/set definition line (axis) 

To use a dimensioning option, you must select it or click it. The same applies to all 

other dimensioning. The section or definition line is visible when editing a dimension 

chain. If such a dimension chain is copied into another storey, the new elements or 

windows are immediately dimensioned automatically on the respective section or 

definition line. Certain modification actions automatically trigger a refresh via the 
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REFRESH AR OBJECTS function so that the dimension chain recognises the new 

dimension points. 

Define section line for walls 

 

The dimensioning option is only available in ELITECAD Architecture and 

dimensions all walls with layers on a section line that were generated using the 

CREATE WALL function. Make sure that the section line is orthogonal (unless you 

prefer it otherwise). The section line must not go through the same point as the 

dimension chain. 

 

Define section line for walls contours 

 

The dimensioning option is only available in ELITECAD Architecture and 

dimensions all walls without layers on a section line that were generated using the 

CREATE WALL function. Make sure that the section line is orthogonal (unless you 

prefer it otherwise). The section line must not go through the same point as the 

dimension chain. 

 

Section line 

 

This dimensioning option is only available in ELITECAD Architecture and 

dimensions all elements on a section line. Make sure that the section line is 

orthogonal (unless you prefer it otherwise). The section line must not go through the 

same point as the dimension chain. 
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Define section line for axis grid 

 

The dimensioning option is only available in ELITECAD Architecture and 

dimensions all axes on a section that were generated using the AXIS-GRID function 

in the AR OBJECTS menu. Make sure that the section line is orthogonal (unless you 

prefer it otherwise). The section line must not go through the same point as the 

dimension chain. 

 

Opening dimension/set definition line (size) 

 

This dimensioning option is only available in ELITECAD Architecture and 

dimensions all window, door and wall openings on a definition line. The definition 

line must lie on the exterior or interior surface of the wall, and the exterior or interior 

wall opening is dimensioned accordingly. For the opening width, the opening height 

is written under the dimension line. 

 

Opening dimension/set definition line (axis) 

 

This dimensioning option is only available in ELITECAD Architecture and 

dimensions all window and door axes on a definition line. The definition line must 

lie on the exterior or interior surface of the wall. 
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Opening dimension/parameter for opening dimension 

 

On this parameter dialog window, you can define in ELITECAD Architecture, which 

heights are to be dimensioned if definition line with sizes is used. There are separate 

value settings for windows and doors. 

 

TIP 
If the FULL HEAT INSULATION option is set, the dimension points 

react to the bare masonry itself and not to the insulation.  

Section line/delete definition line 

 

This function is only available in ELITECAD Architecture and deletes a chain 

dimension's section line or definition line. This makes sense if a chain dimension 

consists of multiple section lines/definition lines. 

Parameter for multi-layer dimensioning 

 

On this parameter dialog window, you can define in ELITECAD Architecture which 

wall layers are to be dimensioned. 
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COORDINATE DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Coordinate dimension 

This function launches coordinate dimensioning. Then it creates a horizontal or 

vertical dimension line passing from the point to be dimensioned to the dimension 

text position in the drawing. (The execution depends on the parameter setting for 

coordinate dimension). The correct horizontal distance between the reference point 

and points to be dimensioned is calculated and represented. 
 

After the function is activated, define the reference point and the point to be 

dimensioned using one of the standard positioning procedures. The desired location 

for the dimension line and the dimension details are marked the same way. 
 

TIP 
If the "Query text" check box located in the Dimension parameters 

dialog window under the DETAIL PARAMETERS menu > TEXT 

PARAMETERS is selected, computer-generated dimensions can be 

modified via keyboard entry. Next, enter the next point to be 

dimensioned or end coordinate dimensioning.  

REFERENCE VALUE 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Reference value 

This function launches reference dimensioning. Then it creates a horizontal or 

vertical dimension line passing from the reference point to the point to be 

dimensioned in the drawing. (The execution depends on the parameter setting for 

reference dimension.) The correct horizontal distance between these points is 

calculated and represented. 
 

After the function is activated, define the left-hand (reference) point and right-hand 

point between which the horizontal dimensioning is to be displayed using one of the 

standard positioning procedures. The desired location for the dimension line and the 

dimension details are marked the same way. If the Query text check box located on 

the Dimension parameters dialog window under DETAIL PARAMRETERS > 

TEXT PRAMETERS is selected, computer-generated dimensions can be modified 

via keyboard entry. Next, enter the next point to be dimensioned or end reference 

dimensioning. 
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FLOATING DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Floating dimension 

The function draws a horizontal or vertical floating dimension line between two 

points in the drawing, calculates the vertical distance between the points and 

represents it. 
 

After the function is activated, use one of the standard positioning procedures to 

specify the lower and upper point between which the direct dimension is to appear. 

The desired location for the dimension line and the dimension details are marked the 

same way. If the Query text check box located on the Dimension parameters dialog 

window under DETAIL PARAMETERS > TEXT PARAMETERS is selected, 

computer-generated dimensions can be modified via keyboard entry. 

DIAMETER DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Diameter dimension 

The function draws diameter dimension lines, calculates the correct diameter 

dimensions and represents them. 
 

After the function is activated, select the circumference of the circle or segment with 

the cross hair. Then specify the position of the dimension text. The dimension line is 

drawn passing through this point and the circle's centre point. 
 

TIP 
The dimension figure is not centred, enabling multiple concentric 

circles to be dimensioned cleanly. When positioning the dimension 

text for small circles, you may encounter the message "Text does not 

fit! Where to?" (RET = unchanged). Then you can place the text 

outside the circle or press [Return] to keep it inside the circle.  

RADIUS DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Radius dimension 

This function draws radius dimension lines, calculates the correct radius dimensions 

and represents them. 
 

For the radius dimension, you must select the curve in question with the cross hair 

then enter the desired position where the dimension should be listed. A dimension 

line is drawn to it. 
 

TIP 
The required parameters for dimension line and dimension details must 

be defined in advance under Dimension parameters.  
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ANGLE DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Angle dimension 

This function displays a dimension curve between two lines, calculates the correct 

angle dimension and represents it. 
 

After this function is activated, the two lines for angle dimensioning must be selected 

with the cross hair. The dimension curve is drawn anticlockwise from the first 

selected line to the second one. You are also prompted to enter the radial position of 

the dimension curve; the position of the dimension figure is automatically calculated 

based on the position of the dimension curve. 
 

TIP 
The calculated angle is listed in the defined unit (degrees, gradian/gon, 

or radian).  

ISOMETRIC DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Isometric dimension 

This function is used to enter an isometric dimension. To do so, enter the incline of 

the dimension help line from a reference line and enter the dimension text manually. 

(The measured length is not automatically specified by the system, as isometric 

views are generally not to scale.) 
 

After the function is activated, first specify the direction of the help line, which can 

be an element or a help line (e.g. a pipe axis). Then the system automatically 

switches to point entry (but you can select any other capture function). Now, the left 

and right end point of the dimension is marked (which also defines the dimension 

line's direction). After you have specified the text's position, enter the text itself. 
 

TIP 
The position of the dimension help lines can be at any angle. The 

tolerance check box can also be used during isometric view 

dimensioning.  

CURVE DIMENSION 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Curve dimension 

This function is used to enter a curve dimension. The measured length is 

automatically calculated by the system.  
 

After the function is activated, the system begins by asking you to specify the curve 

to be dimensioned. After you have placed the start and end point of the curve, you 

can place the curve dimension using the preview. 
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DIMENSION PARAMETERS DIALOG 

WINDOW 

 

Toolbar Dimension 

Property bar dimension 

Here, you can define all dimension-specific parameters and save them as a custom 

parameter record. 

 

Parameter name 

All parameters for dimensioning are specified on the dimension parameter dialog 

window. These can also be stored under any parameter name. 

The name of the selected parameter record can be found in the "Parameter name" 

selection box. It can be defined freely. By selecting various types, you can see how 

the values in all the other entry fields are automatically modified. This way, once you 

have saved a dimension type as a custom defined type, you can call it up repeatedly. 

Record 

To generate a new type, simply enter the new name in the text box and modify all the 

values in the dialog window as desired. Next, you can insert the new type into the 

selection list via the menu item RECORD > SAVE. To delete a type that is no longer 

needed, use the menu item RECORD > DELETE. 

Detail parameter: 

From the DETAIL PARAMETERS menu, you can configure the arrow parameter, 

the text parameter and the tolerance parameter. 
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Linear dimension 

 

Dimension limitation line 

You can select from various dimension limitations. 

 

without 

Arrow 

Circle 

Backslash, pen like dimension line 

Backslash, pen configurable 

The dimensions are configured using the DIMENSION ARROW PARAMETERS 

detail parameter. 

Dimension text 

You have the following three options when setting the dimension figure. 

 
Dimension text over dimension line 

 
Dimension text on dimension line 

 
Dimension text under dimension line 

 

 

You can configure the dimension and pen colour directly on the parameter dialog 

window. You can configure other parameter settings for the dimension text in the 

DIMENSION TEXT PARAMETERS.  

Dimension help line 

There are two configuration options available for selection. 
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Configure the length of the dimension help line. 

 

 

Configure the distance between the dimension help line and 

the dimension point. 

Tolerance text  

 

There are various depiction modes for the tolerance text. The text size and pen colour 

can also be configured directly. You can configure other settings for the tolerance 

text in the TOLERANCE PARAMETERS. 

 Tolerance text is not represented. 

 

 After the dimension line is set, the user is prompted for tolerance text. 

 

 After the dimension line is set, the user is prompted for the upper and lower 

tolerance text. 

 

 

 

 The tolerance text is written in superscript. 

 

When M,cm/mm dimensioning is active in the toolbar. 
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Dimension line 

 
Pen for the dimension line and dimension help line. 

You must activate the dimension line overhang in the DIMENSION ARROW 

PARAMETERS detail parameter so that the value adjusts accordingly and the 

overhand is displayed. 

Radius dimension 

 

Dimension line 

 

Pen of dimension line 
 

The dimension line can be lengthened up to the centre point of the circle. 

 

 

Dimension limitation line 

You can select from various dimension limitations. 

 

without 

Arrow 

Circle 

Backslash, pen like dimension line 

Backslash, pen configurable 
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The dimensions are configured using the DIMENSION ARROW PARAMETERS 

detail parameter. 

Dimension text 

The following options are available when placing the dimension figure. 

 
Dimension text over dimension line 

 
Dimension text on dimension line 

 
Dimension text under dimension line 

 
Dimension text (with horizontal ending) over dimension line 

 
Dimension text (with horizontal ending) on dimension line 

 
Dimension text (with horizontal ending) under dimension line 

 

You can configure the dimension and pen colour directly on the parameter dialog 

window. You can find other parameter settings for the dimension text in the 

DIMENSION TEXT PARAMETERS.  

Tolerance text 

 

Here you have the option to define the depiction type, size and pen colour of the 

tolerance text. You can find other parameter settings for the tolerance text in the 

TOLERANCE PARAMETERS. 

 

 

 

Angle dimension 
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Dimension line 

 

Pen of dimension line 

Dimension limitation line 

You can select from various dimension limitations. 

 

without 

Arrow 

Circle 

Backslash, pen like dimension line 

Backslash, pen configurable 

You can configure the dimensions in the DIMENSION ARROW PARAMETERS 

detail parameter. 

Dimension text 

The following options are available when placing the dimension figure. 

 
Dimension text orthogonal on dimension line 

 
Dimension text tangential on dimension line 

 
Dimension text tangential between dimension line 

 
Dimension text tangential under dimension line 

 

You can configure the dimension and pen colour directly on the parameter dialog 

window. You can find other parameter settings for the dimension text in the 

DIMENSION TEXT PARAMETERS. 

Tolerance text 

 

Here you have the option to define the depiction type, size and pen colour of the 

tolerance text. You can find other parameter settings for the tolerance text in the 

TOLERANCE PARAMETERS. 

Dimension help line 

You have two configuration options for the dimension help lines. 

 

With this option, you define the length of the dimension help 

line regardless of where the dimension point is placed. 
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With this option, you define how far away the dimension help 

line is from the defined dimension point. 

Reference value 

Only supplemental parameters are located under the reference value. The general 

parameters are adopted from the Linear Dimension. 

 

Distance of individual dimension lines and selection of the start tip. Optionally, the 

position of the dimension text can be prompted. 

 

The distance between the individual dimension lines and their start offset. 

Optionally, the position of the dimension text can be prompted. 

 

The distance between the individual dimension lines and their length. Optionally, the 

position of the dimension text can be prompted. 
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Coordinate dimension 

Only supplemental parameters are located under the coordinate dimension. The 

general parameters are adopted from the Linear Dimension. 

 

There are two additional options provided. 

   

Place dimension 

 

In the properties bar, you can activate the PLACE DIMENSION function while 

defining the dimension points. By entering additional points, the dimension help line 

can be created in place. 

DIMENSION DETAIL PARAMETERS 

Dimension arrow parameters 

Depending on the setting for dimension limitation in the dimension parameter dialog 

window, the dialog window that appears for the dimension arrow parameters may 

vary. 

 
 

If a dimension arrow is not selected, no 

other settings are possible. 

 

 

If an arrow is selected as the dimension 

arrow, you have the option to configure 

the arrow length and arrow width for the 

arrow parameter detail parameter. 
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If a circle is selected as the dimension 

arrow, you have the option to configure 

the circle's radius for the arrow parameter 

detail parameter. The PROJECTION 

option refers to the overlap of the 

dimension line and the dimension chain. 

 

 

If a stroke is selected as the dimension 

arrow, you have the option to configure 

the stroke length and the stroke angle. The 

PROJECTION option refers to the overlap 

of the dimension line and the dimension 

chain. 

 

 

If a stroke is selected as the dimension 

arrow, you have the option to configure 

the stroke length and the stroke angle. As 

the pen colour is configurable here too, 

you can select a thicker pen. The 

PROJECTION option refers to the overlap 

of the dimension line and the dimension 

chain. 

Dimension text parameters 

 

If certain settings are blocked for the dimension text parameters, this is because not 

all settings are possible when using TrueType fonts. 
 

 
Selection of text, frame or TrueType font 

 Height dimension figure 
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 Width dimension figure 

 
Pen type dimension figure  

 
Inclination dimension figure 

 

Distance of dimension text to dimension line  
1:    Dist. = 0;  

2:    Dist. 50 % text height 

2.5: Dist. 75 % text height 

 
Character spacing 

 
Rotates the dimension figure to the other side of 

the dimension help line 

 
How many digits after the decimal point 

 
If the QUERY TEXT option is switched on, you 

must enter the dimension figure. 

 No 0 after the decimal point (1, not 1.0) 

 One 0 before decimal point (0.31) 

 
Selection of decimal point character 

 Frame on/off 

 
Background colour on/off 

Background 

There is an option to set an infill hatch as the background.  

The 0 pen is invisible and is used to cover things. 

 

Depiction 

 

Assignment 

 

You can select here whether dimension texts that have no room between the 

dimension help lines should be written upwards or sideways. 
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Diameter character 

 

Specify here whether to use a large or small diameter character. 

Depiction 

 

Select here how the dimension should appear. 

Tolerance parameters 

DETAIL PARAMETERS > TOLERANCE PARAMETERS 

When TrueType fonts are selected, certain settings are also blocked in the tolerance 

parameters.  

 

 Selection of text or TrueType font 

 
Height dimension figure 

 
Width dimension figure 

 
Pen type dimension figure  

 
Inclination dimension figure 

 

Distance of dimension text to dimension line 
1:    Dist. = 0;  

2:    Dist. 50 % text height 

2.5: Dist. 75 % text height 

 
Character spacing 
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The following options can only be selected when m,cm/mm dimensioning 

(  ) is activated: 

 Rounds to the nearest half-centimetre or millimetre 

 The "metres place" is separated with a point. 
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6.2 HEIGHT MARKER 

SPECIFY HEIGHT MARKER 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Height marker 

The HEIGHT MARKER function can be found among the dimension functions. 
 

Height marker dimensioning places a symbol for which the height is always 

automatically calculated. Usually, the height position is calculated from the 

coordinate origin (X0, Y0 = format middle). 

The symbol can be changed in any way. 

Set levels 

To launch it, click the HEIGHT MARKER function. 

Dimension which point? 

On the plan, enter the point that you would like to dimension with a height marker. 

Position of height marker 

You can only move horizontally to the point at which the marker should be placed. 

You can also move the cursor to a pre-existing height marker to align the new marker 

to it. Finally, you can define the marker's position by flipping it. 

      

Associations 

A marker that is placed in a view or section linked with the design model is retained 

if changes are made to the geometry. After the view/section is refreshed, the height 

marker is recalculated. 

Edit/modify text 

You can edit the marker's text in the element part selection mode ([Alt] key). 

HEIGHT MARKER PROPERTIES BAR 

 
 

 
Height marker – Parameters 

 

Renovation planning state (only in ELITECAD 

Architecture, see chapter 8.5) 
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Select symbol 

 
Height marker – Offset over point 

 
Height marker – Offset 

 
Height marker – Leading text 

 
Height marker – Trailing text 

 

M,cm/mm dimensioning: Tolerance text is written in 

superscript (only in ELITECAD Architecture) 

 
Plus sign 

 
Modify height marker over polygon 

Height marker parameter 

 

In the height marker parameters, you can configure settings for the height marker. 

You can select the symbol from which the height marker should be generated and 

you can configure how it will be depicted. 

 

General parameters 

   Status renovation planning (only in ELITECAD Architecture) 

  Freeze (only in ELITECAD Architecture) 

 Type (name of the record) 

 Layer 

The general parameters for objects are described in chapter 8.5. 

Symbol 

 

Here, select the symbol that should be used to create the marker. You can select the 

file directly using the Selection button. 
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The standard path for the symbols is: 

<ELITECAD installation path>\u\<version>\<ar|me>\glob\symbol\... 

Own symbols 

You can create as many of your own symbols as you like. Important: The reference 

point for each symbol should always be on the arrow tip, as that is the point from 

which the height is calculated.  
 

Examples: 

 

TIP 
If you would like to create a symbol of your own, it is best to load a 

template from the path listed above, adapt it as you wish, and save it 

under a new name.  

Offset 

Using the offset, you can specify a displacement value in the current unit by which to 

move the reference level in relation to the coordinate origin. 

The option is needed if a part is cut for space reasons in a detail section, for instance. 
 

TIP 
The value matches the one in the properties bar.  

Height marker – Offset over point 

 

Instead of a manual entry for the offset, you can specify a point digitally with the 

mouse. The measured height from the coordinate origin is entered into the "Offset" 

field and the height of the marker is recalculated. 

Height marker – Offset 

 

Using the offset, you can specify a displacement value in the current unit by which to 

move the reference level in relation to the coordinate origin. 

Height marker – Leading text/Trailing text 

   

You can enter additional text in these fields to be added to the calculated height text. 

Plus sign 

 

This setting is used to add a plus sign as a pre-text before the value. 

M,cm/mm dimensioning 
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The m,cm/mm dimensioning is only available in ELITECAD Architecture and writes 

the millimetres in superscript. In the height marker parameters, you can configure 

rounding to the nearest half centimetre or nearest millimetre. When m,cm/mm 

dimensioning is activated, the number of decimal places is irrelevant for height 

marker parameters. 

Modify height marker over polygon 

 

Using this function, you can modify the offset of multiple markers at the same time. 
 

After calling this function, you can place a polygon over the markers to be changed. 

Next, enter the offset for these markers in the entry line. The entry is always entered 

in the current unit and must be confirmed with [Enter]. 

Modify height marker via Copy parameters 

 

If you click on a marker after the COPY PARAMETERS function, there are 

additional options available for global modifications. 
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6.3 HEIGHT MARKER OF FLOOR PLAN 

SPECIFY HEIGHT MARKER 

 

Toolbar * Create new  

Lay-out menu > Dimensions > Height marker of floor plan 

The HEIGHT MARKER OF FLOOR PLAN function can be found among the 

dimension functions and is only available in ELITECAD Architecture. 
 

Height marker of floor plan dimension places a symbol that is automatically labelled 

with the height of the bare floor top surface (BTS) and the top surface of the bare 

ceiling (TSBC).  

Edit/modify text 

You can edit the marker's text in the element part selection mode ([Alt] key). 

1 

HEIGHT MARKER OF FLOOR PLAN 

PROPERTIES BAR 

 

The properties bar becomes visible if you select the HEIGHT MARKER OF FLOOR 

PLAN function to generate a marker or if you click an existing marker to edit it. 
 

 
Height marker – Parameters 

 

Renovation planning state (in ELITECAD 

Architecture , see chapter 8.5) 

 
Height marker – Offset 

 
Height marker – Leading text 

 
Height marker – Trailing text 

 

M,cm/mm dimensioning: Tolerance text is written in 

superscript 

 
Modify height marker over polygon 

Height marker parameter 

 

In the height marker parameters, you can configure settings for the height marker. 

You can select the symbol from which the height marker should be generated, the 

number of decimal places, the height marker offset and whether or not the height 

marker should include a "plus" sign. 
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Symbol 

Here, select the symbol that should be used to create the marker. You can select the 

file directly using the Selection button. 

The standard path for the symbols is:  

<ELITECAD installation path>\u\<version>\<ar|me>\glob\symbol\... 

Own symbols 

You can create as many of your own symbols as you like. Important: The reference 

point for each symbol should always be in the centre of the circle, as that is the point 

from which the height is calculated.  
 

TIP 
If you would like to create a symbol of your own, it is best to load a 

template from the path listed above, adapt it as you wish, and save it 

under a new name.  

Height marker – Offset 

 

Using the offset, you can specify a displacement value in the current unit by which to 

move the reference level in relation to the coordinate origin. The offsets can be 

configured separately for BTS and TSBC. 

Height marker – Leading text/Post-text 

   

You can enter additional text in these fields to be added to the calculated height text. 

The text can be configured separately for BTS and TSBC. 

M,cm/mm dimensioning 

The m,cm/mm dimensioning writes the millimetres in superscript. In the height 

marker parameters, you can configure rounding to the nearest half centimetre or 

nearest millimetre. When m,cm/mm dimensioning is activated, the number of 

decimal places is irrelevant for height marker parameters. 

Modify height marker over polygon 

 

Using this function, you can modify the offset of multiple markers at the same time. 
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After calling this function, you can place a polygon over the markers to be changed. 

Next, enter the offset for BTS and TSBC in the entry line. The inputs are always 

entered in the current unit and must be confirmed with [Enter]. 

Modify height marker via Copy parameters 

 

If you click on a marker after the COPY PARAMETERS function, there are 

additional options available for global modifications. 
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6.4 ARROW 

The arrow is part of the rest. 

Visible/invisible 

 

Arrows can be temporarily switched off using the image control functions. 

Switch on/off 

VIEW menu > SWITCHES 

If you switch off the arrows using this check box, the arrows are not saved during 

"Save as" unless the subsequent dialog window is confirmed with "visible selection". 

Rest scaling 

SETTINGS menu > REST SCALING on/off 

If rest scaling is switched off, the arrows are not enlarged or reduced when scaling or 

modifying the scale. 
 

 

Toolbar * Create new  

Lay-out menu > Arrows 

When you click the CREATE ARROW function, the settings are copied from the 

most recently placed arrow and the arrow can be placed immediately. The Arrow 

start? query appears in the entry line. Now draw the arrow on the plan. You can 

complete the arrow by double-clicking or using the END ARROW function. 

 

ARROW PROPERTIES BAR 

 

The properties bar becomes visible if you select the CREATE ARROW function to 

generate an arrow or if you click an existing marker to edit it. 
 

 
Arrow parameters 

 Type 

 

Renovation planning state (in ELITECAD 

Architecture, see chapter 8.5) 

 
Arrow type 

 
Line type 

 
Arrow length and arrow width 

arrow start 

end arrow 
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 Circle radius 

 
Line length and angle 

 
Pen colour 

 
Start arrow 

 
End arrow 

 
At text balloon 

 
Background 

ARROW PARAMETERS 

 

 

In this dialog window, you can configure all parameters for note arrows. These can 

also be stored under any parameter name (Menu RECORD > SAVE). 

Parameter name 

 

Using the RECORD menu, you can save new parameter records or delete existing 

ones. 

Arrow type 

 

None 

Arrow 

Circle 

Stroke 

You can select the type of arrow tip. 

Line type 
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The line type can be selected. 

Pen colour 

 

Pen colour of arrow, incl. head. 

Start arrow 

 

"Start arrow" is automatically run when you click the ARROW function, and the 

arrow can be drawn immediately. To complete the arrow, simply double-click or use 

the END ARROW function. 

End arrow 

 

This function completes the START ARROW function. 
 

TIP 
To complete the arrow, simply double-click. 

  

At text balloon 

 

You can also select this option. At the start or end of the arrow, click the function 

and then click a text. 

Background 

 

There is an option to set an infill hatch as the background.  

The 0 pen is invisible and is used to cover things. 
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6.5 HATCH 

The hatch is part of the rest. 

Visible/invisible 

 

The hatching can be temporarily switched off using the image control functions. 

Switch on/off 

VIEW menu > SWITCHES 

If you switch off the hatching using this check box, the hatching is not saved during 

"Save as" unless the subsequent dialog window is confirmed with "visible selection". 

Rest scaling 

SETTINGS menu > REST SCALING on/off 

If rest scaling is switched off, the hatching is not enlarged or reduced when scaling or 

modifying the scale. 

Print sequence 

A newly created hatch is automatically placed in the foreground, but this can be 

changed using Control foreground/background in the context menu. 

Under the SETINGS menu > OPTIONS > DEPICTION > 2D/3D, you can also select 

a check box specifying that elements are always in front of infill hatch. This check 

box is automatically selected if plans are loaded from versions earlier than V11. 

AUTO HATCHING  

 

Toolbar * Create new 

Lay-out menu > Hatch > Automatic hatch 

Use this function to launch a hatch process where existing contours and 

texts/dimension texts are automatically recognised as gaps. 

MANUAL HATCH  

 

Toolbar * Create new 

Lay-out menu > Hatch > Manual hatch 

For manual hatching, you can also select additional contours and define 

texts/dimension text as gaps. The end of the hatch procedure must be selected. 

PROPERTIES BAR HATCHING 

 

 
Hatching parameters 

 Hatch type 

 

Renovation planning state (in ELITECAD 

Architecture, see chapter 8.5) 

 
Hatch type preview 
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Toggle Auto hatching / Manual hatching 

 
Toggle hatch / covering hatch 

 
Assignment 

 
Colour selection over table 

 
Start hatch 

 
End hatch 

 
Polygon 

 
Next contour 

 
Preview area 

 contour of search mode display 

 
Align hatch 

After you activate the function, you are prompted to define the outer contour of the 

surface to be hatched by clicking on it. The start element will proceed around 

clockwise from the perspective of the point you clicked. A closed contour is hatched 

without any additional query. With an open contour, additional functions are 

available at the cursor via the Input Assistant or by pressing [TAB]. 

  

Hatch type 

Saved hatches. 

Hatch type preview 

The standard hatches that are provided with the program come with a small preview. 

Custom created hatches do not have a preview image.  

Assignment layer 

The hatch can be assigned to the active layer or to the layer of the selected contour. 

This selection is only available if the "Selection using Group/Class/Level" switch is 

deactivated in the OPTIONS. 

 
Hatch to contour layer 

 
Hatch to active layer 

 

  



Chapter 6 – Lay-out  

www.elitecad.eu  415 

Assignment object 

The hatch can be assigned to the active object or to the object of the selected contour. 

This selection is only available if the "Selection using Group/Class/Level" switch is 

activated in the OPTIONS. 

 
Hatch to object of the contour 

 
Hatch to active object 

TIP 
In calculated views or section views, the assignment to the object of 

the contour has to be handled with care. Objects that are related to the 

design model are deleted when refreshing the view!  

Colour selections 

For colour selections, there is a distinction between line hatch and infill hatch. For 

line hatch, the pen colour must be defined; for infill hatch, the plane colour. 

Start hatch 

 

The function launches the manual hatch process. 

After you activate the function, you must define the outer counter of the surface to be 

hatched by clicking on it. The start element will proceed around clockwise from the 

perspective of the point you clicked. When it is closed, you must confirm the contour 

using END HATCH or [Enter]. For an open contour, additional functions are 

available at the cursor in the Input Assistant or by pressing [Tab]. 

  

End hatch 

 or [Return] 

Ends the manual hatch process and generates the hatch. 

Polygon functions 

Using polygon functions, you can complete the definition of open contours or create 

hatches using only a single polygon, if no contour exists. 

 

Use the POLYGON function in order to define any contour for the hatch. 

 

Use the NEXT CONTOUR function if the contour consists of multiple open 

polygons and you want to connect the contour you clicked first with the next contour. 

TIP 
The auto hatching function uses the branching parameter that is 

configured under SETTINGS > OPTIONS > WORK PARAMETERS 

> GENERAL.  

Preview area 
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The preview area shows a preview of the selected contour. You can switch this 

preview on/off, as it uses a large amount of performance for dense plans. 

HATCHING PARAMETERS 

In the hatching parameters, you can define all of the hatch's specific parameters and 

save them as a custom parameter record. There are parameter masks for line hatches, 

model hatches and infill hatches. 

Parameter name 

In the RECORD menu, you can create a new function with the SAVE function or use 

the DELETE function to delete an existing parameter. 

Boundary 

 

The hatch can be generated with a boundary. The boundary has the same pen as the 

hatch. The line type is solid (no. 1). 

Line hatch 

The line hatch can be created with one of the first seven tabs. This is the location of 

the settings parameters such as inclination, pen number, line type and line spacing. 

The SHOW function displays a preview of the current settings in the preview 

window. 

Background 

 

All line hatches have the option to switch to an infill hatch as the background. 

The 0 pen is invisible and is used to cover things. 

 

Rotate automatically 

 

Line hatches can be rotated automatically. The hatch is always aligned based on the 

longest line in the contour. When changes are made to the contour, the hatch is 

recalculated. 

Simple line hatch 

Defined by an angle and a line type. 
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Double line hatch 

Defined by an angle and two lines of the same type with a different distance. 

 

Simple cross hatch 

Defined by an angle and a line type. 

 

Multiple cross-hatching 

Defined by an angle and two lines of the same type with a different distance. 

 

Variable double-hatch 

Defined by an angle and two lines of different types with a different distance. 
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Variable cross-hatch 

Defined by two angles and two lines of different types with a different distance. 

 

Free line hatch 

Consists of two hatches, each defined by an angle and multiple lines of the same type 

with a distance. 
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Model hatch 

A model hatch consists of a hatch definition (ELITECAD file) that can be used as a 

tile and distributed across the surface in various ways. 

 

If the 2D elements of the hatch definition consist only of one colour, the colour of 

settings will be applied. Otherwise, the colours remain unchanged. 

Hatch definition 

The definition files are located in the path: 

<ELITECAD-installation path>\u\<version>\cad\glob\hatch\<region> 

Depending on the settings, a different subfolder has to be chosen. In ELITECAD 

Architecture <region> stands for language_region, e.g. de_de for Germany, de_at 

for Austria, en_uk for UK. ELITECAD Mechanics <region> stands for language 

alone, e.g. de for German, en for English. 
 

Example of a hatch definition: Stonework 
 

 

Segmentation – With distance 

 

The tile width and height must be entered. The origin of the hatch lies in the lower 

left corner of the hatch contour. A vertical distance can be added to the hatch. 

  

Segmentation – Absolute 
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The tile width and height must be entered. The origin of the hatch lies in the centre of 

the page. To place multiple hatches seamlessly alongside each other, "absolute" 

segmentation must be selected for each of them. 

  

Segmentation – Centred 

 

The tile width and height must be entered. The origin of the hatch is centred 

vertically. 

  

Segmentation – Stretched, tiled 

 

The tile is scaled until it touches the first side of the contour. Then the hatch is tiled 

in the other direction. The hatch automatically adjusts to the height, and is therefore 

ideal for hatching layers. 

  

Segmentation – Stretched, 1 tile 

 

The hatch is only placed into the contour once. A rectangle is placed around the 

contour to be hatched, and the hatch tile is stretched in all directions to fit it. 

  

 WORKSHOP  

centre of 

the page 
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Create new model hatch  

Create a panelling hatch for a 50x20 cm artificial stone panel.  

It is best to create the template file on a new plan. 

FILE menu > NEW 

Select an appropriate scale. 

 

Begin creating a panel at the zero point (X0,Y0). 

 

TIP 
Template drawings consist of elements. Rest elements such as text, 

hatches and dimensions cannot be used.  
 

Save the file. The file must be saved to the "hatch" directory. This directory contains 

all template files for model hatches. 

FILE menu > SAVE AS 

<ELITECAD installation path>\u\<version>\cad\glob\hatch\<region> 

Depending on the settings, a different subfolder has to be chosen. In ELITECAD 

Architecture <region> stands for language_region, e.g. de_de for Germany, de_at 

for Austria, en_uk for UK. ELITECAD Mechanics <region> stands for language 

alone, e.g. de for German, en for English. 

Navigate to the "hatch" directory and enter "Panel50x20" as the file name. 
 

Draw a 500x400 cm rectangle at 1:100 scale and generate the panel hatch with the 

following settings for the hatching parameters:  

   

Along with the X and Y offset, you must configure the value for how many times the 

model drawing should be repeated. The panel is 50 cm wide and should be created to 

1:100 scale, so it must be 5 mm on the plan. The alignment can be used to shift the 

panels. 
 

TIP 
Since the original was drawn at 1:10 scale, but the hatch is defined at 

1:100 scale, the scaling must be 0.1.  
 

reference point (X0, Y0) 
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Place the hatch in the outline. 

 

  WORKSHOP END 

Infill hatch 

Infill hatch 

The infill hatch is defined via a colour selection (pen number). The hatch can be 

extended with a transparency.  

 

Colour gradient hatch 

Two infill hatches are mixed together, for which transparency, angle, border distance 

and centre point can be defined. 

 

Gradient type 

 

For "Linear", the midpoint of the mixture is precisely midway between the two 

colours, whereas the midpoint is the second colour for "Cylindrical". 
 

Example with the midpoint at 50 %: 

Linear    Cylindrical 
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Transparency 

 

If two different colours are selected, only one field is free and the value applies to 

both colours at the same time. 

If the same colour is selected twice, both fields are free and you can enter different 

values, e.g. for a transparency gradient. 

   

     

Angle 

Specify the angle of the gradient direction. 

Border distance 

Here you can define the border distance, which will apply to both sides equally. In 

this area, the base colour remains constant before the gradient starts. 
 

Example with border distance: 

0 %    25 %    50 % (maximum) 

     

Centre point 

Specify here where the midpoint of the mixture is to lie. 
 

Example with centre point: 

25 %    50 %    75 % 

     

Pen number selection 
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The SHOW function displays a preview of the current settings in the preview 

window. 

Texture hatch 

The hatching area will be filled with a texture from the material database. A texture 

hatch has the same settings like a model hatch. The only difference is that a texture 

will be used instead of the model used for filling the area. 

 

Texture 

 

The texture can be selected from the defined materials. The button materials editor 

leads to the material parameters. 
 

TIP 
The order can be changed using the Foreground/Background control. 

Hatches that lie on top of one another are not mixed by default. 

  

EDIT HATCH 

Move/copy hatch 

The selected hatch can be moved or copied using the context menu (right-click). 

 

The query Move which point? appears. 

After you click a point, the query Position where to? appears. 

Place the hatch in the new location. 
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Modify hatch 

When the hatch is selected, the properties bar is displayed and the handles and 

grippers appear on the contour of the hatch. You can modify the hatch parameters in 

the properties bar. 

With the handles and grippers, you can modify the shape of the hatch. Move the 

cursor onto a handle or gripper until the cursor's depiction changes to a four-direction 

arrow. Click to confirm. The additional functions are available at the cursor in the 

Input Assistant or by pressing [Tab]. 

  

Change shape using handle 

           

TIP 
If a polygon is congruent with the hatch contour and is selected, the 

change affects both items.  

Align hatch 

The function to align the hatch is launched vie the property bar of the hatch. First, an 

arbitrary point has to be selected. A new location has to be indicated and the 

elements of the hatched are aligned accordingly. 

HATCH FUNCTIONS 

Element hatching 

 
Hatch toolbar 

 

The hatch is converted to elements. The hatch is preserved. 

Delete hatch 

 

Hatch toolbar 

 

This function only deletes hatches. 

COVERING HATCH  

 

Toolbar * Create new 

Lay-out menu > Hatch > Covering hatch 

This function is used for covering a specific area of the drawing.  
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Covering hatch properties bar 

 

 
Pen colour 

After activating the function, you are prompted to specify the first point of the 

polygon. Next, you can continue moving around the polygon until it is closed again. 

Pen colour 

Select the pen type to be used to represent the frame. You cannot change the infill 

here. 

Modifying covering catch 

See Edit hatch 
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6.6 TEXTS 

The text is part of the "rest". 

Visible/invisible 

 

The text can be temporarily switched off using the image control functions. 

Switch on/off 

VIEW menu > SWITCHES 

If you switch off the text using this check box, the text is not saved during "Save as" 

unless the subsequent dialog window is confirmed with "visible selection". That way 

you can create a plan without text. 

Rest scaling 

SETTINGS menu > REST SCALING on/off 

If rest scaling is switched off, the text is not enlarged or reduced when scaling or 

modifying the scale. 

CREATE TEXT 

 

Toolbar * Create new 

Lay-out menu > Texts 

You can use this function to create texts. The line length is limited to 160 characters. 

After activating the function, you have two options for positioning the text. 

Entry by rectangle 

 

Expand a rectangle, where the first point placed becomes the reference point and a 

continuous text can be written. The text has automatic line breaks for the provided 

width. 

If the width of the text box is changed using the handles, the line breaks are 

automatically adapted. 
 

TIP 
If you want to align the text to a slanted line, you must select the "To 

element" capture mode.  

 

       

  

Entry by reference point  
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When setting the text's reference point, the line breaks must be manually added with 

Enter. If the text box's width is modified using the handles, these line breaks are 

retained. 

For an additional text, you do not need to call up the function again, but simply click 

the new position. 

Automatic text enlargement 

The text is displayed for entry and editing to be ideal for the screen, no matter the 

text size and text angle. A vertical text at 90° is written horizontally during entry, and 

then rotated once the text function has been exited. The same applies to the text's size 

and position. If you do not want this effect, you can switch off the option under 

SETTINGS > OPTIONS > WORK PARAMETERS > GENERAL. 

Tabulator (tabs) 

You can use tabs to align the text to the left or right, centre it, or align it to a decimal 

point. 

When text is being written or edited, the ruler appears above the text box, where you 

can set and view the tabs. 
 

To set a tab, right-click the ruler in the desired position and select one of the four 

tabs from the context menu.  

 

TIP 
The type of an existing tab can be modified using the context menu. 

  
You can open the settings dialog window either via the option at the end of the list or 

by double-clicking the ruler. 

 

In order to specify new spacing, enter the value in the "Position" field and confirm it 

with "Apply". 

You can only change an existing position by deleting it and recreating it. "Apply" 

always makes a new entry. The old position must therefore still be deleted. 
 

TIP 
You can also drag the tab symbol to the new position directly on the 

ruler. To delete a tab, simply drag the symbol down from the ruler. 



Chapter 6 – Lay-out  

www.elitecad.eu  429 

  

TEXT PROPERTIES BAR 

 

The properties bar appears when you are creating or editing a text. 
 

 
Text parameters 

 Parameter type 

 

Renovation planning state (in ELITECAD 

Architecture, see chapter 8.5) 

 Font 

 
Pen type 

 
Text size 

 
Angle 

 
Entry style 

 
Reference point 

 
Bold 

 
Italic 

 
Underlined 

 Crossed out 

 
Overlined 

 Subscript 

 Superscript 

 
Text alignment 

 
Background colour 

 

TEXT PARAMETERS 
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Here, you can define all text-specific parameters. The parameter dialog window is 

subdivided into Text, Frame and TrueType font. You can save your own parameter 

records in the RECORD menu. 

Difference between text and TrueType font 

All vector-based fonts are stored under "Text". Each of these fonts is created out of 

individual lines. 

All fonts that are installed on your PC (C:\WINDOWS\Fonts) are stored under 

"TrueType font". TrueType fonts include Arial, Times New Roman, etc. 

Text 

 

Reference point 

The reference point specifies how the text should be positioned relative to the 

digitised point. 

Specify this by entering a number from 1 to 9. 
 

The reference point is displayed visually on the properties bar. 

 

Pen 

Select the pen type to be used to represent the text. The pen numbers range from 0 to 

1023. The pen affects how the texts are printed. You can achieve bold text by 

selecting a thicker pen.  

Character set 

The most common character sets: 
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Text angle (-90 – 360) 

 

Angle of texts from the horizontal. 

Text slant (-60 – 60) 

Inclination angle of text, from -60° up to +60°. 

e.g. a = 30°  

e.g. a = 60°  
 



Chapter 6 – Lay-out  

www.elitecad.eu  432 

TIP 
The way the angle is measured depends on the setting of the check box 

"Entry of text direction" under SETTINGS > OPTIONS > WORK 

PARAMETERS > GENERAL.  

Tabulator offset 

Default tab stop is listed in mm of paper. 

Line spacing (1.0 – 2.5) 

 

This "LS" (line spacing) factor sets the distance from the text to the invisible 

baseline. 

The vertical spacing between the characters in two lines is the doubled distance "a" 

(see figure). 

Formula to calculate the "LS" (line space) factor: 
 

LS = 2 x "a" text spacing in mm
 + 1 

         Text height in mm 

Character spacing (1.0 – 2.5) 

 

This "CS" (character spacing) factor sets the character distance. 

Formula to calculate the "CS" (character spacing) factor: 
 

CS = 2 x character spacing "b" in mm + 1 

         Character width mm 
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Height (0.01 – 1000 mm) 

 

You can enter character heights from 0.01 – 1000 mm. 

Width (0 – 1000) 

 

You can enter numeric widths from 0 – 1000 mm.  

Text alignment 

Select one of the four available text alignments: 

Left alignment, right alignment, centred or block style 

  

  

TIP 
The block style only takes effect if there are spaces between words in 

the text.  

Frame 

If this field is activated, the text is given a frame. You can format the frame on the 

"Frame" tab. 

Background 

There is an option to set an infill hatch as the background.  

The 0 pen is invisible and is used to cover things. 

 

TIP 
The background colour can also be controlled via the properties bar. 
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Frame 

Properties bar Text: Text parameters: Frame 

 

This mask specifies the pen type, line type and the shape of the text frame. Whether a 

text frame is used depends on the setting of the "Frame" check box on the Text and 

TTF tabs.  

If the EXTENDED FRAME option is not selected, the frame is only as large as the 

text itself. Otherwise, the frame fills the entire text box. 

 

 

TrueType font 

 

Font 

All TrueType fonts installed on the PC are listed. The fonts are in the "Fonts" 

Windows directory. The number of fonts varies from PC to PC. 

Formatting: bold, italic, underline, strike-through, overlined, subscript 

If desired, activate the respective switch. 

Pen 

Select the pen type to be used to represent the text. As the TrueType fonts have a 

given type face, the pen does not affect printing.  

Extended frame not active 

Extended frame active 
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Height (0.01 – 1000 mm) 

 

You can enter character heights from 0.01 – 1000 mm. 

As the TrueType fonts have a given type face, the width of the characters is modified 

in proportion to the height. 

Width (0 – 1000) 

 

You can enter numeric widths from 0 – 1000 mm. 

Text angle (-90 – 360) 

 

Angle of texts from the horizontal. 

Tabulator offset 

Default tab stop is listed in mm of paper. 

Reference point 

The reference point specifies how the text should be positioned relative to the 

digitised point. 

Specify this by entering a number from 1 to 9. 
 

The reference point is displayed visually on the properties bar. 

 

Line spacing (1.0 – 2.5) 

 

This "LS" (line spacing) factor sets the distance from the text to the invisible 

baseline. 

The vertical spacing between the characters in two lines is the doubled distance "a" 

(see figure). 

Formula to calculate the "LS" (line space) factor: 
 

"LS" factor = 2 x "a" text spacing in mm
   +1 
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          Text height in mm 

Character spacing 

 

The character spacing can be enlarged up to a factor of 2.5. 

Text alignment 

Select one of the four available text alignments: 

Left alignment, right alignment, centred or block style 

  

  

TIP 
The block style only takes effect if there are spaces between words in 

the text.  

Frame 

If this field is activated, the text is given a frame. You can format the frame on the 

"Frame" tab. 

Background 

There is an option to set an infill hatch as the background.  

The 0 pen is invisible and is used to cover things. 

 

TIP 
The background colour can also be controlled via the properties bar. 

  

Special characters 

Insert symbol 

If you right-click inside the text box while creating or editing a text, the item "Insert 

symbol" appears in the context menu. Selecting a character inserts it at the current 

cursor position. 



Chapter 6 – Lay-out  

www.elitecad.eu  437 

 

If you click on "Further...", the Windows Character Map appears. 

 

You can use the character map to view characters that are available in the selected 

font. You can copy individual characters or a group of characters to the clipboard, 

and then paste them into ELITECAD. 

Autotext 

If you right-click inside the text box while creating or editing a text, the item 

INSERT AUTO TEXT appears in the context menu. An auto text item is a 

placeholder where ELITECAD displays data that is subject to change. Variable auto 

text items such as the date or time are not constantly refreshed, but they are updated 

when printing at the latest. 
 

If the SHOW AUTO TEXT item is activated, auto text is displayed as normal text, 

not as placeholders.  

mshelp://windows/?id=5bcd85c0-892a-4ca1-a2d9-7864aaf107d0#gtmt_gls_font_def
mshelp://windows/?id=a6097d65-285d-4757-a0f9-2da7b4818fc7#gtmt_clipboard_def
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An auto text item can be converted to normal text. During editing, an item appears in 

the context menu: CONVERT AUTO TEXT. 

 

An easy example of auto text is the date. This generates text that automatically 

displays today's date. Various formats are possible. 

 

General auto text items can be found under the System, File and Views groups. 

You can use the Title block, Room stamp, and Openings groups to create your own 

Lib parts for each function. 

MODIFY TEXT 

Modify text  

You can modify the text by double-clicking it to edit it.  

Move/copy text 

If you click on a text, then right-click to open the context menu, you can move or 

copy the text using the respective functions shown here. 
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The query Move which point? appears. 

After you click a point, the query Position where to? appears. 

Place the text at the new location. 

Handles 

Alternatively, you can also move or copy the text by clicking on a handle around the 

selected text. The text now "sticks" to the cursor and can be placed in the new 

location. If you also click and hold the [Ctrl] key while dragging it, a copy is made. 

 

You can modify the text box using the two handles underneath the text. 

 

Capture mode for the text 

If you right-click inside the graphic window, you can specify under CONFIGURE 

AUTO CAPTURE whether or not to snap to text reference points. 

 

Context menu 

If you right-click inside the text box while creating or editing text, a context menu 

appears. 
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Take text 

You can use this option to use any text that has already been placed. Instead of 

laboriously typing in text, you can paste existing text in the current text position. 

To do so, select a text by clicking on it after activating the function. 

From file 

This function enables you to import the alphanumeric text of an ASCII file into a 

CAD drawing. E.g., a text file with the ".txt" extension (file type). You cannot adopt 

any formatting such as tabs, spacing, etc. 
 

After activating the function, you can select the text file. 

TEXT FUNCTIONS 

Text on line 

 

Text toolbar 

 

You can use this function to align the text you entered directly to the inclination of a 

line, help line or curve. The current text parameters apply, including reference point. 

The line you clicked is snapped to a right angle. This point then becomes the 

reference point for the text. 

Copy text 

 

Text toolbar 

 

Copies (duplicates) an existing text at another location. The function remains active. 

Move text 

 

Text toolbar 

 

This function is used to move a text to a new location in the drawing. The function 

remains active. 

Modify text 

 

Text toolbar 

 

Take text 

 

Text toolbar 

 

Text from file 

 

Text toolbar 

 

Delete text 

 

Text toolbar 

 

This function is used to delete selectively a text in the drawing. 

Insert text balloon 

 

Text toolbar 

 

This function generates a frame around an existing text. 
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After activating the function, you are prompted to select the text to be framed. The 

text is framed following the previously configured frame parameters and the system 

is ready to frame other texts. 

Delete text balloon 

 

Text toolbar 

 

This function deletes an existing text frame. 
 

After this function is activated, you are asked to select the desired frame. In doing so, 

you must position the cross hair inside the frame. The frame is deleted and the 

system is ready to delete another frame. 

Modify text content globally 

 
 

Modify menu > Modify text content globally 

You can use this function to search for a text string such as a word in all existing 

texts and replace it with another text string. 

The text to be replaced and the new text can also be a part of a word or multiple 

words. 

The search is case-sensitive and takes account of spaces at the start or end of the text. 



Chapter 6 – Lay-out  

www.elitecad.eu  442 

6.7 MATERIAL 

You can change the alignment by which texture images are applied to 3D objects 

after they have been added. These options only have an effect if the texture in 

question is tiled.  

ALIGN TEXTURE 

 
 

Lay-out menu > Material > Align texture 

You can use this function to align the texture on an individual surface. After you call 

up the function, you must click the desired surface. Next, you can specify the 

reference point and the new position for the shift. 
 

If a surface does not yet have any texture alignment information, a query appears 

asking whether this should be generated. You must confirm the prompt with "Yes". 

This is the case for 3D objects such as surfaces, boxes, freeform, etc. 

 

EXPLANATION 
When an object is edited or refreshed, the texture alignment is reset. 

  

ALIGN TEXT GLOBALLY 

 
 

Lay-out menu > Material > Align text globally 

This function can be used to align the texture of multiple surfaces at the same time. 

After you call up the function, you must click on an appropriate surface. Next, you 

can specify the reference point and the new position for the shift.  
 

TIP 
You can shift the first surface you click on in any direction, but you 

can only shift the height for the other surfaces that have the same 

texture. 

  
 

EXPLANATION 
Architecture objects in the same structure automatically have a texture 

alignment and are already combined. For 3D objects such as surfaces, 

boxes, freeforms, etc., you must first run the function JOIN 

TEXTURE ALIGNMENTS.  
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JOIN TEXTURE ALIGNMENTS 

 
 

Lay-out menu > Material > Join texture alignments 

You can use this function to combine texture alignments. After you call up this 

function, you must click on the first surface to align. Then select the other surfaces 

and complete the function by pressing [Enter]. 
 

If the first surface you click on does not have any texture alignment information, a 

query appears asking whether this should be generated. You must confirm the 

prompt with "Yes". This is the case for 3D objects such as surfaces, boxes, 

freeforms, etc. 

 

REMOVE TEXTURE ALIGNMENT INFO 

 
 

Lay-out menu > Material > Remove texture alignment info 

This function deletes the texture alignment information of a specific surface. 

After you call up the function, you must click the desired surface. 
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6.8 TITLE BLOCK 

Title blocks are ELITECAD drawings with prepared auto text items (project, plan 

name, etc.) that are stored in a separate folder. The PLACE TITLE BLOCK function 

opens the title block directory directly. You can use the COMPLETE TITLE 

BLOCK function to fill in the auto texts that are integrated in the title block. 

The appendix to course unit 3 shows how to create your own title block. 

PLACE TITLE BLOCK 

 

Lay-out toolbar 

Lay-out menu > Place title block 

When you place a title block, a file selection window opens, where you can select 

and load the desired title block. 
 

TIP 
This first checks whether the current project directory has a "head" 

subfolder. If one is not found, the directory of the default title blocks 

<ELITECAD installation path>\u\<version>\<ar|me>\glob\l\head\ 

opens. 

This way you can easily manage and load project-specific title blocks 

that include specific information or have a specific layout.  
 

You can use this function to import any custom title blocks or parts of title blocks. 

However, you only have the option to fill in the title blocks automatically if the 

corresponding auto texts are in use. 

COMPLETE TITLE BLOCK 

 

Lay-out toolbar 

Lay-out menu > Complete title block 

After you place a title block, a window opens where you can enter the information 

via the COMPLETE TITLE BLOCK function. 
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If there is already a filled-in title block on the plan, the information is copied over 

from it. The Scale, Page format, Editor (login) and Date are automatically filled in 

but can be changed. 

THE DATA IS ONLY WRITTEN INTO THE TITLE BLOCK IF IT WAS 

GENERATED WITH THE CORRESPONDING AUTO TEXTS. 

> SEE THE CHAPTER "MODIFY TITLE BLOCK". 

You can also call up or enter revision comments via the "Rev. list" button. These 

comments are also filled in automatically. 

 

A maximum of 8 revision comments are possible. 

CONFIGURE CLASSIFICATION TITLE 

BLOCK 

Up to ELITECAD version 12.0 the title block was defined by objects with specific 

classification structure. Classification title blocks can still be used in parallel to title 

blocks with auto texts.  
 

In case you create your own classification title blocks, you have to consider that the 

text that is generated automatically by the function COMPLETE TITLE BLOCK, 

belongs to an object with a specific name.  

The title block needs a specific classification structure. You can modify the 

classification by the function CHANGE > CLASSIFICATION. 

Select all objects of the title block and enter the following values. 

 

TIP 
Each of the texts that are filled out need to be an individual object with 

specific name. The easiest way to achieve this is to take an existing 

title block and copy single objects in your title block.  
 

Following object names are defined for the title block 
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material Material.pre-product 

pageno Page number 

id Drawing number 

rev Revision 

descr Plan description 

comm Comment 

scale Scale 

weight Weight 

cre_usr Edited by 

cre_date Edited on 

chk_usr Checked by 

chk_date Checked on 

free_usr Approved by 

free_date Approved on 

ori_usr Creator 

ori_date Creation date 
 

Following object names are defined for revision marks 

*rev_rev State (revision) 

*rev_descr description 

*rev_usr  User 

*rev_date Revision date 

*rev_chk Checked by 

*rev_cdate Checked on 

Enter the revision number instead of the asterisk at beginning of the object name 

(number between 1 and 8), e.g. 1rev_rev, 2rev_rev. 

MODIFY AUTO TEXT TITLE BLOCK 

Title blocks can be personalised. The AUTO TEXT function can be used to add 

fields. 

If you right-click inside the text box while creating or editing a text, the item "Insert 

auto text" appears in the context menu. 
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All the options are listed under the Title block group. 

 

CREATE CUSTOM TITLE BLOCK 

 WORKSHOP  

Open new drawing. 
 

1. Select the function FILE NEW and change the scale to 1:1. 

 

2. Draw the frames for the different fields, ensuring that all elements are in the Plan 

graphic layer. 

 

 

3. Add text. To enable a text to be created vertically in the centre of a field, the text 

reference point must be set to Centre left. 
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4. Auto texts can now be added to the title block. There are auto texts that are filled 

out directly by the program (project, MST, file name, etc.) and auto texts that are 

filled in via the screen Complete title block (plan content, building project, etc.). 

       

 

5. As a test the title block can be filled out:  

LAY-OUT MENU > COMPLETE TITLE BLOCK. 

    

6. To enable the title block to be selected with a single click, it must be grouped 

together. Select the title block and from the context menu select GROUP 

SELECTION. 

 

 

7. Move the title block in such a way that the point of the title block is located in the 

middle of the page; later on the title block will be attached to this point when you 

locate it using your cursor. 

Project:  Test ABC 
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8. Save the title block to your library. 

FILE MENU > SAVE AS 

  WORKSHOP END 
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6.9 FORMAT FRAME 

DIN/ANSI FORMAT 

 

Lay-out toolbar 

Lay-out menu > Format frame 

This function is used to load a format frame. 
 

After the function is activated, the format frame is automatically loaded based on the 

current format settings (DIN, ANSI). In the A3 format only, enter the number of the 

desired DIN format (A3 or A4).  
 

TIP 
The symbols used for that are stored in the <ELITECAD installation 

path>\u\<version>\cad\glob\l directory under the name a00 -a4 for 

DIN formats and a–e for ANSI formats. These symbols can be opened 

normally, like an ELITECAD file, then changed and finally saved again 

in the same directory under the same name. That way you can change 

pens, draw double frames or modify folding lines, for instance.  

User-defined paper sizes 

You can save your own format frames for user-defined paper sizes. They only need 

to have the same name as the saved template and be saved under the <ELITECAD 

installation path>\u\<version>\cad\glob\l directory. 
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7.1 GENERAL 3D PARAMETERS 

COMMON PARAMETERS 

In the properties bar and in the big parameter dialog window for 3D objects, some 

parameters and functions are equal for all 3D objects and are described in this chapter 

together for all types. 

Layer/Name 

 

 

Either the layer or the name of the object is edited here. The name is available if 

working with group/class/level is activated in the OPTIONS. This is the preferred 

setting in ELITECAD Mechanics. 

Material 

 

This setting is only available in ELITECAD Mechanics. The assigned material is 

added as an attribute to the object and listed in the bill of materials. This information 

is used to calculate the weight of an object if the volume is available. Additionally, the 

hatch for sections is defined by the material. A necessary requirement for the 

calculation is a specific weight for the material defined in the database. 

Colour/Material 

 

Here you can select the colour and transparency, as well as the material for 3D 

depiction. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Representation level 

This function is only available in ELITECAD Architecture. 

 

The depiction of 3D objects in views depending on the representation level can be 

changed here. 
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Renovation planning state 

This function is only available in ELITECAD Architecture. 

 

This function is used to set the renovation planning state. See chapter 8.5. 

Kind of 3D definition 

You have two options available for generating a 3D objects: Either draw the contour 

directly, or you can draw a closed polygon before accessing the function and "define" 

it as a 3D object. 

For some 3D objects, it is required that the contour is a closed polygon. 

TIP 
If polygons are nested and were drawn or clicked from outside inwards, 

or are in the selection, cut-outs are produced.  

Over contour entry 

 

The definition is done by directly drawing a polygon. Once you have reached the start 

point of the drawing again, the function defines the 3D object immediately. 

If open contours are allowed, the polygon input is terminated by entering the last point 

twice. 

Over select contour 

 

Click on the outline of the polygon to generate the 3D object. 

Over selection  

If a selection has already been made when this function is selected, a query appears as 

to whether this selection should be used. 

Resolution 

 
This function is used to set parameters for the resolution. You find a detailed 

description at the chapter MODIFY>RESOLUTION. 

Modify contour 

 

Using this function, you can change the contour of the surface at a later point. 

Once you have clicked on the function, the 2D contour of the 3D object is 

automatically displayed. 

For objects, which are defined by multiple contours, a selection window appears at the 

top left corner of the screen, where the desired contour is chosen. The selection is 

confirmed by either the [ENTER] button or by the clicking confirmation in the dialog. 

Now change the contour with the usual 2D drawing functions. Close the function with 

the "Contour finished" button at the top left corner of the screen. 
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TIP 
After selecting the surface, click on a handle or gripper of the contour to 

access manipulation functions directly in a tool bar or by using [TAB] 

with the cursor.  

TYPE-SPECIFIC PARAMETERS 

In the properties bar and in the big parameter dialog window for 3D objects, some 

parameters and functions are equal for multiple 3D objects and are described in this 

chapter together for corresponding types. 

Planar Surface, extrude and box 

   

The height is the distance of the planar surface from the work plane. 

The base and upper heights for extrude and box are the limitation planes perpendicular 

to the work plane. 

 

If the limitation plane is not perpendicular to the work plane, then instead of the height 

value the note "inclined" is displayed. 

Height entry mode 

Limitation plane over heights 

     

The height can be entered as a numerical value (in the unit currently set) in the 

properties bar. 

Limitation plane over point entry 

     

The height can be directly defined using the CAPTURE FUNCTIONS by selecting a 

height marker in the 3D model. 

Limitation plane over 3 points 

     

This defines the surface over three points. The height is queried for each point. The 

definition of three Z-coordinate points for the slanted surface can take place anywhere 

on the screen, and is not linked to the contour elements! 
 

TIP 
It is also possible to select points directly in the 3D model here. The 

clicked height is recommended above the entry line and can be easily 

confirmed with [Enter].   
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Limitation plane over surface 

     

Clicking on an existing surface defines the position. 

Rotation extrude and rotation box 

 

The start and end angles for rotation are entered here. 

Rotation type for trans surface, trans box, 

design surface, design box, free form surface, 

2-views curve 

 

The most common rotation types can be selected in the property bar for the trans box 

and trans surface. 

 parallel (type 1) 

 symmetrical (type 5) 

In ELITECAD Mechanics, there is a second creation method for the types 1-8 

numbered 101-108 

 standard (type 102) 

 standard rounded (type 108) 

The rotation type for the remaining 3D definitions is set in the respective big parameter 

windows. The free type offers the possibility to enter the number of the type manually. 

 

Starting position for the examples is a trans surface with the following origin: 

   

Type 1: 

The contour is moved along the path without changing its position in space. 
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Type 2: 

The contour is moved perpendicular to the path. The edge of the surface is 

perpendicular to the path. 

   

Type 3: 

The contour is moved perpendicular to the path. The edge of the surface is at the same 

angle to the path at the start and the end. The angle corresponds to the angle between 

the contour and the path. 

   

Type 4: 

The contour is moved perpendicular to the path. The edge of the surface maintains the 

angle between the contour and path on one side and ends perpendicular on the other 

side. 

   

Type 5: 

The contour is moved perpendicular to the path. The edge of the surface maintains the 

angle between the contour and path on one side and ends symmetrical on the other 

side. 
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Type 6: 

The contour is moved along the path and maintains the enclosed angle. Holes that 

result from buckles are filled. 

   

Type 7: 

The contour is moved along the path and maintains the enclosed angle. The angle 

changes if there are buckles. 

   

Type 8: 

The contour is moved along the path and maintains the enclosed angle. Holes that 

result from buckles are filled with a round joint. 

   

Type 101, 102 for design box and design surface: 

This special type is only available in ELITECAD Mechanics and is valid for the 3D 

types design box and design surface. 

The type 102 uses the direction of the direction of the way contour in the start and end 

point as a tangent for the surface. With the type 101 the way contour is irrelevant for 

the generation. The surface with the shortest connection is created for the type 101. 

 

  type 102    type 101 

Delta 

The tolerance with which two border curves are considered being connected. Default 

value is 0.01 mm. Only displayed for 3D objects defined in the Window Manager of 

ELITECAD 6.0. 
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Height 

Only displayed for 3D objects defined in the Window Manager of ELITECAD 6.0. 

Operator definition 

The following types of operations are possible: 

Minus operation, join, section, and fillet. 

Online 

The definition is only updated if online is switched on. 

Radius 

Only possible for fillet operations; radius for fillet surface. 

DEPICTION 

This function is only available in ELITECAD Architecture. 

3D objects are subject to the representation level, therefore allowing a depiction that 

is true to the material for views, sections and floor plans each at the appropriate scale. 

Each newly defined 3D definition is automatically assigned the default parameters 

from the representation level. 

 

To obtain an individual depiction of single definitions, a created definition is assigned 

its own material. 

 

Once the link (1) is detached from the representation level, an existing parameter can 

be selected (2) or a new parameter record can be directly created. The settings (5) must 

be made per representation level (3) and view type (4). The settings (5) differ for each 

view type. 
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7.2 CREATION 

PLANAR SURFACE  

Define planar surface 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > Surface 

This function is used to define a surface from a closed 2D contour. 

Click on the Create planar surface function to enable the settings for the last planar 

surface drawn. The contour can now be drawn.  
 

TIP 
If the 2D contour is open at one point, the surface is not created. The 

contour must first be correctly closed for the surface to be generated.  

  

Planar Surface properties bar 

 

The properties bar becomes visible as soon as the DEFINE SURFACE function is 

started or if an existing surface is edited. 
 

 
3D object parameters 

 
Renovation planning state (only in Architecture) 

  
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Kind of 3D definition 

 
Entry mode for the base height 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object Parameters 
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 WORKSHOP  

Define surface 

Draw a rectangle, then click on DEFINE SURFACE and set the Kind of 3D definition 

to Select contour. Set the height to 0, the colour to 2 and click on the rectangle. 
 

       

   

Several definitions can even be stored for the same contour. 

Now set the height to 50, the colour to 3 and click on the rectangle again. 

 

 

TIP 
The individual parameters of the surfaces can be modified with 

Selection element part.   
 

To create a slanted surface, set the Entry mode to 3 points. After you have drawn the 

contour, click on point 1 and enter a height of 0. Then click on points 2 and 3 and enter 

the heights 100 and 200. This creates a slanted level. 
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  WORKSHOP END 

EXTRUDE 

Define extrude 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > Extrude 

This function is used to define an extrude from 2D lines. 

Click on the Create extrude function to enable the settings for the last extrude drawn. 

The contour can now be drawn. 

Extrude properties bar 

 

The properties bar becomes visible as soon as the DEFINE EXTRUDE function is 

started or if an existing extrude is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Kind of 3D definition  

  
Entry mode for the base height 

  
Entry mode for the upper height 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 
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3D object parameters 

 

 

 WORKSHOP  

Define extrude 

Draw a contour then click on DEFINE EXTRUDE and set the Kind of 3D definition 

to Select contour. Set the base height to 0, the upper height to 100, the colour to 2 and 

click on the contour. 

        

  

Several definitions can even be stored for the same contour. 

Now set the base height to 200, the upper height to 300, the colour to 3 and click on 

the contour again. 

 

 

TIP 



Chapter 7 – 3D Objects  

www.elitecad.eu  464 

The individual parameters of the extrudes can be modified with 

Selection element part.   
 

To create a slanted extrude, set the Entry mode to 3 points. After you have drawn the 

contour, click on point 1 and enter a height of 0. Then click on points 2 and 3 and enter 

the heights 0 and -100. Proceed in exactly the same way for the upper height and enter 

the heights 100 and 200. Slanted levels are then produced. 

    

  

  WORKSHOP END 

BOX  

Define box 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > Box 

This function is used to define a box from 2D lines. 

Click on the CREATE BOX function to enable the settings for the last box drawn. The 

contour can now be drawn.  
 

TIP 
If the 2D contour is open at one point, the box is not created. The contour 

must first be correctly closed for the box to be generated.  

Box properties bar 

 

The properties bar becomes visible as soon as the DEFINE BOX function is started or 

if an existing box is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 
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Kind of 3D definition 

 
Entry mode for the base height 

 
Entry mode for the upper height 

 
Modify contour 

 
Resolution 

 

General properties see chapter General 3D parameters. 

3D object parameters 

 

 

 WORKSHOP  

Define box 

Draw a rectangle then click on DEFINE BOX and set the Kind of 3D definition to 

Select contour. Set the base height to 0, the upper height to 100, the colour to 2 and 

click on the contour. 

        

  

Several definitions can even be stored for the same contour. 
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Now set the base height to 200, the upper height to 300, the colour to 3 and click on 

the rectangle again. 

 

 

TIP 
The individual parameters of the boxes can be modified with Selection 

element part.   
 

To create a slanted box, set the Entry mode to 3 points. After you have drawn the 

rectangle, click on point 1 and enter a height of 0. Then click on points 2 and 3 and 

enter the heights 0 and -100. Proceed in exactly the same way for the upper height and 

enter the heights 100 and 200. Slanted levels are then produced. 

    

   

  WORKSHOP END 
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ROTATION EXTRUDE 

Define rotation extrude 

  

3D tool bar, 3D-Object tool bar (ME) 

Draw menu > 3D > Rotation extrude 

This function is used to define a rotation extrude from 2D lines.  

Click on the CREATE ROTATION EXTRUDE function to enable the settings for the 

last rotation extrude drawn. The contour can now be drawn.  
 

EXPLANATION 
Use the tool bar to start the ROTATION BOX function and switch to 

rotation extrude in the properties bar. 

 

  

TIP 
The axis may not intersect the contour, otherwise an error occurs and 

the contour is represented with the pen 0.  

Rotation extrude properties bar 

 

The properties bar becomes visible as soon as the DEFINE ROTATION EXTRUDE 

function is started or if an existing rotation extrude is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Kind of 3D definition 

 
Start angle 

 
End angle 

 
Modify contour 

 
Modify rotation axis 

 
Resolution 
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General properties see chapter General 3D parameters. 

3D object parameters 

 

 

 

Entry 

Start angle, end angle 

 

At this point, the start and end angles of the rotation extrude are displayed. 

Centre line 

 

This option is only available in ELITECAD Mechanics. If the option is active, a centre 

line is created along the rotation axis, which adjusts to the extent of the 3D object. The 

depiction settings are defined in the menu SETTINGS > OPTIONS > WORKING 

PARAMETERS > MECHANICAL LINES. 
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Modify rotation axis 

 

Press this function to redefine the axis for the rotation extrude. 

 

 WORKSHOP  

Define rotation extrude 

Draw a contour, then click on DEFINE ROTATION EXTRUDE and set the start angle 

to 0, the end angle to -180 and the colour to 2. For the position of the axis, click on 

points P1 and P2 and click on the contour. 

 

      

  

Several definitions can even be stored for the same contour. 

Then simply click again on DEFINE ROTATION EXTRUDE and set the start angle 

to 80, the end angle to 100 and the colour to 3. 

Click once more on points P1 and P2 and click on the contour. 

  

 

TIP 
The individual parameters of the rotation extrude can be modified with 

Selection element part.   

  WORKSHOP END 
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ROTATION BOX  

Define rotation box 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > Rotation box 

This function is used to define a rotation box from 2D lines.  

Click on the CREATE ROTATION BOX function to enable the settings for the last 

rotation box drawn. The contour can now be drawn.  
 

TIP 
If the 2D contour is open at one point, the box is not created. The contour 

must first be correctly closed for the box to be generated.  

Rotation box properties bar 

 

The properties bar becomes visible as soon as the DEFINE ROTATION BOX function 

is started or if an existing rotation box is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Kind of 3D definition 

 
Start angle 

 
End angle 

 
Modify contour 

 
Modify rotation axis 

 
Resolution 

 

General properties see chapter General 3D parameters. 

3D object parameters 
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Entry 

Start angle, end angle 

 

At this point, the start and end angles of the rotation box are displayed. 

Centre line 

 

This option is only available in ELITECAD Mechanics. If the option is active, a centre 

line is created along the rotation axis, which adjusts to the extent of the 3D object. The 

depiction settings are defined in the menu SETTINGS > OPTIONS > WORKING 

PARAMETERS > MECHANICAL LINES. 

Modify rotation axis 

 

Press this function to redefine the axis for the rotation box. 

 WORKSHOP  
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Define rotation box 

Draw a contour, then click on DEFINE ROTATION BOX and set the start angle to 0, 

the end angle to -180 and the colour to 2. For the position of the axis, click on points 

P1 and P2 and click on the contour. 

     

  

Several definitions can even be stored for the same contour. 

Then simply click again on DEFINE ROTATION BOX and set the start angle to 80, 

the end angle to 100 and the colour to 3. 

Click once more on points P1 and P2 and click on the contour. 

  

 

TIP 
The individual parameters of the rotation boxes can be modified with 

Selection element part.   

 

  WORKSHOP END 

TRANS SURFACE  

Define trans surface 

  

Free forms / curve tool bar, Free forms tool bar (ME) 

Draw menu > Free form > Trans surface 

This function allows you to generate a surface using one or more contours that are 

moved along a path. 

After activating this function, click on the contour and confirm with [Enter]. The 

selected contour is represented in purple. Then click on the path and the trans surface 

is created. 
 

The following options are available for selection as a contour or path: 
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2D contour 

2-views curve 

Extracted border curve 
 

EXPLANATION 
Use the tool bar to start the TRANS BOX function and switch to trans 

surface in the properties bar. 

 

  

TIP 
The contour and path do not have to be connected.  

Trans surface properties bar 

 

The properties bar becomes visible as soon as the DEFINE TRANS SURFACE 

function is started or if an existing trans surface is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Rotation type 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 
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 WORKSHOP  

Define trans surface 

Draw a line with a connecting curve over centre point. 

The work plane on which the contour is drawn must be perpendicular to the current 

work plane. To do this, use the CREATE WORK PLANE AS NEW USING 

NORMAL function. After starting the function, click on points P1 and P2. Use [Ctrl] 

+ [space] to get to the starting position of the new work plane. 

Draw a line again with a connecting curve. You can also start the first point of the line 

with 0 [Enter]. This means that the current cursor position (P1) is the start point. After 

drawing, reset the work plane. 

       

  

Now click on the DEFINE TRANS SURFACE function. The contour K must be 

clicked first, then the path W. 
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  WORKSHOP END 

TRANS BOX  

Define trans box 

  

Free forms / curve tool bar, Free forms tool bar 

Draw menu > Free form > Trans box 

This function allows you to generate an object using a closed, planar contour (optional 

with cut-outs), that is moved along a path. 

The procedure for defining an object is identical to that for defining a TRANS 

SURFACE, as the lateral surface of the trans box is a trans surface. Floor and slab 

surfaces are generated from the closed contour. 
 

TIP 
If polygons are interleaved and were clicked from outside inwards, cut-

outs are produced.  
 

TIP 
If the 2D contour is open at one point, the trans box is not created. The 

contour must first be correctly closed for the object to be generated.  

  
 

TIP 
The contour and path do not have to be connected. 

  

Trans box properties bar 

 

The properties bar becomes visible as soon as the DEFINE TRANS BOX function is 

started or if an existing trans box is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Rotation type 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 
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3D object parameters 

 

 

 WORKSHOP  

Define trans box 

Draw a line with a connecting curve over centre point. 

The work plane on which the contour is drawn must be perpendicular to the current 

work plane. To do this, use the CREATE WORK PLANE AS NEW USING 

NORMAL function. After starting the function, click on points P1 and P2. Use [Ctrl] 

+ [space] to get to the starting position of the new work plane. 

Now draw a rectangle. You can also start the first point of the rectangle with 0 [Enter]. 

This means that the current cursor position (P1) is the start point. The second point can 

be freely set. Reapply the work plane. 

       

  

Now click on the DEFINE TRANS BOX function. The contour K must be clicked 

first, then the path W. 
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  WORKSHOP END 

DESIGN SURFACE  

Define design surface 

  

Free forms / curve tool bar, Free forms tool bar (ME) 

Draw menu > Free form > Design surface 

This function allows you to generate a surface using a contour that is transformed into 

a second contour along a path. 

After activating this function, click on the first contour. The selected contour is 

represented in purple. Then click on the path. The selected path is represented in 

purple. After you click on the second contour, the design surface is created. 
 

The following options are available for selection as a contour or path: 

2D contour 

2-views curve 

Extract border curve 
 

EXPLANATION 
Use the tool bar to start the DESIGN BOX function and switch to design 

surface in the properties bar. 

 

  
 

TIP 
The contour and path do not have to be connected. 

  

Design surface properties bar 

 

The properties bar becomes visible as soon as the DEFINE DESIGN SURFACE 

function is started or if an existing design surface is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 



Chapter 7 – 3D Objects  

www.elitecad.eu  478 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 

 

 

 
Rotation type 

 WORKSHOP  

Define design surface 

Draw a line for the path on the floor plan. 

The work plane on which the contours are drawn must be perpendicular to the current 

work plane. To do this, use the CREATE WORK PLANE AS NEW USING 

NORMAL function. After starting the function, click on points P1 and P2. Use 

[Ctrl]+[space] to get to the starting position of the new work plane. 

Draw a connecting line. You can also start the first point of the line with 0 [Enter]. 

This means that the current cursor position (P1) is the start point. After drawing, 

reapply the work plane. 
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Now you need a second contour, which is copied and scaled in this example. Select 

the first contour and click on COPY SELECTION. 

Following the query Move which point? click on point P1. In the properties bar that 

now appears, you can also scale in addition to copying. Click on the SCALE button, 

enter the value 0.2 and confirm the entry with [Enter]. Apply the smaller contour to 

point P2. 

  

 

Now click on the DEFINE DESIGN SURFACE function. The contour K1 must be 

clicked first, then the path W and finally the second contour K2. 

 

  

  WORKSHOP END 

 

DESIGN BOX  

Define design box 

  

Free forms / curve tool bar, Free forms tool bar 

Draw menu > Free form > Design box 

This function allows you to generate an object using a closed, planar contour that is 

converted to a second closed, planar contour along a path. 
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The procedure for defining an object is identical to that for defining a DESIGN 

SURFACE, as the lateral surface of the design box is a design surface. Floor and slab 

surfaces are generated from the contours. 
 

TIP 
If the 2D contour is open at one point, the design box is not created. The 

contour must first be correctly closed for the object to be generated. 

  
 

TIP 
The contour and path do not have to be connected. 

  

Design box properties bar 

 

The properties bar becomes visible as soon as the DEFINE DESIGN BOX function is 

started or if an existing design box is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 
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Rotation type 

 WORKSHOP  

Define design box 

Draw a line for the path on the floor plan. 

The work plane on which the contours are drawn must be perpendicular to the current 

work plane. To do this, use the CREATE WORK PLANE AS NEW USING 

NORMAL function. After starting the function, click on points P1 and P2. Use 

[Ctrl]+[space] to get to the starting position of the new work plane. 

Now draw a rectangle. You can also start the first point of the rectangle with 0 [Enter]. 

This means that the current cursor position (P1) is the start point. The second point can 

be freely set. Reapply the work plane. 

      

  

Now you need a second contour, which is copied and scaled in this example. Select 

the first contour and click on COPY SELECTION. 

Following the query Move which point? click on point P1. In the properties bar that 

now appears, you can also scale in addition to copying. Press on the additional function 

"Scale", enter the value 0.2 and confirm the entry with [Enter]. Apply the smaller 

contour to point P2. 

  

 

Now click on the DEFINE DESIGN BOX function. The contour K1 must be clicked 

first, then the path W and finally the second contour K2. 
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  WORKSHOP END 

FREE FORM SURFACE  

Define free form surface 

  

Free forms / curve tool bar, Free forms tool bar 

Draw menu > Free form > Free form surface 

This function allows you to generate a surface using four limit lines (2 contours and 2 

paths). 

After activating this function, click on contour 1. The selected contour is represented 

in purple. Then click on path 1. Once you have clicked on contour 2 and path 2 the 

free form surface is created.  
 

The following options are available for selection as a contour or path: 

2D contour 

2-views curve 

Extract border curve 
 

TIP 
Contours and paths must be connected to the start and endpoints.  

  

Free form surface properties bar 

 

The properties bar becomes visible as soon as the DEFINE FREE FORM SURFACE 

function is started or if an existing free form surface is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour selection) 

 
Transparency in percentage (colour selection) 

 
Material selection (material mode) 

 
Modify contour 
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Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 

 

 

 
Rotation type 

 WORKSHOP  

Define free form 

In this example, the first contour is drawn in the front view. In views management, 

switch to the front view. 

   

Now draw a CURVE BY 3 POINTS. 

You can start the first point of the curve P1 with 0 [Enter]. This means that the current 

cursor position (P1) is the start point. The second point P2 and the third point P3 can 

be freely set. Then switch back to the model view. 
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Now select the contour and go to the COPY SELECTION function. Following the 

query Move which point? click on point P1. In the properties bar that now appears, 

you can also rotate, mirror and copy multiple times in addition to copying. Press the 

additional functions ROTATE, MIRRORING 3D and MULTIPLE COPY one after 

the other. Now the query How often? appears in the entry line. Enter the number 3 and 

confirm with [Enter]. Now the contour can be placed in its new position. Click on 

point P3. 

    

  

Select the DEFINE FREE FORM SURFACE function. Now click on contour K1, path 

W1, contour K2 and finally path W2 one after the other. 

 

  

  WORKSHOP END 
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2-VIEWS OBJECT 

Define 2-view object 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > 2-views object 

This function is used to generate a 3D object from its projections in two non-parallel 

planes. 

Before accessing the function, a planar, closed contour must be created for each of the 

first and second view.  

After activating this function, the two views must be selected by clicking and 

confirming with [Enter]. After you click on the two contours, the 3D geometry is 

created. 
 

TIP 
If polygons are interleaved and were clicked from outside inwards, cut-

outs are produced.  

2-views object properties bar 

 

The properties bar becomes visible as soon as the DEFINE 2-VIEWS OBJECT 

function is started or if an existing 2-views structure is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 
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 WORKSHOP  

Define 2-view object 

In this example, the first contour is drawn in the front view. In views management, 

switch to the front view. 

  

Create four parallel help lines with the distance 100 cm to each of the points P1 and 

P2. 

  

  

Now draw a triangle. The help lines can then be deleted again. Then switch back to 

the model view. 
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Now select the contour and go to the COPY SELECTION function. Following the 

query Move which point? click on point P1. In the properties bar that now appears, 

you can also rotate 90 degrees to the left in addition to copying. Press the additional 

function ROTATE. Now the contour can be placed in its new position. Click on point 

P1 again. 

  

  

Select the DEFINE 2-VIEW OBJECT function. Click on the contours K1 and K2 and 

confirm each with [Enter]. 

 

  

  WORKSHOP END 

3-VIEW OBJECT 

Define 3-view object 

  

3D tool bar, Free forms tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > 3D > 3-views part 

This function is used to generate a 3D object from its projections in three non-parallel 

planes. 

Before accessing the function, a planar, closed contour must be created for each of the 

three views.  
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After activating this function, the three views must be selected by clicking and 

confirming with [Enter]. After you click on the contours, the 3D geometry is created. 
 

TIP 
If polygons are interleaved and were clicked from outside inwards, cut-

outs are produced.  

3-views object properties bar 

 

The properties bar becomes visible as soon as the DEFINE 3-VIEWS OBJECT 

function is started or if an existing 3-views object is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection (colour mode) 

 
Transparency in percentage (colour mode) 

 
Material selection (material mode) 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 

 

 

 WORKSHOP  

Define 3-views object 
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To draw the first two contours, proceed in exactly the same way as in the workshop 

for the 2-VIEWS OBJECT. 

 

Use [Ctrl]+[space] to return to the starting position and transfer five parallel help lines 

with the distance 80 cm to each of points P1 and P2. 

  

  

Now draw a polygon as illustrated below. The help lines can be deleted again 

afterwards. 

     

  

Select the DEFINE 3-VIEWS OBJECT function. Click on the contours K1 to K3 and 

confirm each with [Enter].  

 

  

  WORKSHOP END 
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2-VIEW CURVE  

Define 2-view curve 

  

Free forms / curve tool bar (AR), 3D-Object tool bar (ME) 

Draw menu > Curve > 2-views curve 

This function is used to generate a 3D curve from its projection to two planes that are 

perpendicular to each other. 

Before accessing the function, a planar, closed contour must be created for each of the 

first and second views, if not already available. 

After activating this function, the two views must be selected by clicking, and the 3D 

curve is created. 
 

TIP 
Both views must be in two work planes that are perpendicular to each 

other. The start and endpoints of the first and second view must uniquely 

match each other.   

2-views curve properties bar 

 

The properties bar becomes visible as soon as the 2-VIEWS CURVE function is 

started or if an existing 2-views curve is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection – direct entry 

 
Selection of line type 

 
Modify contour 

 
Resolution 

General properties see chapter General 3D parameters. 

3D object parameters 
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Rotation type 

Colour selections 

The exact description of the COLOUR SELECTION menu can be found in the chapter 

1.4 "Colours".  

Colour selection – direct entry 

 

The surface colour can be entered directly (from 0-1023). 

Colour selection over table 

 

Here the colour is selected using a colour table. 

Line type 

 

Here you can select the desired line type. 

Example: 

  

The new 3D curve is now available for other 3D functions. 
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CURVE BY UNFOLD CONTOUR 

  

Free forms / curve tool bar, Free forms tool bar  (AR), 3D-Object tool bar (ME) 

Draw menu > Curve > by unfolded contour 

This function is used to create a 3D curve from a path (projected 3D curve) and a 

contour, which represents its unfolded curve. In addition, the surface described by path 

contour and spatial curve can also be created. 

After activating this function, identify the 2D contour for the path, and the unfold 

contour, by clicking on them. Then you are asked for the colour desired (pen number) 

for the 3D curve. A 3D curve is created. 
 

TIP 
 The path and unfold contour must be 2D contours. 

 The contours can be in any work planes. 

 Both contours must have the same origin (important for the 

orientation of the 3D curve). 

 The contour may not be closed, excepting multiple circles 

superimposed upon each other to generate a helix with multiple coils. 

 The path contour is used for the X and Y-coordinates of the 3D curve. 

If both contours are in one work plane, the Y-coordinate of the unfold 

contour is used for the Z-value of the 3D curve. If the path contour 

and the unfold contour are in different work planes, the projection 

contour is converted into the work plane of the path contour and used 

to define the Z-values.  

Example: 

  

The new 3D curve is now available for other 3D functions. 

CURVE OVER COORDINATES 

  

Free forms / curve tool bar, Free forms tool bar  (AR), 3D-Object tool bar (ME) 

Draw menu > Curve > Over points 

This function is used to generate a spatial line. 

After activating this function, you can enter as many points as you wish either using 

the values field, or by clicking on them.  
 

TIP 
The 3D curve is available for free form surface definitions. Existing 3D 

curves can be modified via the menu MODIFY > 3D CURVES. 
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Curve over coordinates properties bar 

 

The properties bar becomes visible as soon as the CURVE OVER POINTS function 

is started or if an existing curve is edited. 
 

 
3D object parameters 

 Renovation planning state (only in Architecture) 

 
Colour selection – direct entry 

 Rounding radius 

General properties see chapter General 3D parameters. 

STANDARD 3D OBJECTS 

 
Standard 3D objects tool bar 

Draw menu > 3D > Standard 3D objects 

This function is used to create standard 3D objects easily. You can select from the 

symbols illustrated below. 

After clicking on each function, the corresponding queries appear above the entry line. 

 Cube    Cuboid   Prism 

   

 Cone    Cylinder   Barrel 

   

 Segment   Circle sector   Cone stump 
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 Pyramid 
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7.3 MODIFY 

3D OBJECT PARAMETERS 

  

*Modify tool bar 

Modify menu > 3D object parameters 

This function is used to display and modify the parameters of a 3D object. 
 

TIP 
The same window can also be started in the properties bar. To edit an 

object, click on "3D object parameters".  
 

After activating this function, the desired object is selected by clicking on it, and the 

3D object parameters dialog appears. Depending on the type, different parameters 

appear (e.g. for BOX). 

 

Parameters 

You can find a description of the parameters in the chapter General 3D parameters. 

Multiple 3D objects 

  

These buttons are used to scroll forwards and backwards if the current contour belongs 

to more than one object. 

OK 

This button applies the set values and closes the window. 

Apply 

This button applies the set values with immediate effect (e.g., colours change). 

Cancel 

This button closes the window without applying the set values. 
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BOOLEAN OPERATION 

  

Modify tool bar, Free forms tool bar  (AR), 3D-Object tool bar (ME) 

Modify menu > Boolean operation 

You can use this function to execute Boolean operations with objects (e.g. box). 

The following settings window appears after activating this function. Select the desired 

option and close the window with OK. You can now click on the 3D objects. 

 

Associative 

When enabled, the result is associatively linked with the starting definition. If a starting 

definition is changed, the result automatically updated. 

Section 

The result is the section (intersection) of the specified object. 

Join 

The objects specified are joined. 

A minus B 

The objects are subtracted. 
 

EXPLANATION 
 The Boolean calculation produces a new definition (except for the A 

object which is already a Boolean definition). With A and B objects, 

the 3D definition is hidden. 

 Boolean operations can also be applied to free form surfaces. 

 For Boolean operations with surfaces, the normal vector direction 

determines which side of the object remains. 

  

 WORKSHOP  

Boolean operation 

The basis for this example is two boxes inside each other. 

Draw two rectangles and use them to define boxes. 
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Then click on the BOOLEAN OPERATION function and make the following settings. 

Confirm with OK. 

 

 

Please click definition A (ENTER = End) 
 

Use the mouse to click on the larger of the two boxes and then confirm with [Enter]. 

Please click definition B (ENTER = End) 
 

Now the object that is to be removed can be specified. Click on the smaller box and 

confirm this with [Enter]. 

  

The SECTION option produces the following result. 

 

The JOIN option produces the following result. 
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  WORKSHOP END 

TIP 
When selecting the different definitions "A" or "B", you can select as 

many objects as you wish, before ending the process with [Enter]. 

  

ROUND EDGES 

 

*Modify toolbar, Modify toolbar (ME) 

Menu Modify > Round edges 

This function is only available in ELITECAD Mechanics. 

With this function, the edges of a closed body can be rounded off or chamfered. 

Depending on the selected setting, individual edges or several connected edges can be 

edited. Processing takes place either with a constant radius, as a constant chamfer or 

as a rounding with a variable transition. In addition, various options for editing vertices 

are possible. 

Define edge blend 

First, the 3D definition to be edited is selected. If a 3D definition was selected on which 

edge rounding is possible in principle, the ROUNDING menu appears. 
 

REMARK 
The ROUND EDGES function requires a special description of the 

model. If the selected definition is not yet available in the structure 

required for the function, the program will perform an internal 

conversion. For special parts from older ELITECAD versions (before 

version 10) or VDA data, the necessary description may not be 

generated. EDGE ROUND is not possible in such cases.  
 

An edge rounding operation may consist of several individual fillets. To define each 

single fillet, perform the following steps: 

1. Select the mode (BEFORE selection) 

2. Enter required parameter (BEFORE selection) 

3. Select edge or vertex 

4. Confirm selection with [Enter] 
 

[Enter] without edge or vertex selection completes the entire input and starts the 

calculation. 
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Edge blend parameters 

 

The parameters displayed depend on the current mode. 

Blend mode 

 

Blend sequence 

A series of tangentially connected, rounded edges of constant radius. 

 

Vertex blend 

A rounded vertex. Attention: All subsequent edges must also be rounded, 

either constant or variable. A mixture with chamfers is not possible. 

 

Single blend 

A rounded single edge with a constant radius. 

 

Variable single blend 

A rounded single edge with linearly interpolated radius profile between 

two specified values (linearly interpolated over the edge length). 

 

Variable blend sequence 

A series of tangentially connected, rounded edges with a linearly 

interpolated radius profile between two given values (linearly interpolated 

over the entire length). 

 

Single chamfer 

A 45 ° chamfer running parallel to the edge to be defined. A chamfer is 

only possible with adjacent planar or cylindrical surfaces. 

 

Chamfer sequence 

A series of tangentially connected 45 ° chamfers running parallel to the 

defining edges. A chamfer is only possible with adjacent planar or 

cylindrical surfaces. 

Radius 

Depending on the mode, this value has a different meaning: 

Rounding radius for constant rounding 

Starting radius with variable rounding (starting point marked via box) 

Edge distance for chamfers 

End radius 

The end radius can only be selected with variable fillets. 

The variable rounding is interpolated linearly between the start and end radius over the 

length of the selected edge or edge sequence. 

Offset 

The offset can only be selected in the mode vertex blend. 

The corner surface is set back by this value from the corresponding corner point 

(marked by 3D cross). The offset should be larger than the radius otherwise, there will 

be no effect. 
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Bulge 

A bulge can only be selected in the mode vertex blend. 

You can enter comma values from 0 to 2 for the degree of bulging of the vertex blend. 

0 => as flat as possible 

1 => default 

2 => maximal bulge 

Define blend 

Enter the selection 

The edge or corner to be edited is to be selected in the graphics window with the 

mouse. Depending on the current mode, the program searches for corresponding 

further edges (for vertex blends all single edges not yet selected, starting from the 

vertex, for sequences all edges tangent to the selected edge). 

Visualise the selection 

Edges with defined fillets are clearly enhanced. 

GREEN highlighted areas always correspond to the CURRENT SELECTION. 

All confirmed selections, the CONFIRMED SELECTION, will be highlighted 

YELLOW. 

    
Defined vertex blends are indicated with 3D crosses. 

   
For variable fillets, the start points automatically selected by the program are 

visualised by means of boxes (only visible in CURRENT SELECTION). 

  

Confirming the selection 

With [Enter] the selection GREEN is confirmed. In this case, the previously set 

parameters are taken from the respective edges or from the vertex. 

Modify or delete entry 

To be able to change something, there must already be a CONFIRMED SELECTION, 

that is, any yellow highlighted edges or vertices. You change these as follows: 
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Set the mode of the selection to be changed (if you want to change a vertex blend, set 

the vertex blend mode, etc.) 

Set new parameters. A radius value of 0 (with variable rounding both radii 0) 

corresponds to a deletion operation. 

Select edge or corner point from the CONFIRMED SELECTION. 
 

If the selection was successful, the associated selection will again be highlighted in 

GREEN, as in the case of reselection, since this is the current CURRENT 

SELECTION. In addition, a dialog window appears. This displays the old and the new 

parameters set. 

 

With OK, the new values are accepted, with CANCEL the old values remain. 
 

If the selection was unsuccessful, the set mode usually does not match the mode of the 

selected selection. A note about this is below the input line like selection edge belongs 

to .... 

Complete edge rounding operation 

[Enter] without edge or vertex selection calls the calculation. 

If the algorithm fails due to mathematical (such as radius to large) or algorithmic 

constraints, the state is restored like it was before the calculation was executed. In this 

way, parts of the selection can be changed without having to redo the entire selection. 

Remarks 

A vertex blend corresponds to a rounded corner point. However, this operation is not 

possible if only one edge belonging to that vertex does not have a fillet. In order to 

avoid that such cases occur (failure due to a non-selected edge), all not rounded 

individual edges of a vertex blend are automatically selected during the selection. Of 

course, these edges can be changed individually or even deleted, by addressing them 

in single rounding mode. Before the calculation, however, all deleted and not reset 

individual edges of the vertex blend again receive the default radius of the assigned 

vertex blend, i.e. the value that stood in the selection of the vertex blend in the 

parameter dialog window. 

The temporary deletion of a single rounding involved in a vertex blend is suitable, if 

one wants to replace the automatically selected single rounding by a rounding 

sequence (However, it is more elegant, first to put on the rounding sequence, and then 

put a vertex blend on it). 

Inaccuracies in the model increase the likelihood of edge rounding failure, if 

mathematically possible. 

Placing vertex blends on corner points where multiple edges converge will sometimes 

increase the likelihood of a successful rounding operation. 

Doubtful fillets, such as rounding off only half of the edge of a cylinder, are indeed 

partially executed, but do not necessarily provide useful models. 
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DRAFT 

 

*Modify toolbar, Modify toolbar (ME) 

Menu Modify > Draft 

This function is only available in ELITECAD Mechanics. 

With this function, the surfaces of a closed body can be inclined by a free angle. The 

inclination is performed relative to a REFERENCE PLANE, which is either a selected 

surface of a 3D object or the current workspace plane. 

Define draft 

Select 3D definition 

First, the 3D definition to be edited is selected. If a 3D definition was selected on which 

a draft is possible in principle, the reference plane is queried next. 
 

REMARK 
The DRAFT function requires a special description of the model. If the 

selected definition is not yet available in the structure required for the 

function, the program will perform an internal conversion. For special 

parts from older ELITECAD versions (before version 10) or VDA data, 

the necessary description may not be generated. A DRAFT is not 

possible in such cases.  

Select reference plane 

The selection of a reference plane is done by selecting 

the desired surface in the graphics window, where a 

confirmation takes place, since this definition remains 

fixed for the other selections. If confirmed, the reference 

plane (RED) including the TAPERING DIRECTION, 

shown as a pyramid in the centre of the surface, is 

displayed. If no surface is selected by pressing [Enter], 

the current workspace plane is used as the reference 

plane, whereby the direction of taper here corresponds to 

the positive Z direction. This choice is not highlighted 

graphically, because there is still the option to display the coordinate system. 

 

REMARK 
The difference between choosing a surface and selecting the workspace 

plane as the reference plane is that the slope in the first case is around 

the common edges of reference and selected surfaces, but in the second 

case around the intersection edges of the workspace plane with the 

selected surfaces (these edges stay fixed). The angle of inclination 

applies relative to the tapering direction in the middle of the reference 

surface, represented by a pyramid, or, when the workspace plane is 

selected as the reference plane, the Z-direction.  

Select single surfaces 

After selecting the reference plane, the SINGLE SURFACES involved in the draft are 

selected. The selection is made by clicking on it, which makes it appear in the colour 

of the CURRENT SELECTION (GREEN). For the newly selected surface, an 

inclination angle can be specified in the input line. The angle of inclination refers to 

the tapering direction, which is illustrated either by the illustrated pyramid, or 
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corresponds to the Z-direction of the current workspace. If the CURRENT 

SELECTION (GREEN) is confirmed with the value indicated in the input line by 

[Enter], it will go to the CONFIRMED SELECTION (YELLOW), assuming the set 

inclination angle. 

 

REMARK 
If a certain surface of the 3D model has been selected as the reference 

plane (RED, with pyramid), then all surfaces that are selected for the 

draft must have at least one common edge with it. Furthermore, all 

adjacent further surfaces, which are tangential to the selected surface 

and have at least one common edge with the reference surface, are 

automatically selected. This is the desired situation in most cases. 
 

If this automatic selection is not desired, then you can specify a suitable 

workspace plane as the reference plane. Subsequently, any surfaces can 

be selected and assigned different values. An automatic selection does 

not occur in this mode.  

Complete draft 

When all selections have been made, pressing the [Enter] key again executes the 

calculation phase, attempting to perform the draft in the desired form. Should the 

algorithm fail due to mathematical (such as unrealistic angles) or algorithmic 

constraints (the surfaces to be tapered must satisfy certain properties in relation to the 

tapering direction), the state before the calculation is made is restored, including any 

selection made. This allows parts of the selection to be changed without having to 

repeat the entire selection. 

Modify or delete entry 

By re-selecting a surface of the CONFIRMED SELECTION (YELLOW), it can be 

assigned a new angle of inclination. The surface is again marked in the colour of the 

CURRENT SELECTION (GREEN); the old value of the inclination angle appears in 

the input line. The adoption of a new value is the same as in the first selection of the 

surface. Assuming an angle value 0 in this context means deleting the CURRENT 

SELECTION (GREEN) from the CONFIRMED SELECTION (YELLOW). 

Shadow draft 

A special case is the choice of a reference surface (RED, with pyramid) in the 3D 

model and the selection of another, adjacent surface, which is tangentially connected 

to the reference surface along the common edge. Because the simple tilting of the 

selected surface along the edge in is not desired in most cases (this would cause the 

tangency to be lost), the program interprets this operation as a shadow shape slope. 
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The angle reference is also done in this case in relation to the tapering direction of the 

reference surface, the shadow is to fall in the shadow of this direction along the 

selected surface, tangency is retained here. The SHADOW DRAFT is subject to 

certain geometric limitations and is not always possible. 

DELETE SURFACES 

 

*Modify toolbar, modify toolbar (ME) 

Menu modify > Delete surfaces 

This function is only available in ELITECAD Mechanics. 

First, the definition to be edited is selected by clicking. Afterwards, the surfaces to be 

deleted are selected by clicking on them. 

The selected surfaces are not only deleted, but the function also tries to close the 

resulting hole in the body by extending the adjacent surfaces. 
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VERIFY 3D TREE 

 

Special functions toolbar 

Menu Extras > Special functions > Verify 3D tree 

This function is only available in ELITECAD Mechanics. 

Basics 

A series of interdependent 3D operations can be 

represented as a tree. The 3D base definitions, 

such as boxes or extrudes or any special parts, 

are located at the lower positions. Each further 

processing step is one level higher in the tree. 

Boolean operations merge multiple branches 

into one. At the top is the current end result. 

 

If a change is now made to an intermediate step, 

generally all dependent results also change. The 

program tries to recalculate all dependent 3D 

operations of a changed definition (unless the 

user sets an operation to "offline"). 
 

Because of these changes, various operations 

defined as intermediate steps generally change, 

or some operations are no longer possible. This 

is especially true for operations related to 

certain edges or faces of the model, such as edge fillets, chamfers or draft operations. 
 

In order not to destroy the model when re-calculating, or to create a wrong model, the 

update is interrupted when an operation fails or cannot be uniquely assigned, such as 

if a rounded or chamfered edge is no longer found or a surface of a draft operation has 

changed. 
 

REMARK 
If an assignment cannot be performed automatically, then the original 

operations are not lost. However, the result is displayed in 3D with a 

blue colour.  

Operation 

With the function VERIFY 3D TREE, the user can manually assign the new 3D objects 

to the previously defined surface and edge operations. The newly assigned operations 

are taken over from there on. 
 

3D TREE INSPECTION works hierarchically. The tests are repeated until all errors 

have been corrected or the user cancels. If an error is not resolved, the test function 

does not pass over this point. The successful completion of the 3D tree check is 

displayed with the message Check completed. 

Step 1 – 2D check 

It is checked whether a 3D basic definition could not be generated from the associated 

2D contour. One reason might be that in a box the modified 2D contour is open or 

intersects itself. The user receives the following message: Model #n cannot be 

CHAMFER 
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generated. Verify 2D model, where #n is the number of the model. The test corresponds 

to the function VERIFY 2D MODEL. 

Step 2 - 3D check 

It is checked whether an error has occurred during further calculation. An error has 

occurred if surfaces or edge operation could not be mapped, or the operation failed 

otherwise. 

If surfaces or edges could not be mapped, the user is prompted to fix it. The originally 

selected surface or edge is displayed with the previous parameters. It can either be 

reassigned or deleted. The remapping takes place with the specified parameters and 

modes. A not found single edge is assigned about a single edge, a single surface not 

found a single surface, etc. 

Step 3 – delete and add 

Once all affected surfaces or edges of a calculation step have been treated this way, 

the user can still modify or extend the entire operation if he wishes. This makes sense, 

since there may well be cases in which the simple assignment of a previous surface or 

edge to a new one does not correspond to the desired result, if, for example, tangential 

gradients have resulted from a change, which should now be taken into account. To 

this end, questionable surfaces and edges can be deleted and reset. Deleting and setting 

works the same as with the corresponding functions ROUND EDGE and DRAFT. 

CONNECT SURFACES 

 

Surfaces tool bar 

Modify menu > Surfaces > Connect 

This function creates a connecting surface between two surfaces. The transition of 

surfaces to the connecting surface can be tangential or edge-on-edge.  
 

The following queries appear after activating this function: 
 

Transition tangential on both surfaces? 

If you confirm this query with "Y", the transition of the surfaces to the connecting 

surface is smooth. Enter "N" and the surface is drawn with sharp edges. 
 

Please click on the surface in the 3D view 

The points of the surfaces that are to be connected can be clicked on with the mouse. 
 

This surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. However, if the purple surface is not the desired surface, respond to the query 

with "N" [Enter]. In this case, the query Please click on the surface in the 3D view 

appears again.  
 

TIP 
If the transition is not tangential, the first query is Please select 

definition. Then click on the border curve in the 3D view and confirm 

that this is correct.  

 WORKSHOP  

Connect surfaces 
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First, create two surfaces with different heights. The exact description can be found in 

the workshop DEFINE SURFACE. 

 

Select the CONNECT SURFACE function. 

Transition tangential on both surfaces? 
 

Confirm with "Y" [Enter]. 

Please click on the surface in the 3D view 
 

Use the mouse to click on the point where you want to connect. 

Make sure that you click on the side of the surface that is to be connected. 

This surface? 
 

Confirm with "Y" [Enter]. 

Please click on the surface in the 3D view 
 

Use the mouse to click on the other surface to which you want to connect. 

Here too, make sure that you click on the side of the surface that is to be connected. 

This surface? 
 

Confirm with "Y" [Enter]. 

The connecting surface is created. 
 

Tangential transition  Non-tangential transition 

  

  WORKSHOP END 

SMOOTH SURFACE 

  

Surfaces tool bar 

Modify menu > Surfaces > Smooth 

This function is used to create a tangential transition between two trans, design or free 

form surfaces. The border curves are retained. 
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view 

Now select the desired surface by clicking on it. 
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This surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. However if the purple surface is not the desired surface, respond to the query 

with "N" [Enter]. In this case, the query Please click on the surface in the 3D view 

appears again. This cycle is continued until positive confirmation is received for the 

query This surface? 
 

Please click on the surface in the 3D view [ENTER=calculation] 

Here you can select another surface by clicking on it, or smooth the interior of the 

selected surface by pressing [Enter]. If another surface is selected, the query This 

surface? appears again (as described above). 
 

Tangential to the first surface? 

If you press "Y" [Enter] the first surface is not changed, and the second is connected 

to the first surface tangentially. If you press "N" [Enter], the transition to both surfaces 

is adapted. 
 

TIP 
Contour or path must be connected to the start or endpoints.  

  
 

 WORKSHOP  

Smooth surface 

Draw two trans surfaces from one path and two contours. The exact description can be 

found in the workshop DEFINE TRANS SURFACE. 

  

Select the SMOOTH SURFACE function. 

Please click on the surface in the 3D view 
 

Now select the desired surface by clicking on it. 

Click on the base surface. 

This surface? 
 

Confirm with "Y" [Enter]. 

Please click on the surface in the 3D view [ENTER=calculation] 
 

Click on the other surface and confirm the query This surface? with [Enter]. 

Tangential to the first surface? 
 

Confirm with "Y" [Enter]. 
 

Before smoothing   after smoothing 
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  WORKSHOP END 

JOIN SURFACE 

  

Surfaces tool bar 

Modify menu > Surfaces > Join 

This function is used to connect trans, design or free form surfaces with a common 

border curve. This is particularly desirable in mould construction, so that one single 

surface can be formed from several individual surfaces, and this one surface can be 

shaped or manipulated further. 

The result is a new surface and the starting surfaces are deleted. The parameters of the 

new surface (e.g. colour) are transferred from the first surface selected.  
 

The following query appears after activating this function: 
 

Please click on the surface in the 3D view [ENTER=calculation] 

Now select a desired surface by clicking on it. 
 

This surface and parameters? 

If you confirm with "Y" [Enter], the surface is included in the calculations. However, 

if the query is confirmed with "N" [Enter] the query Please click on the surface in the 

3D view [ENTER=calculation] appears again. This cycle is continued until positive 

confirmation is received for the query This surface and parameters? 
 

TIP 
 The connecting surfaces must be selected in the order in which they 

are to be joined. 

 The Join surface function works for as many surfaces as you wish, if 

they share a common border curve. 

 Otherwise, Join surfaces only works for two surfaces at a time. To 

connect as many surfaces as you want, you have to repeat the 

function.  
 

EXPLANATION 
If the selected surfaces do not have a common border curve, one of these 

two messages appears in the info window: 
 

 First and second surface have no common border curve. 

 Two of the surfaces have no common border curve. 
 

If joining does not work in principle, the following message appears: 
 

 Merge surfaces cancelled.  
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 WORKSHOP  

Join surface 

Draw two trans surfaces from one path and two contours. The exact description can be 

found in the workshop DEFINE TRANS SURFACE. 

  

Select the JOIN SURFACE function. 

Please click on the surface in the 3D view [ENTER=calculation] 
 

Click on the base surface. 

This surface and parameters? 
 

Confirm with "Y" [Enter]. 

Please click on the surface in the 3D view [ENTER=calculation] 
 

Click on the other surface and confirm the query This surface and parameters? with 

"Y" [Enter]. 
 

The function can now be closed with "Y" [Enter]. 
 

Before joining   after joining 

  

  WORKSHOP END 

LENGTHEN SURFACES 

  

Surfaces tool bar 

Modify menu > Surfaces > Lengthen 

This function is used to lengthen a surface tangentially. 
 

The following query appears after activating this function: 
 

Please select definition. 

Now select a desired surface by clicking on it. 
 

Please click the surface on the desired edge in 3D view 



Chapter 7 – 3D Objects  

www.elitecad.eu  511 

Now the side that you want to lengthen must be specified, by clicking inside the 

surface. 
 

Lengthen surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. However if the purple surface is not the desired surface, respond to the query 

with "N" [Enter]. In this case, the query Please click surface on the desired edge in the 

3D view appears again. 
 

Please enter length 

Now enter the new desired length. 
 

TIP 
For trimmed surfaces, a new surface is created which joins tangentially. 

If the starting surface is not trimmed, the starting surface is lengthened. 

  

 WORKSHOP  

Lengthen surfaces 

Draw a trans surface from one path and one contour. The exact description can be 

found in the workshop DEFINE TRANS SURFACE. 

  

Select the LENGTHEN SURFACE function. 

Please select definition. 
 

Click on the surface you want to lengthen. 

Please click the surface on the desired edge in 3D view 
 

Click on the inner edge of the surface. 

Lengthen surface? 
 

Confirm with "Y" [Enter]. 

Please enter length 
 

Enter a value (200) and confirm it with [Enter]. 
 

Before lengthening  after lengthening 



Chapter 7 – 3D Objects  

www.elitecad.eu  512 

  

  WORKSHOP END 

INVERT SURFACES 

  

Surfaces tool bar 

Modify menu > Surfaces > Invert 

This function can be used to reverse the normal vector direction of a surface.  
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view [ENTER > END] 

Now select one of the desired surfaces by clicking on it. The selected surface is then 

coloured purple. 
 

This surface? 

Confirm this query with "Y" [Enter] and the direction of the normal vectors 

(represented in red) is reversed. However if the purple surface is not the desired 

surface, respond to the query with "N" [Enter]. In this case, the query Please click on 

the surface in the 3D view [RETURN > END] appears again. 
 

TIP 
This preparation of surfaces makes it possible for the radius for all 

surfaces to be entered with the same sign when performing 

TRIM/FILLET. This prevents errors through incorrect inputs. 

  

 WORKSHOP  

Invert surfaces 

First, draw a box and a slanted surface over three points. The exact description can be 

found in the workshops DEFINE BOX and DEFINE SURFACE. 

  

Select the INVERT SURFACES function. 

Please click on the surface in the 3D view [ENTER > END] 
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Click on the slanted surface. 

This surface? 
 

Confirm with "Y" [Enter]. 
 

The function can now be closed with [Enter]. 

Example with Boolean operation: 

Normal vectors upwards  Result after Boolean operation 

  

Normal vectors downwards  Result after Boolean operation 

  

  WORKSHOP END 

PARALLEL SURFACES 

  

Surfaces tool bar 

Modify menu > Surfaces > Parallel 

This function allows you to generate a surface that is the same distance from a given 

surface at one point. 
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view 

Click on the surface. It is then coloured purple. 
 

This surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. If not, confirm the query with "N" [Enter]. You will have another chance to 

select the surface. 
 

Please enter offset 

Enter the desired distance. 
 

TIP 
A positive value is assessed in the direction of normal vectors, a negative 

value is the reverse.   
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 WORKSHOP  

Parallel surfaces 

First, draw a slanted surface over three points. The exact description can be found in 

the workshop DEFINE SURFACE. 

  

Select the PARALLEL SURFACES function. 

Please click on the surface in the 3D view 
 

Click on the surface. 

This surface? 
 

Confirm with "Y" [Enter]. 

Please enter offset 
 

Enter the desired distance (400) and confirm with [Enter]. 
 

The parallel surface is displayed automatically. 

  

  WORKSHOP END 

OUTLINE MODEL 

  

Surfaces tool bar 

Modify menu > Surfaces > Outline model 

Use this function to outline any 2D contour on a surface (e.g. fonts, logos, etc.). 
 

EXPLANATION 
Following the query Which model as border (Select point)? (ENTER = 

Cancel outline), a corresponding 2D model can be clicked on the 

reference point and entered onto a specific surface. 

However, if you want to delete an existing outline model again, you can 

do so with [Enter]. Then click on the surface from which the outline 

model is to be removed.  
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TIP 
For the options APPLY DIRECT and APPLY AS HOLE, the 2D model 

must be closed. Changes to the shape and position of the 2D model 

automatically affect the surface.   

Options 

 

Apply model direct 

 

Use the option APPLY MODEL DIRECT to cut out the surface. The selected model 

remains. 

Apply model as hole 

 

The surface is also cut out with this option, however the model selected is removed 

from the surface. 

Apply model as curve 

 

When the model is applied "as curve", a 3D curve is created, which you can continue 

to edit. The surface is not changed. 

Adjust horizontally 

 

The selected model is adjusted to be the same width as the surface. 

Adjust vertically 

 

The selected model is adjusted to be the same height as the surface. 
 

TIP 
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When you apply the 2D model without adjustment, an attempt is made 

to apply the model to the surface to scale (1:1). (For free form surfaces, 

this is only possible with a distortion). If the model protrudes over the 

edge of the surface, it is scaled.  

 WORKSHOP  

Outline model 

First, draw a slanted surface over three points. The exact description can be found in 

the workshop DEFINE SURFACE. 

Then a circle can be drawn inside the rectangle in a new model. 

  

The following queries appear after activating this function: 

Which model as outline (Select point)? (Enter = Remove outline) 
 

The corresponding 2D model can now be clicked on the reference point. 

Click on point P1 on the circle in the wire model. 

Apply onto which surface (select point) 
 

Now switch to the solid design model and click on point P2 on the surface. This also 

determines the position of the reference point. 

     

  

The options window opens. 

Now click on one of the following options and confirm the window with OK. The 

surface is cut out. 
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Examples with the Adjust option 

    

  

  WORKSHOP END 

DELETE TRIMMING 

  

Surfaces tool bar 

Modify menu > Surfaces > Delete trimming 

This function is used to restore trimmed surfaces that have been edited using the 

function TRIM SURFACES. These surfaces are then re-displayed as untrimmed 

surfaces. 
 

TIP 
To restore trimmed surfaces, they must not have been trimmed using the 

associative function.  
 

After activating this function, select the desired surface by clicking on it. The selected 

surface is then represented in purple. Before it is restored, you must confirm this is 

correct with [Enter]. 

Example 

Origin    Surfaces trimmed  Trimming deleted 
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DELETE SINGLE SURFACE 

  

Surfaces tool bar 

Modify menu > Surfaces > Delete single surface 

Use this function to delete a single surface from a definition. 

After activating this function, select the desired surface by clicking on it. The selected 

surface is then represented in purple. Before it is deleted, you must confirm this is 

correct with [Enter]. 
 

TIP 
Clicking on the surface again deselects it. 

  

Example 

  

SURFACE-DIVISION OPERATION 
 

 

Modify menu > Surfaces > Surface-division operation 

This function is used to divide connecting free form surfaces. After activating this 

function, select the desired object by clicking on it. 
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EXTRACT BORDER CURVE 

  

3D curves tool bar 

Modify menu > 3D curves > Extract border curve 

This function is used to generate 3D NURBS curves from surface borders.  

The following queries appear after activating this function. 
 

Please select definition 

Click on the surface. It is then coloured purple. 
 

Please click on the border curve in the 3D view (ENTER=End) 

Now identify the desired surface border by clicking on it. The selected curve is 

represented in yellow. 
 

This curve? 

If the yellow curve is the desired curve, confirm the query with "Y" [Enter]. 

However, if the yellow curve is not the desired curve, respond to the query with "N" 

[Enter]. In this case, the first query appears again. 
 

Please click on the border curve in the 3D view (ENTER=End) 

Now you can click on another surface. However, this surface must border the current 

border curve (represented in yellow). If this is not the case, the following message 

appears: "Curves are not connected" and the query Please click on the border curve in 

the 3D view (ENTER=End) appears again. 
 

Press [Enter] to end the selection. A NURBS curve and a 2D model that corresponds 

to the projection for this curve in the work plane are then produced. 

 WORKSHOP  

Extract border curve 

First, draw a trans surface. The exact description can be found in the workshop 

DEFINE TRANS SURFACE. 

  

Select the EXTRACT BORDER CURVE function. 

Please select definition 
 

Click on the surface. 

Please click on the border curve in the 3D view (ENTER=End) 
 

Click near the upper curve K1. 

This curve? 
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Confirm with [Enter]. 

Please click on the border curve in the 3D view (ENTER=End) 
 

Repeat the process again with curve K2. 

The new 3D curve is now available for other 3D functions. 

 

  WORKSHOP END 

FILLET CURVES 

 
 

Modify menu > 3D curves > Fillet 

After selecting the 3D curve, you will be asked for a manipulation point. For the point 

specified here, the next point positioned on the curve is searched for, which either 

corresponds to a point or is assigned to a fillet. In the case of a point, a fillet can be 

defined; if a fillet already exists, the existing radius can be changed (radius 0 means a 

corner is restored). 
 

TIP 
To better define the manipulation point, it is recommended to capture 

points on the curve.  

Example 

3D curve with corners Filleted 3D curve 

  

CONNECT CURVES 

  

3D curves tool bar 

Modify menu > 3D curves > Connect 
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Several 3D curves that follow on from each other can be connected into one single 

curve, if the curves adjoin each other. To do this, select the curves one after each other 

using this function and complete the selection with [Enter]. 

SPLIT CURVES 

  

3D curves tool bar 

Modify menu > 3D curves > Split 

After selecting the 3D curve, you will be asked for a partition point. For the point 

specified here, the next point positioned on the curve is identified as the actual partition 

point, and the curve is split there. The splitting operation results in two part curves that 

are each assigned to a model. 
 

TIP 
To better define the partition point, it is recommended to capture points 

on the curve.  

 

 

DELETE SINGLE CURVE 

  

3D curves tool bar 

Modify menu > 3D curves > Delete single curve 

You can use this function to delete single 3D or section curves. Start the function and 

then click on the desired curve. 

It is deleted. 
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FILLET SURFACES 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Fillet 

This function can be used to fillet a surface with as many surfaces as you wish. 
 

The following queries appear after activating this function: 
 

Fillet radius? 

The desired radius is entered in user units. 
 

Associative? (Y/N) 

If this query is responded to with N, the surfaces are trimmed and filleted. The fillet 

surface is created as a separate definition. The radius can no longer be changed. If 

"associative" is selected, the surfaces involved are combined into one object. This 

object also has the fillet surface. There is an association with the starting surfaces, so 

that each change results in the fillet being recalculated. The fillet radius can be changed 

in the properties bar. 
 

Fillet which surface? 

Now select the surface to be filleted by clicking on it. With surfaces that interpenetrate 

each other there are four options for filleting. The position of the points clicked on the 

surfaces determines the position of the fillet surface. Filleting happens in the direction 

of the points. 
 

Fillet using which surface? (ENTER = End) 

Now you can select other surfaces to be filleted by clicking on them. Once all surfaces 

are selected, this function is closed with [Enter]. 
 

TIP 
 At least two surfaces must be specified, otherwise the message "Only 

one surface was specified!" appears. 

 If it is not possible to fillet the surfaces, the message "Filleting 

cancelled" appears. 

 Delete filleting: 

 If the fillet was created associatively, it can be removed again using 

the 3D DELETE function. Otherwise, it is restored when the fillet 

surface is deleted. 

 Associative filleting: 

 Changes to the starting surface can only be correctly recalculated if 

no additional surfaces are affected by the filleting. 

 If a surface is filleted with several other surfaces, you must make sure 

that these surfaces connect to each other tangentially in the fillet area. 

  

 WORKSHOP  

Fillet surfaces 

First, draw a circle with a radius of 100 cm and use it to define a box. The exact 

description can be found in the workshop DEFINE BOX. 
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Select the FILLET SURFACES function. 

Fillet radius? 
 

Enter the value 50 cm and confirm with [Enter]. 

Associative? (Y/N) 
 

Confirm with "Y" [Enter]. 

Fillet which surface? 
 

Click on the lateral surface with your mouse. 

Fillet using which surface? (ENTER = End) 
 

Click on the slab surface and end the function with [Enter]. 

  

  WORKSHOP END 

TRIM SURFACES 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Trim 

This function can be used to trim a surface with as many surfaces as you wish. 
 

The following queries appear after activating this function: 
 

Associative? (Y/N) 

If this query is responded to with N, the surfaces are trimmed. This process can no 

longer be changed. If "associative" is selected, the surfaces involved are combined into 

one object. There is an association with the starting surfaces so that each change results 

in the trim being recalculated. 
 

Trim which surface? 

Now select the surface to be trimmed by clicking on it – it is then coloured purple.  

With surfaces that interpenetrate each other there are four options for trimming. The 

section curve splits each surface into two halves. The surfaces must be clicked on each 

side that is to remain after the operation. 
 

Trim using which surface? (ENTER = End) 
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Now you can select other surfaces to be trimmed by clicking on them. Once all surfaces 

are selected, this function is closed with [Enter]. The result is that the surfaces are 

trimmed and the section curve displayed. 
 

TIP 
 At least two surfaces must be specified, otherwise the message Only 

one surface was specified! appears. 

 If it is not possible to trim the surfaces, the message "Trimming 

cancelled" appears. 

 Delete trimming: 

 If the trimming operation was created associatively, it can be 

removed again using the 3D DELETE function. Otherwise, it is 

restored when the section curve is deleted.  

 WORKSHOP  

Trim surfaces 

First draw an extrude and a slanted surface over three points. The exact description 

can be found in the workshops DEFINE EXTRUDE and DEFINE SURFACE. 

  

Select the TRIM SURFACES function. 

Associative? (Y/N) 
 

Confirm with "Y" [Enter]. 

Trim which surface? 
 

Click on the outer edge of the slanted surface. 

Trim using which surface? (ENTER = End) 
 

Click on the base edge of the extrude and end the function with [Enter]. 

  

  WORKSHOP END 
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CHAMFER SURFACES 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Chamfer 

This function can be used to chamfer a surface with as many surfaces as you wish. 
 

The following queries appear after activating this function: 
 

Chamfer distance? 

The desired distance is entered in user units. 
 

Chamfer angle? (0:symmetric) 

The desired angle is entered in user units. 
 

Associative? (Y/N) 

If this query is responded to with N, the surfaces are trimmed and chamfered. The 

chamfer surface is created as a separate definition. The chamfer distance can no longer 

be changed. If "associative" is selected, the surfaces involved are combined into one 

object. This object also has the chamfer surface. There is an association with the 

starting surfaces, so that each change results in the chamfer being recalculated. The 

chamfer distance can be changed in the properties bar. 
 

Chamfer which surface? 

Now select the surface to be chamfered by clicking on it. With surfaces that 

interpenetrate each other there are four options for chamfering. The position of the 

points clicked on the surfaces determines the position of the chamfer surface. 

Chamfering happens in the direction of the points. 
 

Chamfer using which surface? (ENTER=End) 

Now you can select other surfaces to be chamfered by clicking on them. Once all 

surfaces are selected, this function is closed with [Enter]. 
 

TIP 
 At least two surfaces must be specified, otherwise the message Only 

one surface was specified! appears. 

 If it is not possible to chamfer the surfaces, the message "Chamfer 

cancelled" appears. 

 Delete chamfer: 

 If the chamfer was created associatively, it can be removed again 

using the 3D DELETE function. Otherwise, it is restored when the 

chamfer surface is deleted.  

 WORKSHOP  

Chamfer surfaces 

First, draw a circle with a radius of 100 cm and use it to define a box. The exact 

description can be found in the workshop DEFINE BOX. 
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Select the CHAMFER SURFACES function. 

Chamfer distance? 
 

Enter the value 50 cm and confirm with [Enter]. 

Chamfer angle? (0:symmetric) 
 

Enter the value 50 and confirm with [Enter]. 

Associative? (Y/N) 
 

Confirm with "Y" [Enter]. 

Chamfer which surface? 
 

Click on the lateral surface with your mouse. 

Chamfer using which surface? (ENTER=End) 
 

Click on the slab surface and end the function with [Enter]. 

  

  WORKSHOP END 

SECTION CURVE 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Section curve 

This function can be used to section a surface with as many surfaces as you wish and 

then calculate their intersection lines. 
 

TIP 
 At least two surfaces must be specified, otherwise the message "Only 

one surface was specified!" appears. 

 If it is not possible to section the surfaces, the message "Sectioning 

cancelled" appears.   
 

The following queries appear after activating this function: 
 

Associative? (Y/N) 
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If you respond to this query with "N", the surfaces are retained and the section curve 

is created in a new model. This process can no longer be changed. If "associative" is 

selected, the surfaces involved are combined into one object. There is an association 

with the starting surfaces, so that each change results in the section curve being 

recalculated. 
 

Section which surface? 

Now select the surface to be sectioned by clicking on it. 
 

Section using which surface? (ENTER = End) 

Now you can select other surfaces to be sectioned by clicking on them. Once all 

surfaces are selected, this function is closed with [Enter]. 

Example: 

   

TRIM/FILLET 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Trim/Fillet 

This function can be used to: 
 

Fillet a surface with as many surfaces as you wish. The user can choose from several 

kinds of execution. 

Trim a surface with as many surfaces as you wish. This is also possible with an offset. 
 

TIP 
 At least two surfaces must be specified, otherwise the message "Only 

one surface was specified!" appears. 

 To trim a surface with an offset, a radius must be specified and the 

FILLET option switched off. 

 If it is not possible to trim/fillet the surfaces, the message "Trim/Fillet 

cancelled" appears.  

 If a surface is filleted with several other surfaces, you must make sure 

that these surfaces connect to each other tangentially in the fillet area. 

  
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view [ENTER=calculation] 

Now select the desired surface by clicking on it. 
 

The following parameter window appears. 
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Trim:  

The selected surface is trimmed. 

Fillet: 

A new surface with the specified radius is added to the 

surface selected. If neither option (trim/fillet) is checked, the 

selected surface remains unchanged. 

+/-: 

This switch indicates the direction of the radius. "+" 

indicates the positive normal vector direction. 

Trim cross: 

If this option is activated, each part area on which the cross 

hair is located is trimmed. Otherwise, these part areas are 

retained. This check box only takes effect in combination 

with trimming. 

Fill corners: 

If this option is activated, the fillet surface is continued up 

to the edge of the first surface. 

Precision: 

The values set here for level and tolerance should not be 

changed. 

Angle: 

The smaller the angle, the more precise the render (time!)  

Tolerance: 

Precision for the transition of the fillet surfaces (in user 

unit). 
 

The values set apply to the selected surface. If the surface 

that has turned purple is the desired surface, press the YES button. However if the 

purple surface is not the desired surface, press the NO button. 
 

"Please click on the surface in the 3D view [ENTER=calculation]" 

Now you can select another surface. (As described above) 
 

Once all surfaces are selected, this function is closed by pressing [Enter] following the 

query "Please click on the surface in the 3D view [ENTER=calculation]". 

The selected surfaces are then trimmed and/or filleted. 

 

 

Example: 
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VARIABLE TRIMMING/FILLET 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Variable fillet 

This function can be used to: 
 

Fillet a surface with as many surfaces as you wish. The user can choose from several 

kinds of execution. 

Trim a surface with as many surfaces as you wish. This is also possible with an offset. 
 

TIP 
 At least two surfaces must be specified, otherwise the message "Only 

one surface was specified!" appears. 

 To trim a surface with an offset, a radius must be specified and the 

FILLET option switched off. 

 If it is not possible to trim/fillet the surfaces, the message "Trim/Fillet 

cancelled" appears.  

 If a surface is filleted with several other surfaces, you must make sure 

that these surfaces connect to each other tangentially in the fillet area. 

  
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view [ENTER=calculation] 

Now select the desired surface by clicking on it. 
 

The following parameter window appears. 
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Trim:  

The selected surface is trimmed. 

Fillet: 

A new surface with the specified radius is added to the surface 

selected. If neither option (trim/fillet) is checked, the selected 

surface remains unchanged. 

Radii: 

Several radii (in user units) can be entered here. It is only 

possible to enter one radius per row. 

+/-: 

This switch indicates the direction of the radius. "+" indicates 

the positive normal vector direction. 

Trim cross: 

If this option is activated, each part area on which the cross 

hair is located is trimmed. Otherwise, these part areas are 

retained. This check box only takes effect in combination with 

trimming. 

Fill corners: 

Currently not supported 

Precision: 

The values set here for level and tolerance should not be 

changed. 

Angle: 

The smaller the angle, the more precise the render (time!)  

Tolerance: 

Precision for the transition of the fillet surfaces (in user unit) 
 

The values set apply to the selected surface. If the surface that has turned purple is the 

desired surface, press the YES button. However if the purple surface is not the desired 

surface, press the NO button. 
 

"Please click on the surface in the 3D view [ENTER=calculation]" 

Now you can select another surface. (As described above) 
 

Once all surfaces are selected, this function is closed by pressing [Enter] following the 

query "Please click on the surface in the 3D view [ENTER=calculation]". 

All curves with constant radii are then displayed on the screen, and the following query 

appears: 
 

Please click points on the guide curve [ENTER=calculation] 

Now indicate all points, in the desired order, on the curves displayed by clicking on 

them. Each individual point is checked with the query "This point?" and confirmed 

with "Y/N". Press [Enter] to end the selection of points. 

 

Please enter interpolation type 0=point,1=tangent,2/3=radius 

The interpolation type must be specified here by entering the corresponding numbers. 
 

Point: Points are connected by lines 

Tangent, radius: Points are connected by flat curves 
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Example: 

  

INVERT TRIMMING 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Invert trimming 

This function can be used to select the remaining surface (inverse surface). This means 

that this function saves you from having to redefine incorrectly trimmed surfaces. 
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view 

Now select the surface to be trimmed by clicking on it – it is then coloured purple.  
 

Invert surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. However, if the purple surface is not the desired surface, respond to the query 

with "N" [Enter]. In this case, the query Please click on the surface in the 3D view 

appears again. This cycle is continued until positive confirmation is received for the 

query Invert this surface? 
 

Then the desired surface is inverted. 

Example: 

Incorrectly trimmed surface  Inverted trimming 
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BLEND CORNER 

 

Fillet tool bar 

Modify menu > Fillet surfaces > Blend corner 

This function is used to fillet three converging fillet surfaces. 
 

The following queries appear after activating this function: 
 

Please click on the surface in the 3D view 

Now select a fillet surface by clicking on it. The selected surface is then coloured 

purple. 
 

This surface? 

If the surface that has turned purple is the desired surface, confirm the query with "Y" 

[Enter]. However, if the purple surface is not the desired surface, respond to the query 

with "N" [Enter]. In this case, either the query Please click on the surface in the 3D 

view appears again, or if several surfaces are possible, the next is proposed. This cycle 

is continued until positive confirmation is received for the queries This surface? 
 

Then the blend corner is created. 

Example: 

  

MODIFY RESOLUTION 

 

 

Settings menu > Resolution 

This function is used to configure the parameters for 3D resolution. You can choose 

between equal resolution and curve-dependent resolution. The analytical data model 

with NURBS is an exact description of curves and surfaces. For the graphic display, 

facets must be harmonised – however the resolution representation can be as high as 

you wish. The higher the resolution representation, the better the graphics but the 

longer the rendering time. 
 

There are multiple options for configuring the detail of depiction. 

Configuring the parameters for each definition individually: 

In the properties bar for the relevant definition 

Tool bar * Modify > 3D OBJECT PARAMETERS 

MODIFY menu > 3D OBJECT PARAMETERS 

Configuring the parameters globally: 

SETTINGS menu > RESOLUTION 
 

This has the following advantages: 
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Using global resolution, high or low resolution can be quickly configured for the entire 

image. If individual parameters are changed, an individual object can be represented 

in high resolution without requiring a lot of rendering time for the others.  

Parameters 

 

Use object dependent parameters 

The depiction resolution configured here is used as a default setting for new 3D 

objects. 

Use global parameters 

If this option is activated, the configured values for depiction are used for all 3D 

definitions. If this option is not activated, the parameters entered for the definition are 

used for depiction. 
 

Use the EXTENDED option to differentiate between different calculation modes. In 

addition, there is the AUTOMATIC ZOOM option. If this option is activated, complex 

3D objects are only exactly displayed if they are zoomed in. This has an impact on 

performance speed. 

Optimal 

 

Depiction 

Use the slider to move from low to high depiction. 
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Limit for small radials 

Use the slider to move from a small to a large limit. 

Curvature dependent resolution 

 

Curvature-dependent resolution means that the surfaces are only divided where a 

configurable curvature value is exceeded. Sufficiently flat facets are not divided any 

further. This results in the number of points being considerably smaller than with equal 

resolution, and dynamic movements are faster. 

Angle 

The tolerance angle indicates to what maximum degree the surface normal may differ 

to the left and right edge of a facet (or above – below). The tolerance angle can also 

be considered being the maximum change of one facet in regards to the adjoining facet. 

The smaller the tolerance angle, the higher the resolution.  

 

Uniform resolution 
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EXPLANATION 
NURBS surfaces are made up of segments. A straight part or a quadrant 

is normally converted into one segment (e.g. the lateral surface of a 

cuboid or a cylinder comprises four segments).  

Surface 

The surface resolution indicates how often a segment is to be divided. A rectangular 

surface can be divided in two directions at different resolutions. The directions are 

usually referred to as U and V. In general, the U resolution is the direction of the model 

and the V resolution the extrude or rotation direction. With free form surfaces made 

up of two, three or four border curves, the U direction is generally the contour and the 

V direction the path. 

Border 

The border resolution indicates to what degree the border of a facet should be divided. 

This value is also used for segmenting trimming curves. 

OK 

This function applies the values and then removes the entry mask from the screen. 

Apply 

This function applies the configured values without removing the entry mask from the 

screen. 

Cancel 

This function removes the dialog window from the screen without adopting the values. 
 

TIP 
Optimisations: 

For some surfaces, the resolution is optimised. It is of no use 

fragmenting a planar rectangular surface into several facets – quite the 

contrary, as this increases processing time and memory usage. For 

surfaces that are planar in at least one direction (polygon, extrude, box), 

the configured resolution is ignored. A cuboid does not need to be 

divided further in the direction of the extrude – surface resolution 1 

would suffice. The resolution can also be kept lower for a cylinder. The 

lateral surface is fragmented into eight facets (curved) by default, with 

a high-resolution border. However, to give users the chance to 

implement their settings for optimal graphics, optimisation is switched 

off for surface resolution > 10.  

MODIFY FACET COLOUR 

 

Modify tool bar (ME) 

 

This function can be used to change the colour of a 3D object or even single colours 

in a free definition (also special parts from CAD400, DXF or ELITECAD V4) or of 

special parts from ELITECAD V7. 
 

After activating this function, select the colours to be changed by clicking on them, 

and assign another colour by entering the colour number or using the menu (m). 
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ENTRY MODE 

 

Change toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. This switch controls if certain functions consider just the 

current object/model or the current image. Hence, some operations can be applied to a 

complete selection. In general, this behaviour is achievable with selection of multiple 

objects without this switch too. 
 

After activation of this function, the current setting is displayed in the status bar: 

3D-Definitions are related to ACTIVE MODEL 

3D-Definitions are related to IMAGE 

If the option is active, a notification in the property bar is displayed in the status bar. 

WARNING: All entries relate to all models in the IMAGE! 

CHANGE WIREFRAME COLOUR 

 

3D toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. It works in dependence of the switch ENTRY MODE. 
 

For 3D objects that are created by a 2D contour, the colour of the edges is taken from 

the colour of the 2D contour. There are also 3D objects that exist without 2D contour, 

like free definitions or surfaces that are imported via 3D interfaces. In order to make 

these objects better distinguishable by their colour this function is used to assign a new 

edge colour for a 3D object. 

CHANGE ROTATION ANGLE 

 

3D toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. It works in dependence of the switch ENTRY MODE. 
 

This function is used to add a new start and end angle for 3D definitions created as 

ROTATION BOX or ROTATION EXTRUDE. 
 

After activation of the function the start and end angle for the rotation is queried. The 

angles are entered in degrees and confirmed with [Enter]. 
 

A start angle of 0 degrees and an end angle with 360 degrees describe a complete 

rotation. If no full rotation is necessary, the direction of rotation is essential (sign!). 

CHANGE ROTATION AXIS 

 

3D Toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. It works in dependence of the switch ENTRY MODE. 
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After activation of the function the first and second point of the new rotation axis have 

to be entered. 3D definitions created as ROTATION BOX or ROTATION EXTRUDE 

are rotated around this new axis. 

CHANGE SIZE 

 

3D toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. It works in dependence of the switch ENTRY MODE. 
 

This function is used to change the size of 3D definitions created as PLANAR 

SURFACE, EXTRUDE or BOX. 

After activation of the function, the height (Z coordinate) of the lower and upper 

limitation plane is queried. 
 

1. Plane is parallel to the workspace: 

 The height is entered as a numerical value (in current units). 

 The height is entered by snapping a height point in the graphics window (CAD 

snap mode). 
 

2. Plane is not parallel to the workspace (enabled by entering "e" or "f"): 

 With "e", the plane is defined by three points (point entry as number or CAD 

snap mode). 

 With "f", a plane is defined by selecting a surface in the graphics window. 

CHANGE COLOUR 

 

3D toolbar 

 

This special function is mainly intended for the usage with the classification structure 

in ELITECAD Mechanics. It works in dependence of the switch ENTRY MODE. 
 

This function is used to change the colour and transparency of 3D definitions. 
 

After activation of the function a new colour and/or transparency is entered by the new 

colour number (0-1024) and transparency value (0-100%; 0 ... opaque). 

SECTIONS 

 

Extras tool bar 

Extras menu > Sections 

This function is used to generate a planar section using the current 3D image. The 

current work plane is always used as the section plane. 
 

The following settings window appears after activating this function. Select the desired 

option and close the window with OK. The intersection is calculated. 
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Section line 

 Used to create a section profile from 3D objects as a 2D contours. A new 2D 

object is created for each surface. 

Surface section 

 Used to trim the current visible objects. 

Volume section 

 Used similarly to the surface section to trim the current visible objects, whereby 

additional end surfaces are created. 

Place result in top view: 

The result of the section can be placed either in the current work plane or in the top 

view. This option is only possible with section lines. 

Hatch section areas: 

If this option is selected, hatching is created for the section area with the current 

hatching parameters. This option is only possible with volume sections. 
 

TIP 
 The original part (3D model) is not changed. The section is created 

as a separate object. The current layer name is used for newly created 

objects. If the layer name has not yet been defined, it is stored with 

cut. The resulting model receives the attribute object= cutline, 

cutvolume, cutsurf, depending on the section type.  

EXPLOSION 

 

Extras toolbar, view toolbar (ME) 

Menu Extras > Explosion 

This function is only available in ELITECAD Mechanics and is used to create an 

exploded view of the currently visible 3D model. 
 

When creating an explosion view the positions of the 3D objects are shifted in space 

without rotation or resizing. The positions of the 3D objects are scaled relative to the 

origin of the current workspace. 



Chapter 7 – 3D Objects  

www.elitecad.eu  539 

Different values can be entered for different directions.  

Factor < 1 => the design model is shrunk 

Factor = 1 => the design model remains unchanged 

Factor > 1 => the design model is stretched 

A scaling may be reverted by the invers factor (e.g. the factor 2 is inverted by the factor 

0.5). 

Only visible objects are considered. Hence, the design model is exploded very flexibly 

through multiple calls of the function with different 3D objects visible. 
 

REMARK 
This functions is not intended for visualisation purposes only, it changes 

the design model. 2D elements remain unchanged. 3D definitions 

change their position. If you want some objects to be keep their position 

relative to each other, you have to combine them into a special part first.

  

DEFINE SPECIAL PART 

 

Extras tool bar 

 

This section is used to combine the current 3D image into a single new object with 3D 

information.  
 

After activating this function, you will be prompted: 
 

2D display with rectangle? 

If the 2D display of the special part is to be drawn as a defining rectangle, confirm the 

query with "Y" [Enter]. If you do not want a 2D display, respond to the query with 

"N" [Enter]. 
 

TIP 
The 3D objects that are combined into one special part can no longer be 

edited in their original form. The new special part object is converted 

into a free definition and only its colour, transparency and resolution can 

be changed.  
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HIDDEN LINE 

 

Extras tool bar 

Extras menu > Hidden line 

This function is used to calculate a 2D image from 3D objects. 
 

The result is converted into a new 2D model and a new layer (hidden line), i.e. copied 

into the 2D data format and entered in the selected plane.  

This new 2D model can now be used with all the 2D functions.  
 

The following settings window appears after activating this function. Select the desired 

option and close the window with OK. The 3D image is then calculated as hidden line. 

 

Quality 

Here you can select the quality of the hidden line. If you are not satisfied with the 

result, the quality can be increased. 

Intersection lines 

If this option is activated, the surfaces of the model are intersected with each other to 

obtain intersection lines. (Lengthens rendering time!) 

Hiddenline with pen 

Here you can configure whether the 2D image is rendered with a pen or whether the 

edging colours of the 3D object are used. The pen can be configured. 

Masked dashed lines 

If you want to include hidden lines in the rendering, this option can be activated. The 

pen and line type can be configured. 
 

TIP 
The rendering only involves the parts of the 3D object that are visible 

on the screen.  

SURFACE TO SURFACE 

 

Manipulation tool bar 

 

Use this function to position objects by assigning one surface to another. The selection 

must be made beforehand. 
 

The following queries appear after activating this function: 
 

Copy? 
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If the current selection is to be copied, respond to this query with "Y" [Enter]. If you 

do not want a copy, respond to the query with "N" [Enter]. 
 

Assign which surface? 

The surface that is to be reassigned must be clicked on in the 3D view. 
 

Assign to which surface? 

Now click on the surface to which the previously selected surface should be assigned. 

The action is performed after confirming the confirmation prompt To this surface? 
 

TIP 
This function is only possible for the following definitions: 

Surface, extrude, box, rotation extrude and rotation box 

Position and orientation of the assigned object on the selected surface 

are undefined and can be changed using the manipulation functions. 

  

MODIFY SMOOTHING TOLERANCE ANGLE 

 

Surfaces tool bar 

 

With free form surfaces, buckles in the borders of the surface can be sustained or 

ignored. The tolerance angle indicates up to what value the buckles are ignored. 
 

After activating this function, you will be prompted: 
 

Please enter tolerance angle (degree) for internal smoothing 

Enter the desired value. The default value is 5 degrees. 

3D OBJECT HISTORY 

 

Info tool bar 

Info menu > 3D obj. evolution 

This function is used to analyse the evolution history of a 3D object, which was created 

from associative operations. 
 

The following query appears after activating this function: 
 

Analyse which definition? 

Select the desired object by clicking on it. The entire 3D object is represented in purple 

and the entry window appears. 
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In the middle text field, the type (e.g. MINUS OPERATION) of the selected definition 

is displayed. The top text field contains a list of links to objects, which the object 

represented in purple helped to create. Initially this field is empty. The bottom text 

field contains a list of links to those objects that helped to create the object represented 

in purple. 

If both the top and bottom text fields are empty, the object exists on its own and does 

not depend on other objects. 
 

Use the PARAMETERS button to display and modify the parameters of the purple 

object (see also MODIFY > 3D object parameters). 
 

If the purple object was created through an associative operation (e.g. section, join, 

minus operation, fillet operations), you can scroll back one step in the creation process 

by clicking "v". The purple object becomes invisible and all objects that helped to 

create it become visible (e.g. all A and B parts in a Boolean operation). The first object 

in the list becomes purple and its type is displayed in the middle text field. The previous 

purple object moves to the top list and the links associated with the current purple 

object are displayed in the bottom list.  
 

You can switch between A and B definitions using "<" and ">", and the middle and 

bottom text fields are updated accordingly. 
 

Use the "^" button to move up a level. You can scroll through the creation process until 

no more dependencies can be found. 
 

Use the buttons OK and CANCEL to close the window; the original object is now 

visible again. 
 

TIP 
 It is not just possible to change the parameters of visible objects – 

you can also modify their 2D geometry. 

 If the middle object is the result of a Boolean operation, there is one 

entry for each A and B part in the bottom list. 

 For associative fillets, an entry is provided for each surface.  
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LIST 3D COLOURS 

 

Info tool bar 

 

This function lists the 3D colours used in the design model in the info window. 

MODIFY 3D COLOURS GLOBALLY 

 

* Modify tool bar 

 

This function can be used to change one colour to another colour for all objects that 

are visible on the screen. 

Select the colour to be changed by clicking on it or entering the colour number. The 

new colour is then assigned by entering the colour number or using the menu (m). 
 

TIP 
The exact description of the colour selection menu can be found in the 

chapter 1.4 Pen colours.  
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7.4 DELETE 

DELETE 3D 

 

Manipulate tool bar 

 

This function is used to delete the 3D definitions. 
 

After activating this function, select the desired definition by clicking on a surface or 

curve. The selected surface is then represented in purple. Before it is deleted, you must 

confirm this is correct. 
 

TIP 
If a 3D definition is selected with Selection element part ([Alt] key 

pressed), the 3D definition can also be deleted with [Del]. Multiple 

selection is possible with [Shift].   

DELETE 3D BY TYPE 

These special functions are mainly intended for the usage with the classification 

structure of ELITECAD Mechanics. They delete exactly those 3D definitions, which 

have a specific type depending on the switch ENTRY MODE. The 2D data remains. 
 

TIP 
Consider the switch ENTRY MODE before deleting! Either the 

appropriate 3D definition in the active object is deleted or all appropriate 

3D objects that are visible on the screen.  
 

The following functions are working similarly and differ only in the type of the 3D 

definition to be deleted. 

Delete planar surface 

 

3D toolbar 

 

Delete extrude 

 

3D toolbar 

 

Delete box 

 

3D toolbar 

 

Delete rotation extrude 

 

3D toolbar 
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Delete rotation box 

 

D toolbar 

 

Delete trans surface 

 

Freeform  / curve toolbar 

 

Delete trans box 

 

Freeform  / curve toolbar 

 

Delete design surface 

 

Freeform  / curve toolbar 

 

Delete design box 

 

Freeform  / curve toolbar 

 

Delete free form 

 

Freeform  / curve toolbar 

 

Delete 2-view curve 

  

Freeform  / curve toolbar 

 

Delete 2-view object 

 

3D toolbar 

 

Delete 3-view object 

 

3D toolbar 

 

 Delete Boolean operation 

  

Change toolbar 
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8.1 REPRESENTATION LEVEL 

The display of the 3D and architecture objects in the floor plan and section is 

controlled by using representation levels. The appearance and label of windows and 

doors, room stamps and architectural dimensioning vary according to the selected 

representation level. 
 

The representation level does not need to be automatically linked to the scale but can 

be selected according to the planning stage (design, permission, execution, etc.). These 

planning stages are of course linked to a certain SCALE setting, so the hatch, text and 

dimension parameter settings as well as the preciseness of the details of the AR Objects 

must be taken into account accordingly. 

SELECT REPRESENTATION LEVEL 

 

The representation level is defined in the status bar. 
 

The state "without representation level" specifies that the file will be worked on 

without representation levels. The possibility of implementing the planning stages "at 

the touch of a button" from the entry planning to the work drawing, for example, is 

then no longer applicable. The settings of the respective functions are used under 

"without representation level". 

Representation level settings 

  
Settings tool bar 

Menu > Settings > Representation levels...  
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The fields Name, Code and Scale represent the values of the active representation 

level. The code is a unique characteristic as the names of the representation levels 

mostly stay the same during import or export. 

Parameters 

The detailed settings of the active representation level. 

New... 

Creates a new EMPTY representation level. Check whether it is easier to use the 

COPY function and then make changes. When creating a representation level, the 

parameter's storage type under SETTINGS > OPTIONS > SYSTEM > 

CONFIGURATION determines whether the representation level is created for User 

or Global. 

Copy 

Creates a new representation level with the same settings as the active representation 

level.  

Delete 

Removes the active representation level. If the message "not authorised" appears when 

you delete a representation level, this means that in this case it is a global 

representation level, which can only be removed by an administrator. 

Import  

You can import a representation level using this function. This way, a representation 

level that you have created yourself can be read on different workstations.  

Export  

Using this function, a representation level can be saved and read on other workstations. 
 

When creating a new file, a dialog window opens in which the name, a unique code 

and optional scale for the representation level must be entered. 

 

OK creates the name of the representation level. All specified materials (accessible via 

the Parameter button) are adopted into the new representation level and must now be 

adjusted according to your needs. 

Parameters 
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Clicking the parameter icon, takes you to the settings dialog window of the active 

representation level (see display in Status-Window)  

Materials management 

The line widths and hatch parameters used to display the materials of walls, floors, 

girders, chimneys, stairs and columns in the floor plan and section views are defined 

in materials management. 

 

Existing materials can be selected from the selection box where the pen and hatch 

parameters always refer to the active material. The hatch parameter can be selected 

from <List..>, i.e. from a list of all of the settings created under Hatch – Parameter. 

If the hatch field is empty, no hatch is implemented. 

Materials can also consist of two hatches: a grey preview hatch and a line hatch over 

it. 

 

If this option is activated, the hatch rotates with the material. 

     
The "insulation" material rotates with the wall; the "brick" material does not. 

 

Should a new material be created, you can enter the desired name into the selection 

box, specify the pen and hatch parameters and confirm with <Save modifications>. 

This material name is now equally available in all of the other representation levels 

and can be individually customised to each representation level. 

<Delete> removes the active material from all of the representation levels. 

Window parameters 

The settings for displaying windows in 2D and 3D can be defined here. In addition, 

you can also modify the type of label and the text parameters to be used, the length 

and the pen for the centre line, and the pen and line types for the lintel lines. 
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Display 

 

The window profile can be generated in the floor plan as a 1-dash, frame or off-centre 

frame depiction, in which the lines for the frame, casement and dummy f./joint 

(different gross clearance/finished clearance) can be switched on or off and whose pens 

can be changed. The frame, muntins, exterior and interior windowsills are individually 

routed to create a 3D depiction. 

Label 

 

The centre line dimensioning of the window size can take place in the gross or finished 

clearance or as an absolute marker for the parapet and lower edge of the lintel (Swiss 

standard). 

The parapet height's label is toggled between the gross or finished parapet and the text 

formatting is entered (< > is the placeholder for the value). Please also refer to Window-

Label parameters. 

Under <List..> you can select the text parameters to be used (all of the settings created 

under Text parameters).  

In addition, you can deactivate the label of the size entry and parapet height (tick 

boxes). 
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Height markers 

 

If the windows are worked on using the height markers, you can specify here which 

markers are to be written with which text. The characters <> are placeholders for the 

calculated value. 

Centre line 

 

The length of the centre line can be defined in absolute lengths or as a distance 

dimension to the label text. The value of this is always given on the plan in mm. The 

depiction of the centre line can be switched off using the tick box, however the length 

of the centre line applies to the distance of the label to the wall outer edge, even when 

it is not displayed. 
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Lintel lines 

 

Here you can set the pen and line types of the lintel lines for the hidden and visible 

depiction (see window lintel). 

You can then preserve dashed lintel lines in, for example, a window without parapet 

in one representation level and not in another representation level (with pen 0 = not 

printed). 

Door parameters 

The settings for the depiction of doors in 2D and 3D can be defined here. In addition, 

you can also set the type of label and the text parameters to be used, the length and the 

pen for the centre line, and the pen and line types for the lintel lines. 

Display 

 

Door leaf and door jamb can be represented in either 2D or 3D. The door's split level 

line (stop line) can be configured with the pen/line type and can be suppressed. The 

split level line can then be shown or suppressed in a representation level. 



Chapter 8 – Architectural objects  

www.elitecad.eu 553 

Label  

 

The centre line dimensioning of the door size can take place in the gross or finished 

clearance, in floor clearance (OKFFB up to UK lintel) or as an absolute marker for 

threshold and lower edge of the lintel (Swiss standard). The lintel height's label is 

toggled between gross or net lintel height or lintel (gross) FFL and the text formatting 

is entered (< > is the placeholder for the value). 

Fire proofing 

 

Optionally to the door labelling an additional fire proofing labelling may be depicted. 

Any symbol that follows the ‚~‘ sign, will be depicted subscripted. The ‚~‘ sign itself 

is not depicted. 

You can select the text parameters to use under <List..>.  

In addition, you can deactivate the label of the size entry and parapet height (tick 

boxes). 
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Centre line 

 

The length of the centre line can be defined in absolute lengths or as a distance 

dimension to the label text. The value of this is always given on the plan in mm. The 

depiction of the centre line can be switched off using the tick box, however the length 

of the centre line applies to the distance of the label to the wall outer edge, even when 

it is not displayed. 

Lintel lines 

 

Here you can set the pen and line types of the lintel lines for the hidden and visible 

display (see lintel). 

You can then preserve dashed lintel lines in doors in one representation level and not 

in another representation level (with pen 0 = not printed).  

Room parameters 

Room labels and room groups are linked with the representation level. The parameter 

name defines the label parameter saved under the ROOM function. This is also true of 

the ROOM GROUP.  
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You can select the desired parameter under <List..>. The set parameters for the ROOM 

and ROOM GROUP functions are loaded when the representation level is converted. 

Dimension parameters 

On this dialog window, you specify the dimension parameters for the parameter group 

1-3 to be used during architectural dimensioning. 

 

The dimension parameter must be selected from <List..>, i.e. from a list of all of the 

settings created under the function DIMENSION PARAMETERS > PARAMETER 

NAME. Selecting a representation level automatically converts the active dimension 

parameter. 

The three parameter records are linked with the parameter groups P1, P2, P3 in the 

dimension properties bar.  
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3D objects 

Free 3D definitions (box, trans boxes, etc.) are subject to the representation level and 

therefore allow a depiction that is true to the material for views, sections and floor 

plans at the appropriate scale. 

 

You can select the desired parameter under "Parameter name". This set parameter is 

then loaded for the 3D-objects, which are linked to the representation level when the 

representation level is switched. 
 

The detail settings can be called up directly under <...>.  

 

Existing templates can be modified here or reopened. The settings can be made for all 

representation levels. 

REFRESH REPRESENTATION LEVEL 
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If a drawing is loaded and the representation level is changed under the status list, you 

can select what should be refreshed in the Refresh representation level dialog window.  

 

If you would like to refresh a representation level without converting it, click the 

parameter button to access this dialog window. 

 

Design model – AR Objects 

All architecture objects such as walls, windows, doors, etc. are regenerated in the 

selected representation level. 

Scale 

If a default scale is specified for the representation level, you can decide here whether 

another scale should be used for the refresh. The scale can also be retroactively 

adjusted via the status list. 

Views 

Material depictions and architectural dimensions are updated in the views and sections 

with the selected representation level's settings. 

Freeze active views  

 

When activated, all existing views of the view, section, plan, detail and plot type are 

frozen in the active status. 

These views are specially marked with a frozen symbol in the view manager and 

additionally retain the representation level's description in their names. 
 

Frozen views except for the plot views cannot be refreshed. 

If the representation level has been changed and modifications to the design model 

have been made, selecting Refresh view can bring a frozen plot view back to its active 

status. 
 

If you try to refresh a frozen view of the section or plan type, the following message 

appears: 

View is OFFLINE!  
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Release frozen views 

To return to an already existing representation level, unfreeze and refresh the already 

created views. 

Should the status of the existing views remain the same, deactivate the switch. If the 

representation level then changes back and the views are again frozen, the marker _1 

is added to the name. 
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8.2 PROJECT 

The project is the highest hierarchical level in the file organisation. All of the data of 

a building project is stored in a folder. The default when starting a new project is that 

a folder with the new project name is stored in the ELITECAD-Installation directory 

e.g. C:\ProgramFiles\ELITECAD\z\<projectname>. 
 

The settings can be configured in the setup. You can retroactively modify these settings 

in START > PROGRAMS > ELITECAD[VERSION]AR > ELITECAD 

CONFIGURATION. 
 

To make projects more comprehensible, you can introduce project groups. These 

project groups can be organised by client, department or year, etc. This can be activated 

in Setup under Settings or retroactively under SETTINGS > OPTIONS > 

SAVE/LOAD > GENERAL. 

When this is enabled, the system creates an additional directory under the project path 

with the name of the group, and then creates a folder in it with the project name. 

Project 

 

Storeys manager > Project settings 

File menu > Project 

The PROJECT function opens the project settings dialog window. 

 

An existing project can be selected from the Project field. 

The button  creates a new project. The dialog window is emptied and can be fill 

with the new data. 

The button  creates a variant of the project. A dialog window opens where the 

drawings to be copied can be selected individually. 
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When a new project is created, punctuation should not be used in the name (exceptions: 

hyphen "-", underscore "_") and the name should have a maximum of 80 characters. 
 

The Standard defines which country specific standard should be used for 

quantification. (E.g. DIN, Ö-Norm, SIA). 
 

The name of the owner, for example, can be entered in the Name field, and additional 

information about the building project can be entered under Description. The entry in 

the Project field creates a folder with the same name and is always the project name 

that ELITECAD uses. The Name field is used in the project book's reports. The content 

of the "Description" field only serves the documentation. 

In the section Address 2 the same fields are available for entering a second name and 

address. 
 

If the Project group option is activated, the project dialog window displays another 

Group field.  
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New groups can be created by entering the name into the Group field and confirming 

with [Enter]. A folder with the group's description is automatically created. 

If a group is selected, only the corresponding projects appear in the Project field. As 

before, the NEW button creates a new project. 
 

The RECORD > SAVE function creates a new project without having to close the 

window. 
 

TIP 
When creating a new project, specify your project's most important 

properties in the following order: "Structure" > "Building" > "Height 

section" and "Storeys". The active project can also be modified in the 

same dialog window. Whilst the structure settings are being edited, the 

project dialog window is locked for all of the other users. Thus, when 

several employees are working on the same project, the structure 

window of this project can only be opened once. This prevents any 

unintended overwriting.  

Project template 

Alternatively, a project can be created in the start dialog window from a project 

template. The templates are not modified during this process. The path for project 

template is defined in the ELITECAD configuration. 
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8.3 STRUCTURE 

What is a structure? 

A structure is treated as a continuous and self-contained building in ELITECAD. The 

structure can be comprised of multiple storeys but this is not a necessity. The 

classification into different structures allows you to manage buildings with different 

height levels. Two structures can both have an upper storey named "NF1" on differing 

levels. 
 

Structures are generally used as filters. They can be understood as a combination of 

the different storeys, which can be selected separately. This creates a variety of 

possibilities for the editing of the design model, as well as by several employees. The 

structure "without structures" is automatically assigned to all of the drawing objects to 

which the program cannot assign a unique structure (or storey). 
 

TIP 
The division of the building project into different structures should be 

carefully considered. On the one hand, separated buildings create a 

better structuring of the project, but on the other hand it is not very useful 

to divide a building with shifted floor levels in one storey into two 

structures, for instance (...which of the two do the continuous exterior 

walls belong to?).   

STRUCTURE SETTINGS 

 

Storeys manager > Project settings 

File menu > Structure settings 

Creating a new project opens the structure settings dialog window, which can also be 

called up any time during editing via the storeys manager functions.  

 

The dialog window is comprised of four different entry ranges: 

Structure, height section, storeys and buildings. 
 

Whereas the OK button saves and quits the dialog window, APPLY also saves the 

entries but does not close the dialog window. 
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TIP 
Should the entered values be saved as standard, the option SAVE AS 

DEFAULT in the FUNCTIONS menu needs to be used. (See description 

below)  

Structure  

This entry range consists of four parts. 

- The general height marking of the project 

- The list of structures  

- Commands to create and modify the structure 

- Height reference (±0.00) and height situation of the single structures  
 

Entries and modifications always refer to the active structures, even in the other entry 

ranges. This is shown in the title of the structure dialog window and ELITECAD 

window. 

Height marking  

Three different settings are possible: 

- Sea level: The structure's height situation is decisive. 

- Project null: The +/- 0.00 corresponds to the height of the reference point. 

- Per structure: Every structure has its own height situation.  

  

   

   

This information only affects the automatic height marking of the window and room 

label. 

Structure list 

Defined structures are shown here with their main properties.   

You can easily activate the desired structure by selecting it from the list. If different 

structures are created with differing height situations, a difference in level for this to 

project null, which can be read in the grey-shaded field, appears.  
 

TIP 
At a later point in time, if it becomes necessary to modify the height of 

the project null, the reference heights of the individual structures must 

be adjusted accordingly.   

Commands to create and modify the structure 

New/modify 

This function opens the parameter dialog window of the structure settings in order to 

either create a new structure or amend the values of an existing structure.  
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Name 

The name appears in both the settings dialog window and in the quick info in the 

storeys manager window. It is therefore worth choosing a short and unambiguous term. 

A new structure is automatically called "new" when it is first created.  

Description 

This information is used to clarify the chosen name. This only appears in the structure 

settings overview. 

Height situation 

The height situation can be entered here and the difference in level to project null can 

be read in the grey-shaded field. 

Reference 

With this switch, you can specify whether the +/- 0.00 is located on the finished floor 

level (FFL) or on the ground floor's bare ceiling TS (TSBC).  

Type of structure 

This switch allocates a building type to the structure. Standard heights then appear in 

the Height section entry range (if such had been deposited via the Building entry 

range). 
 

Either OK or APPLY writes the information back and the display switches to the 

Height section entry range. 

Delete 

Deletes the selected structure's data from the list provided, that it contains no elements.  

Copy 

Creates a copy of the active structure settings with the same name+1.  

Upwards/downwards 

The buttons UPWARDS and DOWNWARDS sort the structures. Sorting these in 

descending order also applies for sorting the storey management window from left to 

right. 

Height reference (±0.00) and height situation of the single structures 

You can specify the active structure's height reference and height situation here. The 

difference in level to project null is shown in the grey-shaded field.  
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Height section 

You can specify the number of storeys as well as their height for the active structures 

in this entry range. All information is entered in the "active unit"; only the ridge height 

and the maximal building height are always entered in [m].  

 

Number 

Enter the number of the same type of storey here. The possibility of being able to 

define multiple ground floors is used to manage differing height levels within the 

structure. 

Height 

Enter the standard value for the room clearance (FFL to lower edge false ceiling) of 

each type of storey here.  

(N.B: In contrast to the room height clearance, the dimensions for the "installation 

height" and "floor finish" are included for the framing height clearance. These values 

are defined in the entry range's Storey field.) 

With no. 

This function provides the storeys with a consecutive number to reach the same storey 

description.  If you have a project with two structures and one of the two only has one 

normal storey, the active numbering identifies the storey as "NF1" instead of "NF".  

"Padlock" – Controlling the height of multiple storeys of the same type 

The number of similar storeys can be entered in the height section. 

If the room clearance of such storeys differs from the values of the height section, a 

green padlock appears next to the "Height" field. 
 

The padlock has two functions:  
 

If it is closed with a click (colour switches to red) and the entry is confirmed with 

APPLY, all room heights in the entry range "Storeys" are reset to the height section's 

standard values. 

E.g.: The value for NF1-NF3 = 3 m but all values in NF4 = 4 m are then reset to 3 m.  
 

If the padlock stays open and a new height is entered into the entry field and confirmed 

with APPLY, the net clearance of all of this type of storey is changed by the difference 

between the old and new value.   

E.g.: If NF2 is increased from 3 m to 3.50 m, all storeys are increased by 0.50 m. 
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Maximal ridge height and maximal height 

The heights of all of the active storeys above FFL GF is shown in the "max. height" 

field. A warning appears if it is higher than the max. entered ridge height.  
 

If the entered height indication as well as the settings from "Building" should be 

available by default, these can be saved with the "Type of structure" under 

FUNCTIONS > SAVE AS DEFAULT. These settings are once again called up when 

a new structure is created by selecting the relevant type of structure. 
 

In addition, please read the paragraph on the "graphic height section" below. 

Building 

The pre-settings for the active structure can be specified in the entry range BUILDING. 

The values assigned here can be overwritten at any time.  

 

Gauge for walls and columns 

General construction data for active types of structure can be noted here. The 

information is solely for documentation purposes and has no effect on the design 

model. 

Presets 

These values are suggested for the height section's settings. 

Basement floor gauge/Raw slab gauge 

The information describes the slab's framing dimension.  

Floor gauge 

The value stands for the floor finish. This is the dimension from the structural floor 

level (SFL) to the finished floor level (FFL).  

Installation height 

The value stands for the height of the false ceiling construction. 

Parapet height/lintel height  

These values are used for the AR OBJECTS > FAÇADE GRID function. 
 

APPLY writes the data into the project database and allows you to continue editing 

the structure settings' sub-dialog window. 
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Storeys 

If the information under the height section is finalised with APPLY, these standard 

values are also available in the STOREYS entry range. 

Now you can specify the single storeys more precisely if needed. Select the desired 

storey from the dropdown box. The "Type = standard" entry refers to the storey that 

has been entered into the height section; "Type = free" means that it has been set by 

the INSERT function. 

 

Room clearance 

This information is finished measurements (FFL to lower edge gross ceiling).  

Floor gauge 

The value stands for the floor finish. This is the dimension from the structural floor 

level (SFL) to the finished floor level (FFL).  

FFL: 

The height of the finished floor in the active storey is shown on the right-hand side of 

the page.  

Installation height 

The value stands for the height of the false ceiling construction. 

Raw slab gauge 

Always enter the ceiling of the storey located below in the field. As a rule, this belongs 

to the respective storey. 

Label and lintel height 

The information is for framing dimensions!Insert 

This function inserts another storey between storeys or at the end of the list. The storey 

number (level) and storey name are to be entered in the entry line and the values for 

the new storey completed in the storey dialog window. Free storey descriptions can be 

used here (GF instead of BA; gallery or similar).  

Delete 

This function deletes a storey from the storey dialog window when it is empty, 

meaning that no elements are linked to it.  
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Modify 

Via MODIFY you can amend the "Storey number" (level) as well as the "Storey 

name". If a storey number has already been assigned, the current storey is given this 

number and the other is moved to a different position. Your own storey descriptions, 

for instance, can be used here (GF instead of BA; gallery or the like) 

 

After modification, the design model is updated automatically. 
 

If the design model had not been loaded at the time of the modification, a query appears 

when loading that the structure settings are different. 
 

The dialog appears depending on the option QUERY IF STRUCTURE SETTINGS 

DO NOT MATCH under SETTING > OPTIONS > SAVE/OPEN > GENERAL. If 

the dialog is not displayed, the drawing settings are applied. 
 

 

This dialog also appears when you load a drawing from a previous project, which does 

not match that of the active one. 
 

If "from project" is selected, the design model is automatically refreshed according to 

the new occurrences. All walls, windows, doors, columns, ceilings and roofs, which 

refer to the height section, are adjusted in level and height.  

If "from drawing" is selected, the active project settings are overwritten by the project 

settings saved in the drawing. The drawing will then be read, as it has been stored. 
 

If "join" is selected, the drawing is read as it was saved, the modified structure still 

appears in management and is renamed in [Structure name]. 
 

If drawing A had fewer structures than the previously loaded drawing B from the same 

project, the storeys manager specifies the difference and queries whether the 

unmodified structure should be deleted or whether it must be kept (as an empty 

structure).  
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The dialog appears depending on the option QUERY IF STRUCTURE SETTINGS 

DO NOT MATCH under SETTING > OPTIONS > SAVE/OPEN > GENERAL. If 

the dialog is not displayed, the unused structures are deleted. 

Functions 

Different commands are available in the FUNCTIONS menu: 

Save as default 

The function saves all of the structure's settings but of course without the list and 

number of storeys. In this way, the settings, which have been made once, can be 

predefined for future projects. These default settings are saved for every selected type 

of structure (entry range STRUCTURE > MODIFY > TYPE OF STRUCTURE)! 

Modify in image 

This command will be described in the next chapter "The graphic height section". 

Regenerate storey dialog window 

This function calculates a new height section from the starting values of the "Height 

section" and "Building" ranges. If, for example, the gauge of all raw ceilings in the 

project is modified, this value can be modified in the building entry range and 

generally assigned via the Regenerate storey dialog window.  

Graphical height section  

 

By selecting the command MODIFY IN IMAGE under the FUNCTIONS menu and 

clicking the concerned parts in the graphic, the storey values can be modified.  
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TIP 
Type near a graphic depiction, e.g. the parapet: You can now modify the 

value of the parapet height in the entry line. This is also true when you 

click on the dimension figure for the parapet height. The data in the 

storey settings is automatically refreshed and the height section is 

regenerated.  

CREATE STRUCTURE 

  

Storeys manager; Tool bar *Create new AR Object 

AR Objects menu > Structure 

The CREATE STRUCTURE function generates a building volume from the storey 

ceiling and/or outer walls based on the structure settings and an outline and optionally 

creates the dimensions. 

The outline must be from a closed polygon, which was previously defined. It does not 

matter to which storey the outline belongs. A storey of the desired structure must be 

active when the CREATE STRUCTURE function is started. 
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Parameter 

 

 

Predefined parameter set can be selected for walls and slabs by their names. This 

option offers the possibility for the usage of multi-layered components. 

Layer 

Choice of relevant layer. 

Material 

 

The material is defined in the representation level by a pen and hatch. A suitable 

depiction of the construction part is mapped in the plan.  

Texture / 3D-Colour 

 /  

A texture or 3D colour can be assigned to walls and ceilings. 

Switch on/off 

 

The walls can be switched off for a skeleton construction. 

Offset ceiling 

The ceilings can be allocated an offset, which resets the value. 

Dimensions 

 

Depending on the choice, up to three different dimensions can be selected. 

Dimension offset 

  

The horizontal and vertical offset can be entered here. 
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8.4 WORK WITH STOREYS 

The correct and logical allocation of every individual object drawn in ELITECAD is 

a prerequisite for orderly and fast work with the program. 
 

In addition to the variety of possibilities of condensing objects through layers or 

groupings, project management comes first. The top of the pyramid forms the "project" 

with its project name. The different "structures" to which different "storeys" are 

assigned in turn are managed under it. 
 

Every object in ELITECAD is clearly allocated according to the project, structure and 

storey. Ensure that there is also a structure called "without structures" and a storey 

called "without storey". 
 

This is the basic hierarchy of the architecture program and should always be kept in 

mind when drawing. In ELITECAD's program title bar, the current project, the active 

structure and active storey are always on display next to the loaded file. 

Storey and structure allocation 

A structure, which has no storey, is managed within every project. This is the structure 

"without structures". All objects which do not belong to a structure should be located 

on the "without structures" (and therefore also on "without storey"). These can for 

instance be the components of the exterior construction, development or similar. 
 

If ELITECAD is restarted and no structure or storey is selected, all newly drawn 

objects are allocated as "without structures". 
 

For the allocation of storey-transcending elements such as exterior chimneys, rainfall 

guttering, curtain facades (not by a multi-layered wall), the storey "without storey" can 

be used in the relevant structure.  

Active storey 

As long as a storey is active, all newly drawn elements are assigned to it. 

The single storeys are activated, among other things, by the storey functions described 

below. In addition, storeys can also be activated by switching views and either 

activated or deactivated by loading "Storeys" and "work copies". The storey dialog 

window is set to "empty" with a combination of "Select all + Delete" or NEW FILE 

from the menu item. 
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Storeys manager 

 
View tool bar 

View menu > Storeys         [Ctrl] + [G]             

 

This dialog window has two ranges. Project, structure and depiction of the storey 

dialog window can be configured in the header line. A table then appears with the 

defined storeys as icons.  

Functions in the header line 

 

 Manage project settings 

 Manage structure settings 

 Create structure 

 Show all storeys 

 Switch the depiction of the storeys from table to list view 

Depiction of the storey dialog window 

Table    List   overwrite protection active 

               

Meaning of the different icon colours 

     

grey: light green: dark green: orange: padlock: 

not loaded invisible visible active locked 
 

Directly click on the icons in the storey dialog window to control the storey's display. 

These commands can be found amongst others in the Context menu. 
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Table view 
 

The symbols for the "without storey" structure are arranged in 

the header line. The symbol for the "without structures" 

structure is in the first field on the left. 
 

Storey table: The storeys are arranged in the rows according to 

their number and in the columns according to their structure. 

The visibility of the single fields or entire rows/columns is 

controlled via the context menu.   

The structure and storey names appear in the quick info of the 

individual fields. 

List view 
 

The list view provides direct access to the visibility and 

save function for the individual storeys or the entire 

structures.  

This is provided similarly to the layer list.  

The display can be switched on or off with the "eye", and 

the padlock locks the storey or structure. These are then 

shown as grey; the capture points are accessible but the 

elements cannot be modified. 

 

 

 

 

View from the active overwrite protection 

In this mode, the storey icons have 

an arrow added to those, which are 

loaded as reference. This allows 

you to instantly see that the 

overwrite protection is active. 
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Design model editing in team 

The storeys manager provides support when several people wish to work on the same 

design model. This consists of the corresponding Functions in the context menu, in 

addition to the status indication in the storey dialog window and precautions in order 

to prevent involuntarily overwriting. 

 

Requirements 

- Project, structure settings and storeys are defined. 

Storeys in files – Requirements for team functions 

The STOREYS IN FILES option is activated under SETTINGS > OPTIONS > 

SAVE/LOAD > GENERAL. 

 

This function must be at least activated in the team in every workstation.  

It unlocks the save and load functions for the teamwork and caters for another 

depiction of the storey symbols in the management: 

    

As reference  Locked 
 

It also guarantees that only one team member at any one time can perform any 

modifications to the design model range that he has loaded. 

Preparation 

Because the team function sets up its own file storage, it is sensible to work with a 

master file from the very beginning. This could contain minimal information, for 

example the axis-grid in every storey. The storey files are generated with the SAVE 

ALL STOREYS context function. The team workers can now develop their design 

model ranges individually. 

Edit design model 

The internal structure of the project with structures and storeys determines the possible 

design model ranges, which can be edited at the same time at different workstations. 

"Design model range" means at least a storey or any choice of storeys or structures.  
 

The same design model range can only be saved in the workstation where it was first 

loaded. A restriction is that the loading and saving of the ranges are exclusively 

performed via the storey dialog window. 

Loading a design model range via the context menu determines whether the range 

obtains the "to modify" or "as reference" status. If the range has already been loaded 

in another workstation with the "to modify" status, it can only be loaded "as reference". 
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If you then attempt to load it with the "to modify" status, an error message appears. 

The same message appears when you attempt to save a design model range, which was 

loaded as reference, via the context menu as long as it is opened at another workstation 

with the "to modify" status. 

 

In order to see all changes in the entire design model range, all design model ranges 

are reloaded in a workstation. The views can then be generated and FILE > SAVE 

AS... saves the design model and views in the master file. 
 

TIP 
The complete file (master file) should be saved at regular intervals with 

a version identification. Load the last master file, then reload all storeys 

via the storey dialog window and save under FILE > SAVE AS  

The team function's file storage 

 

When "Save all storeys" is first performed in the context menu, ELITECAD executes 

it in the following steps: 
 

The drawings of storeys "without structures" and "without storeys" are saved in the 

project directory provided that something has already been drawn. 

Subdirectories with the name of the structures are then created. The drawings of the 

single storeys are stored here.  

When you later save this again, a one (_1) is added to the name of the existing file. 

The previous stage can then always be accessed.  
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The access to the storey remains locked until the user unloads it from his design model. 

The following also removes the lock: NEW FILE/OPEN, LOAD WORK COPY or 

DELETE ALL.   
 

Objects, which are located on the structure "without structures" are stored in the none.d 

file. 
 

Objects, which are assigned a structure but not a storey (without storey) are saved in 

the storey path in the none.d file. 
 

TIP 
Restricted access is generated by creating a file of the same name but 

with the prefix "~$" (e.g. house.d > ~$house.d). If the restricted access 

was not automatically removed, the manual deletion of this file can be 

revoked. These filenames are indeed visible in Windows Explorer after 

the appropriate modifications have been made to the settings. 

  
 

Saving via the context menu does not affect the master file. 

Single functions of the storey dialog window 

Additional commands for the storeys manager are available in the context menu (right-

click on the storey or structure).  

Context menu of storey icons 
 

Descriptions of structures/storey  
 

View options: Show/Hide/Visible alone/Locked – no 

modifications possible 
 

Functions for team editing:  

(Available when STOREYS IN FILES is active) 
 

Save/Load/Reload and unload the selected 

storey/structure 
 

View options 

Show/Hide 

Controls the storey's display. If it is the active storey, it cannot be hidden. This function 

is available by clicking the "eye" in the list view.  

Assemble alone 

Activates the storey and switches all other loaded storeys to invisible. Double-clicking 

the storey icon has the same effect.   
 

TIP 
Double-clicking on any icon assembles the respective content alone.  

A single click on the storey's icon assembles this and activates it. A 

single click on the structure's icon assembles the storey "without storey" 

and activates it.  
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Lock 

The function locks the storey, which is only displayed in one colour. It can be shown 

or hidden. If you click on the icon, a query appears asking whether the lock should be 

removed. The pen colour with which the locked storeys are displayed is specified 

under SETTINGS > OPTIONS > REFERENCE PLAN. 

Functions for team editing  

The following functions for the design model editing in team are available as soon as 

STOREYS IN FILES has been activated. They make management easier when 

individual storeys are edited by different people. The selected storey or selected 

structure can be saved, deleted and loaded directly via the storeys manager without 

going through the file menu's usual functions.  

Save  

You will be asked whether the storey should be saved. Confirming stores the storey in 

the project path in a directory with the name of the respective structure (e.g. as GF.d). 

If the file already exists, the file will be named GF_1.d when saved. 

Activating the file lock only allows the storey to be deleted by the user who locked the 

storey or who had loaded it to modify. Removing the storey deletes the restricted 

access.  

Load  

Loads the storey file. The name of the storey is shown in the title line. If overwrite 

protection is activated, this checks to see if the storey has already been loaded by one 

of the other users. If this is the case, then the storey can only be loaded as reference. 

Reload  

Replaces the storey in question with the saved version. All of the storey's existing 

elements are also deleted! The name of the storey is shown in the title line. If overwrite 

protection is activated, this checks to see if the storey has already been loaded by one 

of the other users. If this is the case, then the storey can only be loaded as reference. 

Unload  

This function deletes the storey from the design model. A backed up storey file is, 

however, not deleted from the structure path!  
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Structure icon context menu 
 

Description of the selected structure 
 

View options: visible/exclusively visible/locked 
 

Functions for team editing: 

Save/Load missing (storeys)/Reload and unload  
 

The same commands, with one exception, as those in the 

storey's context menu are available here. The function 

LOAD MISSING is additionally present here.  

Background context menu 

If you right-click in the storey dialog window's empty range, a menu with additional 

commands appears. The visibility control is on the one side (always available) and the 

loading/saving of all storeys on the other. These commands are only available under 

the active STOREYS IN FILES option. 

Visibility control and depiction in the storey dialog window 

 

 

 

 

 

Assemble all sets all loaded storeys as "visible". 

 

 

 

Settings modifies the depiction of the storey dialog 

window: 

 

 

Show names   Building top/down  Lines on/off 

      

Save all storeys saves all of the loaded storeys.  

See Information on file storage above.  
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This command can also be used when all storeys up until now had been saved under a 

name (e.g. model.d) and the design model should now be disassembled into single 

storey files. 
 

The LOAD ALL STOREYS function only loads the stored single storeys whose 

storeys in the current file are empty. 
 

The RELOAD ALL STOREYS function deletes all loaded data after a confirmation 

prompt and then loads all saved single storeys (including none.d). 

Assemble storey filter 

 

View tool bar 

[F5] 

This function assembles all of the objects from the former storey filter. 
 

This has the following advantages: 

If single objects are shown or hidden from an active storey filter (visible storeys), this 

function can quickly be set back to the former view without having to again redefine 

the visibility in the graphic storey dialog window. 
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8.5 ARCHITECTURE OBJECTS 

 

This chapter explains the basic properties and mechanisms of architectural objects. 

The individual objects are explained in the framing and extension chapters. 

What are objects? 

The bases of architecture are "objects". These objects always consist of images 

(2D/3D) and their parameters which belong to the object in the form of "attributes" (an 

object's attributes are listed under INFO > MODEL INFORMATION). 

 

An object can also contain multiple sub objects. The door in a wall is a sub object of 

the wall object. If the wall is selected, the built in windows and doors for example are 

also selected. If, however, a door is clicked on, the wall is not selected with it. 

 

The corresponding property bar appears when you call up the function or click on an 

object. The most important settings can be modified here. In order to specify all details 

of an object, use the appropriate big parameter dialog window. The big parameter 

dialog window also opens by double-clicking an object. 

Parameters of objects 

Object parameters are settings of an object that can be configured in the parameter 

dialog window. Settings can be saved as a record for every kind of object. 

Type 

Selection with predefined records. 

 
Example: wall dialog window 

To save each separate type, the dialog window of the desired construction part must 

be set, a new name entered in the text field and finally saved in the menu RECORD > 

SAVE. 

To delete a type that is no longer needed, use can the menu item RECORD > DELETE. 

Layer 

 
Example: wall dialog window 
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Every construction part has the layer field in the record with the layer selection. It is 

then guaranteed that the construction parts already lie in the correct layer when they 

are generated. 

You can generate a new layer by entering its name into the text field. 

Renovation planning state 

 
Example: wall dialog window 

This option menu is only visible if the renovation planning mode has been activated 

under SETTINGS > OPTIONS > WORK PARAMETERS > ARCHITECTURE. 

A renovation planning state can be assigned to every object. If an object has not been 

assigned to one of the three states demolition, existing construction or new 

construction, then it belongs to the state unknown. 

For each of the three renovation planning states there are two depiction possibilities. 

Either the depiction is done unchanged (according to the material settings defined in 

the representation levels) or the depiction is done with according to the depiction 

parameters for demolition, existing construction and new construction. These 

parameters can be defined under SETTINGS > OPTIONS > DEPICTION > 

RENOVATION PLANNING. 

Freeze construction part  

 
Example: wall dialog window 

If a construction part is edited, a symbol appears in the parameter dialog window to 

freeze the object. If you press this symbol, the dialog window automatically closes and 

the object is frozen. From this moment, the object is exempted from any update 

functions. 
 

If a frozen object is edited, a message appears on the screen asking whether this should 

be unfrozen. 

 

Copy parameters 

Object parameters can be copied as single items, grouped items or specific items from 

one object to another or to multiple objects. This allows construction parts to be 

globally adjusted according to changes made to the project. 

Function description chapter 4.8 



Chapter 8 – Architectural objects  

www.elitecad.eu 583 

Adopt parameters 

The function takes the properties of an existing construction part and starts the 

CREATION function to locate the construction part. 

Function description chapter 4.8 

GENERAL FUNCTIONS 

Functions, which allow objects to be manipulated, are described below.  

Refresh AR Objects 

 

Modify tool bar 

Modify menu > Refresh AR Objects 

Depending on the settings, architectural objects are not automatically refreshed. A 

manual refresh can be triggered via this function. You can then set whether a refresh 

should be carried out for all or for just selected parts. 

 

Both "Refresh 3D" and "Reorganize properties" are generally switched on. You can 

determine from the selection which subset of projects should be refreshed. 

Storey / Structure 

  

Object selection 

 

AR Object allocation 

 

Modify tool bar 

Modify menu > AR Object allocation 

The function allocates objects to the active storey and structure. 
 

When allocating the single objects, the active storey and active structure are shown in 

the question text. In order to avoid errors in clicking, a message also appears each time 

an object is selected asking whether the correct object has been chosen. 
 

When allocating via All, the number of found objects is given before the allocation. 

Only visible objects are allocated. 
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Purge objects 

 

Special functions tool bar 

Extras menu > Special functions > Purge objects 

This function checks all of the AR Objects and purges them. This function also restores 

defects in the openings of doors and windows in walls. 

(Re)Draw walls 

 

*Modify tool bar 

 

The (RE)DRAW WALLS function hides all 3D information and (re)draws the walls. 

All superfluous lines are switched off. This function is preferably used in the design 

model. 



Chapter 8 – Architectural objects  

www.elitecad.eu 585 

8.6 RENOVATION PLANNING 

OVERVIEW 

 Renovation planning with 

ELITECAD AR is possible 

consistently in 2D and 3D. The 

depiction of the states 

demolition, existing 

construction and new 

construction is freely 

configurable from the 3D model 

down to the plans. 
 

All project states exist 

simultaneously and can be set 

visible or invisible with a single 

mouse click. Classification is 

done at the level of construction 

parts without the need of 

utilizing layers. 
 

Numerous functions for construction use this state information and manage tasks 

automatically (i.e. closing of a wall opening when setting a window to demolition 

state). Even the automatic dimensioning only refers to meaningful combinations of 

states. 

The fully integrated renovation 

planning in ELITECAD 

supports the user not only in the 

3D modelling process and plan 

layouting, but also in the 

calculation of masses and 

dimensions, as well as in the 

generation of reports for the 

desired project states. 
 

During the BIM process, the 

interfaces grant the transfer of 

state information. 

Visualisation of renovation 

planning in a virtual reality environment demonstrates very impressively how a 

building changes. 

BASICS 

States 

ELITECAD manages the time dependent states of a renovation planning project. The 

renovation planning states are a completely independent property of architectural 

objects as well as of basic elements. (E.g. texts, dimensions, help lines). 
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Following states are available: 

 Existing construction 

 Demolition 

 New construction 

If no state has been assigned to an object, then the object is said to be in the state 

unknown. 

Activating renovation planning 

Before working with these states, the renovation planning has to be activated under 

SETTINGS > OPTIONS > WORK PARAMETERS > ARCHITECTURE first. Only 

then, all related settings are active or visible. 

 

Graphical depiction 

Pen, colour, text 

The depiction parameters are configured individually under SETTINGS > OPTIONS 

> DEPICTION > RENOVATION PLANNING for the states demolition, existing and 

new construction. 

 

The coloured depiction can be generally deactivated here. 

Views 

The coloured depiction of renovation planning states can be activated per view. 
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MANAGEMENT 

Objects 

When renovation planning is active, a selection menu for the object sate appears in the 

property bar as well as in the big parameter dialog windows. A renovation planning 

state can therefore easily be assigned to an object.  

 

 

For each of the three renovation planning states there are two possibilities. Either the 

depiction is done with the material settings defined in the representation levels or the 

depiction is done according to the depiction parameters for renovation planning that 

are defined in the OPTIONS. 
 

This state can be passed onto other objects. 

Visibility filter 

After switching on renovation planning the 

selection menu for visibility becomes active 

in the status window. 
 

Renovation planning states are set visible or 

invisible via this menu and are combined 

with the current structure, storey and layer 

filter. Useful prepared combinations of 

states accelerate the selection of visible objects, i.e. setting only demolition visible or 

demolition plus existing construction. 
 

The filter is saved view dependent that means one view may display the state at the 

start of a project and another view may show the final state. 
 

The visibility filter for three commonly used states can be preconfigured under 

SETTINGS > OPTIONS > DEPICTION > ARCHITECTURE. There is a quick way 

to enable them in the RENOVATION PLANNING toolbar. The default states are: 
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 Back to the past  demolition + existing construction 

 Back to the future  new + existing construction 

 Back to the roots  previous state 

EDITING 

Fill openings automatically 

Objects creating openings (windows, doors, walls and 

floor openings) can be closed in a renovation planning 

project. In the terminology of renovation planning this 

means, the opening is set to demolition. By 

performing this change, each opening object 

automatically creates a filling wall / filling slab in 

order to close the opening. The filling wall / slab 

automatically receives the state new construction. 

 

This process can be deactivated via a toggle 

individually for each object. 

Filling walls / slabs can be detached from the opening 

and could be edited manually afterwards. 
 

In the OPTIONS it can be defined how the 

automatically created filling objects should be 

depicted. There are two possibilities: Either according 

to the material or coloured. 

Defining wall openings 

The inverse process of closing openings is the creation of openings. In that case, the 

window or door is the new construction object. A part of the wall is extracted from the 

wall during this process and remains as an independent demolition wall. 
 

It is definitely realistic, that areas, which are supposed to be closed, may overlap with 

new openings. 

An example: A terrace door 

should be removed – demolished 

and on the same place a wide 

window should be located – a new 

construction object. One part of 

the wall opening remains, one part 

of the wall down to the floor is 

bricked and one region of the 

opening will enlarged at the side. 

All these steps are automatically 

accomplished in ELITECAD with 

well-known functions. The door 
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has to be set to demolition state and a window with state new construction has to be 

placed. 

Defining floor openings 

For floor openings, the same principles like for walls are valid. A part of the slab is 

extracted from the existing slab and remains as a slab with the state demolition. Here 

areas that may be opened or closed may partially overlap as well. 

Logically linked walls 

An example for a logically linked wall is an existing wall that 

is linked with a new wall used for insulation. 

 

For logically linked walls, individual stops for openings are 

possible. 

 

 

 

 

Modifying walls 

Further typical tasks in the renovation planning process are 

splitting of walls, demolition of walls or drawing new walls.  

Automatic model adaption when modifying walls 

Walls intersect with slabs and roofs and limit rooms. When performing these actions, 

it is ensured that only compatible objects intersect. Demolition objects and new 

construction objects clearly do not influence each other, i.e. an intersection of a 

demolition wall with a newly constructed roof makes no sense. 

Intersection of matching walls 

In the same way that wall changes affect other objects, the walls themselves take care 

that they only intersect with matching walls. 

Modifying rooms 

Even rooms may possess a renovation planning state. A room with a certain state only 

interacts with reasonable walls, i.e. a demolition room with existing or demolition 

walls, a new construction room with existing 

and new construction walls. 

Changing walls also has impact on the room. 

Rooms can be divided or combined. Hence, 

demolition and new construction rooms can 

partially lie on the same location. This 

introduces no problems because these rooms do 

not influence each other. 
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Dimensioning 

 

Dimensions play a special role in renovation planning. They may not only receive a 

state like other objects in order to be filterable and depicted in corresponding views. 

The state of a dimension also defines which objects should be considered for 

dimensioning. An opening dimension of the type demolition ignores new walls. 

Changing the state of a dimension, i.e. from demolition to new construction involves 

an immediate update of the dimension and at the same instant, completely different 

objects are considered. 

Exchanging library parts 

 
Library parts contain renovation planning information as well. They are depicted like 

all the other objects in the defined colours. When renovation planning is active, 

exchanging a library part also changes its state, i.e. from existing to demolition and 

sets the new object to new construction. 

QUANTIFICATION 

The object state is taken into account when calculating the masses and dimensions and 

stored in the database. Quantification functions consider this information. 

Filter in the quantification manager 

A status filter offers the filtered display 

of renovation planning states in the 

manager. 

Filter in reports 

The reports list the objects separately 

depending on the object state. 

 

 

 

INTERFACES 

3DPDF, U3D, 

SketchUp  

During the export, the renovation 

planning information is considered. 

One level below the storey another 

hierarchy level for the object sates is 

introduced. The export is done 

optionally with or without the 

configured colour options. 
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IFC 

The IFC import reads the object sate and exports the state during the IFC export. 

VISUALISATION IN THE WALKING MODE 

During the walking mode, three combinations of states can be changed with a 

single button click (before, after, back to the previous state). A change between 

the states at the beginning and at the end of a renovation planning project is thus 

possible in a virtual reality environment. The functions can be integrated into 

the graphical menu of the walking mode. See chapter Visibility filter. 

FINALISE RENOVATION PLANNING 

Create new state after renovation 

 

Renovation planning toolbar 

Extras menu > Renovation planning > Create new state after renovation 

After the renovation planning has been completed, a new design model, representing 

the state after the renovation, can be created automatically from the design model with 

renovation planning information out of the existing and new construction data. 

During this process, all data belonging to the status demolition will be deleted. If 

necessary, data with the status existing and new construction are combined (for 

example, existing wall with a new filling wall of a bricked-up window). Finally, the 

information existing and new construction are deleted from the objects, so that in the 

end a design model remains that corresponds to the new state and has no renovation 

planning information. 
 

Views, sections, plot views, etc. are not updated automatically. Manually adjusted and 

unnecessary views should be corrected after review. 

Restore old state before renovation 

 

Renovation planning toolbar 

Extras menu > Renovation planning > Create old state before renovation 

If necessary, the state before the renovation can be restored from the design model 

with renovation planning information automatically from existing construction and 

demolition data.  

During this process, all data belonging to the status new construction will be deleted. 

If necessary, data with the status existing and demolition are combined (e.g., existing 

wall with a demolition wall of an intended wall opening). Finally, the information 

existing construction and demolition are deleted from the objects, so that in the end a 

design model remains that corresponds to the old state and contains no renovation 

planning information. 
 

Views, sections, plot views, etc. are not updated automatically. Manually adjusted and 

unnecessary views should be corrected after review. 
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9.1 GRID 

CREATE AXIS-GRID 

  

AR Objects toolbar 

AR Objects menu > Axis-grid 

Click on the CREATE AXIS GRID function to enable the settings for the last axis-

grid drawn. The axis-grid can immediately be placed. 

The axis grid consists of two orthogonal axes, the horizontal X-axis and the vertical 

Y-axis. For rotated axis systems, you must create the grid on a rotated coordinate 

system: See DEFINE COORDINATE SYSTEM function (chapter 2.3). 

AXIS GRID PROPERTY BAR 

 

The property bar is visible as soon as the function CREATE AXIS GRID is started or 

an existing axis grid is edited. The property bar is used to modify the main properties 

of an axis grid. 

 
Axis grid parameters 

 
Type 

 
Renovation planning state (see chapter 8.5) 

,  
Number of grid lines along X- or Y-axis 

,  
Distance between two grid lines 

,  
Grid line start offset 

 
Grid line pen 

 
Grid line type 

AXIS GRID PARAMETERS 

 

You can open the axis-grid parameters via the properties bar or by double-clicking the 

axis-grid to be modified. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Pen- / Line type 

 

Pen- and line type of grid lines. 

Geometry 

The settings are subdivided into one column for the X-axis and one column for the Y-

axis. If the Y-axis is the same as the X-axis, you can set the option SAME in the middle 

column. 

 

In the first two rows, specify the number of grid lines in the X- and Y-direction along 

with their spacing. 

The offset defines the overlap of the axes over the axis section points along the edges 

of the grid surface. The offset can be on one or both sides. 
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Label 

 

The axes can be labelled on one or both sides. The text is controlled by a predefined 

text parameter. There are various formats available for the numbering. You can specify 

the start value of the numbering as well as whether the numbering should rise from left 

to right or from right to left.  

CREATE FACADE GRID 

  

AR Objects toolbar 

AR Objects menu > Facade grid 

The facade grid copies the heights from the structure settings and can be placed on a 

building's outer facade. 

 

The recommended value for the X-spacing (grid) is adopted from the structure settings 

dimension system. The spacing values of all height lines come from the values in the 

structure settings and only their pen and line type can be modified in this window. 

BTS = top side of complete floor 

B.Us = window bottom edge 

B.Ts = window top edge 

US GC = bottom side of raw slab 

 WORKSHOP  

Create facade grid 

Before executing this function, place your work plane on a facade exterior surface.  
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Open the CREATE FACADE GRID dialog window, enter the desired values and 

confirm by clicking OK. You will be prompted for the lower left and upper right 

positions of the axis grid. 

  

 

After the facade grid has been placed, you can open up the space for the windows on 

the same work plane. All windows are automatically assigned to their associated 

storey, even if that storey is not the current one at the time of installation. 

  

 

  WORKSHOP END 
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9.2 WALL 

CREATE WALL 

  

Construction parts toolbar 

AR Objects menu > Wall 

When you click the CREATE WALL function, the settings of the most recently drawn 

wall are active and the path of the wall can be drawn immediately. Depending on the 

selected setting for the ENTRY MODE option, the first wall query appears in the entry 

line, e.g. 1st axis point. 
 

TIP 
Draw complex walls in multiple pieces, especially if the top edge of the 

wall will intersect the roof.  
 

TIP 
Demolition wall 

You can define demolition walls with a wall height of "0". These are not 

represented in the 3D view. The height reference must be set to parapet 

so that the height of "0" can be specified.  

 WORKSHOP  

Create wall  

Launch the CREATE WALL function. 

 

Set the type of wall entry in the properties bar to "Create wall by polygon". 

 

Now draw the wall axis. Later you will define whether this will become the wall's 

middle, outside, or inside contour. To end wall entry, click again on the last point. 

 

Now define the direction in which the wall should be drawn. Move the mouse in the 

middle of a wall segment from one side to the other. Once you have reached the correct 

position, confirm by left-clicking. 

Keep in mind that the wall gauge is always modified from the axis outwards. You can 

move the axis later using the MOVE WALL AXIS function. 
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Contour exterior 

 

Contour centred 

 

Contour inside 

 

Confirm the position by left-clicking. 

 

The function remains active. You can begin with the next wall right away. 

  WORKSHOP END 

WALL PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE WALL function is started or if 

an existing wall is edited. 

You can manipulate the main values in the wall's properties bar. 

 
Wall parameters 

 Type 
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Renovation planning state (see chapter 8.5) 

 
Entry mode 

 
Height reference 

 
Wall gauge 

 
Wall height 

 

Height difference from the wall's bottom edge to the 

current work plane 

 
Wall type 

 Room dividing 

 
Parapet wall 

 View with envelope 

 
Editing functions for multi-layered walls 

 
Properties of wall (material) 

 
Properties of wall (depiction) 

 
If the wall is multi-layered, the properties are 

deactivated 

 
Modification functions 

WALL PARAMETERS 

 

You can open the wall parameters via the properties bar or by double-clicking the wall 

to be modified. The dialog window has three columns. First, the General Settings 

including the sizes and entry, then the settings of each layer and finally the preview. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

 

Depending on the selected height reference, you can configure the bottom edge and 

height values freely. 

Room dividing 

This property should always be selected by default. Non–room dividing walls would 

include toilet stall walls, dormer walls, facing panels and the like. If a wall is not room 

dividing, it does not divide surfaces when calculating room area. 
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Parapet wall 

If a wall is labelled a parapet wall, the hatch is automatically hidden in the floor plan 

and the settings are used in the "Roof section/secondary wall detail parameter" for 

the floor plan depiction. The hatch is preserved in the section. 

Binding beam 

 

If "Wall to ceiling" or "Free wall reference" is selected for the height reference, the 

BINDING BEAM option also appears. When this option is selected, the wall is 

reported as a binding beam. The 2D PEN/LT option corresponds to a parapet wall. 

System-built wall 

When this option is selected, the wall is reported as a whole and not by layers. 

Main wall 

This option only appears if multiple walls are linked with each other. If a construction 

is labelled the "Main wall", it is the one represented in the floor plan as the cross-

section. If a wall is a "Secondary wall", the cross-section does not appear and the 

depiction follows the settings under "Roof section/secondary wall detail 

parameter". 

View with envelope 

  

For multi-layered walls, the depiction in views can optionally be with the envelope 

only. 

Roof section/secondary wall detail parameter 

 

 

Here, you can configure the pen and line type for the areas that are not visible for a 

roof section. However, you can also switch off depiction. 
 

Switched on     Switched off 
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Here, you can configure the pen and line type for the floor plan, if the parapet wall, 

2D pen/lt or secondary wall options are selected. 

Entry 

Entry mode 

Create wall by polygon 

 

Entry is via the wall axis. This is a freely definable polygon or rectangle. If at the end 

the polygon leads back to its start, the wall is drawn immediately. In all other cases, 

the wall polygon is closed by entering the same endpoint twice. 

For the query Which direction?, you can define the wall's direction, i.e. the position of 

the wall axis. The options are the centre, the right side of the wall or the left side of the 

wall. This axis is adopted as the reference line for later changes to the wall gauge. 

Create wall from existing contour 

 

First, you must draw a contour that follows the desired wall path. Always place this 

contour on the storey plane, even if the wall is to relate to a shifted level floor. After 

defining the contour, you must define the position of the axis (wall direction) with the 

cursor. 

Define wall from outline 

 

The first two entry options are used to draw the wall axis. This always results in a 

uniformly thick wall. With this option, the entire outline of the wall is drawn as a 

closed polygon. This makes it possible to create tapered walls as well. This entry mode 

is only available for single-layered walls. 
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Examples: 

   

Height reference 

Choosing the correct height reference simplifies entry and has advantages for later 

modifications to the structure settings.  

Walls that use a ceiling as a reference automatically adjust themselves if the ceiling is 

modified (height reference of ceiling: Storey ceiling or level floor). A free wall never 

adjusts itself.  

Height reference – Wall from floor to ceiling (Standard) 

 

You can save the effort of entering heights, as this wall is always located between the 

storey slabs of two storeys. The slabs must have storey slab or level floor as their 

height references to be accounted for by the walls. This is the typical setting for interior 

walls. 

If the wall has a roof over it (that belongs to the same storey and the same structure), 

the storey wall connects automatically. 

Height reference – Wall – underside floor to ceiling  

 

The wall begins at the underside of the floor and goes up to the underside of the ceiling. 

This reference is used for the exterior wall in order to create a closed outer shell. 

Height reference - Wall to ceiling 

 

This wall is oriented with its upper edge on the next ceiling or a roof within the same 

storey. The underside is connected to the raw slab. 
 

NOTE 
If you also select the BINDING BEAM option for this wall reference, 

the wall is reported as a binding beam. 

  

Height reference - Wall from floor 

 

Wall from floor is for a parapet wall standing on a floor. References a storey slab or 

level floor. The height can be freely configured and references the top edge of the slab. 

Roofs or storey slabs of higher storeys are not accounted for. 

Height reference - Wall from floor underside 
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The wall from the floor underside starts at the lower edge of the storey ceiling and is 

defined with any height starting at that marker. The wall does not account for level 

floors. 

Height reference - Wall up to roof with max. height 

 

The wall has a maximum height and accounts for storey ceilings or level floors. The 

lower edge and height can be configured. This height reference has two usage areas.  

The first usage is for a wall on the top floor that should adjust to fit the roof but only 

up to a specific wall height. 

 

The other usage is for exterior walls, which have wall layers that are not clamped 

between the ceilings and have other heights. 

                                              

     

Height reference - Dormer walls 

 

Wall between two roofs. After you specify the axis and direction of the wall, both roofs 

are queried for the limitation. The wall remains associated with both roofs. 

Height reference - Free wall reference 

Free walls do not reference floors or roofs. 

Once the free wall is selected, you can also define the wall's shape in the adjacent 

dropdown selection box (only available for this wall type). The free wall entry is 

always defined by a combination of two fields. Depending on the selected shape, you 

are prompted to provide different details. 

Below and above straight 

 

For the straight shape, specifying the lower edge in reference to the ground floor (TS 

slab) and the wall height clearly defines the position of the wall in the storey. 

Slanted below 
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This shape is well suited to defining dormer walls. The top edge of the wall is 

determined based on the specified height and the value for the lower edge (which only 

applies as a reference for the height dimension). You can either determine the lower 

section using a previously drawn 3D surface/box (e.g. a roof plane) or by entering the 

height of three free points. If you select the entry by points, simply imagine you are 

defining a plane in 3D space using the points. This "plane" slices off the bottom of the 

wall. 

Slanted above 

 

The SLANTED ABOVE shape functions similarly to the previous SLANTED 

BELOW function, except the top edge is the slanted one. This wall works well for 

firewalls that run above roofs, free facades, dormer walls or furrowed roofs. 

Slanted below and above 

 

The SLANTED ABOVE AND BELOW shape combines the two aforementioned wall 

shapes. 

Define wall from lateral contour 

 

The wall shape with a lateral contour is generated from the definition of a view. Draw 

the wall view as a closed polygon on the work plane in which the wall should be 

positioned (wall plane). After you launch the WALL function, the path of the wall is 

drawn. Finally, you must provide your drawn contour of the side view.  

Outer wall/Inner wall 

It is relevant for the sections with floors and roofs whether a wall is inside or outside. 

If the outer walls form a closed contour, the layer groups sectioned by the outer wall 

are no longer represented in the area in front of the roof. 

 

Assign the correct surface area according to OE standard 1800 (2011) and EN 15221-

6 in the reporting lists. 

Outer wall 

 

Inner wall 

 

outer wall inner wall 
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Partition wall 

 

Dividing walls for office buildings 

Flexible partition wall 

 

Basement separation, toilet separation wall 

Floor is created up to the wall axis. 

Parameter 

The parameter section displays the settings of the active wall layer. 

 

Number of active layer 

 

For multi-layered walls, you can select the desired layer in order to configure its 

settings. Instead of selecting the number, you can click directly on the layer in the 

preview. 

Gauge of active layer 

 

Main layer / supplementary layer 

 

If a wall layer is defined as the main layer, it automatically intersects other main layers. 
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Material and its linkage 

 

The materials and their corresponding settings are saved in the representation level. 

When linkage to the representation level is selected (recommended), the pen and hatch 

settings are adopted and cannot be manipulated ("greyed out"). 

The material is relevant to reporting. 

Pen and hatching parameters 

 

 

 

When the linkage of the material is active, only the line type can be modified.  

 

 

 

If you unlink the materials, the pen type and hatches can be modified. The settings are 

described in chapter 8.1 Representation level > Materials management. 

Colour mode/Material mode 

  

Switch between colour mode and material mode. If a texture is defined, it takes 

precedence. The 3D colour appears for the empty texture field. For more details, see 

chapter 1.4 "Colours" and 1.7 "Materials". 

Material for room label 

If the lock is not set (open lock), the material configured in the room parameters takes 

precedence over the wall material. If the lock is set (lock closed), the material of the 

wall is represented and not that of the wall label. Reporting does not account for these 

settings and uses the "material for room label" for the entire room. 

 Standard  

main layer 

m
a
in

 l
a

y
e
r 
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3D hatch 

 

The wall can be assigned a line hatch that appears in the calculated hidden line views. 

 

Wall limitation top/bottom 

 

If the wall layer affects a slab or a roof, the sectioning settings take effect. They define 

which layer group the wall layer should lead up to. This can be specified for the upper 

and lower wall connection. 

Layer type 

 

For the reporting to be correct, a layer type must be assigned to the layer. 

If the linkage to the material is detached, you can make the assignment independently. 

If the linkage is active, the layer type is read from the reporting database using the 

material name. 

Preview 

 

The current construction is represented in the preview. Layers can be added, deleted 

or replaced. The wall axis is on wall layer 1. If you click on a layer in the preview, its 

parameters are displayed. 
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Add layer 

 

The function adds a new layer to the last layer. This layer has the same settings as the 

current layer. 

Insert layer 

 

The function adds a new layer above the active layer. 

Delete layer 

 

Deletes the active layer. 

Mirror layers 

 

This function rotates the group of layers by 180 degrees. 
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MODIFICATION FUNCTIONS 

 

When a wall is being edited, modification functions are available at the end of the 

properties bar, or you can call up the functions under the MODIFY menu > WALL. 

Divide wall 

 

The DIVIDE WALL function divides a wall into two parts.  

For a closed wall, you are prompted for two partition points. 

 

If you place the partition point on a corner of a wall that has a right angle, the program 

offers two possible partition lines. You can select the desired one. 

 

If you place the partition point on a wall corner that does not have a right angle, the 

wall is divided by a line that splits the angle in half. 

 WORKSHOP  

You would like to give an area of wall a different construction. To do so, the wall must 

be divided. Click on the wall, select the DIVIDE WALL modification function, and 

set the partition point.  

      

   

further dividing line 

first partition point 

second partition point 
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Divide the longer wall section. To do so, move the cursor to the beginning of the wall 

and hover it until the cross appears. Then move the cursor in the direction where the 

division is to be made, enter the distance and confirm with [Enter]. 

   

Now you can delete the middle wall slab or simply convert it to another wall type. 

  WORKSHOP END 

Join wall 

 

Joins two divided walls of the same gauge into one wall. If the two walls have different 

properties, such as height, material, pen, etc., the settings for the wall you clicked are 

adopted. 

You can only click on walls that belong to the same storey and structure. It is also only 

possible to join two walls that are touching and have their wall axis on the same side. 

If that is not the case, you can use the MOVE WALL AXIS function to change the 

position. 

Modify wall axis 

 

The function enables you to modify the contour of an existing wall. The function 

completely rebuilds the wall from the wall axis. 

After the function is launched, the wall is reduced to the wall axis. The wall axis can 

be modified using the DRAWING function. Make sure that the wall axis produces a 

complete polygon. To complete the function, you must run the WALL AXIS READY 

function. This appears in the top left of the work area. 

 

TIP 
If you click a contour handle or gripper after selecting the wall, a variety 

of manipulation functions is available in the input assistant. 

  

 WORKSHOP  

Example 1: 

After you have selected the function, the 3D is hidden for the wall and the wall axis 

becomes visible.  
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Now you can modify this axis as you wish. You can fillet the corner of a wall, for 

example. To do so, use the FILLET function. To complete the function, click WALL 

AXIS READY.  

      

   

  WORKSHOP END 

Move wall axis 

 

When you modify the gauge of wall, the position of the wall axis is important, as it 

determines the direction of the gauge change modification. Normally, wall axis display 

is switched off (see SETTINGS > OPTIONS > DEPICTION). While this function is 

selected, the wall axis is displayed and can be moved using the flip cursor. 

Modify wall contour 

 

You can modify the contour of a single-layered wall. The wall can be assigned to any 

outline. 

After launching the function, the wall is reduced to the outline. You can use the 2D 

drawing functions to edit the outline. Make sure that the new contour produces a closed 

polygon again. To complete the function, you must click the WALL CONTOUR 

READY function. This appears in the top left of the work area. 

 

After the contour modification, the wall has a free contour and not all of the editing 

functions are available. 
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TIP 
The wall should be divided in the area of the modification so that only 

part of the wall has a free contour.  

 WORKSHOP  

After you call up the function, you can draw the new wall path using the normal 

drawing functions. Afterwards, you should edit the wall polygon to produce a closed 

polygon again (Delete segment, etc.). 

       

   

End the function using WALL CONTOUR READY. The wall is drawn. Make sure 

that the wall has become a free contour. There should no longer be all of the editing 

options available.  

  WORKSHOP END 

Switch between main contour / layer contour 

 

This selection box gives access to the individual layers so that you can modify them 

independently of the main wall's geometry. To make a horizontal change, the layer 

must be independent. To make a vertical change, the "Auto" selection box must be 

switched to any height reference. 

Control height of single layers 

You can change individual layer's heights independently of the wall's height reference. 

To do so, switch to the layer contours on the properties bar. 

 

All the individual layers are listed. Currently, all of them still have the wall's global 

height reference. 
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In this example, the wood panelling should not go up to the lower edge of the wall. 
 

Select the layer and switch the height reference from "Auto" to "Wall to ceiling". 

The layer's behaviour can now be modified individually, separate from that of the wall.  

    

The individually configured layer will no longer react to changes to the wall. 

Control single layers in floor plan 

If multi-layered walls intersect each other or have independent wall layers, the 

display of the handles can be switched between the main axis and the local axes.  
 

Main axis  Local axes 

       

      Select the desired layer 

  

MULTI-LAYERED WALL FUNCTIONS 

On the wall's property bar, you can display the "Editor functions for multi-layered 

walls" toolbar. 

 

 

Manually create wall-layer 

 

This function creates a separate wall axis for each selected layer. That way, the layer 

can be lengthened or shortened.  
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If you have made a layer of a wall independent, the next time you click the wall 

individual handles appear on the wall once the display has been switched to "Local 

axes". 

Cancel independence of wall layer 

 

This function deletes the additional created wall axis for individual layers. The stretch 

or modification of this axis is automatically undone. 

Divide wall layer 

 

This function interrupts a layer for a specific distance. The layer is always divided 

completely. 

 

First, select the function then select the layer to divide then specify the two division 

points. 

Link wall logically 

 

If multiple walls are drawn on top of each other, e.g. a plinth wall and a multi-layered 

wall, they can be linked with each other to adapt the wall layers to each other 

automatically. When doing so, the wall positioned higher is always cut out. You can 

specify which wall should be represented as sectioned in the wall parameters dialog 

window using the MAIN WALL option. 
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Windows, doors and wall openings can also be placed in this type of linked wall 

constructions. If a height is changed for linked walls, the walls must be refreshed using 

the REFRESH AR OBJECTS function.  

Show logical links 

 

If you click a wall after calling the function, all possible walls to link are displayed. 

Delete logical links 

 

Deletes the linkage for walls. 

Define wall ending 

 

You can use this function to give a wall construction a freely drawn wall ending. This 

is especially useful when wall layers end at an angle. 

After you call up the function, you must click the desired wall. You are then prompted 

for the "Start point of end contour". The contour must pass from one side of the wall 

to the other at the least. To complete the contour, you must click on the same point 

twice. 

  

Delete wall ending 

 

This function deletes a defined wall ending. After you call up the function, you must 

click the desired wall. You are then prompted for the side to be deleted. When you 

click it, the wall ending is deleted. 

OTHER WALL COMMANDS 

Hatch walls 

 

LAY-OUT menu > HATCH WALLS 
 

If automatic wall hatching is switched off (Generate hatch at once under SETTINGS 

menu > OPTIONS > WORK PARAMETERS > ARCHITECTURE), you can click 

this button to hatch all constructed walls on command. 

P4+5 

P3 

P2 

P1 
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(Re)Draw walls 

 

With this function the plan depiction of doors and windows either are given lintel lines 

or the lintel lines are removed, depending on the settings. Additionally, the connection 

lines for walls of the same material are removed in the plan. 

Modify wall connection 

Using this function, you can correct the wall connection, if the connection angle has 

changed, for example. You can correct walls whose wall axes touch the edge of another 

wall.  

Call the command MODIFY WALL CONNECTION under the MODIFY menu > 

WALL. When executing the function, click the wall whose ending is to be corrected.  
 

TIP 
Alternatively, the LENGTHEN/SHORTEN SINGLE ELEMENT 

function can be used. 

  

Lengthen wall layer 

 

The layer being edited automatically receives an independent wall axis. 

For an independent wall layer a new axis can be added. The new wall axis is always 

positioned on the outer side of the wall. 

After you click the layer to be lengthened, you can immediately continue drawing the 

axis. Finally, click again in the same spot. 

  

Please note that edits to the wall may undo the lengthening. 
 

TIP 
Beforehand, split the wall in the area where you would like to make the 

addition.  

Show exterior/interior walls 

 
 

Extras menu > Show exterior/interior walls 

This function opens a dialog window to set the visibility of walls. 
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9.3 BASE, FLOORS AND LANDINGS 

CREATE SLAB 

  

Construction parts toolbar 

AR Objects menu > Floors 

When you click the CREATE SLAB function, the settings of the most recently drawn 

slab are active and the path of the slab can be drawn immediately. Depending on the 

selected setting for the ENTRY MODE option, a query appears in the entry line. 

ELITECAD uses the term "slab" for bases, floors and landings. 

In general, a storey should contain the slabs that lie within its height range. This 

includes the slab on which the walls stand. Sometimes exceptions must be made to this 

rule, e.g. if rooms extend over multiple storeys. The "ceiling over a storey" should 

always belong to the storey above it. 
 

The polygon of the floor outline is always part of the plan graphics (on the storey 

level), even if the height situation of the 3D slab is located above or beneath it. 

PROPERTIES BAR OF SLAB 

 

The properties bar is visible as soon as the CREATE SLAB function is started or if an 

existing slab is edited. 

You can select the slab's main values in the properties bar. 
 

 Slab parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

  Entry mode 

 Height reference 

 Floor gauge 

 
Floor height 

 Slab type 

 
Reported as 

 View with envelope 

 
Properties of slab (material) 

 Properties of slab (depiction) 

 
Switch between main contour / layer contour 
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Modification functions 

SLAB PARAMETERS 

 

You can open the slab parameters via the properties bar or by double-clicking the slab 

to be modified. The dialog window has three columns. First, the General Settings 

including the sizes and entry, then the settings of each layer and finally the preview. 

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 
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Dimensions 

   

Use this field to specify general values such as gauge, height situation, incline settings, 

floor plan depiction and the side view depiction. 

Incline settings 

These settings are only visible with a sloping slab. 

There are 3 definition types  

 

 Incline 

 Slope 

 Define by 3 points 
 

The slab is defined by 2 points for the Incline and Slope definition types. 

 

First point: Point for top side 

This point is used to measure the height situation of the slab. 
 

Second point: Point for incline/slope direction 

This point specifies the direction of the incline or slope. 
 

The Define by 3 points definition type determines the inclination via 3 points. 

When you create the slab, the first point sets the height of the slab. You must also 

specify the height for the inclination to start then the other two points follow with a 

query for the respective inclination height. The three height points situate an imaginary 

surface, which moves in parallel until the surface leads to the point for the upper edge. 

points for upper edge 

points for incline / slope 

incline slope 

cut 

ground 

plan 
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If you enter the same value for the first point's inclination height as for the height 

situation field, the slab passes directly through the 3 points. 

 

Layer gauge for tapered slab 

 

If the slab's upper edge is not parallel to its lower edge (configurable in the individual 

layers), you must specify whether the layer gauge is the maximum or minimum value. 

P1: point for upper edge 

height for incline 100 

P3: height for incline 170 

P1: point for upper edge 

height for incline 0 

P2: height for incline 50 

P3: height for incline 70 

P2: height for incline 150 
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Floor plan depiction 

 

The two values are for the depiction of the slab in the floor plan. The floor plan contour 

always matches the main drawn contour. Individual layer changes are not displayed. 

The left column is for freely lying edges of the slab, while the right column is for the 

edges under a wall. 

View enveloping body 

  

For multi-layered slabs, it may make sense only to display the enveloping body. This 

example shows a section through a stairwell with a view of a multi-layered slab. 

 

Section through stair 

Reported as 

The SLAB function can be used for various construction parts. For the construction 

parts to appear in the correct reporting lists, their applications must be defined. 

 

Entry 

Entry mode 

There are two entry types available for selection. 

ground plan 

cut 

point for upper edge 

point for incline 

maximum thickness = 20 minimal thickness = 20 
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Entry directly by polygon 

Entry by a predefined contour 

Draw contour manually 

 

The Input Assistant offers the drawing options of Polygon, Rectangle, Circle, Ellipse 

and Spline. 

 

If you use Polygon, make sure to close it. 

Define slab with predefined contour 

 

Before starting the SLAB function, you must draw an outline using the drawing 

functions. The slab is generated from this outline.  

Height reference 

The height reference determines the relationship to the design model. The references 

"Free slab", "Storey floor" and "Level floor" are available as options. 

Free slab 

 

A free slab is represented as an independent slab. It does not section any walls, and 

floors are not accounted for. 

Possible application: Representing hanging ceilings, landings, foundations (if no 

separate foundation storey has been defined). 

Storey floor according to height section 

 

The gauge and height situation of the storey floor is determined by the storey list. For 

that reason, the gauge and upper edge entry fields are "greyed out". The storey floor is 

always the raw slab of the active storey. All storey walls of the active storey begin at 

the storey floor or a level floor of the storey. 

Level floor for shifted storeys 

 

The height and gauge of the level floor can be freely defined. All storey walls of the 

active storey begin at the storey floor or at a level floor of the storey. If a storey floor 

and level floor are positioned over each other, the storey walls always begin at the 

higher-up floor. 

Slab type 

  

You can choose between a horizontal and a sloping slab. 
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Parameter 

The parameter section includes the settings of the active slab layer. 

 

Number of active layer 

 

For multi-layered slabs, you can select the desired layer in order to configure its 

settings. Instead of selecting the number, you can click directly on the layer in the 

preview. 

Gauge of active layer 

 

Material and its linkage 

 

Pen and hatching parameters 

 

 

Colour mode/Material mode 

 

Material for room label 

 

3D hatch 

 

Layer slope 

 

This option is only active for a sloping slab. 

You can specify for each layer border whether it is on the incline. 

A slab may only have one inclination, but be horizontal overall when you consider 

both the top and bottom surfaces. 
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Examples: 

 

Layer group 

 

The layers are divided into layer groups. Three layer groups are available: upper, 

middle and lower. The layer groups govern sectioning with the wall's layers. The 

sectioning is performed by assigning which wall layers should lead to which layer 

groups. For the assignment of a layer group, the entire construction with the wall must 

be accounted for. 
 

Example section through basement ceiling: 

Situation 

 

Assign each slab layer to a layer group.  

 

   

For the individual wall layers, use the WALL LIMITATION TOP setting to assign 

the layer group of the slab they should lead up to. 

    

basement 

ground floor 

straight 

straight 
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layer group top 

layer group center 

layer group bottom 
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Layer type 

 

Preview 

 

The current construction is displayed in the preview. Layers can be added, deleted or 

replaced. Each layer must be assigned to a layer group. The layer group is labelled 

with T, C and B (top, centre and bottom). If you click on a layer in the preview, its 

parameters are displayed. 

Append floor layer 

 

Insert floor layer 

 

Delete floor layer 

 

Swap slab layers 

 

Extend layer group up/down 

  

The layer group of the active layer is extended one layer up or down. 

No layer groups 

The layer groups are removed. The walls will only account for the slab's height 

reference or manually modified layer contours. 

MODIFICATION FUNCTIONS 
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When a slab is being edited, modification functions are available at the end of the 

properties bar. 

Slab offset 

 

This function can be used to shift a storey slab into the building. If the slab is drawn 

justified with the outer skin, the slab can be reduced as a whole in order to gain room 

for insulation, for example. 
 

TIP 
You can also enlarge the slab by entering a negative value. 

  

Modify slab contour 

 

You modify the contour of an existing slab or add openings to it. 

After the function is launched, the slab is reduced to the 2D contour. 

You can use the 2D drawing functions to edit the contour. Make sure that the new 

contour produces a closed polygon again. To complete the function, you must click 

the SLAB CONTOUR READY function. This appears in the top left of the work area. 

 

TIP 
If you click a contour handle or gripper after selecting the slab, 

manipulation functions are available in the Input Assistant.  

Split slab 

 

You can use this function to divide a slab into two independent parts.  

The division line should start and end on the floor's outer contour. When you are 

finished, double-click to complete the function. 
 

TIP 
If the start or end point of the division line is not positioned exactly on 

the outer contour, you can automatically adjust it by confirming the 

shown message.  
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Switch between main contour / layer contour 

 

This selection box gives access to the individual layers so that you can modify them 

independently of the main contour's geometry. The selection box provides a list of the 

layers. 

Change layer contour manually 

The slab has a main contour. If the main contour is modified (MODIFY FLOOR 

CONTOUR function), all layers adjust accordingly. To modify an individual layer, the 

layer must be switched to manual. 

Select the layer and switch the selection box from automatic to manual. The change is 

shown in the list. 

 

At the same time, the layer in solid mode is highlighted in colour and the remaining 

layers are represented as transparent. 

       

In this state, the handles and grippers only react to the selected layer and no longer to 

the main contour. You can change the contour in any way as long as it remains inside 

the main contour. It is also permissible to cut holes from the layer. 

ADDITIONAL FLOOR FUNCTIONS 

FLOOR OPENING 

 

Construction parts toolbar 

AR Objects menu > Floor opening 

You can use this function to define floor openings and slits in 2D and 3D. 
 

When you click the CREATE SLAB OPENING function, the settings of the most 

recently placed opening are active and the slab opening can be placed immediately. 

Floor opening properties bar 

 

The properties bar is visible as soon as the CREATE FLOOR OPENING function is 

started or if an existing opening is edited. 
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You can manipulate the main values in the properties bar. 
 

 
Floor opening parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Opening type 

 
Shape 

 
Shadow type 

 
Opening width 

 
Opening height 

 
Close openings automatically (renovation planning) 

 2D depiction in own storey 

 
2D depiction in other storey on / off 

 2D depiction in other storey 

Floor opening parameters 

 

You can open the floor opening parameters via the properties bar or by double-clicking 

the floor opening to be modified. 

After you enter the values and confirm with OK, you are prompted for the position of 

the opening. Once you enter a point, you can define the position of the opening using 

the flip cursor. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Style 

Slab opening 

 

Ceiling opening 

 

Slab slot 

 

Ceiling slot 

 

Shape 

   

The shapes rectangular, circular and free contour are available. The rectangular and 

circular shapes are defined over parameters whereas for the free contour a previously 

created contour has to be selected. 
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Shadow 

  

Shadow depiction can be turned off optionally. 

Dimensions 

 

Width / height 

Dimensions of opening 

Depth 

For a slot, lists the depth of the opening. 

3D depiction 

Define here whether the opening should be visible in 3D. 

2D depiction in other storey 

Define here whether the 2D depiction should be visible in the storey above or below 

the current one. 

Automatically 

If a slab opening is set to demolition state, this option can be used to generate a slab in 

order to fill the opening automatically. 

Exclude floor finish 

The slab opening will also be applied to the room. 

Use only free ceilings in active storey 

This option is only available for ceiling openings. 

Parameters 

 

Pen and line type 

  
Here you can select the pen/line type for the 2D depiction. 

Shadow 

If you switch on "Shadow", the opening is represented with a shadow and the 

configured hatch colour for the shadow is used as an infill hatch. However, hatch is 

only used for floor openings and slots. The shadow for the ceilings is represented 

diagonally from the floor shadow and is not hatched. 
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Hatch 

Here, enter the pen number for the infill hatch of the shadow. 

Text symbol 

 
Symbol is switched off 

 
Symbol is switched on 

Pre-text 

 

A free text can be entered here. 

Selection of library part 

 

Here, you can select a specific library part for the symbol. The standard symbols are 

stored under <ELITECAD installation directory>\u\<version>\ar\glob\symbol. 
 

TIP 
If you would like to create a symbol of your own, it is best to load a 

template from the path listed above (wd_text.d or wd_text_new.d). 

Adapt the symbol as you wish, and save it under a new name. Make sure 

the placing point of the symbol is in the centre of the page. 

Autotext entries for the slab opening: 
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9.4 COLUMNS 

CREATE COLUMNS 

 

Construction parts toolbar 

AR Objects menu > Column 

Click on the CREATE COLUMN function to enable the settings for the last column 

drawn. The column can immediately be placed. 

COLUMN PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE COLUMN function is started or 

if an existing column is edited. 

You can manipulate the main values in the column's properties bar. 

 
Column parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Shape of columns 

 
Height reference 

 
Column width 

 
Column length 

 
Column height 

 

Height difference from the column's bottom edge to the 

current work plane 

 
Exterior column 

 
Room dividing 

 
Remove column from wall 

 Properties of column (material) 

 Properties of column (depiction) 

 
Modification functions 
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COLUMN PARAMETERS 

 

You can open the column parameters via the properties bar or by double-clicking the 

column to be modified. 

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

 

Depending on the selected height reference, you can configure the bottom edge and 

height values freely. 

Exterior column 

The report differentiates between interior and exterior columns. 



Chapter 9 – Framing  

www.elitecad.eu  635 

Room dividing 

If a column is not room dividing, it is not recognized as a boundary when calculating 

room areas. 

Entry 

Height reference 

Choosing the correct height reference simplifies entry and has advantages for later 

modifications to the structure settings.  

Columns that use a ceiling as a reference automatically adjust themselves if the ceiling 

is modified (height reference of ceiling: Storey ceiling or level floor). A free column 

never adjusts itself. 

Column from floor to ceiling (Standard) 

 

Column from underside floor to ceiling 

 

Column to ceiling 

 

Column from floor 

 

Column from underside floor 

 

Free columns 

 

Free columns do not reference floors or roofs. 

Column shape  

 

You can select pillars with a rectangular, square, round or free cross-section. For a free 

column, you must create a closed polygon in advance. 

 

When you create a circular column, you can also specify an angle-dependent circular 

resolution in 3D. 
 

TIP 
A hollow column can be generated as a free column using 2 concentric 

circles, for example.  

Remove column from wall 
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If you select this option, walls in which columns are placed are automatically removed 

in 2D and in 3D. That way you can draw columns directly into a wall. 

Parameter 

 

Material and its linkage 

 

Pen and hatching parameters 

 

 

Colour mode/Material mode 

  

Material for room label 

 

3D hatch 

 

Column intersection top/bottom 

 

MODIFICATION FUNCTIONS 

 

When a column is being edited, modification functions are available at the end of the 

properties bar. 

Modify column contour 

 

You can modify an existing column contour. 

After the function is launched, the column is reduced to the 2D contour. 
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You can use the 2D drawing functions to edit the contour. To complete the function, 

you must click the COLUMN CONTOUR READY function. This appears in the top 

left of the work area. 

 

TIP 
If you click a handle or gripper after selecting a column from free 

contour, manipulation functions are available in the Input assistant. 

  

Edit columns  

 

The function enables you to add pillar heads with forked columns or supports. The pen 

of the column is used for the groove or bracket. You also can call up the function from 

the MODIFY menu > WALL. 

Forked column 

You can only add forked heads to square or rectangular pillars. 

 

The forked column is always centred on top. When prompted "connect to which side 

of column", click the side on the floor plan that should be grooved. 
 

TIP 
To delete the groove, you can select it as a sub-object in the floor plan 

and delete it. The 3D depiction refreshes automatically.  

Support 

You can only add bearing brackets to square or rectangular pillars. 
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The bracket is always centred on the pillar's cross-section. When prompted "connect 

to which side of column", click the side on the floor plan that should be given the 

bearing bracket. 
 

TIP 
To delete the console, you can select it as a sub-object in the floor plan 

and delete it.  
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9.5 GIRDER 

CREATE GIRDER 

 

Construction parts toolbar 

AR Objects menu > Girder 

When you click the CREATE GIRDER function, the settings of the most recently 

drawn girder are active and the path of the girder can be drawn immediately. 

You can use this function to generate orthogonal or free girder profiles. Girders are 

not room dividing, so they are not accounted for when determining room area. 

GIRDER PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE GIRDER function is started or if 

an existing girder is edited. 

You can manipulate the main values in the girder's properties bar. 
 

 
Girder parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Girder shape 

 
Height reference 

 
Girder width 

 
Girder height 

 
Heights of top edge of girder to raw slab 

 
Distance from girder's top edge 

 
Exterior girder 

 Properties of girder (material) 

 Properties of girder (depiction) 

GIRDER PARAMETERS 
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You can open the girder parameters via the properties bar or by double-clicking the 

girder to be modified. 

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

 

The girder's cross-section (rectangular, free) and height section determine which of the 

fields are configurable or "greyed out". 

Distance from girder's top edge 

 

Only active with the "Girder to ceiling" height reference. If the girder is not attached 

to the ceiling, but has a fixed distance to it, you should configure that distance instead 

of setting the height reference to free. This reduces the effort required when modifying 

the structure settings. 

Quantify covers 

The surfaces are added with the cover of the room label for the room's ceiling covering. 
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Exterior girder 

The report differentiates between interior and exterior girders. 

Entry 

Height reference - Girder to ceiling 

 

The top edge of girder to ceiling always reaches the storey height. Level floors and 

roofs are not accounted for. 

Height reference - Free girder 

 

The girder's height situation can be freely configured. When modifying the structure 

settings, the position does not change. 

Shape of the girder – Right-angled 

 

Enter the sizes via their widths and heights. 

Shape of the girder – Free 

 

Beforehand, you must draw a cross-section. The cross-section can easily be drawn 

normal to the viewer in the floor plan. This can also be a library part (steel girder). 

When you create the girder, you are prompted for a contour, then the start and end 

points and finally the direction. 

 

Parameter 

 

library part 

upper edge 
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Material and its linkage 

 

Pen/line type for floor plan 

 

Pen and hatching parameters 

The pen for the section depiction cannot be selected. It is copied from the material's 

representation level. 

 

Colour mode/Material mode 

  

3D hatch 
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9.6 STAIR 

CREATE STAIR 

 

Construction parts toolbar 

AR Objects menu > Stair, ME Objects menu > Stair 

Click on the CREATE STAIR function to enable the settings for the last stair drawn. 

The stair can immediately be placed. References to storey are only valid in ELITECAD 

Architecture. 

STAIR PROPERTIES BAR 

The properties bar is visible as soon as the CREATE STAIR function is started or if 

an existing stair is edited. 

You can manipulate the main values in the stair's properties bar. 

 
Stair parameters 

 Type 

 

Renovation planning state (only in ELITECAD 

Architecture, see chapter 8.5) 

 
Shape of stair 

 
Height reference 

 
Start height and rise 

 
Number of steps 

 
Step height 

 
Step width 

 
Slope ratio 

 
Stair width 

 
Stair length 

PLACING A STAIR 

The stair is placed via two points. For a "straight stair", provide the start and end point 

of the stringer. For a "corner stair" or a "dog leg" staircase, provide the corner points 

of the second stringer. 

After specifying the points digitally, you can flip to define the position of these points. 
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For straight stairs, you can use the left/right position of the line, or use the first or 

second point as the start point of the stair.  

For "corner" or "dog leg staircases", the position can be mirrored over the line, or you 

can specify whether the corner point is in between the first or second stringer of the 

first or second provided point. 

Confirm the desired position digitally.  

 

You can flip to mirror over the stringer and change the start/end point or corner point. 

The stair is not generated until you click again to confirm the position. You can then 

modify it via the parameter window and <Apply>. 
 

The definition of a "free form stair" requires three polygons. These polygons represent 

the outer borderline of the inside and outside stringers as well as the walking line. 

Depending on the entry mode, the inner and outer stringer can be generated as a 

parallel contour. Activate in ELITECAD Architecture the storey where the staircase 

begins. Draw the required polygons on the storey level or in the active work plane in 

ELITECAD Mechanics. Each line must be continuous. Elements may not be 

superimposed. 

 

Entry mode 

The free form stair offers different entry modes. 

  drawing all polygons 

  selecting all polygons 

  drawing the walking line, stringers over parallel offset 

  selecting the walking line, stringers over parallel offset 

When selecting, click on the walking line with its entrance point. 
 

outside stringer 

inside stringer 

walking line 

entrance point 
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TIP 
If possible, draw the polygons to be longer than the expected end point 

of the stair, as changing the number of steps or tread width can shorten 

a free form stair but can never lengthen it. Once set, you cannot modify 

the start point.  

STAIR PARAMETERS 

 
The first time you call up the parameter window, it is populated with pre-set values. 

When it is called up subsequently, the most recently specified values are retained 

(provided the parameter window was closed by clicking OK). 
 

Stair shapes 

 Straight flight 

 Straight flight with intermediate landing 

 Quarter turn stair with intermediate landing 

 Dog leg stair with intermediate landing 

 Spiral stair 

 Quarter turn staircase 

 Full dog leg winding staircase 

 Dog leg winding stair 

 Free form stair 

 Modular stair 

 

In practice, you can use these stair types to generate most necessary stairs. If any other 

stair shapes are necessary, you can usually generate them out of a combination of the 

pre-set stair types or simply through the various 3D functions. 



Chapter 9 – Framing  

www.elitecad.eu  646 

General parameters 

   Status renovation planning (only in ELITECAD Architecture) 

  Freeze (only in ELITECAD Architecture) 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Main registers 

  Stair geometry 

  Landing and step winding 

  Step lay out 

  Stringer 

  Bearing construction 

  Stair head 

  Stair foot 

  Plan graphics 

General information about the stair parameters 

The appearance of the parameter window and the types of configurable values vary 

depending on the stair shape. 

  Entrance/exit  

  Rotational direction 

  Height definition 

   Limitation values 
 

The stair mask has "calculation fields". These are greyed-out values and the results of 

calculations based on other configured values: 
 

For example, changing the suggested rise naturally also leads to changing the run 

length of the stair. Likewise, changing the number of steps results in adjusting the 

slope measurement. 
 

To generate the stair in ELITECAD Architecture, select the storey on which the stair 

should stand from the storey list. This is also, where the plan graphics is generated. 

Keep in mind that the program always considers the value provided for the entrance 

level to be relative to the storey level. In ELITECAD Mechanics the stair is placed on 

the active work plane. 
 

The entry for placing the stair is already active once the parameter window has been 

opened. 

You cannot close the parameter window with OK until the stair has been placed.  

You cannot make additional modifications from the parameter window until you have 

confirmed with APPLY. 
 

If you modify the stair (by double-clicking), the parameter window with the respective 

settings opens. 
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Stair geometry 

 

The parameter window displays graphics and entry values for the stair geometry 

depending on the stair shape. Based on the shape, the geometry distinguishes between 

"straight" stairs, stairs "with intermediate landing" and "spiral" stairs. 

Floor plan geometry 

The graphics and entry fields vary depending on the stair shape, 
 

e.g. quarter turn staircase 

  Lock 

Activating a value's "lock buttons" blocks that value from affecting the geometry 

calculations. If you change the tread width, the locked values for the stair length are 

not recalculated. 

If both length values are locked and you change the tread width, the number of steps 

is automatically corrected. 
 

Example: dog leg stair with intermediate landing 

  Lock 

If one of the "lock buttons" is selected for a dog leg stair with intermediate landing, 

the value is only fixed if "Free offset" is set under the Landing options. For all other 

LANDING options, stair length is automatically calculated. If both stair lengths are 

fixed, this is automatically adjusted. 

In the absence of fixed values, the system attempts to include as many steps as possible 

with the shortest possible stride length in a flight. 

A stringer length can be shortened or lengthened by increasing or decreasing the step 

number of the lower section or upper section. You can also adjust the stringer length 

via the step offset on the landing. 

   Change exit and entrance 
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  Change rotational direction of stairs 

You can use these functions to change the position after the stair has been placed or 

when modifying it. 

Start height and number of steps 

When you open the parameter window in ELITECAD Architecture, the storey height 

of the current storey is adopted as the "start height". The number of steps is based on 

the maximum rise of step. 
 

e.g. Quarter turn staircase  e.g. Dog leg stair with intermediate landing 

  

There are three options available from the height definition. 

 Free height and entrance level 

 Free height from storey level 

 Storey height from storey level 

For storey height, the rise height is determined from the entries in the storey list. 

Likewise, the gauges of slabs and floor compositions are automatically adopted and 

thus cannot be modified directly. 

In order to enter a custom entrance height, you can remove the fixing of value G, enter 

a new value, and re-fix it. The number of steps is automatically calculated or can be 

configured manually if "Optimizing" is switched off for the limitation values. 
 

When the "Maintain step sum" button is pressed for stairs with an intermediate landing, 

changing the stringer lengths does not increase the number of steps, but only shifts 

them between the step number for the lower section and upper section. 

If you remove this fixing, changing the string lengths calculates a new number of steps 

for the respective flight. 

 Retain number of steps 

Slope ratio 

The "rise of step" is given from the rise and the number of steps. The "tread width" 

(J) is calculated using the formula 2*I+J = 63, for which you should configure the 

possible lower and upper value for the "step length" under Parameter limitation 

values.  

You can change the "tread width" manually within these limitation values. That 

automatically changes the stringer lengths. 

If the stair's "rise" is not fixed, you can also enter the "rise of step" (I), and the rise will 

be calculated from the stringer lengths and the number of steps. 
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Parameter limitation values 

 

On this dialog window, you can define the upper and lower limitation values for the 

"stride length", within which you can adjust the "rise of step" or "tread width". You 

should also configure the "maximum rise" and the "minimum tread width" for winding 

with spiral staircases. 

 

 

 

J min: Minimal tread width when winding 

 

I min: Maximum rise 

 

2*I+J> Bottom limit for tread depth 

 

2*I+J< Upper limit for tread depth 

 

2*I+J= Active tread depth 

 

 

 

For "Optimizing", you can select between "No optimizing", the "Step formula", or the 

"Security rule". 
 

Finally, you can define the "Minimal head room". 
 

TIP 
To create a stair that does not always recalculate itself if you change a 

value, you can set "Optimizing" to "No optimizing". Despite this, you 

will still recognise if the limitation values are exceeded, as the fields will 

be highlighted in red. 

  

Landing design 

 

Here, for "intermediate landings", you can specify the offset of the entrance and exit 

to the landing edge as well as the landing base gauge.  



Chapter 9 – Framing  

www.elitecad.eu  650 

 

The landing base gauge is fixed in three cases by the assumption that the sectioning 

edge (bending line) is continuous for a dog leg stair and flush with the stair width for 

an angled stair. 

Free alignment 

 

You can specify any alignment via the front step edges and the sectioning edges of the 

lower edge of the tread. The bending line is based on the landing base gauge. 

Shift the lower section by one step 

 

The front step edge for the lower flight is offset one step width from the landing. The 

landing base gauge is calculated (narrowest landing base gauge). 

Shift the lower and upper sections by a half step 

 

The front step edges for both flights are shifted by a half step width from the landing. 

The landing base gauge is calculated. 

Shift the upper section by one step 

 

The front step edge for the upper flight is offset one step width from the landing. The 

landing base gauge is calculated (largest landing base gauge). 
 

Changing the "offset" also simultaneously changes the stringer lengths on the floor 

plan and vice versa. 

To achieve a specific alignment (e.g. half a step), you can first use the fix alignment 

and then define the landing base gauge accordingly using "Free offset". The offset of 

the bending lines is calculated from the landing base gauge.  
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When entering via "Free offset", the bending line of the tread underside is not tied to 

the landing edge, but may also extend into the landing for the lower flight.  
 

An automatic material hatch is not currently implemented for the section depiction. 
 

TIP 
You cannot specify the shape of the landing using this function. 

However, you can define the shape either in the floor plan depiction or 

in 3D using standard 2D functions.  

Step winding 

 

For spiral staircases, enter both the "pitch line" position as well as the "corner radius" 

of the inside stringer. 

 

When the stair is generated, the winding is automatically configured based on the 

lowest number of steps for entrance or exit. The winding is built up symmetrically 

starting from the corner step (minimum "tread width").  

The smallest "tread width" is defined via the limitation value (J min). 

 

Automatic winding 

 

The number of steps can be changed accordingly. If you select a number of steps that 

is too low (below the minimum "tread width"), the system calculates the closest 

possible number of steps that satisfies the conditions. If you enter the value "0", all 

steps are realigned to be "normal to the pitch line". 

Step-corner position 

 

You can use this function to draw a reference line representing either the edge or the 

middle of the steps. The position of the pitch line is corrected automatically. 
 

Specify first and second point 1 for middle of step  
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TIP 
For a quarter-turn stair, you must complete the function after the first 

line with [Enter].  

Step winding 

 

Enter offset area via the first and last step. The "tread width" is retained on the pitch 

line. 

Manual winding setting 

 

You can wind each individual step based on its position on the inside or outside 

stringer. 

There is also an option to switch off the fixing to the pitch line. Once the function is 

activated, the value can be entered in the entry line. Entering "0" removes the fixing. 

Entering "1" keeps the rotation point for winding on the pitch line. 

Distance winding 

 

You can wind individual steps based on the distance to the previous step. 

There is also an option to switch off the fixing to the pitch line. Once the function is 

activated, the value can be entered in the entry line. Entering "0" removes the fixing. 

Entering "1" keeps the rotation point for winding on the pitch line. 
 

TIP 
You can combine stair winding with any other options if automatic 

winding is switched off.  

When the subsequent warning appears, you must first set "automatic 

winding" to "0". 

  

The step winding is constructed on the inside stringer following the projection method. 

With "automatic winding", the range of winding is adopted symmetrical to the wedge-

shaped step (corner step). 

P2 

P1 
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Step lay out 

 

There are two designs available: one with a "nosing over step riser" and another with 

an "angled riser". These layouts are also represented in 3D. In the 2D graphics, the 

front step edge and the raw edge are represented. If you change the "nosing" of the 

tread or angled riser or the "gauge of the step riser", the position of the front step edges 

remains fixed and the construction is shifted towards the pitch line. 
 

With nosing over step riser   with angled riser 

  

The third option is for all dimensions to relate to the raw stair. This can be used for a 

prefabricated stair, for example. 

Material and its linkage 

  

This setting is only available in ELITECAD Architecture. 

The settings for a stair's pen and hatch can be stored together under one name. This 

"material name" is managed within the representation levels. The material settings are 

specific to the representation level; in other words, they are different depending on 

which representation level is active. For more information in this regard, please refer 

to the "Representation levels" chapter. 

Pen and hatching parameters 

  

If the material is linked with the parameter record, you cannot change the configured 

pen or the hatch name. If you undo the link (by "unlocking" the lock icon), you can 

configure the pen and hatch via the combo box or selection list. However, that does 
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not change the material's stored settings. These can only be changed within 

representation level management. 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 Colours and 1.7 Materials. 

Stringer 

 

 

Here, you can enter three values for the stringer: the bottom height, upper height and 

stringer gauge. 

Material and its linkage 

  

This setting is only available in ELITECAD Architecture. 

The settings for a stair's pen and hatch can be stored together under one name. This 

"material name" is managed within the representation levels. The material settings are 

specific to the representation level; in other words, they are different depending on 

which representation level is active. For more information in this regard, please refer 

to the "Representation levels" chapter. 

Pen and hatching parameters 

  

If the material is linked with the parameter record, you cannot change the configured 

pen or the hatch name. If you undo the link (by "unlocking" the lock icon), you can 

configure the pen and hatch via the combo box or selection list. However, that does 

not change the material's stored settings. These can only be changed within 

representation level management. 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 Colours and 1.7 Materials. 

Bearing construction 

 

You can select one of three different designs for the bearing construction. Currently, 

you can only use the beam for straight flights of stairs. 
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 Centred beam 

 2 symmetric beam 

 Tread (full stair width) 

e.g. tread    2 symmetric beams 

  

TIP 
For the tread, you can also choose between a straight and an offset 

bottom view.  

Material and its linkage 

  

This setting is only available in ELITECAD Architecture. 

The settings for a stair's pen and hatch can be stored together under one name. This 

"material name" is managed within the representation levels. The material settings are 

specific to the representation level; in other words, they are different depending on 

which representation level is active. For more information in this regard, please refer 

to the "Representation levels" chapter. 

Pen and hatching parameters 

  

If the material is linked with the parameter record, you cannot change the configured 

pen or the hatch name. If you undo the link (by "unlocking" the lock icon), you can 

configure the pen and hatch via the combo box or selection list. However, that does 

not change the material's stored settings. These can only be changed within 

representation level management. 

  

These two buttons allow you to switch between colour mode and material mode.  

For more details, see chapter 1.4 Colours and 1.7 Materials. 
 

TIP 
You can switch off the depiction of the tread. This may be useful if you 

want to represent a stringer stair, for instance.  

Stair head 
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There are three options available for the design of the stair head. 

 Vertical termination 

 Horizontal termination 

 With protruding nosing 

Example with vertical termination 

 

The "A" and "B" values lock each other. In other words, if the "B" value is fixed, its 

value is preserved when changing the tread gauge and the "A" value is adjusted 

accordingly.  
 

If the height indication was set at storey height in ELITECAD Architecture, the gross 

ceiling and slab gauges are set by Storey management and cannot be changed.  

Stair foot 

 

You can select among five options for the design of the stair foot. 

 Horizontal support (for slab or foundation) 

 Partly vertical connection 

 Fully vertical connection 

 Vertical connection to lower tread 

 With protruding nosing 

Example with protruding nosing 
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The values on the parameter window refer to the design of the connection to the tread.  

The A and B values lock each other. In other words, if the B value is fixed (B button), 

its value is preserved when changing the tread gauge and the A value is adjusted 

accordingly. 

Similarly, you can use D and E to determine the height of the bracket, and can also fix 

it when modifying the gross ceiling gauge or the floor composition. 

The support width is defined by the C value. 
 

If the height indication was set at storey height in ELITECAD Architecture, the gross 

ceiling and slab gauges are set by Storey management and cannot be changed.  

Plan graphics 

 

The floor plan depiction contains both the stair flights as well as the landing contour.  

 

The factors for circle radius and arrow length are based on the "tread width". For the 

section line, you can select either factor or angle. 

The type of text can be selected from the "selection box" where all records saved under 

the text parameters are listed. 
 

In ELITECAD Architecture, there are four different types of depiction on the lower 

storey and two types for the upper story. In ELITECAD Mechanics, there is no options 

available. 
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You can determine the position of the section line automatically or manually. 

     

  

You can also separately configure or switch off the pen/line type for steps, the section 

and pitch line, the circle at the entrance and the arrow at the exit. Later you can specify 

whether the exit should be represented in 2D. 
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EDIT STAIRS 

Stairs can be edited and modified at any time by double-clicking them. All detail 

settings can be modified at a later point. It is also possible to modify the stair type, 

except with a free form or modular stair. 
 

In ELITECAD Architecture, you can use COPY INTO ACTIVE STOREY to adopt 

stairs into a storey, automatically adapting the "rise". 
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9.7 ROOF 

CREATE ROOF 

 

Construction parts toolbar 

AR Objects menu > Roof 

When you click the CREATE ROOF function, the settings of the most recently drawn 

roof are active and the path of the roof can be drawn immediately. Depending on the 

selected setting for the ENTRY MODE option, the first contour query appears in the 

entry line, e.g. Start point. 
 

The roof is created on the storey in which the walls are sectioned with the roof. A roof 

can also be defined over multiple storeys. 

 WORKSHOP  

Draw roof 

In the storey list, select the top floor of your project and draw the outline of the eaves 

or gables. 

  

  

Now click the CREATE ROOF function and define the values as shown below. 

  

Once you are satisfied with the settings, click on the previously drawn polygon. As the 

height marker, you can select a building corner, for instance. 
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  WORKSHOP END 

ROOF PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE ROOF function is started or if an 

existing roof is edited. 

You can manipulate the main values in the roof's properties bar. 
 

 
Roof parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Roof shape 

 
Entry mode 

 
Roof gauge 

 
Gauge direction 

 
Roof height 

 
Roof pitch 

 
View as envelope 

 
Roof section on/off 

 
Display extended roof functions 

 Properties of roof (depiction) 

 
Modification functions 

ROOF PARAMETERS 

 

You can open the roof parameters via the properties bar or by double-clicking the roof 

to be modified. The parameter window has three columns. First, the dimensions 

including the sizes and entry, then the parameters of each layer and finally the preview. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

  

    

Gauge 

The roof gauge is the sum of all individual layers. 
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Gauge indication 

 

You can enter the gauge indication as either normal or vertical to the roof plane. 

Gauge direction 

 

Starting from the height marker, the roof is generated upward or downward. 

Height 

 

When you place the roof, you are asked for the point at which the height is to be 

measured. 

The height is measured from the raw slab of the active storey.  

Angle 

 

Pen/line type of floor plan depiction 

The floor plan depiction corresponds to the main contour of the roof. Manually 

modified layers are not represented.  

View enveloping body 

   

If you do not want to have a line at the location and eaves of each layer, you can 

activate the VIEW ENVELOPING BODY option. 

Roof over multiple storeys 

 

Walls are only intersected with the roof if they are located on the same storey as the 

roof. If the roof is to be sectioned with walls from other storeys, you must select this 

option. The first value specifies the number of storeys above and the second value 

specifies the number of storeys below. The roof section is only displayed on the storey 

in which the roof is created. 

Detail parameters roof section in floor plan 

 

The roof section is the sectioned depiction of the roof on the floor when the jamb wall 

has a low height. 
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Depiction on/off 

On:   Off:  

Height / Reference 

The position of the roof section is controlled by the section height. The height is 

measured from the raw slab or from the finished floor. 

Individual 2D depiction 

If the option is active, the roof section is represented similarly to the section. The 

settings are adopted form the individual layers. 

For the general depiction, all layers are generated with the executed pen/line type and 

hatch. 

 

bottom 

area 
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Bottom area 

You can determine a hatch and a pen/line type for the top view of the roof plane 

underneath the roof section (see graphic above). 
 

The appearance of the parameter window and the types of queries are highly dependent 

on the selected construction part and are therefore described below in the discussion 

of each roof types. 

Entry 

Entry mode 

There are two entry types available for selection. 

Entry directly by polygon 

Entry by a predefined contour 

Draw roof contour manually 

 

The Input Assistant offers the drawing options of Polygon, Rectangle, Circle, Ellipse 

and Spline. 

 

If you use polygon, make sure to close it. 

Create roof from existing contour 

 

Before starting the ROOF function, you must draw an outline using the drawing 

functions. The ceiling is generated out of this outline.  

Parameter 

The parameter section includes the settings of the active roof layer. 

  

Number of active layer 
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For multi-layered roofs, you can select the desired layer in order to configure its 

settings. Instead of selecting the number, you can click directly on the layer in the 

preview. 

Gauge of active layer 

 

Layer reference to rafter structure 

 

This option defines the layer under which the rafters are to be generated. This option 

can only be active for one layer. 

Material and its linkage 

 

Pen and hatching parameters 

 

 

Colour mode/Material mode 

   

Individual 3D depiction 

 

When it is locked, only one colour or one material is used for the layer. 

 

When it is unlocked, another option appears with extended settings for eaves, location 

and roof lower layer. 

 

3D hatch 

 

Roof completion 

 



Chapter 9 – Framing  

www.elitecad.eu  667 

The eaves ending can be generated as either "vertical" (up and down), "normal" 

(perpendicular to the roof plane) or "horizontal". For the pent or shed roof, the 

completion can be selected for both sides. 

Layer group 

 

The layers are divided into layer groups. Three layer groups are available: top, centre 

and bottom. The layer groups govern sectioning with the wall's layers. The sectioning 

is performed by assigning which wall layers should lead to which layer groups. For 

the assignment of a layer group, the entire construction with the wall must be 

accounted for. 
 

Example: Section by top floor: 

Situation 

 

Assign each roof layer to a layer group. 

 

For the individual wall layers, use the LIMITATION TOP setting to assign the layer 

group of the roof up to which they should lead.  
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Layer type 

 

ROOF SHAPE 

Flat roof 

 

 

Horizontal roof. You can add skylight domes to a flat roof. 

Pent or shed roof 

 

 

wall layer 

intersection 
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By angle 

You must enter the roof height for two points. The two points are usually the eaves or 

are on the jamb wall. 

By points 

The roof is defined by 3 points. For example, 2 points on the eaves and one point on 

the ridge. You can also select points in 3D directly. The program suggests the 

appropriate height in the entry line. 

By geometry 

This definition adopts a single pre-defined line as the reference line for the roof pitch. 

It is recommended to draw this line on a work plane that is normal to the storey plane, 

e.g. via the WORK PLANE ON SURFACE function and then select the gable wall. 

The line, the length of which is irrelevant, serves as the reference edge for the entire 

pent or shed roof. 

Gabled roof 

 

 

The ridge of a gabled roof is always horizontal, that is, parallel to the storey plane. The 

eaves are adjusted based on the geometry of the roof edge. If they are not parallel to 

the ridge, there will be incline drain pipes. 

 

By angle 

First, you must define the ridge via two points, then the point for the roof height. This 

point may lie on the eaves, on the knee wall, on the ridge, or anywhere on the roof. 

By geometry 

Selecting "By geometry" generates a gabled roof using two lines that describe the 

trajectory lines of both roof planes as with the pent or shed roof. This way you can 

generate a gabled roof with various roof plane inclinations. 

The lines must lie on the same work plane (e.g. on the gable wall). The ridge is normal 

to the trajectory lines and passes through the section point of the two definition lines. 
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Hip roof 

 

 

The roof edges of a hip roof are surrounded by eaves and it has no gable (except when 

defined by an angle variable). The eaves for this roof shape are always horizontal, that 

is, parallel to the storey plane. In contrast, the ridge or ridges are always the sectioning 

lines of the individual roof planes. The number of roof planes generated corresponds 

with the number of lines in the roof edge polygon. Arcs are permitted, but are cut up 

into straight segments. 

 

By angle 

The functions generate a hip roof whose individual roof planes have the same angle.  

By angle variable 

The setting prompts you interactively for the inclination of each roof plane, which you 

must enter and confirm with [Enter]. The flag jumps to the respective eaves whose 

angle you need to enter next. You can only enter the roof gauge vertically. 
 

TIP 
If you enter "90" for an inclination, a gable wall is created in that 

position instead of a roof plane.  

Barrel roof 
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A barrel roof is defined using the floor plan polygon, the eaves height and the peak 

(ridge) height. You also need to enter the direction of the trajectory line (reference 

edge) via two points. The peak of the barrel is always horizontal and normal to the 

midpoint of the trajectory line. You can only configure roof openings to have a vertical 

reveal. Roof windows cannot be placed. 

Free roof 

 

 

Before running the function for the FREE ROOF, in addition to drawing the floor plan 

polygon, you must also draw a cross-section of the roof structure. This should be a 

closed polygon and represents a view/section of the roof panel. For the cross-section, 

the work plane must be perpendicular to the storey plane. This room form is only 

possible if single-layered. You can only configure roof openings to have a vertical 

reveal. Roof windows cannot be placed. 
 

TIP 
You can only create a skewed roof with the free-form functions. 

  

MODIFICATION FUNCTIONS 

 

When a roof is being edited, modification functions are available at the end of the 

properties bar. 

Modify roof contour 

 

You can modify the contour of an existing roof or add openings to it. 

After the function is launched, the roof is reduced to the 2D contour. 

You can use the 2D drawing functions to edit the contour. Make sure that the new 

contour produces a closed polygon again (for each roof plane). To complete the 

function, you must click the ROOF CONTOUR READY function. This appears in the 

top left of the work area. 

 

TIP 
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If you click a handle or gripper after selecting the slab, manipulation 

functions are available in the Input Assistant.  

Modify definition point 

 

Press this function to redefine the position of the existing definition points. You will 

be prompted to re-enter all the points that were necessary for configuration. 
 

TIP 
To leave a point unchanged, you can skip it by entering "0" and pressing 

[Enter].  

Switch between main contour / layer contour 

 

This selection box gives access to the individual layers so that you can modify them 

independently of the main contour's geometry. The selection box provides a list of the 

layers. You can select any layer and change it manually. 

This works just as for a slab. 
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EXTENDED ROOF FUNCTIONS 

 

 

You can call up the extended roof functions in the roof's properties bar. The functions 

have their own toolbar. They can be deleted again at any time. You also can call up 

the functions from the MODIFY menu > ROOF. 

Create special hip for roof 

 

You can create a hip-adapted roof at the gable of a roof. This gable can be defined 

using a gabled roof or a hip roof with variable incline (plane with 90°). 

 

Under "New", you are prompted for the "Position of hip" (the ridge point of the gable) 

and the "Roof pitch". Next, you must specify the height of the edge of the eaves for 

the hip-adapted roof. The program calculates the existing ridge height and suggests it. 

Using "Modify", you can select an existing hip-adapted roof to edit it. Using "Delete", 

you can click a hip-adapted roof to delete it. 

Height section line 

 

The height section line is described in detail in the next chapter. 

Trimming roof planes 

 

This function is used for trimming roof planes.  

There are 3 options available for selection. 

Direct: The roof is trimmed; modifications are not adapted. 

Linkage: Modified angles and heights for both roofs are refreshed. 

Delete: An intersection can be deleted. 

 

Generally, the higher part of a roof plane always trims the lower part. For the 

sectioning, always select the roof plane that should receive the cut-out first. For the 

second roof plane, you can enter parallel distances that reduce the cut-out on the main 

roof. 
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EXPLANATION 
Overhanging roof shapes are not suitable for trimming. 

  

Section lines of roof planes 

 

You can use this function to generate the sectioning line of the lower roof edge of two 

roof planes. This function aids in creating the alignment of various suitable roof planes. 

These can be corrected for these lines with the Modify roof contour modification 

function. 

The section line is generated with current pen/line type and its 3D view is also visible. 

Height in point 

 

Measures the roof's upper and lower edges at a given point in the roof range in relation 

to the storey plane (raw slab). The values are shown in the info window. 

CREATE HEIGHT SECTION LINE 

 

The HEIGHT SECTION LINE function generates a 2D line, which represents the 

intersection of a roof with a horizontal plane at a given height. 

Height section line properties bar 

 

The properties bar is visible as soon as the HEIGHT SECTION LINE function is 

started or if an existing height section line is edited. 

You can manipulate the main values in the height section line's properties bar. 
 

 
There is no parameter dialog window 

 Type 

 
Renovation planning state (see chapter 8.5) 

first roof 

second roof 

parallel distance 

second roof surface 

parallel distance 

gable side 

cut-out 
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Save / delete record 

 
Label on / off 

 
Label font 

 
M, cm/mm dimensioning 

 
Properties of height section line (depiction) 

 
Roof side 

 
Height 

 
Height reference 

 
Label height reference 

 
Single roof plane / whole roof 

 
Automatically / manually 

General parameters 

  Status renovation planning 

 Type 

  Save / delete record 

The general parameters for architectural objects are described in chapter 8.5. 

Label 

  

Labelling can be activated and deactivated. 

Font 

 

Here the font for the label can be selected. 

M, cm/mm dimensioning 

 

Toggles the type of dimensioning. 

Properties for 2D depiction 

 

2D depiction of the height line. 

Roof side 
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Indicates the roof side, which will be used for intersection. 

Height 

 

This value determines the height for intersection. 

Height reference 

 

The height reference is either FFL or SFL. 

Single roof plane / whole roof 

 

The height section line is either generated for a single roof plane or for the whole roof 

at once. 

Automatically / manually 

 

If automatically is active a number of fields are deactivated and the setting are 

automatically chosen. 

CREATE ROOF OPENING 

 

Construction parts toolbar 

AR Objects menu > Roof opening 

The function creates openings or slots in the roof. 

When you click the CREATE ROOF OPENING function, the settings of the most 

recently placed opening are active and the roof opening can be placed immediately. 
 

Once the values have been entered in the parameters, a roof plane must be selected for 

positioning the opening, and then the position in the floor plan and finally the direction 

of the opening are set. 

Roof opening properties bar 

 

The properties bar is visible as soon as the CREATE ROOF OPENING function is 

started or if an existing opening is edited. 

You can manipulate the main values in the properties bar. 
 

 
Roof opening parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

   
Opening shape – orthogonal / free contour 



Chapter 9 – Framing  

www.elitecad.eu  677 

   
Style – hole /slot 

   
Size on - storey plane / roof slope 

 
Width 

 
Length 

  
Depth (only for slot) normal / vertical 

   
Position in top view / position by height 

 
2D depiction / (not) copy from roof 

Roof opening parameters 

 

You can open the roof opening parameters via the properties bar or by double-clicking 

the roof opening to be modified.  

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 
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Dimensions 

   
Shape: right-angled Shape: right-angled Shape: free  

Size on roof slope Size on storey plane  

Hole Slot Hole 

Size on - storey plane / roof slope 

The dimensions can be measured on the roof slope or on the storey plane. This setting 

is accounted for when you modify the roof slope. 

Style – hole / slot 

You can create the opening as a hole or only as a slot with a specific depth. The slot 

can only be from above. The depth of the slot can be set to be normal or vertical. 

Usage: To add solar collectors to an area of the roof instead of roof shingles. 

2D depiction 

 

An open padlock indicates that pen and line type for the 2D Depiction can be entered. 

A closed padlock indicates that pen and line type for the 2D depiction are copied from 

the roof parameters. 

Entry 

The entry process differs depending on the selected shape of the opening. 

Roof opening – free  

 

Entry directly by polygon 

 

Entry by a predefined contour 

 

Roof opening – right-angled  

 

The roof opening can either be set in the floor plan or placed above the height of the 

lower edge of the opening. If the roof height or inclination is changed, the roof opening 

is refreshed according to the entry. 
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Position by floor plan 

 

Position by height 

 

The height of the roof at any point can be measured with the HEIGHT IN POINT 

function. 

Parameter 

Active side 

 

The settings in the parameter window always refer to the active side. 

Number of edges 

 

A side can consist of an edge or two edges. All sides should have the same number of 

edges to avoid geometric errors. 

1 edge 

  

An edge can run in four ways. Any angle can be entered in the "Angle" variant. If the 

opening does not have enough space in the roof with the specified angle, the edge is 

created vertically. 

2 edges 

The lengths can be determined for the first edge. You can select how the length is 

measured. An edge can be horizontal, but the distance is measured perpendicularly to 

the roof plane. All sides should have the same length to avoid geometric errors. 

 

One of the four alternatives for the edge can be selected for each partial edge. 

normal 

angle 

horizon. 

perpen. 
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Example of an opening with two edges. Both "right" and "left" sides are also defined 

with two edges, although one edge would suffice. 

 
Cross-section Long section 

    

A warning appears if the edges do not meet at the corners. 

 

Keep stops: 

In this case you will have to take geometric errors into account. 
 

Adjust stops: 

In this case, a dialog window appears with all of the settings for each side. You can 

decide which stop should be used as a reference. 

perpendicular 

horizontal 
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9.8 DORMER 

CREATE DORMER 

 

Construction parts toolbar 

AR Objects menu > Dormer 

The DORMER function is a tool for generating roof structures. There are four basic 

shapes available for selection.  

When you click the CREATE DORMER function, the settings of the most recently 

drawn dormer are active and the dormer can be created immediately. 

DORMER PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE DORMER function is started or 

if an existing dormer is edited. 

You can manipulate the main values in the dormer's properties bar. 
 

 
Dormer parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Dormer type 

 
Entry style 

 
Dimensions (depending on dormer type) 

 
Click dedendum 

 
Dormer roof pitch 

 
Click the clearance (breadth) 

 
Gables overhang 

 
Type of wall opening 

 
Lower termination of front wall 

 
Create trimmer 
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DORMER PARAMETERS 

The upper part of the parameter window displays the pre-set parameters. You can use 

the other entry fields to define the sizes, material, layer, depiction and dormer features. 

 

Dormer shapes 

Here you can select one of the various dormer shapes. 

 Shed dormer 

 Gable dormer 

 Spiry dormer 

 Trapezoid dormer 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer (is taken from roof) 

The general parameters for architectural objects are described in chapter 8.5. 
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Dimensions 

   

Here you can enter or modify the dimensions of the dormer. 

The parameter window looks different depending on the selected dormer shape. For 

the shed or gable dormer, you can enter the roof pitch, roof gauge, roof overhang and 

wall gauge. The entries for spiry and trapezoid dormers are limited to roof pitch and 

roof gauge. 

Roof parameter 

 

This button opens the dialog window for roof parameters. 

 

Selection of roof parameter settings. If the roof parameters of the main roof have to be 

applied, then the lock has to be closed. The SELECTION menu will be deactivated. 

Net clearance (breadth) outside 

  

The entered width is the outer dimension of the dormer. 

Net clearance (breadth) inside 

  

The entered width is the inner dimension of the dormer. 

Click the clearance (breadth) 

 

You can use this function to measure the net clearance (breadth) from the floor plan 

and automatically enter it into the adjacent field. 

Side wall parameter 

 

This button opens the dialog window for side wall parameters. 
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Selection of side wall parameter settings. If the wall parameters of the main wall have 

to be applied, then the lock has to be closed. The SELECTION menu will be 

deactivated. 

Entry 

You can only change the entry style for a spiry dormer. 

  

Parameter 

 

Here you can enter or modify other dimension and height values for the dormer. 

The parameter window looks different depending on the selected dormer shape. In 

general, you can enter the addendum, dedendum, wall gauge, and roof overhang. 

Materials 

 

The material is taken into account in the report. A name can be freely chosen, simply 

entered in the dropdown box and confirmed with [Enter]. If you want to remove a 

name from the dropdown list, enter it with a preceding minus sign and confirm with 

[Enter]. 
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Addendum 

   

The addendum entered is measured on the inside or outside depending on the 

configuration. 

Dedendum 

   

The dedendum entered is measured on the inside or outside depending on the 

configuration. 

Click dedendum 

 

You can use this function to measure the dedendum from the floor plan and 

automatically enter it into the adjacent field. 

Lock dedendum 

 

If the height of the main roof is modified, the dedendum of the dormer is retained. If 

this tick box is not selected, the height of the dormer is shifted with that of the main 

roof. 

Front wall parameter 

 

This button opens the dialog window for front wall parameters. 

 

Selection of front wall parameter settings.  

Detail parameter 

 

Lower termination of front wall 

Top of roof 

 

The gable wall begins at the top edge of the roof. 

Underside of roof 

 

The gable wall begins at the lower edge of the roof. 

Slab 
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The gable wall rests on the raw slab. 

None 

 

No wall is drawn. 

Roof opening 

   

Enter here whether the main roof should only be cut out in the area of the dormer or 

up to the eaves. 

Trimmer 

  

Here you can decide whether a replacement should be drawn for the roof cut-out. 
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9.9 TRUSS 

CREATE TRUSS 

 

Construction parts toolbar 

AR Objects menu > Truss 

Using the TRUSS function, you can create various truss elements or a beam position. 

Before creating construction parts attached to the roof pitch (such as rafters, wall 

plates, etc.), a roof must be defined. It is also possible to define bearing constructions 

for balconies and terraces with beams, balusters and braces. 
 

When you click the CREATE TRUSS function, the settings of the most recently drawn 

truss are active and the truss can be created immediately. 

TRUSS PROPERTIES BAR 

 

The properties bar is visible as soon as the TRUSS function is started or if an existing 

truss element is edited. 

You can manipulate the main values in the truss properties bar. 
 

 
Truss parameters 

 Truss type 

 
Renovation planning state (see chapter 8.5) 

 
Truss element 

 
Entry mode (depending on element) 

 
Dimensions (depending on element) 

 
Properties of truss 

 Truss section on/off 

 
3D intersection with layers 

 Modification functions 

 
Free parameters  



Chapter 9 – Framing  

www.elitecad.eu  689 

TRUSS PARAMETERS 

 

The appearance of the parameter window and the types of queries are highly dependent 

on the selected construction part and are therefore described below in the discussion 

of each construction part. 

Height indications 

All height indications related to the top or bottom edges of wall plates, beams and 

balusters (spindles) are based on the raw slab (storey zero) of the active storey. 

Plan graphics 

The depiction for the plan graphics is automatically situated in the storey where the 

roof was defined. For construction parts that are not directly associated with the roof, 

you can use the storey list beforehand to select the storey in which the plan graphics 

are to be represented. 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 
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Parameter 

 

Material 

The material is for reporting. It is not dependent on representation level. 

Section depiction 

The pen/line type and hatches are for the depiction in the sectioned state. 

Colour/Material mode 

3D hatch 

Free cross section 

 
A library part with a free cross section can be selected here. 

Truss section in floor plan detail parameters 

 

The roof section is the sectioned depiction of the truss on the floor plan when the jamb 

wall has a low height. 

This option is only definitive for rafters, including hip rafters and valley rafters. 

  

Depiction on/off 

On:   Off:  

Height / Reference 

The position of the roof section is controlled by the section height. The height is 

measured from the raw slab or from the finished floor. 

standard ground 

plan depiction 

section  

bottom area 
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Section planes 

The area in which the truss elements are represented as sectioned. 

Bottom plane 

Truss elements underneath the section height. These elements are mostly covered by 

the roof and are therefore represented by dotted lines. 

THE CONSTRUCTION PARTS 

Rafters 

    

 

Dimensions 

Enter the dimensions of the rafters via their "height" and "width". Depending on the 

separation type, you can enter a rafter distance (jump dimension) or the number of 

rafters. For the "Distance" separation type, a rest distance is left over. 

Rest distance 

 

For the distance, there are various options as to how the rest (remainder) is treated. 

"No" means that value for the distance is treated as a maximum. 
 

no   both sides  centred   left 

 

Offset left/right 

  

If the rafters are distributed across the entire roof plane (TOTAL PLANE option), you 

can specify an offset on the left and right of the roof. The roof is always viewed from 
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the side of the eaves. The distance is from the outer edge of the roof to the start of the 

first rafter. 

Rafter distance to eaves edge 

Here an automatic shortening (positive value) or enlargement (negative value) of the 

rafters to eaves edge can be configured. 

Roof connection, Layer reference to rafter structure 

In the Roof parameters, you can specify the roof layer under which the rafters are to 

be placed. 

Roof distance 

 

The rafters can be created at a distance from the specified roof layer. Use for vaults 

located at a different height from the rafters if the rafters do not begin under a layer 

boundary or are used for large hall roofs as a connector (see image). 

 

Rafter head 

You can define the "rafter head" design as one of three options. 

 Perpendicular (perpendicular to the roof pitch) 

 Horizontal/vertical (with specified front height) 

 Horizontal/normal (with specified front height) 

 Vertical 

Floor plan depiction pen/line type 

Plan graphics of rafters in the floor plan. 

3D sectioning 

When this is activated, the truss elements cut out the walls. 

Truss section in floor plan detail parameters  

 

Separation - Distance 

Here, you should also specify the "Rafter distance" (axis distance) and the position of 

the rest distance. You can specify the latter as "both sides", "centred", "left" or "right". 
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Total plane/range 

 

The TOTAL PLANE setting distributes the rafters across the entire width of the roof 

plane. In addition, you can define rest distances on the left and right sides. If this 

option is not used, they are distributed across a range defined by two points, which are 

to be specified from left to right from the perspective of the edge of the eaves up to the 

outer edge of the rafters. 
 

Position 

The rafters are distributed on the trajectory line of the roof pitch. You can combine 

multiple separation ranges and separations within the same roof plane. 
 

Select to apply the roof plane. 

Separation – Number 

Generates a set number of rafters across the entire roof plane, accounting for the 

left/right offset or a range of the roof plane. 

For the dimensions, specify the number of rafters. 

 

Total plane/range (see above, under division by distance) 

Select to apply the roof plane. 

Separation – Single 

Generates a single rafter across the entire roof plane. 

Select the roof plane, and then define a point on the middle axis of the rafter. 

Separation – Single (manually) 

Generates a single rafter with its start and end point. 

Select the roof plane, and then define the start and end point on the middle axis of the 

rafter. 

Separation – Copy rafter lay out 

Copies the dimensions and the rafter row of a facing rafter. 

Select the roof plane, and then select a rafter from the facing roof plane. 

Beam position 

 

 

A beam is assigned to a slab, not a roof. 
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The settings are the same as those for a rafter. Values such as "Rafter head" and 

"Detail parameters truss section in floor plan" do not apply. 

Wall plates 

 

  
"Bearer (straight plate)"   "Binder (pitched plate)"  

 

There are two available types of "wall plates". Depending on the separation type, a 

"bearer (straight plate)" or a "binder (pitched plate)" is created. 
 

Enter the dimensions of the wall plate via its "height" and "width". 

Separation – Position 

The position of the wall plate is defined by the start and end points of the middle axis. 

The lower edge is calculated using the dimension of the rafter you click and the notch 

depth. 

Separation – Lower edge 

Define the "lower edge" of the wall plate. When you click the rafter, the resulting 

middle axis position is shown as a dashed line, and you can now enter the start and end 

points. You can also determine the points outside of the displayed axis. If you do so, 

the position is projected normal to the middle axis. 

Plate distance to roof edge 

Only active for pitched plate. 

Here an automatic shortening (positive value) or enlargement (negative value) of the 

plate to the roof edge can be entered. 

pitched plate 

straight plate 
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Separation – Distance 

Separation – Number 

Separation – Single (manual) 

Wall limitation 

 

Only active for "bearer (straight plate)". 

You can use this option to section a specific range of a wall at the height of the wall 

plate's lower edge. If the wall plate rests on top of a cap stone, the range can be given 

a limitation using a 2D contour. This contour must be drawn first. After you define the 

position in the top view, you can select this contour. 

 

 WORKSHOP  

Wall plate with wall limitation 

The rafters must be placed before you can define a wall plate. 
 

Now draw a rectangle of the range that will become the height of lower edge of the 

wall plate. 

 

Open the "Truss" parameter window. 

 

Select the WALL PLATE function then select the option for wall limitation. 

 

Next, click APPLY. Select the rafter under which you would like to place the wall 

plate, and then select the position of the wall plate. When the Select contour for wall 

ending prompt appears, click on the rectangle you drew earlier. 

The height of all walls located under this wall limitation should now have changed. 
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  WORKSHOP END 

TIP 
You can also define a ridge piece using the WALL PLATE WITH 

LIMITATION function. That way you can also specify the height for 

the walls' supports. 

  

Ridge piece 

 

Dimensions 

Enter the dimensions of the wall plate via its "height" and "width". 

Floor plan depiction pen/line type 

Plan graphics of ridge pieces in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

You can place the ridge pieces either below the roof or below the rafters. 

    

"Below rafters"    "Below roof" 



Chapter 9 – Framing  

www.elitecad.eu  697 

    

The "notch depth" defines the  The beam cross-section is  

depth of the notch in the rafter  positioned at the set roof distance 

normal to the roof pitch.   distance from the defined roof layer. 

Limitation by roof 

You cannot draw a ridge piece beyond the edge of the roof. 

Beam 

 

 

Dimensions 

Enter the dimensions of the beam via its "height" and "width". 

Height situation over lower edge/upper edge 

For the positioning, you can switch between "lower edge" and "upper edge". The 

system always measures from the raw slab (storey plane). 

Floor plan depiction pen/line type 

Plan graphics of beams in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Assign to roof 

The beam can be assigned to a roof. 
 

The position is defined using its start and end points via the beam's middle axis. 
 

The length can be modified by stretching.  
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Collar 

 

 

Dimensions 

Enter the dimensions of the collar via its "height" and "width". The distance between 

the collars is determined based on the rafter you click on. 

Height situation 

The height of the collars is determined based on the "lower edge". 

Execution 

For the execution of the collars, you can select between "both sides", "left" or "right" 

as seen from the edge of the eaves of the specified rafters. 
 

Define the range of the distribution by clicking on the first and last rafter. You should 

also select one of the facing rafters. The collars are limited by the upper edge of the 

rafters. 
 

If the rafter cross-section or rafter spacing is changed, the collars do not adjust 

themselves automatically and must be moved manually or recreated. If the collars are 

limited for a range by a recess in the building that is perpendicular to the wall, you can 

move individual collars via the side view. 

Floor plan depiction pen/line type 

Plan graphics of collars in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Hip rafter/valley rafter 

  



Chapter 9 – Framing  

www.elitecad.eu  699 

 

Enter the dimensions via "height" and "width". If you specify "0" for the height, the 

rafter height results from the height of the connecting rafter clicked on.  
 

Specify the position by clicking on the start and end points on the axis of the hip/valley. 

Roof distance 

 

The rafters can be created at a distance from the specified roof layer. 

Rafter head 

 

Currently, the only type of rafter head provided has a "vertical termination". 

Floor plan depiction pen/line type 

Plan graphics of rafters in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Redefining a hip/valley rafter does not automatically shorten the rafters. To do so, you 

must refresh the rafter separation via Edit. If the hip/valley rafters already exist, the 

rafters are connected automatically. 
 

The length can be modified by stretching. For the 3D to adapt too, you must edit the 

hip and confirm the dialog window with OK or APPLY.  

Balusters (spindle) 
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Dimension 

Enter the dimensions of the cross-section via its "height" and "width". 

The length of balusters is defined via its lower edge and top side. 

The angle defines the rotation in the floor plan. 

Floor plan depiction pen/line type 

Plan graphics of balusters in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Entry 

When entering a baluster, you can either select a beam or enter a height value. This is 

available for the lower edge and top edge of the post. 
 

Existing braces are not automatically adjusted to fit a new cross-section.  

Braces 

 

 

Dimension 

In addition to the dimension, enter the "issued dimension", the outer notch of the strut. 

Execution 

For the execution of the braces, you can select between following modes: 
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Floor plan depiction pen/line type 

Plan graphics of braces in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Entry 

Braces can only be defined for balusters (spindles) that are positioned under a beam or 

wall plate. Click on the baluster that is to be linked to the braces. The braces are created 

on the middle axis facing the beam/wall plate above them. 
 

If you change the baluster's (spindle's) cross-section later, the braces are not 

automatically adjusted. You must delete them and recreate them.  

Trimmer 

 

 

Dimension 

The cross-section of the trimmer is defined via its "height" and "width". The lateral 

filler wood is executed in the cross-section of the rafters. 

Distances 

You can enter a distance to the opening from all four sides. 

Floor plan depiction pen/line type 

Plan graphics of trimmers in the floor plan. 

3D sectioning 

Truss section in floor plan detail parameters  

 

Entry 

Define the clearance opening of the trimmer on the floor plan by diagonal via two 

points. 
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If the rafter spacing is changed, the trimmers do not adjust themselves automatically. 

You must edit them and confirm the dialog window with OK or APPLY.  
 

TIP 
The lateral filler wood is not shown until the clearance distance to the 

rafters is greater than the rafter width. 

  

EDIT TRUSS 

 

Construction parts of the truss can be edited and modified later by double-clicking 

them. The parameter window with the corresponding settings opens. 
 

Once the height situation is set, you can only edit it for beams, but not for wall plates 

or balusters (spindle).  
 

You can move or delete individual rafters via the modification functions in the 

properties bar. 
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9.10 CHIMNEY 

CREATE CHIMNEY 

 

Construction parts toolbar 

AR Objects menu > Chimney 

Click on the CREATE CHIMNEY function to enable the settings for the last chimney 

drawn. The chimney can immediately be placed. A chimney is generated from 

previously drawn contours or from a library part. 

CHIMNEY PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE CHIMNEY function is started or 

if an existing chimney is edited. 

You can manipulate the main values in the chimney's properties bar. 

 
Chimney parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Height reference 

 
Chimney height 

 

Height difference from the chimney's bottom edge to 

the current work plane 

 
Exterior chimney 

 
Room dividing 

 
Remove chimney from wall 

 Properties of chimney (material) 

 Properties of chimney (depiction) 

CHIMNEY PARAMETERS 

 

You can open the chimney parameters via the properties bar or by double-clicking the 

chimney to be modified. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

 

Depending on the height definition, you can enter the lower edge and the chimney 

height. 

Room dividing 

If a chimney is dividing rooms, then it is treated as boundary for the calculation of 

room areas. 

Exterior chimney 

A chimney can be classified as exterior or interior chimney. 
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Entry 

Height reference 

The chimney does not react to level floors or roofs. The heights are read from the 

height section. 

Chimney with free height 

 

The lower edge and height of this chimney can be freely defined. 

Chimney from slab to ceiling 

 

The chimney leads from the upper edge of the slab to the lower edge of the ceiling. 

Chimney from underside floor to ceiling 

 

The chimney leads from the lower edge of the floor to the lower edge of the ceiling. 

Chimney to ceiling 

 

The chimney leads from any specified height to the lower edge of the ceiling. This 

would apply to a stove with a chimney that only starts at a specific height. 

Chimney from floor 

 

The chimney leads up from the upper edge of the floor to any specified height. This 

reference should be selected for the top floor in order to lead the chimney out of the 

roof. 

Chimney from underside floor 

 

The chimney leads from the lower edge of the floor to any specified height. This 

reference should be selected for the top floor in order to lead the chimney out of the 

roof. 

Remove chimney from wall 

 

If the chimney is placed in a wall, this option must be selected so that the wall is 

automatically removed. 
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Parameter 

 

Material and its linkage 

 

Pen and hatching parameters 

 

 

Colour mode/Material mode 

  

3D hatch 

 

Limitation top 

 

The chimney can be limited at the top end with a certain layer group of the ceiling. 

Limitation bottom 

 

The chimney can be limited at the bottom end with a certain layer group of the floor. 

 WORKSHOP  

Create chimney 

After launching the CREATE function, you are prompted for a contour to serve as the 

basis of the chimney definition. After you click on this contour (which should have 

been created in advance), a 3-dimensional chimney is generated from it according to 

the settings on the parameter window. 
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For a simple chimney, you can also use two attached contours. The chimney hatch is 

always generated solely between the two outer polygons of the chimney's definition. 

When making your selection, you must always click the outer contour first. 

 

However, the 2D depiction may be significantly more complex (e.g. libraries from 

chimney manufacturers). 

 

  WORKSHOP END 
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10.1 DOORS 

 

Construction parts toolbar 

AR Objects menu > Door 

Click on the CREATE DOOR function to enable the settings for the most recently 

placed door. The door can now be placed. The Position of door query appears in the 

entry line. 

DOOR PROPERTIES BAR 

 

The properties bar becomes visible as soon as the CREATE DOOR function is 

launched or if an existing door is edited. 

You can manipulate the main values in the door's properties bar.  
 

 
Door parameters 

 Type 

 

Renovation planning state (only in ELITECAD 

Architecture, see chapter 8.5) 

 
Door shape 

 
Symbol type 

 
Elevation in floor plan 

 
Door width 

 
Door height 

 
Threshold height 

 

Vault height (only active for segment curve door and 

Pointed arch door) 

 
Opening angle 

 
Modify door stop (only active when modifying) 

 Close openings automatically (renovation planning) 

 Lintel depiction 

 Finished clearance / gross clearance 

 
Door jamb type 

 
Switch stop on/off 
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 Door handle parameters 

DOOR PARAMETERS 

 

You can open the door parameters via the properties bar or by double-clicking the door 

to be modified. 

 

General parameters 

   Status renovation planning (only in ELITECAD Architecture) 

  Freeze (only in ELITECAD Architecture) 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Material 

The material is taken into account in the report. Any name can be chosen, simply 

entered in the dropdown box and confirmed with [Enter]. If you want to remove a 

name from the dropdown list, enter it with a preceding minus sign and confirm with 

[Enter].  

Dimensions 
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Door height 

The door height depends on the entry style: 

Finished clearance, gross clearance, gross clearance from "finished higher floor" 
 

TIP 
If a threshold higher than the floor is defined, the height is calculated 

from the threshold.  

Door width 

The door width depends on the entry style: 

Gross clearance or finished clearance 
 

TIP 
If a pre-existing door is edited, the original placement point of the door 

is indicated. A modification to the door width always takes effect from 

this point. 

The point can be moved to the reference points on the left, right and in 

the centre using the mouse. 

  

Threshold height 

The threshold must always be entered from "raw slab", regardless of which entry style 

setting is active. 

Fire protection 

Additionally to the labelling of the door, the fire protection class is added. Any symbol 

that follows the ‚~‘ symbol, will be displayed subscripted, The ‚~‘ symbol itself is not 

displayed. 

The "fire protection" field is written into the project book for each report and is used 

in the door report. 

Opening in 3D 

 

This setting is generally active. Optionally a generation of an opening into the 3D wall 

can be deactivated. In that case, only a 2D depiction of a door is generated in the wall. 

Entry 

 

In order to account for different entry styles, there are various options available for 

entering dimensions. 

Finished clearance 
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The finished clearance describes the finished passage dimension: the width between 

the door jambs and the height from the finished higher floor to the lintel door jamb. If 

a threshold higher than the floor is defined, the height is measured from the threshold. 

Gross clearance 

 

The gross clearance describes the width of the raw wall opening. 

If you select gross clearance as the entry style, an additional dropdown box opens for 

entering the height of the rough dimensions. 

Upper edge finished floor level up to lintel lower edge 

 

Height from higher finished floor up to gross lintel lower edge. If the threshold is 

higher than the floor, the dimension is measured from the threshold. 
 

TIP 
The (finished) floor height defined in the structure settings for the storey 

is taken into account for the FFL height (top edge of finished floor 

height). However, if a room name has been assigned, the (finished) floor 

height used in it takes precedence over the "general (finished) floor 

height)" in the structure settings.  

Top of slab up to lintel lower edge 

 

Height from raw slab to lintel lower edge entered. If a threshold is entered, the 

dimension is measured from the threshold. 

Report object as 

 

Using this setting a door can be reported as a window in the quantification. 

Selection 

Door shape 

 

Rectangular door 

Segment curve door 

Round-arch door 

Pointed arch door 

Four door shapes are available; rectangular door, segment curve door, round-arch door 

and pointed arch door. If the segment curve or pointed arch door is selected, the 

segmental arch height can be entered in the door parameters under dimensions or in 

the properties bar using the segmental arch height symbol. 
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Door jamb 

 

Without door jamb 

Corner jamb 

Embracing jamb 

Wooden jamb 

Dummy jamb 

On wall frame 

Free contour 

Here you can specify the style of door jamb. Note that the settings in the door jamb 

parameters have an effect on the difference between finished clearance and gross 

clearance. The detailed setting of individual door jambs can be configured in the door 

parameters in the detail parameters. 

Door symbol 

 

Standard curve 

Symmetric double casement 

Asymmetric double casement 

Sliding gate 

One-sided sliding door 

Two-sided sliding door 

Swing door 

Double swing door 

Passage 

Symbol selection first only refers to the symbol type. The stop direction and stop side 

are specified by the flip cursor when installing the door. If you need to modify the stop 

direction later, you can do this with the MODIFY DOOR STOP function in the 

properties bar. 

When installing a double door with different door leaf widths (asymmetric), you are 

asked for the width of one of the casements when installing. The installation side can 

then be specified with the flip cursor. 

Elevation in floor plan 

 

None 

Line 

Symbol 
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You can specify whether a threshold or a height difference of the floor should be 

represented. 

The representation can be switched off, or displayed as a line or as a line with symbol. 

The detailed setting of the slab elevation can be configured in the detail parameter of 

the slab elevation. 

Door stop 

 

Without stop 

With stop 

If "with stop" is selected, on the left you have the option to set the “door depth (in 

frame)”. Here the door depth (in frame) describes the gauge of the stop. 

The detailed setting of the stop can be configured in the detail parameter of the stop. 

Door lintel 

 

Type1 

Type2 

Without lintel 

Not visible 

The lintel line depiction in the floor plan is set using this button. There are two different 

types of lintel lines, which can be specified. The types are set in the representation 

levels: The top selection option here is type1, the middle type2. Type1 is dashed by 

default and type2 is a solid line. The third selection switches the lintel line depiction 

off, and the hatching is contiguous in the fourth. 

Lintel lines setting in representation level 

 

2D only in active storey 

 

The 2D depiction for multi-storey doors can be either in the own storey or in other 

storeys. 

Renovation planning – fill automatically 

 

If the status of a door is changed to demolition, the automatic generation of a wall that 

fills the hole can be triggered with this option. 
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Door detail parameters 

 

Here you will find other setting options for an individually customised door. Each of 

the buttons shown leads to another separate parameter dialog window. 
 

TIP 
Various settings in the detail parameter dialog window depend on the 

representation level. This means that when the representation level is 

refreshed, the doors are regenerated and adapted to the settings in the 

representation level.  
 

Representation levels create the conditions for covering several planning phases with 

one design model. This means that by simply switching, a door can be generated 

without a door jamb for the entry planning, and with a door jamb and an additional 

lintel height label for the work planning, for example. This always relates to the same 

door. Please also refer the Views chapter.  

If the representation levels are switched on (LAY-OUT > REPRESENTATION 

LEVELS), their settings take precedence. If you switch the representation levels off at 

this point or modify a door, the detail parameter window settings are taken into 

account. For more information in this regard, please refer to the "Representation 

levels" chapter. 

In order to express this dependency clearly, the respective sections of the 

representation level dialog windows are listed in addition to the detail dialog windows 

shown below. 

Door leaf parameters 

 

 

The 2D and 3D fields activate the door leaf.  

Symbol 

An opening symbol and angle can be selected for the door leaf. The opening angle 

only relates to the representation of the 3D door leaf; in the plan graphics the door 

curve is always shown as 90°. Note that all opened doors are hidden when creating a 

building section. 
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Dimensions 

The dimensions for the 3D door leaf depend on the door type. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

3D hatch 

 

The wall can be assigned a hatch that appears in the calculated hidden line views. 

Door leaf settings in the representation level 

 

Labelling parameters 

 

 

This dialog window covers the representation of automatically generated door labels. 

These can be fully switched on or off using the three tick boxes. 
 

The pen can be selected for the centre line. The length of the centre line can be entered 

absolutely or relatively to the length of the label. 
 

TIP 
Even when the centre line is switched off, the length of the centre line 

is used to determine the distance of the text from the door.  
 

The label is divided into two blocks, inside and outside the door. 
 

Opening-side label (above both selection boxes) 

 "Gross clearance" is the size of the wall opening (height of top of slab up to lintel 

bottom edge) 

 "Finished clearance" is the finished door clear opening (height of top edge of 

finished floor level up to door jamb bottom edge). 

 "Start pt net clearance" is the size of the exterior wall opening of a stop door (height 

of top of slab up to lintel bottom edge) 
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 "Start pt net clearance" is the size of the inner wall opening of a stop door (height 

of top edge finished floor level up to lintel bottom edge) 

 

 "Gross clearance from FFL/Thr." measures the height of the finished floor level 

top edge up to the lintel bottom edge. 

 "SW:+ST: (raw)" Swiss standard: here the lintel and threshold height of the door 

is counted towards the opening side depending on the setting of the specified lintel 

height parallel to the door. 

In the second selection box, the associated text parameters can be selected from the 

text database. The text parameters themselves can only be manipulated in the text 

parameter dialog window. 
 

Label of the specified lintel height (bottom three selection boxes) 

 "Gross lintel height" is top of slab up to lintel bottom edge 

 "Net lintel height" is top of slab up to door jamb bottom edge 

 "Lintel (gross) FFL" is top edge finished floor level up to lintel bottom edge 

 "Gross lintel from 0.0" is ±0.00 up to lintel bottom edge 

In the second field, the text parameter can be specified in turn. 

In the third field, a pre-text or post-text can be entered. 

A placeholder "< >" must be entered for the calculated value. 
 

Fire proofing labelling (two selections on the right) 

 "fire proofing" is oriented along the centre line 

 "fire proofing rotated" is oriented perpendicular to the centre line 

In the second menu, the text parameter can be selected. 

The checkbox enables or disables fire-proofing labelling. 

The fire proofing class is entered in the main dialog window. 
 

TIP 
The (finished) floor height defined in the structure settings for the storey 

is taken into account for the FFL height. However, if a room name has 

been assigned, the (finished) floor height used in it takes precedence 

over the "general (finished) floor height" in the structure settings. 

All settings options in this dialog window depend on the representation 

level. 

  

Label settings in the representation level 
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Door jamb parameters 

 

  

   

   

As well as the pen, 3D colour and material, the door jamb and the dimensions of the 

different door jamb types can also be entered. The dialog window appears differently 

depending on the door jamb type selected. 

In the left-hand column, the door jamb can be switched on/off in 2D and 3D. The line 

type is adopted from the door leaf parameters. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Door jamb settings in the representation level 

 

3D hatch 

 

The 3D hatch is use for depiction in calculated hidden line views. 
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Stop parameters 

 

A stop for the doors can be defined in the stop parameters. Settings in this dialog 

window only make sense if the stop is activated in the main parameter window. 

 

The shape of the individual wall layers in the stop area depends on the wall 

construction. As the wall composition is yet unknown when placing a new door, there 

is no preview and no settings can be configured yet. 

The correct layer gradient of the wall can only be determined when the existing door 

is edited. 
 

The stop detail editor consists of the preview, the list of the individual wall layers and 

the control. 
 

The stop editor for doors is identical with the stop editor for windows. The stop editor 

is documented in the chapter windows. 

Slab elevation parameters 
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In the detail parameters, you can specify the text parameter, the pen and line type of 

the slab elevation symbol. 

Door handle parameters 

 

 

The 2D and 3D fields activate the door handles.  

Selection 

 

A library part for the handle can be selected here. 

The menu which of up to 4 handles are configured (stop side and opposite side and 

optionally two more for a double casement door). If the first padlock is closed, the 

settings of stop side and opposite side are identical. If the second padlock is closed, 

the settings for both door leafs are identical. 

Dimensions 

The height and distance are measured relative to the door leaf. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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3D hatch 

 

The door handle can be assigned a hatch that appears in the calculated hidden line 

views. 

MODIFICATION FUNCTIONS 

Modify door stop 

 

This function is only active when the door is being edited. Once the door is placed, 

this function allows you to modify the hinge side and the opening side again. 

Placement points 

If a pre-existing door is edited, the original placement point of the door is indicated. A 

modification to the door width always takes effect from this point. 

The point can be moved to the reference points on the left, right and in the centre using 

the mouse. 

 

TIP 
After selecting the door, click on a handle or gripper of the contour to 

access manipulation functions directly in a toolbar or by using [TAB] 

with the cursor.  
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10.2 WINDOW 

 

Construction parts toolbar 

AR Objects menu > Create window 

The window and the roof windows and flat roof windows are joined in one function, 

but differ in principle in their setting options. This chapter is therefore divided into two 

sub-chapters. 

WINDOW 

When you click the CREATE WINDOW function, the settings are copied from the 

most recently placed window and the window can be placed immediately. The Position 

of window query appears in the entry line. 

WINDOW PROPERTIES BAR 

 
The properties bar becomes visible as soon as the CREATE WINDOWS function is 

launched or if an existing window is edited. 

You can manipulate the main values in the properties bar.  
 

 
Window parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Window shape 

 
Window width 

 
Window height 

 
Height of w-base 

 
Depth 

 Niche 

 Fill automatically (renovation planning) 

 Lintel depiction 

 Window height 

 Entry from 

 
Division editor 
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Stop type / Stop editor 

WINDOW PARAMETERS 

 

You can open the window parameters via the properties bar or by double-clicking the 

window to be modified. 

   CH+F:  

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Material 

The material is taken into account in the report. Any name can be chosen, simply 

entered in the dropdown box and confirmed with [Enter]. If you want to remove a 

name from the dropdown list, enter it with a preceding minus sign and confirm with 

[Enter]. 

Parameter management 

The settings are saved in the ar (architecture)-config.val (see document for 

ELITECAD configuration).  

A drawing with the name window_parametername.d is also saved in the same 

directory. The drawing for the most recently used current parameter with the name 

window_act_.d is also saved there. 

All special settings such as free contours and free stops are also saved in the drawing. 
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Recommendation 

The following procedure is recommended in order to limit the time required for 

assembling the parameter list: 

Reduce saved parameters to the essentials. 

Save windows with special settings with the corresponding wall construction in a 

separate overview drawing or library. If one of these windows is required later, it can 

be edited and saved as a parameter. 
 

You can find a large number of window examples in the "Glass constructions" example 

object. This can be adopted as a parameter and saved. 

Stop type 

   

Overview 

The settings in system control, region and language options influence the gross 

clearance/finished clearance window dimension entries. 

For the country settings Switzerland and France, the outer sill is always measured from 

the top side. 
 

In all other settings, the inner bare parapet top side is definitive for the gross clearance. 

For the finished clearance, the finished inner parapet top side (inner window sill) or 

exterior window sill can be selected. 

Window without stop  

 

 

Gross clearance and finished clearance. Difference due to plaster gauge and blind 

Window with stop 
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Gross clearance and finished clearance as for the window without stop. 

The gauge of the stop stone for the cavity wall is determined by the exterior wall layer 

as standard. This can be edited in the stop editor. 

Window with external insulation (composite thermal insulation system) and 

back-ventilated facades 

 

 

The gross clearance refers to the solid wall. The stop width and blind reduce the gross 

clearance to finished clearance. 

As standard, the outer layers are drawn into the reveal without an air layer. This 

reduces the total gauge of the layers to the stop width. 

 

The gross clearance (wall aperture) can be selected for the opening dimension. 

Walling 
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Walling clearance dimension 

Window with internal insulation 

 

 

Gross clearance and finished clearance. Difference due to plaster gauge and blind  

Copy parameters 
 

 Stop   

 
Stop parameters 

 * 

Window dimensions 

There are different entry fields available depending on the selected window shape. 

The numerical data with a grey background on the left of the field provides entry help. 

This is always the addition of the window height and parapet height depending on the 

remaining entries (e.g. from raw slab).  

Entry 

Gross clearance/Finished clearance 

There is a choice between the entry style gross clearance (wall clearance) and finished 

clearance for entering the window opening dimension clearance.  

The difference depends on the stop type selected. 
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TIP 
The window is represented in 3D without side joints between the on wall 

frame and the raw opening. When the joint is switched on, a 2D line is 

represented in the plan graphics.  

Parapet height entry style 

The parapet height entry style only applies how you enter your dimensions for the 

parapet, so whether you specify a rough dimension or a finished dimension.  

Bare parapet height = raw storey floor top edge or level floor to bare parapet top 

edge without window sill. 

Finished parapet height = top edge finished floor to top edge interior sill. For the 

France and Switzerland country setting, up to window sill top edge. 

The (finished) floor height is defined for storeys in the structure settings. If a room 

name is set, the (finished) floor height assigned there takes precedence over the 

structure setting. 

External reveal depth 

 

Entry in the properties bar (illustration) or in the window parameter.  

Recess/Recess for radiator 

The width corresponds to the external frame dimension plus joints. Input in the 

window parameters. 

Window doors: If the lower window frame is at floor height, a recess must always be 

set with the depth of the inner reveal. 

Outside recess 

If this option is activated, the floor/outer covering is drawn as a recess to the window 

frame as soon as the bottom edge of the frame lies lower than the top edge of the outer 

covering. 

Report as 

The window can be quantified as a window or a door. 

Opening in 3D 

 

This setting is generally active. Optionally a generation of an opening into the 3D wall 

can be deactivated. In that case, only a 2D depiction of a window is generated in the 

wall. 

2D only in active storey 

 

The 2D depiction for multi-storey windows can be either in the own storey or in other 

storeys. 

Renovation planning – fill automatically 

 

If the status of a door is changed to demolition, the automatic generation of a wall that 

fills the hole can be triggered with this option. 
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Renovation planning 

 

If a window is changed to demolition state, a wall is created to fill the opening 

automatically. 

Copy parameters 
 

 General   

 Window shape   

 Width   

 Height   

 Parapet height   

 Depth   

 Recess for radiator   

 Outside recess   

 Layer   

 Material   

 Casement rod lay out  * 

 Glass composition   

 
 

 

 

 

 

Lintel  
 

 

 

 

 

dashed 

contiguous 

without  

contiguous 

contiguous with window 

 
 

 

 

Enter size 

 
 

 

Gross clearance 

Net finished dim. from inner sill 

Net finished dim. from outer sill 

 
 

Enter the start height  
 

Input from bare base 

Input from finished floor 

 Gross/finished lintel   

 Side plaster gauge   

 Report   

 Frame   

 Floor plan depiction   

Window shape 

                    

There are 14 different shape types available for selection. The first 12 of these shapes 

are standard shapes, which have clearly defined outer contours (shape of the window 

reveal). 

 WORKSHOP  

Corner window 

Work plane is on the normal storey work plane. 

1. CREATE WINDOW function 

 

2. Select corner window shape. 
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3. As an additional value for corner windows, the window frame widening of the 

corner frame (left) and the window frame width for the corner frame (right) can be set. 

The window frame width = 0 setting transfers the window frame width from the frame 

detail parameter. 

 

4. Place the window by entering both corner points and the direction of the corner 

window. 

        

5. In order to define a frameless corner window it is necessary to deactivate to corner 

column. Additionally the frame width at the corner has to be set to 0. In such cases, 

the corner element may not be defined as a window that can be opened. 

  WORKSHOP END 

 

The window by free form shape allows you to define a free window contour. This 

contour should lie "on the wall" i.e. the work plane is positioned on the wall surface 

and a closed polygon is drawn there. Note here that windows of this shape are generally 

installed from the outer side of the wall. Various options (blinds, window sill, walling, 

etc.) are not available for this shape. 

 WORKSHOP  

Window by free form 

Place your work plane on the building outer shell (so that the window opens inwards). 

There are various ways to do this, e.g. by switching on the solid view [Ctrl]+[D], 

opening the WORK PLANE ON SURFACE function and selecting the wall view. 
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Draw a closed polygon as an exterior window contour. All of the drawing functions 

and help geometry are available here. 

Run the WINDOW function to convert to a window. Select the WINDOW BY FREE 

FORM window shape and assign this to the drawn contour.  

  WORKSHOP END 

 

The window by free rectangle shape is a simple tool for entering rectangular windows 

in 3D. Position the work plane on the wall. When opening the WINDOW function, 

only the bottom left and top right corner of the opening are queried. All further 

depiction variants result from the parameters set. 

 WORKSHOP  

Window over multiple storeys 

A window over multiple storeys can normally be set in the floor plan in the lowest 

involved storey. The correct height can be directly entered for the window height. The 

window is created contiguously in all storeys with one floor plan per storey. The wall 

axes must be exactly over each other. 
 

You can also proceed in the same way as the WINDOW BY FREE FORM function 

(previous workshop) and place the work plane on the wall. 

Drag the window to the facade with the WINDOW BY FREE RECTANGLE function. 

Left lower corner, then right upper corner. 

  WORKSHOP END 

Copy parameters 
 

 General   

 Window shape   

Depiction 

  With window sills     without window sills 
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Example with window recess and blind. Representation type 5 is shown above twice: 

the second-lowest series with window sills, blinds and recesses switched on. 
 

No lintel lines are shown when window sills are switched on. 

 Type 1 dotted lintel lines.  

 Type 2 solid lintel lines. 

 Type 3 no lintel lines. 

 Type 4 contiguous lintel (hatch) with window. Blinds and recesses are switched 

off in the example.  

 Type 5 contiguous lintel (hatch).  
 

The window sills, blinds, recesses etc. can be switched on or off for all types in the 2D 

depiction.  
 

TIP 
For type 4 "Lintel continuous with window", the pen and line type for 

reveals and frames can be selected in the 2D representation.  

  

Representation levels parameters  

Type 1 + 2 are set in the representation levels parameters dialog window. 

 

If the representation level is refreshed or changed, then the settings of the 

representation level parameters are adopted. 

Copy parameters 
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Lintel  
 

 

 

 

 

dashed 

contiguous 

without  

contiguous with window 

contiguous  

Window detail parameters 

 

Here you will find additional settings options for an individually customised window. 

Each of the buttons shown leads to another separate set-up dialog window. 
 

TIP 
Various settings in the detail parameter dialog windows depend on the 

representation level. This means that when the representation level is 

refreshed, the windows will be regenerated and adapted to the settings 

in the representation level.  
 

Representation levels create the conditions for covering several planning phases with 

one design model. This means that by changing the representation level, the window 

can be provided with a profile representation for the input planning which differs from 

that in the work planning. This always relates to the same window.  

If the representation level is changed or refreshed (SETTINGS > 

REPRESENTATION LEVELS) and "Refresh design model + views" is confirmed 

with OK, then the pre-settings of the representation level are adopted. 
 

In order to express this dependency clearly, the respective sections of the 

representation level dialog windows are listed in addition to the detail dialog windows 

shown below. 

Outer sill 

 

Overview 

 

Window sills of type 1 and 2 are in front of the window frame. 

Window sill type 3 corresponds to the French construction type. 

Window sill type 4 is for windows, which open outwards. 
 

The 2D and 3D fields activate the window sill.  

If 2D is activated, the lintel line is shown with pen 0 (=not printed). 
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The side widenings can have different values on the left and right. 

Low window sill (type 1) 

 

The cross-section is defined with front height, sill height and projection. 

"Parapet offset" defines the difference in height between the bare parapet on the inside 

and outside. 

The value with a grey background shows the protrusion of the top edge of the frame 

over the window sill. 

High window sill (type 2) 

 

Entries the same as type 1 

France window sill (type 3) 

 

The cross-section is defined with the front height and the height, the projection (offset) 

and the distance to the frame line ("sill depth offset). 

"Parapet offset" defines the difference in height between the bare parapet on the inside 

and the top edge of the window sill. 



Chapter 10 – Extension  

www.elitecad.eu  734 

Window sill for windows which open outwards (type 4) 

 

Entries the same as type 3 

Create sill from free contour 

1. Before the free contour can be defined as a window sill, the dimensions and 

positions must be preset in the detail parameter. 

2. Draw the window sill contour in the floor plan according to the main dimensions 

of the existing window sill. The contour should remain upright regardless of how 

the window axis is lying in the floor plan. 

 

3. Edit window (click on the window) and open the WINDOW PARAMETERS set-

up dialog window. 

4. Start definitions with the button "Define window sill from free contour" in the outer 

sill detail parameter. 

 

5. Capture point of reference (exterior, bottom edge of joint below) 

6. Define any point in the direction of the inner edge. 

7. Close all set-up dialog windows by clicking OK. 

point direction inner edge 

reference point on 
exterior, bottom edge 
(joint below) 

joint 
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Alternatives when defining 

 

With the WORK PLAN ON SURFACE function, click on the surface of the frame 

side. 

Draw the frame contour in this work plane and then proceed as above. 

Note 

This window can be saved as a parameter. 

The sill depth is also fixed when modifications are made to the w-frame depth (in 

wall). 

The values cannot be changed in the outer sill detail parameter, with the exception of 

the side widenings. 

Delete free window sill 

 

The window sill is reset to a standard cross-section using the "Delete free contour" 

button. 

Representation levels parameters 

Representation in 2D/3D and the 2D depiction pen depend on the representation level. 

 

Copy parameters 
 

 Outer sill   

 Represent in 2D   

 Represent in 3D   

 Sill type   

 Height   

 Front height   

 Offset   

 Parapet offset   

 Side widening left   

 Side widening right   

 Sill depth offset   

 Cross section contour    

 Pen   

 3D depiction   

 Material   

Inner sill 
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The 2D and 3D fields activate the window sill. 

If 2D is activated, then the 2D depiction of the lintel is switched off. 

If there is no inner sill (e.g. the parapet has tiles in the bathroom), then neither 2D nor 

3D should be switched on. 

The following does not apply for the country setting France and Switzerland: 

"Take gauge as plaster" should be activated for finished dimensions from the top edge 

of the inner window sill. Otherwise, the sill height is set to 0 cm. This means that both 

the finished parapet height and the finished clearance can be set correctly. 

Side widenings 

 

The side widenings can have different values on the left and right. 

Inner sill from free contour 

An inner sill can be defined as well as the frame leg in the w. frame parameters. 

Representation levels parameters 

Representation in 2D/3D and the 2D depiction pen depend on the representation level. 

 

Copy parameters 
 

 Inner sill   

 Represent in 2D   

 Represent in 3D   

 Gauge   

 Offset   

 Offset sill   

 Pen   

 Line type   

 3D depiction   

 Material   

Window frame parameters 
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The floor plan detail and a section of a window are shown in the dialog window. 

2D depiction in floor plan (w.frame) 

 

Three profiles are available for selection in the floor plan:  

Simple 2D line. The 3D depiction can be set independently of this. 

Double 2D lines with frame and casement limitations. 

Frame and casement with different gauges and offset. 

Block frame and casement (window opening outwards). 

Copy parameters 
 

 Frame   

 
 

 

Floor plan depiction  
 

 

Line 

W.frame and casement equal 

W.frame and casement separated 

Style of the casement stop 

   

Frame settings 

The tick boxes for casements, frames and joints affect the 2D depiction in the floor 

plan. The side joints are represented in 3D. 

In the section, you can use the tick box to select whether the joint should be represented 

in 3D for the top and bottom joints. For a type 5 blind lying above, the joint widths 

above the blind height should correspond. 

W-frame in 3D and Casement in 3D switches the entire representation of the window 

profile in 3D on or off (when switched off, glazing can be generated in the raw window 

cavity!) 

Copy parameters 
 

 Frame   

 Floor plan depiction  Line 

W.frame and casement equal 

W.frame and casement separated 

 
Normal frame/block frame  Normal frame 

Block frame 
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 Casement gauge   

 Casement offset   

 Window frame gauge   

 Casement   

 Casement frame width   

 Frame   

 Side joint   

 Side joint width   

 W-frame in 3D   

 Casement in 3D   

 Frame width up   

 Frame width bottom   

 Frame width left   

 Frame width right   

 Top joint width    

 Bottom joint width   

 Top joint in 3D   

 Bottom joint in 3D   

 Left joint in 3D   

 Right joint in 3D   

 Pen   

 Line type   

 3D frame representation   

 3D casement representation   

Opening symbol floor plan 

     

No symbol  

Turn casement 1/3 open 

Turn&tilt casement 1/3 open  

Turn casement open 

Turn&tilt casement opened 

Copy parameters 
 

 Symbols   

 Pen   

 Line type   

 Floor plan depiction opening  No symbol  

Turn casement 1/3 open 

Turn&tilt casement 1/3 open  

Turn casement open 

Turn&tilt casement opened 

 Geometry  * 

Opening direction 

  

Opening inwards or outwards 

Define frame, limb and casement frame from free contour. 

1. Before the free contour can be defined, the dimensions and position must be preset 

in the detail parameter. 

2. The profiles are created using the desired detailing. The contours should remain 

upright regardless of how the window axis is lying in the floor plan. Each contour 

must be an individual polygon. 
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3. Using help lines, fix the frame outer edge and bottom edge of the frame. 

 

Example: France window construction with padding 
 

4. Edit window (click on the window) and select Frame in the window parameter 

detail parameter. 

 

5. Start definitions using the contour button. 

6. Capture point of reference (exterior, bottom edge of joint below). 

7. Define any point in the horizontal direction of the inner edge. The contour is 

adopted with <APPLY>. 

8. Close input window with OK. 

bottom frame 

point direction inner edge 

reference point on 
exterior, bottom edge 
(joint below) 

exterior edge frame 
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Window defined with free contours for window sill + window frame 

Note 

The contour is adjusted to the required width for different window frame widths 

(according to the frame detail parameter). 
 

An inner window sill can also be defined with the frame leg. 
 

The contours can also be defined using the window editor. 

Representation levels parameters 

All profile depictions including the profile pen depend on the representation level. 

 

Assembly frame + padding 
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An assembly frame or padding can be specified using this dialog window. 

Assembly frame 

 

An assembly frame can be defined on the four sides of the window frame. 

The position is determined by the distance to the window frame (joint/net offset) and 

by the depth (offset).  

The cross-section is given from the width and the gauge. 

The 2D and 3D fields activate the assembly frame. 

The assembly frame can also be used for a dummy frame. 

Padding 

Padding can be defined on the side and at the top (see illustration in last chapter). 

The position is determined by the difference to the outer gross clear dimension (joint 

/ net offset) and by the depth (offset).  

The cross-section is given from the width and the gauge. 

The 2D and 3D fields activate the padding. 

Copy parameters 
 

 Assembly frame/padding   

 Represent in 2D   

 Represent in 3D   

 Execution  Assembly frame 

Padding 

 Width   

 Depth   

 Offset   

 Joint / net offset   

 Pen   

 Line type   

 3D depiction   

Blind / net curtain 
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Overview 

 

The 2D and 3D fields activate the blind. 

Side widenings 

 

The side widenings can have different values on the left and right. 

Types 

      

Type 1 on facade outer side 

Type 2 + 3 on outer side of frame 

Type 4 for renovations between lintel and frame 

Type 5 for external insulation and back-ventilated facade, position freely definable 

Type 6 over the frame, for solid angle constructions 

Blind on facade (type 1) 

 

The offset causes the position to be adjusted to the finished net clearance. 

Blind on outside of frame (type 2) 

      

The offset can also be larger than the cabinet height (illustration on right). 

No wall layers are imported in the lintel in type 2 (centre illustration). 
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Reference marker for opening dimension and height marker:  

Gross lintel inside and bottom edge of cabinet (net lintel height). 

Blind on outside of frame (type 3) 

    

For type 3, the wall layers are imported according to the STOP setting. 

Blind between window frame and lintel (type 4) 

 

The top edge of the window frame is automatically adjusted due to the cabinet height. 

Blind position freely definable (type 5) for walls with external insulation 

       

Blind type 5 is particularly suitable for facades with external insulation. 

The cabinet can be positioned on the outer side of the frame (e.g. for gathered slat 

blinds) or can lie above the frame (blind). 

The entry style differs somewhat from the other types as a result. 

 Offset: Value for the difference between finished clearance and gross clearance. 

The offset must equal the cabinet height for blinds above the frame. 

This dimension determined for the offset is important for the entry of gross 

clearance and finished clearance, as well as for the opening dimension. 

 The position of the cabinet is independent of the frame. 

 If the blind cabinet is above the frame and the lintel over the cabinet, the cabinet 

height must be entered for the joint above and for the offset. 
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Reference marker for opening dimension and height marker:  

Gross lintel inside and bottom edge of the cabinet (net lintel height) = bottom edge of 

insulation. 

Blind with angle (type 6) 

 

Blind type 6 is suitable for solid constructions. 

Reference marker for opening dimension and height marker:  

Gross lintel exterior and cabinet height 

Inside label: The reference height for the lintel height is measured for the top edge of 

the cabinet. 

Copy parameters 
 

 Blind   

 Represent in 2D   

 Represent in 3D   

 Blind type   

 Width   

 Height   

 Offset   

 Depth   

 Pen   

 Line type   

 3D depiction   
 

For all types, the offset is the difference between gross lintel and the bottom edge of 

the blind (net lintel height). 

Blind case 

 

The 2D and 3D fields activate the blind case. 

The position is determined by the distances to the wall and reveal. 

The shape is given by the window frame width and the gauge. 
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The CAD calculates the blind width and height from the settings of the window 

opening and the number of blinds. 

The 3D hatch is set as the blind infill and can be seen in views and sections. 

Copy parameters 
 

 Blind case   

 Represent in 2D   

 Represent in 3D   

 Number left   

 Number right   

 Window frame width   

 Distance to reveal   

 Gauge   

 Distance to wall   

 Pen   

 Line type   

 3D hatch   

 3D depiction of frame   

 3D depiction of interior part   

Window walling 

 

 

 

This is activated with the stop for the window walling. 

The lintel gauge, side gauge and walling offset produce the side and upper cross-

section depending on the w-frame depth (in wall). 

The window sill is determined with the window sill height, front height and offset. 

The difference from the inner to the outer parapet is entered for the parapet offset. 

The cross-sections are hatched in the floor plan and section using the hatching 

parameters. 

Copy parameters 
 

 Walling   

 Represent in 2D   

 Represent in 3D   

 Gauge   
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 Offset   

 Parapet offset   

 Pen   

 Line type   

 Hatch   

 3D depiction   

 Lintel   

 Gauge   

 Outer sill   

 Represent in 2D   

 Represent in 3D   

 Height   

 Front height   

 Offset   

 Parapet offset   

 Side widening left   

 Side widening right   

 Pen   

 3D depiction   
 

The side widenings of the window sill are not active for the walling. 

Labelling parameters 

 

 

Alternative 1: Label inside, centre line and large text on centre line 

 

Alternative 2: Height marker 
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General 

A pre-text and a placeholder with <> for the value calculated by the CAD are entered 

for each label field. 

The text parameters are selected from the general parameter database.  

In order to manipulate text parameters, please select the dialog window for the text 

parameters in the menu LAY-OUT > TEXT > TEXT PARAMETERS. 

Height marker (Switzerland) 

The height markers are activated at the top left. This switches off the large text on the 

centre line. If the selection box on the right of the blind is activated, the bottom edge 

of the blind is only given if a blind is present. 

The pre-text (e.g. top edge floor height) and ±<> is written into the floor plan. 

The font parameter is selected above. A parameter should be selected in the block style 

for an optimal representation. 

The distance of the text block is determined on the right (for the centre line). 

Inside label (Austria) 

 

Activation using the box under the floor plan. 

 

The label corresponds to the specifications of OE standard A 6240-2. 

Bare parapet = rough dimension top of slab up to bare parapet height (without inner 

window sill). 

Finished parapet = finished dimension top edge of finished floor level to top edge of 

interior sill. 

For the markers GR-PAR = bare parapet, F-par = finished parapet, and LIN-US = 

bottom edge of inner lintel, the initial height can be selected from the top edge of the 

bare ceiling, finished floor or from ±0.00. 

The type of output in the floor plan is determined in the dropdown box (illustration 

above). 

If the markers for GR-PAR+LIN-US are selected, the values should be separated with 

";" e.g. 

GR-PAR <>;LIN-US <> 

The font parameter is selected in the centre at the bottom. 
 

TIP 
The types rough or finished dimension write the actual dimension of the 

drawn window into the plan graphics, regardless of which entry style is 

used for constructing the window! 

The (finished) floor height defined in the structure settings for the storey 

is taken into account for the FFL height. However, if there is a room 

name, the (finished) floor height used in it takes precedence over the 

"general (finished) floor height)" in the structure settings.  
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Large text on centre line 

Activation of large text in the dialog window using the box on the left. This switches 

off the height markers. 

You can select: 

 Gross clear dimension 

 Finished clear dimension from the outer window sill (architecture line) 

 Finished F-par clear dimension from the inner window sill (OE standard) 

The rough dimensions are calculated without stop width when the stop type "Window 

with external insulation" is switched on. 

Recommendation for finished clear dimension: Use F-Par type when this style is 

selected for entering window dimensions. 

Centre line and distance of height marker to the window. 

On the right, the length of the centre line can be entered absolutely or relatively to the 

length of the label. The distance of the height markers is determined at the same time. 

Representation levels parameters 

The following settings are active when a representation level is changed or when 

refreshing the representation level: 

 

The above font parameter also applies for the height markers. 

 

The button on the right of the blind cabinet is used to write only the bottom edge of 

the blind when a blind housing is present. 

 

Copy parameters 
 

 Label   
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 Window height marker   

 Depict large text   

 Large text  Gross clearance 

Finished clearance 

F-Par 

 Size/Height notation text 

parameters 
  

 Depict parapet text   

 Parapet text  Bare parapet 

Finished parapet 

Gr-PAR+LIN-US fr US Slab 

Gr-PAR+LIN-US fr FFL 

Gr-PAR+LIN-US from +/- 0.00 

 Parapet text parameters   

 Parapet text format   

 Parapet text spacing (mm)   

 Centre line   

 Length of centre line over  Length 

Distance to window 

 Length of centre line (mm)   

 Pen for centre line   

2D/3D depiction 

  

  

2D depiction 

Setting the pen and line type 2D depiction for all window parts activated in the dialog 

windows. The 2D can be switched off in the tick boxes. 

The grey background means "undefined". 

This makes the components of the window immediately apparent. 

Opening in special case: Active if "Lintel continuous with window" is selected for 

the representation.  

3D depiction 

Colour mode/Material mode 
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These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

3D hatch 

 

 
Every sub element of a window can be assigned a hatch that appears in the calculated 

hidden line views. 
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Stop editor 

 

Stop editor in the window parameters 

      

Selection of stop in the window parameters 

      

Open the stop editor to select the stop in the properties bar. 
 

1. Without stop 

2. Stop for solid construction 

3. Stop for facades with external insulation 

4. Stop for window walling 

5. Stop for walls with internal insulation 
 

The stop editor can be opened directly in the properties bar. 
 

The gradient of the individual wall layers in the stop area depends on the wall 

construction and the stop type. As the wall composition is yet unknown when placing 

a new window, there is no preview and you cannot yet configure settings. 

The correct layer gradient of the wall can only be determined when the existing 

window is edited. 

Depending on the stop type chosen, the stops are defined differently by the CAD. 
 

The stop detail editor consists of the preview and the list of the individual wall layers. 

Preview 

A preview first appears when you edit a window. 

It is preferable to work in contour mode: CTRL + K. 

 

The OPTION menu defines which region is displayed in the preview window. 
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Main wall / side wall 

 

The red marked area is only active if a side wall exists. Here the stop settings for a side 

wall can be configured. 

The settings for the main wall are configured below the graphics window and for the 

main wall layers right beside the graphics window. 

Stop for solid constructions 

  

   

For the stop for solid construction, the external layer is imported with the layer gauge 

and the insulation is cut out. 

List of wall layers 

The wall layers are listed here. This list is only correct if you edit a window; when you 

place a window, the last values are always shown, as the program assumes that you 

are placing the window in the same wall. 

In the column "Draw wall layer into reveal", you can decide for each layer with a tick 

in the tick box whether the respective layer should be drawn into the reveal.  

For each individual layer, the value of the gauge with which the layer goes into the 

reveal can also be manipulated. 
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Stop for facades with external insulation 

  

 

For the stop for facades with external insulation, the exterior layer is imported with the 

layer gauge. The CAD calculates the gauge of the insulation layer drawn into the 

reveal: Stop width less cladding. The "air" layer is treated by the CAD as a special 

layer and is not taken into account. 

For the opening dimensioning, the raw opening of the load-bearing layer can be 

dimensioned using this stop type. 

Stop for walling 

  

Walling requires additional settings. These are entered in the window walling detail 

parameter. 

Stop for walls with internal insulation 

  

 

If the outermost layer should not be dragged inside, set the gauge to 0. 

Side wall 
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No value   with extension   drag into reveal 
 

The option LENGTHEN FREE STOPS AT SIDE WALL means that the stop is 

tangentially extended to the side wall. 

Control 

 

Stop 

Left, right, top and bottom. 

If the lintel stop is inactive, this is overridden by a blind setting. 

Window combinations 

In order for two individual windows to be closed together (e.g. window with window 

doors), the stop must be set to 0 for the combination and the tick removed in the box 

below it (in the illustration for the stop on the right). 

Define free stops 

In order for free stops to be defined, the window must have been set previously with 

normal stops. 

The free stops are drawn directly into the preview window. 

Free stops are only defined for the wall layers, which differ from the automatic stop. 

The window can be saved as a parameter. 

Limitation: Free stops do not match modified window depths (in wall). 

Procedure 

Select the stop side with the Display button. 

 

Set the contour in the preview window using the help lines. 
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Draw contour for layer in the preview window: From layer outer side point 1 to layer 

inner side point 2. Double-click to close. It can also be started from the layer inner 

side. 

 

An individual contour must be drawn for each layer to be modified. 

     

The parameters of this type of window can be passed on using the COPY 

PARAMETERS function. 

 

The function DELETE FREE STOP removes a drawn stop again. You need to click it 

with the mouse in the preview window. 

Notes 

Windows with free stops can be saved as parameters. 
 

Modify wall layer gauges and w-frame depth (in wall): 

 Point 1 + 2 stay on the layer border. 

 All elements of the contour maintain their original length, with the exception of 

the last element for point 2.  

 If the contour only consists of one element (as in the first example), then this is 

dragged to the new length between point 1 + 2. 

 It follows from this that: A change to the w-frame depth (in wall) requires a 

modification of the layer gauge and is only possible for simple contours (first 

example). 

Tool for window division/muntins 

 

The window editor can be launched using the button in the window parameter or in 

the properties bar. 

This tool allows you to set the window divisions manually. All window divisions, 

which are no longer possible with the WINDOW DIVISION or MUNTINS function, 
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can be set using this function without any problems. The functionality is explained in 

the Glass element section. 

MODIFICATION FUNCTIONS 

Placement points 

If a pre-existing window is edited, the original placement point of the window is 

indicated. Modifications to the window width always take effect from this point. 

The point can be moved to the reference points on the left, right and in the centre using 

the mouse. 

 

Move the placement point with the mouse. 
 

TIP 
After selecting the door, click on a handle or gripper of the contour to 

access manipulation functions directly in a toolbar or by using [TAB] 

with the cursor.  

ROOF WINDOW 

When you click the CREATE WINDOW function, the settings are copied from the 

most recently placed window and the window can be placed immediately.  
 

Once the values have been entered in the parameters, a roof plane must be selected for 

positioning the roof window then the position in the floor plan and finally the direction 

of the opening are set. 

If the roof window is placed on a flat roof, the horizontal orientation can also be 

determined. 

ROOF WINDOW PROPERTIES BAR 

 

The properties bar becomes visible as soon as the CREATE WINDOW function is 

launched or if an existing window is edited. 

You can manipulate the main values in the properties bar.  
 

 
Window parameters 

 Type 
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Renovation planning state (see chapter 8.5) 

 
Window shape 

 Predefined window 

 Window frame width 

 Window frame length 

 Installation depth 

 Frame bearing area 

 Trimmer 

 Style of position 

WINDOW PARAMETERS 

 

The set-up dialog window for the window is opened with the WINDOW 

PARAMETER function. The settings of this dialog window are maintained. If the 

dialog window is closed and reopened, the status most recently set is still available.  

 

General parameters 

   Status renovation planning 
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  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Material 

The material is taken into account in the report. Any name can be chosen, simply 

entered in the dropdown box and confirmed with [Enter]. If you want to remove a 

name from the dropdown list, enter it with a preceding minus sign and confirm with 

[Enter]. 

Dimensions 

 

Lib part: 
 

Predefined window free window 

    

Here you can either select from a list of predefined windows (library part in 

combination with predefined manufacturer dimensions) or you can select a library part 

using a free mode and the desired dimensions can be freely defined. 

The free Lib parts with the corresponding attributes are stored under 

 <ELITECAD installation directory>u\<version>\ar\glob\l\roofwindow\slant, or  

<ELITECAD installation directory>u\<version>\ar\glob\l\roofwindow\flat 

Stop 

  

The installation depth can be determined here and also the frame bearing area for roof 

windows. 
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Parameter 

Active side 

 

The settings in the dialog window always refer to the active side. 

Number of edges 

 

A side can consist of one edge or two edges. All sides should have the same number 

of edges to avoid geometric errors. 

1 edge 

  

An edge can run in four ways. Any angle can be entered in the "Angle" variant. If the 

opening does not have enough space in the roof with the specified angle, the edge is 

created vertically. 

2 edges 

The lengths can be determined for the first edge. You can select how the length is 

measured. An edge can be horizontal, but the distance is measured perpendicularly to 

the roof plane. All sides should have the same length to avoid geometric errors. 

 

One of the four alternatives for the edge course can be selected for each partial edge. 

Example of an opening with two edges. Both "right" and "left" sides are also defined 

with two edges, although one edge would suffice. 

normal 

angle 

horizon. 

perpen. 
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Cross-section Long section 

    

A warning appears if the edges do not meet at the corners. 

 

Keep stops: 

In this case, you will have to consider geometric errors. 
 

Adjust stops: 

In this case, a dialog window appears with all of the settings for each side. You can 

decide which stop should be used as a reference. 

perpendicular 

horizontal 
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Trimmer 

  

Here you can decide whether a trimmer should be drawn for the roof cut-out. 

The trimmer distances correspond to the manufacturer's information but can be 

adjusted if necessary. The trimmer parameter dialog window opens if only the trimmer 

is edited.  

 

Description chapter 9.9 

Entry: 

The roof window can either be set in the floor plan or placed above the height of the 

bottom edge. If the roof height or inclination is changed, the roof opening is refreshed 

according to the entry. 
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Position by floor plan 

 

Position by height 

 

The height of the roof at any point can be measured with the HEIGHT IN POINT 

function. 

Window shape 

Roof window 

 

 

Flat roof window 
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Window detail parameters 

 

Here you will find additional settings options for an individually customised window. 

Each of the buttons shown leads to another separate set-up dialog window. 

Padding 

 

 

The distance, gauge, width and lengthening can be entered. 

The 2D and 3D fields activate the padding. 

Covering frame - Joint 
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A depth and the distances can be entered. 

The 3D fields activate the joint. 

Labelling parameters 

 

 

Label 

The text parameters are selected from the general parameter database.  

A pre-text and a placeholder with <> for the value calculated by the CAD are entered 

in the label field. 

Large text 

The external frame dimension, the gross clearance or the finished clearance (lining 

dimension) can be labelled. 

Centre line  

Here, the length of the centre line can be entered absolutely or relatively to the length 

of the label.  
 

Representation without centre line  Representation with centre line 
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2D/3D depiction 

  

     

2D depiction 

Setting the pen and line type 2D depiction for all window parts activated in the dialog 

window. The 2D can be switched off in the tick boxes. 

The grey background means "undefined". 

This makes the components of the window immediately apparent. 

3D depiction 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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10.3 GLASS ELEMENTS 

 

Construction parts toolbar 

AR Objects menu > Glass element 

The advantage of the window glass element is that a glass element does not require a 

wall. 

This creates the option of constructing glazing anywhere in the room for all variation 

options, or whole glass facades or conservatories. It is preferable, however, to create 

glazed roofs with the ROOF function, as these separate the volume (important for 

volume calculations for rooms). 

 WORKSHOP  

Create glass element  

START GLASS ELEMENT function. 

 

Set the entry mode in the properties bar to "Draw roof contour manually". 

 

Now draw the glass element's axis. Later you will define whether this is the outer or 

inner side. 

To end entry, click again on the last point. 

 

Now define the direction in which the glass element should be drawn. Move the mouse 

from one side to the other. One you have reached the correct position, confirm by left-

clicking. 

Keep in mind that the glass element gauge is always modified from the axis outwards. 
 

Contour exterior 

 

Contour inside 
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Confirm the position by left-clicking. 

 

Once the direction is confirmed, the glass element is created and a dialog window 

opens for the window division of the first part.  

 

Enter the properties for the frame: dimensions, colour properties. You can also make 

adjustments by clicking on the glass parameter ( ). You can return to the frame 

properties with the control arrows ( ). 

In each case, do not forget to click the "Apply" button to adopt the settings.  

  WORKSHOP END 
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Alternatives to glass element 

Window 

For perpendicular, rectangular constructions, the window can have advantages over 

the glass element in many areas. 

A wall must be drawn with the length, height and gauge of the frame. Then a window 

without a stop is set with depth 0. 

Advantages: 

Blinds and window sills can also be set. 

The corner window also has additional settings options in corner areas. 

Roof 

The roof construction can also be used for glass construction by setting transparency 

for the 3D colour. The position of the bearing construction can be more precisely 

determined with the truss elements (rafters, etc.). 

General 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

GLASS ELEMENT PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE GLASS ELEMENT function is 

launched or if an existing glass element is edited. 

You can manipulate the main values in the glass element's properties bar. 
 

 
Glass element parameters 

 
Renovation planning state (see chapter 8.5) 

 
Entry mode 

 
Height reference 

 
Glass element width 

 
Glass element height 

 
Height difference from the glass element's bottom 

edge to the current work plane 

 
Window frame width 

 
Window frame gauge 

 Room dividing 
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Properties of frame (depiction) 

 
Properties of window pane (depiction) 

TOOL FOR WINDOW DIVISION / MUNTINS 

For glass elements: 

As soon as a glass element is selected, the editor dialog window "Tool for window 

division / muntins" opens. 
 

For windows: 

The window can already be defined in more detail in the window parameter before it 

is applied. 

 

 

Your current window/glass element is always visible in the right dimension in this 

editor window. Divisions, muntins and padding are applied, deleted or selected with 

the tools on the right-hand side of the dialog window. In the lower area of the dialog 

window, in each case enter the dimensions and colours of the respective active 

element. (Frame, division, casement, muntins, infill or glass). The active element is 

represented in purple. 

You can work with various ELITECAD functions in the working window of the editor: 

Measure, Convert to solid, Wire model, Zoom, and Move. 
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Help lines 

 

This button allows you to draw help lines in the preview window, which help you to 

place the individual window parts. 

3D hatch 

 

Every sub element of a glass element can be assigned a hatch that appears in the 

calculated hidden line views. 

Frame 

 

Entry options: 

Window frame width, window frame gauge. 

Pen, 3D colour and material, 3D hatch. 

Window area (consider for calculating the sum of all window areas) 

Room dividing 

If a glass element is not room dividing, it is not recognized as a boundary when 

calculating room areas. 

 

The frame and frame leg are defined by free contour / delete contour (Chapter 10.2 

Window). 

Options for whether the glass element surface should be taken into account in the room 

label of the window area, and whether it should divide the room or not (not available 

for windows).  

Glass 

 

 

Entry options: 

Position of window pane 

Append, insert, delete or swap layers. 

Display of number of layers 

Number of active layer 

Gauge of active layer (not represented in 2D and 3D) 

Display of distance from the interior edge 

Pen, 3D colour and material, 3D hatch. 



Chapter 10 – Extension  

www.elitecad.eu  771 

Transparency in percentages. 

3D freeze active is the standard setting. If the 3D is not frozen, then the model for 

window casement and glass can be moved/rotated for temporary representations. 

Vertical division 

 

 

Entry options: 

Dimensions. 

Pen, 3D colour and material, 3D hatch. 

2D option for floor plan depiction. 

It is useful to set a help line for the axis beforehand. 

The position in the glass area is determined in the preview window. 

When editing a division, the distance from the division axis to the left outer edge of 

the frame must be specified. This value can be directly adjusted. 

Keep in mind that depending on the division width you specify another casement may 

be incorporated in the division. 

Horizontal division 

 

 

Entry options: 

Dimensions. 

Pen, 3D colour and material, 3D hatch. 

It is useful to set a help line for the axis beforehand. 

The position in the glass area is determined in the preview window. 

When editing a division, the distance from the division axis to the bottom outer edge 

of the frame must be specified. This value can be directly adjusted. Keep in mind that 

depending on the division width you specify another casement may be incorporated in 

the division. 

Slanted division 

 

 

Entry options: 

Dimensions. 
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Pen, 3D colour and material, 3D hatch. 

It is useful to set a help line for the axis beforehand. 

The start and end points of the division are entered in the glass area in the preview 

window. Both points can be placed anywhere on the axis. However, they must not be 

outside of the window.  

Multiple division 

 

 

Entry options: 

Dimensions.  

Pen, 3D colour and material, 3D hatch. 

2D option for floor plan depiction. 

Horizontal/vertical selector. 

Distances. 

Enter the distances (separated by a comma) and specify the glass area into which the 

division must be integrated. 

Casement 

 

 

Entry options: 

Dimensions and casement offset to frame. 

Pen, 3D colour and material, 3D hatch. 

Define casement from free contour/Delete free definition. 

2D option for floor plan depiction. 

Opening symbol of the casement with the detail parameter for the opening symbol. 

Floor plan depiction of the opening symbol. Note that the floor plan symbol is only 

shown if the corresponding opening symbol is also defined. 

The position of the casement is determined in the glass area in the preview window.  

Symmetric casements 

 

 

Entry options: 

Dimensions of casement offset to frame. 
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Pen, 3D colour and material, 3D hatch. 

Selection for casement from free contour. 

2D option for floor plan depiction. 

Opening symbol of the casement with the detail parameter for the opening symbol. 

Floor plan depiction of the opening symbol. Note that the floor plan symbol is only 

shown if the corresponding opening symbol is also defined. 

The position of the double casement is determined in the glass area in the preview 

window. 

Asymmetric casements 

 

 

Entry options: 

Dimensions of casement offset to frame. 

Pen, 3D colour and material, 3D hatch. 

Selection for casement from free contour. 

2D option for floor plan depiction. 

Characters #: Number of casements. 

Next to it on the right-hand side is the button used to define each individual casement 

width when the sym. option is switched off. The casement is equally divided with 

width 0. 

Opening symbol of the casement with the detail parameter for the opening symbol. 

Floor plan depiction of the opening symbol. Note that the floor plan symbol is only 

shown if the corresponding opening symbol is also defined. 

The position of the casements is determined in the glass area in the preview window. 

Window opening symbol 

 

Button for casements 

Depending on the setting in the window division (single or double-casement window), 

other opening symbols are available. 

In the opening symbol parameters formatting settings can be configured depending 

on the selected symbol. 

Single-casement: 
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Double-casement: 

 

Opening symbol parameters 

 

Button for casements 

 

The pen can be set in the parameter. The arrow symbol can be formatted with the 

sliding door and the lift-up sliding door symbol. If the CENTRED option is activated, 

the symbol is automatically horizontally centred on the window pane. The symbol is 

always centred vertically. The dimensions refer to the current dimension unit and the 

current scale. 
 

No values in this dialog window depend on the representation level. 

Muntins 

 

 

Entry options: 

Dimensions. 

Pen, 3D colour and material. 

2D option for floor plan depiction. 

The number of muntins in the x-direction (horizontal) and number in the y-direction 

(vertical). The value "0" does not generate any muntins in this direction. 

You can click in the glass area to place the muntins. 
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Free muntins 

 

Entry options: 

Dimensions. 

Pen, 3D colour and material, 3D hatch. 

2D option for floor plan depiction. 

It is useful to set a help line for the axis beforehand.  

The start and end points can be set anywhere on the axis between the frame or casement 

frame. 

 

Infill 

 

Entry options: 

Pen, 3D colour and material, 3D hatch. 

The infill fills a window with a fixed colour. The infill is always between the fixed 

elements of a window such as frames and transoms. If when defining an infill there is 

a casement on the glass part, this is deleted by the program. Additional definitions of 

muntins are possible. 

Select previous part / Select next part 

   

With these control arrows, you can switch between the individual window parts 

(frame, glass, divisions, casement, muntins, and infill) to check the settings, make 

modifications or delete the window part. 

The selected part is always marked as active (purple). 
 

TIP 
You can also change to solid view for a better view of the active element. 

Key combination: [Ctrl]+[D]  

Select part 

 

You need to select a particular window part (frame, glass, divisions, casement, 

muntins, and infill) in order to edit it. Use the function to select the window part. The 

selected part is always marked as active (purple). 
 

TIP 
You can also change to solid view for a better view of the active element. 
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Key combination: [Ctrl]+[D]  

Delete part 

 

This function deletes the active window part (divisions, casement, muntins, and infill). 

The frame and the glass cannot be deleted. 

To activate a window part, use the SELECT PART function or switch to the desired 

part using control arrows. 

Report as 

 The glass element can be quantified as a window, door or glass element. 

2D only in active storey 

 

The 2D depiction for multi-storey glass element can be either in the own storey or in 

other storeys. 

Copy parameters for windows 
 

 General   

 Casement rod lay out   

 Glass composition   

 Frame   

 
 

 

Floor plan depiction  
 

 

Line 

W.frame and casement equal 

W.frame and casement separated 

 Casement gauge   

 Casement offset   

 Window frame gauge   

 Casement   

 Casement frame width   

 Frame   

 W-frame in 3D   

 Frame width up   

 Frame width bottom   

 Frame width left   

 Frame width right   

 Pen   

 Line type   

 3D frame depiction   

 3D casement depiction   

 Muntins and pane   

 Represent muntins in 2D   

 Muntins gauge   

 Muntins depth   

 Pen for muntins   

 3D depiction of muntins   

 Depict pane   

 3D depiction of pane   

 3D freeze   
 Symbols   

 Pen   

 Line type   

 Floor plan depiction opening  No symbol  
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Turn casement 1/3 open 

Turn&tilt casement 1/3 open  

Turn casement open 

Turn&tilt casement opened 

 Geometry  * 

Copy parameters for glass element 
 

 General   

 Layer   

 3D freeze   

 Material   

 Exterior   

 Report 

 

 

 Glass element 

Window 

Door 

 Room dividing   

 Height reference  free height ref. 

from floor to ceiling 

from underside of floor to ceiling 

to ceiling 

from floor 

 Width   

 Height   

 Bottom edge   

 Frame   

 Dimensions  * 

 Pen  * 

 3D depiction  * 

 Casement/muntins division  * 

 Glass composition  * 

 Transom   

 Dimensions  * 

 Pens  * 

 3D depictions  * 

 Casement   

 Dimensions  * 

 Pens  * 

 3D depictions  * 

 Symbol parameters  * 

 Muntins   

 Dimensions  * 

 Pens  * 

 3D depictions  * 

 Padding   

 Pens  * 

 3D depictions  * 

 Properties   

 Glass composition  * 

Entry mode 

Draw roof contour manually 

 

The Input Assistant offers the drawing options Line, Polygon, Rectangle, Curve, 

Circle, Ellipse and Spline. The circle is always a lying glass element. 
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Define using existing contour 

 

First, you must draw a contour that follows the desired shape, with a circle always 

generating a lying glass element. After setting the contour, you must define the 

position of the axis with the cursor. 

Height reference 

Choosing the correct height reference simplifies entry and has advantages for later 

modifications to the structure settings.  

Height reference – lying 

 

The glass element is created as lying and required a closed contour. 

This height reference is used automatically if the work plane does not correspond to 

the storey plane. 

Height reference – free height reference 

 

The lower edge and height of this glass element can be freely defined. 

Height reference – from floor to ceiling 

 

The glass element begins at the top side of the slab and goes up to the underside of the 

ceiling. You can save the effort of entering heights, as this glass element is always 

oriented to the structure settings.  

Height reference – from underside floor to ceiling  

 

The glass element begins at the underside of the slab and goes up to the underside of 

the ceiling. You can save the effort of entering heights, as this glass element is always 

oriented to the structure settings.  

Height reference – to ceiling 

 

The glass element is oriented with its top edge to the storey ceiling. The bottom edge 

can be freely configured and references the top edge of the slab.  

Height reference – from floor 

 

The glass element starts from the upper edge of the slab and is defined with any height 

starting at that marker.  

Height reference – from floor underside 
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The glass element starts from the lower edge of the slab and is defined with any height 

starting at that marker.  

EDIT GLASS ELEMENT 

Glass elements can be edited and modified at any time by double-clicking them. All 

detail settings can be modified at a later point.  
 

TIP 
After selecting the glass element, click on a handle or gripper of the 

contour to access manipulation functions directly in a toolbar or by using 

[TAB] with the cursor.  
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10.4 WALL OPENING 

 

Construction parts toolbar 

AR Objects menu > Create wall opening 

Click on the CREATE WALL OPENING function to enable the settings for the most 

recently placed wall opening. The wall opening can now be placed. The Position of 

opening query appears in the entry line. 

WALL OPENING PROPERTIES BAR 

 

The properties bar is visible as soon as the CREATE WALL OPENING function is 

launched or if an existing wall opening is edited. You can manipulate the main values 

in the wall opening's properties bar. 
 

 
Wall opening parameters 

 Type 

 
Renovation planning state (see chapter 8.5) 

 
Opening shape 

 
Opening type 

 
Wall opening width 

 
Wall opening height 

 
Wall opening bottom 

 
Wall opening depth 

 Labelling 

 Close openings automatically (renovation planning) 

 
Lintel line depiction 

 Diagonals 

 
Wall opening properties (depiction) 
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WALL OPENING PARAMETERS 

 

You can open the wall opening parameters via the properties bar or by double-clicking 

the wall opening to be modified. 

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Dimensions 

 

Wall opening height 

Enters the height of the opening from the underside to the lintel. 

Wall opening width 

Enters the width of the opening. 

Wall opening bottom 

The height of the bottom edge is entered from "raw slab". 
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Wall opening text 

If the text symbol is switched on in the parameters, the text entered here is appended 

to the symbol. 

Wall opening depth 

If the trench is selected as the wall opening type, the depth of the opening can be 

manipulated with this value. 

Opening in 3D 

 

This setting is generally active. Optionally a generation of an opening into the 3D wall 

can be deactivated. In that case, only a 2D depiction of a wall opening is generated in 

the wall. 

Selection 

Shape 

 

Rectangle 

Circle 

Semi circle 

Round-arch 

Segment curve 

Pointed arch 

Diamond 

half triangle right 

half triangle left 

Isosceles triangle 

Select free contour 

Rectangle by diagonal 

Use free volume 

There are 13 different shape types available for selection. The first 10 of these shapes 

are standard shapes, which have a clearly defined outer contour (shape of the reveal). 

 

The select free contour shape allows you to define a free wall opening contour. This 

contour should lie "on the wall" i.e. the work plane is positioned on the wall surface. 

A closed polygon can be drawn there. 

 

The rectangle by diagonal shape is a simple tool for entering rectangular wall 

openings in 3D. Position the work plane on the wall. When launching the function, 
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only the bottom left and top right corner of the opening are queried. All further 

representation variants result from the parameters set. 

 

The use free volume shape offers the option to generate an opening by defining a 

"deduction" beforehand. This can be a 3D box which is "embedded in the wall", which 

by definition means that a "hole in the wall" appears by taking the deduction away. 

After activating the function, the volume, which is taken away must be selected, and 

then the wall in which the process is to take place. 
 

TIP 
The volume of the deduction must not be coincident with the underside 

or top side of the wall. Always leave some free space, even if it just a 

millimetre.  
 

Style 

 
Opening 

 
Trench/recess 

The style of wall opening determines whether it is a wall opening or a wall 

trench/recess. 

If the wall trench is selected, the field for entering the wall opening depth appears in 

the dialog window. 

Stop 

 
Without stop 

 
Free stop 

If the free stop is selected, the field for entering the wall opening depth appears in the 

dialog window. 

Stop editor 

 

The stop editor is identical to the window stop editor and documented in the window 

chapter. 

Parameter 

Floor 

 Floor runs into niche 

 Floor is limited with wall 

Text symbol 

 Symbol is switched off 



Chapter 10 – Extension  

www.elitecad.eu  784 

 Symbol is switched on 

Selection of Lib part 

 
Here, you can select a specific Lib part for the symbol. The standard symbols are stored 

under <ELITECAD installation directory>u\<version>\ar\glob\symbol . 
 

TIP 
If you would like to create a symbol of your own, it is best to load a 

template from the path listed above (wd_text.d or wd_text_new.d). 

Adapt the symbol as you wish, and save it under a new name. Make sure 

the placing point of the symbol is in the centre of the page. 
 

Entries in auto text 

  

Lintel line depiction 

 

Type1 

Type2 

Without lintel 

Not visible 

The lintel line depiction in the floor plan is set using this button. There are two different 

types of lintel lines, which can be specified. The types are set in the representation 

levels for windows: The top selection option here is type1, the middle type2. Type1 is 

dashed by default and type2 is a solid line. The third selection switches the lintel line 

depiction off, and the fourth shows no wall opening at all. 

2D only in active storey 

 

The 2D depiction for multi storey windows can be either in the own storey or in other 

storeys. 

Renovation planning – fill automatically 
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If the status of a door is changed to demolition, the automatic generation of a wall that 

fills the hole can be triggered with this option. 

Pen- and line type 

  

Here you can select the pen/line type for the 2D depiction. 

Floor plan depiction 

  Only pen/line type 

  Only pen/line type 

  Additional colour selection 

  Additional colour selection 

  Additional colour selection 

  Additional hatch selection 

MODIFICATION FUNCTIONS 

Placement points 

If a pre-existing wall opening is edited, its original placement point is indicated. Now 

if you modify the wall opening width, the modification always takes effect from this 

point. The point can be moved to the reference points on the left, right and in the centre 

using the mouse. 

 

Move the placement point with the mouse. 
 

TIP 
After selecting the wall opening, click on a handle or gripper of the 

contour to access manipulation functions directly in a toolbar or by using 

[TAB] with the cursor.  
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10.5 BANISTER 

 

Construction parts toolbar 

 

When you click the CREATE BANISTER function, the settings are copied from the 

most recently drawn banister and the banister can be placed immediately.  

BANISTER PROPERTIES BAR 

Create 

 

Change 

 

The properties bar is visible as soon as the CREATE BANISTER function is launched 

or if an existing banister is edited. 

You can manipulate the main values in the banister's properties bar. 
 

The appearance of the properties bar depends on the selected construction part.  
 

 
Banister parameter 

 
Renovation planning state (see chapter 8.5) 

 
Entry mode 

 
Construction part 

 
Shape 

 
Height 

 
Width 

 
Height of construction element 

 
Level of construction element 

 Exterior / interior banister 

 Room dividing 

 Properties of banister (depiction) 
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BANISTER PARAMETER 

 

You can open the banister parameters via the properties bar or by double-clicking the 

banister to be modified. 

 

 

General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Plan graphics 

 

Exterior banister 

The banister can be quantified as an exterior or interior banister. 

Room dividing 

If a banister is not room dividing, it is not recognized as a boundary when calculating 

room areas. 

2D depiction 

Here you can also set whether or not the banister should have a 2D representation. The 

pen and line type can be determined. 
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Handrail 

 
Shape of the handrail 

 

Select from a round, rectangular or free profile. 

For a free profile, you have the option to draw any cross-section yourself and use it as 

a handrail.  
 

TIP 
The free profile is a self-drawn cross-section saved as an ELITECAD 

file. The cross-section must be a successive contour. No 3D definitions! 

The reference point must always be at the bottom in the centre when 

saving. 

  

Handrail height  

The handrail height is always measured in ELITECAD Architecture from the top side 

of the storey floor or from the front edge of the tread on a stair. In ELITECAD 

Mechanics the height reference is relative to the active work plane. 
 

EXPLANATION 
If a banister is generated from a polygon that is not drawn in the floor 

plan level, the handrail height is measured from this definition.  
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Position of handrail 

In the floor plan, the handrail is fixed by two dimensions, one for the distance of the 

handrail axis to the stairway, and one for the start of the handrail in relation to the first 

step. The end of the handrail is symmetric to the start. 

Offset 

 

Using the offset, you can enter a displacement value in the current unit by which to 

move the reference level in relation to the coordinate origin. 

Enter height 

 

Instead of a manual entry for the offset, you can specify a point digitally with the 

mouse. The measured height from the coordinate origin is entered into the "Offset" 

field. 

Parameters 

 

You can switch the handrail on or off using the tick box. 

You can also specify the pen, 3D colour and material. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Balusters 
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Shape of baluster 

 

Select from a round, rectangular or free profile. 

For a free profile, you have the option to draw any cross-section yourself and use it as 

a baluster. 
 

TIP 
The free profile is a self-drawn cross-section saved as an ELITECAD 

file. The cross-section must be a successive contour. The reference point 

must always be in the centre of the contour when saving. 

If a 3D part is loaded, this is adopted as balusters as a whole. The 

reference point must also be in the centre and under the 3D part when 

saving here.  

Position of baluster 

For the baluster top edge, the value 0 is measured underneath the handrail.  

For the baluster underside, the value 0 is measured flush to an imaginary line 

connecting the stair edges. 

In the floor plan, the baluster is fixed by two dimensions, one for the distance of the 

baluster axis to the stairway, and one for the start of the baluster in relation to the first 

step. The end of balusters is symmetric to the start. 

Equal distribution 

 

Enter the number of balusters, which should be distributed along the banister. "Per 

side" means that all connected banister parts are divided as a whole. "Per section" 

applies for each direction modification of the banister anew. 
 

Per side     per section 

   

Distribution over maximal distance 
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Here you can enter a maximum distance of the balusters. "Per side" means that all 

connected banister parts are divided as a whole. "Per section" applies for each direction 

modification of the banister anew. 
 

Per side     per section 

   

Special distribution (only active for stair) 

 

In "special" distribution, you can set balusters per step. There are several options, 

which you can activate with the tick box: 

Centred balusters, balusters with distance to step front or back edge, or combined 

solutions. 

 

The bottom edge of the balusters can be created in two different executions. 

Here, the frequency determines the number of steps after which the selected balusters 

are set in each case. Value "1" would be for every step. 

Parameters 

 

You can switch the panels on or off using the tick box. 

You can also specify the pen and the 3D colour. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 



Chapter 10 – Extension  

www.elitecad.eu  792 

Panel 

 

Dimension of panel 

The panel gauge can be set. 

Position of panel 

For the panel underside, the value 0 is measured flush to an imaginary line connecting 

the stair edges. The height of the panel is measured from the bottom edge. 

In the floor plan, the panels are fixed by two dimensions, one for the distance of the 

panel axis to the stairway, and one for the distance of the panel from the baluster.  

Fit to frame 

This option can be selected if a frame is defined. The panel is then automatically 

adjusted to the frame geometry. 

Parameters 

 

You can switch the panels on or off using the tick box. 

You can also specify the pen, 3D colour, transparency and material. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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Frame 

 

Shape of frame 

 

Select from a round, rectangular or free profile. 

For a free profile, you have the option to draw any cross-section yourself and use it as 

a frame. 
 

TIP 
The free profile is a self-drawn cross-section saved as an ELITECAD 

file. The cross-section must be a successive contour. No 3D definitions! 

The reference point must always be at the bottom in the centre when 

saving. 

  

Position of frame 

For the frame underside, the value 0 is measured flush to an imaginary line connecting 

the stair edges. The height of the frame is measured from the bottom edge. 

In the floor plan, the frame is fixed by two dimensions, one for the distance of the 

frame axis to the stairway, and one for the distance of the frame from the baluster.  

Parameters 
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You can switch the frame on or off using the tick box. 

You can also specify the pen, 3D colour and material. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Horizontal muntins 

 

Shape of horizontal muntins 

 

Select from a round, rectangular or free profile. 

For a free profile, you have the option to draw any cross-section yourself and use it as 

a horizontal muntin. 
 

TIP 
The free profile is a self-drawn cross-section saved as an ELITECAD 

file. The cross-section must be a successive contour. No 3D definitions! 

The reference point must always be at the bottom in the centre when 

saving. 
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Position of horizontal muntins 

For the bottom edge, the value 0 is measured flush to an imaginary line connecting the 

stair edges. The height of the horizontal muntins is measured from the bottom edge. 

In the floor plan, the horizontal muntins are fixed by two dimensions, one for the 

distance of the muntin axis to the stairway, and one for the distance of the muntins 

from the baluster.  

Equal distribution 

 

Enter the number of muntins  

Distribution over maximal distance 

 

Here you can enter a maximum distance of the muntins.  

Fit to frame 

This option can be selected if a frame is defined. The horizontal muntins are then 

automatically adjusted to the frame geometry. 

Parameters 

 

You can switch the muntins on or off using the tick box. 

You can also specify the pen, 3D colour and material. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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Vertical muntins 

 

Shape of horizontal muntins 

 

Select from a round, rectangular or free profile. 

For a free profile, you have the option to draw any cross-section yourself and use it as 

a vertical muntin. 
 

TIP 
The free profile is a self-drawn cross-section saved as an ELITECAD 

file. The cross-section must be a successive contour. The reference point 

must always be in the centre of the contour when saving. 

If a 3D part is loaded, this is adopted as muntin as a whole. The reference 

point must also be in the centre and under the 3D part when saving here

  

Position of vertical muntins 

For the baluster top edge, the value 0 is measured underneath the handrail.  

For the muntin bottom edge, the value 0 is measured flush to an imaginary line 

connecting the stair edges. 

In the floor plan, the vertical muntins are fixed by two dimensions, one for the distance 

of the muntin axis to the stairway, and one for the distance of the muntins from the 

baluster.  

Equal distribution 
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Enter the number of muntins, which should be distributed along the banister. The 

options PER SIDE and PER SECTION are only available if no balusters are active. 

Distribution over maximal distance 

 

Here you can enter a maximum distance of the balusters. The options PER SIDE and 

PER SECTION are only available if no balusters are active. 

Fit to frame 

This option can be selected if a frame is defined. The vertical muntins are then 

automatically adjusted to the frame geometry. 

Parameters 

 

You can switch the muntins on or off using the tick box. 

You can also specify the pen, 3D colour and material. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Entry 

Stair 

 

A stair can be selected later with this option. Blue contours are shown where a banister 

is possible. Several contours can also be selected, and the selection confirmed with 

[Enter]. 

Draw roof contour manually 

 

The drawing functions LINE, POLYGON, CURVE and SPLINE are available for 

selection in the Input Assistant. You need to double-click to enter via the polygon and 

the spline. 

Create banister from existing contour 

 

With this option, one or several 2D contours can be selected. The selection is 

confirmed with [Enter]. 
 

TIP 
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A banister can be generated from a polygon that is not drawn in the floor 

plan level. This allows banisters to be generated on a slanted retaining 

wall, for example. A definition from 3D curves is also possible. 

  

EDIT BANISTER 

Banisters can be edited and modified at any time by double-clicking them. All detail 

settings can be modified at a later point.  
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10.6 ROOM 

 

Construction parts toolbar 

AR Objects menu > Room 

The room label creates the room label block in the floor plan, but also a floor and the 

materials for walls, floors and ceilings for the report.  

In order for the room to be placed automatically, there must be a surrounding room-

limiting area. Walls with doors and windows, glass elements, columns, chimneys and 

room separators are delimiters. 

ROOM PROPERTIES BAR 

The properties bar is visible as soon as the ROOM function is launched or if an existing 

room is edited. 

 
 

 
Room parameters 

 Room name 

 
Renovation planning state (see chapter 8.5) 

 Unit name 

 
Floor covering 

 
Wall finish 

 
Ceiling covering 

 
Colour 

 Labelling 

 Parameter 

 
Switch between main contour / layer contour 

 
Modification functions 
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ROOM PARAMETERS 

  
Switzerland/Austria   Germany 

General parameters 

  Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Name 

Name of the room. 

Unit 

Several rooms are compiled into one unit. In residential construction, this unit would 

be a flat, and in the commercial sector, a rental unit. 

Section 

A combination of several accommodation units within a structure or a separation of 

different uses e.g. office, production, sales, residential. 

Number 

Room number 

Util. type (Switzerland/Austria) Area type (Germany) 

Areas according to standard (e.g. MUA main usage area). 

Austria: ÖNORM B1800 (Austrian Standards Institute), Section 4.3 Net footprint. 

Switzerland: SIA 416, Section 2.1 Net storey area and section 3.1 Exterior net storey 

area. 

Germany: DIN 277-2, table 1 (net floor areas) (e.g. NF1). 
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Area type (Switzerland/Austria) Range (Germany) 

Boundary type of the rooms for the report. 

For Austria, the field "Area type" of the range according to ÖNORM B 1800, section 

4.1.1 (a, b or c) is used. 

Germany: according to DIN 277, section 3.1.1 (a, b or c). 

Usage type (only Germany) 

According to DIN 277-2, up to 3 places 

Area style 

In addition to the "normal areas", there are special areas, which must be declared for a 

correct report. This includes an air space, exterior room, courtyard, stairwell, or 

whether the plane counts as a construction surface according to ÖNORM B 1800, DIN 

277, SIA 416. 

Infill hatch 

In order to show the assignment (unit 1, 2, etc. or use of wet rooms) of rooms in 

different colours in the plan, an infill hatch can be assigned. 

Room infill hatches can also be switched on or off globally via the function EXTRAS 

> ROOM HATCHES ON/OFF. 

Max. room height 

Room height, according to the standards ÖNORM B 1800, DIN 277 and SIA416, 

which is definitive for the net volume. A 3D surface is created at this height using the 

function QUANTIFY. 

Proportion of living space 

The field is provided for verifying the living space. The permissible proportion of the 

surface is entered in percent, which includes the surface for living space according to 

the standard. Germany: Living spaces ordinance (WoFlV). 

If no value is entered, the value up to 100 % of living space is included in the report. 

Deduction for plaster (only Germany) 

The deduction for plaster in % is no longer permissible according to the living spaces 

ordinance (WoFlV), but can be used for comparative purposes. 

Apply free contour 

 

A previously drawn 2D contour can be defined as a room contour. Walls or room 

separators do not necessarily need to be present. This function is used if the basis is a 

2D plan, but the room areas should be calculated. 

Modify free contour 

 

If an individual contour is used as a room contour, the room has grippers and handles 

along the contour during editing. The contour can be modified with polygon 

manipulations, or the function MODIFY FREE CONTOUR is used at the end of the 

properties bar, which reduces the room back to a 2D contour, which can be edited. To 

complete the function, you must click the ROOM CONTOUR READY function. This 

appears on the dialog window at the top right. 
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Materials 

The names of materials are always directly "connected" to the respective component 

for the dimension report. The "dimension" of a wall can therefore be identified by its 

geometric data and its material label. 

However, the report of plaster surfaces, for example, cannot simply be linked with a 

wall component, as surfaces must be deducted from abutting walls. Therefore, the 

"room skin", i.e. all material layers, which are shown in the room (namely the 

difference from bare construction to extension) are assigned to the room. 

The name "TILES" can be assigned to the material for the floor, and e.g. "PLASTER" 

for the walls and ceiling with its respective gauge. For the surface of a drywall, 

"PAINTED" will suffice with gauge "0", as the plasterboard layer belongs to the wall 

and should not be included in the calculation. 
 

TIP 
The names of materials entered can be saved individually or deleted 

again. 

    

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
 

EXPLANATION 
For the construction parts wall, column and slab, for the colour or 

material selection there is a button which specifies whether the material 

for room label is shown or not. 

 

If the lock is not set (open lock), the material configured in the room 

parameters takes precedence. However, if the lock is set (lock closed), 

the material of the respective construction part is represented and not 

that of the room label. This setting has no effect on the report. 

  

Floor gauge 

The gauge of the floor can also be controlled using the height reference. 
 

Height reference active 

 

If the height reference is active, the gauge of the floor is calculated from the height 

section of the structure settings and cannot be adjusted in this dialog window. In 

general, this option should be selected, as this is the only way to make a global 

modification in the structure settings. 
 

Height reference free 
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The free height reference is used if a floor of the storey has another composition (e.g. 

cement layer instead of a subfloor/screed). 
 

TIP 
The floor gauge which can be defined in the room dialog window 

influences the parapet heights/lintel heights of windows and doors 

insofar as these have been entered via finished parapet, finished 

clearance or lintel (gross) FFL. The higher floor composition is always 

used for doors (not the opening direction side!). If no room name is 

available when placing, the (finished) floor level defined in the structure 

settings is taken into account. 

In the case of library parts defined as furniture, the 3D information about 

the height of the floor composition is moved in the Z-direction. 

  

Parameters for floor construction 

 

The floor composition with its own layers can be specified in the parameter. 

Thickness of wall finish 

 

The gauge of the wall finish can be defined. This layer is not shown in the design 

model, but is only relevant in the report (wall finish, living spaces). In active linkage 

(red lock), each wall side of the room is checked for the substrate material, and if the 

material is stored in the report database, use the corresponding gauge from the 

database. For walls without a substrate material in the database, the gauge entered in 

the dialog window is used. The gauge from the database is only taken into account in 

living space verification. This is not taken into account for the wall covers. 

Ceiling covering gauge 

Gauge of ceiling covering 

Additional covers 

If an existing room is edited, additional room covers can be appended. 

 

Definition of an additional covering 

There are three different types: 
 

Addition   replacement   deduction 
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For the Additional type, the plane is quantified twice, for the basic material and for the 

additional material. If the basic material is replaced, only the new covering is 

quantified. The material and texture field is empty for the Deduction type. The plane 

is not quantified. This type is used, for example, for a fitted cupboard, which is not 

cleaned behind, or if there is no floor covering under the bathtub. 

All of the drawing functions are available in the Input Assistant for creating the planes. 

The work plane does not need to be set on a wall, but rather the system notices 

independently which wall should be added. 

An existing, additional room finish can be selected and manipulated with the handles 

and grippers; the value settings of the material can be seen via the properties bar or the 

marked covering can be deleted. 

 

Parameters for floor construction 

 

The individual layers of the floor can be defined and materialised. The layers can be 

created with an inclination. 
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Type 

Description chapter 8.5 

Floor (finish) type 

 
straight No incline settings 

 
Slanted above and below Incline settings active 

 
Slanted above Incline settings active 

Incline settings 

These settings are only visible with a sloping floor. 

There are 3 definition types  

 

 Incline 

 Slope 

 Define by 3 points 

 

The floor is defined by 2 points for the INCLINE and SLOPE definition types. 
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The DEFINE BY 3 POINTS definition type determines the inclination via 3 points. 

When creating the floor, the point is always queried first then the associated height 

must be entered. An imaginary plane is defined through the three height points, which 

is then moved in parallel until the layer has the defined minimum or maximum value. 

Layer gauge minimum or maximum value 

 
Maximum value 

 
Minimum value 

The layer gauge is measured on the thickest cross-section or on the thinnest cross-

section. For the maximum value, it must be ensured that the layer does not approach 

zero. 

Parameters 

Number of active layer 

 

For multi-layered floors, you can select the desired layer in order to configure its 

settings. Instead of selecting the number, you can click directly on the layer in the 

preview. 

Gauge of active layer 

 

Material and its linkage 

The materials and their corresponding settings are saved in the representation level. 

When linkage to the representation level is selected (recommended), the pen and hatch 

settings are adopted and cannot be manipulated ("greyed out") 

Pen and Hatching parameters 

 

 

 

When the linkage of the material is active, only the line type can be modified.  

 

points for upper edge 

points for incline / slope 

incline slope 

cut 

ground 

plan 
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If you unlink the materials, the pen type and hatches can be modified. 

The settings are described in chapter 8.1 Representation level > Materials 

management. 

Colour mode/Material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

3D hatch 

 

The floor layer can be assigned a line hatch that appears in the calculated hidden line 

views. 

Layer slope 

 

This option is only active for a sloping floor. 

You can specify for each layer border, whether it is on the incline. 

A floor may only have one inclination, but be horizontal overall when you consider 

both the top and bottom surfaces. 

Examples: 

 

Layer type 

 

For the report to be correct, a layer type must be assigned to the layer. 

If the linkage to the material is detached, you can make the assignment independently. 

If the linkage is active, the layer type is read from the report database using the material 

name. 

straight 

straight 

straight 

straight 

straight 

straight 
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Preview 

 

The current construction is depicted in the preview. Layers can be added, deleted or 

replaced. If you click on a layer in the preview, its parameters are displayed. 

Add layer 

 

The function adds a new layer to the last layer. This layer has the same settings as the 

current layer. 

Insert layer 

 

The function adds a new layer above the active layer. 

Delete layer 

 

Deletes the active layer. 

Mirror layers 

 

This function rotates the group of layers by 180 degrees. 

Label 

 

The room label style can be set individually for each representation level. In the 

permission planning, only the room name and the square metre surface are shown; the 

(finished) floor heights and the materials should also be labelled in the execution 

planning. 
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Type 

Description chapter 8.5 

Label options 

Each row has a tick box, which is used to activate the label attribute. 

Text parameters 

A text parameter must be entered for each entry. 

Formatting option 

The formatting option allows pre-texts and post-texts to be generated. If the calculated 

room area is provided with the post-text "m²", the formatting "<> m²" must be entered. 

The sequence of "greater than" and "less than" signs are placeholders for the value 

which is being calculated. 

The room area is set to have 2 decimal places by default. If you want to use a different 

rounding algorithm, you can control this with additional entry between the placeholder 

symbols. 

If only one decimal place should appear, the entry must be "<:1> m²". 

For rounding to a half square meter, it must be "<:05> m²". 

Numbering 

The numbering of the values sets the order of the texts. The text with the lowest number 

(here "1") begins at the height of the room model ("small blue line"), all other texts are 

generated under it. 

Additional label options 

At the bottom of the dialog window there are four free rows available, which can be 

used for each attribute, which is connected to the room label object. However, some 

attributes are added to the room name first by the function SUMMARY TO PROJECT 

BOOK. 
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areanorm Room areas incl. height check and percentage deduction for plaster 

areanormnew Room areas incl. height check and effective deduction for plaster 

areanorm1  Room area under limit height (DIN 277: 1.50 m) 

areanorm2 Room area over limit height (DIN 277: 1.50 m) 

areanorm0  Area from living space calculation below limit height 1 

areanorm50  
Area from living space calculation between limit height 1 and limit 

height 2 

areanorm100 Area from living space calculation above limit height 2 

use Net storey area type 

areatype Area (a, b or c in accordance with DIN 277 and ÖNORM B 1800) 

areapercent Proportion of living space in % 

plaster deduction 
Percentage deduction for plaster in living space calculation (in 

accordance with the old Second German Calculation Ordinance) 

roomheight Room height 

minroomheight Minimal net clearance 
 

For more information about setting the limitation values for living space calculation, 

please refer to the Report chapter, "Deduction limits, height specification and formula 

settings" section. 

Simplified input of additional room labels 

When activating a room label automatically a default value is set as text parameter and 

the room label is numbered. 

Library part 

The room stamp graphics can also be controlled by a library part. This library part can 

include lines, hatches, fixed texts and autotexts. The room stamp should preferably be 

drawn in the centre of the page, as this reference point will later also be the placing 

point of the library part. 

 

The library part can be saved to a parameter record and is therefore dependent on the 

representation levels. If a library part is selected, the attributes have a grey background, 

Living 

painted 
painted 

parquet SL: 

CE: 
WL: 

centre of 
the page 
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as the autotexts in the library part already determine which attribute is represented, and 

how and where. 

      

In the Room stamp group, all attributes with the most common rounding variants are 

included in the autotext. 

 

If the desired rounding is not available, the autotext can be adjusted manually. 

"@format(%floortop,+zm.2)@" 

'+' means with a sign in all cases 

'z' means '±' for value 0 

'm.2' means AT LEAST two decimal places 

 

ROOM REPORT 

Only contours of the construction parts wall, lintel, chimney, vertical glass elements 

and the room separators are used for the room report. These 2D geometries must be on 

the work plane of the current storey (bare ceiling level). Construction parts of other 

structures are not taken into account. Bordering rooms (provided, that walls are only 

defined in one structure) are completed with room separators. 

The must not be any crossover of bordering walls. Equally, for walls lying one above 

another, only one wall in each case may be definitive for the room contour (room 

dividing). 

SL: 
WL: 
CE: 
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ROOM MODIFICATIONS 

Move 

If you move a room name, the room data is immediately recalculated when it is set 

back down. The blue placing cross must always be inside the room to be calculated. 
 

TIP 
If the text should be outside of a room, it can be moved after clicking 

the handle. The blue placing cross stays inside the room here. 

  

Copy 

You can copy a room name as an object at any time. All changes (such as a change of 

storey) are refreshed immediately. However, please note that it may be difficult for 

you to differentiate between two rooms with the same name in the same storey (the 

unit label stays the same when copied) in the list output. You should therefore edit 

your room names as soon as you have copied them. Otherwise, you can easily forget 

to do this! 

Edit 

Clicking on the room label opens the properties bar where you can make modifications 

or you can open the room parameters dialog window for more detailed settings. Please 

do not use the MODIFY TEXT function to modify the room names, otherwise the 

room name will not be able to determine dimensions automatically. 

Refresh 

If the extent of the room is manipulated, i.e. by shifting walls, stretching room 

separating lines or whole rooms, the room name is refreshed automatically. If you 

delete walls and lintels or add new ones to a room, the room name must be refreshed 

using the function REFRESH ROOMS from the LAY-OUT menu. This also applies 

for the window and glass elements. If this is changed, the room label must be refreshed, 

so that the window area is correctly indicated. 

SHOW ROOM HATCHES 

 
 

Extras menu > Room hatches on/off 

This function opens a dialog window to set the visibility of room hatches. 

 



Chapter 10 – Extension  

www.elitecad.eu  813 

10.7 ROOM SEPARATOR 

 

Construction parts toolbar 

AR Objects menu > Room separator 

In some cases, you will want to show parts of rooms. You can delimit rooms using the 

room separator, a special polygon. 

In the same way as for the walls, the program needs closed contours to identify rooms! 

Therefore, please ensure that you always make connections of room separators with 

the corresponding capture modes, so that no "holes" develop. 

ROOM SEPARATOR PROPERTY BAR 

The property bar is visible as soon as the function ROOM SEPARATOR is started or 

an existing room separator is edited. 

 

Entry mode 

 

 

Draw contour 

Select contour 

Line type 

 

Line type used to draw the room separator. 

Pen 

 

Pen used to draw the room separator. Room separators may also be drawn with pen 

"0" (will not be printed). 
 

TIP 
Further examples of room separators: 

 Using room separators, large rooms in departments (large 

offices/department stores/cost centres) can be divided.  

 Exterior areas such as balconies and terraces can be recorded as 

quantifiable rooms.  

 WORKSHOP  

Set room separator 

Example: 

Split a living room with an attached kitchen so that both areas can be shown separately. 

Draw the room separator from "wall to wall", so in this case also along the working 

area edge. 
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The separation line will not be printed. If you want to show a separation line due to a 

change of covering, you can change the pen colour with the PEN/LINE FROM 

ELEMENT function. 
 

Select function 

 

If you have not yet created a polygon, you will need to select the option DRAW 

CONTOUR. 
 

Draw the room separator. Line type and pen colour are not relevant. 

Attention: Only draw a room separator between the walls and never over them. 

  

You must not press the [Esc] button to end the contour, but click again on the last point 

of the room separator contour in the same way as for the wall. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  WORKSHOP END 
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10.8 ROOM GROUP 

 

Construction parts toolbar 

AR Objects menu > Room group 

Multiple rooms are grouped into a room group. An application of room groups is the 

combination of multiple rooms into an apartment. 

ROOM GROUP PROPERTY BAR 

The properties bar is visible as soon as the ROOM GROUP function is launched or if 

an existing room group is edited. You can manipulate the main values in the room 

group’s properties bar. 

 
 

 Type 

 Description 

 Renovation planning sate (see chapter 8.5) 

 
Room name 

 
Unit 

 Section 

 
Storey transcening 

 
Structure transcening 

 
Label 

 
Copy values of room 

 
Show grouped rooms 

ROOM GROUP PARAMETERS 

 

You can open the room group parameters via the properties bar or by double-clicking 

the room group to be modified. 
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General parameters 

   Status renovation planning 

  Freeze 

 Type 

 Layer 

The general parameters for architectural objects are described in chapter 8.5. 

Description 

The description corresponds to the room name in the room label. 

Filter criteria 

The room group parameters correspond to the parameters of the room. They define 

how rooms are grouped according to which criteria. Empty fields are not user for 

filtering. 

In order to avoid entering all values, parameters can be copied from a room. Parameters 

that are not needed are easily deleted. 
 

It is allowed that room group are storey or structure transcending. If a storey or 

building transcending filtering is deactivated, the filtering considers only the same 

storey or structure of the room group. Special treatment is performed if structure 

transcending without storey transcending is activated. That configuration considers 

storey of all structures having the same storey number like the room group. 
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LABELLING PARAMETER 

 

The labelling parameters of the ROOM GROUP function are identically to the 

labelling parameters of rooms. The only difference is that areas correspond to the sum 

of areas of the grouped rooms. 

If the option UPDATE ROOMS AUTOMATICALLY is active, then the sums of 

rooms are automatically calculated.  
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11.1 VIEWS 

What is a view? 

In ELITECAD, the word "view" summarises the following terms: 
 

 General view (building view, facade, standard view like front, rear, isometric) 

 Plan view 

 Section 

 Detail 

 Plot view 
 

A view is synonymous with a "defined view angle" of the 3D model. Depending on 

the view type, this view angle can display different properties, such as the depiction of 

the model as a floor plan, a 3D hidden line or section. In addition, a filter can be defined 

that determines which components of the design model are to be displayed. Additions 

can be made in the views that are not visible in the design model. The design model 

can therefore be edited without being disrupted by a multitude of lines that originate 

from floor plans, sections, views and details. 

A view is determined (e.g. 3D rotated and zoomed) and saved under any name. 

There is a direct connection between 3D model and plan views. All other view types 

can be refreshed as required. If the project is modified in the design model, the changes 

are also displayed in all defined views and plots. The greater part of project processing 

and the associated creation of plan documents can be generated from a single 3D model 

by using views. This helps to avoid inputting and executing redundant CAD inputs in 

ELITECAD as much as possible.  
 

TIP 
In ELITECAD Architecture views are only backed up once all storeys 

have been saved together (e.g. as model.d). This must be borne in mind 

especially when working with separate storey files (see chapter 8, team 

function).  

TIP 
The option SAVE VIEWS can be deactivated in the OPTIONS. This is 

used for instance to create library with reduced size.  

VIEWS MANAGEMENT 

 

View toolbar 

View menu > Window > Views... 

Views management is used for managing the individual views in the model. Views 

management helps to create an optimum overview, either for the management or for 

creating plans. 

If the window is not visible on the user interface, it can be opened or moved to the 

foreground via VIEW > WINDOW > VIEWS.... 

There are different options for positioning the dialog window on the screen. These are 

described in the chapter on the user interface. 
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Header functions 

Functions are in the top row. They change depending 

on which view type (design model, views, sections, 

etc.) is selected. 

If not all functions are visible, the window is too 

narrow and must be widened for the user to be able to 

access the functions. 

 

Left mouse button 

A view can be selected with the left mouse button. The 

name is marked and the view is shown in the work 

area. Open the parameter dialog window of the 

respective view by double-clicking it. 

A view can be inserted by drag and drop into a plot 

with the left mouse button. 

 

Right mouse button 

A new view can be created, the sorting order 

determined or a group (sub directory) created by 

clicking once on the title of a view type. 

Different functions are available depending on the 

type by clicking once on a view. 

 

Structure view 

Further structures are displayed or hidden by clicking 

once on the triangle preceding the main titles. Double-

clicking on the main title achieves the same result. 

What types of views are there? 

The main work takes place in the view Design model. 

The views are structured by type. 

- Design model views 

- Views 

- Sections 

- Plan views 

- Details  

- Plots  

- Layout templates 

- Reference 
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Predefined views 

In ELITECAD Mechanics only the Design model views exists when a new 

construction is started. All other views have to be manually created by you when 

needed. 
 

In ELITECAD Architecture some views are available from the outset. These are three-

dimensional design model views with predefined view position and focal point.  For 

instance, the design model view "Top view" displays the design model from above. 

When rotating it in 3D, it becomes apparent that it is a design model view. A design 

model view always displays the current model, but just from a different angle.  

 

NOTE 
Views can be detached from the main window for simultaneous 

processing in a separate window. This function is located in the context 

menu of the view and is described in chapter 1.2 USER INTERFACE > 

VIEW LAYOUT. 

References are described in chapter 1.9   

Header functions of views management 

Other functions are available depending on which view type is selected. 

 

 Functions to create new views 

 New main group 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 
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 Expand all view groups 

 Close all view groups 

Quick info 

If the cursor is moved over a view name, a window containing the most important 

information for this view appears temporarily. The type of the displayed data depends 

on the type of view.  

The preview image is only available once the view has been loaded for images that 

have been created prior to ELITECAD V12. 

        

Structuring 

Free groups and subgroups can be created under each view type that only contain views 

of this type. 

Main groups can also be created parallel to the view types. The function NEW MAIN 

GROUP can be accessed via the header functions, via the context menu of the Design 

model view or the context menu of the background of views management. 

Views of different types can be combined in self-defined main groups. 

 

Refresh views 

Views that are no longer up to date are marked with a symbol. The view is refreshed 

by clicking on this symbol. 

 

TIP 
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If multiple views are marked by holding down the [Ctrl] or [Shift] key, 

they can be refreshed simultaneously via the context menu.  

FUNCTIONS IN VIEWS 

Many functions in views of different types are identical and described in this common 

section. 

Show view in a new window 

This function is only available if "Multiple views" is switched on in the OPTIONS and 

the view is not active. The view is opened in a new window. 

Float view window 

This function is only available if "Multiple views" is switched on in the OPTIONS. 

The view is opened in a separate window, which can be displayed on a second monitor. 

Rename 

The view can be given another name. 
 

TIP 
The predefined design model views cannot be renamed or deleted. 

  

Delete 

The current view is deleted. The function must be confirmed in a query. The program 

switches to design model view. 

3D edit mode 

Modifying in 3D edit mode is only available in ELITECAD Architecture. The 3D edit 

mode is relevant for views with type "view", "section" and "detail". In model and plan 

views, one is always working in the 3D edit mode. 

Modifications or additions in the 3D edit mode can be made directly in the 3D objects. 

A more detailed description can be found in the chapter EDIT VIEWS. 

Export view 

The function creates a 2D file of the view. The file loses all relation to the original 

design model and therefore cannot be refreshed. 

Modify view 

The settings dialog window of the view opens and the values, especially the type, can 

be modified. 
 

TIP 
The view can also be modified by double-clicking on the view name.  
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Separate view 

This function is only available in ELITECAD Mechanics. This function is used to store 

the view as separate drawing. The view remains associated with the design model as 

an external view. You find a detailed description in the section External views. 

Define, modify or delete cut-out 

The menu item DEFINE CUT-OUT appears by right-clicking on the graphics window 

(context menu). If the cut-out already exists, MODUIFY CUT-OUT appears. 

   

The function DEFINE CUT-OUT determines an area to which the visibility of the 

view is restricted. Partial areas can therefore be defined from larger views. This 

functionality is not available in all views, excluded are the design model view, plot 

views and predefined standard views. 
 

The handles of the definition contour of the cut-out become visible with the function 

MODIFY CUT-OUT. Additionally, the cut-out can be modified via the middle mouse 

button and zoom functions (in model views the view angle). The camera position and 

the cut-out are saved by pressing [Esc] or CANCEL.  

 

The view angle in model views can be modified via VIEW > CAMERA. The most 

recent camera setting is saved once the camera dialog window is confirmed with OK. 
 

The context function DELETE CUT-OUT cannot be used for perspective views of 

"Design model view" type. 

GENERAL VIEW PARAMETERS 

Many parameters in the settings dialog window of views of different types are identical 

and hence described in this common section. 

Name 

The description of the view must be unique. If a view with the same name already 

exists, a query appears asking the user whether the existing view is to be overwritten. 

Type 

During creation, the type is fixed. Having been created, the type with the function 

MODIFY VIEW can be switched. Only compatible view types are offered, some view 

types do not allow type changes at all. 

Offline 

If the option OFFLINE is selected, the view cannot be refreshed. 
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Format 

Standard formats such as A5 to A00 can be selected or a user-defined paper format 

can be set. In this case, the height and width can be entered directly or saved with a 

name using the OPEN button. The format can be adjusted at a later stage. 

Orientation 

Users can select between portrait format and landscape format here. 

Rest scaling 

Hatch, text, arrows and dimensions are denoted with "Rest". 

Rest scaling is available for views with type "view", "section" and "detail". If the scale 

of the view is selected differently than in the model, this option controls whether the 

rest is enlarged or reduced like the geometry. 
 

EXPLANATION 
The check box only modifies the rest that derives from the design model 

or an original view. If hatches, texts or dimensioning have been drawn 

in the view, these depend on the switch settings in the menu SETTINGS 

> REST SCALING in the case of a change to scale. 

  

Renovation planning 

The settings for renovation planning are only available in ELITECAD Architecture. 

Object state 

 

The coloured depiction of renovation planning states can be activated per view. 

Additionally, the renovation planning has to be activated in the OPTIONS. 

Fillings 

 

Fillings for walls and slabs are displayed in the view according to the setting of this 

option. 

Demolition objects 

 

Demolition objects can be depicted in wireframe mode if necessary. In that case, they 

have no impact on the calculation of shadows. 

Visibility 

The settings for renovation planning are only available in ELITECAD Architecture. 
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Layer types 

 

This setting defines the visibility of multi-layered objects. Depending on this setting 

e.g. only load-bearing layers of a wall are depicted in a view. 

DESIGN MODEL VIEW 

 

A model view displays the model from a specific angle and in a specific depiction 

type, such as wire model, hidden line and render. As this is a view of the design model, 

it always shows the current state of the design model unless it is a view of the rendering 

type, which you must refresh manually. 

Header functions for design model views 

 

 New model view 

 New view 

 New section 

 New plan view 

 New detail 

 New plot 

 Create floor plan views 

 New layout template 
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 New main group 

 Modify 

 Refresh 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a design model view 

If you right-click on a created view, the following options are available: 

 

 

Show view in a new window 

Float view window 

Rename 

Delete 

Refresh view 

If a model view is in the "Rendering" depiction, the image is frozen and is no longer 

refreshed automatically. The view can be updated with the function REFRESH VIEW. 

Render offline 

If there is a large number of render graphics in high resolution, it might happen that 

the RAM becomes fragmented and is no longer fully available after a while. As such, 

the render graphics can no longer be rendered. To avoid this, the rendering of the image 

can be launched in a separate Windows process using this function. 

Export view 

If a model view is in the "Rendering" depiction, the image can be saved as a separate 

ELITECAD file. This plan only contains the graphic and can no longer be refreshed. 

Save PDF file 

Modify view 

Create new design model view 

 

New model view views management 

Insert menu > View (design model type) 

This function saves the current viewing angle of the CAD model in a new model view. 
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A new design model view can be generated via a corresponding header function or via 

the context menu of the model views if a model view is selected. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 

Settings of a design model view 

 

General parameters 

Name 

Type 

Format 

Orientation 

Offline 
 

View specific parameters 

Depiction 

The 3D model can be saved in the depiction type wire model, hidden line, solid or 

rendering. The type can be adjusted at a later stage via MODIFY VIEW. 
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Additional settings for rendering 

 

Render parameters 

 

The render parameters can be opened directly or the saved records called up here in 

addition. 

Background 

 

If this option is selected, a colour or a texture from the material database can be 

selected for representing the background image. 

Skymap can be selected as background image as well. Skymaps are 360° images, 

which offer a background in the walking mode for each viewing direction. 

  

  

Skymaps are provided as materials with the material property skybox shader (see 

chapter Managing and organising > Materials). 
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Renovation planning (only in ELITECAD Architecture) 

Object state 

Fillings 

Functions in the graphics window context 

menu 

Rotate skymap 

In order to adjust the skymap with the design model a skaycube/skymap can be rotated. 

The corresponding functions can be found in the context menu of the graphic window. 

The skymap can be manipulated with the mouse in graphics window.  

 

Move/scale background image 

Depending on the camera setting and angle, moving or scaling the background image 

is required so that it fits correctly. The corresponding functions can be found in the 

context menu of the graphic window. If you press [Ctrl] when scaling, the image can 

be modified maintain the aspect ratio. 

 

Functions in the graphics window context 

menu 

Define, modify or delete cut-out 

VIEWS 

 

The views are generated 2D plans. 
 

Editing of views is described in the chapter EDIT VIEWS. 
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Header functions for the views 

 

 New section 

 New detail  

 New plot 

 New layout template 

 New main group 

 Modify 

 Refresh 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a view 

If you right-click on a created view, the following options are available: 
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Show view in a new window 

Float view window 

Rename 

Delete 

3D edit mode (only available in ELITECAD Architecture) 

Separate view (only available in ELITECAD Mechanics) 

Refresh view 

Modifications to the model are included in the generation of the view. The design 

model data for the view valid up until now is replaced by data from the current design 

model. Newly drawn 2D elements are retained, as are edited elements of refreshed 

objects (e.g. deletion lines). 
 

Undesired elements are deleted or modified when post-editing a newly generated view. 

Instead of actually deleting the elements, the system draws "deletion lines" over the 

selected elements. These hide the original lines when refreshing. If the deletion lines 

are deleted, the original elements reappear after refreshing. 
 

TIP 
The deletion lines are assigned a separate layer automatically that can 

be hidden or displayed as required.  
 

TIPP 
When working with the classification structure group/class/level, care 

has to be taken that newly drawn 2D data is not added to an object, which 

will be updated. For instance, the hatch should not be added to the 

contour model.  

Export view 

Save PDF file 

Modify view 

Create new view 

 
New view views management 

Insert menu > View (view type) 

The currently set view angle on the model is displayed as a hidden line in 2D form. 

Hidden line means that all visible edges are rendered. 
 

TIP 
WORK PLANE ON SURFACE can also be used for generating a facade 

and the function VIEW POSITION used for a perspective view of it 

(chapter 2.3 image properties).  
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A new view can be generated via a corresponding header function or via the context 

menu of the views if a design model view is selected. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 

Settings of a view 
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General parameters 

Name 

Type 

Format 

Orientation 

Offline 

Rest scaling 

Heading 

The heading can be switched on or off. The name of the view is used as a heading. The 

parameters of the heading can be defined. The header is written in the centre above the 

view. 

Title 

The title can be switched on and off. 

ELITECAD Architecture uses the name of the view as a title. The text parameter of 

the tile can be specified. 
 

ELITECAD Mechanics uses a predefined text block for the title. Depending on your 

choice, the name of the view, the type of the view or the scale is used for instance. The 

text blocks are saved as templates in the directory <ELITECAD installation 

path>\u\<version>\me\glob\symbols\title and are selected by their name. The text 

parameters are taken from the template. 

Title position 

In ELITECAD Architecture, the title is positioned centred above the view. 
 

In ELITECAD Mechanics, the view title can be positioned centred below or centred 

above the view when creating the view. If the title is moved is afterwards in the 

graphics window, this is indicated in the menu as a free position. The view title position 

is maintained during regeneration of the view. A free position may be reset manually. 
 

TIP 
The header of the views can be moved individually in the plots.  

  

View specific parameters 

Quality 

The higher the quality set, the higher the precision of the rendering. The rendering time 

increases, however. 
 

Options: Preview, Fast, Exact in ELITECAD Mechanics. 
 

The setting PREVIEW uses a fast calculation method to detect the visibility of edges. 

In consequence of certain guesses, small errors may occur at the boundaries of curved 

surfaces. 
 

The setting FAST uses the data that are used for the display to detect the visibility of 

edges. This 3D data depends on the RESOLUTION setting, which means that 

boundaries of round surfaces are approximated by lines. If possible, arcs are used but 

the precision is not guaranteed. Just like in in the setting PREVIEW there is no correct 

treatment of tangential transitions possible. 
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The setting EXACT uses the analytical description of the geometry to determine the 

visibility of edges. 

Opening symbols 

This option is only available in ELITECAD Architecture. If this option is selected, the 

opening symbols are automatically displayed in the rendered view. The opening types 

must be set in "Tool for window division/muntins" of the individual windows. 

Visible lines 

Users can select between two options: 

All with the same pen or the pen is adopted from the edge colour. 

  

Hidden lines 

 

All edges that are behind the visible surfaces can be displayed in a specific pen and 

line type.  

Display priority 

This option is only available in ELITECAD Architecture. 

 

With the setting OBJECT BEFORE VIEW the invisible lines of a 3D object are 

displayed in accordance with the representation level parameters of the 3D object. 

TIP 
With the setting OBJECT BEFORE VIEW the invisible lines of single 

objects can be displayed, although they are generally deactivated in the 

view.  

Intersection lines 

If two 3D objects intersect, the resulting intersection lines are created with this check 

box. 
 

In ELITECAD Mechanics no intersections lines are calculated when the quality setting 

is set to EXACT. Objects that intersect each other may produce wrong results with this 

setting. Intersection lines have to be generated as real edges of the object using the 3D 

editing functions. 

Tangential Transitions 

This setting is only available in ELITECAD Mechanics. 

 

All visible edges (surface boundaries) that do not represent sharp edges can be depicted 

in an individual pen and line type. (e.g. transition between a planar surface and a 

cylindrical surface). Transitions between two surfaces of the same type (e.g. two 

halves of a cylinder) are never depicted. 
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This option is only available for the quality setting EXACT. 

Hidden tangential transitions are depicted with the settings for invisible lines. 

Centre lines 

This setting is only available in ELITECAD Mechanics. 

When this option is active, centre lines from the design model are depicted. 

Depiction 

 

This menu can be used to determine whether a solid image or a render image is stored 

in addition to the lines for the view. 

Hidden line 

Only lines are displayed. 

 

With solid image 

The colour surfaces are added to the background of the line depiction. 

 

With render image 

The render image is added to the background of the line depiction. 

 

If "Render" is selected, rendering parameters also appear. 
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Render parameters 

 

The render parameters can be opened directly or the saved records called up here. 

Vector shadow 

This option is only available in ELITECAD Architecture. 

 

In order to render a vector shadow, a light source with the light type "parallel light or 

sun" must be present. This must be set beforehand via the function LIGHT 

PARAMETERS. The "parallel light" may not be "camera relative" but must have a 

fixed position. If there is no such light source, the selection field remains blank and no 

shadow can be rendered.  

The orientation of the light source can be changed at any time via LIGHT 

PARAMETERS. 
 

TIP 
Create a separate light source for each view. This is the only way to set 

an optimal position of the sun for each individual view. If you use the 

same sun for each view and keep moving the position, the views may 

not be refreshed.  
 

Users can select which layers cast or receive shadows in SETTINGS menu > 

OPTIONS > VIEWS > VECTOR SHADOW. The hatch parameter that is used for the 

shadow can also be set here. 

Renovation planning parameters (only in ELITECAD Architecture) 

Object state 

Fillings 

Demolition objects 

Visibility (only in ELITECAD Architecture) 

Layer types 

General functions 

Storey division lines 

This option is only available in ELITECAD Architecture. The storey division lines 

and vertical division lines of walls and columns disappear if the same material has 

been selected.  
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Functions in the graphics window context 

menu 

Define, modify or delete cut-out 

SECTIONS 

 

The sections are generated 2D plans. 
 

Editing of section views is described in the chapter EDIT VIEWS. 

Header functions for section views 

 

 New section 

 New detail  

 New plot 

 New layout template 

 New main group 

 Modify 

 Refresh 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a section view 

If you right-click on a created view, the following options are available: 
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Show view in a new window 

Float view window 

Rename 

Delete 

3D edit mode (only available in ELITECAD Architecture) 

Separate view (only available in ELITECAD Mechanics) 

Refresh view 

Export view 

Save PDF file 

Navigate to origin 

Clicking this function switches to the view in which the section view was defined. The 

visible cut-out is set to the section line. 

Modify view 

Create section 

 
New section views management 

Insert menu > Section 

A new section is defined in the model. All relevant data should be assembled. 

 

A new section can be generated via a corresponding header function or via the context 

menu of the views if a design model view is selected. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 
 

TIP 
In ELITECAD Mechanics, a section view can be created directly in the 

plot view. After definition of the section line, the section view is placed 
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in the plot view. The position of the section view is associated with the 

section line. When moving the origin view the section view is shifted as 

well. In order to suppress this behaviour, click the frame of the view and 

select CANCEL POSITION LINK from the context menu.  

Settings of a section view 

 

General parameters 

Name 

The name is suggested automatically but can be modified. The program begins with 

the name "A-A" and continues with the name "B-B". If a name is used that already 

exists, a query appears asking the user whether the existing view is to be overwritten. 

It does not matter under which view type this is saved.  
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Type 

Format 

Orientation 

Offline 

Rest scaling 

Heading 

Section parameters 

Hatch section 

A section is hatched in ELITECAD Mechanics with the defined hatching parameters 

if the HATCH SECTION option is selected. 

A section is hatched in ELITECAD Architecture depending on the material definition 

of the individual sections of construction parts if the HATCH SECTION option is 

selected. The associated hatching parameter therefore does not need to be set. 

Modify section line 

This option is only available in ELITECAD Architecture. The borders of the sectioned 

planes are normally drawn with the same pen that the construction part section has in 

the model. Selecting this option modifies these lines in the same way as the sectioned 

construction parts are displayed in the floor plan. Floors and girders are an exception. 

The pen from the material definition of these two objects is used here in accordance 

with the display depth. 

Section line 

 

A section line is generated automatically for each set pen and line type in section 

control. 

 

A section arrow that was saved as a symbol is set at each end of this line. An example 

symbol sectionsymbol.d is saved here:  

<ELITECAD installation path>\u\<version>\<ar|me>\glob\symbol 

Separate symbols can also be created. 
 

There are three different types of section lines: straight, offset or limited. 

Users can choose between the same or a continuous designation for each type. 
 

 
Normal section / label A-A (entire model appears as a section) 

 
Normal section / label A-B (entire model appears as a section) 

 
Section stepped multiple times / label A-B 

 
Section stepped multiple times / label A-B C-D 

 
Limited section / label A-A 

 
Limited section / label A-B 
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The letter for the section label can be freely selected. 

 

Optionally a number be used. This creates possibilities for cut labelling such as "A1-

A1", "B2-B2" or "Z1-Z3". Alternatively, the letter can also be omitted so that the 

name consists only of digits, i.e. "1-1", "2-2" or "1-3" etc. 
 

TIP 
In ELITECAD Architecture the section line is added to the active storey 

during section creation. The section line can be adopted in the other 

storeys using the function COPY INTO ACTIVE STOREY.  

Modify section line parameters 

 

If an existing section line is clicked on, separate parameters such as pen and line type 

can be modified in the properties bar, or the shape may be changed via handles.  
 

 
Broken section line: 

The section line is divided between the arrows. 

 

 
Continuous section line: 

Removes the division described above. 

 

 
Broken section line with pen/line type:  

The section line is divided between the arrows. The divided interval can be 

drawn with a user defined pen/line type. If this option is selected, the new 

parameters appear in the property bar. 

 

 

View specific parameters 

See chapter Settings of a view for a description of the general view parameters.  

Terrain section line 

If a terrain is visible in the section view this option activates the depiction of a section 

line of the corresponding original terrain (only possible if a reference terrain exists). 

broken section line 

broken section line with 
pen/line type 

broken section line 

Continuous section line 

broken section line 

with pen/line type 
Continuous section line 
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Redirections 

 

For stepped sections the appearance at the redirections can be defined. With the option 

EDGE COLOUR the colour of the actual object in the 3D model is used. The option 

INVISIBLE draws the redirections with pen 0. A user defined appearance can be 

chosen with the option WITH PEN, where pen and line type can be selected. 

Depth of section 

 

For planar and limited section views, an arbitrary section depth can be defined. 

Depending on the selected option, objects that lie behind the entered depth are not 

displayed or displayed using a defined pen and line type. The depth distance is entered 

in current units. 

Depth of section - without 

 

Without a defined depth, all visible objects behind the section plane are displayed. 

 

Depth of section - invisible 

 

Objects lying behind the defined depth of section are not displayed. 
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Section depth – with pen 

 

Objects, lying behind the defined depth of section are displayed with the selected pen 

and line type. 

  

Renovation planning parameters (only in ELITECAD Architecture) 

Object state 

Fillings 

Sectioned fillings 

 

Sectioned fillings for walls and slabs are displayed in the view according to the setting 

of this option. 

Demolition objects 

Visibility (only in ELITECAD Architecture) 

Layer types 
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Functions in the graphics window context 

menu 

Define, modify or delete cut-out 

 WORKSHOP  

Generate sections 

Ideally, a new section is defined from the model. All relevant design model data must 

be assembled. 
 

Click on the function CREATE NEW SECTION 

 

or with the right mouse button on the title "Sections" in views management 

 

Set section dialog window with stepped section line 

  

Enter point 1 for section gradient [identical point > end] 

Enter one point of the section line after the other. Click a second time on the last point 

to close. 
 

Which direction? 

The viewing direction of the section can be defined depending on the side you move 

the cursor to. This can be easily controlled using the alternating arrow symbols. 
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The section is calculated having set the 

direction. 

 

In ELITECAD Architecture, all opened door 

leaves are temporarily hidden during section 

control so that they are not visible in the 

section. All sections of the construction parts 

are hatched in accordance with their material 

definition. 
 

In ELITECAD Mechanics all sectioned 

construction parts are automatically hatched. 
 

The section has now been added in the views 

management and can be selected. 

 

  WORKSHOP END 

Define direction 

End – click twice 

Start 
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PLAN VIEWS 

 

In ELITECAD Mechanics 3D plan views are usually not used. 

In ELITECAD Mechanics 2D a plan view can be used to manage cut-outs of the 

model. 

In ELITECAD Architecture the plan view displays the 2D-relevant architectural data 

of the model as a floor plan. These are usually the drawing elements displayed in the 

plan graphics of a storey floor plan. 

Unlike a section or a view, the plan view always refreshes itself with the model and 

vice versa. If a door is moved in the floor plan, this modification is immediately visible 

in the design model.  

Each plan view may have a separate visibility control of the layers. As such, there may 

be multiple plan views of a storey in which different structures are visible. 
 

TIP 
The design model and the plan view refresh each other. All plan views 

are therefore always consistent with the latest version of the model. This 

is why lines from the 2D floor plan cannot be deleted arbitrarily without 

compromising the 3D geometry.  

Header functions for the plan views 

 

 New plan view 

 New detail 

 New plot 

 New layout template 

 New plan cut-out 

 New main group 

 Modify 
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 Refresh 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a plan view 

If you right-click on a created view, the following options are available: 

 

Show view in a new window 

Float view window 

Rename 

Delete 

Refresh view 

Creates a new image assembly 

Export view 

Save PDF file 

Modify view 
 

TIP 
The type must be set to "Design model" in order to modify the selection 

of the design model data for the current plan view. The view now 

appears under the design model views. All data from the model appear 

with ASSEMBLE. The selection can now be redefined via storey and/or 

layer management. The type is set back to plan with MODIFY VIEW. 

  

Generate floor plan views 

 
Views management > Generate floor plan views 

Insert menu > Floor plan views 

This function is only available in ELITECAD Architecture and creates all floor plan 

views of the model. Floor plans are plan views. Designation is performed in 

accordance with the designation of the individual structure settings of the individual 

storeys. All storeys that have the same storey number are displayed in the same floor 

plan view (e.g. "-1, 0, 1, 2") for multiple structures. If different storey names are on 
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the same level, the individual plans are given the names "Level 0", "Level 1", "Level 

2", etc. 

Create new plan view 

 
New plan view views management 

Insert menu > view (plan type) 

 

A new plan view can be generated via a corresponding header function or via the 

context menu of the views if a model view is selected. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 
 

In ELITECAD Architecture plan views are typically created by the function 

GENERATE FLOOR PLAN VIEWS. The function CREATE NEW PLAN can be 

used to define exactly which data appears in the plan. Each plan view may have a 

separate visibility control of the layers. It is therefore possible to design multiple plan 

views for the same storey with different contents (e.g. for electronic installation or 

furnishing). 
 

TIP 
You also have the option to display storeys from different structures in 

the same plan. E.g. Ground floor of structure A with the basement 

parking of structure B.  

Settings of a plan view 
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General parameters 

Name 

Type 

Format 

Orientation 

Offline 
 

Plan parameters 

Automatic hidden line 

This option is only available in ELITECAD Architecture. If a plan view is defined 

with a storey filter, all 2D data belonging to the storey is displayed. In addition, a 

hidden line is created with this option for all 3D objects of the storey for which there 

are no 2D lines parallel to the storey level. 

Renovation planning parameters (only in ELITECAD Architecture) 

Object state 

Fillings 

Functions in the graphics window context 

menu 

Define, modify or delete cut-out 

New plan cut-out 

 
Views management > Create plan cut-out 

 

The plan cut-out is an area of an entire plan. The plan cut-out is always up to date with 

the plan as well as the model. The plan cut-out behaves in the same way as a plan view. 

Data that is added in a plan cut-out is also added directly in the plan and design model. 

The plan cut-out is used if the plan view has a format that is too large and must be 

divided into separate cut-outs for a printout. In ELITECAD Architecture an apartment 

building can be separated from the whole. The plan cut-out can be saved in a different 

scale than the plan view. An area can be zoomed in when displayed on the border. 

 

The plan view can only be created from a plan view. As soon as the plan view is 

selected, the option NEW PLAN CUT-OUT appears in the header functions. 
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Once the name of the plan cut-out and the other settings have been defined, a properties 

bar opens in which the line type and colour of the bordering can be determined. (Pen 

colour 0 = invisible on printout) 

The cut-out in the plan is then defined via two diagonal points. 

 

The plan section is listed in the plan views. 

The same editing rules apply as for the plan views. 
 

TIP 
The detail frame should not be deleted from the original plan. The user 

therefore always has the option to stretch or move it and to refresh the 

plan cut-out again.  
 

Plan section context menu 

 

Navigate to origin 

Clicking this function switches to the view in which the plan cut-out was defined. The 

visible cut-out is set to the cut-out contour. 
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DETAILS 

 

A detail is a generated 2D plan. 
 

Editing of detail views is described in the chapter EDIT VIEWS. 

Header functions for the views 

  

 New detail  

 New plot 

 New layout template 

 New main group 

 Modify 

 Refresh 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a detail view 

If you right-click on a created view, the following options are available: 
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Show view in a new window 

Float view window 

Rename 

Delete 

Separate view (only available in ELITECAD Mechanics) 

Refresh view 

This function refreshes the detail. Innovations that have been created in the original 

view are taken into account. When refreshing, all data that was rendered from the 

original view is first deleted and then the newly rendered data read in. Newly drawn 

2D objects are retained. 

Modified or deleted elements of objects being refreshed are returned to the state in 

which they were created in the original view. 

TIPP 
When working with the classification structure group/class/level care 

has to be taken that newly drawn 2D data is not added to an object, which 

will be updated. For instance, the hatch should not be added to the 

contour model, because it will be deleted when updating the view. 

  

Export view 

Save PDF file 

Navigate to origin 

Clicking this function switches to the view in which the detail was defined. The visible 

cut-out is set to the detail contour. 

Modify view 

Create new detail 

 
New detail views management 

Insert menu > Detail 

The detail view allows you to define cut-outs of your design model, cut-outs from the 

plan view (normal case) and from the section or a view. 

 

A new detail is generated using the corresponding header function or via CREATE 

DETAIL in the context menu of the title bar. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 

 

TIP 
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In ELITECAD Mechanics, a detail view can be defined directly in the 

plot view. You have to activate the desired sub view in the plot view. 

After defining the detail contour, the position of the detail label has to 

be indicated. Afterwards the detail view is placed in the plot view. 

  

Settings of a detail view 

 

While drawing the detail contour the pen and line type for the contour can be selected 

in the property bar. 

 

General parameters 

Name 

Type 

The type of detail depends on the type of the original view. If it was generated from a 

design model or design model view, it can be defined with the types "design model", 

"view" or "plan". A detail is generated from a view, a plan, a section or a detail and 

may only have the type "plan". 

Entry mode 

 

The area of the data that is to be transferred into the detail can be determined with four 

different options. 

There are two pre-defined shapes, rectangle and circle, as well as the polygon, which 

can be used to define any outline. 

The option SELECTION creates a detail from the objects visible on the screen. The 

detail is set automatically to "Offline" and can no longer be refreshed. 
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Format 

Orientation 

Offline 

Rest scaling 

Heading 

Renovation planning parameters (only in ELITECAD Architecture) 

Object state 

PLOTS 

 

The plot generates an empty page on which the plan layout is set up. Everything that 

needs to be drawn or loaded in addition (plan frame, title block, legend, labels) belongs 

to this plot. The previously defined views (plans, sections, views, details) can be placed 

as required. The views are only inserted as a reference. These sub views can be edited 

directly in the plot. Modifications in the original are added to the plot immediately. A 

plot is simply a set of different views. 

Header functions for the views 

 

 Insert view 

 Move view 

 Rotate view 

 Refresh view 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a plot view 

If you right-click on a created view, the following options are available: 
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Show view in a new window 

Float view window 

Expand/Reduce 

The sub views are displayed or hidden. Double-clicking on the plot name achieves the 

same result. 

Sort 

The sub views are arranged in ascending or descending order. 

Rename 

Delete 

Separate view (only available in ELITECAD Mechanics) 

Refresh view 

This function refreshes all sub views on the plot.  

Export view 

Save PDF file 

Insert view into plot 

This function opens a selection dialog window in which all views are listed. The 

required view can be marked, confirmed with OK and positioned in the plot. 

In the selection menu to insert new views into a plot view there are entries for 

predefined views, the design model view, the entry "4 views" and the manually defined 

views. In ELITECAD Architecture, all manually defined views are listed. In 

ELITECAD Mechanics, only those views are listed that are not assigned to a plot view 

or that are assigned to the active plot view. If they are assigned to a plot view, then the 

name of the corresponding plot view is given in brackets. Hereby it is possible to create 

sub views with identical names in different plot views. (e.g. different section views 

with the name A-A can exist in different plot views). 
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TIP 
The view can also be inserted into the plot using drag and drop.  

Activate the plot in which the view is to be positioned. Drag the NAME 

of the view into the plot with the left mouse button. As soon as you are 

in the work area, you can release the mouse button and position the view 

in the correct place. 

      

Insert four views into plot 

With this choice, four standard views (front view, top view, side view and isometric 

view) are inserted into a plot view. These are adjusted horizontally and vertically in 

the plot view and created according to the settings under SETTINGS > OPTIONS > 

VIEWS > GENERAL. Sections and further defined views can be inserted later. In 

ELITECAD Mechanics, these four views keep their relative position when moving 

one of the connected views. 
 

Add a view relative to another view 

In ELITECAD Mechanics, there is a further option to insert a view. If a view is already 

selected by its frame when starting the function INSERT VIEW INTO PLOT, the 

selection window is not displayed. Instead, new views are inserted relative to the 

selected view by folding. The position of the new view is associated with the origin 

view. When moving the origin view, the new view is shifted as well. In order to 
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suppress this behaviour click the frame of the view and select CANCEL POSITION 

LINK from the context menu. 

Move view 

The inserted views can be moved with this function.  
 

In order to move multiple sub views simultaneously, the placeholders (white/red 

bordering) that are to be moved are selected by holding down the [Shift] key and then 

clicking on the function MOVE SELECTION. 

Delete view 

Deletes placed sub views. 

The view to be deleted is queried. It must be selected via the placeholder (white/red 

bordering). This function must be confirmed. 

 

Multiple sub views can be deleted from the plot simultaneously. To do this, the 

required sub views must be selected via their placeholder (white/red bordering) with 

the [Shift] key held down and deleted with the [Del] key. 

This deletes the sub view from the plot. Deleting each view must be confirmed. 

Rotate view 

The function ROTATE VIEW allows users to modify the orientation of the view. 

Sections can therefore be placed in the direction of projection for the floor plan, for 

instance. 

Edit view 

The function EDIT VIEW can be used to switch temporarily to the selected sub view 

in order to make any modifications required there. The corresponding plot must be 

clicked in views management in order to switch back to the plot view.  

Modify view 

The detail parameters of the sub view can be changed later on with the function 

MODIFY VIEW. 

Edit layout template 

When selecting this function, the view is switched to the layout template and then it 

can be modified. 

Delete layout template 

The layout template will be removed from the active plot view. The layout template 

remains. 

Sub views 

If the structure is extended for a plot, all sub views appear that were inserted in the 

plot. If one of these sub views is clicked on, it can be edited within the plot. 

Placeholders (white/red bordering) are temporarily displayed in bold and red to 

differentiate them optically. The view is deselected and the placeholder displayed as 

normal when the name of the plot is clicked on. 

Texts, dimensioning, etc. can therefore also be aligned to each other in the plot 

compilation. 
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TIP 
The sub view can also be selected by double-clicking a placeholder. The 

view can be deselected by clicking outside the placeholder. 

Alternatively, the placeholder can also be selected or deselected via the 

context menu. Select the placeholder and right-click on the user 

interface.  

      

A range of commands can be carried out directly by right-clicking on a sub view. 

 

Create new plot 

 
New plot views management 

Insert menu > Plot 

Plots can be taken to mean a set of different views. 
 

TIP 
Views and details with different scales can be combined in a plot.  

  

 

A new plot is generated using the corresponding header function or via CREATE 

PLOT in the context menu of the plot title bar. 
 

The desired settings have to be entered in the settings dialog window of the view. By 

clicking on OK, the settings are saved and the view is created. The function MODIFY 

VIEW allows to change the settings of the view after creation. 
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Settings of a plot view 

 

General parameters 

Name 

Template 

Previously defined layout templates can be selected here. 

Layout templates can be created and managed in the view management window. Use 

layout templates to define plan descriptions only once and to add them in multiple plot 

views. The combo box only lists templates that are already loaded. 

The OPEN button allows adding already saved templates. Here *.d files can be opened, 

which have been saved as layout templates. 
 

TIP 
In order to add a layout template to an existing plot view or to replace 

an existing layout template, the template can be dragged using the mouse 

with drag and drop from the view management window onto the plot 

view.  

Format 

Orientation 

LAYOUT TEMPLATES 

 

A layout template contains data (e.g. texts, frames, keys) that are displayed in the 

background of plot views. A layout template can be used in multiple plot views. The 

layout template data cannot be selected or modified in the plot view. 
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Header functions for the layout templates 

 
 

 New plot 

 New layout template 

 New main group 

 3D edit mode (only available in ELITECAD Architecture) 

 Save PDF file 

 Expand all view groups 

 Close all view groups 

Context menu of a layout template 

If you right-click on a created view, the following options are available: 

 

Show view in a new window 

Float view window 

Rename 

Delete 

Export layout template 

A layout template can be exported as a separate file. Saved templates can therefore 

also be used in other drawings. 

Create new layout template 

 
New layout template views management 

 

New layout templates are defined via their names and are assigned a paper format. 

Like views, layout templates can be selected and then edited. 



Chapter 11 – Output  

www.elitecad.eu  862 

 

A new layout template is generated using the corresponding header function or via 

CREATE LAYOUT TEMPLATE in the context menu of the layout title bar. 
 

The desired settings have to be entered in the settings dialog window of the layout 

template. By clicking on OK, the settings are saved and the layout template is created. 

Settings of a layout template 

 

General parameters 

Name 

Format 

Orientation 

Replace a layout template 

To add a layout template to a plot view or replace an existing template at a later stage, 

the template can be dragged into views management via drag and drop. 

FILTER IN VIEWS 

Filters can be used to define which data of the model is displayed in a view. The 

primary used filters in ELITECAD Architecture are the storey and the layer filter, as 

well as the filter for renovation planning states. In ELITECAD Mechanics, the 

preferred filters are the assembly and classification filters. Additionally, there is an 

object filter available for both applications. 
 

It is essential which data is assembled when creating a new view, because the filter of 

the current view is saved in the new view. If the whole design model should be 

contained in the view, it is recommended that the whole design model is assembled 

before. Otherwise, the desired filter has to be set before. Objects created after a view 

was created are only visible in views if they belong to the filter. The object filter 

restricts the visibility only to certain objects, therefore new objects do not appear in 

views with object filters. Hence, object filters have to be applied with care. 
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If filters are active in a view, they are displayed in the views preview (move the mouse 

of the title of the view). 

 

Setting the filter when creating the view 

When creating a view, the filter of the current view is passed to the new view and 

saved as the filter for the new view. 
 

In ELITECAD Architecture, the filter for a plot view is irrelevant. In ELITECAD 

Mechanics, it is already essential, which construction parts are assembled when 

creating a new plot view, because the current selection is saved as a generation filter 

for views, which are assigned to the plot (see Filter for plot views). 

Modify the filter while editing the view 

The behaviour depends on the type of the view. 
 

In views with the type section, view or detail the filter which has been saved when 

creating the view, (generation filter) is used to generate a 2D view from the design 

model. Modification of a filter while editing a view only affects the visibility of the 

generated 2D data (display filter). 

Example: 

Layers can be switched on and off. A new layer filter is created. The elements of the 

layers are only displayed without the objects appearing behind them. Example facade, 

type view: Hide wall layer; building interior does not appear. 
 

In contrast, model and plan views directly show data from the design model. Therefore, 

it is not differentiated between generation filter and display filter for these views. 
 

In a plot view there is only a visibility filter for the 2D data drawn in the plot view. 

Modify the generation filter 

Modification of the generation filter is possible for views of the type plan, section and 

view and depends on the type of filter. 
 

The layer filter is directly modifiable (see Modification of the layer filter). 

In order to change the layer filter of sections and views the view must be switched to 

3D editing mode in ELITECAD Architecture. In this mode, you are temporarily in the 

model and are able to modify the filter. The new layer filter is saved when exiting the 

3D editing mode. 
 

Layer filter, classification filter and assembly filter in ELITECAD Mechanics can be 

modified analogously to the storey filter, which is described below. The classification 

filter can additionally be modified directly in the classification manager (see chapter 

1.6 Layer/Classification). 
 

When editing a view of the type plan, view or section, a storey filter cannot be modified 

directly in the storey manager. In order to reset the visibility of storeys the following 

procedure is required. 
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The view must be edited with the function MODIFY VIEW from the context menu of 

views management. The type must be switched to "Design model". The view now 

appears under the design model views in views management.  

The elements added in the view such as dimension, levels, library elements, etc. must 

be retained. 

 

The filter can now be reset. To fix the modification, edit the view again with the 

function MODIFY VIEW and set the type back to the previous type. The view now 

appears under the previous category in views management. The parts modified or 

added in the original view are displayed again. 

Storey filter 

The storey filter is only available in ELITECAD Architecture and is set in the storeys 

manager. 
 

active and visible 

invisible 

visible 
 

This filter allows to control the visibility of storeys and/or entire structures. 

Modify storey filter 

This is only possible in design model views. 

It is not possible to modify the filter of views of the detail type. 

Views of the plan, section and view type can be switched to the design model view 

type via MODIFY in the context menu, where the visibility can be re-adjusted (see 

Modify the generation filter). 

Layer filter 

The layer filter is set in layer management. 

Check boxes in layer management:   visible     invisible 
 

Layers can be switched to visible/invisible in all views. This is useful if, for example, 

only specific structures should be visible for specialist plans (electronic plans, 

installation plans...) etc.  

Modify layer filters in plan views 

If a filter is modified at a later stage, the system queries whether the current (i.e. the 

modified) filter is to be retained before leaving the view. 
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A LAYER setting is saved in the view and is retained when changing the view once 

the query above has been answered accordingly. 

Modification of the layer filter in sections and views 

In views of the type section and view, a modification of a layer filter only affects the 

visibility of the generated and added 2D data (display filter). 

In order to modify the visibility of the design model data in views and sections, the 

generation filter has to be modified (see Modify the generation filter). 

Renovation state filter 

The filter for renovation states is only available in ELITECAD Architecture and is set 

in the status window. Setting a filter for renovation planning sates is only possible if 

renovation planning was activated in the options. In order to set the visibility in views 

several reasonable combinations of states are predefined. 

Assembly filter 

The assembly filter is only available in ELITECAD Mechanics and is defined in the 

assembly manager window. 

Switches in the assembly management:   visible    invisible 

Assembly groups can be set visible or invisible in all types of views. 
 

TIP 
In the context menu of an assembly group in the assembly management 

window, a plot view of the respective assembly group can be defined 

directly.  

Modification of the assembly filter in sections views and details 

In views of the type section and view, a modification of filter only affects the visibility 

of the generated and added 2D data (display filter). 

In order to modify the visibility of the model data in views and sections, the generation 

filter has to be modified (see Modify the generation filter). 

Classification filter 

The classification filter is only available if the option WORK WITH 

GROUP/CLASS/LEVEL has been activated in the OPTIONS. This is the preferred 

option in ELITECAD Mechanics. 
 

The classification filter is set in the classification management window. 

Switches in the classification management:   visible     invisible 
 

The classification can be set visible/invisible in all types of views. 

Modification of the classification filter in sections views and details 

In views of the type section, view and detail, a modification of filter only affects the 

visibility of the generated and added 2D data (display filter). 

In order to modify the visibility of the model data in views and sections, the generation 

filter has to be modified (see Modify the generation filter). 

Alternatively, the generation filter can be modified directly in the classification 

management. Activate the filter symbol, which displays the design model data. The 

filter can be readjusted. 
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You find a detailed description in chapter 1.6 Layer/Classification. 

Object filter 

This filter is created when individual objects are switched off (functions 

HIDE/ASSEMBLE > SELECTION). This filter type should be avoided, as newly 

drawn objects do not appear in the view. The view only recognises the visible objects. 

Modified or new objects are not displayed. 

If an object filter is selected when creating a view, a message is displayed alerting the 

user to the problem. 

 

If only one object is to be hidden in a view, it is advisable to assign the object to a 

separate layer and hide the layer in the layer filter. 

Modify the object filter in sections, views and details 

In views of the type section, view and detail, a modification of a filter only affects the 

visibility of the generated and added 2D data (display filter). 

In order to modify the visibility of the model data in views and sections, the generation 

filter has to be modified. This is possible with 3D editing mode (see Modify the 

generation filter). 

Filter for model views 

In model views, all filters can be modified arbitrarily. When switching to another view, 

the current filter is saved when leaving a view, so that the filter is available when 

activating the view again. 

Filter for plan views 

In ELITECAD Architecture, a storey filter is usually active in the plan views: When 

generating floor plans a plan view with a single visible storey is created for each storey. 

E.g. Ground floor plan => only ground floor visible. 
 

Layers can be switched off when generating and later on when editing (see Modify the 

layer filter for plan views). 
 

While editing a plan view the storey filter cannot be set anymore in the storey manager 

(see Modify the storey filter) 
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Filter view, section and detail 

Creating a view 

The current filters are applied when defining a view. 

Examples for ELITECAD Architecture: 

One structure can be switched off for a model with two structures in order to have a 

free view of the other or the basement level is switched off so that it does not appear. 

If elements are of the environment are not needed, they can be switched off via a layer 

so that the facade behind them appears in the image. 

Layers that are not being used can be hidden for a detail from a plan view. For example, 

the dimensioning, as it must be much more detailed in the new detail. 

Editing a view 

Modifications of the filter while editing a view only affects the visibility of the 

generated or added 2D data (display filter). 

Modifying the generation filter 

In order to change the visibility of the design model, the creation filter has to be 

modified. (see Modify the generation filter). 

Filter for plot views 

Editing a view 

Filter in plot views control the visibility of the 2D data drawn in the plot view (display 

filter) like format frame, title block. Inserted sub-views have an independent filter. 

Generation filter 

In ELITECAD Mechanics it is essential which construction parts are assembled when 

defining a plot view, because the current selection (e.g. an assembly) is stored while 

defining a plot view (generation filter of a plot view). If predefined standard views are 

inserted into the plot view, these views will automatically apply the generation filter 

of the plot view (even when inserting four views). 

If plot views have already been defined in ELITECAD Mechanics when defining a 

new view, a query appears whether the new view should be assigned to an existing 

plot view. This guarantees that the new view uses the same filter like the plot view 

without setting the filter for the required construction parts manually before. 

The generation filter for plot views cannot be modified. 

BREAK VIEW 

This function is only available in ELITECAD Mechanics. Uniform long work pieces 

can be depicted in a shortened mode. Shortening positions are represented as tear-lines, 

which are drawn as zigzag lines, shaft- or pipe tear-lines. 
 

In order to create a view shortening, the desired view has to be selected in the plot 

view first. Start the function via the menu FINISH > TEAR-LINE or via menu entry 

TEAR-LINE in the context menu that opens by a click with the right mouse button in 

the graphics window. 

Existing tear-lines are edited via the context menu entry EDIT TEAR-LINE or deleted 

via the context menu entry DELETE TEAR-LINE. 
 

After starting the function, the following parameter window appears: 
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Once defined, parameters can be saved by RECORD > SAVE under an arbitrary name 

and later reused again. 
 

Select the type of the tear-line in right section of the parameter window. 

    shaft 

    pipe 

    zig-zag 
 

The hatch for pipes and shafts can be selected too. 

  name of the hatch 

In the main section of the window the dimensions are defined. Lengths and distances 

for the height of the tear-line, dstances to the view shortening and the pipe thickkness. 
 

The fields in lower section have the following meaning: 

  tear-line pen 

 tear-line line type 

The completed dialog window is confirmed with OK. A preview of the view 

shortening is displayed. Enter two points to define the position and the width of the 

shortening. The start- and endpoints of the tear-lines can be positioned by dragging 

with the mouse. 

All settings can be edited afterwards using the same parameter window. Select the 

view shortening and select the symbol for editing or use the function EDIT TEAR-

LINE. 
 

Shortened views are only displayed shortened in plot views. If a view is activated for 

editing, the shortened region is displayed in its full extent. 
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EDIT VIEWS  

Views and sections 

Modify in 2D mode 

Views and sections are 2D depictions that are linked in the background with the 3D 

design model. They can be edited with 2D functions. Modifications or additions to the 

views are not taken into consideration in the design model. Changes in the design 

model that affect the view are applied via the function REFRESH VIEW. 
 

A deletion line, which hides the original line when refreshing the view, is 

automatically drawn when deleting elements or modifying line thicknesses. These 

deletion lines are assigned a separate layer automatically that can be hidden or 

displayed as required. 
 

The object structure is retained when creating views (e.g. lines of a wall). The selection 

mode "Element part" ([Alt] key held down) can be used in order to edit individual 

elements of an object. 

Modify in 3D editing mode 

Modifying in 3D editing mode is only available in ELITECAD Architecture. 3D 

objects can be modified directly in views and sections by switching to the 3D editing 

mode. The name of the current view is displayed in blue. If this check box is ticked, it 

applies for all views until it is deactivated. 
 

Modifications or additions to 3D objects have an effect on the model. Newly added 

2D objects are only displayed in the corresponding view. 
 

3D editing mode on    3D editing mode off 

  

Details 

A detail is a 2D copy of the cut-out that was defined when being generated. The cut-

out is denoted in the original with a blue dashed border. If this frame is deleted, the 

detail is set automatically to Offline and can no longer be refreshed. 
 

The detail can be edited with 2D functions. Modifications to the detail are not taken 

into consideration in the design model or original plan. 
 

A detail can be stored as an "online" or "offline" detail. An "online" detail applies 

changes in the original view (plan, section, view) when it is refreshed. 
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EXTERNAL VIEWS 

Working with external views is only available in ELITECAD Mechanics. Views of 

the type section, detail, plot or view can be saved as independent drawings. They 

remain connected as external views with the design model. 
 

This option offers the advantage that it is not necessary to load all views when loading 

the design model. Additionally, external views are available as simple 2D plans for 

printing or examination, which are loaded faster individually than loading the design 

model plus the views. 
 

The process of separating view data is called SEPARATING. The function 

SEPARATE VIEW is accessible in the context menu of the views in the views 

management. The external view is saved as a drawing file in the same directory like 

the design model file. During this process, the view is removed from the working 

storage. 

External views are LOADED and UNLOADED back to the working storage via the 

context menu. After opening a drawing all external views are unloaded.  

A separated view can be reintegrated later via REINTEGRATE VIEW from the 

context menu to be part of the design model file again. The external view file is deleted 

during this process. 
 

The view state is displayed in the views management window with a specific symbol: 

 
normal view 

 
Separated view, not loaded 

 
Separated view, loaded 

 

Separated view, loaded with write 

protection 

TIP 
Please consider that external views are not missing when handing over 

drawings. Optionally use the function FILE > CREATE ARCHIVE, 

which creates a drawing file where all external views are reintegrated. 

  

Editing separated views 

If external views are loaded together with the design model view, they can be treated 

like normal views, updated and modified. When the model is saved, the loaded external 

views are automatically saved together with the model. 

External views can be opened as independent drawings. In this case, only additions are 

possible, because there is no access to the design model. Especially, the addition of 

attributes, position numbers and dimensioning requires access to design model 

information. The absence of the design model is indicated with a symbol in the views 

management window. 
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EXPORT VIEWS TO PDF 

Which views can be exported? 

Following views can be exported: 

 Model view 

 Plan view 

 Section view 

 Plot view 
 

Each view is exported using its scale and format. The model view is exported as a 3D 

model. 

Which preconditions have to be fulfilled? 

In order to create PDF-files using ELITECAD the following software packages have 

to be installed: 
 

The installation is described for the Bullzip PDF printer, but any other PDF printer 

may be used as well. 

1. Bullzip PDF printer: 

Bullzip PDF printer is used for creation of PDF files. The current version can be 

downloaded from http://www.bullzip.com/products/pdf/info.php. A tested version is 

also available on the installation media of ELITECAD in the directory "\Tools\ 

BullZipPDFPrinter\". 

2. Ghostscript: 

Ghostscript is required for the conversion of postscript-files into PDF-files. The 

current version can be downloaded from http://www.ghostscript.com. A tested version 

is also available on the installations media of ELITECAD in the directory 

"\Tools\Ghostscript\". 
 

A complete installation description is available in <ELITECAD installation 

path>\u\<version>\doc\de\cad\PS-PDF.pdf. 

See Views cannot be exported. 

  

http://www.bullzip.com/products/pdf/info.php
http://www.ghostscript.com/
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Export 

 

View management 

Save PDF 

Views that should be exported have to be selected. A click on the symbol opens the 

export dialog window. 

 

TIP 
If multiple views are marked with [Ctrl/Strg] or [Shift] key, they could 

be exported together using the export item from the context menu. 
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Export-dialog 

 

The tree on the left side shows all views that can be exported. By clicking the button 

with the arrow pointing to the right, all marked views are added to list of views to be 

exported. 
 

TIP 
If multiple views are marked with [Ctrl/Strg] or [Shift] key, they could 

be exported together.  

 

The list on the right side shows all views that are selected for export. By clicking the 

button with the arrow pointing to the left, all marked views are removed from the list 

of views to be exported. 
 

TIP 
If multiple views are marked with [Ctrl/Strg] or [Shift] key, they could 

be removed together.   
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The order of the views in the list of views to be exported defines the sequence how the 

views are appended to the PDF document. By clicking, the button with the arrow 

pointing up or down the order can be modified. All selected views are shifted up or 

down by one position. 
 

TIP 
If multiple views are marked with [Ctrl/Strg] or [Shift] key, they could 

be moved together.  

 

If the checkbox "Open PDF" is selected, the PDF-document is opened after creation 

using the configured standard PDF-reader. 

 

By clicking the button "Export" all views are exported into a common PDF document. 

The order of the views in the list of views to be exported defines the sequence how the 

views are added to the PDF document. Each view will be added as a separate page into 

the document. 

After clicking the button, the explorer appears and asks for a PDF document. 
 

By clicking the button "Export separated", all views are exported into a separate PDF 

document.  

After clicking the button, the explorer appears and asks for a PDF document.  

Each view will be exported into a file. The file name is a combination of the selected 

PDF document and the view name. 
 

Once the settings in this dialog have been made, they will remain. If the dialog is 

opened again, the same views are selected for export. 

If the drawing is saved, the information which views were selected for export is saved 

as well. 
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Views cannot be exported 

 

If Bullzip PDF printer or Ghostscript are not installed properly, only the model view 

can be exported as a 3D model. 

Clicking the help button at the lower right corner opens an installation description how 

to solve this problem. 
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11.2 PRINT 

  

Toolbar * main functions 

File menu > Print 

This function is used to output a print copy. All printers in Windows can be 

communicated with, however. Each device must have been created under Windows as 

a printer ( key > Devices and printers; Windows8: [ KEY +I > CHANGE PC 

SETTINGS > DEVICES > ADD DEVICE). 

UNIX printers in the network can be communicated with by adding a connection with 

"LPR Port" and a host and spool name. 

All images and vector graphics can be output. The colour and pen widths of the lines 

and the infill hatches are determined under SETTINGS > COLOUR PROPERTIES. 

If colour gradient hatches or transparencies exist in plans, certain printer drivers may 

not print them as transparent. In this case, the option PRINT IN HIGHEST QUALITY 

must be selected under SETTINGS > OPTIONS > SYSTEM > CONFIGURATION. 

The following entry dialog window appears after activating this function. 

 

Name 

Names of available printers. The user can select a type of printer as an output device. 

Properties 

Opens the driver of the printer set. The format and resolution are defined here in 

particular. 

Print 

The print format can be used for all printers and plotters. 

Plot  

The plot format is used for printers or plotters that support HP/GL2. This check box is 

only available once a corresponding assignment is made with SET PLOTTER. 

Format detection 

This check box is only available in connection with plotting. If the check box is ticked, 

the current drawing format is used. However, if this is not required or possible (e.g. 

A00 or oversize format), this check box must be deactivated and the corresponding 

paper format (paper size, portrait/landscape format) selected via Properties. 

Output in file  

If this check box is ticked, the output files are redirected into a file. The dialog field 

Save file appears. 
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Format/cut-out 

 

Users can select here whether the entire drawing or the currently zoomed cut-out of 

the drawing is to be printed. 

Modify 

If this check box is ticked, the drawing is adjusted to the selected output format. The 

ISO page border becomes visible. 

The check boxes Cut-out and Modify must be ticked in order to print a zoomed area to 

fill a page. 

Rotate 180°  

Selecting this function prints the entire printout rotated 180°. 

 

If the check box Modify is ticked, scaling is not possible. 

Factor 

Enter here the value that should be used for scaling. 

X-offset/Y-offset 

The user can state moves of the printout in X- and Y-axis direction. Given in mm. This 

is necessary in the event that the printout is centred on the format but is to be placed 

on the margin on paper. 

Number of copies 

 

This check box is used for defining the print run.  

Options 

Printing parameters can be set here. The same window opens as under SETTINGS > 

COLOUR PROPERTIES 

Set plotter 

A plotter configuration can be assigned to the selected printer/plotter via this check 

box. This creates a file in the directory <ELITECAD installation 

path>\u\<version>\cad\glob\hpglconf with its name consisting of the type designation 

(entry for type in the printing main dialog window) and the file extension .hgc. The 

Plot check box can now be ticked and plotting can commence. 
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During plotting (on a laser printer e.g. LaserJet), as the drawer is determined when 

creating the device (e.g. A4 drawer, manual feeder), it is not possible to switch between 

different drawers later on for outputs (e.g. A3/A4 drawer). Multiple plotters can be 

created for the same printer. 

Diskette 

This check box is used for loading a plotter configuration from an external data carrier. 

Remove 

If a configuration has already been assigned to a plotter, it can be deleted with Delete. 

Vanishing point plotting 

The configuration HP DesignJet (vanishing point plotting) must be selected for 

vanishing point plotting. A vanishing point plot occurs if the drawing protrudes over 

the edges of the format boundaries, e.g. width A1 and length 2 A1 (594 x 1682 mm) 
 

TIP 
You can also generate and print a TIFF, JPEG or BMP file to print a 

solid view with FILE > FILE EXCHANGE > WRITE GRAPHICS.  

  

EXAMPLES 

The basic drawing is a work drawing with details in A0 format, scale 1:50  
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Default setting A4 format 

  

Result: A cut-out of the drawing. The drawing is cut around the centre. The cut-out 

remains to scale. 

  

Format with modify 

This setting means that everything is always output on the selected printing format 

regardless of the format on the screen. The printout is not to scale. 

  

E.g.: A drawing in A0 format is adjusted to the format that is set under properties (e.g. 

A4).  

CAUTION: If the lines are too thick in this case, they can be set under SETTINGS >  

COLOUR PROPERTIES. This means that A0 can also be output on lasers in A4 

format (still visible). 

Result: Complete drawing but not to scale. 
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Cut-out 

The current zoom cut-out is output in the selected format that is set under properties 

(e.g. A4) using the CUT-OUT function. This printout remains to scale. No defined 

zoom can therefore be output with this method. This is possible using the functions 

CUT-OUT and MODIFY. 

  

Zoom on screen 

 

Result: 

To scale cut-out area 
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A3 format with upright A4 format 

  

  

Switch to portrait format in the properties to ensure that the output is correct. 

A0 plan 

Some example settings for HP DesignJet 1055C A0 plotters: 

 

Printing command 

Landscape format 

 

User-defined paper size 1220 x 860 mm 
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Activate automatic rotation and printing area in the plotter settings. 

 

Plotting command 

Activate plotting and format detection 

Landscape format 

 

A1 plan 

 

Printing command 

Landscape format 

User-defined paper size 860 x 620 mm 

Paper source: 36-inch roll 

Activate automatic rotation and printing area 

Plotting command 

Activate plotting and format detection 

Portrait format 

Paper source: 36-inch roll 
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A1 plan halved in height 

 

Printing command: 

The PRINT command takes the centre of the page as the point of reference. A Y-offset 

can be entered for vertical moving and an X-offset for horizontal moving to move the 

reference point. 
 

Y-offset scaling of 150 mm 

Landscape format 

User-defined paper size 860 x 320 mm 

Paper source: 36-inch roll 

Activate automatic rotation and printing area 

 

Plotting command 

Activate plotting and format detection 

Portrait format 

Paper source: 36-inch roll 

A4 plan 

Printing command 

X-offset scaling of 105 mm 

 

Portrait format 

User-defined paper size 230 x 320 mm 

Paper source: 36-inch roll  

Activate automatic rotation and printing area  

Plotting command 

Activate plotting and format detection 

Portrait format 



Chapter 11 – Output  

www.elitecad.eu  884 

Paper source: 36-inch roll 

Plan between A0 and A00 

Plan 90 cm high, 120-180 cm long 

Printing command 

Format must be centred to A00 

 

Landscape format 

User-defined paper size 1220-1820 x 920 mm 

Paper source: 36-inch roll 

Plotting command 

The plan must be left aligned on the A00. The vertical position of the plan is not 

important. 

 

Activate plotting and format detection 

Landscape format 

Paper source: 36-inch roll 
 

A special plotter configuration must be installed for formats larger than A0: 

HP DesignJet (vanishing point plotting) 

(If plotting is performed again with A0 size, the default configuration must be set up 

again)  

Plan 84 x 120-180 cm on A00 
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Plan with excess length 

 

Printing command 

Landscape format 

User-defined paper size 2020 x 320 mm 

Paper source: 36-inch roll  

Activate automatic rotation and printing area  

Plotting command 

The plotter must be installed with the option ENDLESS PLOTTING.  

Activate plotting, format detection deactivated 

Landscape format 

User-defined paper size 2020 x 320 mm 

Paper source: 36-inch roll 

Zoom plot 

     

Toolbar * main functions 

File menu > Print 

A plan cut-out can be selected and output directly on a printer or in a PDF file with 

the ZOOM PLOT function. Users can choose between A4, A3 and a freely definable 

printing format. 
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Template 

A previously created layout template is used as a template. A layout template appears 

in the preview window when selected. Any scale can be entered or selected from the 

list. Settings that were already defined by the Layout template can no longer be 

selected (format, orientation, format frame, display autotext).  

Format 

Formats from A5-A00, A-E as well as A4 and A3 portrait format can be selected. The 

format must also be set in the printer driver. 

Orientation 

Landscape or portrait format. The orientation must also be set in the printer driver.  

Scale 

A scale can be selected from the list or entered directly into the field.  

Print 

FORMAT FRAME active: A frame is printed out along with the drawing. The frame 

drawing can be found here: 

<ELITECAD installation path>\u\<version>\cad\glob\l 

AUTOTEXT active: Auto texts of the format frame drawing are printed. 

BORDER active: A covering border with the entered width (in cm) is inserted.  

POLYGON active: If the centre point is set, a polygon dialog appears and the Input 

Assistant tools are displayed.  

EXTENDED COVERAGE AREA: The entire drawing is hidden with the exception 

of the cut-out to be printed. 
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12.1 OVERVIEW 

The terrain module is an optional extension to ELITECAD. This module can be used 

to model natural landscapes using height lines or dimensioning points, or to import 

terrain data in different formats. Streets, paths, external borders, excavation ranges and 

landfill/dispersal ranges are defined by parameterised editing functions in order to 

provide a building's or a plant’s surroundings with the desired final appearance. The 

excavation volume or quantity of soil dug up is refreshed with every modification and 

provides a substantial tool for the calculation. 

The 2D excavation plan contains slopes with the inclines indicated and automatically 

generated height lines. Points with the height values displayed are always up to date. 

The 3D design model depiction follows either with a finished building or as a 3D 

excavation plan. Height lines are transferred into the views; a section depiction is 

similarly possible. 

References to structures and projects settings in this chapter are only valid for 

ELITECAD Architecture. 
 

TIP 
In the course unit "Terrain" you can then see the functions in a practical 

example. In the pre-installed example project "Terrain" there is also an 

example file (Example_terrain) available.  
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12.2 BASIS 

TERMS 

Terrain model: 

The terrain model is always an object in ELITECAD that contains all of the 3D data, 

modifications, parameters, etc. 

Height lines: 

Height lines are used to display height information in a planar depiction. Points of 

equal height are connected at regular height intervals with a curve. 

Height points: 

These are measuring points on the surface. 

Excavation: 

Removed material. 

Landfill/dispersal: 

Dug up material. 

Reference terrain: 

A terrain's frozen state. 

FUNCTION 

A terrain model is created in two basic steps. 

1. The shape of the original terrain is defined by: 

 Height lines 

 Height points 

 Perimeter contour 
 

The data is either manually created or read in different formats and describes the shape 

of the parcel of land before each modification. This state can be saved as "reference 

terrain". 
 

You can then edit the terrain. There are two different ways of making changes: 

2.a The original terrain surface is manipulated by: 

 modifying the height lines 

 modifying the height points 

 inserting terrain edges/areas 
 

The result of this step is a new terrain surface showing how the parcel of land should 

ultimately look. 

2.b Architectural measures: 

 Streets/paths (with slopes) 

 Terrain excavation (e.g. cellar) 

 Landfill/dispersal (e.g. car park, terrace) 

 Free excavation 
 

The architectural measures are saved as "modifying objects" which are integrated into 

the terrain surface. 
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If you make changes to the definition data (points, height curves), the architectural 

modifications will be added to the refreshed terrain. 

The finished terrain ultimately has a positive or negative volume difference to the 

reference terrain. A positive difference means that material needs to be added; a 

negative one means that material needs to be removed. 
 

A plan view can then be created from a fully defined terrain. Theo plan view is always 

updated even when making modifications and contains information relevant for an 

excavation plan. 

In a section view the visibility of the reference terrain can be activated in the view 

parameters. 

3. Completion of the excavation plan 

 Specify height marker 

 Generate view 

 Activate hatch and height sections 

LIMITATIONS 

 The terrain must neither overhang nor contain any holes. 

 There can only be one terrain object per drawing. 

 Excavation contours, landfill/dispersals and the perimeter contour must not contain 

any holes. 

 Height curves should not intersect each other. This is not prohibited but the 

differing heights produce a situation which does not naturally occur. 

 The external borders (perimeter contour) must lie within the points and curves. The 

contour is checked when regenerated. If the perimeter contour is later modified so 

that the perimeter contour lies in an undefined range, the result is undefined. 
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12.3 CREATE TERRAIN 

 

Terrain toolbar 

Extras menu > Terrain 

Click the TERRAIN function to start a terrain model. The terrain properties bar 

appears and an empty terrain object is created. All further data is automatically inserted 

into this object. 

TERRAIN PROPERTIES BAR 

 

The properties bar becomes visible if you select the TERRAIN function to generate a 

terrain or if you click an existing terrain to edit it. 
 

 
Terrain options 

 
Renovation planning state (only in ELITECAD 

Architecture) 

 
Generate 

 
Terrain mode 

 
Colour selection – direct entry 

 
Colour selection over table 

 
Entry mode 

 
Switch on height lines 

 
Switch on slope 

 
Volume 

 
Save reference terrain 

 
New definition point 

 
New height line 

 
New terrain edge/area 

 
Move points and curves in Z direction 

 
Perimeter contour 

 
Excavation 

 
Landfill/dispersal 

 
Free excavation 

 
Street 

 
Path 

 
Height point 
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TERRAIN OPTIONS 

 

The "Parameter(s)" button calls up the detailed terrain options. 

All parameters relevant to generating a terrain are saved with the terrain object. If you 

load a drawing with terrain, these are adopted and applied to the active parameters. 

General parameters 

 

 

Type 

 

Used to select predefined parameters. 

In order to save a new record, the parameters have to be set and a new name has to be 

entered into the text field. 

 Saving a record 

 Deleting a record 

Layer 

 

Every construction part has the layer field in the record with the layer selection. It is 

then guaranteed that the construction parts already lie in the correct layer when they 

are generated. 

You can generate a new layer by entering its name into the text field. 

Renovation planning state 

 

This option is only available in ELITECAD Architecture and is described in chapter 

8.5. 

The stat is valid for the whole object and is not for single terrain modifications. 
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Automatic update 

 

If this is switched on, any modifications made to the terrain are implemented 

immediately. Some actions, however, require manual recalculation. 

For performance reasons, this switch can be switched off. You can then only trigger a 

calculation via the GENERATE function. 

Terrain units 

 

The unit is used to show and enter height values. It is also used for labelling height 

lines and showing the volume difference. 

Import Terrain and import units 

 

This function loads a terrain from a file as a reference terrain using the defined units. 

Generation parameter 

 

Fix perimeter contour 

 

Once the reference terrain is saved and the option is activated, the height along the 

perimeter contour is no longer modified. 

Thickness 

 

The terrain is represented as a volume object and also has a surface on its underside. 

The height of the underside must be arbitrarily specified. The thickness indicates how 

far the underside should be away from the lowest point of the top surface. 
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2D-arc segmentation 

 

This affects the drawn contours of the street, excavation, etc. If needed, existing curves 

are replaced by one or more lines, depending on the setting. 

Resolution 

 

The calculated surface's precision can vary. Even the "low" selection requires a 

minimum amount of precision. 

XY-offset 

 

The XY shift of the reference point is entered and read in this field.  
 

EXPLANATION 
A terrain which is imported always appears centred in the middle of the 

page. So that the height points still show the original XY-coordinates 

when they are selected, the corresponding offset is automatically added.

  

Entry from  

Different options for entering the heights can be selected here. References to buildings 

and project settings are only valid for ELITECAD Architecture.  

 

The terrain's default Z height is always zero. The effect this zero point has on the 

structure is dependent on the structure settings. If, for example, the "sea level" or "per 

structure" height marking system is selected here, the first entered structure is always 

at the zero Z-height, so just as high as the terrain's zero point regardless of its height 

situation. If the "project null" height marking system is chosen, the project's null point 

is at the height entered here.  
 

If the terrain's entry height is modified after its creation, do not correct the terrain's 

height itself but the values of the height curves, height lines, excavation, label, etc. If 

you would like to move the terrain's height, you must use the MOVE POINTS AND 

CURVES IN Z DIRECTION function. 

Proprietary height 

This switch setting frees the Z-OFFSET field in which a particular value can be added. 

If, for example, you select 20 m as the offset and define the heights with 20 m, the 

points are at the zero Z height. 

Project null 

This option automatically sets the "Z-offset" to 0 and the height entries are entered 

from project null. If the heights are defined with a 0 value, the points are at the zero Z-

height. 
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Sea level 

If the SEA LEVEL option is selected, the height situation of the first entered structure 

is shown. Always indicate the heights in real sea levels. 

 

Offset 

 

The Z-offset is either entered or read in this field. 

Surface parameters 

 

Excavation hatch 

 

This is used for representing the slopes in an excavation plan. 

Z-offset 

Z0= project null point 

input from 
sea level 

input from 
project null point 

input from 
own height 
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The type of hatch can be selected from the "selection box" where all records saved 

under the hatching parameters are listed.  
 

TIP 
All line hatches are always automatically shown perpendicular to the 

excavation edges regardless of the angle with which they were saved. 

Cross hatches are also represented with only one line.   

Section hatch 

 

This is used while creating a section view in order to hatch a section of the terrain. The 

type of hatch can be selected from the "selection box" where all records saved under 

the hatching parameters are listed.  

Colour/material for surfaces and sides 

 

Colour mode/material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

Edge colour 

 

Height line parameters 
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Distance 

 

The entry determines the height distance with which the height lines will be drawn. 

Start height 

 

The height lines are displayed and labelled from this height. 

Height line text 

 

You can indicate here on which height line the text should be. The first pen from the 

Colour selections simultaneously affects the height lines. 

Angle 

 

The angle indicates an approximate guideline for the text position. 

Colour selections 

 

The first pen applies to the labelled height lines and the second pen for the height lines 

in between. 

The pen colours can be directly entered or selected via the colour table. (from 0-1023) 

Text parameters 

 

The type of text can be selected from the "selection box" where all records saved under 

the text parameters are listed. 

Decimal places 

 

Enter how many digits there will be after the decimal point. 

Depiction 

 

Enter whether the height lines will be generated in the floor plan or in their actual 

height. 

GENERATE 

 

The terrain is recalculated using the "Generate" button. All definition curves and 

definition points are used. In case a perimeter contour was defined, the terrain is 

restricted by this contour. 



Chapter 12 – Terrain  

www.elitecad.eu  898 

TERRAIN MODE 

Depict with structure 

 

Edits are generally carried out in this depiction mode. The terrain is displayed in the 

wire design model, pixel hidden line or solid design model, depending on the screen 

parameters. The excavation contours are integrated perpendicularly upwards and 

without side distance into the terrain. The final edited terrain then directly connects to 

the building. 

Depict with excavation 

 

The terrain is represented as a 3D excavation plan with all slopes in this depiction 

mode. The terrain is recalculated when toggling between depiction modes. 

Depict without excavation 

 

In this depiction mode, you can switch to the reference terrain. Should this not be 

present, the terrain is displayed without architectural measures. In this case, a warning 

message appears. 

COLOUR/MATERIAL MODE 

Colour mode/material mode 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 

ENTRY 

Entry mode 

You have two options available for generating a terrain edge/area, perimeter contour, 

excavation, landfill/dispersal, street or path: Either draw the contour directly, or you 

can define a polygon before accessing the function and select it.  

Contour entry 

 

You can draw a contour directly. 

Select contour 

 

You can select an existing polygon. 
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SWITCH ON HEIGHT LINES 

 

Height sections can be activated in the properties bar using this switch. Planar 

horizontal sections are calculated and the result is projected as 2D curves into the XY-

plane. The calculation follows according to the set parameters with distance and label. 

These curves serve as a result for the excavation plan and are not provided for 

modifying the terrain. 

SWITCH ON SLOPE 

 

Slope hatches can be activated in the properties bar using this switch. The outlines of 

the excavation contour's slopes are hatched according to the selected parameters. If the 

hatch in use is a line hatch, then the lines point in the direction of the steepest incline. 

REFERENCE TERRAIN AND VOLUME  

 

If no reference terrain exists, the excavation volume is determined as follows: 

The terrain surface is generated from definition curves and points. This state is adopted 

as its initial state. Excavation, landfill/dispersal, streets, etc. are integrated into the 

surface and result in a new edited surface. The difference between the initial state and 

the edited surface is displayed as volume in the properties bar. (A positive value 

means: material must be added; negative means: material must be removed) 

In practice, the terrain appears different on an undeveloped parcel of land as it should 

finally look. Height points are generally determined from the geometer and describe 

an original terrain. The volume difference should optionally refer to the original 

terrain. In order to reach this, you must first define the original terrain and then freeze 

this state using the "Save reference terrain" buttons. This frozen terrain is referred to 

as reference terrain. Points and curves can later be modified in such a way that the final 

surface is created. If the reference terrain has been created once, the calculation of the 

volume difference refers to the difference between the reference terrain and the 

finished, edited surface. 

The reference terrain can no longer be edited but can be replaced by recreating another. 

If the perimeter contour is modified, then the reference terrain should be reset since 

the difference would not give a meaningful value. 
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12.4 NEW DEFINITION POINT 

 

You can switch between the terrain and the point properties bars using the "New 

definition point" button. 

HEIGHT POINTS PROPERTIES BAR 

 

The properties bar becomes visible if you select the NEW DEFINITION POINT 

function to generate a height point or if you click an existing marker to edit it. 
 

 
New point 

 
Delete point 

 
Colour selection direct entry 

 
Colour selection over table 

 
X-coordinate 

 
Y-coordinate 

 
Z-coordinate 

 
To terrain property bar 

New point 

 

Click this button to define new height points.  
 

The following query appears after activating this function: 
 

Please enter point [Enter = End] 

The easiest would be to enter the height points into the top view. Here you can enter 

the desired Z-value in the properties bar and click on the floor plan position. The 

cursor's coordinates are shown in the point properties bar. 

The height point’s settings must be confirmed with [Enter]. If the AUTOMATIC 

UPDATE option is activated, the terrain is automatically recalculated. Otherwise you 

must trigger the GENERATE function. 

Delete point 
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Existing points can be deleted and moved. Clicking on the height point symbol shows 

the point properties bar. Handles (small squares) then appear on the symbols; the active 

point's handle is shown in another colour. 
 

Points which are no longer used must first be selected and then deleted either using the 

"Delete point" button or by hitting the [Delete] key. 

Colour selections 

The points are displayed via a symbol and their colour can be set here. 
 

TIP 
The point symbols are only visible in the 3D design model and have two 

different colours. One color is used for imported points and one color is 

used for manually added points.  

Colour selection – direct entry 

 

The pen colour can be entered directly. (from 0-1023) 

Colour selection over table 

 

The pen colour is selected here via the colour table. 

Coordinates 

 

Here the coordinates of the active height point are displayed. 

To terrain properties bar 

 

Once all of the points have been entered, you can go back to the terrain properties bar 

using the back button. 

Modify height points 

Existing points can be deleted and moved. Clicking on the height point symbol shows 

the point properties bar. Handles (small squares) then appear on the symbols; the active 

point's handle is shown in another colour. The active point's coordinates are shown in 

the properties bar. After a short wait, any change made to the values is applied and the 

point changes position. Alternatively, the point can be moved with the mouse. In the 

top view, only the X- or Y-values can be modified with the mouse. In a rotated view 

you can see the projection of a line on the work plane by moving the point. The shift 

takes place in a plane which lies perpendicular to the angle of view. 
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12.5 NEW HEIGHT LINE 

 

You can switch between the TERRAIN functions and the height line properties bars 

using the NEW HEIGHT LINE button. Height lines are created as NURBS curves. 

HEIGHT LINE PROPERTIES BAR 

 

The properties bar becomes visible if you select the NEW HEIGHT LINE function to 

generate a height line or if you click an existing height line to edit it. 
 

 
NURBS begin 

 
NURBS end 

 
NURBS close 

 
Line type 

 
Colour selection – direct entry 

 
Colour selection over table 

 
X-coordinate 

 
Y-coordinate 

 
Z-coordinate 

 
Delete point 

 
Delete line 

 
To terrain properties bar 

NURBS begin 

 

Click this button to define new height lines. This function must be restarted for every 

new height line. 
 

The following query appears after activating this function: 
 

Please enter 1st point [Enter = End] 

The easiest would be to enter the height curves into the top view. Here you can enter 

the desired Z-value in the properties bar and enter points onto the curve with the 

mouse. The cursor's coordinates are shown in the curve properties bar. The height 



Chapter 12 – Terrain  

www.elitecad.eu  903 

curve is calculated by entering these points and is displayed as a preview. The resulting 

curve is generated as a smooth NURBS curve. As a result, it is not possible to create 

corners. All of the points lie on a level, even if the curve is created in a rotated view. 
 

The height line’s settings can be confirmed with [Enter], "NURBS end", "NURBS 

close" or by double-clicking.  

If the AUTOMATIC UPDATE option is activated, the terrain is automatically 

recalculated. Otherwise you must trigger the GENERATE function. 
 

TIP 
A curve can be either open or closed. 

  

NURBS end 

 

This confirms an entry of an open curve. 

NURBS close 

 

This confirms an entry of a closed curve either by selecting the start point or by using 

the "NURBS close" button. The transition from the start to end point is also smoothly 

calculated. 
 

TIP 
Using either "NURBS end" or "NURBS close", the form can later be 

switched between open and closed by editing the height line. 

  

Line type  

 

The curves are represented by a line. The line type can be adjusted here. 

Colour selections 

The curves are represented by a line. The colour can be adjusted here. 
 

TIP 
The curves are only visible in the 3D design model and can have 

different colours.  

Colour selection – direct entry 

 

The pen colour can be entered directly. (from 0-1023) 
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Colour selection over table 

 

The pen colour is selected here via the colour table. 

Coordinates 

 

At this point, the coordinates of the active points of a height line are displayed. 

Delete point 

 

Clicking on a definition curve shows the curve properties bar. Handles (small squares) 

then appear by the originally entered points; the active point's handle is shown in 

another colour. 
 

A height line's points which are no longer in use must be selected and deleted 

individually from the curve using the "Delete point" button. 

Delete line 

 

This deletes the selected existing curve. 

To terrain properties bar 

 

Once all of the curves have been created, you can go back to the terrain properties bar 

using the back button. 

Modify height lines 

Clicking on a definition curve shows the curve properties bar. Handles (small squares) 

then appear by the originally entered points; the active point's handle is shown in 

another colour. The active point's coordinates are shown in the properties bar. After a 

short wait, any change made to the values is applied. The point changes position and 

the curve is recalculated. Alternatively, the point can be moved with the mouse and a 

preview of the new curve is shown. In the view, only the X- or Y-values of a point can 

be modified with the mouse. Modifying the Z-value in the entry field moves the entire 

curve. 
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12.6 NEW TERRAIN EDGE/AREA 

 

Edges and area can be integrated into the terrain using this function. Terrain edges are 

calculated before all of the other modifications (street, path, landfill/dispersal, 

excavation). 
 

The "New terrain edge/area" button prompts you either to draw a contour or to select 

an existing polygon, depending on which Entry mode is selected. This contour must 

meet the following requirements: 
 

 The polygon is an open or closed continuous contour. 

 The contours must not intersect each other. 

 The contour lies in a level parallel to the floor plan level. 
 

TIP 
A straight line can also be divided into multiple line pieces and provided 

with different height values.  
 

The following dialog window appears. 

 

Minimal width 

 

The minimal width defines a distance to a terrain edge or area within height points and 

curves are ignored except height points lying on the contour which are used to define 

the height of the edge/area. If the terrain edges/areas overlap with height curves or if 

there are any height points or curves within that distance, then the height values of the 

contour take precedence. The width is necessary to create a smooth transition between 

the terrain edge/area and the remaining terrain surface. The smaller the width, the 

steeper is the transition. 

If the value is deleted, the distance is set automatically. (Approx. 5% of the whole 

terrain extent). 
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The points, which no longer have any effect on the terrain because of this entry, are 

identified by a rhombic handle. 

 Height point on a terrain edge or area 

  Ignored height point 

 Standard height point 

Type 

For closed contours, one can define if just the contour or if the whole area should be 

taken into account. If the area type is selected, height curves and height points lying 

within the area are ignored. 

Entry mode 

Here the mode of height definition is defined.  

1. Height entry by value. 

2. Applying the height from the reference terrain, if defined.  

TIP 
This setting is used to fix the height along a contour. (I.e. a property 

boundary).  

3. Height definition by height points on the contour. 

The following rules are in force: 

 1 point  The whole contour lies on this height. 

 2 points  Gives the direction of the steepest descent. 

 3 points  Gives a plane. 

 Multiple points Results in a variable height gradient. The height is 

    interpolated between height points. 

TIP 
Height points can be used for multiple contours.  

Limitations: 

 Height points can only be entered onto the endpoints of a line. 

 Two height points must not lie next to each other. 

 The terrain edges must not intersect each other. 

 Avoid very small areas. 
 

 

EXPLANATION 
If terrain edges/areas are located exactly on top of each other, the 3D 

nodes are identical. After selecting the terrain area, you can insert 

additional points by clicking on a handle or gripper of the contour. 

Click on the terrain area and divide the element at the relevant points. 

Height points must be set on these 3D nodes. 
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Use terrain colour 

If the option is active, the same colour or same material is used as that in the terrain 

area. 

A colour or material for the terrain area can otherwise be selected. The range is 

"superimposed" onto the terrain. 

Colour mode/material mode 

 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
 

TIP 
It is only possible to enter a colour or material for a closed contour.  

  

points available points available 

element divided 
points available 

no points available 
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12.7 MOVE POINTS AND CURVES IN Z 

DIRECTION 

 

All definition curves and points are modified using this button. The height of the entire 

terrain is shifted. 

This is particularly necessary if the imported terrain data should be aligned to the 

drawing. 
 

The following query appears after activating this function: 
 

Distance? 

A positive or a negative value (in an active unit) can now be entered and confirmed 

with [Enter]. 
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12.8 PERIMETER CONTOUR 

 

If no perimeter contour has been defined, the terrain's outer border is based on the 

definition curves and definition points. It is not extrapolated outwards. 
 

The "Perimeter contour" button prompts you to either draw a contour or to select an 

existing polygon, depending on which Entry mode is selected.  
 

The perimeter contour generally marks the limits of the piece of land. Naturally, every 

polygon can be selected as a perimeter contour that meets the following requirements: 
 

 The contour is closed 

 The contour has no holes 

 the contour lies within the points and curves 

 The contour lies in a plane parallel to the floor XY-plane 
 

TIP 
If the function is performed for the second time, a new perimeter contour 

can only replace the previous one. The reference terrain is also deleted. 
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12.9 EXCAVATION 

 

The "Excavation" button prompts you either to draw a contour or to select an existing 

polygon, depending on which Entry mode is selected. This contour must meet the 

following requirements: 
 

 The contour is closed 

 The contour has no holes 

 The contour lies in a level parallel to the floor XY-level 

 The contour should contain no narrow recesses (due to slopes). 
 

The following dialog window appears. 

 

Height (B): 

Height of the excavation base. 

Inclination angle (C): 

Upward slope angle. 

Descent angle (A): 

Downward slope angle. 
 

EXPLANATION 
Slope angles are used in the generation of slope angle hatches in the 

excavation plan as well as in "Depict with excavation". In the depiction 

with structures, upward angle slopes are always perpendicular and 

downward angle slopes are slanted according to the angle (in case the 

slab contour protrudes from the terrain).  

Variable slope angle: 
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The slope angle can be individually specified for each line. Two interactive functions 

(for upward and downward) query the angle for every element. In order to identify the 

active element, a marker is set in the middle of the element. The values are only 

specified when the function has ended. Cancelling deletes it – the value from the 

parameter window then applies.  
 

EXPLANATION 
Variable angles can lead to undefined situations, especially concerning 

curves with tangentially attached lines.  

Height dimension (H): 

Ground clearance (e.g. for a foundation) 
 

Attention: 

This entry, together with the "Height (B)", is added and produces a new marker for the 

excavation base. 

Width dimension (O): 

Side distance (work plane) 

Gradient in %: 

 

Enter the inclination into the text field.  

2 points define the direction of the slope. 

Colour mode/material mode 

 

The colours or material can be entered separately for the sides and floor. 

  

These two buttons allow you to switch between colour mode and material mode. For 

more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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12.10 LANDFILL/DISPERSAL 

 

LANDFIL/DISPERSALis used to erect a planar platform such as a car park or a 

terrace. 
 

The LANDFILL/DISPERSAL function is defined similarly to EXCAVATION. There 

are two differences: There is no configurable side distance and the depiction of the 

slopes in a 3D design model is always slanted in all of the depiction modes. 
 

The following dialog window appears. 
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12.11 FREE EXCAVATION 

 

A free excavation is used to define fixed given surfaces embedded in the terrain or 

overhanging ranges such as a tunnel or an earth cellar. 
 

To define a free excavation, you must first create a 3D object that forms the desired 

cut-out. After selecting the function, select the 3D object, which is subtracted from the 

terrain. The colour of the surfaces is then adopted from the 3D object. 
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12.12 STREET 

 

The "Street" button prompts you either to draw a contour or to select an existing 

polygon, depending on which Entry mode is selected. The definition contour is used 

as a centre line. This contour must meet the following requirements: 
 

 The contour is open 

 The contour is uninterrupted 

 The contour lies in a level parallel to the floor XY-level 

 The contour should contain no curves/recesses which are too narrow (due to slopes) 
 

The following dialog window appears. 

 

Width (W): 

Width of the street 

Inclination angle (C): 

Upward slope angle. 

Descent angle (A): 

Downward slope angle. 

Colour mode/material mode 

 

The colours or material can be entered separately for the sides and floor. 

  

These two buttons allow you to switch between colour mode and material mode.  

For more details, see chapter 1.4 "Colours" and 1.7 "Materials". 
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TIP 
The street's height gradient is based on the line's endpoints and the 

contour's curves. The height value from the terrain to these points is 

determined and the heights in between are equally interpolated. If you 

want to specify the heights exactly then you should lay the desired street 

point on a terrain edge.  
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12.13 PATH 

 

The PATH function is defined similarly to STREET. The only difference being: The 

slope angle is not configurable because the path is always restricted to being 

perpendicular downwards. 
 

The following dialog window appears. 
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12.14 HEIGHT POINT 

 

The "Height point" button requires you to specify the positions for the height points. 

The height values are shown as text in these positions. Changes made in the terrain are 

automatically updated in the height markers when refreshed. 
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12.15 MODIFY TERRAIN 

Every single definition can be selected again at a later point and can be deleted or 

modified in their properties. 
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12.16 TERRAIN IMPORT 

The following formats are supported: 

 ASCII files with unsorted XYZ-coordinate points (*.txt). One point per row. 

 ASCII files with sorted XYZ-coordinate points on a rectangular grid.  

 ASCII files with XYZ-coordinate points that form triangles. 

 Import of terrain information from the INTERLIS format. Either *.ili or *.itf files 

can be selected here. Only the height points are transferred from this format. 

Additional 2D data from INTERLIS can be transferred via the DXF conversion. 

 Import files in Shape format. Files with *.shp extension can be selected here. 
 

There are different formatting styles when importing terrain data from ASCII files. A 

concise selection of relevant rows and columns can be freely configured on import.  

 

Three settings can be arbitrary chosen: 

 The columns for the X, Y and Z value 

 The separator for the values in between a row 

 The number of rows for the header or from which row the points begin 

 The units of the points to be imported 
 

After the selection has been made, you can start the import with OK. 
 

External data often contains height information in metres above sea level. This data is 

also always imported on its absolute height. If the structure settings have no defined 

height situation for the structure, the terrain is widely read over the building. In this 

case, simply correct the structure's and project null's height situation to the correct sea 

level. 

If the height information is not given in metres above sea level, the imported terrain's 

height must be adjusted if required. For this, always use the MOVE POINTS AND 

CURVES IN Z DIRECTION function. 
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13.1 OVERVIEW 

The drainage module is an optional extension to ELITECAD. With this module, you 

can create a piping network using special functions. Chambers, piping and load points 

are defined using the entry dialog window and automatically generated, along with 

shaped parts, in 2D and 3D. You can define the set drop and modify the pipe diameter 

using the respective functions. Chamber and piping labels are placed on the specified 

points at the touch of a button. 
 

TIP 
We recommend reading course unit "drainage". You can then see the 

functions in a practical example.  

OVERVIEW OF FUNCTIONS 

 
Load point 

 
Chamber 

 
Library part 

 
Piping 

 
Slope calculation 

 
Set height 

 
Dimension 

 
Set drop 

 
Raise/lower load points 

 
Three-line 

 
Label 

 
Parts list 

 
Display bottom of pipe 
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13.2 CREATE PIPING NETWORK 

SET LOAD POINT 

 

Drainage properties bar 

 

The load points must be set at the upper end of the drainage network.  

Horizontally e.g. for the chamber outlet, vertically e.g. for the connections to the 

building drainages fall pipes. The load points must always be set in the same storey. 

LOAD POINT PROPERTIES BAR 

The properties bar becomes visible if you select the LOAD POINT function to 

generate a load point or if you double-click on a load point to modify it. 

 

 
Dimension 

 
Height 

 
Height reference 

 
Select toolbar 

 
Connection type 

Dimension 

 

The load point's dimension can be either selected or entered here. 

Height 

 

The floor height can be entered here. The unit is dependent on the set height reference. 

If the load points have been increased or decreased, the height of the connection points 

is entered. The floor height can be read in the grey field. 

 

Height reference 
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There are three different types of height reference. 

Sea level 

 

The entry is in metres above sea level. 

±0.00 

 

The entry is in metres above the project null point. 

Storey 

 

The entry is from the active storey and in the active unit. 

Separate load points 

 

Separate load points can be inserted with the SELECT DIRECTORY function. 

The functionality is only guaranteed if the necessary attributes are present. 

Creating separate load points 

An existing load point must be read and modified as a drawing. 
 

From the standard directory "ELITECAD installation directory" 

\u\<version>\ar\bs\sa\l you can load the load points as a template. It is important that 

the model is activated under ACTIVATE MODEL before modification. The load point 

can then be saved under the same in its own library directory. 

Connection type 

 

There are three different types of connection type. 

Up 

 

This can, for example, be used to connect a drain pipe to a fall pipe. 

Horizontal 

 

This can be used for a chamber output, for example. 

Downward 

 

This can be used for a mud drum dip pipe, for example. 
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CREATE CHAMBER 

 

Drainage properties bar 

 

You can use this function to create chambers in 3D. 

CHAMBER PROPERTIES BAR 

The properties bar becomes visible if you select the CHAMBER function to generate 

a chamber or if you double click on a chamber to modify it. 

You can manipulate the main values in the properties bar. However, fine-tuning can 

be done under the chamber parameters. 

 

 
Chamber parameters 

 Type 

 
Geometry 

 
Diameter 

 
Chamber height 

 
Top side 

 
Height reference 

 
Cone type 

 
Cone diameter 

 
Cone height 

 
Place 

CHAMBER PARAMETERS 

 

The set-up dialog window for the chamber is opened with the CHAMBER 

PARAMETER function. The settings of this dialog window are maintained. If the 

dialog window is closed and reopened, the status most recently set is still in place. If 

you would like to keep the set parameters for later use, assign it a name in the "Type" 

field and save it using the function RECORD > SAVE. 
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Type 

The name of the selected parameter record can be found in the "Type" selection box. 

It can be defined freely and refers to the chamber type. By selecting various types, you 

can see how the values in all of the other entry fields are automatically modified. This 

way, once you have saved a chamber type as a custom defined type, you can call it up 

repeatedly. 

To generate a chamber type, simply enter the new name in the text box and modify all 

the values on the dialog window as desired. Next, you can insert the new type into the 

selection list via the menu item RECORD > SAVE. To delete a type that is no longer 

needed, use the menu item RECORD > DELETE. 

Layer 

You can assign a layer to the chamber in the "Layer" field. 

Parameters 

Material 

 

The chamber material can be selected here. 

2D depiction 

 

Here you can select the pen for the 2D depiction. 

Line type 

 

Here you can select the desired line type. 
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3D depiction 

 

Here you can select the pen for the 3D depiction. 

Sizes/Dimensions 

 

Shape 

  

Users can select between circular and elliptical: 

Diameter 

 

Here you can select the desired diameter. 

Chamber height 

 

The chamber height can be defined here. 

Chamber upper edge 

 

The chamber height can be entered here. The unit is dependent on the set height 

reference. 

Height reference 

 

There are three different types of height reference. 

Sea level 

 

The entry is in metres above sea level. 

±0.00 

 

The entry is in metres above the project null point. 

Storey 
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The entry is from the active storey and in the active unit. 

Wall thickness 

 

The wall thickness can be defined here. 

Floor gauge 

 

The floor gauge can be defined here. 

Cone 

 

Shape 

    

You can select between none, central or eccentric cone. 

Cone diameter 

 

Here you can select the cone diameter. 

Cone height 

 

Here you can select the cone height. 

Lid 

 

Lid diameter 

 

The lid diameter can be defined here. 

Lid height 

 

The lid height can be defined here. 

Place 

 

The drawing can be manipulated accordingly via the properties bar before being 

placed. 
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Properties bar for place 

 

For more details, see chapter 1.8 Open and save > Properties bar for 

loading/positioning. 

SET LIBRARY PARTS 

 

Drainage properties bar 

 

This function is used for relative loading and placing of library parts. The library parts 

are aligned to the respective scale when being placed. 
 

For more details, see chapter 1.8 Open and save > Insert library. 
 

TIP 
ELITECAD's library has two subdirectories with complimentary 

drainage parts for 2D and 3D.  

The directory structure is independent of the normal insertions of the 

library parts.   

CREATE PIPING 

 

Drainage properties bar 

 

You can use this function to create piping in 3D. If it is necessary to modify the route 

of the parts, these can be deleted and redrawn. 

PIPING PROPERTIES BAR 

The properties bar becomes visible if you select the PIPING function to generate 

piping or if you double-click on the piping to modify it. 

You can manipulate the main values in the properties bar. However, fine-tuning can 

be done under the piping parameters. 

 

 
Piping parameters 

 Type 

 
Diameter 

 
Actual incline (only visible when editing) 

 
Height 1 (only visible when editing) 

 
Height 2 (only visible when editing) 

 
Height reference (only visible when editing) 
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Polygon functions 

 
Polygon functions 

 
Polygon functions 

 Piping properties bar (material) 

 
Piping properties bar (depiction) 

PIPING PARAMETERS 

 

The set-up dialog window for the piping is opened with the PIPING PARAMETER 

function. The settings of this dialog window are maintained. If the dialog window is 

closed and reopened, the status most recently set is still in place. If you would like to 

keep the set parameter for later use, assign it a name in the "Type" field and save it 

using the function RECORD > SAVE. 

 

Type 

The name of the selected parameter record can be found in the "Type" selection box. 

It can be defined freely and refers to the type of piping. By selecting various types, 

you can see how the values in all of the other entry fields are automatically modified. 

This way, once you have saved a type of piping as a custom-defined type, you can call 

it up repeatedly. 

To generate a type of piping, simply enter the new name in the text box and modify all 

the values in the dialog window as desired. Next, you can insert the new type into the 

selection list via the menu item RECORD > SAVE. To delete a type that is no longer 

needed, use the menu item RECORD > DELETE. 
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Layer 

You can assign a layer to the piping in the "Layer" field. 

Parameters 

Material 

 

The piping material can be selected here. 

Perimeter line 

  

Here you can select the pen and line type for the 2D depiction of the perimeter line. 

Centre line 

  

Here you can select the pen and line type for the 2D depiction of the centre line. 

3D depiction 

 

Here you can select the pen for the 3D depiction. 

Hatch 

 

Here you can select the hatch colour for the 2D depiction. 

Dimension/incline 

 

Diameter 

 

Here you can select the desired diameter. 

Actual incline 

 

The piping unit's current incline is shown here. 

Height 1 

 

The piping unit's current lowest point is shown here. 
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Height 2 

 

The piping unit's current highest point is shown here. 

Height reference 

 

There are three different types of height reference. 

Sea level 

 

The height indication is given in metres above sea level. 

±0.00 

 

The height indication is given in metres above the project null point. 

Storey 

 

The height indication is from the active storey and in the active unit. 

Polygon functions 

Start piping 

 

This function can be used to start a new piping unit. 

End piping 

 

This function can be used to end a piping unit. 
 

TIP 
You can also end a piping unit by double-clicking or by pressing the 

[Esc] key.  

Piping back 

 

This function can be used to reset the most recent part without interrupting the 

function. You can then continue the piping from this point. 
 

TIP 
Parts of a piping network can be deleted by selecting them and pressing 

[Delete]. Multiple selection is possible with [Shift].   
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EXPLANATION 
If a part of the piping network is shown after the slope calculation, the 

slope calculation needs to be performed again.  
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13.3 GENERATE PIPING NETWORK 

START SLOPE CALCULATION 

 

Drainage properties bar 

 

This function can be used to create a 3D line in the piping network (one-line 3D) 

The piping network can be edited (e.g. height modifications) 
 

The load points must be set and the piping must be created before you can carry out 

the slope calculation.  
 

After you call up the function, click the lower end of the piping network. The intended 

slope is then requested. The intended slope is once again removed by entering "x". 
 

EXPLANATION 
An intended slope in a piping network is not undercut. Modifying the 

heights of the parts also does not undercut the intended slope. In this 

case, you are able to set a drop.   
 

EXPLANATION 
If after the slope calculation, a load point is changed with the SET 

HEIGHT function, the height of the entire piping network is 

automatically changed so that the intended slope is not undercut 

anywhere.   
 

EXPLANATION 
If a single point in a piping network is modified using the SET HEIGHT 

function, which causes the intended slope in the piping to be undercut, 

an error message (a large X) appears.   
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13.4 EDIT PIPING NETWORK 

SET HEIGHT 

 

Drainage properties bar 

 

This function can be used to bring the piping network to a final height gradient. The 

height of a piping network's load points, raised load points as well as branching and 

end points can also be fixed or modified. To set the heights, you must first generate 

the piping network. 

If the heights of points within a piping network are modified, these same changes are 

applied to the lower piping parts on the intended slope. A drop can then be defined in 

the resulting piping section. 

SET HEIGHT PROPERTIES BAR 

The properties bar appears when you select the SET HEIGHT function. 

 

 
Height reference  

Height reference 

 

There are three different types of height reference. 

Sea level 

 

The height indication is given in metres above sea level. 

±0.00 

 

The height indication is given in metres above the project null point. 

Storey 

 

The height indication is from the active storey and in the active unit. 
 

TIP 
If the RAISE/LOWER LOAD POINTS function is performed, the 

height of the upper or lower point can be modified. The desired point in 

the wire design model is then easy to select.  
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TIP 
If modifying the height undercuts the intended slope in the piping, an 

error message in the form of a large X appears. 

This message can be requested with the model information 

(measurement functions). These are then output in the info window. 

  

DIMENSIONS 

 

Drainage properties bar 

 

This function can be used to modify the cross-section of multiple pipings 

simultaneously. The load points must be set before you can set a dimension. 

DIMENSIONS PROPERTIES BAR 

The properties bar appears when you select the DIMENSIONS function. 

 

 
Dimension 

Dimension 

 

The load point's dimension can be either selected or entered here. 
 

After you call up the function, the new cross-section in the properties bar is set and 

you can click the desired pipings. The function is confirmed with [Enter]. 

SET DROP 

 

Drainage properties bar 

 

This function can be used to set a drop in the piping sections. To set a drop, you must 

first generate the piping network and set the effective incline to be greater than the 

intended slope. To do this, you must shift the height of a particular 3D node. 
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Likewise, the maximal possible height difference must be great enough for the 

necessary curves to be generated. 
 

After you call up the function, you must click the desired piping section. The prompt 

"Set slope at what point or <ENTER> for automatic?" then appears. The point for the 

drop can then be specified or the query confirmed with [Enter]. In this case, the drop 

at the lowest possible point is set.  

If the requirements for a drop are met, the maximal possible height difference is shown 

in the entry line. This can be adopted or overwritten by a lower difference. The angle 

for the offset is subsequently requested. 

If the default is not used and the angle does not come to 90°, the query "Shift in which 

direction?" appears. If you click on the upper end of the piping, the previously selected 

point for the "offset" is the lower start of the drop. The lower end shown is then the 

upper point of the drop. 

RAISE/LOWER LOAD POINTS 

 

Drainage properties bar 

 

The function is used to add 3D lines upwards or downwards to vertical load points. 

The floor height remains unchanged. To raise/lower load points, the vertical load 

points must be present and the slope calculation must be carried out. 
 

After you call up the function, you must click the desired piping network. 
 

TIP 
Both the floor height and the raised/lowered point can be further 

modified with the SET HEIGHT function. 
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13.5 LAY-OUT PIPING NETWORK 

THREE-LINE 

 

Drainage properties bar 

 

The function is used to generate the pipes and shaped parts according to the preceding 

settings. The pipes and shaped parts are generated in 3D and 2D. A generated and 

edited piping network (one-line 3D) is required for the three-line. The 3D line (one-

line) then remains. 
 

EXPLANATION 
A piping network's pipes and shaped parts always create a specific 

object. These can be deleted and regenerated at any time.   

To generate: 

 An elbow pipe: this is generated for every change in direction. 

 A double elbow pipe (2 x 45°): this is generated by a drawn right-angled piping 

shape. 

 A tee and a 45° elbow pipe: these are generated by tee piping connected at right 

angles. 

 A reduction: this is generated between piping with different dimensions. 

 An elbow pipe and a pipe: these are generated by raised/lowered load points. 
 

EXPLANATION 
To modify a piping network, the pipes and shaped parts must first be 

deleted (they form an object). The 3D line (one-line) is then maintained.  

Once modified, the slope calculation must be refreshed before the three-

line can be regenerated.   
 

TIP 
A piping network or part of it can also be stretched. The shaped parts 

must also first be deleted. Once stretched, the slope calculation must be 

refreshed before the three-line can be regenerated.   



Chapter 13 – Drainage  

www.elitecad.eu  938 

13.6 LABEL 

 

Drainage properties bar 

 

These three functions are used to automatically label the piping, floors and chambers.  
 

The text parameters for the labelling of the piping and bottoms of pipes are stored in 

the text editor under the "piping" record. Chambers are stored in the "chamber" record. 

If these records are no longer available, the active text parameters are used. 
 

TIP 
The text in each case belongs to the object that was clicked. If a piping 

or chamber is deleted, the accompanying text automatically disappears. 

If you want to delete just the text, you must do this using the Selection 

mode element part ([Alt] key pressed). Multiple selection is possible 

with [Shift]. 

If you press the [Alt] key and double-click on the text, the text 

parameters appear and can be modified.  

Label piping 

 

To label the pipings, you must first generate the piping network. The material is 

labelled in Ø mm, the incline in % and with an arrow indicating the direction. 
 

After you call up the function, you can click the desired piping network using the 

mouse.  
 

TIP 
The function is retained and is available until it is cancelled with [Esc]. 

  
 

TIP 
If piping is labelled and the incline modified, the text is automatically 

adjusted.  

Label bottom of pipe 

 

To label the bottom of a pipe, you must first generate the piping network. The labelling 

is dependent on the height reference, which can be defined in the properties bar. 
 

Calling up the function requests you to specify the point to which the floor height 

should be measured. The text can then be placed. 

Height reference 

 

There are three different types of height reference. 
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Sea level 

 

The labelling is given in metres above sea level. 

±0.00 

 

The labelling is given in metres above the project null point. 

Storey 

 

The labelling is from the active storey and in the active unit. 
 

TIP 
The function is retained and is available until it is cancelled with [Esc]. 

  
 

EXPLANATION 
The floor height's text is not automatically adjusted if any changes are 

made.  

Label chamber 

To label the bottom of a pipe, you must first generate the piping network and set the 

chambers. The labelling is dependent on the height reference, which can be defined in 

the properties bar after selecting the chamber. 
 

Calling up the function requests you to specify which chamber should be measured. 

You can then click the inlets and place the text. If you press the [Esc] key, you are 

asked for the outlet point. After placing the text, the entire chamber text can be set. 
 

EXPLANATION 
 The text is then placed. 

  

Height reference 

 

There are three different types of height reference. 

Sea level 

 

The labelling is given in metres above sea level. 

±0.00 

 

The labelling is given in metres above the project null point. 
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Storey 

 

The labelling is from the active storey and in the active unit. 
 

EXPLANATION 
The chamber label's text is not automatically adjusted if any 

modifications are made.  
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13.7 REPORT 

PARTS LIST 

 

 

Extras menu > Quantities > Report 

A requirement for the parts list is that you have to layout the piping network.  
 

The parts list function generates a list of all the drainage parts built in the image using 

the following values: 

 

- Pipes 

 Material, nominal width, length, total length, number 
 

- Curves 

 Material, nominal width, angle, number 
 

- Tee 

 Material, nominal width, angle, number 
 

- Reductions 

 Material, nominal width, number 
 

- Chambers 

 Material, chamber: nominal width + height, cone: nominal width + height 
 

- Elements (floor drainage, channels, roof water chambers, etc.) 

 Name, description, material, length, width, height, number 
 

The parts list is written in the san_bom.txt file in the project directory and immediately 

opened in Windows Editor.  

The file can of course be adapted to other uses, saved under different names and be 

printed. 
 

The curves and tees may have unusual degree information. These values are exactly 

calculated and rounded to a degree.  

The slope calculation of multiple load points is very complex.  

It is almost impossible for 15° steps and 45° tees to result in anything. 

Such differences in the connecting sleeves are offset on the construction site. 
 

TIP 
The function REPORT > REPORT MANAGER generates a formatted 

parts list (following report in DB after its execution).   
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If an individual element is clicked on, its values appear in the properties field of the 

Report Manager. 
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13.8 SHOW INFO 

DISPLAY BOTTOM OF PIPE 

 

Drainage properties bar 

 

The function is used to output height information in the info window. 
 

To label the pipings, you must first generate the piping network. 

 

EXPLANATION 
If it is not possible to generate a piping network, e.g. because of a 

negative intended slope or because of incorrect height modifications 

etc., an error message in the form of a large X appears. These crosses 

show the source of the error and can be requested with the MODEL 

INFORMATION function in the measurement dialog window. The 

message is output in the info window. 

 

You must correct or redraw at these points. 

The crosses can be removed again through selection and deletion. 
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14.1 FUNCTIONALITY 

A model must be available in order to calculate the quantities. Using the function 

CALCULATE QUANTITIES the masses of the model are written storey and structure 

related to the database. Quantities of the complete model is always calculated, including 

the currently hidden objects. 

The quantified masses are represented in the Quantities Manager. 

Objects can be selected in the graphics window or in the quantities manager. The values of 

the current object are displayed. In order to enhance the visibility of the objects inside the 

model, the model is switched to Transparency mode when the quantities manager is shown. 

 

From the quantities manager the settings can be accessed and various types of Excel reports 

can be displayed. The Quantities manager provides a dialog for project management and 

maintaining master data. 

 

Sample model and course unit for calculating 

quantities  

Recommendation 

In order to obtain a better understanding of the Quantities and master data and prior to 

making adjustments to the settings, it is recommended to load and calculate the quantities 

of the sample model from the project CAD_Object_Quantities. 

The quantities calculation using this model is described in detail in the course unit 

Quantities.  

Model in 
transparency mode 

List of objects 

Value of the 
current object 
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14.2 FUNCTIONS 

Area verification 

  

 

Menu Extras > Quantities > Space verification 

The function AREA VERIFICATION divides the room areas into calculable parts 

(rectangles, triangles and circular segments). These are depicted in the floor plan and 

numbered in order to guarantee optimal traceability. 

You can choose the storeys in which the area verification shall be generated. 

 

The data are generated and added to the layer "Area verification". The room areas are 

divided into calculable parts and numbered. The pen and text formatting settings can be 

defined under SETTINGS > OPTIONS > WORK PARAMETERS > AREA 

VERIFICATION.  

These are documented by the subsequent CALCULATE QUANTITIES. 

The function AREA VERIFICATION is solely required if the area parts have to be 

documented in a plan.  

The function CALCULATE QUANTITIES also calculates the area parts without any 

previously generated area verification. 
 

Example of area verification 
 

Situation: 

  
Plan view GF Area verification 

 

Excerpt from the report "Area verification – base sizes" 
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Excerpt from the report "Floor area and cubic contents" 

 

Living space verification 

  

 

Menu Extras > Quantities > Living space verification 

The function LIVING SPACE VERIFICATION works identically to the AREA 

VERIFICATION, except that the calculation is based on the clear room area and comprises 

the limiting heights. The thicknesses of the wall upper layer from the room dialog window 

are taken into consideration. 

In Germany, the verification is generated in accordance with the Living Space Regulations 

(window recesses down to the ground and deeper than 13 cm are included). 
 

Germany as an example: 

   

Example under the roof: Visual representation of the various limiting heights 
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Report "Living space verification" 

 

The limiting heights and the values of the individual areas can be displayed and controlled 

directly within the model. 

 

Documentation plan 

If the quantities shall be documented in the plan, the field "Display docu-text" needs to be 

activated in SETTINGS > OPTIONS > WORK PARAMETERS > QUANTITIES and a 

WF1.1 

WF2.1 

WF3.1 

Room2 
13.82m² 
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parameter (text) needs to be set. The Docu-text is a numbering of the object types and 

object subtypes. 

 

The docu-texts are assigned to the layer "Docutext". 

The field "every storey" determines whether the numbering of the documentation shall 

restart at every new storey or whether it shall be unique for the entire project. 

The pretext for the docu-text can be defined in the column "Text" of the chart. 

 

The 2D depiction can be individually configured for each type. This has no impact to the 

quantities and reports. 

Project management 

 
 

Menu Extras > Quantities > Project management 

Any quantified projects as well as their models are listed in the project management. Data 

of these models, which already exist in the database, are replaced during every new 

quantities calculation.  

 

The display of quantified design models and projects is filtered according to the standard, 

which was used for quantification. When the project management is opened, the standard, 

which was selected in the project settings, is set. Changing the filter has no effect to the 

standard of the project settings. If the standard is changed in the project settings requires 

the quantification to be performed again. Old data remains during this process. 
 

The function DELETE is used to purge unused projects and design models. 
 

The function RESET DATABASE deletes all quantified data, inclusive project and design 

models that have been quantified according to standards different to the standard that is 

currently used for filtering. 
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14.3 QUANTITIES MANAGER 

 

Toolbar *Construction Parts 

Menu Extras > Quantities > Quantities manager 

 Toolbar Quantities > Quantities manager 

If the window of the quantities manager is shown, the representation of the model switches 

to the Transparency mode. If a storey or structure is selected in the quantities manager, the 

representation switches to the solid mode.  

 

Header functions 

 

 

Listing 

 

 

 

 

 

 

Active object 

 

 

 

 

 

Values and attributes / Formulas 

 

 

 

 

 

 

 

 

 

 

 
Representation 

 
Filter for renovation planning 

 
Calculate quantities 

 
Zoom to selected objects 

 
Create and print reports 

 
Settings / Rules 

 
Project management 

 
Room volume depiction 

 
Define transparency  
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Navigation within the quantities manager 

Show a structure / storey 

  

Showing by selecting the structure or storey in the quantities manager 

Visualize a group of object types / an object type 

  

Visualization by selecting the group of object types or the object type in the quantities 

manager. The calculation results are displayed with the object type. 

Select an object in the CAD  

 

If an object is selected in the CAD, the object types belonging to it are marked in the 

quantities manager.  

An individual object type is subsequently selected in the quantities manager and the 

calculation results are displayed. 
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Display calculation results 

 

The object type is selected in the quantities manager. 

The same is visualized in the CAD together with the location, the measuring type (here at 

the facade surface) and, as far as possible, which openings will be ignored (here a small 

window to the left of the door)  

The results are displayed in the tab "Values and attributes". 

 

The detailed calculation including any deductions is represented in the tab Formulas. 

Navigation inside of rooms  

In the case of rooms, it usually makes sense to select the room in the CAD beforehand. 

 

The object types belonging to them are marked in the quantities manager.  

The desired object type is subsequently selected in the quantities manager. 
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Representation  

 

The object types can be listed using various kinds of structures.  

Choosing hierarchy: 

The object types are subordinate to the rooms, walls and ceilings which are, in turn, 

classified per storey. 

 

 

The object type "Floor layer" is assigned to the flooring of the corresponding room and 

storey. 

Choosing structure: 

The object types are subordinate to the storeys. 

 

 

For each storey the object type "Floor layer", in which any floor layers of this storey are 

listed, exists. 

Choosing object types: 

The objects types are not subordinate to the storeys. 
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All floor layers of the entire project are listed under the object type "Floor layer". 

Filter for renovation planning 

 

The renovation planning state is noted for each object. The filter only displays data in the 

quantities manager that correspond to the selected state. 

Zoom to selected objects 

 

In some cases, it is difficult to locate objects being selected in the quantification manager 

in the drawing because they are too small or outside the field of view. The function ZOOM 

TO OBJECT displays the selected objects as large as possible in full screen size. 

Calculate quantities 

 

Toolbar AR-Lay-out > Calculate quantities 

Menu Extras > Quantities > Calculate quantities 

 Quantities manager > Calculate quantities 

The masses of the currently loaded model are calculated and written to the database. Any 

hidden parts also have been quantified.  

Project and model 

The project name as well as the model name (drawing name) are saved. This enables to 

save several variations of a project under varying model names (Project management). 

Quantified AR objects 

Areas and volumes of rooms and constructions 

According to DIN 277, ÖNORM B 1800 and SIA 416 

Living spaces 

Quantified living spaces (e.g. German Living Space Regulations) 

Area verification 

Room areas divided into parts  
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Floor 

Solid ceilings, wooden joist ceilings, balconies, roofs, platform half-space landing, room 

ceilings, and foundations 

Volume and floor areas 

Roof 

Individual layers 

Area in real projection 

Roof edges (roof ridge, roof valleys, roof cut-outs etc.) in the measure of length. 

Truss 

Carcassing timber 

Walls 

Interior / exterior walls, System-built walls, water-proof concrete walls, brick walls, dry-

wall construction, changing-room partitions, exterior insulations, ventilated wall linings, 

massive wooden wallboards, wooden single plank walls. 

Columns 

Without consoles and notched columns 

Girders / binding beam 

Chimney 

Free objects 

Windows, roof windows and glass elements 

Window sills and cornices 

Doors 

Openings 

Wall openings, floor openings, ceiling openings and roof openings 

Stairs 

Banisters 

Room 

Room area depending on the type of usage and enclosing 

Calculation of living spaces with 2 limit values, usable area beyond the limiting height 

Room value depending on the enclosing 

Floor finish planes 

Wall coverings 

Exterior wall areas 

Ceiling coverings 

Room list 

Compilation depending on the room 

Furnishings 

From the library. 

Room volume depiction 
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This representation visualizes the assembled rooms as boxes. 

If an individual room is shown, the same is solely displayed in this room volume depiction. 

Deduction planes may also be defined in this representation (see chapter 10.6 Room) 

Define transparency  

 

Adjustment of the transparency for the model depiction if object type representation is 

chosen as structure. 

 

The quality of the transparency is selected in the entry line using 0 or 1. 

1 = rapid transparency 

The imaging is faster, the resolution of the transparency is coarser. 

0 = fine transparency 

The imaging takes longer; the resolution of the transparency is finer. 
 

The transparency is subsequently adjusted. 

0:  The model is not displayed transparently 

255: Highest transparency value. 

Note 

The transparency mode is only possible in the active quantities manager. 
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14.4 OBJECT TYPES 

All object types, including those, which are only evaluated in BIM2COST, are described 

in the following list. 

A single-layer CAD building part can be quantified into several object types, consisting of 

an object type and object subtypes. These are listed in the quantities manager equally (and 

not hierarchically). 

Docu-text 

 

The architectural objects are quantified and written storey and structure related to the 

MySQL-database. 

Every quantified object obtains a documentation text (e.g. WA3), which is composed a 

pretext for the CAD object type (e.g. WA) and a consecutive documentation number (e.g. 

3). 

In the case of room surfaces on walls, the documentation number is indicated as decimal if 

various groundings exist. The room number is positioned in front of the decimal point and 

the number for the various groundings behind the decimal point. 

In the quantities manager, the documentation text is indicated behind the object type. 

OBJECT TYPES AND OBJECT SUBTYPES 

The division into object types and object subtypes is described in detail in the following 

sections CAD-floors, inner plate and outer plate. The same method of apportionment 

applies to all CAD objects.  

An object type is constantly quantified in the case of a CAD object, which could be divided 

into various layers. If a CAD object could be composed of several layers (e.g. due to the 

import of an IFC model for which a roof being composed of several layers was defined in 

an external CAD or by the division into various layers in BIM2COST), object subtypes 

"Layer" are quantified.  

In addition, object subtypes, which have the feature of a construction or covering, are 

quantified. A covering can be composed of several layers. 
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CAD-FLOORS 

 

Independent foundations, strip foundations and 

foundation plates 

Object type: Foundation 

Differentiation in the window "Values and attributes" by the attribute Form. 

Inner plate and outer plate 

Object type: Ceiling 

The object type ceiling contains the following object subtypes: 

Object subtype: Bottom layer 

The ceiling normally contains only one bottom layer. 

However, several bottom layers can be created due to the import of IFC models if CAD 

floors have been defined as such in an external CAD.  

Object subtype: Floor construction 

The floor construction is equal with the feature supporting structure. 

In BIM2COST, this object type is used for the determination of costs.  

Object subtype: Floor covering 

Only in BIM2COST. If a layer of the layer type E (covering) is defined in BIM2COST 

using the Layer Editor, the feature floor covering is attributed. All object types with the 

designation covering can be composed of several layers. 

(If works are carried out in BIM2COST using the Layer Editor, only the features but not 

the representation in the CAD are changed). 

Roof 

Note 

This option of CAD floors is especially intended for users who work with the Swiss cost 

estimation method eBKP-H and with BIM2COST. 

According to eBKP-H, ceilings, which are below the exterior rooms or the outer shell of 

the building, have to be defined as roofs.  
 

In the particular list concrete ceilings, CAD-floors, which were designated as roofs, were 

indicated under roof cladding or concrete ceilings under roofs (Switzerland). 

Recommendation 

Designate CAD-floors in ELITECAD as exterior slab to enable that the term will be 

indicated in the list concrete ceiling. 

In BIM2COST, this definition can subsequently be changed to roof. 
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Object type: Roof 

The object type roof contains the following object subtypes 

Object subtype: Roof layer 

One roof can be composed of several layers 

Object subtype: Roof construction 

Feature: Supporting structure. 

Object subtype: Roof cladding 

Only possible in BIM2COST using the Layer Editor or in the case of IFC models. 

The roof cladding can be composed of several layers. 

Material 

A CAD-floor made of the material concrete (or a synonym) is assigned to the discipline 

(craftsmen's differentiation) concrete ceilings and included in the list of the same name. 

WALLS 

Note on BIM2COST 

Users who work with BIM2COST have to set the feature exterior or interior 

Load-bearing/non-load-bearing 

The adjustment at the walls has an influence on the object subtypes. 

Object type: Wall 

The object type wall contains the following object subtypes: 

Object subtype: Wall layer 

One wall can be composed of several layers 

Object subtype: Wall construction 

Feature description: 

Single-layer walls are always quantified as wall construction, irrespective of whether these 

were defined as load-bearing or non-load-bearing (exceptional case in ELITECAD). 

In the case of multi-layer walls, the load-bearing layer is quantified as wall construction. 

Object subtype: Wall (covering) 

The object type wall (covering) is evaluated in the case of wall coverings and single-plank 

walls.  

Feature description for non-load-bearing layers: Any non-load-bearing layers are evaluated 

as wall coverings and can be composed of several layers. 
 

Wall coverings are measured at the wall axis.  
 

Multi-layer exterior walls have to be designed in a way that the wall axis is located on the 

outside. Any layers of the covering (e.g. exterior insulation, thermal insulation composite 

systems) are measured on the outside and are, depending on the names of the materials, 

indicated in the list exterior insulation. 
 

In the case of system walls, e.g. single plank walls with plaster boards, all layers have to 

be defined as non-load-bearing. If a wall solely consists of non-load-bearing layers, the 

same is equally quantified as object type wall (covering) and, depending on the names of 

the materials, listed under plaster boards.  

All layers are afterwards indicated in their entirety in the list Dry Walls (in the same way 

as the system walls are measured and billed). 
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Material 

The material names of the layers control the attribution to the discipline (craftsmen's 

differentiation). 

CAD-ROOF 

Object type: Roof 

The object type roof contains the following object subtypes 

Object subtype: Roof layer 

Normally: 1 roof layer. Several roof layers are possible in BIM2COST  

Object subtype: Roof construction 

Feature: Bearing construction. 

Object subtype: Roof cladding 

Only possible in BIM2COST using the Layer Editor or in the case of IFC models. 

The roof cladding can be composed of several layers. 

Object subtype of the truss 

Special case: All object types of the truss are also object subtypes of the roof 

Material 

CAD-roofs made of the material concrete are indicated in the list concrete ceilings at roof 

cladding or in the list concrete roofs at foundations and ceilings. The remaining materials 

are included in the list Roof surface areas and edges at roofs. 

TRUSS 

Object type: Truss 

The object type truss summarizes those carcassing timbers, which were designed in the 

same working process. 

Example for the designation documentation text: truss, DK117 

Object subtype: Construction timber 

For construction timber, the object type truss is divided into construction timbers of the 

same type. The rafters, which adjoin valleys and arris, do not have the same length. The 

timbers of the same length are summarized. 

The documentation text indicates the type of construction timber. Example for rafters: 

construction timber, SP117.4 (rafter of the truss DK117, section 4) 

STAIRS 

Object type: Stair 

Object subtype: Stair section 

Divided into landings and stair flights 

Material 

In BIM2COST, the attribution to the cost element is controlled via the stair material. 
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BANISTERS 

Object type: Banister 

BINDING BEAM 

Object type: Binding beam 

COLUMNS 

Object type: Column 

In BIM2COST, the attribution to the cost element is controlled using the designation 

interior/exterior. 

WINDOW 

Object type: Window 

The feature interior/exterior is taken over by the wall and enables to control the attribution 

to the cost element in BIM2COST. 

Material 

In BIM2COST, the attribution to the cost element is controlled using the window frame 

material.  

GLASS ELEMENT 

Object type: Glass-element 

DOORS 

Object type: Door 

The feature interior/exterior is taken over by the wall and enables to control the attribution 

to the cost element in BIM2COST. 

ROOMS 

Object type: Room 

Listing of 

 Room area in accordance with the standards SIA 416, ÖNORM B 1800 and DIN 277 

 Area distribution in accordance with the standards SIA 416, ÖNORM B 1800 and DIN 

277 

 Area type in accordance with the standards ÖNORM B 1800 and DIN 277 

 Room volume in accordance with the standards SIA 416, ÖNORM B 1800 and DIN 

277 

 Evaluated living space 

 Further values, however, without room covers (room covers in special object types) 
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It shall be kept in mind that the different floor plan areas in the room can vary. For example: 

A low front-resistant masonry, e.g. for installations, does not reduce the room area but the 

floor covering. 

All room covers are object subtypes of the object type room. 

Room kinds 

 

 Normal room 

 Air space: In the case of air spaces which are on all sides enclosed by room-dividing 

walls or room divisions. Air spaces, which laterally adjoin a roof, must not be defined 

as air space. In this case, the room covering wall of the lower room is automatically 

hoisted. 

 Construction area: For room areas which have to be added to the construction area in 

accordance with DIN 277, ÖNORM B1800 and SIA 416. 

However, the room label can be omitted for such rooms. ELITECAD calculates the 

construction area as a subtraction of the gross floor area and the room areas.  

 Exterior space: With this kind, the room covers are assigned the feature exterior. In this 

way, the attribution to the cost elements is controlled in BIM2COST. 

 Courtyard: Courtyards are outside areas and are not added to the internal or external 

floor area. 

 Stair well: On top of stair flights for which no 3D floor shall be generated. 

Room designation for stairs 

The room label for stairs always has to be added in the top most storey (at the exit). In this 

way, it is no longer necessary to add a room label, which is separated from the rest of room 

in the lowest storey below the stairs.  

The standards of DIN 277, ÖNORM B 1800 and SIA 416 are consequently complied with 

(room in the case of stairs is measured in the upper storey). 

Deduction and addition planes 

Chapter 10.6 Room describes how room surfaces can be overlaid with additional materials. 

These surfaces are taken into consideration during the quantities. 

ROOM COVERING FLOOR 

Room covers also rank among the object subtypes of rooms. See Navigation in the case of 

rooms 

Flooring for stairs 

The floor plan areas are automatically accounted as floor covers when using the room 

definition above the stairs. The same can be visualized at the object subtypes. 
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Object type: Flooring 

The labelling of the flooring is complemented by the documentation text of the room, e.g. 

flooring, RA1. Deduction and addition planes are assigned the documentation text CO with 

the room number and number of the plane, e.g. CO1.1 

The object type flooring contains all of the following object subtypes 

Object subtype: Floor layer 

A floor layer can be divided into several layers. 

Labelling: Documentation text of the room, layer number,  

e.g. floor layer, RA1.1.1 or in the case of deduction and addition planes CO1.1.1 

Object subtype: Floor upper layer 

Feature labelling. A floor upper layer can be composed of several layers. 

Labelling analogous to the flooring, e.g. floor upper layer, RA1.1 (CO1.1) 

Object subtype: Floor under layer 

Feature designation for layers below the floor overlay. The object type floor under layer 

can be composed of several layers. 

Labelling analogous to the floor upper layer, e.g. floor-under layer, RA1.1 (CO1.1) 

ROOM COVERING CEILING 

Ceiling covering for stairs 

The true space is automatically calculated in the stairs' bottom view (measured obliquely 

in the case of stair flights) for stairs, which are beyond a room definition. 
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Object type: Ceiling covering 

Labelling: Ceiling covering, RA1 / ceiling covering, CO1.1 

Object subtype: Ceiling finishing ply 

Labelling: Ceiling finishing ply, RA1.1.1/ ceiling finishing ply, CO1.1.1 

Object subtype: Ceiling upper layer 

Feature labelling: Ceiling upper layer, RA1.1 / ceiling upper layer, CO1.1 

Object subtype: Ceiling under layer 

Feature labelling: Ceiling under layer, RA1.1 / ceiling under layer, CO1.1 

ROOM COVERING WALL 

Wall coverings in the case of stairs 

The wall covering is interrupted in the case of stairs, which adjoin the wall. Below the stair, 

the wall covering is added to the lower storey, and the part above it to the upper storey. 

 

Covering underlay  

The covering underlay (wall material) is also quantified. 

This feature is used in BIM2COST for the attribution to the cost elements. 

Wall covering on non-load-bearing walls 

Wall coverings are calculated on all walls, which are located in the room. 
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Deduction test 

Openings are deducted if the opening is larger than the limit value. 

Object type: Wall covering 

Labelling including numbering for the sub-floors: wall covering, RA1.1 / wall covering, 

CO 1.1 

Object subtype: Wall covering layer 

Labelling including numbering for the sub-floors and layers: wall covering layer, RA1.1.1 

/ wall covering layer, CO1.1.1 

Object subtype: Wall overlay 

Feature labelling: Wall overlay, RA1.1 / wall overlay, CO1.1 

Object subtype: Wall covering underlay 

Solely in BIM2COST 

Feature labelling: Wall covering underlay, RA1.1 / wall covering underlay, CO1.1 

DRAINAGE 

Sewage systems, which are designed according to the module drainage, are quantified.  

All sewer parts are included in the list titled sewage system. 

Object type: Sewer line 

The sewer line is composed of several parts: It starts with the outlet into a manhole or the 

like and contains any pipes and moulded parts, which lead from the outlet upward. The 

length is quantified.  

Labelling: Sewer line, KA1 

Object subtype: Sewage pipes 

The sewage pipes contain all moulded parts. At "Values and attributes" these are 

differentiated according to the moulded parts. The documentation text is composed of the 

string number and the pipe number. 

Labelling: Sewage pipes, KA1.1 

Object type: Manhole 

Labelling: Manhole, 1 

STOREY DATA 

Object type: Storey data 

Areas and room volumes according to SIA416, DIN277, ÖNORM B1800 
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EXTERIOR SURFACE 

Object type: exterior surface 

The external surface is divided according to the sub-floors (wall material). 

EXTERIOR WALL AREA ABOVE GROUND 

LEVEL  

Object type: AWFO exterior wall area above ground level 

Unless being processed in BIM2COST this object type corresponds to the exterior surface. 

In BIM2COST, the ground wall line can be designed using the function DEFINE THE 

SUBSIOL. 

EXTERIOR WALL AREA BELOW GROUND 

LEVEL  

Object type: AWFU exterior wall area below ground level 

Only in BIM2COST after the definition of the ground line. 

FREE OBJECTS 

In order to calculate quantities of user defined 3D objects, properties have to be assigned 

to these objects. When the object is selected, its properties are displayed in the properties 

manager. Beside some fields, a calculator symbol is shown. A click on this symbol 

calculates the values from the geometric representation and enters these values into the 

fields. 

 

The first button in the properties manager opens the assignment dialog for free objects. In 

this dialog window it can be defined which object type and corresponding properties will 
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be used for the quantification of the selected free 3D object. Multiple properties can be 

selected, which can also be saved as template using the parameter button. 
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14.5 SETTINGS / RULES 

 

The function can be accessed in the quantities manager. 

SYNONYMS 

 

The example shows which material names are quantified as external insulation. As soon as 

one of these material names is used in the room dialog window, the material is quantified 

as external insulation. 

 

By summarizing the subordinate terms into a generic term, only the generic term needs to 

be assigned to a discipline. 
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Purpose of the synonyms 

During the quantification, the attribution of disciplines is controlled via the synonyms 

(materials).  

Generic terms and related subordinated terms (synonyms) of materials are contained in the 

synonym window. 

The tab "Object types" subsequently determines which generic terms shall be attributed to 

which discipline (craftsmen's differentiation). 
 

The synonyms "concrete, waterproof", "water-repellent concrete" and "waterproof 

concrete" are in the above example contained in the generic term sealing concrete. 

During quantification, this generic term is assigned to the building component. 

Therefore, not every single material needs to be listed in the tab "Object types". 

Country and region setting 

The MySQL-database is structured in a way that, depending on the settings of Windows 

(CONTROL PANEL > REGION AND LANGUAGE OPTIONS), materials specific to the 

region are listed. 

For Switzerland, the materials from the collection of material parameters and from the 

catalogues of NPK are used. 

For Austria, the materials of LB-HB have been gathered. 

For Germany, the materials of different German documents are in use. 

Spelling 

The exact entry of the material names is compared during the attribution to the generic 

terms. Lower case is not substituted for upper case.  

The sharp S symbol "ß" which is common in Austria and Germany is not synonymous with 

the double S "ss". 

Entry and adaptation of synonyms 

The push button "New generic term" enables to enter new generic terms. 

If a generic term is marked in the window, a new subordinate term can be entered using 

the push button "New synonym". 

The push buttons "Modify label" and "Delete element" enable to carry out changes. 

In the same way, changes can be carried out by clicking twice on a term. 

During the quantification, the CAD checks, which materials do not yet exist, and which 

can be added directly to the list. 

Import and export 

The push buttons "Import" and "Export" allow to secure these changes and to transfer these 

to other stations. 
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Since, as a general rule, all work stations access the same MySQL-server, all changes are 

available at all work stations and export as well as import for other stations is consequently 

not necessary. 

Reset 

All values can be reset to the delivery state. If multiple used work with the same database, 

resetting is only accessible for the person who works with the most recent ELITECAD 

version. 

OBJECT TYPES 

Tab types of wall layers 

Attribution of disciplines (craftsmen's differentiations). 

The lists differentiate between "brick walls" and "concrete walls". The material in the room 

dialog window determines which wall layer is quantified into which list. The material is 

entered in the object types via the synonyms. The tab for site-mixed concrete and for 

masonry are available. Depending on the tab in which the synonym is deposited, it appears 

in the corresponding list. If a wall layer does not appear in the corresponding list, the error 

needs to be searched in these two tabs. 

 

Tab site-mixed concrete construction 

As an exception, this setting does not only apply to walls but also to CAD-floors. 

Adaptation of attributions 

Adaptations can be carried out using the push buttons "Remove" and "Add". 

Quantification of concrete walls 

In the lists, the object type wall construction is used for concrete walls, if the wall consists 

of one layer or if the wall layer is designated as load-bearing. These are measured at the 

centre of the layer. The deduction test for openings is carried out according to the 

OPTIONS. 

The object type wall layer is used in the case of non-load bearing layers. The wall layer is 

indicated as a volume body. The volume body is not contiguous in the case of ignored 

openings. 

Every single layer is measured. 
 

The visualization for the object type wall construction indicates whether openings are 

deducted or not. In the example below, the small window openings are not deducted and 

the corresponding visualization area is contiguous at the window.  
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In the tab Formulas, it is indicated using zero values at the openings that these were not 

deducted. 

 

After the quantification of walls, "concrete walls" appears in the quantities manager at the 

tab "Values and attributes" in the column "Discipline" in the case of concrete walls and 

"concrete ceiling" in the case of CAD-concrete floors. 

 

Tab Masonry 

 

Insulation material 

Differing names for insulations have to be used in order to be able to differentiate between 

the insulation designations for the disciplines. In the basic setting of ELITECAD, different 

names for the exterior insulation layers and the insulation layers of plaster boards were 

used. The user needs to adapt this setting optimally to his working method. If for example 

the material name insulation is used for exterior insulations, the material name insulation 

needs to be deleted in the tab Masonry.  

Quantification of masonry 

In the lists for Masonry the object type wall construction is used for the concrete walls, if 

the wall consists of one layer or if the wall layer was designated as load-bearing. These are 

measured at the centre of the layer. The deduction test for openings is carried out according 

to the OPTIONS. 

The object type wall layer is used in the case of non-load bearing layers. The wall layer is 

indicated as a volume body. The volume body is not contiguous in the case of ignored 

openings. 
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Every single layer is measured. 
 

After the quantification in the case of walls, "Masonry" from the tab Masonry appears in 

the row "Discipline" in the tab "Values and attributes". 

Tab plaster boards (dry construction) 

 

This list shall include all materials, which are also used for system walls (single-plank walls 

with plaster board). 

Insulation of system walls 

The name of the insulation also needs to be different in order to enable a distinction from 

other disciplines (craftsmen's differentiations). Here the name "Insulation-drywall" was 

entered for this purpose. 

Quantification of dry walls 

The above listed materials are used in the lists for dry walls. 
 

After the quantification of walls made of the above listed materials, "Dry wall" appears in 

the quantities manager at the tab "Values and attributes" in the row "Discipline". 

One-layer dry walls  

The object type wall construction is used for lists in the case of one-layer dry walls. The 

visualization surface is contiguous in the case of ignored openings. 

Multi-layer dry walls (system walls such as single-plank walls) 

Prerequisite: 

All layers are defined as non-load-bearing.  

All layers are included in the above list. 

Walls, which comply with these conditions, are indicated in the list under the object type 

"Wall (covering)". All layers are summarized and measured at the side of the wall axis. 

In the example below, the wall axis at the right interior wall should be changed since 

measurements will always be carried out on the outside edges. 
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Tab Exterior insulation layers 

 

This list shall contain all materials, which are used for exterior insulation systems such as 

thermal insulation composite systems. 

Insulation for exterior insulations 

In order to enable a distinction from other disciplines (craftsmen's differentiations), the 

name of the insulation also needs to be different. Here the name "Exterior insulation" was 

entered for this purpose. 

Quantification of external insulations 

The above listed materials are used in the lists for dry walls. 
 

After the quantification of wall coverings made of the above listed materials, "Exterior 

insulation" appears in the quantities manager at the tab "Values and attributes" in the row 

"Discipline". 

Requirements 

All the layers need to be defined as non-load-bearing. 
 

Coverings, which comply with these requirements, are contained in the list under the object 

type "Wall (covering)". All layers are summarized and measured at the side of the wall 

axis. 

The visualization surface is contiguous in the case of ignored openings. 
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Tab "Other layers" 

 

The tab "Other layers" contains materials, which shall be calculated using a deduction test. 

The deduction test is applied in accordance with the setting for masonry. 
 

These materials are measured at the centre of the layer and included in the list "Various 

types of walls". 

Walls made of non-listed materials 

Materials, which are not listed in the wall layer types tabs, will be evaluated without 

deduction tests and listed as "Various types of walls". 

COLOURS 

 

The tab colours lays down with which 3D-hatching the object types are represented. 

 



Chapter 14 – Quantities 

www.elitecad.eu  975 

The colour is adjusted using the buttons at "Modify". 

INI-VALUES 

 

The company data for the reports are entered at the tab INI-values 

The font size is changed at Id 7. 

TEXTS 

Any texts from the quantities manager can be renamed. 

 

The texts, which are used in reports, are directly adjusted at the reports. 

Attributes 

The feature designations of the attributes are listed. 

The name of the attribute is adapted for the attribute values at the settings. 

Object types 

The object types can be renamed. 

Value types 

Value types are predominantly measurable sizes such as length, angle, minimum size etc.  

Discipline 

Craftsmen's differentiation. 
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OPTIONS 

In the options threshold values and other parameters of the standard can be adjusted. 

 

General 

Number of decimals for the rounding 

Room 

 Display limitations of space including 3D-surfaces and living space limiting values  

 Adjust the factors and limiting heights for the calculation of living spaces 

 Calculate window niche to the NFA for ground surfaces according to SIA 416, DIN 

277 and ÖNORM B1800 

 Minimum room size, so that small empty spaces/joints between building components 

are recognized as rooms 

 Minimum niche depth for the calculation of living spaces. 0 values signify that window 

niches are not calculated. Settings for Germany need to be defined in accordance with 

the Living Space Regulation 0.13. 

Disciplines (craftsmen's differentiation) 

It can be defined individually for the various disciplines exterior insulation, dry 

construction, concrete walls in square meters and plasters until which point including 

indication of size an opening shall be ignored.  

THICKNESS OF THE WALL FINISH 

These values only have an influence on the living space verification. 
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Synonyms are listed and a corresponding plaster thickness (thickness of the wall finish). 

As a standard, materials, which shall not be overlaid with an additional cover, are listed.  

The thickness of the wall finish is defined at the wall material in the room dialog window. 

 

Upon an active linking (red padlock) every wall side of the roof is checked with regard to 

the basement material (material of the wall layer) and if the material has been entered in 

the quantities database, the corresponding thickness of the database is applied. The 

thickness which was been entered in the mask is used for walls of which the material has 

not been entered in the quantities database. 

Example: 

2 rooms with a separating wall made of the material wood, exterior wall made of the 

material bricks. 

 

The materials block and wood have to be searched in the list of synonyms.  

Wood is a material; block becomes a synonym of brick.  
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The material brick is not contained in the tab thickness of wall finish. In this way, for all 

walls of the material brick the thickness of the wall finish is defined using the value of the 

room dialog window. 

The material wood is included in the list with the thickness of the wall finish amounting to 

0. This means that the wooden wall has no wall covering layer. 

 

The setting can be controlled via the living space verification.  

 

Room 1 is not linked to the database and consequently a wall covering with a thickness of 

3cm is applied on all adjoining walls.    

Room 2 is actively linked to the database and consequently the ground surface at the 

wooden wall is calculated up to the wall. 

LAYER TYPES 

The layer type has to be determined for "Layer"-related building components (wall, ground, 

roof and floor). 

Room2 
5.97m² 

FFB±0.00 

Parquet 

Room1 
4.21m² 

FFB±0.00 
Parquet 
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In order to guarantee a correct quantification, a layer type needs to be attributed to the layer. 

If the chain to the material has been dissolved, an attribution can be carried out 

independently. If the chain is active, the layer type is read from the quantities database 

using the name of the material. 

Chained with material 

The material of the layer first searches the list of synonyms in order to be able to switch to 

the generic term of the material. 

 

In this example, the material is "Insulation-exterior" 

 

"Insulation-exterior" becomes the generic term exterior insulation. 
 

In the tab layer types the materials of each component type are divided into the four layer 

types "Load-bearing construction", "Non-load-bearing construction", "Sub-construction" 

and "Covering". 
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The example is a wall and the material exterior insulation is a covering layer. In this way, 

the layer will be changed automatically to covering when the link is active. 

 

This automatism attributes the correct layer type to standard constructions and correctly 

quantify the component without manual interventions. 
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14.6 LISTS / REPORTS 

 

Toolbar AR lay-out> Create and print reports 

Menu Extras > Quantities > Reports 

 Quantities manager > Create and print reports 

 

CREATE AND PRINT REPORTS 

The report is opened by double clicking on its name. 

Requirement 

The model needs to be loaded and quantified. In order to open the created reports it is 

required that Excel is installed. This is not a requirement for the generation of reports. It is 

possible to open the reports with other software that supports the standard Office Open 

XML (e.g. LibreOffice or OpenOffice) but more or less differences may occur. 

Contents of reports 

All reports including their contents and attachments are described in detail in the course 

unit Quantification in the chapter 10.2. 

Templates 

For the generation of reports templates in Excel-format are provided and located in the 

directory <ELITECAD-installation-directory>\u\<version>\ar\calc\reports or in 
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subdirectories for variants of standards. Format modifications (fonts, frame, …) are easily 

done using standard Excel functions. 

In order to avoid an overwriting of these user modifications of the templates by updates, a 

parallel directory <ELITECAD-installation-directory>\u\<version>\ar_c\calc\reports has 

to be created and the desired report has to be copied into this directory. Changes of the 

report content require special knowledge about the variables and report generation. This 

topic is not documented in this manual. Please contact your ELITECAD reseller. 
 

Header and Footer 

The file HeaderFooter.xlsx is intended for changes in header and footer. Before making 

any modifications this file has to be copied into a parallel directory as described in the 

previous section. Changes are automatically applied to all reports where this header / footer 

template is included. 

Renovation planning 

When renovation planning is active a filter is displayed, which filters data according to the 

renovation planning state. Combinations of states are allowed as well. A new hierarchy is 

introduced in the reports for the renovation planning state.  
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14.7 CHECKING THE ELITECAD MODEL 

Check room contours 

The following rules need to be complied with in order to be able to determine the room 

contours of the CAD: 

• Room-dividing elements must not overlay. 

• No room divisions along room-dividing walls or room-dividing glass elements. 

• No room-dividing building components such as walls, glass elements above each other 

with the active option ROOM DIVIDING. This option is allowed to be selected for only 

one building component. 

Show room separating objects 

 
 

Menu Extras > Quantities > Show room separating objects 

All room-dividing building components of the current story are shown. 

Check room contours 

 
 

Menu Extras > Quantities > Check room contours 

Assembly of room contours (model). 

The desired storey has to be active. The contours are attributed to the layer "Room-check-

contours". 
 

TIP 
The individual contours can be checked using the function VERIFY 2D 

MODEL (Menu INFO) to determine if the contour is faulty (open). 

  

Delete room contours 

 
 

Menu Extras > Quantities > Delete room contours 

Room contours, which have been generated by the CHECK ROOM CONTUR function, 

will be deleted by this function. 

Check wall axes 

 
 

Menu Change > Wall > Change wall axes 

In order to ensure a correct quantification of the walls and the wall surfaces, it is important 

that all walls have been created correctly. The wall axes have to adjoin the wall contour. 

Check external contours  

An external contour is generated for every storey during the quantification. 

These contours can be created using the layer "External contour". 

These contours are only indicated if the room contours are switched on. 

Activate "Room contour" under SETTINGS > OPTIONS > DEPICTION > 

ARCHITECTURE. 
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Function of the height control 

 
 

Menu Extras > Quantities > Quantities Manager > Push button Settings/Rules 

 

At the tab Options the option VISUALISE ROOM VOLUME set to 1. 

New 3D-objects at the "further CAD layers" are generated during the quantification. If the 

option is reset to 0, these objects will be deleted during the next quantification.  

These objects are only visible in the wire and solid model. If these should be released in a 

plan view, a hidden line over the Menu EXTRAS > HIDDEN LINE needs to be calculated 

in advance. 
 

Layer Room boundaries: 

Horizontal and vertical 3D-surfaces show the limitations of the room. The lower surfaces 

are located at the height TF rough slab. The setting MAXIMUM ROOM HEIGHT of the 

room definition is taken into consideration. 
 

Layer Room boundaries _100%: 

3D-surfaces at the height of the upper limit value for the calculation of living spaces. 

The height is calculated starting from TF finished floor. 
 

Layer Room boundaries _50%: 

3D- surfaces at the height of the medium limit value for the calculation of living spaces. 

The height is calculated starting from TF finished floor. 
 

Layer Room boundaries _0%: 

3D- surfaces at the height of the lower limit value for the calculation of living spaces. 

The height is calculated starting from TF finished floor. 
 

Layer Room boundaries: 

Horizontal and vertical 3D-surfaces show the limitations of the storey. 

The horizontal surfaces are located at the height of LF ceiling slab (LF ceiling). 
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